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Welcome
Welcome to the Metasys Site Management Portal (SMP) Help. This help file contains information
on how to use the Metasys SMP user interface software. This section provides links to the major
sections of the help file. For information about the components that make up a Metasys system,
see System overview.
Note: Throughout this help file, the term SMP refers to the user interface of the online
Metasys engines and servers as well as the offline SCT, unless otherwise indicated.

Summary of Changes
The following information is new or revised at Release 11.0:
•

Removed content about Basic Access, which was removed as a user access type at Release
11.0.

•

Removed content about the RADIUS account user, which is no longer supported at Release
11.0 and does not comply with the FIPS 140-2 feature.

•

Added the new SA Bus Integration Object for SNCs.

•

Added a new object type for integrations called Network Port, a requirement for complying
with the BACnet standard specifications. These integrations are now Network Port objects:
BACnet IP, Field Bus MSTP, SA Bus, Ethernet IP Datalink, and IP Field Controller. Also because
of this change, the following attribute tables were modified: MS/TP Field Bus Integration
Attributes, SA Bus Integration Attributes, Ethernet IP Datalink Attributes,

•

Added information about a new user access type called API Access.

•

Added new attribute called FIPS Compliance Status to ADS Device Object for supporting FIPS
140-2.

•

Added two new USB Port Enabled attributes to Engine Device Object.

Getting Started
The Site Management Portal User Interface enables you to set up and maintain your building
management system by interacting with Metasys engines and Metasys servers to perform
functions such as:
•

Navigating a site that includes: Navigating to an Item, Modifying an Item, and Commanding
Items.

•

Creating a calendar and exception schedules for events and holidays.

•

Creating trends, alarms, or totalizations extensions on points.

•

Creating reports to monitor data about your system.

•

Customizing the navigation tree with a user view.

•

Creating graphical displays using the User Graphics Tool (UGT) and Graphics+.

System overview
The major components of the Metasys system are:
ADS/ADX: The Application and Data Server (ADS) is a software package that you can use to
monitor and control the entire Metasys system. The ADS also serves as a long-term storage
device for alarm and event messages, trend data, and user transactions. For customers with large
facilities, the Extended Application and Data Server (ADX) is available to provide extended user
Metasys Site Management Portal Help
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access and historical data storage capabilities. You can use an ADS/ADX to access the user interface
and to serve as the location for user graphics. The ADS/ADX typically coordinates multiple user
access from web browsers to the network. Hereafter, the term Metasys Server applies to either the
ADS or the ADX.
You can also install the ADX in a split configuration with the ADX software/user interface on
one computer (the web/application server computer) and the historical trend data on another
computer (the database server computer).
OAS: The Open Application Server was introduced in Metasys Release 10.1. You can use an OAS
as the point of access into a building automation system (BAS) and to archive historical and
configuration data for a site. You can use an OAS as the supervisory device for 200 or fewer field
devices through BACnet/IP or Remote Field Bus protocols. As a Site Director, an OAS can also
support two child NxE or SNx devices. The OAS is an ideal solution to add the Metasys UI to an
engine-only site. Hereafter, the term Metasys Server also applies to the OAS.
Network Engine: The network engine is a family of devices that supervise lower-level field
controllers over the Metasys BAS. Network engines include the Network Automation Engines
(NAEs), Network Integration Engines (NIEs), Network Control Engines (NCEs), Series of Network
Controllers (SNCs), and Series of Network Engines (SNEs):
•

The NAE and SNE are Ethernet-based supervisory engines that monitor and supervise
networks of field-level building automation devices that typically control HVAC equipment,
lighting, security, fire, and building access. The features of NAEs and SNEs include alarm and
event management, trending, archiving, energy management, scheduling, and password
protection through their embedded Site Management Portal. Different models and options
support various communications protocols, including BACnet® over IP, BACnet MS/TP,
Johnson Controls® N2 Bus, LonWorks, Modbus®, M-Bus, and KNX. The NAE55 and SNE2200x
Series support a comprehensive set of supervisory features and functions for large facilities
and technically advanced buildings and complexes. The NAE35, NAE45, SNE1050x, and
SNE1100x Series support the same features and functions of the NAE55 and SNE2200x engines,
but are designed for smaller buildings (or small areas of larger buildings) and enable the
wider distribution of supervisory functions in larger facilities. Lastly, the NAE85 supports large
BACnet/IP integrations with over 10,000 objects.

•

The secure NAE-S is a hardened, secure version of the standard Network Automation Engine
(NAE) 55 supervisory engine that uses embedded encryption technology to protect and secure
the building management system at the endpoint. The engine meets the Federal Information
Processing Standard (FIPS 140-2), Security Level 2, that specifies the use of a cryptographic
module and a tamper-proof housing. The engine is also Common Criteria certified.

•

The NCE and SNC combine the network supervisor capabilities and IP network connectivity
of a network engine with the Input/Output (I/O) point connectivity and direct digital control
capabilities of a field controller. The NCE and SNC are a cost-effective solution designed for
central plants and large built-up air handler applications. All NCE and SNC models include
IP Ethernet network connectivity, the Site Management Portal, and the network supervisory
functions featured on network automation engines. Some NCE and SNC models include an
onboard display with keypad. The NCE and SNC support a wide variety of building networks
such as BACnet/IP, BACnet MS/TP, Johnson Controls N2 Bus, LonWorks, Modbus, M-Bus, and
KNX.
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•

The NIEx5 is an Ethernet-based, supervisory engine for integration of Metasys N1 Networks.
The NIEx5, which includes the NIE55 and NIE85, is a specialized version of the NAE and is
designed to provide for the migration of existing N1 networks into the Metasys system. The
NIEx5 has the same Site Management Portal as the NAE. Unlike the NAE, the NIEx5 does not
support integration of BACnet MS/TP or BACnet/IP, N2, and LonWorks networks. Two models
of the NIEx5 are available. The NIE55 supports smaller N1 networks, while the NIE85 supports
larger N1 integrations. The NIE55 and NIE85 engines were retired at Metasys system Release
9.0.

The NIEx9 is an Ethernet-based, supervisory engine for integration of building control devices
that communicate over the Modbus®, MBus, or KNX protocol. The NIEx9 also communicates
over the BACnet MS/TP, BACnet/IP, N2, or LonWorks networks. This specialized version of the
NIE is designed to provide for the migration of these existing third-party networks into the
current generation Metasys system. The NIEx9 provides the same Site Management Portal UI
as the NAE or NIE. Several models are available: NIE29, NIE39, NIE49, NIE59, and NIE89. The
NIE29, NIE39, and NIE49 engines were retired at Metasys system Release 9.0.7.
SCT: You can use the System Configuration Tool in all phases of engineering, installing, and
commissioning of devices that make up the Metasys system. You can use the SCT offline to create
archive databases that can be downloaded to an Engine or Server. You can also use the SCT to
upload and archive databases that were created or edited online from an Engine or Server. With the
SCT, you can view and configure multiple sites in one archive.
•

SCT no longer requires the Site Director to be of an equivalent release version as the tool. You can
use the SCT also to maintain a variety of engines from Release 5.2 and later. The Site Director must
now be at an equivalent or greater release version than the highest versioned engine. For example,
if you have a 10.1 engine and an 8.0 engine in the archive, the Site Director needs to be at Release
10.1 or later.
The SCT has the same look and feel as the Engine and Server Site Management Portal.
Metasys system configuration requires that you define a single device as the Site Director. The Site
Director device may be a network engine or server, and its primary role is to coordinate multipleuser access from the web browser to the network. If a Metasys server exists in the system, it is
defined as the Site Director automatically. When communicating directly to Metasys servers or
network engines, you are in the online mode.
Note: In order to use HTTPS communications between Metasys SMP and SCT, you must have
SCT Release 11.1 or later, SMP Release 8.1 or later, and the latest version of Launcher installed.

Related Documentation
Use the following table to find information available outside this Help system:
Table 1: Related Documentation
For More Information On

See Document

Metasys System

Metasys System Configuration Guide
(LIT-12011832)

Metasys System terms and acronyms

Metasys System Extended Architecture Glossary
Technical Bulletin (LIT-1201612)

How to use the Metasys Launcher

Launcher Help (LIT-12011742)

Network information including Internet security
risks

Network and IT Guidance Technical Bulletin
(LIT-12011279)

How to use the Open Application Server (OAS)

Open Application Server Help Guide
(LIT-12013243)
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Table 1: Related Documentation
For More Information On

See Document

ADS or ADX installation and upgrade

Metasys Server Installation and Upgrade
Instructions Wizard (LIT-12012162)

How to install an OAS

OAS Installation Guide (LIT-12013222)

SCT installation and upgrade

SCT Installation and Upgrade Instruction
(LIT-12012067)

Configuration of an ADS/ADX within the Metasys
ADS/ADX Commissioning Guide (LIT-1201645)
System. Also includes information on configuration
of repositories, time synchronization, printing, and
dial-up connections.
How to set up time management on the Metasys
System

ADS/ADX Commissioning Guide (LIT-1201645)

How to configure the split ADX

ADS/ADX Commissioning Guide (LIT-1201645)

License information for the Metasys System

Metasys System Extended Architecture License
Information (Part No. 24-10067-1)

Licensing for the ADS/ADX, Export Utility, and
Advanced Graphics Application software

Software Manager Help (LIT-12012389)

Installation of Export Utility software

Export Utility Installation Instructions
(LIT-12011527)

NAE Commissioning Guide (LIT-1201519)

Use of the Export Utility to extract historical data to Export Utility Help (LIT-120952)
formats such as Microsoft Excel® and Access
Installation of the Advanced Graphics Application
and SVG Viewer

Advanced Graphics Application Installation
Instructions (LIT-12011525)

Configuration and use of the Advanced Graphics
Application to create graphics with dynamic
capabilities

Advanced Graphics Application Help
(LIT-1201850)

Installation of the Graphic Generation Tool

Graphic Generation Tool Installation
Instructions (LIT-12011685)

Configuration and use of the Graphic Generation
Tool to create Graphics+ files

Graphic Generation Tool Help (LIT-12011697)

Use of Graphics+ files at the Site Director

Graphics+ Runtime Help (LIT-12011708)

Use of the SCT regarding offline archive databases
setup and basic setup of an N2 network online

Metasys SCT Help (LIT-12011964)

How to create and edit users and roles, configure
user profiles, assign system access permissions,
assign all items navigation view permissions, and
unlock user accounts

Security Administrator System Technical Bulletin
(LIT-1201528)

Metasys for Validated Environments (MVE),
Extended Architecture

Metasys for Validated Environments, Extended
Architecture Technical Bulletin (LIT-12011327)

How to install the NAE55 and NIE55

NAE55/NIE55 Installation Instructions (Part No.
24-10051-0)

How to install the Secure NAE-S

NAE55-S Installation Instructions (Part No.
24-10051-108)
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Table 1: Related Documentation
For More Information On

See Document

How to install the NAE35 and the NAE45

NAE35/NAE45 Installation Instructions (Part No.
24-10050-6)

How to install the NxE85

NxE85 Installation Instructions (LIT-12011530)

How to install the SNE1050, SNE1100, and SNE2200
network engines

SNE Installation Guide (Part No.
24-10143-01647)

How to install the SNC1612 and SNC2515 network
engines

SNC Installation Guide (Part No.
24-10143-01892)

How to commission the LCS85

LCS85 Commissioning Guide (LIT-12011568)

How to commission the NAE

NAE Commissioning Guide (LIT-1201519)

How to commission the SNE

SNE Commissioning Guide (LIT-12013352)

How to commission the SNC

SNC Commissioning Guide (LIT-12013295)

How to set up and commission an NAE85/NIE85

NxE85 Commissioning Guide (LIT-12011044)

How to install and use the NAE/NIE Update Tool

NAE/NIE Update Tool Technical Bulletin
(LIT-12011524)

How to install and Use the NAE Configuration Tool

NxE Information and Configuration Tool
Technical Bulletin (LIT-1201990)

NAE55 Compliance with ANSI/ASHRAE Standard
135-2008, BACnet Protocol

NAE/NCE Protocol Implementation
Conformance Statement Technical Bulletin
(LIT-1201532)
This document includes the PICS and BIBBs
for the NAE55.

NIE Compliance with ANSI/ASHRAE Standard
135-2008, BACnet Protocol

NIE Series Protocol Implementation
Conformance Statement Technical Bulletin
(LIT-1201672)
This document includes the PICS and BIBBs
for the NIE.

How to use web service technology for secure
access to the Metasys System

Metasys System Extended Architecture
Secure Data Access DLL Technical Bulletin
(LIT-1201663)

Concepts and procedures to perform an N1
Migration with an NIE

N1 Migration with NIE Technical Bulletin
(LIT-1201535)

How to integrate an N2 network in the Metasys
System with the NAE

N2 Integration with the NAE Technical Bulletin
(LIT-1201683)

How to set up an NAE55 as a BACnet System
Integrator in a Metasys System network

BACnet Controller Integration with NAE/NCE
Technical Bulletin (LIT-1201531)

How to set up an NAE as a LonWorks Network
Integrator

LONWORKS Network Integration with NAE and
LCS Technical Bulletin (LIT-1201668)

The operation of and setting up Metasys System
Demand Limiting and Load Rolling

DLLR Technical Bulletin (LIT-12011288)

Metasys Advanced Reporting System and Energy
Essentials

Metasys Advanced Reporting System Help
(LIT-12011312)

How to install the Metasys Advanced Reporting
System

Metasys Server Installation and Upgrade
Instructions (LIT-12012162)
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Table 1: Related Documentation
For More Information On

See Document

How to install Energy Essentials

Energy Essentials Installation Instructions
(LIT-12011539)

How to configure the Metasys Advanced Reporting ADS/ADX Commissioning Guide (LIT-1201645)
System
How to configure Microsoft SQL Server Report
Services to work with the Metasys Advanced
Reporting System

ADS/ADX Commissioning Guide (LIT-1201645)

MS/TP communications and field controllers

MS/TP Communications Bus Technical Bulletin
(LIT-12011034)

Site Management Portal User Interface
You can interact with the entire Metasys system from any location running a supported web
browser. Use either Windows Internet Explorer version 11, Microsoft Edge version 44 or later, Apple
Safari® version 11.0 or later, or Google Chrome™ version 78.0 or later. Other browsers, such as
Mozilla® Firefox®, may also be used but are not fully supported.
Note: In Internet Explorer 11, select the option Display all websites in Compatibility View,
found under Tools > Compatibility View Settings, to ensure that websites appear and
function correctly.
You use the Launcher application to reach the login screen for the Site Management Portal UI. If
the Launcher is not already installed on your machine, you are prompted to install it when you
attempt to log in the SMP using the web browser.
After you log in to the Metasys system, you are able to perform the following operations:
•

navigate to an item in the system

•

create user views

•

view summary definitions and tailored summaries

•

manage alarms and events

•

record and display trend data

•

work with items to monitor and command systems and points

•

edit and modify items

•

schedule activities

•

create and view graphics

•

create, simulate, and activate control system logic

Site Management Portal User Interface Concepts
User Interface Object Icons and Class IDs
The SMP user interface shows object icons in the All Items tree based on class IDs and use cases.
For example, some class IDs display differently if the device is a Site Director. If a class ID does not
have a designated icon, the default icon is used. The following table contains all class ID icons.
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Table 2: User Interface Object Icons
Icon

Object

Class ID

Default

NA
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Table 2: User Interface Object Icons
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BACnet Analog Input

0

N2 Analog Input

147

XL5K Analog Input

202

Lon Analog Input

351

N1 Analog Input

417

VND Analog Input

428

BACnet Analog Input Mapper

500

Analog Input Mapper

599

BACnet Analog Output

1

N2 Analog Output

149

XL5K Analog Output

203

Lon Analog Output

352

N1 Analog Output

419

VND Analog Output

429

BACnet Analog Output Mapper

501

Analog Output Mapper

600

BACnet Analog Value

2

JCI Analog Value

165

BACnet Analog Value Mapper

502

Analog Value Mapper

601

BACnet Binary Input

3

N2 Binary Input

148

XL5K Binary Input

204

Lon Binary Input

353

N1 Binary Input

418

VND Binary Input

430

BACnet Binary Input Mapper

503

Binary Input Mapper

602

BACnet Binary Output

4

N2 Binary Output

150

XL5K Binary Output

205

Lon Binary Output

354

N1 Binary Output

420

VND Binary Output

431

BACnet Binary Output Mapper

504

Binary Output Mapper

603

BACnet Binary Value

5

Binary Value

168

BACnet Binary Value Mapper

505
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BACnet Calendar

6

JCI Calendar

161

N1 Calendar

423

Calendar Mapper

762

BACnet Event Enrollment

9

JCI Event Enrollment

190

BACnet Event Enrollment Mapper

509

BACnet File

10

Resource File

357

BACnet File Mapper

510

File

554

BACnet Group

11

JCI Group

191

BACnet Group Mapper

511

BACnet Loop

12

Proportional, Integral, and Derivative Loop

252

JCI Loop

264

BACnet Program

516

BACnet Multistate Input

13

N2 Multistate Input

151

XL5K Multistate Input

206

LON Multistate Input

355

N1 Multistate Input

421

VND Multistate Input

432

BACnet Multistate Input Mapper

513

JCI Multistate Input Mapper

605

BACnet Multistate Output

13

XL5K Multistate Output

207

LON Multistate Output

356

N1 Multistate Output

422

VND Multistate Output

433

BACnet Multistate Output Mapper

514

BACnet Notification

15

JCI Notification

313

BACnet Notification Mapper

515

JCI Notification Mapper

763

BACnet Schedule

16

JCI Schedule

263

BACnet Schedule Mapper

517

JCI Schedule Mapper

761
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BACnet Multistate Value

19

JCI Multistate Value

141

BACnet Multistate Value Mapper

519

JCI Multistate Mapper

606

BACnet Accumulator

23

N2 Program Control

153

XL5K Program Control

208

Flex Accumulator

209

BACnet Accumulator Mapper

220

N1 Program Control

245

BACnet PE

129

Subscription Server

135

Subscription Client

661

DLLR

137

IEIEJ Electric Demand Monitoring

214

IEIEJ Electric Demand Control

215

IEIEJ Generic Load Control

216

BACnet Load Control

225

BACnet Electric Demand Control

228

BACnet Generic Load Control

245

Load

138

Multiple Control

144

BACnet Command

507

Interlock

146

Trend

155

BACnet Trend Log

520

Trend Mapper

760

Analog Alarm

156

Multistate Alarm

172

Optimal Start

174

Metasys Site Management Portal Help

Table 2: User Interface Object Icons
Container

176

User View Folder

2000

Controller Folder Template

2006

SCT Summary Definition Folder

2011

Container

176

Container

176

Reference

176

Global Data

177

Signal Select

178

Pulse Meter

181

BACnet Pulse Converter

221

N50 (NAE55)

185

NAE 45

192

NAE 35

193

BACnet Router

219

Gateway

282

N50 Integration (NIE)

358

NAE 35

613

Site Director N50

185

Site Director NAE 45

192

Site Director NAE 35

193

Site Director BACnet Router

219

Site Director Gateway

282

Site Director N50 Integration (NIE55)

358

Site Director NAE 35

613

SNC

448

SNE1100x

871

SNE1050x

872

SNE110L
x

873

SNE2200x

877

Site Director SNC

448
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20

Site Director SNE1100x

871

Site Director SNE1050x

872

Site Director SNE110Lx

873

Site Director SNE2200x

877

Programming

450

Local Application

236

Local Hardware IO

449

Auto Shutdown

186

Field Bus

195

SA Bus

196

XL5K Integration

200

WRS Class

210

N2 Integration

290

MSTP Integration

307

N1 Integration

346

LON Integration

349

Field Device

197

XL5K Controller

201

Controller

278

NCM

347

LON Controller

350

VND Controller

427

BACnet Device

508

REM Device

597

RIOM Device

598

Fire Control Device

199

Wireless Receiver

211

Fire Control Device

N/A

Wireless Sensor

212
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Table 2: User Interface Object Icons
Supervisor Status Primitive

213

Net Sensor Device

627

IEIEJ Electric Demand Monitoring

214

BACnet Electric Demand Monitoring

227

BACnet Trend Log Multiple

224

Trend Log Multiple

300

Solar Clock

249

Diagnostic

255

Analog Totalization

274

Runtime Totalization

275

Event Totalization

276

ODS Workstation

283

OAS Workstation

393

ADS Workstation

425

ADS Lite E

752

ADS Lite A

753

Initial Device Configuration

2004

Site Director ODS Workstation

283

Site Director OAS Workstation

393

Site Director ADS Workstation

425

Site Director ADS Lite E

752

Site Director ADS Lite A

753

Site

286

Ethernet IP

292

Data Broadcast

319

System Class

336

BACnet IP Integration

343

Graphic

344

Trend Study

345
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22

Navigation Tree

348

P2000 Server

377

P2000 Host Engine

N/A

P2000 Panel

378

P2000 Portal

379

P2000 Door

380

P2000 Report

N/A

Standards Table

585

BACnet Averaging

518

Averaging

677

BACnet Life Safety Point

521

BACnet Life Safety Zone

522

Input Float Block

526

Output Float Block

527

Input Enumeration Block

528

Output Enumeration Block

529

Input Boolean Block

530

Output Boolean Block

531

Summer Winter Compensation Primitive

532

Control Activity

536

Float Constant

551

Boolean Constant

552

Control Point

555
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Sensor Primitive

556

Comparison

560

Math Primitive

/561

ABH Primitive

563

DP Primitive

564

Enth Primitive

565

RH Primitive

566

WB Primitive

567

Flow

570

Enumeration Constant

568

Sequence

575

Variable Speed Drive

632

NCE

651

Site Director NCE

651

Summary Definition

699

Xaml Graphic

717

Legacy Equipment

805

Space

806

Equipment Definition

807

BACnet Character String

820

BACnet Integer

825

BACnet Positive Integer

828

Archive Object

2000
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Controller Template

2008

SCT Summary Definition

2010

Launcher
About this task:
The Metasys system relies on a private internal Java Runtime Engine (JRE) that is installed when you
download the Launcher application. This private JRE is not exposed to the same security risks as the
public version of the JRE.
The Launcher manages a list of all supervisory engines, Metasys Servers, and SCT computers at
your facility. You can also add the Metasys UI, Metasys Advanced Reporting System, and any web
address to its managed list of websites. You can access any release of the Metasys system with the
Launcher, but opening the SMP or SCT UI at Release 5.2 or earlier requires the public JRE on the
client computer. To install the Launcher application:
1.

Open your web browser and enter the URL for the Site Management Portal. Examples:
https://MAIN-ADX/metasys
https://main-adx.my-domain.com
https://10.10.15.100/metasys
Note: If your site has self-signed certificate and you attempt to install the Launcher
application through the HTTPS site, a security certificate error appears. Continue to the
website in order to continue installing the Launcher application.
The Windows Launcher Download screen appears.

2.
3.
4.
5.

Click Full Launcher Installer to access SMP or SCT, which allows you to run or download the
Launcher installation file.
Click Run to start the installer. For more details, refer to the Launcher Installation Instructions
(LIT-12011783).
After installation, close the web browser. By default, the Launcher screen appears after
installation.
Refer to the Adding a New SMP or SCT Device Profile and Adding a New Other Profile sections of
Launcher Help (LIT-12011742) for instructions on how to manage a list of all engines, Metasys
Servers, ODS, SCT, Metasys Advanced Reporting System, or any generic website links that
require a login.

Login
Note: We strongly advise that you do not access the Metasys Site Management Portal UI from
a computer running a server-class operating system. By default, Windows Internet Explorer
Enhanced Security Configuration is enabled on server-class operating systems and may block
the Launcher download page from which you install the Launcher application for access to the
Site Management Portal. Open the Site Management Portal UI from a computer that is not
running a server-class OS.
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The Metasys system supports Active Directory service and SSO. When you launch the device that
is configured as the Site Director of the extended Metasys network, three possible login scenarios
occur:
•

If the Active Directory service feature is disabled, the Metasys login screen appears. Enter
your Metasys user name and password to gain access to the Metasys Site Management Portal
(SMP) user interface.

•

If the Active Directory service and SSO features are enabled and you are logged in to your
Windows desktop as an Active Directory service user with access to the Metasys system, the
login screen does not appear and you automatically have access to the Metasys SMP user
interface.

•

If the Active Directory service feature is enabled, but you are not logged in to your Windows
desktop as an Active Directory service user with access to the Metasys system (or if the Active
Directory service feature is enabled and SSO is disabled), the login screen appears. From
that screen, you can access the Metasys system by entering your Metasys user name and
password, and by selecting Metasys Local from the Login To drop-down menu; or by entering
an Active Directory service user name and password, and by selecting the Active Directory
service domain from the Login To drop-down menu.
The first time you log in to the site or engine and after you change the default password, the
Metasys Terms and Conditions appear. Scroll through and read the entire Terms and Conditions
text. If you agree with the terms, click Accept at the end of the text. If you do not agree, click
Cancel to return to the login screen.
Note: If the Site Director is not available, you may want to directly connect to a network
engine. In this scenario, Active Directory service login is not supported (both automatic login
and user name/password login), and you must use a Metasys user name and password to
connect. The security configuration for a network engine may be set up differently than in the
Site Director.
For information about setting up the default login domain in the SMP UI for sites that use Active
Directory accounts, refer to the Selecting a Default Domain for Active Directory Service – Users section
in the Security Administrator System Technical Bulletin (LIT-1201528).

Warning Banner
After Metasys installation, you can use the SMP UI to enable a Warning Banner option at the Site
object. The Warning Banner is a special login feature that consists of a text window that appears to
the SMP user. The information in the text window is customized for the United States government
agency where the Metasys system is installed. The user must read and accept the conditions set
forth in the Warning Banner before logging in.
You have the choice of three different warning banners: U.S. Department of Defense (DoD), U.S.
General Services Administration (GSA), or U.S. Department of Transportation (DOT) Federal Aviation
Administration (FAA). The default selection is None. The following figure shows the Warning Banner
selection in the UI.
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Figure 1: Warning Banner Selection

Warning Banner Example
The figure below shows the banner that appears each time you access the Site Management Portal
if the DoD banner type is selected on the Site object.
Figure 2: United States DoD Warning Statement

26

Metasys Site Management Portal Help

For this example, the statement contains information critical to any Metasys user accessing the BAS
at a Department of Defense facility. You must click OK to consent to the statement before reaching
the login screen. The standard Metasys system login screen appears after you click OK. If the Active
Directory service and SSO features are enabled, Active Directory logs you in without asking for the
user name and password.
When the Metasys system login screen appears, you have up to 30 seconds to log in. If 30 seconds
pass with no login activity, the login screen clears and the warning banner screen returns. The
banner also reappears after you log out of the Metasys system or the system logs you out because
of user inactivity.
Record of User Access with IP Address
The Audit Viewer in the Metasys software records each change that occurs in the Metasys system.
The User column in the Audit Viewer records the name of each user who logged in (authorized
user) or tried to log in (unauthorized user). The Post Value column records the IP address of the
client computer used to access the Metasys system. See the following table.
Figure 3: Users and IP Addresses Recorded by Audit Viewer

Metasys Modes
Metasys software can operate in different modes: online using the Site Management Portal UI
offline using the SCT UI. When you are connected to the network engine or Metasys Server, you
can perform online mode operational activities such as monitoring and commanding. When you
are connected to the SCT only, you can perform offline mode system configuration tasks such as
configuring point objects and features.
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Online Mode
When you are connected to the network engine or Metasys Server, you can perform online
operational activities such as monitoring and commanding equipment. You can also perform online
database configuration activities, such as defining field controllers or adding points. This function is
referred to as online mode or Site Management Portal (SMP) mode. The online mode is available to
users with the access type of Standard Access. See the Access Types section.
Any changes you make to the system configuration are made online to the system and need to be
uploaded to be stored in the archive database.

Offline Mode
You can use SCT to configure servers and network engines without connecting to the live Metasys
system server and network engines. This function is called offline (or system configuration) mode.
In offline mode, use SCT to set up the system database. Then, load configuration changes created
in offline mode to the network engine for the settings to take effect.
Two features are available only with SCT: ActionQ and Manage Archive. You can add servers and
network engines in offline mode only.
The offline mode is available to users with the Access Type of Standard Access. See the Access
Types section.

Access Types
Metasys system administrators determine the type of access a user has to the Metasys system
through user accounts in the Security Administrator tool. The three access types are Standard
Access, API Access, and Tenant Access.

Standard Access
Standard Access allows the Metasys local system user or Active Directory service user to access all
authorized features of the online Site Management Portal (SMP) UI and the SCT. Users who were
assigned Basic Access accounts with previous releases of the SMP UI are converted to Standard
Access user accounts during the archive upgrade process.
Note: If you want to use the Metasys Advanced Reporting System, you must have Standard
Access with the Advanced Reporting privilege.

API Access
With Application Programming Interface (API) Access, users can retrieve information from the
Metasys system network. Use API Access to read and write Metasys system data from a custom
application with the same high level of security as when you access system data through the
SMP UI. To perform a data request using a custom application, you need an API Access account
and the appropriate network and application privileges. The API type access works with public
APIs. However, an API user has limited access capabilities on the Metasys SMP UI and Metasys UI.
Therefore, if you need the full capabilities of either UI, define a Standard Access user.

Tenant Access
Tenant Access allows the local system user or Active Directory service user to access all authorized
features of the Metasys UI. Tenant Access users can log on the Metasys UI, but do not have log on
privileges to the SMP UI.

Authorized Menu Items
Access to particular menu items depends not only on the mode of operation, but also on the
defined System Security and Authorization (Access Control) that provides users with appropriate
levels of access to the Metasys system. Use the Security Administrator System to set Authorization
and System Security.
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In each menu table, a check in the Authorization Required column means you must be authorized
to perform that action for that particular item.

Screen Layout and Frames
The screen contains four frames and provides a consistent look and feel in every mode (online, or
offline). Your access to certain features depends on the mode in which you are operating and your
assigned access type and privileges.
Note: If the navigation frame or a display frame is active, the header bar of the active frame
or pane is highlighted. The Menu and Status frames are not highlighted even when you click in
them.
Figure 4: Site Management Portal (SMP) UI Screen Frames

Table 3: Site Management Portal (SMP) UI Screen Frames
Number

Name

Description

1

Menu

Displays the menu bar and the first three characters of the loggedin user name. Active Directory service user names display as the fully
qualified user name (for example, user@engineering.jci.com).
Logging Out or exit from the system using buttons in the menu frame.

2

Display

Presents data or information in the user-selected Panel Layout. The
top display panel shows information about the Site Director named
jciadx1 (the device is selected in the navigation tree and the name of
the device appears at the top of the Display Panel). The bottom Display
Panel contains a Tailored Summary showing the occupancy schedule for
AHU-1. See the Display Frame Layout section for more information on
the Display Frame.
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Table 3: Site Management Portal (SMP) UI Screen Frames
Number

Name

Description

3

Navigation Displays navigation trees that organize items in the system. The All Items
tree generates automatically when you configure the system database.
You can create one or several user navigation trees (also referred to as
user views) for defining your own navigation concept.
For more information on the navigation tree, see the Navigation Tree
section.

4

Status

Displays information about current user actions and the current time/
time zone of the server that you are logged into (supervisory device
or Site Director). Status bar icons indicate system status. In the screen
above, the status bar indicates that all alarms are snoozed.

Navigation Tree
The navigation frame can display several navigation trees in online mode. The All Items tree is
generated during system configuration and represents the network layout of your system. You can
add additional user-defined navigation trees (also referred to as user views) that provide navigation
capabilities for viewing particular parts of your system.
Note: The Equipment folder and Facility Graphics folder only appear in the All Items tree in
SCT. Equipment objects and Metasys UI graphics are not displayed in SMP.
Note: The navigation trees that appear for a particular user, including the All Items tree, are
defined by the system administrator when the user's access permissions are created.
Navigation trees support standard browsing concepts such as the plus sign (+) for expanding
items in the tree and the minus sign (-) for collapsing or hiding items in the tree. The maximum
number of items that you can nest under an item in the All Items tree is 7. User-defined trees have
no restrictions on the number of nested items.
To see more details on an item in the navigation tree, drag and drop the item or double-click the
item in the navigation tree. The navigation frame also supports scroll bars and both right-click and
left-click options.
You can display user views as either a set of tabs (default) or a drop-down list. This interface
helps with large jobs that have many user views, as the tabs can occupy a large percentage of the
viewable navigation screen area. Configure the default navigation display in the General Display
Settings on the Display Settings Tab of the Metasys Preferences.
Click the Detach icon
to detach the navigation frame. You can minimize and maximize the
navigation frame, but if you click the X button, the frame is restored to its default position.

Items
The Metasys system uses the term item as a generic reference to an object or selection in the
navigation tree. Items in the All Items navigation tree include the site, devices, control systems
(logic), graphics, objects, integrations, schedules, files, trend studies, field points, user-defined
navigation trees, and other system data. Each item can have another item under it, and so on as the
system hierarchy continues. Items have right-click pop-up menus that provide commanding and
viewing options. A symbol represents each item in the navigation tree, and status symbols indicate
the status of each item.

Status Indicators
Status indicators show the status of items in the system on the user interface. For example, these
status indicators appear in the navigation tree, in a column on Summary views, and in a column on
the Global Search Viewer’s Search Results table. Also, a connection status indicator appears on the
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SMP login screen and Main screen to denote the current security level of the certificate. If you place
the cursor over the icon, a tooltip appears to further describe the certificate. The following table
shows examples of the status indicators and the mode in which they may appear.
Note: In Simulation mode, status indicators only appear in the Summary views in the display
frame. The indicators do not appear in the navigation tree in this mode.
Notes:
•

If the items under an item have different states, the parent item displays only the icon for the
state of highest priority of Unreliable Alarm, Alarm, and Warning states. Unreliable Alarm is the
highest priority, followed by Alarm and Warning.

•

In rare instances, a network engine may appear online in the navigation map, but is actually
offline to the Site Director. To confirm the offline status, open the engine's focus window; the
window shows a gray screen with the text Item Not Found. If the engine is offline, the engine
and the Site Director may no longer be paired. See Pair Network Engine with Site Director for
steps on how to force a re-pairing of the devices.

Table 4: Status Indicators
Indicator Indicator
Description

Status

Mode

Red exclamation
point

Alarm: Item (or an item under this item in the
tree) is in an alarm state.

Online

Blue exclamation
point

Warning: Item (or an item under this item in the
tree) is in a warning state or cannot be found on
the network.

Online

Red exclamation
point and red
question mark

Unreliable Alarm: Item (or an item under this
item in the tree) may be in alarm, which is an
unreliable state.

Online

Note: The Unreliable Alarm icon appears when
the alarm state of the object is Unreliable, and
only applies to objects that have alarming defined
through an alarm extension, intrinsic alarming, or
an event enrollment object. If the object’s Reliability attribute causes its Status to be Unreliable,
but the object does not have alarming defined, its
Alarm State is Normal and the icon is not shown.

Red X

Offline: Item is offline

Online

Notes:
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•

Field devices with the Disable Automatic
Alarming attribute set to True display
a red X when they are offline. See the
appropriate object in the Object Help for
details on this attribute.

•

When a SA Bus device, for example, an
IOM or sensor, goes offline, an alarm is
generated and the device is identified in
the Site Management Portal (SMP) UI by
the red exclamation point instead of the
red X.
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Table 4: Status Indicators
Indicator Indicator
Description

Status

Mode

Blue X

Communications Error: Unable to read item
Online
status - error occurred when attempting to retrieve
the item’s current state.

Green arrow

Item has been edited since it was last loaded to the Offline
Engine.

Key with slash
mark

Network engine is not paired with the Site
Director.

Green shield with
check mark

Security level between the client computer and the Online
Metasys Server or network engine is encrypted
Offline
and trusted.

Orange shield
with exclamation
point

Security level between the client computer and the Online
Metasys Server or network engine is encrypted,
Offline
but not trusted.

Red shield with X
symbol

Security level between the client computer and
Online
the Metasys Server or network engine cannot
Offline
be verified because the certificate has expired,
is not valid, or is not present. However, if the
client computer is using Launcher 1.6 and the
Metasys Server or network engine is at Release 8.1,
communication is still encrypted.

Online

User-Defined Navigation Trees
User-defined navigation trees (also referred to as user views, user navigation views, and userdefined trees) allow you to organize items and folders for specific users or functions.

Unlicensed Items Trees
An unlicensed items tree appears and becomes the default tree if your Metasys system contains
unlicensed Metasys Server software. If you license the software and refresh the tabs, the unlicensed
items tree disappears.

Panel Layout
The Display Frame can be divided into up to four display panels. When viewing an item in a display
panel, the name, status, and default attribute (usually the present value) of the item you display
appear at the top of the display panel. Each display panel can contain different tabs, depending
on the item selected from the navigation tree, and each tab shows different information. Dynamic
attributes displayed in a panel automatically refresh when changes are detected.
The default display panel is the first empty panel or last unlocked panel if all displayed panels are
filled. Display panels are locked while in Edit mode, or may be locked using the Lock button of the
selected display panel. If all available panels are locked, you cannot display an additional item in
any of the display panels.
You can resize each display panel by dragging its borders, or using an available splitter bar. With
some items, an Edit button appears (except in Simulation mode), allowing you to edit the item’s
configuration attributes.
You can drag and drop items into a display panel and navigate among them using the Back and
Forward display panel buttons. The display panel holds a maximum history of five items.
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If you run any of the predefined reports found in the Query Menu, the result of the query appears
in an available panel in a spreadsheet format. Sort the report results by clicking the column
heading, and resize columns by dragging column borders. When you scroll down through the
column, the headers remain visible.
The data presented in a report comes from a snapshot of the system at the time you request the
report. The displayed data does not automatically refresh and does not support an Edit mode. You
can manually refresh the report through the Action Menu.

Display Frame Layout
The user interface allows you to define your own display frame layout. Six options are available:
Figure 5: Panel Layout Options

To change the way the panels are arranged, see Changing the Display Panel Layout. If you have a
multi-panel display and you change to a layout with fewer panels, the locked items/newest items
in the view stay, depending on how many panes are available in the new layout. The other panels
close, and they do not reappear if you switch back to the multi-pane view.
To resize the panels, drag the borders of the panel until it reaches the desired size. To make one
panel (in a multi-panel arrangement), take up the entire Display frame temporarily, click the
maximize button. To restore a maximized panel in a multi-pane view, click the restore button. A
panel can also be maximized/restored by double-clicking its header bar.

Display Panel Tabs
Each display panel contains tabs that vary depending on the item displayed.
For example, most of the point objects, such as the OAT contain the following tabs:
Table 5: Tabs
Tab

Description

Alarm

Becomes available when you define an Alarm Extension for a point. The New and
Delete buttons allow you to add or delete Alarm Extensions for the point. The Basic
and Advanced radio buttons allow you to filter the attribute display in this tab. The
Edit button allows you to change configurable attributes.

Focus

Becomes available when you define a point object. The Focus tab shows operation
attributes available for the object type to which the object belongs. Note that the
Basic and Advanced radio buttons allow you to filter the attribute display in this tab.
The Edit button allows you to change configurable attributes.

Hardware

Becomes available when you define a point object that has a reference to a physical
input or output. The Hardware tab shows hardware-related attributes available for
the object type to which the point object belongs.
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Table 5: Tabs
Tab

Description

BACnet
Alarm

Becomes available when you define a BACnet intrinsic alarm for a point. The
Intrinsic Alarming Defined attribute is explained in Trend Extension Attributes
section. The BACnet Alarm tab shows BACnet Alarm-related attributes available for
the object type to which the point object belongs. The Basic and Advanced radio
buttons allow you to filter the attribute display in this tab. The Edit button allows
you to change configurable attributes.

Totalization

Becomes available when you create a Totalizator Extension. New and Delete
buttons allow you to add or delete Totalization Extensions for the point. The Edit
button allows you to change configurable attributes.

Trend

Becomes available when you create a Trend Extension for a point object. New and
Delete buttons allow you to add or delete Trend Extensions for the point. The Chart
view allows you to view data samples in a graphical format and retrieve new trend
data. The Table view of the Trend Extension allows you to view the trend’s data
samples in a table format. The Definition view of the Trend Extension allows you to
view and edit the attributes of the trend extension object.

Averaging

Becomes available when you create an Averaging Extension for a point object. The
New button allows you to add Averaging Extensions for the point.

Load

Becomes available when you create a Load Extension for a point object. The New
button allows you to add Load Extensions for the point.

Other items may contain fewer or more tabs. For example, the item representing a network engine
or Metasys Server contains the following tabs:
•

Focus

•

Summary

•

Diagnostic

•

Communication

•

Network

•

Email (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)

•

Pager (removed from the ADS/ADX at Release 10.1 and later)

•

SNMP (disabled in the ADS/ADX at Release 10.1, but enabled in Metasys UI)

•

Alarm

•

Trend

•

Syslog (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)

• Printer (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)
For information on the tabs available in the system, see the Object and Feature Tabs section.

Display Panel Buttons
Table 6 shows the display panel buttons.
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Table 6: Display Panel Buttons
Button

Description
Allows you to edit attributes for the displayed item. The values you can edit vary
depending on the displayed item. Click Save to save your changes.
Note:

•

This button does not appear in Simulation mode.

•

This button appears dimmed if the user has Standard Access mode,
but does not have Modify Items permission for the object being
viewed.

•

The term edit refers to changing items using the Edit button. See the
Modify section. The term modify refers to changing items using the
Modify menu item and the Modify dialog box. See the Modify Dialog
section.

Displays the content previously displayed in that panel. Each panel can have a
display history of up to five items.
Displays the content of the next panel saved in the history.
Locks the selected display panel (prevents another item from being dropped in
this panel and overwriting it). A locked panel can be resized. This button toggles
between locked and unlocked.
Maximizes the active panel to the full size of the Display Frame. You can
also maximize the pane by double-clicking the header bar. The other panels
reappear if you click the restore button.
Restores the panels to their original size and position. You can also restore the
pane by double-clicking the header bar.
Closes just the currently displayed view in the display panel.
Closes all of the views in the display panel (including views stored in history).
Displays commonly used information about the displayed item.
Displays all the information the system contains pertaining to the displayed
item.

Tailored Summaries
Tailored Summaries appear in the display frame, and allow you to view, command, and modify
large quantities of similar data in a tabular format. Tailored summaries are essentially summary
views of Metasys system items. For more information on this feature, see the Tailored Summaries
section in the Metasys SCT Help (LIT-12011964).

Alarms Window
The Alarms Window (also referred to as Metasys - Events or Alarm Bar) displays the newest,
highest priority alarm message. Only alarms defined in the Fault Ack Required and Normal Ack
Required attributes of the alarm extensions or the BACnet alarm definitions are eligible to appear
in the Alarms Window. In addition, only those alarms for which you have the Manage Item Events
category-based permission appear in the Alarms Window. The alarm message includes the name
of the item in alarm, the current status, date and time when the alarm occurred, alarm priority, the
present value of the item, and a description related to the alarm condition (if applicable). The color
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of the Alarms Window is based on the Alarm’s Priority level and is configured on the Alarm Settings
Tab of the Metasys Preferences.
The number of alarm messages that require acknowledgment appear above the View Item button.
Use the Alarms Window buttons to perform actions related to the displayed alarm message.
For more information on alarms and events, see Alarm and Event Management. When no alarm
messages need acknowledgement (or all alarms are snoozed), the Alarms Window disappears. No
matter which mode the system is in, you can minimize the window and the mode automatically
restores itself if a new alarm occurs.
In an Engine that is not the Site Director, alarm and event messages that are acknowledged or
discarded at the Engine do not appear acknowledged or discarded in the Metasys Server.
To enable or disable the display of the Alarms Window, see Enabling or Disabling Alarm Pop-ups.
To have an audible sound notify users of changes occurring in the Alarms Window, on the Tools
menu, click Administrator, select the Enable Audible Alarm check box, and click OK. However,
a user with administrator rights must use the Security Administrator Tool to set this property
for any Active Directory service users who were added to the Metasys system. Make sure the
Windows operating system audio controls are not muted and the volume is loud enough to hear.
An audible alarm sounds as long as an alarm is detected (if alarms are not snoozed or at least one
unacknowledged alarm is pending for the logged-in user). The alarm sound interval (15 seconds by
default) is configurable from the Preferences dialog box.
The Alarms Window does not appear when you are using the SCT in offline (configuration) mode.
The current navigation view does not limit or affect the Alarm notification, only the user’s
permissions for managing item events can. Therefore, it is possible for a user to receive an alarm
for an item that does not exist in the currently displayed navigation view.

Alarms Window Buttons
The Alarms Window (also referred to as Metasys - Events or Alarm Bar) contains buttons to
acknowledge, snooze, view, and discard alarm messages.
Table 7: Alarms Window Buttons
Button Text

Description

Ack

Acknowledges events and stops the event from appearing on the Alarms
Window.

Snooze

Sends the currently displayed alarm message away for 5 minutes, allowing any
pending next highest events to appear in the Alarms Window. After 5 minutes,
the alarm appears in the Alarms Window again (if it is the highest priority event).
To change the amount of time the Alarms Window snoozes, see Engine Device
Object.

Snooze All

Puts the entire Alarms Window to sleep for 5 minutes. For the next 5 minutes,
the Alarms Window disappears, even if high priority alarms or events occur.
To change the amount of time the Alarms Window snoozes, see Engine Device
Object.

View Item

Shows the Focus tab of the object in alarm in the Display Frame.

View Graphic

Displays the graphic associated with the alarm extension of the item in alarm
in the available display frame. This button appears only if a graphic has been
defined for the object.

Discard

Deletes the alarm with acknowledgment.

Minimize

Minimizes the Alarms Window to the Windows task bar. If a new alarm occurs,
the Alarms Window appears again as the top window.
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For more information on alarm and event management, see the Alarm and Event Management
section.

Status Bar Icons
Icons in the Status bar indicate system activity (Table 8).
Table 8: Status Bar Icons/Text
Icon/
Text

Description
This icon appears if the Metasys software is sending or receiving view data to or from
the Metasys Server or Engine.
This icon appears when diagnostic information for the Metasys system user interface is
available. If you click this icon, the User Interface Diagnostics window appears.
This icon appears white if no events are currently in the Alarms Window. When this icon
is flashing red, the Alarms Window contains events. If you click the icon, the Alarms
Window appears in front of the other windows. A dashed box appears around this
icon when the alarm pop-ups are disabled. If you click the icon, alarm pop-ups are
automatically re-enabled, and the Alarms Window appears if applicable.

Time
Zone/
Date/
Time

The status bar of the Site Management Portal (SMP) UI displays the date, time, and
time zone of the device to which you are logged in. Due to the time it takes to retrieve
the time from the device, the status bar time may lag slightly behind the device’s
actual time. If the device reports an unsupported time zone, the SMP UI defaults to
Coordinated Universal Time (UTC).

User Interface Diagnostics Window
The User Interface Diagnostics window reports conditions within the system that may affect the
operation of the user interface, but which require no immediate user acknowledgment or action.
When the Metasys system logs a diagnostic message to the UI Diagnostics window, it includes
the time when the condition was detected. Diagnostic messages are logged to the UI Diagnostics
window for various reasons, including the following:
•

An attempt to connect to a device on the Metasys network failed.

•

The device you are logged into is temporarily busy and cannot provide updated data.

•

The data provided by the device is in an invalid format such as non-XML.

• An unexpected event occurred in the user interface.
When the system detects any of the preceding conditions, a new diagnostic message appears at
the bottom of the message list. Whenever the UI Diagnostics window is open (even if cleared), an
icon appears in the status bar. When the user clicks the UI Diagnostics icon, the UI Diagnostics
window moves to the front of all other windows. If the UI Diagnostics window is closed, it opens
automatically when a new diagnostics message is logged. Click Clear to clear the window contents
without closing the window.
Click Close to close the window.

Viewing Item Data
Item data is the information associated with an item such as the attributes of an object. Access the
information associated with an item by viewing it in a display frame. See the Displaying Information
About an Item section for more information.

Reports
Use the predefined report feature to query a single network engine, multiple network engines, or
the entire site (all network engines on the site) for alarm, offline, disabled, override, trouble, and
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out of service conditions. To generate a report, select one or multiple network engines or the site in
the navigation tree and select a report from the Query Menu. The query executes for the selected
network engines or site. When you select multiple network engines or the site in the navigation
tree, the report feature queries each supervisory device and combines the results in one report.
These predefined reports (alarm, offline, disabled, override, trouble, and out of service) are
different from the Scheduled Reports option available in the Query menu. For information on
scheduled reports, see the Scheduled Reports section. For information on the Global Search and
Object List options, see the Global Search section.
The query produces a report in the display panel. The report shows the time the query was
initiated, the report status, and the report results. The stop button allows you to cancel a running
query at any time. The Copy button allows you to copy the report content to the clipboard.
The following figure shows an example of an Offline Report. See the Running Reports topic for
information on how to run a query.
Figure 6: Offline Report Screen

Table 9 describes the information provided by each report.
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Table 9: Report Types and Descriptions
Report

Description

Alarm

Lists all items in alarm state in the selected site or devices.
For each item in alarm state, the report displays the item type icon, item name,
item description, alarm type, and the value of the item when it entered alarm
state.

Offline

Lists all items in offline state in the selected site or devices.
For each offline item, the report displays the item type icon, item name, and
item description.

Disabled

Lists all disabled items in the selected site or devices.
For each disabled item, the report displays the item type icon, item name, and
item description.

Dormant User
Account

Lists all user accounts for the system by supervisory device. This applies to
Local Metasys User accounts and Active Directory accounts.
For each account, the device name, account name, user name, role, account
type, last successful login, days since last login, status, is dormant, days
dormant, and dormant event sent are displayed.
Distinguishes among accounts that have not attempted access in previous x
number of days, accounts that have never been used, and accounts that have
never successfully accessed the Metasys device, additionally showing which of
these accounts are disabled.
Note: Any devices that are not responding or are at a release prior to 8.0 are not
included in the report and are noted at the bottom of the report dialog box.

Operator
Override

Lists all items currently overridden by the operator.
For each overridden item, the report displays the item type icon, item name,
status, item description, and the current value of the item. See the status
column to determine whether an operator overridden item should be released.

Out of Service

Lists all items that have the Out of Service attribute set to True.
For each out of service item, the report displays the item type icon, item
name, and item description. All BACnet point objects have this property (for all
integrations) as well as the BACnet Loop, Program, and Schedule objects.

Supervisory
Override

Lists all items currently overridden by the supervisory device.
For each overridden item, the report displays the item type icon, item name,
status, item description, and the current value of the item. See the status
column to determine whether a supervisory overridden item should be
released.

Trouble

Lists all items that have the Trouble attribute set to True.
For each item in trouble state, the report displays the item type icon, item
name, and item description. Usually, Binary Input and Binary Output points
have this property. It is mostly used in Fire and Security applications but may
be used when the Binary Output command does not match the feedback. (The
Binary Input feature is integration dependent.)

Commands
Use commands to force an item to perform a specific action. For example, ON and OFF commands
for a binary output make a fan run or stop, and the Enable and Disable commands in the Trend
extension start and stop the collection of samples.
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For information on which commands an item supports, see the appropriate topic in the Object
Help.
For information on how to send a command to a single item, see Commanding an Item in the
Commands Dialog section.
For information on sending a command to multiple items, see Commanding Multiple Items (Global
Command) in the Commands Dialog section.

Temporary Override
Temporary Override allows the operator to override a point for a specified time. After the specified
time period passes, the Override is automatically released. The Temporary Override command
supports N2, LON, and VND integration objects.
Figure 7: Temporary Override Command Window

Note: The command duration can range from 1 minute to 100 hours, 59 minutes.
Table 10: Temporary Override Supported Objects
Local

BACnet

MSTP

N2

LON

VND

AV

AO

AO

AO

AO

AO

BV

BO

BO

BO

BO

BO

MSV

AV

AV

MSO

MSO

BV

BV

MSO

MSV

MSO

MSV

Temporary Out of Service
Temporary Out of Service commands allow the operator to take an object temporarily out of
service. After the specified time period passes, the Out of Service is automatically released. The
Temporary Out of Service commands support N2, LON, and VND integration objects.
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Figure 8: Temporary Out of Service Command Window

Note: The command duration can range from 1 minute to 100 hours, 59 minutes.
Table 11: Temporary Out of Service Supported Objects
BACnet

MSTP

N2

LON

VND

AI

AI

AI

AI

AI

BI

BI

BI

BI

BI

MSI

MSI

MSI

MSI

Drag and Drop
You can drag items into various content areas of the SMP. The following table summarizes the
source items and their destinations.
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Table 12: Drag and Drop
Source Location
Navigation Trees
All Items Tree, All
Items Tree - Expert,
Unlicensed Item Tree,
User Views

Types of Items Valid for Destination
To Drop To
•

Attribute Reference field: fully
qualified reference

•

Global Search – Search Locations:
Various

•

Global Search – Search Results:
Various

Notes
If the view has an edit mode,
the view must be in edit mode
in order to drag an item into a
field.

Note: Dragging an item in to the
search Results table adds the
item to the table. You can then
save the results as an Object List
for scheduled reports.

Global Search Viewer

•

Interlock Object

•

Interlock Object Action Tables

•

Interlock Definition Table

•

List of Attribute Reference field:
fully qualified reference

•

List of Object Reference field: fully
qualified reference

•

Multiple Command Object (MCO)
Action Tables: Various

•

Object Reference field: fully
qualified reference

•

Search Locations field: Various
Note: Dragging an item in to
the search locations field adds
the item to the locations for the
search query.

•

Search Results table: Various
Note: Dragging an item in to
the search Results table adds
the item. You can then save
the results as an Object List for
scheduled reports.

•

Tailored Summary Viewer: Global
Search Results Object

Pop-up Menus
Pop-up menus provide an efficient way to quickly access important item information. Pop-up
menus are also referred to as right-click menus. To access pop-up menus, right-click an item in
the Navigation Tree. Content of the menu depends on the type of selected item and your level of
authorization. For example, point object pop-up menus usually show the options View, Command,
Modify, and Show Extensions. For Engines, pop-up menus usually show View, Event Viewer, Audit
Viewer, Command, Modify, Show Extensions, Alarm Report, Offline Report, Disabled Report,
Operator Override Report, Supervisory Override Report, Trouble Report, Out of Service Report, and
Remove from Site.
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Timed Inactivity Logout
Timed logout automatically logs you out of the Metasys system after a predefined time of inactivity.
The system closes open databases, discards unsaved changes and view settings, and logs out the
user. Users who logged in with a Metasys user name and users who were automatically logged in
using Active Directory service, see the login screen at timed logout. If this system has the Warning
Banner option selected, the custom warning banner screen appears at timed logout.
If you are an Active Directory service user and want to access the Metasys system again through
automatic login, close the login screen and navigate to the Metasys URL. Otherwise, you can enter
your Active Directory service user name and password and select your Active Directory service
domain at the login screen to regain access to the Metasys system. Use the Security Administrator
System to set this and other security features.
When the Warning Banner screen appears at timed logout, you must click OK to consent to the
statement before returning to the login screen. The login screen waits 30 seconds for you to enter
your credentials. If 30 seconds pass with no login activity, the login screen clears and the Warning
Banner screen returns.

Electronic Signatures and Annotations for MVE Only
MVE sites have settings in the Site Object for enabling annotation and electronic signature
functionality. You can set the MVE site to require only annotations, only electronic signatures, both
annotations and signatures, or neither annotations nor signatures. Non-MVE sites may optionally
define and use annotations; however, electronic signatures are specific to MVE sites.
When enabled, electronic signatures challenge users whenever they attempt to make a change to
the system. Before the system performs the user’s request, they must supply a signature and state
a reason for the change. The mechanism the Metasys system uses for expressing that signature is
a reauthentication challenge, in which users must reenter the password they used to log in to the
Metasys system using either their Metasys password or their Active Directory service password.
This process is recognized as an electronic signature.
In addition to collecting the electronic signature, the Metasys system may also require the user
to enter or select an annotation. Annotations are statements that further describe the change
being requested. After the password is verified and an annotation is selected, the user request is
performed.
You can configure electronic signatures and annotations at the device and object levels. You cannot
delete annotations on an MVE site. For information on enabling these settings, see Configuring
Annotation and Electronic Signature Requirements in the Site Object in MVE. For additional
information, refer to the Metasys for Validated Environments, Extended Architecture Technical Bulletin
(LIT-12011327).

Site Management Portal User Interface Steps
Changing the Display Panel Layout
To change the Display Panel layout, on the View menu, select Panel Layout and choose one of the
six layouts.

Acknowledging, Snoozing, and Discarding Events
To acknowledge, snooze, and discard events, click the appropriate button on the Alarms Window
(also referred to as Metasys - Events or Alarm Bar).
Notes:
•

You also can view the item or associated graphic.

•

You also may use the Event Viewer to view and take action on events. See Alarm and Event
Management for more information about the Alarm and Event feature.
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Enabling or Disabling Alarm Pop-ups
The Alarms Window is also referred to as Metasys - Events or Alarm Bar.
To enable the alarm pop-ups feature of the Alarms Window, on the View menu, select the Enable
Alarm Pop-Ups check box.
To disable the alarm pop-up windows feature of the Alarms Window, on the View menu, remove
the selection from the Enable Alarm Pop-Ups check box.
Notes:
•

You can perform this task only if you have permission to disable the alarm pop-ups
feature.

•

A dashed box appears around the alarm status bar icon when the alarm pop-up windows
are disabled. If you click the icon, alarm pop-ups are automatically re-enabled, and the
Alarms Window appears if applicable.

•

By default, alarm pop-up windows are enabled every time you log into the system.
However, if you want to disable the Alarm Window from appearing every time you log in,
set the Enable alarm pop-ups on login attribute to False. This setting is located under
Tools > Configure Preferences > Display Settings tab, User Preferences section. You can
perform this task only if you have permission to change User Preferences. For more
information, see Display Settings Tab.

Running Reports
About this task:
Follow the steps in this procedure to run one of the predefined reports (alarm, offline, disabled,
operator override, supervisory override, trouble, and out of service). To schedule a report on a
Metasys Server, see Creating a New Scheduled Report in the Scheduled Reports section.
To run a report:
1.
2.

Select the single supervisory device (Engine or Metasys Server), multiple supervisory devices,
or the entire site in the navigation tree that you want to query.
On the menu bar, click Query and select the type of report you want to run (Alarm Report,
Offline Report, Disabled Report, Dormant User Account Report, Operator Override Report,
Supervisory Override Report, Trouble Report, or Out of Service Report). The Report Viewer
appears in the default display panel.
Note: If you did not select a supervisory device or site, a message box appears. Click OK,
select a supervisory device or site, and repeat step 2.

3.

View the results of the report.

Print
1.

Select the navigation tree or display panel you wish to print.
Note: You must select either the navigation tree or a display panel to enable Print. If you
selected a display panel, the entire contents of the visible display panel prints out. If you
selected the navigation tree, all visible parts of the tree print out (even parts of the tree
that you need to scroll to view). Collapsed parts of the tree (not visible in the tree) do not
print. You cannot print the contents of the Alarms Window.

2.
3.
4.
44

Select Page Setup from the Item menu if you wish to change the paper, orientation, or
margin size. Click OK when done.
Select Print Preview from the Item menu to see what the printout looks like. Click Print or
click OK.
On the Item menu, select Print.
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Note: If the panel you selected is not printable, Print is disabled.

Configuring Annotation and Electronic Signature Requirements in the Site Object
in MVE
For sites with MVE installed, configure the following attributes in the Site Object for MVE
annotations and electronic signatures:
•

Annotation Include

•

Annotation Exclude

•

Annotation Alarm Priority Threshold

•

Signature Include

•

Signature Exclude

• Signature Alarm Priority Threshold
These settings appear only on MVE sites. See the Site Object section for details on these attributes.
You can require annotations, electronic signatures, both, or neither on an MVE site. Non-MVE sites
may optionally define and use annotations; however, electronic signatures are specific to MVE
sites. For information on annotation and electronic signature preferences, see Annotation Settings
Tab and Electronic Signature Settings Tab in the Preferences section. Also see Audit Message
Annotations in Audit Trail for information on the fields in an annotation.
For additional information, refer to the Metasys for Validated Environments, Extended Architecture
Technical Bulletin (LIT-12011327).

Working with Items
In addition to the procedures in this section, see also Creating items and Exiting.

Navigating to an Item
To navigate to and select an item, click the plus (+) and minus (-) signs in the Navigation Tree to
expand and collapse folders until the desired item appears on the tree.
Note: Use the Ctrl or Shift key to select multiple items.
Note: For information about how to display information about the item, see the Displaying
Information About an Item section.

Displaying Information About an Item
To display information about an item you selected in the navigation tree:
Do one of the following and click the desired tab:
•

Drag and drop the item from the navigation tree into a display panel.

•

Select an item in the navigation tree, open the View Menu, and click Selected Item. The data
displays in the default display frame.

•

Double-click the item in the navigation tree; it displays in the default display panel.

•

Right-click an item in the navigation tree or a feature in the display panel (such as Global
Search or a Tailored Summary) and select View.
Notes:
•

When you display information in a panel that already contains data, the older data is
replaced and added to the panel history. To access up to five previously displayed items in
the panel history, click the back button in the display panel.
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•

If all available panels are locked and you try to display information about an item, a
message appears stating that all panels are locked. Click OK and unlock a panel to display
other item information.

Modify
About this task:
The term modify refers to changing items using the Modify menu item and the Modify dialog box.
See the Modify Dialog section.
To edit the attributes of an item:
1.
2.

View the details of the item in a display panel.
Select an item tab (for example, Focus).
Note: Some items contain an Advanced radio button. If you select this button, additional
attributes appear.

3.
4.

Click Edit.
Edit the attributes as needed.
Note: If you place your cursor over an edit field, the ToolTip provides information about
the valid format or range for that value. ToolTips also appear for strings.

5.

Click Save.
For information on using the Modify dialog box to modify single or multiple items, see the
Modify Dialog section.

Commanding Items
To send a command to an item in a graphic, see the User Graphics Tool (UGT) section.
To send a command to a single item, see Commanding an Item in the Commands Dialog section.
To send a command to multiple items, see Commanding Multiple Items (Global Command) in the
Commands Dialog section.

Annotating Objects/Items
About this task:
This feature allows you to enter follow-up comments for actions taken on this object or item, such
as what the user did to fix a problem, what was fixed, or when an override was released.
To annotate objects/items:
1.

Select the object/item to annotate in the navigation tree (All Items or User view).
Note: You cannot add an annotation for a folder.

2.

On the Action menu, select Add Annotation.

3.

Select or type annotation text. Annotation text can be from 1 to 255 characters.
Note: The Predefined Annotations List on the Add Annotation dialog box contains
annotations saved in your system preferences. If you have not defined annotations in
your system preferences, the drop-down list is empty.

4.

Click OK to save the annotation.
See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE.

Viewing Annotations for Objects/Items
1.

Select the object/item to view in the navigation tree (All Items or User view).
Note: Folders cannot have annotations.
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2.

On the Action menu, select View Annotations.
See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE.

Deleting Objects or Items
About this task:
To delete objects or items:
1.
2.

Select the object or item you want to delete in the All Items tree. This option is not available in
user views.
On the Edit menu, select Delete Items.
Notes:
- You cannot select an object or item in the display frame and delete it from the system.
You can only delete objects or items by selecting them in the navigation tree.
- After deleting objects or items in the online mode, perform an upload to store the
updated system configuration in the archive. Perform a download of your site to verify
that the changes are visible online.
- After deleting objects or items in SCT, perform a download to update the online
configuration of the device.

Logging Out
Save your changes before you log out. Logging out closes the Alarms window and all other open
windows except the login screen and Help. If your system is configured with a timed logout, the
system times out after a specific period of inactivity. For more information on exiting, see Exiting.
To log out, click the Logout button in the menu bar.
If you are an Active Directory service user who accessed the Metasys system by using an automatic
login and want to access the Metasys system again in the same manner, close the login screen
and navigate to the Metasys URL. Alternatively, you can regain access to the Metasys system by
entering your Active Directory service user name and password and selecting your Active Directory
service domain at the login screen.
Note: If you are editing an item in a display panel, the Metasys software cancels the logout
process and notifies you that you cannot exit or log out while in Edit mode. You must exit Edit
mode by saving or canceling your changes before you can log out of the application.

Exiting
Save changes before exiting. Exiting closes all open windows (except the Help) associated with the
session, including the Alarms Window and login screen. For more information on logging out, see
the Logging Out topic.
To exit, click the Exit button in the menu bar.
Note: If you are currently editing an item in a display panel, the Metasys software cancels the
exit process and notifies you that you cannot exit or log out while in Edit mode. You must exit
Edit mode by saving or canceling your changes before you can exit the application.

Working in the SMP UI
Objects in the SMP user interface are now easily searchable in the navigation trees through the
Locate in Tree feature. The Locate in Tree feature displays the expanded Equipment, Spaces, or All
Items tree location for an object selected from the focus window.
To use this search feature, right-click one of the following object name locations and select Locate
in Tree:
•

Global Search table rows
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•

An object's Summary tab table rows

•

An object's Focus window title bar

Figure 9: Locate in Tree Option

Note: Locate in Tree search feature is not compatible with User Views and the Unlicensed Item
trees.

Wizards
Wizards make complex tasks easy and guide you through creating and configuring objects and
features. A wizard typically consists of a series of steps, each corresponding to a screen presented
to the user.
A wizard may appear when you select an option from the Insert menu and when you prompt
certain actions such as copying and pasting an item in the Navigation Tree. For example, a wizard
appears when you select Object from the Insert menu. Wizards that are available in different
modes (for example, any combination of online or offline) appear the same.

Wizards Concepts
Types of Wizards
The following table lists the wizards in the system.
Table 13: Types of Wizards
Integration

Global Data Object

Program Object

Group Object

Analog Value Object

Interlock
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Table 13: Types of Wizards
Accumulator Object

Loop Object

Auto Shutdown Object

Multistate Value Object

Binary Value Object

Multiple Command Object

Calendar Object

Notification Class Object

Demand Limiting/Load Rolling (DLLR) Object

Optimal Start Object

Data Broadcast Object

Pulse Meter Object

Electric Demand Control Object

Schedule Object

Electric Demand Monitoring Object

Signal Select Object

Field Device

Solar Clock Object

Field Point

Graphic

Folder

New User View

Event Enrollment Object

Summary Definition Wizard

Generator Load Control Object

Passthru Wizard

Wizard Navigation Buttons
The buttons in Table 14 are common to most of the wizards and allow you to move through wizard
screens.
Table 14: Common Wizard Navigation Buttons
Button

Description

Cancel

Closes the wizard without saving any data. This button is always active.

< Back

Takes you back one screen in the wizard. This may not be the last screen viewed, since
you can move between screens. This button is active on all screens except the first.

Next >

Takes you to the next screen in the wizard. If the current screen requires user input or
you are on the last screen in the wizard, the Next button is disabled.

Last

If available, presents a summary screen for the wizard. If your input is required in any
previous screen, the Last button is disabled. The Last button takes the user to the last
wizard screen, which is the summary screen. Once the summary screen is displayed,
the Last button is replaced by the Finish button.

Finish

Exits the wizard and saves the data. Selecting Finish is the normal method of exiting
a completed wizard. If any prior screens require your input, this button is disabled. If
a wizard has a summary screen, the Finish button is not available until the summary
screen is displayed.

Wizards Steps
Using Wizards
Browse the following Menu Topic chapters for more information on using wizards, including:
•

selections for accessing each wizard

•

descriptions

•

tips

•

related information
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Creating Items with Wizards
About this task:
1.

Select the item to create. The corresponding wizard appears. If more than one type of item is
available, select the desired type. Click Next.
- Select Action menu > Show Extensions to launch the Extension Wizard to create
extensions to objects that support them.
- Select Insert menu > Integration, Field Device, Field Point, Folder, Control System,
Object, Graphic, Trend Study, User View, or Summary Definition to launch their
respective wizards.

2.

Complete the information on the wizard screens, using the navigation buttons to move
through the screens. The screens vary depending on the item you are creating. See the Using
Wizards section for information specific to each wizard.
Note: All items appear in the wizard, not just valid destinations. When you click an item
that is not a valid destination for the item being added, an error message appears on the
right side of the wizard and the Next button is disabled.

3.

Select Finish on the summary page to create the item. If an error occurs, a message displays
and the wizard returns to the summary page. If the item supports extensions, the Extension
Wizard displays after the item is successfully created.

Item Menu
The Item menu functions are used to select views to print. Three options are available: Page Setup,
Print Preview, and Print (Ctrl P).

Page Setup
1.

Select the navigation tree or display panel you wish to print.
Note: You must select either the navigation tree or a display panel to enable Print. If you
selected a display panel, the entire contents of the visible display panel prints out. If you
selected the navigation tree, all visible parts of the tree print out (even parts of the tree
that you need to scroll to view). Collapsed parts of the tree (not visible in the tree) do not
print. You cannot print the contents of the Alarms Window.

2.

Select Page Setup from the Item menu if you wish to change the paper, orientation, or
margin size. Click OK when done.

Print Preview
1.

Select the navigation tree or display panel you wish to print.
Note: You must select either the navigation tree or a display panel to enable Print. If you
selected a display panel, the entire contents of the visible display panel prints out. If you
selected the navigation tree, all visible parts of the tree print out (even parts of the tree
that you need to scroll to view). Collapsed parts of the tree (not visible in the tree) do not
print. You cannot print the contents of the Alarms Window.

2.
3.
4.
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Select Page Setup from the Item menu if you wish to change the paper, orientation, or
margin size. Click OK when done.
Select Print Preview from the Item menu to see what the printout looks like.
Click Print or click OK.
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Print
1.

Select the navigation tree or display panel you wish to print.
Note: You must select either the navigation tree or a display panel to enable Print. If you
selected a display panel, the entire contents of the visible display panel prints out. If you
selected the navigation tree, all visible parts of the tree print out (even parts of the tree
that you need to scroll to view). Collapsed parts of the tree (not visible in the tree) do not
print. You cannot print the contents of the Alarms Window.

2.
3.
4.

Select Page Setup from the Item menu if you wish to change the paper, orientation, or
margin size. Click OK when done.
Select Print Preview from the Item menu to see what the printout looks like. Click Print or
click OK.
On the Item menu, select Print.
Note: If the panel you selected is not printable, Print is disabled.

Edit Menu
The Edit menu is used to delete objects from your All Items tree.

Delete Items
Menu Selection: Edit > Delete Items
Deletes one or more items selected in the All Items tree from the site.
Note: The Edit menu or Right-click > Delete functions are not used to delete items from a User
View while the User View Editor is open. Using either function permanently deletes selected
items from the archive.
For details on deleting items, see Deleting Objects or Items.

Deleting Objects or Items
About this task:
To delete objects or items:
1.
2.

Select the object or item you want to delete in the All Items tree. This option is not available in
user views.
On the Edit menu, select Delete Items.
Notes:
- You cannot select an object or item in the display frame and delete it from the system.
You can only delete objects or items by selecting them in the navigation tree.
- After deleting objects or items in the online mode, perform an upload to store the
updated system configuration in the archive. Perform a download of your site to verify
that the changes are visible online.
- After deleting objects or items in SCT, perform a download to update the online
configuration of the device.

View Menu
Click the menu item in the following table for its description.
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Table 15: SMP View Menu
Menu Item
Selected Item

Event Viewer

Trend Viewer

Audit Viewer

Tailored Summary Validation Labels/ Panel Layout
11
Viewer
Settings
Scheduled
Reports

Extended Labels

Enable Alarm PopUps

Single Panel

22

Change Results
Viewer

Two Panel
Horizontal
Two Panel Vertical
Three Panel
Horizontal
Three Panel
Vertical
Four Panel

1
2

This selection is Validation Labels in the SMP UI (MVE only) and Validation Settings in the SCT UI.
Available on the Metasys Server only.

Launching the Event Viewer
1.

Select Event Viewer from the View menu.
Note: If you do not have an Engine or Metasys Server selected or if you have multiple
items selected, a Device Selection dialog box appears.

2.
3.

Select the device containing the event repositories with the event messages that you want to
display in the Event Viewer.
Click OK. The Event Viewer appears in the display frame and displays the event messages
from the event repository of the selected device. See Event Viewer and Event Messages for
details.
Note: Alternatively, you can right-click the desired device in the navigation frame and
select Event Viewer from the menu that appears.

Event Viewer and Event Messages
The Event Viewer displays the event messages from the event repository of the currently selected
device in your system and allows you to acknowledge and discard the event messages. See
Launching the Event Viewer.
Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and event
messages do not appear acknowledged or discarded in the Metasys Server.
You can only view the event messages from one event repository of one device at a time. The
window displays 1,000 messages per page.
If you are viewing the contents of a local Engine event repository, the event messages shown come
from that Engine only.
If you are viewing the contents of a local Engine event repository of an Engine device designated as
the Site Director, the event messages shown come from that Engine local event repository only.
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If you are viewing the contents of a Metasys Server event repository, the event messages shown
come from that Metasys Server event repository only. A Metasys Server event repository may
contain event messages that have been routed from other Engine or Metasys Server devices but
does not display the contents of multiple repositories.
Note: You can define an event repository as a Default Destination so it receives event
messages from other event repositories. You can forward event messages from one Metasys
Server event repository to other Metasys Server event repositories. See ADS Event Message
Forwarding.
When viewing a Metasys Server, the system applies a standard filter to the Event Viewer when it is
first opened. This filter allows you to see all events that you have permission to view.
You can use custom filters when viewing the Metasys Server to narrow the list of events to only
those that meet specific criteria. Custom filters query the entire Metasys Server database, not
just the list of events that appears on the screen. You can filter events by any combination of
Date/Time, Priority Range, Alarm Type, Authorization Category, Requires Acknowledgment, User,
Acknowledged, and/or Discarded. New events appear in the list only if they meet all criteria
specified in the filter. You cannot save custom filters.
You can print the event messages displayed in the Event Viewer at any printer connected to the
computer running the web-based Metasys user interface. For information on how to do this, see
Printing the Event Messages Displayed in the Event Viewer.
For information on the Alarms Window, see Alarms Window.
The following table describes the format of the event message (and corresponding buttons and
fields) as displayed in the Event Viewer.
Table 16: Event Message Format
Item/
Column

Description

Selected
device
(Engines
only)

Indicates the device for which the Event Viewer is displayed. The device name
appears on the left side of the Event Viewer above the table only for Engine
devices.
This field corresponds to the selection made in the Device Selection Dialog box.
See Launching the Event Viewer.

Event Count
(Engines
only)

Indicates the number of event messages that currently appear in the Event Viewer.
The Event Count appears on the right side of the Event Viewer above the table only
for Engine devices.

Standard
Filter radio
button
(Metasys
Server only)

Indicates that standard filtering is applied to the Event Viewer for the selected
Metasys Server. This filter information appears on the right side of the Event
Viewer above the table. The count of entries that apply to this filter appears in
parentheses next to the radio button.

Custom Filter
radio button
(Metasys
Server only)

Indicates that custom filtering is applied to the Event Viewer for the selected
Metasys Server. This filter information appears on the right side of the Event
Viewer above the table. The count of entries that apply to this filter appears in
parentheses next to the radio button.
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Table 16: Event Message Format
Item/
Column

Description

Custom
Filter table
(Metasys
Server only)

Allows you to apply custom filtering to the Event Viewer when the Custom Filter
radio button is selected. This table appears but is not active when the Standard
Filter radio button is selected. You may need to adjust the slider bar to show the
Custom Filter table.
The buttons for this table are:
•

Add - adds a filter using the Add Filter dialog box

•

Remove - removes the selected filter

•

Apply - queries the Metasys Server database and displays the resultant event
messages
See Creating a Custom Filter for the Event Viewer (Metasys Server Only).
Status icons

Displays an icon indicating the status of the event message:
- event message is new (that is, the message has occurred in the system within
the new entry timeframe)
Note: See Display Settings Tab in the Preferences section for information on changing the amount of time event messages are considered new using the New entry timeframe preference (default value = 15 minutes).

- event message does not require acknowledgment. A red X through this icon
indicates that the message has been discarded.
- event message requires acknowledgment. A red X through this icon indicates
that the message has been discarded.
- event message has one annotation
- event message has more than one annotation
- event message has an associated graphic
- event message has an electronic signature
Type

Displays the status of the item associated with the event message:
•

Normal

•

Low Warning/High Warning/Warning

•

Low Alarm/High Alarm/Alarm

•

Trouble

•

Status

•

Offline

•

Unreliable

•

[Blank] - none of the above status types apply.

Priority

Indicates the priority of the event. See Event Priority. A lower priority number
indicates event messages of higher importance.

When

Displays the date and time that the event message was generated. The date and
time format is defined by the Language selected in the User Profile (User Profile
tab of the Security Administrator System).
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Table 16: Event Message Format
Item/
Column

Description

Item

Displays the Name of the item that generated the event message. An item name
is the label displayed for the selected item in the All Items navigation tree (for
example, AV1, NAE2, or Schedule1). Be sure you define relatively unique item
names if you plan to use printed lists of the event messages of the Event Viewer.

Value

Displays the Present Value and engineering units, if applicable, of the associated
item at the time the event message was generated.

Description

Displays the text defined by the Description attribute for the item that generated
the event message. Be sure you define relatively unique descriptions if you plan to
use printed lists of the event messages of the Event Viewer.

Alarm
Displays the text defined by the Alarm Message Text attribute of the alarm
Message Text extension for the state of the item associated with the event message, if
applicable.
Specifies the column of data used to sort the event messages currently displayed
in the Event Viewer (ascending or descending order).
Paging
Controls
(Metasys
Server only)

Allows you to navigate through the pages of event messages in the Event Viewer.
Use the buttons to go to the first page, previous page, next page, or last page.
Type a page number in the text box and press the enter key to jump directly to a
specific page.

Ack button

Acknowledges the selected event messages. See Acknowledging Event Messages.

Discard
button

Removes the selected event messages from the Event Viewer. See Discarding Event
Messages.
Note: In an Engine that is not the Site Director, acknowledged or discarded alarm and
event messages do not appear acknowledged or discarded in the Metasys Server.

Copy button

Copies the selected events to the Clipboard for pasting into other applications such
as Microsoft Excel or Word.
If nothing is selected in the Event Viewer when you click this button, all entries
copy to the Clipboard. You can also use Ctrl+A to select all and Ctrl+C to copy to
Clipboard.

Alarm and Event Management
The alarm and event feature provides event management for the Metasys system. This feature
allows you to configure the detection of alarm conditions and the routing of event messages to
destinations such as an email account or pager for acknowledgment. The Alarms Window displays
event messages in a prioritized order and allows you to respond to the alarms. The Event Viewer
provides the functionality to retrieve and examine event messages stored in an event repository.
For information on alarm and event management for Metasys systems integrated with BACnet
devices, see the Alarm and Event Management for Metasys Systems Integrated with BACnet
Devices topics.
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Alarm and Event Management Concepts
Alarm and Event Management Overview
An event is a notification of a state change of an item in the system. When a value in an FAC, Engine,
or Metasys Server deviates from its normal operating condition, such as exceeding a high limit or
failing to respond to a command within a specified time period, the system detects a change of
state and the FAC, Engine, or Metasys Server generates an event message.
When an FAC generates an event message, it temporarily stores the event message in its Event
Log. It also immediately forwards the event message to the Engine or configured Metasys Server
to which it is connected. When an Engine generates an event message, it temporarily stores the
message in its local event repository. When a Metasys Server generates an event message, it
permanently stores the message in its event repository. You can send event messages stored in
the local event repository of an Engine to the event repository of a Metasys Server for permanent
storage by defining a Metasys Server event repository as the default destination. Also, you can
route event messages to other destinations such as a pager or an email account. For more
information, see the Event Repositories and Event Message Routing, Filtering, and Destinations
sections.
For sites with Metasys for Validated Environments Installed (MVE) installed, configure the following
attributes in the Site Object:
•

Annotation Include

•

Annotation Exclude

•

Annotation Alarm Priority Threshold

•

Signature Include

•

Signature Exclude

• Signature Alarm Priority Threshold
These settings apply only to MVE sites and enable the MVE required annotations and electronic
signature for event messages. You can apply these settings at the site level or down to the object
level as needed. You can define the settings to require an electronic signature, an annotation,
neither, or both. When both options are required and a user acknowledges or discards an event
message, they are prompted to reauthenticate and enter a reason and annotation for the action.
The user’s login name, date and time of signature, and the reason for signature are saved as part
of the annotation. You cannot delete annotations on an MVE site.
Non-MVE sites may optionally define and use annotations; however, electronic signatures are
specific to MVE sites.
See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE in the
Site Management Portal User Interface section. For additional information, refer to the Metasys for
Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).
The Alarms Window and Event Viewer allow you to examine and respond to event messages. The
Alarms Window displays event messages one at a time in a prioritized order and allows you to
respond to the newest alarm first. The Event Viewer displays all of the event messages stored in the
event repository of the currently selected device. In addition, Alarm Reports allow you to query for
alarm conditions in the Metasys system online and provide a list of items that are currently in an
alarm condition.
Note: The current navigation view does not limit or affect the alarm notification; only the
user’s permissions for managing item events can. Therefore, a user may receive an alarm for
an item that does not exist in the currently displayed navigation view.
The following figure shows the flow of event messages through the Metasys system.
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Figure 10: Event Message Flow

For information on how to configure and route event messages for Metasys systems integrated
with BACnet devices, see Alarm and Event Management for Metasys Systems Integrated with
BACnet Devices.

Alarm Extensions
Using object alarm extension is a very easy method for configuring the detection of alarm
conditions. To configure the values that determine alarm condition detection, use the Alarm
Extension Wizard that appears after creating an object using the Object. You also can add alarm
extensions after you create an object by selecting it in the navigation tree and selecting Show
Extensions from the Action Menu.
Use alarm extensions to define the values for the high/low warning and high/low alarm conditions
for Analog Input Object, Analog Output Object, and Analog Value Object. For a complete list of
Analog Alarm extension attributes, see Analog Alarm Attributes.
Also, use alarm extensions to define the values for the alarm and trouble conditions for Binary
Input Object, Binary Output Object, Binary Value Object, Multistate Input Object, Multistate Output
Object, and Multistate Value Object. For a complete list of Multistate Alarm extension attributes, see
Multistate Alarm Attributes.
In addition, you can use alarm extensions to define the following conditions:
•

alarm state parameters such as Event Enable, Delay Time, and Report Delay

•

alarm setup parameters such as Acknowledgment Required, Alarm Message Text, and
associated Graphics
Devices with the Disable Automatic Alarming attribute set to True do not produce an alarm but
indicate they are offline in the navigation tree with a red X. See the appropriate object in the Object
Help for details on this attribute. This attribute does not affect alarm extensions.
The Enable Alarms and Disable Alarms commands affect any and all alarm extensions defined for
an object.
For more details on configuring alarm extensions, see Creating Extensions, Alarm Extensions, and
the Help section for the selected object.
After using alarm extensions to configure the detection of alarm conditions, you must configure
the routing, filtering, and format of event messages from Engine or Metasys Server to the desired
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destinations. For more information on filtering or routing events messages, click one of the
following section names:
•

Event Message Routing, Filtering, and Destinations

•

Configuring Destination Delivery Agents (DDAs)

•

Applying Filters for Routing Event Messages to Destinations

• Configuring Event Message Format
For information on AO/BO feedback, see AO/BO Feedback.

Event Repositories
The Metasys system has three event repositories for storing event messages.
Table 17: Event Repositories
Type
Local (Engine) Event
Repository

ADS Event
Repository

FACs Event Log

Description
•

Provides temporary storage for event messages on the Engine.

•

Allows the event messages stored in the local Engine event repository
to appear in the Event Viewer and Alarms Window.

•

Sends event messages from the local Engine event repository to the
defined Default Destination.

•

Provides permanent storage for event messages on the Metasys
Server platform.

•

Event messages generated on a Metasys Server platform are placed
directly into the Metasys Server event repository.

•

Allows the event messages stored in the Metasys Server event
repository to appear in the Event Viewer and Alarms Window.

•

Receives event messages from multiple local Engine event repositories
and provides permanent storage for the event messages. The Metasys
Server event repository is usually defined as the Default Destination
for event messages from local Engine event repositories.

•

Provides the option to send event messages from a single Metasys
Server event repository to one or more Metasys Server event
repositories for permanent storage. See the Configuring an ADS Event
Repository section for details.

•

Event logs are only viewable in the CCT. Configure the Advanced tab
to work with FACs to record events using events logs. Refer to Working
with the Advanced Tab in the CCT Help (LIT-12011147).

•

The CCT can be set up to send event notifications from the FAC event
logs to other devices. Refer to Setting up Device Notification in the CCT
Help (LIT-12011147).

For information on configuring the event repositories, click one of the following section names:
•

Configuring an Engine Event Repository

• Configuring an ADS Event Repository
A Database Timeout Error can occur when viewing events if the repository contains too many
events to be filtered before the system times out (typically, one million events). To prevent
this error, on a regular basis you should backup and purge event records from the repository
(JCIEvents) using the Metasys Database Manager.
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Default Destination
You can define an ADS repository as a Default Destination for each Engine where event messages
are sent under certain conditions and permanently stored:
•

If the Default Destination is a Metasys Server that has a LAN connection (as defined by the
Engine Device Object’s Connection Type attribute or the Site Object’s Default ADS Connection
Type attribute), event messages generated by the Engine are sent to the Metasys Server as
they occur.

•

If the Default Destination is a Metasys Server that has a Dial connection, event messages
generated by the Engine are sent to the Metasys Server when the local event repository is 90%
full Engine object’s Alarm Repository Size attribute), at the user-defined time (Engine object’s
Delivery Time attribute), or when the event priority exceeds the user-defined level (Engine
object’s Priority Threshold attribute).
See the Site Object, Engine Device Object, and Connection Type sections for information on these
attributes.
For information on how to define a Default Destination, see the Configuring an Engine Event
Repository section.
If you have not defined a Default Destination when the Engine local event repository is 100% full,
the local event repository either replaces the oldest messages (rollover) with new messages or
stops recording events according to the Event Action When Full attribute configuration.
Event message rollover begins or replacement stops only when the total number of nonforwarded
event messages reaches the size defined by the Event Repository Size attribute. In other words,
once the local event repository reaches the defined size, new event messages continue to enter the
local event repository replacing forwarded messages until all forwarded messages are gone. The
following figure illustrates the Event Action When Full when set to Rollover or when set to Stop.
Figure 11: Event Action When Full

If you have defined a Default Destination and the Event Action When Full attribute is set to Stop, the
event messages do not stop rolling over as long as forwarding is successful. This situation occurs
because event messages are forwarded to the Default Destination when new event messages are
received, and the forwarded messages are automatically replaced. The local event repository does
not fill up with nonforwarded event messages and, therefore, does not stop accepting new event
messages.
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If an event repository is full when a new event occurs, the following rules apply:
1.

Events forwarded to an ADS Event Repository are always removed before events – not
forwarded.

2.

The lowest priority event with the oldest time stamp and Acknowledge Required set to false is
replaced first.

3.

If the event about to be created is of higher priority than at least one event in the repository,
the event with the oldest time stamp and lowest priority is replaced.

4.

If all events are of the same priority, the event with the oldest time stamp is replaced.

5.

If the event about to be created is of a lower priority than all other events in the Event
Repository, no event is replaced and the new event is discarded. In this situation, the new
event does not cause the Alarm Window to appear, or any other DDA action to take place.
Notes:
•

The local repository for alarms in the Engine is set to rollover at 1000 alarms automatically if
the alarms meet the above requirements.

•

You can define only one ADS Repository as the Default Destination for an Engine; however,
different Engines can have different ADS Repositories defined as their Default Destination.
You can forward event messages from one Metasys Server to other Metasys Servers on the same
site. For details, see the Configuring an ADS Event Repository section.

Event Message Annotations
An annotation is a textual string associated with an event message. All acknowledgments add an
annotation to an event message. In addition, you can add annotations to an event message (in the
ADS event repository only). You cannot edit an existing annotation. Instead, add a new annotation
to the event message. You can also define custom annotations. See Adding Annotations, Viewing
Annotations, and Creating Annotations.
Note: On an Engine, you can view annotations but you cannot add them.
The following table describes the fields of an annotation dialog box.
Table 18: Annotation Dialog Box Fields
Field

Description

User

When viewing annotations: The User field appears under the
Annotation Information section that displays the user ID of the person
that added the annotation.

Date and Time

When adding annotations: Displays the date and time the event
message was generated.
When viewing annotations: The first Date and Time field displays the
date and time the event message was generated. The Date and Time field
appearing under the Annotation Information section displays the date
and time the annotation was added to the event message.
The date and time format is defined by the Language selected in the User
Profile (User Profile tab of the Security Administrator System).

Item Reference

Indicates the complete Item Reference defined for the item that
generated the event message.

Description

Displays the text defined by the Description attribute of the item that
generated the event message.
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Table 18: Annotation Dialog Box Fields
Field

Description

Annotation

Allows you to select from a list of predefined annotations or add a text
string (annotation) of 1–255 characters that may be used to describe any
operational tasks that should be performed to respond to the cause or
condition that prompted the generation of the event message.

Navigation Controls

Allows you to navigate through the annotations, if the event message has
multiple annotations associated with it. Use the buttons to go to the first
annotation, previous annotation, next annotation, or last annotation.
The text box displays the number of the annotation being viewed. The
Annotations feature automatically assigns a number to each annotation
created. For example, if the event message has three annotations, the
number appearing in this section can be 1, 2, or 3 depending on the
annotation being viewed. Type a number in the text box and press the
Enter key to jump directly to a specific annotation.

ADS Event Message Forwarding
You can forward event messages from one Metasys Server to another Metasys Server on the same
site. You also can forward event messages from a Metasys Server on one site to a Metasys Server
defined as the Site Director on another site. After forwarding event messages from one site to
another, you can configure the Site Director of the receiving site to forward the messages to the
other Metasys Server on that site as desired.
See Configuring an ADS Event Repository for information on how to forward event messages from
one Metasys Server to another Metasys Server.
Notes:
•

When you forward event messages, the messages are sent (copied) to the ADS repository
defined as the Default Destination. The event messages are not removed from the ADS
repository that sent the messages.

•

Use message forwarding for notification purposes, not as a backup or archiving method. Use
standard SQL practices for backup, archiving, or replication purposes.

Event Message Routing, Filtering, and Destinations
The Metasys system alarm and event feature allows you to route Engine generated event messages
to different devices that are defined as destinations. For each Engine, you can configure the routing
and filtering of event messages using DDAs. Supported destinations include pagers, printers, email,
and Network Management Systems that use SNMP traps. You can define DDAs by displaying the
Engine and clicking on the desired DDA tab.
For each Engine, you can configure the routing and filtering of event messages using the following
DDAs:
•

Email

•

Pager (not supported on network engines updated with Release 9.0.7 or later)

•

SNMP Trap

•

Serial Printer [for details on serial printer DDAs, refer to the NAE Commissioning Guide
(LIT-1201519)].
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Note: The serial printer DDA is supported on only a few engine models at certain releases.
Also, this DDA is enabled using Remote Desktop of a Site Director Engine, and no attributes/
tabs appear in the UI. Lastly, the serial printer DDA is not available on the NAE35, NAE45,
NCE25, or NIE59. For further information, refer to the NAE Commissioning Guide (LIT-1201519).
When configuring any of these DDAs, you can apply filters for routing specific event messages
and define the format in which the event messages are displayed at the destination. See
Configuring Destination Delivery Agents (DDAs) for information on how to route event messages to
destinations. See Configuring Event Message Format to define the message delivery format.
Use filters to determine which event messages get routed to the defined Destination, such as a
pager or email account. For example, define a filter to route only the event messages that require
acknowledgment by selecting Acknowledge Required == true.
For more information on filters, click the following section names:
•

Filtering Operators

•

Filtering Options

•

Filtering Examples

• Applying Filters for Routing Event Messages to Destinations
See the Event Message Routing Sample Scenario section for a sample event message routing
scenario.
Filtering Operators
The following table describes the Boolean operators used to configure the filters for routing event
messages to destinations.
Table 19: Operators
Operator

Meaning

==

Equal To

!=

Not Equal To

<

Less Than

<=

Less Than or Equal To

>

Greater Than

>=

Greater Than or Equal To
Note: If you define multiple filters for a destination, the DDA combines all the criteria with an
AND condition (all filter criteria must be met).

For more information on filters, click one of the following section names:
•

Filtering Options

•

Filtering Examples

•

Applying Filters for Routing Event Messages to Destinations

Filtering Options
You can apply filters to define which event messages are sent to specific destinations. For
information on how to apply filters to event messages, see Applying Filters for Routing Event
Messages to Destinations. Use the following table as a guide to defining filters.
Note: If you define multiple filters for a destination, the DDA combines all the criteria with an
AND condition (all filter criteria must be met).
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Table 20: Filters
Item

Operator

Value

Authorization
Category

==, !=

HVAC, Fire, Security, Services,
Administrative, General, Lighting,
Refrigeration, Critical Environment,
Air Quality, Power, Energy, System, or
Custom Value

Acknowledge
Required

==, !=

true, false

Current Status

==, !=

Normal, Fault, Off Normal, High Limit,
Low Limit, Low Warning, High Warning,
Low Alarm, High Alarm, Alarm, Trouble,
Status, Offline, Shutdown, Unreliable,
Online, Unknown Previous State

Previous Status
==, !=
(status prior to the
event)

Normal, Fault, Off Normal, High Limit,
Low Limit, Low Warning, High Warning,
Low Alarm, High Alarm, Alarm, Trouble,
Status, Offline, Shutdown, Unreliable,
Online, Unknown Previous State

Priority

==, !=, <, <=, >, >=

Range 0–255
See Event Priority.

Start Day of Week

==, !=, <, <=, >, >=

Monday through Sunday

Start Time

==, !=, <, <=, >, >=

The Time format is defined by the
Language selected in the User Profile
(User Profile tab of the Security
Administrator System).
Example: HH:MM:SS AM/PM format
(12:15:00 PM) for English Language
selection

End Day of Week

==, !=, <, <=, >, >=

Monday through Sunday

End Time

==, !=, <, <=, >, >=

The Time format is defined by the
Language selected in the User Profile
(User Profile tab of the Security
Administrator System).
Example: HH:MM:SS AM/PM format
(12:15:00 PM) for English Language
selection

For more information on filters, click the following section names:
•

Filtering Operators

•

Filtering Examples

•

Applying Filters for Routing Event Messages to Destinations

Filtering Examples
The following table provides examples of filters used by DDAs for routing event messages.
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Table 21: Filtering Examples
Example

Meaning

Authorization Category != HVAC

The DDA routes all event messages to the defined
destination except those from the HVAC category.

Acknowledge Required == true

The DDA routes only the event messages that require
acknowledgment to the defined destination.

Current Status == Alarm

The DDA routes all event messages that were generated
by objects in Alarm status to the defined destination.

Previous Status != Unknown Previous
State

The DDA routes all event messages to the defined
destination except those that were generated by objects
in the unknown previous state.

Priority <= 200

The DDA routes all event messages with an Event Priority
equal to or less than 200 to the defined destination. See
Event Priority.

Start Day of Week >= Friday
and
Start Time >= 05:00:00 PM
and
End Day of Week <= Monday
and
End Time <= 06:00:00 AM

The DDA routes all event messages generated from
5:00:00 PM on Friday through 6:00:00 AM on Monday.
The Time format is defined by the Language selected
in the User Profile (User Profile tab of the Security
Administrator System).

Applying Multiple Filters Example:
If you define multiple filters for a destination, the DDA combines all the criteria with an AND
condition (all filter criteria must be met).
If you want to define a set of filters for sending all High Alarm messages for your HVAC systems
that have been defined with event priorities belonging to the Property Safety Group (Priority 40–79)
and require acknowledgment at an email destination, apply all the following filters under the Email
tab of the Engine.
•

Authorization Category == HVAC

•

Current Status == High Alarm

•

Priority >= 40

•

Priority <= 79

• Acknowledge Required == true
For more information on filters, click the following section names:
•

Filtering Operators

•

Filtering Options

•

Applying Filters for Routing Event Messages to Destinations

Email
You can configure email addresses as destinations for event messages. The Email DDA supports
standard SMTP. You can also send encrypted email messages.
Note: Beginning at Metasys Release 10.1, the Email DDA is no longer enabled for the Metasys
Server, but you can use the Remote Notifications feature in Metasys UI to provide equivalent
functionality. For details, refer to Metasys UI Help (LIT-12011953).
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For information on how to configure an email destination, see Configuring Destination Delivery
Agents (DDAs). For information on sending encrypted email messages, see Configuring Encrypted
Email.
For additional information, see one of the following sections:
•

Email Tab in the Object and Feature Tabs

•

Engine Device Object

•

Configuring Event Message Format to configure how the event message appears at the email
destination

Email Addresses in the Destination Configuration
The Email Addresses attribute on the Email tab in the Destination Configuration of the device
specifies the email address of one or more recipients to receive alarm notification through email.
Click the Add button (>>) next to the Email Address attribute to select email addresses defined by
the user accounts in the Security Administrator system.
You must use valid email addresses, which are set up on an email server, for the device to
successfully send the alarms through email.
Figure 12: Email Addresses Dialog Box
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Table 22: Email Addresses Dialog Box Components
Field

Description

Metasys User Addresses

Displays the users defined in the Security Administrator System and
their email addresses. This information appears only for the device
that you are currently accessing.

Additional User Addresses

Allows you to enter email addresses not appearing in the
Metasys User Addresses list. When entering more than
one email address, separate the addresses with a comma
(John.Smith@jci.com,Jane.Smith@jci.com).

Destination Email Addresses

Displays the Metasys User Addresses and Additional User
Addresses that you selected or entered from the Metasys User
Addresses and Additional User Addresses lists.
You can expand or collapse the Metasys User Addresses folder and
Additional User Addresses folder by clicking the + or - sign or by
double-clicking the folders.
If you right-click the Metasys User Addresses folder or Additional
User Addresses folder, the following menu options appear:

Add Button

•

Sort-by Name: Displays the users in alphabetical order by
name. This option is available only for the Metasys User
Addresses folder.

•

Sort-by Email: Displays the email addresses in alphabetical
order.

•

Remove All: Removes all users and email addresses from the
selected list.

For the button next to the Metasys User Addresses list, adds the
selected users and their email addresses to the Destination Email
Addresses list.
For the button next to the Additional User Addresses lists, adds the
email addresses entered to the Destination Email Addresses list.

Current Calculated Length

Displays the number of characters in the email address string. This
number is calculated after clicking the Add button next to either the
Metasys User Addresses list or the Additional User Addresses list.
The maximum number of characters allowed for the email address
string is 256.

Remove

Removes the selected user and email address from the Destination
Email Addresses list. You also can select a user or email address,
right-click, and select Remove.

Remove All

Removes all users and email addresses from the Destination Email
Addresses list.

Pager
You can configure one or more pagers as destinations for event messages from older network
engines. Newer network engines that run a Linux operating system do not support pagers. The
Pager DDA supports standard TAP.
For information on how to configure a pager destination, see Configuring Destination Delivery
Agents (DDAs). For additional information, see the following:
•
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•

Engine Device Object

•

Configuring Event Message Format to configure how the event message appears at the pager
destination The event message format for pagers is very brief to conform to pager space
limitations.
Troubleshooting Tip:
Occasionally, a pager message may contain extraneous junk characters. These characters may
come from the paging service, appear as a result of interference, or appear when the pager battery
is low. Often, cycling power to the modem and waiting for 10 seconds, or disconnecting the modem
then reconnecting may solve the issue.

Printer
On the Metasys Server platform, you can define any printer supported by Windows software as a
destination for event messages, and a single DDA can print alarms on multiple printers. Printers
connected to the Metasys Server by parallel port or USB are supported, as well as IP-based network
printers (if printers are set up with an IP address).
Note: Beginning at Metasys Release 10.1, the Printer DDA is no longer enabled for the Metasys
Server, but you can use the Remote Notifications feature in Metasys UI to provide equivalent
functionality. For details, refer to Metasys UI Help (LIT-12011953).
To set up a printer on a split ADX, the printer must be accessible from the web/application server
computer, as opposed to the database server computer.
You can configure the Metasys Server Printer DDA for single line printing for a tractor feed printer
(also known as tractor feed printing, line printing, and dot matrix printer support). To set up a
printer for single line printing for a tractor feed printer (no form feed/tractor printing mode), set
the ADS Device Object Printer tab Line Out attribute to 0. By setting this attribute to 0, when an
alarm is sent to the tractor feed printer, it prints the alarm text and then advances a single line, thus
waiting to print the next alarm.
Notes:
•

When using a tractor feed printer (without any form feeds), the Timeout, Printing Priority
Threshold, Orientation, Font Face, and Font Size attributes are not used and any values set for
them are ignored. You can set the Orientation, Font Face, Font Size, and line wrapping at the
printer itself.

•

Tractor feed printing is only intended for tractor feed printers. You may encounter abnormal
behavior if you set the Line Out attribute to 0 for other type of printers, such as deskjet and
laserjet printers.
For information on how to configure a printer destination on a Metasys Server, see Configuring
Destination Delivery Agents (DDAs).
For information on how to configure a printer destination on a Metasys Server, refer to the
Configuring Destination Delivery Agents (DDAs) section in the Metasys SMP Help (LIT-1201793).
For additional information on Metasys Server Printer DDAs see the following:
•

Printer Tab in the Object and Feature Tabs

•

Engine Device Object or ADS Device Object

•

Configuring Event Message Format to configure how the event message appears at the printer
destination
On older releases of the NAE55/NIE55 and NAE85/NIE85 platform, you can use the Serial Printer
DDA on the Site Director Engine to print event messages. This DDA is enabled using Remote
Desktop and no attributes/tabs appear in the UI. This DDA is not available on the NAE35, NAE45, or
NIE59. Refer to the NAE Commissioning Guide (LIT-1201519) for details on this DDA.
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SNMP Trap
You can configure a SNMP Trap as a destination for event messages. The SNMP Trap DDA supports
SNMP Versions 1, 2C, and 3.
Note: Beginning at Metasys Release 10.1, the SNMP DDA is no longer enabled for the Metasys
Server, but you can use the Remote Notifications feature in Metasys UI to provide equivalent
functionality. For details, refer to Metasys UI Help (LIT-12011953).
For information on how to configure an SNMP Trap destination, see Configuring Destination
Delivery Agents (DDAs).
For additional information, see the following:
•

SNMP Tab in the Object and Feature Tabs

•

Engine Device Object or ADS Device Object

•

Configuring Event Message Format to configure how the event message appears at the SNMP
Trap destination

Syslog
New at Release 8.0, you can configure a syslog destination that forwards all system events and
audits to your syslog server.
Note: Beginning at Metasys Release 10.1, the Syslog DDA is no longer enabled for the Metasys
Server, but you can use the Remote Notifications feature in Metasys UI to provide equivalent
functionality. For details, refer to Metasys UI Help (LIT-12011953).
The Metasys system provides the optional capability of sending its configured audit log entries
and alarm notifications to an external, industry-standard Syslog server, conforming to Internet
published RFC 3164. The Syslog option provides positive indication of each field possible in the
Metasys event and audit entries, replacing any blank field with the single character dash (-).
Individual fields of each Metasys message are sent to the Syslog server separated by the vertical
bar symbol (|), ensuring the integrity of all data sent to the Syslog server.
After the Syslog DDA is configured, all messages sent to the local Repository are also sent
immediately to the configured Syslog server. You can apply forensic analysis on the consolidation of
all electronic audit and event information at the Syslog server.
For information on how to configure a syslog destination, see Configuring Destination Delivery
Agents (DDAs) For additional information, see the following:
•

Syslog Tab in the Object and Feature Tabs section

•

Engine Device Object

•

Configuring Event Message Format to configure how the event message appears at the syslog
server

Event Message Routing Sample Scenario
An Engine is configured to route all event messages to John Smith’s (Building Operations Engineer)
email address and a set of selected event messages to his manager’s (Building Operations
Manager) pager.
The following configuration is required to make this scenario work:
Make sure the Engine is configured properly and the engine model supports the event message
routing method you are using. Older network engines may work but newer network engines that
run a Linux operating system do not support some event message routing devices. See the Related
Documentation table and the Engine Device Object section for information.
Make sure that object alarm extensions are configured for each object in the Engine that you want
to detect alarm conditions. See the Alarm Extensions section for information.
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Define an email destination for John Smith’s (Building Operations Engineer) email address. See
Event Message Routing, Filtering, and Destinations, Email, and Configuring Destination Delivery
Agents (DDAs).
Define a pager destination for John’s manager’s (Building Operations Manager) pager. See Event
Message Routing, Filtering, and Destinations, Pager, and Configuring Destination Delivery Agents
(DDAs). Make sure you have defined the pager filters correctly.
Once the Engine detects an alarm condition and generates an event message, the Email DDA routes
all unfiltered event messages to John Smith’s email address. The Pager DDA only routes the event
messages that pass the defined pager filters to John’s manager’s pager.

Event Priority
Indicates the importance of the event message and determines when the event message is
displayed. Displaying the priority of the event messages in the Event Viewer allows the user to
acknowledge event messages of higher importance before event messages of lower importance.
The priority number associated with the event message falls within a range of 0–255. Event
messages with a lower priority number are of a higher importance or are more critical than event
messages with a higher priority number. You can route event messages based on priority.
Notes:
•

Use a consistent priority scheme to make sorting event messages based on priority in the
Event Viewer easier.

•

You can specify alarm notification sounds based on alarm priorities. See Alarm Settings Tab.

Life Safety Group (Priority 0–39)
Table 23: Life Safety
Priority

Recommended Use

5

Automatic Fire Alarm

8

Life Safety Process Alarm

11

Manual Fire Alarm

14

Other Higher Priority Life Safety

19

Medical Alarm

22

Hold Up and Duress Alarm

25

Panic Alarm

28

Life Safety Pre-Alarm Alert

31

Other Lower Priority Life Safety

Property Safety Group (Priority 40–79)
Table 24: Property Safety Group
Priority

Recommended Use

45

Burglar Alarm and Forced Door Alarm

48

Security Alarm

51

Other Higher Priority Property Safety

60

Watchman Tour Alarm

63

Property Process Alarm

66

Door Held Open Alarm

69

Other Lower Priority Property Safety
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Supervisory and Trouble Group (Priority 80–139)
Table 25: Supervisory and Trouble Group
Priority

Recommended Use

85

Fire Supervision (Tamper)

88

Security Supervision (Tamper)

91

Other Supervisory

100

Fire Trouble (Equipment Failure)

103

Security and Burglar Trouble (Equipment Failure)

106

Communication Equipment Failure Trouble

109

Process Trouble

112

Energy Alarm

115

Other Failure

124

Communication Equipment Warning Trouble

127

Early Warning Alert

130

Energy Warning

133

Other Warning

Other Group (Priority 140–255)
Table 26: Other Group
Priority

Recommended Use

145

Equipment and Industrial Supervision

148

Comfort Alarm

151

Miscellaneous Higher Priority Alerts

160

System Events

163

Miscellaneous Higher Priority Events

172

Life Safety Return to Normal

179

Property Safety Return to Normal

186

Supervisory and Trouble Return to Normal

189

Miscellaneous Return to Normal

198

System Status Active

201

Comfort Warning

204

Miscellaneous Lower Priority Events

213

System Status Normal

216

Comfort Normal

219

Test and Diagnostic Events

222

Miscellaneous

Alarm and Event Steps
Configuring an Engine Event Repository
About this task:
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To configure the local Engine Event Repository and the Default Destination:
1.
2.
3.
4.
5.

View an Engine device. See Viewing Item Data for information on how to display an item.
Select the Focus tab and click the Advanced radio button to display additional item
information.
Select Edit.
Scroll down to the Alarms and Site sections.
Edit the attributes in these sections. Use the following table as a guide. See Engine Device
Object for information about the attributes. The NAE Device attributes table contains Default
Value and Values/Options/Range information for the attributes. Click the attribute names in
the table for descriptions.
Table 27: Repository Configuration
To Do This:

Edit This Engine Device Object Attribute:

Change the size of the local Engine
repository

Alarm Repository Size

Change the snooze time for the Alarms
Window

Alarm Snooze Time

Forward acknowledged and discarded alarms Ack Forward Enable
and events from an NxE to the Metasys
Server repository
Designate an ADS repository as a Default
Destination

ADS Repository

Indicate the type of connection used by the
Metasys Server

ADS Connection Type

Define a time to deliver event messages to
the Metasys Server

ADS Delivery Time

Define the event message priority that
triggers delivery to the Metasys Server

ADS Priority Threshold

Note: You can define only one repository as the Default Destination for an Engine. See
Event Repositories for more information.
6.

Click Save.
Note: If you want to define all local Engine repositories for the entire site at one time
instead of individually, select the Site in the navigation tree and edit the following Site
Object attributes (the Site attributes table contains Default Value and Values/Options/
Range information for the attributes):
- Default ADS Repository
- Default ADS Connection Type
- Default ADS Delivery Time
- Default ADS Priority Threshold

Configuring an ADS Event Repository
About this task:

Metasys Site Management Portal Help

71

To configure an ADS Event Repository for forwarding event messages from one Metasys Server to
other Metasys Servers:
1.
2.
3.
4.
5.

6.

View the Metasys Server. See Viewing Item Data for information on how to display an item.
Select the Focus tab and click the Advanced radio button to display additional item
information.
Select Edit.
Scroll down to the Repository Storage section.
Edit the Metasys Server's Device Object’s ADS Repositories attribute. See the Metasys Server
attributes table (Table 112) for more information on this attribute or other Metasys Server
attributes, including their Default Value and Values/Options/Range information.
Click Save.

Configuring Destination Delivery Agents (DDAs)
About this task:
To provide consistency and easy configuration of DDAs, each DDA tab in the Metasys system user
interface contains the same layout. Follow the instructions in this section when configuring any
DDA. See Event Message Routing, Filtering, and Destinations for more information on DDAs.
Note: Beginning at Metasys Release 10.1, the Email, SNMP, Syslog, and Printer DDAs
are no longer enabled for the Metasys Server, but you can use the Remote Notifications
feature in Metasys UI to provide equivalent functionality. For details, refer to Metasys UI Help
(LIT-12011953).
On the NAE85/NIE85 platform and on some older releases of the NAE55/NIE55, you can use the
Serial Printer DDA on the Site Director Engine to print event messages. This DDA is enabled using
Remote Desktop, and no attributes/tabs appear in the UI. This DDA is only available on some
network engines. Refer to the NAE Commissioning Guide (LIT-1201519) for details on this DDA.
To configure DDAs for routing event messages:
1.
2.
3.
4.

View an Engine. See Viewing Item Data for information on how to display an item.
Select the tab for the desired destination type.
Select Edit.
Edit the attributes in the Shared Configuration section.
Note:
- See the specific DDA tab in the Object and Feature Tabs for information on
configuring attributes. Also, see the Engine Device Object or the ADS Device
Object section for information on configuring Engine or Metasys Server attributes,
respectively.

5.
6.

In the Destinations section, select New to add a destination or click an existing destination.
Edit the parameters in the Destinations section. See the following:
- Email
- Pager
- SNMP Trap
- Syslog
Note: See the specific DDA tab in the Object and Feature Tabs for information on
configuring attributes. Also, see the Engine Device Object section for information on
configuring Engine attributes.
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7.

Repeat Step 5 and 6 above if you want to configure this device to send event messages to
more than one destination of that type. Add the number of destinations. For example, to
send event messages to two different pagers, create two separate destinations on the Pager
tab.
Notes:
- See Applying Filters for Routing Event Messages to Destinations for information on how
to apply filters to route particular event messages to destinations.
- See Configuring Event Message Format for information on how to configure event
message format.

8.
9.

To remove a destination, select the destination and click Delete.
Click Save.

Configuring Encrypted Email
By default, Metasys software encrypts your user name and password as they are entered into
the SMP UI, but the software does not automatically encrypt email messages. This feature allows
Engines to send email to email servers over a secure channel (secure socket layer [SSL]). The entire
email payload is encrypted, and allows our software to communicate to email servers that require
SSL connections.
Consider these points when using email encryption:
•

The SMTP port is different when using secure socket layer connections. This port is typically
465.

•

To maximize efficiency when using this feature, set up mailing groups instead of individual
users in the destination field to minimize the number of users to which the machine has to
send email. This setup allows you to create different email groups and customize the type of
messages that each user receives.

You can configure encrypted email in three ways:
•

Configuring Encrypted Email with No Authentication Required

•

Configuring Encrypted Email with SMTP Authentication

•

Configuring Encrypted Email with POP-Before-SMTP Authentication

Configuring Encrypted Email with No Authentication Required
About this task:
Note: Encrypted Email with No Authentication Required functions only when Anonymous
Authentication is enabled on the mail server.
1.

View an Engine. See Viewing Item Data for information on how to display an item.

2.
3.
4.

Click the Email tab.
Click Edit.
Edit the Attributes in the Shared Configuration as shown in Table 28.
Table 28: Attributes for No Authentication Required
Attribute

Selection

SMTP Server Host

mail.yourdomain.com or yourdomain.com

SMTP Port

465

Authentication Type

None

SSL Email Enabled

True

SSL Email Ignoring Errors

False
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5.

Verify that the email was sent correctly.

Configuring Encrypted Email with SMTP Authentication
1. View an Engine. See Viewing Item Data for information on how to display an item.
2. Click the Email tab.
3. Click Edit.
4. Edit the Attributes in the Shared Configuration as shown in Table 29.
Table 29: Attributes for SMTP Authentication

5.

Attribute

Selection

SMTP Server Host

mail.yourdomain.com or yourdomain.com

SMTP Port

465

Authentication Type

SMTP

SSL Email Enabled

True

SSL Email Ignoring Errors

False

Verify that the email was sent correctly.

Configuring Encrypted Email with POP-Before-SMTP Authentication
About this task:
Notes:
•

When SSL Email is enabled and you use POP-before-SMTP Authentication, the Metasys
system uses port 995 to communicate to the mail server. Ensure that the mail server you are
connecting to uses port 995 for secure socket layer connections for POP3 access.

•

When SSL Email is not enabled and you use POP-before-SMTP Authentication, the Metasys
system uses port 110 to communicate to the mail server. Ensure that the mail server you are
connecting to uses port 110 for non-encrypted POP3 access.

1.
2.
3.
4.

View an Engine. See Viewing Item Data for information on how to display an item.
Click the Email tab.
Click Edit.
Edit the Attributes in the Shared Configuration as shown in Table 30.
Table 30: Attributes for POP-Before-SMTP Authentication

5.

Attribute

Selection

SMTP Server Host

mail.yourdomain.com or yourdomain.com

SMTP Port

465

Authentication Type

POP-before-SMTP

POP Server Hostname

yourdomain.com or pop.yourdomain.com

SSL Email Enabled

True

SSL Email Ignoring Errors

False

Verify that the email was sent successfully.

Applying Filters for Routing Event Messages to Destinations
1.
2.
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View an Engine device object. See Viewing Item Data for information on how to display an
item.
Select the tab for the destination type (for example, Pager).
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3.

Select Edit.

4.
5.
6.

Select a destination in the Destinations section.
Select New in the Filters section. The Filter dialog box appears.
Select a filter type from the Item drop-down menu. For more information and examples on
filtering, see Event Message Routing, Filtering, and Destinations.
7. Select the operator from the drop-down menu.
8. Select a value from the drop-down menu or type the value in the text box.
9. Click OK.
10. Repeat step Step 4 through step Step 9 to add more filters to that destination.
Note: If you define multiple filters for a destination, the DDA combines all the criteria
with an AND condition (all filter criteria must be met).
11. Make changes to filters using the drop-down menus or text boxes.
12. To remove a filter, select a filter and click Delete.
13. Click Save.

Configuring Event Message Format
1.
2.
3.
4.
5.

View an Engine. See Viewing Item Data for information on how to display an item.
Select the tab for the destination type.
Select Edit.
Select a destination in the Destinations section.
Select the check boxes in the Format section to define which attribute information is included
in the event message when delivered to that destination.
Note: For example, select Value and Units if you only want to display the Value and
Units portion of the event message at the destination.

6.

Click Save.

Acknowledging Event Messages
1.
2.

Launch the Event Viewer.
Select one or more event messages.
Note: Use the Ctrl or Shift key to select multiple messages.

3.

Click Ack.
Notes:
- Alternatively, you can right-click and select Ack or you can acknowledge event messages
in the Alarms Window. See Acknowledging, Snoozing, and Discarding Events for details.
- In an Engine that is not the Site Director, acknowledged or discarded alarm and event
messages do not appear acknowledged or discarded in the Metasys Server.
- All acknowledgments add an annotation to the event message. See Event Message
Annotations.
- An electronic signature and/or annotation may be required when acknowledging an
event.

Discarding Event Messages
1.
2.

Launch the Event Viewer.
Select one or more event messages.

Metasys Site Management Portal Help

75

Note: Use the Ctrl or Shift key to select multiple messages.
3.

Click Discard.
Notes:
- Alternatively, you can right-click and select Discard or you can discard event messages in
the Alarms Window. See Acknowledging, Snoozing, and Discarding Events for details.
- In an Engine that is not the Site Director, acknowledged or discarded alarm and event
messages do not appear acknowledged or discarded in the Metasys Server.
- An electronic signature or annotation may be required when discarding an event.

Sorting the Event Message List
About this task:
Note: When you sort the event message list, only those messages currently displayed on
the screen sort. This feature does not sort all messages if you have multiple pages of event
messages.
1.
2.

Launch the Event Viewer.
Click the header of the column you want to use for sorting. An up or down arrow appears
in the header of that column. Click the arrow to change the sorting order and the table
reorganizes.

Creating a Custom Filter for the Event Viewer (Metasys Server Only)
1.
2.
3.
4.
5.
6.

Launch the Event Viewer.
Click Custom Filter.
Click Add.
Select the criteria and the associated values for the filter and click OK. All criteria added to the
custom filter table will make up the rules of the filter.
Click Apply to get the results of the custom filter.
To view the data without the custom filter, click Standard Filter.

Printing the Event Messages Displayed in the Event Viewer
1.
2.
3.

Launch the Event Viewer.
Click anywhere in the Event Viewer.
Select Print from the Item Menu. The event messages are printed in the order they appear in
the Event Viewer.

Launching the Focus View of the Item That Generated the Event Message
1.

Launch the Event Viewer.

2.

Select an event message and choose Selected Item from the View menu, or right-click and
select View Item.
Notes:
- Some items, such as site level items, do not support this option because they do not
have viewable information.
- Alternatively, you can launch the Focus view of the item that generated the event
message in the Alarms Window by clicking on the View Item button. See Acknowledging,
Snoozing, and Discarding Events for details.
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Launching a Graphic Associated with an Event Message
1.
2.

Launch the Event Viewer.
Double-click the graphic icon of an event message.
Note: Alternatively, you can launch a graphic associated with an event message in the
Alarms Window by clicking the View Graphic button. See Acknowledging, Snoozing, and
Discarding Events for details.

Adding Annotations
About this task:
The annotation feature is not available on the local Engine event repository. You can add
annotations to the ADS event repository only.
1.
2.
3.

Launch the Event Viewer.
Click the event message.
Select Add Annotation from the Actions menu or right-click and select Add Annotation. The
Add Annotation dialog box appears.
Note: The drop-down field on the Add Annotation dialog box contains predefined
annotations from your system preferences. If you have not defined annotations in your
system preferences, the drop-down list is empty.

4.
5.

Type the desired text in the message box.
Click OK.

Creating Annotations
1.
2.
3.

Select the Annotation Settings tab on the Metasys Preferences screen.
Enter annotation text. The text can be from 1 to 255 characters in length.
Click Add to save the new annotation.
Note: The annotations you create appear in the drop-down list on the Add Annotations
dialog box. If you do not create any annotations, this list is blank.

Viewing Annotations
About this task:
You can view annotations from both the ADS and Engine event repositories.
1.
2.
3.

Launch the Event Viewer.
Click the event message.
Select View Annotations from the Actions menu or right-click and select View Annotations.
The View Annotations dialog box appears.
Note: Alternatively, you can double-click the annotation icon in the first column of the
Event Viewer for an event message.

4.
5.

View the message. If multiple messages exist, use the navigation buttons to browse between
event messages or to the first and last event message.
Click OK.

Result
Note: A signed book icon is displayed in the event’s associated Acknowledgment Annotation
dialog box.
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Alarm and Event Management for Metasys Systems Integrated with BACnet
Devices
The Metasys system provides the option to use the Alarm and Event Management feature when
integrating with BACnet devices (including the N30). You can send event messages generated
by the engines, Metasys Servers, or FACs to BACnet devices. This alarming method uses the
Notification Class Object and Event Enrollment or objects with intrinsic alarming to detect alarm
conditions and route event messages from the Metasys system to BACnet devices.
Note: Event Enrollment objects are not supported by any field controllers.
For the alarm and event feature steps, see the Alarm and Event Management Alarm and Event
Steps section.
For details on the attributes appearing on the BACnet Alarms tab, see BACnet Alarm Tab in the
Object and Feature Tabs section.
For information on the BACnet IP Integration object, see the BACnet IP Integration Object.
For information on alarm and event management for the Metasys system, see Alarm and Event
Management.

Alarm and Event Management for Metasys Systems Integrated with BACnet
Metasys/BACnet Alarming Overview
The Metasys system provides the functionality to use the Alarm and Event feature when integrating
with BACnet devices (including the N30). You can configure the engines, Metasys Servers, or FACs
to BACnet devices to comply with the standard BACnet alarm and event services such as intrinsic
alarming, Event Enrollment object alarming, and alarm routing using the Notification Class Object.
These optional alarming methods allow you to send alarm and event messages from the Metasys
system to BACnet devices.
To use the alarm and event feature for Metasys systems that integrate BACnet devices, configure
the Notification Class object, then reference that Notification Class object from the Event
Enrollment Object or from an object with intrinsic alarming. The Notification Class object routes
event messages from Event Enrollment objects or objects with intrinsic alarming to one or more
BACnet device. Intrinsic alarming attributes, Event Enrollment objects, and Notification Class
objects are fully compliant with the BACnet standard specifications and should be used if you want
your Metasys system to send event messages to BACnet devices.
Event Messages routed through the Notification Class object to the Metasys system’s event
repositories can use the Alarm and Event features such as the Event Viewer, Alarms Window, Alarm
Reports, and DDAs. To enable this functionality, you must set the Route to Metasys attribute to
true in the Notification Class objects used. See Configuring Metasys/BACnet Integration Alarming.
See the Alarm and Event Management Alarm and Event Steps section for more information on the
alarm and event feature.
The following figure shows the flow of event messages routed by the Notification Class object.
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Figure 13: Event Message Flow

For details on configuring the detection of alarm conditions, the routing event messages to
destinations, and the filtering and message formatting options, click one of the following:
•

Notification Class object and its attributes

•

Event Enrollment object alarming

•

intrinsic alarming

•

event routing, filtering, and destinations

• event message format
The alarm extensions method of alarming is easier to configure and provides greater flexibility and
functionality for standard Metasys applications. Use alarm extensions for alarming if your system
does not require integration with BACnet devices.

BACnet Intrinsic Alarming
Intrinsic alarming is fully compliant with the BACnet standard specifications and should only be
used when integrating with BACnet devices. Intrinsic alarming allows you to configure the detection
of alarm conditions and the generation of event messages based on attributes (properties) within
an object that is compliant with the standard BACnet objects, such as the High/Low alarm limits for
analog objects and the alarm state for binary objects. The Notification Class Object routes the event
message.
By default, objects do not have intrinsic alarming; however, you can add intrinsic alarming to
an object by setting its Intrinsic Alarming Defined attribute to True. Also, you can add intrinsic
alarming when you create an object, or you can add intrinsic alarming to an existing object. You
can remove intrinsic alarming from an existing object by changing its Intrinsic Alarming Defined
attribute to False. The Intrinsic Alarming Defined attribute is located under the BACnet heading
in the Insert Object wizard and in the object’s Focus view, which is accessible when you select the
Advanced option for the display. When you set the Intrinsic Alarming Defined attribute to True,
the BACnet Alarm tab appears the next time you view the object. The default alarming settings
(for example, high and low limits) are used until you change the settings on the BACnet Alarm
tab. When you set the Intrinsic Alarming Defined attribute to False, all intrinsic alarm settings
configured through the BACnet Alarm tab are discarded and the alarming settings return to their
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default values. For more information on configuring intrinsic alarming in an object, see Configuring
Metasys/BACnet Integration Alarming.
Intrinsic alarming is only available for your Metasys system if you set the BACnet Site attribute to
True in the Site object. See the Site Object for information on configuring the BACnet Site attribute.
To view the BACnet intrinsic alarming attributes of existing Metasys objects after they have been
configured, view the object and click the BACnet Alarm tab. You can add alarm extensions to objects
supporting intrinsic alarming.
The following Metasys objects are compliant with the standard BACnet objects and support BACnet
intrinsic alarming:
•

Accumulator Object

•

Analog Input Object

•

Analog Output Object

•

Analog Value Object

•

Binary Input Object

•

Binary Output Object

•

Binary Value Object

•

Multistate Input Object

•

Multistate Output Object

• Multistate Value Object
After configuring one or more objects with intrinsic alarming, you must configure at least one
Notification Class object to define the routing of event messages to BACnet device destinations.
Then, you must reference the desired Notification Class object from the objects with intrinsic
alarming. If you want the Notification Class object to route the event messages created by the
objects with intrinsic alarming to the Metasys Alarm and Event Management feature, set the
Notification Class object’s Route to Metasys attribute to true.
In addition, you can add object alarm extensions to objects with intrinsic alarming if you want to
route event messages to both BACnet device destinations and Metasys DDAs. For more information
on DDAs, see Event Message Routing, Filtering, and Destinations.
The Enable Alarms and Disable Alarms commands for objects using intrinsic alarming edit the Event
Enable flags under Alarm State to prevent alarms.
You can configure intrinsic alarming online at the Site Management Portal (SMP) UI or offline in
the SCT. Intrinsic alarms for objects in an FAC can be defined using CCT or SMP, but not SCT. If
defined with SMP, you must specify if the intrinsic alarm is to Use Remote Alarming as defined in
the object's Focus tab. If true, the intrinsic alarm parameters are stored in the FAC. If false, the
parameters are stored in the Engine.
Note: The BACnet IP Integration mapper objects Loop and Load Control do not support
intrinsic alarming parameters stored in the Engine. When Intrinsic Alarming Defined is set to
true on these objects, then Use Remote Alarming must also be set to true, and any intrinsic
alarming parameters must be stored and provided by the field device.
For details on the attributes appearing on the BACnet Alarms tab, see BACnet Alarm Tab in the
Object and Feature Tabs section.

BACnet Event Enrollment Object Alarming
The Event Enrollment Object is fully compliant with the BACnet standard specifications and should
only be used when integrating with BACnet devices. The Event Enrollment object monitors the value
of a single attribute and generates event messages based on the defined alarm conditions.
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You can create an Event Enrollment object using the Insert Object Wizard and configure its
attributes, or you can view an existing Event Enrollment object and edit its attributes. Event
Enrollment objects are not supported by any field controllers. Based on the defined event type,
the Event Enrollment object generates event messages for different conditions monitored in the
referenced object. See the Event Type attribute of the Event Enrollment Object and the Event
Enrollment Configuration Examples for more information.
Note: Event Enrollment alarming is only available for your Metasys system if you set the
BACnet Site attribute to True in the Site object. See the Site Object for information on
configuring the BACnet Site attribute.
After configuring one or more Event Enrollment objects, you must configure at least one
Notification Class Object to define the routing of event messages to BACnet device destinations.
Then you must reference the desired Notification Class object from the Event Enrollment objects. If
you want the Notification Class object to route the event messages created by the Event Enrollment
objects to the Metasys Alarm and Event Management feature, set the Notification Class object’s
Route to Metasys attribute to true.
You can add object alarm extensions to Event Enrollment objects if you want to route event
messages to Metasys DDAs. For more information on DDAs, see Event Message Routing, Filtering,
and Destinations.
The Enable Alarms and Disable Alarms commands for the Event Enrollment object alarming edit the
Event Enable flags under Alarm State to prevent alarms.
Click one of the following for more information:
•

Event Enrollment Object and its attributes

•

event types used by the Event Enrollment Object (Event Type attribute)

•

Event Enrollment Configuration Examples

Event Enrollment Configuration Examples
The alarm conditions monitored by the Event Enrollment Object are defined by the selected event
type. Click the event types in the following list for configuration examples:
•

Event Enrollment Configuration Example - Change of Bitstring

•

Event Enrollment Configuration Example - Change of Character String

•

Event Enrollment Configuration Example - Change of State

•

Event Enrollment Configuration Example - Change of Value

•

Event Enrollment Configuration Example - Command Failure

•

Event Enrollment Configuration Example - Double Out of Range

•

Event Enrollment Configuration Example - Floating Limit

•

Event Enrollment Configuration Example - Out of Range

•

Event Enrollment Configuration Example - Signed Out of Range

•

Event Enrollment Configuration Example - Unsigned Out of Range

• Event Enrollment Configuration Example - Unsigned Range
A table is provided for each example that describes the required attributes under both the
Configuration and Event tabs of the Event Enrollment object when you are inserting the new object.
Event Enrollment Configuration Example - Change of Bitstring
The following table is an example of how to configure an Event Enrollment Object using the Change
of Bitstring event type. In this example, the Event Enrollment object references Status flags of an
Analog Value Object. An event message is generated as defined by its Event Enable attribute when
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either the In Alarm or Fault attribute changes to True for a time period longer than the defined
Delay Time. For more information about this event type, see Event Type.
Table 31: Change in Bitstring Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Change in Status Detected

Input Reference

AV1
Status Flags

Delay Time (seconds)

10

Mask

In Alarm - selected (true)
Fault - selected (true)
Overridden - not selected (false)
Out of Service - not selected (false)

Values

In Alarm - selected (true)
Fault - selected (true)
Overridden - not selected (false)
Out of Service - not selected (false)

Event

Event Enrollment Configuration Example - Change of Character String
The following table is an example of how to configure an Event Enrollment Object using the Change
of Character String event type. In this example, the Event Enrollment object references the Present
Value attribute of a Character String object. An event message is generated as defined by its Event
Enable attribute when the Character String's Present Value attribute partially matches one of the
List of Values for a time period longer than the defined Delay Time. For more information about this
event type, see Event Type.
Table 32: Change in Character String Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Change in Object String Detected

Input Reference

CharString1
Present Value

Delay Time (seconds)

120

List of Values

Security Breach
Power Failure

Event

Event Enrollment Configuration Example - Change of State
The following table is an example of how to configure an Event Enrollment Object using the Change
of State event type. In this example, the Event Enrollment object references the Reliability attribute
of a Multistate Value Object. An Event message is generated as defined by its Event Enable attribute
when the state of the MV’s Reliability attribute changes to Unreliable for a time period longer than
the defined Delay Time. For more information about this event type, see Event Type.
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Table 33: Change of State Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Point is now Unreliable

Input Reference

MV1
Reliability

Delay Time (seconds)

0

Event Type

Change of state

Value

Unreliable

Event

Event Enrollment Configuration Example - Change of Value
The following table is an example of how to configure an Event Enrollment Object using the Change
of Value event type. In this example, the Event Enrollment object references the Present Value
attribute of an Analog Input Object. An event message is generated as defined by its Event Enable
attribute when the value of the ZN-T’s Present Value attribute changes by more than the specified
COV Increment for a time period longer than the defined Delay Time. For more information about
this event type, see Event Type.
Table 34: Change in Value Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: NW Conf. Room Temp

Input Reference

ZN-T
Present Value

Delay Time (seconds)

120

Event Type

Change of value

COV Increment

3.0

Event

Event Enrollment Configuration Example - Command Failure
The following table is an example of how to configure an Event Enrollment Object using the
Command Failure event type. In this example, the Event Enrollment object references the Present
Value attribute of a Binary Input Object. An alarm message is generated as defined by its Event
Enable attribute when a command to SA_F’s Present Value attribute is not reflected by the Input
Reference (SA_FLOW) after the defined Delay Time has expired. For more information about this
event type, see Event Type.
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Table 35: Change in Command Failure Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Alarm

Event Message Texts Config

[1]: Supply Fan Command Failure

Input Reference

SA_FLOW
Present Value

Delay Time (seconds)

60

Command Target

SA_F
Present Value

Event

Event Enrollment Configuration Example - Double Out of Range
The following table is an example of how to configure an Event Enrollment Object using the Double
Out of Range event type. In this example, the Event Enrollment object references the Present
Value attribute of a large Analog Value Object. An event message is generated as defined by its
Event Enable attribute when the value of the large AV’s Present Value attribute goes outside the
user-defined low limit/high limit range for a time period longer than the defined Delay Time. Only
double data types are supported. For more information about this event type, see Event Type.
Table 36: Double Out of Range Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Room Temp Out of Range

Input Reference

LAV1
Present Value

Delay Time (seconds)

300

Low Limit

66.0

High Limit

74.0

Deadband

2.0

Event

Event Enrollment Configuration Example - Floating Limit
The following table is an example of how to configure an Event Enrollment Object using the
Floating Limit event type. In this example, the Event Enrollment object references the Present Value
of an Analog Input Object. An alarm message is generated as defined by its Event Enable attribute
when the value of the AI’s Present Value attribute exceeds the defined setpoint (ZNT-SP) plus the
high or minus the low differential limit values for a time period longer than the defined Delay Time.
For more information about this event type, see Event Type.
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Table 37: Floating Limit Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Alarm

Event Message Texts Config

[1]: Room Temp Limit Exceeded

Input Reference

AI1
Present Value

Delay Time (seconds)

300

Setpoint Reference

ZNT-SP
Present Value

Low Differential Limit

3.0

High Differential Limit

4.0

Deadband

1.5

Event

Event Enrollment Configuration Example - Out of Range
The following table is an example of how to configure an Event Enrollment Object using the Out
of Range event type. In this example, the Event Enrollment object references the Present Value
attribute of an Analog Input Object. An event message is generated as defined by its Event Enable
attribute when the value of the AI’s Present Value attribute goes outside the user-defined low limit/
high limit range for a time period longer than the defined Delay Time. For more information about
this event type, see Event Type.
Table 38: Floating Limit Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Room Temp Out of Range

Input Reference

AI1
Present Value

Delay Time (seconds)

300

Low Limit

66.0

High Limit

74.0

Deadband

2.0

Event

Event Enrollment Configuration Example - Signed Out of Range
The following table is an example of how to configure an Event Enrollment Object using the Signed
Out of Range event type. In this example, the Event Enrollment object references the Scale as
Integer attribute of an Accumulator Object. An event message is generates as defined by its Event
Enable attribute when the value of the ACM’s Scale as Integer attribute goes outside the userdefined low limit/high limit range for a time period longer than the defined Delay Time. For more
information about this event type, see Event Type.
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Table 39: Signed Out of Range Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Scale as Integer is Out of Range

Input Reference

ACM1
Scale as Integer

Delay Time (seconds)

120

Low Limit

-2

High Limit

7

Deadband

5

Event

Event Enrollment Configuration Example - Unsigned Out of Range
The following table is an example of how to configure an Event Enrollment Object using the
Unsigned Out of Range event type. In this example, the Event Enrollment object references the
Pulse Rate attribute of an Accumulator Object. An event message is generated as defined by its
Event Enable attribute when the value of the Accumulator’s Pulse Rate goes outside the userdefined low limit/high limit range for a time period longer than the defined Delay Time. Only
positive values are supported. For more information about this event type, see Event Type.
Table 40: Unsigned Out of Range Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: Significant pulse rate change detected

Input Reference

ACM1
Pulse Rate

Delay Time (seconds)

120

Low Limit

10

High Limit

500

Deadband

10

Event

Event Enrollment Configuration Example - Unsigned Range
The following table is an example of how to configure an Event Enrollment Object using the
Unsigned Range event type. In this example, the Event Enrollment object references the Present
Value attribute of an Accumulator Object. An event message is generated as defined by its Event
Enable attribute when the value of the Accumulator’s Present Value goes outside the userdefined low limit/high limit range for a time period longer than the defined Delay Time. For more
information about this event type, see Event Type.
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Table 41: Unsigned Range Example
Tab

Attribute

Value

Focus

Event Enable

To Off Normal

Notify Type

Event

Event Message Texts Config

[1]: A potential excessive use fee

Input Reference

ACM1
Present Value

Delay Time (seconds)

120

Low Limit

10000

High Limit

18000

Event

Alarm and Event Management for Metasys Systems Integrated with BACnet
Configuring Metasys/BACnet Integration Alarming
About this task:
The BACnet Intrinsic Alarming and BACnet Event Enrollment Object Alarming routing services are
fully compliant with the BACnet standard specifications and should only be used when integrating
your Metasys system with BACnet devices.
You can configure intrinsic alarming online at the SMP UI or offline in the SCT. Intrinsic alarming for
FAC objects can be defined with the SMP or offline with CCT.
To configure Metasys/BACnet integration alarming:
1.
2.

Set the BACnet Site attribute to true in each Site Object representing a site that you want to
use Metasys/BACnet Integration alarming.
For each NAE in the site using alarming integration, configure one or more Notification
Class objects for routing event messages from Event Enrollment objects and/or objects with
intrinsic alarming to BACnet device destinations. Be sure you reference the BACnet devices by
adding them to the Recipient List of the Notification Class object. Identify a BACnet device by
using either its network address or BACnet device identifier (OID).
Notes:
- If you want to display alarm and event data from BACnet device destinations on the
Metasys system Alarms Window and Event Viewer, set the Notification Class Object’s
Route to Metasys attribute to true. The BACnet device must specify the NAE as a
recipient for their alarms. To make the NAE an alarm recipient, configure a Notification
Class object on the BACnet device. Alarms and acknowledgements from the BACnet
device are incorporated into the Metasys alarming system. To route BACnet alarms
from the N30 to the NAE, the N30 must be configured to use BACnet alarm routing.
For information on how to configure the N30 to use BACnet alarm routing, refer to the
documentation of the BACnet device you are integrating.
- When the NAE receives an alarm from an NAE, it can be sent from the DDAs on the
receiving NAE but cannot be routed again from that NAE. If the alarms need to be routed
from the NAE device, they should set the Use Remote Alarming to False for objects in the
FAC.

3.

Configure one or more Event Enrollment Object or objects that supports intrinsic alarming
using the Object. See BACnet Intrinsic Alarming for a list of objects that support intrinsic
alarming.
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Result
Note: For both types of these alarm generating objects, you must configure the Event
Enrollment object’s Notification Object Reference attribute to reference the Notification
Class Object created in Step Step 2. This reference represents the instance number of the
Notification Class (value of its Object Identifier attribute). The Notification Class object and the
alarming object must exist on the same device.
See BACnet Intrinsic Alarming for more information on intrinsic alarming.
See BACnet Event Enrollment Object Alarming for information on Event Enrollment alarming.
For more information on BACnet IP Integration, see the BACnet IP Integration Object and the
Related Documentation table.

Launching the Audit Viewer
1.
2.
3.

Select Audit Viewer from the View Menu. If you have more than one Engine or Metasys
Server on the site, a Device Selection dialog box appears.
Select the device containing the audit repository with the audit messages that you want to
display in the Audit Viewer.
Click OK. The Audit Viewer appears in the display frame and displays the audit messages
from the audit repository of the selected device. See Audit Message and Audit Viewer for
details.

Result
Note: Alternatively, you can right-click the desired device in the navigation frame and select
Audit Viewer from the menu that appears.

Audit Trail
The Audit Trail feature generates audit messages and stores them in Audit Repositories. An
audit message contains information about a significant event on the BAS. For audit purposes, a
significant event is an action or occurrence on the system that should be recorded for later analysis
of building operations. A new audit message is generated for each significant event on the BAS. The
Audit Message and Audit Viewer displays the audit messages stored in an audit repository. You can
access the Audit Viewer from the View Menu of the Metasys user interface in online mode.
The Audit Trail provides a historical record of the audited events, such as creating or deleting items,
that have occurred within the system. By viewing audit messages, you can examine and analyze the
actions that occurred in the system.

Audit Trail Concepts
Audit Trail Overview
The Audit Trail feature initiates an audit message when the system detects an audited event such
as a user logging in or logging out of the Metasys system, commanding an item, or changing
the configuration of a device. An audit message is stored in the Audit Repositories of the device
that generated the audit message. When the local audit repository is full, you can send its audit
messages to an ADS (ADX) repository defined as the Default Destination for permanent storage.
The Audit Message and Audit Viewer allows you to view audit messages stored in the audit
repository of the selected device. You can determine how to sort and filter the audit messages that
appear in the Audit Viewer as well as forward them to the defined default destination. You can add
annotations to audit messages and view them when displayed on a Metasys Server. You can also
define customized annotations and add these custom annotations to audit messages.
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For sites with MVE installed, configure the following attributes in the Site Object:
•

Annotation Include

•

Annotation Exclude

•

Signature Include

• Signature Exclude
These settings are used by MVE sites to enable the MVE desired annotations and electronic
signature for audit messages. You can apply these settings at the site level or down to the object
level as needed. You can set the MVE site to require only annotations, only electronic signatures,
both annotations and signatures, or neither annotations nor signatures. Non-MVE sites may
optionally define and use annotations; however, electronic signatures are specific to MVE sites.
When both annotations and signatures are required, and a user acknowledges or discards an audit
message, they are prompted to reauthenticate and enter a reason and annotation for the action.
The user’s login name, date and time of signature, and the reason for signature are saved as part
of the annotation. You cannot delete annotations on an MVE site.
See Configuring Annotation and Electronic Signature Requirements in the Site Object in MVE in the
Site Management Portal User Interface section. For additional information, refer to the Metasys for
Validated Environments, Extended Architecture Technical Bulletin (LIT-12011327).
Figure 14 shows the flow of audit messages through the Metasys system.
Figure 14: Audit Message Process

Audited Events
Audited events are significant events occurring in the system that trigger the Audit Trail feature to
generate an audit message. The following table lists the features and corresponding actions that
initiate the generation of audit messages. The following table also lists Audit Classes (Set 568) in
which the actions belong. Click the feature name for more information about that feature.
Note: Do not confuse audited events with those associated with alarming. See Alarm and
Event Management for details on alarming.
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Table 42: Audited Events
Feature

Action Causing Audit Message

ActionQ

Queues each command issued, enabled, disabled, or deleted (Audit Class
= User Action)

Alarm and Event
Management

By default, the Metasys Server does not create an audit entry when you
discard an event that originates on the Metasys Server through the
Alarms Window, Event Viewer, or a BACnet device (Audit Class = User
Action). To capture audit entries for these events would create an undue
number of entries in the database.
Notes:

Audit Trail

•

Engines do not create an audit entry when you discard events
that originate on the engine. For details on changing this
setting, refer to Creating Audit Entries for Discarded Events in the
NAE Commissioning Guide (LIT-1201519).

•

Error messages returned by the Email DDA logged in the Audit
Viewer appear in English only.

•

each command issued to clear the Audit Repository. See Clearing the
Audit Repository. (Audit Class = User Action)

•

each command issued to discard an audit message or a group of
audit messages. (Audit Class = User Action)

•

each command issued to change the Enabled Audit Level attribute
in the Engine Device Object or ADS Device Object based on a system
event, a user changing the time of day, or a user command.

See Configuring the Engine Audit Repository. (Audit Class = User
Action, Non-critical System Event, Critical System Event, Application, or
Diagnostic)
Trend Extensions
Trend Studies

Scheduling
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•

each new trend extension created (Audit Class = User Action)

•

each change to the trend routing configuration (Audit Class = User
Action)

•

each command issued to the trend extension (Audit Class = User
Action)

•

each change to trend views such as creating, deleting, or editing a
trend view (Audit Class = User Action)

•

each change to the Engine and Metasys Server configuration (Audit
Class = User Action)

•

each item added to or removed from the schedule (Audit Class =
User Action)

•

each change to the key item or its scheduled attribute (Audit Class =
User Action)

•

each change to the effective period (Audit Class = User Action)

•

each time the schedule is enabled or disabled (Audit Class = User
Action or Application)
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Table 42: Audited Events
Feature
System Security

User Graphics Tool
(UGT)
Navigation Tree and
Other Features

Action Causing Audit Message
•

each successful and failed log in and log out attempt (Audit Class =
User Action)

•

each administrative action (Audit Class = User Action)

•

each authentication failure (Audit Class = Application)

•

each authorization failure (Audit Class = Application)

each command (Audit Class = User Action)
•

each user command (Audit Class = User Action)

•

each change in item configuration such as adding, deleting, and
editing an item (Audit Class = User Action)

•

each controller upload, download, synchronization, and reset
occurring in online mode. Audit messages are not generated for
those actions in the SCT offline mode. (Audit Class = User Action,
Application, Non-critical System Event, Critical System Event)

Audit Repositories
The following table describes the two types of audit repositories for storing audit messages in the
Metasys system. The ADS Audit Repository applies to either Metasys Server: ADS or ADX.
Table 43: Audit Repositories
Type
Local (Engine) Audit
Repository

ADS Audit Repository

Description
•

Provides temporary storage for audit messages on the Engine.

•

Allows the audit messages stored in the Engine local audit repository
to be displayed in the Audit Viewer.

•

Forwards audit messages from the Engine local audit repository
to the Default Destination. See Default Destination and Message
Forwarding.

•

Provides permanent storage for audit messages on the Metasys
Server platform.

•

Places audit messages generated on a Metasys Server platform
directly into the ADS audit repository.

•

Receives audit messages from multiple Engine local audit
repositories and provides permanent storage for the audit
messages. The ADS audit repository is usually defined as the default
destination for audit messages from Engine local audit repositories.

•

Allows the audit messages stored in the ADS audit repository to be
displayed in the Audit Viewer.

For information on configuring the Engine local audit repository and the default destination, click
one of the following:
•

Configuring the Engine Audit Repository

•

Forwarding Audit Messages to the Default Destination
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A Database Timeout Error can occur when viewing audit messages if the repository contains too
many unfiltered audit messages before the system times out (typically, one million messages). To
prevent this error, back up and purge audit message records from the repository (JCIAuditTrails)
using the Metasys Database Manager on a regular basis.

Default Destination and Message Forwarding
The Default Destination defines where audit messages are sent when the Engine local audit
repository is full, at a user-defined time (ADS Delivery Time attribute of Engine device), or when a
user clicks the Forward Messages button in the Audit Viewer. Configure an ADS Audit Repository
as the Default Destination to permanently store audit messages. For information on how to define
a default destination, see Configuring the Engine Audit Repository.
When the Dial-Up Audit Forwarding Threshold is reached, all non-forwarded audits in the Local
Audit Repository are forwarded to the defined ADS Repository.
To generate an alarm message when a Rollover or Stop condition occurs, set the Audit Generate
Alarm When Full attribute in the Engine device to True. See Configuring the Engine Audit Repository
and Audit Repositories.
You can forward audit messages to the Default Destination from the Engine local audit repository
by clicking the Forward Messages button in the Audit Viewer. See Forwarding Audit Messages to
the Default Destination.
Notes:
•

You cannot forward audit messages from an ADS audit repository to another ADS audit
repository.

•

You can define only one ADS audit repository as the Default Destination for messages from an
Engine local audit repository; however, different Engines can have different ADS repositories
defined as their Default Destination.
If you have not defined a Default Destination when the Engine local audit repository is 100% full,
the local audit repository either replaces the oldest messages (rollover) with new messages or
stops recording audits according to the Audit Action When Full attribute configuration.
Audit message rollover begins or replacement stops only when the total number of non-forwarded
audit messages reaches the size defined by the Audit Repository Size attribute. In other words,
once the local audit repository reaches the defined size, new audit messages continue to enter the
local audit repository replacing forwarded messages until all forwarded messages are gone. The
following figure illustrates the Audit Action When Full when set to Rollover or when set to Stop.
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Figure 15: Audit Action When Full

If you have defined a Default Destination, the Dial-Up Audit Forwarding Threshold attribute is set
to any percentage other than 100%, and the Audit Action When Full attribute is set to Stop; then the
audit messages do not stop rolling over as long as forwarding is successful. This situation occurs
because audit messages are forwarded to the Default Destination when new audit messages are
received, and the forwarded messages are automatically replaced. The local audit repository does
not fill up with non-forwarded audit messages and, therefore, no alarm is generated.

Audit Message and Audit Viewer
The Audit Trail feature generates a new audit message for each significant event occurring on
the system that contains data associated with the event. See Audited Events. The Audit Viewer
displays the audit messages residing in the Audit Repositories of the currently selected device
and is accessible from the View Menu of the Metasys user interface in online mode. The window
displays 1,000 audit messages per page for a Metasys Server. Engines are limited to a maximum of
500 audit messages per page. See Launching the Audit Viewer.
You can only view the audit messages from one audit repository of one device at a time:
•

If you are viewing the contents of an Engine local audit repository, the audit messages
displayed come from that Engine only.

•

If you are viewing the contents of a Engine local audit repository of an Engine device
designated as the Site Director, the audit messages displayed come from that Engine local
audit repository only.

•

If you are viewing the contents of an ADS audit repository, the audit messages displayed come
from that ADS audit repository only. An ADS audit repository may contain audit messages that
have been routed from other Engine or Metasys Server devices, but the repository does not
display the contents of multiple repositories.
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Note: You can define an audit repository as a Default Destination, so it receives audit
messages from other audit repositories. See Default Destination and Message Forwarding.
When viewing a Metasys Server device, a standard filter is applied to the Audit Viewer when it is first
opened. This filter allows you to see all audit messages.
You can also use custom filters when viewing the Metasys Server to narrow the list of audit
messages to only those that meet specific criteria. Custom filters query the entire Metasys Server
database, not just the list of audit messages that appears on the screen. You can filter audit
messages by any combination of Date/Time, User, Class Level, Action Type, and/or Discarded. New
audit messages appear in the list only if they meet all criteria specified in the filter. Custom filters
cannot be saved.
The following table describes the format of the audit message (and corresponding buttons and
fields) as displayed in the Audit Viewer.
Table 44: Audit Viewer
Item/Column

Description

Selected Device

Indicates the device for which the Audit Viewer is displayed. The device name
appears on the left side of the Audit Viewer above the table.
This field corresponds to the selection made in the Device Selection Dialog
box. See Launching the Audit Viewer.

Audit Count
(Engines Only)

Indicates the number of audit messages that currently appear in the Audit
Viewer. The Audit Count appears on the right side of the Audit Viewer above
the table only for Engine devices.

Standard Filter
Radio Button
(Metasys Server
Only)

Indicates that standard filtering is applied to the Audit Viewer for the selected
Metasys Server. This filter information appears on the right side of the Audit
Viewer above the table. The count of entries that apply to this filter appears in
parentheses next to the radio button.

Custom Filter
Radio Button
(Metasys Server
Only)

Indicates that custom filtering is applied to the Audit Viewer for the selected
Metasys Server. This filter information appears on the right side of the Audit
Viewer above the table. The count of entries that apply to this filter appears in
parentheses next to the radio button.

Custom Filter
Table (Metasys
Server Only)

Allows you to apply custom filtering to the Audit Viewer when the Custom
Filter radio button is selected. This table appears but is not active when the
Standard Filter radio button is selected. You may need to adjust the slider bar
to show the Custom Filter table.
The buttons for this table are:
•

- adds a filter using the Add Filter dialog box

•

- removes the selected filter

•

Apply - queries the Metasys Server database and displays the resultant
audit messages
See Creating a Custom Filter within the Audit Viewer (Metasys Server Only).
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Table 44: Audit Viewer
Item/Column

Description

Status Icons

Displays an icon indicating the status of the audit message:
- audit message is new (that is, the message has occurred in the system
within the new entry timeframe)
Note: See Display Settings Tab in the Preferences section for information on
changing the amount of time audit messages are considered new using the New
entry time frame preference (default value = 15 minutes).

- audit message has one annotation
- audit message has more than one annotation
- audit message has an electronic signature
When

Displays the date and time that the audit message was generated. The date
and time format is defined by the Language selected in the User Profile (User
Profile tab section of the Security Administrator System).

Item

Displays the name of the item that generated the audit message. An item
name is the label displayed for the selected item in the All Items navigation
tree (for example, AV1, NAE2, or Schedule1). Be sure you define unique item
names.

Class Level

Indicates the class in which the audit message belongs. For more information
on Class Level, see the Enabled Audit Level attribute in the Engine Device
Object or ADS Device Object.

Origin Application Indicates the application that performed the action that generated the audit
message. For example, the origin application may be the Alarm and Event,
Trend, or Security feature.
User

Indicates the user associated with the action that initiated the audit message
(for example, the person who changed a setpoint). The generic user called
jci is used to identify a user on a different computer who uploaded or
downloaded a database archive with SCT.

Action Type

Indicates the type of action that initiated the audit message.

Description

Provides the description of the action that generated the audit message. For
example, Enabled appears in this column if you send an Enable command
to an item. The description appearing in this column comes from the State,
Mode, and Type Sets associated with the time that generated the audit
message.
Note: If the Class Level is Non-Critical System Error or Diagnostics and the Action
Type is Error, then the associated error string appears. If the Action Type is Command and there is no further definition of the type of command (for example,
Operator Override, Adjust, etc.), then Description will show the value of the new
command (for example, On or Off).

Previous Value

Indicates the value and engineering units, if applicable, of the item before
performing the action that generated the audit message.
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Table 44: Audit Viewer
Item/Column

Description

Post Value

Indicates the value and engineering units, if applicable, of the item after
performing the action that generated the audit message.
Note: If the Action Type is Command and there is no further definition of the type
of command (for example, Operator Override, Adjust, etc.), then the actual Post
Value is shown in the Description column. If the Description is a User Login Successful or Failed, then the Post Value shows the IP address of the client computer
from which the login attempt was made.

Status

Indicates the status of the item at the time the audit message was generated.
Specifies the column of data used to sort the audit messages in the current
Audit Viewer (ascending or descending order).

Paging Controls
(Metasys Server
Only)

Allows you to navigate through the pages of audit messages in the Audit
Viewer. Use the buttons to go to the first page, previous page, next page, or
last page. Type a page number in the text box and press the enter key to jump
directly to a specific page.

Forward Messages Sends audit messages from the Engine local audit repository to the Default
Button
Destination. See Forwarding Audit Messages to the Default Destination.
Discard Button

Removes the selected audit messages from the Audit Viewer. See Discarding
Audit Messages.

Copy Button

Copies the selected audit messages to the Clipboard for pasting into other
applications such as Microsoft Excel or Word.
When you click this button with nothing selected in the audit viewer, all
entries are copied to the clipboard.
Note: You can also use Ctrl+A to select all entries and Ctrl+C to copy to the clipboard.

Audit Message Annotations
An annotation is a textual string associated with an audit message. You can view or add
annotations from the ADS (ADX) audit repository only. You cannot edit an existing annotation.
Instead, add a new annotation to the audit message. You can also define custom annotations. See
Adding Annotations, Viewing Annotations, and Creating Annotations.
Note: The annotation feature is not available on the Engine local audit repository.
The following table describes the fields of an annotation.
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Table 45: Audit Message Annotations
Field

Description

User

When adding annotations, indicates the user ID of the person associated with
the action that generated the audit message.
When viewing annotations, the first User field displayed indicates the user ID
of the person associated with the action that generated the audit message.
The User field displayed under the Annotation Information section indicates
the user ID of the person that added the annotation.

Date and Time

When adding annotations, indicates the date and time the audit message was
generated.
When viewing annotations, the first Date and Time field displayed indicates
the date and time the audit message was generated. The Date and Time field
displayed under the Annotation Information section indicates the date and
time the annotation was added to the audit message. The date and time
format is defined by the language selected in the User Profile (User Profile tab
section of the Security Administrator System).

Item Reference

Indicates the complete Item Reference of the item associated with the audit
message.

Description

Provides the description of the action that generated the audit message. For
example, Enabled appears in this field if you send an Enable command to an
item. The descriptions come from the State, Mode, and Type Sets associated
with the item that generated the audit message.
Note: If the Class level is Non-Critical System Error or Diagnostics and the Action
Type is Error, then an associated error string appears.

Annotation

Allows you to select from a list of predefined annotations or add or view a text
string (annotation) of up to 254 characters describing the associated audit
message.

Navigation
Controls

If the audit message has multiple annotations associated with it, allows
you to navigate through the annotations. Use the buttons to go to the first
annotation, previous annotation, next annotation, or last annotation.
The text box displays the number of the annotation being viewed. The
Annotations feature automatically assigns a number to each annotation
created. For example, if the audit message has three annotations, the number
being displayed in this section can be 1, 2, or 3 depending on the annotation
being viewed. Type a number in the text box and press the enter key to jump
directly to a specific annotation.

Audit Trail Steps
Configuring the Engine Audit Repository
About this task:
To configure the Engine Audit Repository and the Default Destination:
1.

View the Engine device. See Displaying Information About an Item for information on how to
display an item.
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2.
3.
4.
5.

Select the Focus tab, and click the Advanced radio button to display additional item
information.
Select Edit.
Scroll down to the Audit Trail and Site sections.
Edit the attributes in these sections. Use the table below as a guide. See the Engine Device
Object chapter for information about the attributes. The Engine Device attributes table
contains Default Value and Values/Options/Range information for the attributes. Click the
attribute names in the table for descriptions.
Table 46: Configuring the Engine Audit Repository
To Do This:

Edit This Engine Attribute:

Change the size of the Engine local audit repository.

Audit Repository Size

Designate a Metasys Server repository as a Default
Destination.

ADS Repository

Define a time to deliver audit messages to the Metasys ADS Delivery Time
Server.
Define how full the audit repository must be before
forwarding audit messages to the Metasys Server.

Dial-Up Audit Forwarding
Threshold

Define if the Audit Trail feature overwrites existing
audit messages or stops generating audit messages
when the audit repository is full.

Audit Action When Full

Note: This action is only valid when the device is not set
to forward data to a Metasys Server. The stop/rollover
option only applies when there is no forwarding to an
external repository.

Define if the Audit Trail feature should generate an
alarm when the audit repository is full.

Audit Generate Alarm When Full

Define which level of audit messages get added to the
audit repository.

Enabled Audit Level

Note: You can define only one repository as the Default Destination for audit messages
from an Engine audit repository. See Audit Repositories for more information.
6.

Click Save.
Note: If you want to define all Engine local repositories for the entire site instead of
individually, select the Site in the navigation tree and edit the following Site Object
attributes. The Site object attributes table contains Default Value and Values/Options/
Range information for the following attributes:
- Default ADS Repository
- Default ADS Delivery Time

Enabling Advanced Auditing
About this task:
The Equipment Activity widget captures audits of commands performed by Schedule objects,
Multiple Command objects, and Interlock objects that are tied to equipment configured to the
Metasys UI. To use this feature, you must make sure that the Engine object is at Metasys Release
8.0 or later and the Enable Application Generated Audits attribute is set to True.
1.
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In SMP, open the Engine object's Focus tab.
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2.

Select Advanced.

3.
4.
5.

Click Edit.
Under the Audit Trail section, change the Enable Application Generated Audits value to True.
Click Save.

Adding Annotations
About this task:
Note: You can add annotations from the Metasys Server only. Annotations are not forwarded
between Metasys Servers.
1.
2.

Launch the Audit Viewer by selecting the Metasys Server from the Device Selection Dialog
box.
Right-click the audit message, and select Add Annotation from the menu. Alternatively, you
can select Add Annotation from the Actions menu. The Add Annotation dialog box appears.
Note: The drop-down list on the Add Annotation dialog box contains predefined
annotations from your system preferences. If you have not defined annotations in
your system preferences, the drop-down list is empty. See Annotation Settings Tab in
Preferences.

3.
4.

Type the desired text in the message box.
Click OK.

Viewing Annotations
About this task:
Note: You can view annotations from the Metasys Server only.
To view annotations:
1.
2.

Launch the Audit Viewer by selecting the desired Metasys Server from the Device Selection
dialog box.
Double-click the annotation icon in the first column of the Audit Viewer for the audit
message. The View Annotations dialog box appears.
Notes:
- To indicate that an audit message was electronically signed, a signed book icon appears
in the first column of the Audit Viewer on a validated ADX on an MVE system.
- Alternatively, you can select View Annotations from the Actions menu or right-click the
audit message and select View Annotations from the menu.

3.

View the message.

4.

Click OK.

Creating Annotations
1.
2.
3.

Select the Annotation Settings tab on the Metasys Preferences screen.
Enter annotation text. The text can be from 1 to 254 characters in length.
Click Add to save the annotation settings.
Note: The annotations you create appear in the drop-down list on the Add Annotations
dialog box. If you do not create any annotations, this list is blank.
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Sorting the Audit Message List
1.
2.

Launch the Audit Viewer.
Click the header of the column in which you want to use as the sorting criteria. An up or down
arrow appears in the header of the column. Click on the arrow to change the sorting order,
and the table reorganizes.

Creating a Custom Filter within the Audit Viewer (Metasys Server Only)
1.
2.
3.
4.
5.
6.

Launch the Audit Viewer.
Click the Custom Filter radio button.
Click the Add button.
Select the criteria and the associated values for the filter and click OK. All criteria added to the
custom filter table make up the rules of the filter.
Click Apply to get the results of the custom filter.
To view the data without the custom filter, click the Standard Filter radio button.

Clearing the Audit Repository
1.
2.
3.

Launch the Audit Viewer by selecting the desired Engine or Metasys Server from the Device
Selection dialog box.
Click anywhere in the Audit Viewer.
Click Clear. All audit messages stored in that Audit Repository are cleared.
Notes:
- If you want to permanently store audit messages, click the Forward Messages button
before clicking Clear.
- For a validated ADX on an MVE system, an electronic signature with annotation is
required before clearing the audit repository.

Discarding Audit Messages
1.
2.

Launch the Audit Viewer.
Select one or more audit messages.
Note: For a validated ADX on an MVE system, an electronic signature with annotation is
required before discarding an audit message.

3.

Click Discard.
Note: When you discard audit messages from the repository, they are not automatically
discarded from the originating device.

Forwarding Audit Messages to the Default Destination
1.
2.

Launch the Audit Viewer.
Click Forward Messages. The messages are forwarded from the local audit repository to the
defined Default Destination.

Launching the Focus View of the Item That Generated the Audit Message
1.
2.

Launch the Audit Viewer.
Select an audit message and choose Selected Item from the View menu.

Result
Note: Some items, such as site level items, do not support this option because they do not
have viewable information.
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Trend Viewer
Trend Viewer Overview
The Trend Viewer has three different views: Trend Viewer Chart View, Trend Viewer Table View and
Trend Viewer Definition View. The Chart View and Table View allow you to see trend data in a variety
of different formats. The Definition View allows you to configure how the data appears within the
views.
The Trend Viewer can display the data for up to 10 trends. Although you can select up to 32 items
to include in the Trend Viewer, you are limited to showing the data for a maximum of 10 trends in
the Chart or Table views. The Trend Viewer lists the included items in the Chart Legend (Chart View),
and in the Trend Items table (Definition View). Use the Chart Legend check boxes to choose which
items should be shown or hidden. You can also display multiple Trend Viewers in the display panels
of the user interface.
As you add items to the Trend Viewer, the trends for the new items are automatically shown up
to the maximum number of 10. Once 10 items are shown, you are unable to choose additional
trends to show until you hide one or more of the currently displayed trends. You can hide a trend
by clearing the check box on the Chart Legend.
Note: Changes you make to the Trend Viewer, such as changes to how the chart appears, are
only maintained while you are logged in to the Metasys system user interface. Changes apply
to all new instances of Trend Viewer, within your user session. Changes do not affect existing
Trend Viewers, Trend Study views, or Trend Extension views.

Views
There are three views in the Trend Viewer: Chart View, Table View, and Definition View.
Table 47: Views
Button

View

Description

Chart View

Allows you to view trend data in a chart format.

Table View

Allows you to view trend data in a table format.

Definition
View

Allows you to view the trend viewer setup and display options.

Trend Viewer Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data.
You can zoom, unzoom, and pan within the chart. You can also specify the X-axis and Y-axis ranges.
You can change the Y-axis type to view the chart using stacked Y-axis or a single Y-axis.
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Table 48: Chart View
Button

(Zoom)

Name

Description

Update

Retrieves the most recent data samples for the displayed trends.

Zoom

Toggles the mouse behavior for the chart between zoom mode
and normal mode.
While in zoom mode:

(Normal)

•

drag the mouse over an area of the chart to zoom in on that
area.

•

click Zoom to exit zoom mode and restore the mouse to
normal mode.

•

left-click to zoom out one level.

When you exit zoom mode, the chart remains at the current
zoom level. Use the Restore button to fully zoom out on the chart.
Notes:

•

You cannot pan while the mouse is in zoom mode.

•

You can also zoom and unzoom in normal mode by
using the Shift key and the mouse. To zoom, hold the
Shift key down while dragging the mouse across the
chart. To zoom out one level, left-click the mouse while
holding the shift key down.

Restore

Allows you to return to an unzoomed view and switches the
mouse back to normal mode if the chart's zoom mode is active.

Pan

Allows you to pan the view of the chart vertically or horizontally
by dragging the mouse across a zoomed chart. Panning is not
available for unzoomed charts or when zoom mode is active. To
pan left or right, drag the mouse over the X-axis. To pan up or
down, drag the mouse over the Y-axis.

Points Line

Displays the data using lines and point markers. This is the
default.

Area

Displays the data using an area chart.

Bar

Displays the data using a bar chart.
Note: Only use the bar chart when the number of data samples can
reasonably be expected to display as bars. If too many data samples exist when you click this option, the display becomes unstable
and fails to properly update the screen. To recover, select any other
display option.
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Points

Displays the data using markers with no lines.

Line

Displays the data using lines with no markers.

Stacked Y-axis

Displays the data in a separate Y-axis for each trend.

Single Y-axis

Displays the trend data using a single Y-axis.
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Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click
in the panel to display the menu.
Table 49: Chart Right-Click Menu
Menu Item

Description

Background Color

Opens the Select A Color dialog box and allows you to configure the
background color of the chart.

Y-axis Scale

Displays the Y-axis scale Range Configuration dialog box.

X-axis Scale

Displays the X-axis Range Configuration dialog box.

Gridlines

Allows you to select what type of gridlines appear on the chart. You can
choose: None, X and Y, X Only, and Y Only.

Chart Type

Allows you to select which type of chart to display. You can choose:
Points Line, Area, Bar, Points, and Line.

Stacked Y-axis

Displays the chart on a stacked Y-axis when check box is selected.

Chart Legend
The Chart Legend appears below the graphical charting area. The Chart Legend displays the list of
trend items for the Trend Viewer in a table, and includes information about each item. Log events
are also included.
Table 50: Legend
Button/Field Name

Description

Select All

Selects the maximum number (10) of trend items for display in
the chart.

Remove All
Selections

Deselects all trend items in the chart Legend.

Add

Opens the Select Item dialog box and allows you to add trend
items to the Trend Viewer.
Note: All items and navigation trees appear in the Select Item
window; however, you can only select trends. All other items
appear dimmed.

Remove

Allows you to remove trend items from the Trend Viewer.

Show

Indicates if the data for the trend item appears in the Chart.
When checked, the data appears on the chart and in the table.
When unchecked, the data does not appear in the chart or
table.

Historical Trend
Icon

Indicates the trend was selected from the ADS Historical
Database folder.

Marker

Indicates the appearance of the marker style and color for the
trend item on the Chart.

Color Palette

Opens the Select a Color dialog box. Allows you to change the
color used to chart the trend data.

Log Event

Indicates a change in trend log status. Possible indicators
shown vertically along the red line include:
Log Disabled, Log Purged, Log Enabled, Log Interrupted, Time
Change, Read Error
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Table 50: Legend
Button/Field Name

Description

Name

Displays the trend item name based on the Name attribute.

Reference

Displays the trend item’s full reference.

Chart Legend Right-Click Menu
You can right-click an item in the Chart Legend to access item-specific menu options. The right-click
menu content is based on the type of item you click on. For example, if you right-click a trend item
from a historical database, you can only Refresh the Trend Viewer.

Trend Viewer Table View
The Table view of the Trend Viewer allows you to view data for the selected trends in a table format.
You can copy the trend data to the clipboard for pasting into other applications such as Microsoft
Excel.
Note: The Historical Trend Icon appears in the Table View column headings when applicable.
Table 51: Table View
Button

Name

Description

Update

Updates the data samples with new trend data
immediately.

Add

Allows you to add additional trend items to the Trend
Viewer.

Copy to
Clipboard

Allows you to copy selected trend data to the system
clipboard for pasting into other applications such as
Microsoft Excel. You can also use Ctrl + C to copy data to
the clipboard.

Trend Viewer Definition View
The Definition view of the Trend Viewer allows you to view and edit the Trend Viewer setup and
charting options.
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Table 52: Definition View
Section

Description

General

Allows you to edit the refresh rate and display precision.
•

Refresh Rate: specifies the amount of time, in seconds, for automatic
refresh of data. You must configure this attribute with a value of 0 seconds,
60 seconds, or greater than 60 seconds. Values 1 to 59 are invalid and not
allowed. 0 means manual refresh. If the refresh rate is 0, click the Update
button to display new data.

•

Display Precision: specifies the decimal point rounding and the number
of decimal places used to format real values that do not report a display
precision. If the value reports a display precision, this Trend Viewer attribute
is ignored in favor of the value’s native display precision.

Range Start
Specifies the Start Time and End Time for the Trend Viewer.
and Range End
• Date: Displays the dates for the Viewer Range.
•
Chart Display

Time: Displays the times for the Viewer Range.

Allows you to add gridlines, stack the Y-axis, and choose the chart style for the
Trend Viewer.

Definition View Trend Items Table
The Trend Items table appears at the bottom of the Definition view. The table displays the list of the
Trend Viewer’s trend items.
Table 53: Definition View Trend Items Table
Button

Name

Description

Historical
Trend Icon

Indicates the trend was selected from the ADS Historical
Database folder.

Add

Opens the Select Item dialog box and allows you to add trend
items to the Trend Viewer.

Remove

Allows you to remove a trend item from the Trend Viewer.

Name

Displays the name of the trend item.

Reference

Displays the trend item’s reference information.

Plotting Style

Allows you to select the plotting method for the trend item.
•

Continuous - straight line between data samples.
Continuous plotting connects samples with the shortest
possible line, giving an appearance of a set of diagonal
ramps as samples change value.

•

Discrete - line stays at the same value until the next data
sample is taken (good for binary data). Discrete plotting
has 90-degree angles at the time when samples change
value. The chart appears to be a series of steps.

Trend Viewer Steps
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Selecting Trend Items
To select trend items for initial display in the Trend Viewer, click an individual item in the navigation
tree (select items that have trend extensions). Use the Ctrl or Shift keys to select multiple items.
You can also select items from the Global Search Viewer. In the Global Search Viewer, you can select
trend extensions or items with trend extensions. Once the Trend Viewer is displayed, you can add
additional trend items by selecting trend extensions or historical trend items in the Select Item
dialog box.
Note: If you selected an item from the navigation tree that does not have a trend extension,
the Name column in the Legend and Trend Items Table states No Trend Defined.

Launching the Trend Viewer
1.
2.

Select one or more trend items. See Selecting Trend Items.
From the View menu, select Trend Viewer. The Trend Viewer appears with data for the
selected items (if available).
Note: If the chart appears to flicker, you have too many trend samples in the Trend
Viewer. Reduce the number of displayed trends or change the trending date/time range
to display fewer samples, and performance will improve. See Removing Trends from the
Trend Viewer.

Changing Views
To change views in the Trend Viewer, click the Chart, Table, or Definition view buttons.

Editing the Chart View
Changing the Chart Type
To change the chart type in the Chart view, click one of the chart buttons (such as points, line, or
area).

Configuring the X-axis
About this task:
To configure the X-axis in the Chart view:
1.
2.
3.

Place your cursor on the chart and right-click.
Select the X-axis Scale. The Range Configuration dialog box appears.
Specify whether to Use Automatic Range Calculation. The automatic range is determined
automatically based on the setup in the Definition View.
Note: When you select Use Automatic Range Calculation, you do not fill in the Range
fields.

4.

Specify the Start Time, Start Date, End Time, and End Date.

5.

Click OK.

Result
Note: You can also configure the X-axis range by changing the start and end dates and times
in the Definition View. See Editing the Definition View.

Configuring the Y-axis
About this task:
To configure the Y-axis in the Chart view:
1.
2.
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Place your cursor on the chart and right-click.
Select the Y-axis Scale menu item. The Range Configuration dialog box appears.
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3.
4.

If you are using stacked Y-axis, choose the trend item to which the Y-axis range should be
applied.
Specify whether to Use Automatic Range Calculation. The Range is determined
automatically based on the trend items.
Note: When you select Use Automatic Range Calculation, you do not fill in the Range
fields.

5.

Specify the minimum and maximum values for the Y-axis.
Note: When you use stacked Y-axis, click Apply to apply the changes to a specific
trend item. You can continue setting the ranges for other trend items in the Range
Configuration dialog box.

6.

Click OK.

Changing the Background Color
About this task:
To change the background color in the Chart View:
1.
2.

Place your cursor in the chart view and right-click.
Select the Background Color menu item. The Select a Color dialog box appears.

3.
4.

Select a new background color.
Click OK.

Changing the Color for Charted Data
About this task:
To change the color used to plot the data for a trend item:
1.

Click the Color Palette icon in the Marker column in the Chart Legend for the desired trend
item. The Select a Color dialog box appears.

Figure 16: Color Palette Icon

2.
3.

Select a color.
Click OK. The color appears on all chart styles (not just the charts using Markers).

Zooming
About this task:
To zoom in the Chart view:
1.
2.

Click Zoom to switch the mouse to zoom mode for the chart.
Click and drag your cursor over the area to zoom.
Note: Left-click within the chart to zoom out one level. To exit zoom mode while
retaining the current zoom level, click Zoom. To exit zoom mode and restore the chart to
an unzoomed state, click Restore.

Working with the Table View
Selecting Trend Data
To select trend data, click an individual row in the Table view or use the Ctrl and/or Shift keys to
select multiple rows.
To select all of the trend data, click Select All.
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Note: You also can click and drag your cursor over rows in the table to select items that appear
consecutively.

Sorting Trend Data
To sort search the trend data in the Table view, click the heading of the desired column. The column
sorts and a small red triangle appears indicating the order of the sort (ascending or descending).
Click the column heading again to change the sort order.

Reordering Columns
To reorder the columns in the Table view, drag the heading of the column to the desired location.

Copying Trend Data to the Clipboard
About this task:
To copy trend data in the Table View to the system clipboard:
1.
2.

Select the desired trend data according to Selecting Trend Data section.
Click Copy to Clipboard.
Note: You can also use standard keyboard shortcuts to select and copy the data (Ctrl + A
to Select All, Ctrl + C to Copy).

3.

Open the program to paste the results (for example, Microsoft Excel).

4.

Paste the results according to the program’s conventions (generally Edit > Paste or Ctrl + V).

Editing the Definition View
Configuring Trend Attributes
To configure the Trend Viewer attributes, edit the values and selections using the text boxes, dropdown menus, and calendars. See the Trend Viewer Definition View section.

Changing the Plotting Style
About this task:
To change the plotting style in Definition view:
1.
2.

In the Trend Items table, click the drop-down list in the Plotting Style column.
Select either Continuous or Discrete.

Expanding and Collapsing the Legend and Trend Items Table
To expand and collapse the Legend and Trend Items table in the Chart and Definition view, click
one of the arrows
located on the splitter bar to show and hide the table. Continue to click the
arrows until the desired display is achieved.
Note: You can also drag the splitter bar to resize the Legend and Trend Items table areas.

Adding Trends
About this task:
To add trends to the Trend Viewer in the Chart, Table, and Definition views:
1.
2.

Click the Add icon. The Select Item dialog box appears.
Select one or more items (Ctrl or Shift).
Note: All non-trend items appear dimmed. If everything appears dimmed in the Select
Item dialog box, check to see if you have at least one object with a Trend Extension and/
or that Engine devices from other sites are storing samples in the Metasys Server (if
applicable).

3.
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Click OK.
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Result
Note: You can use the Select Item dialog box to select historical trends from a Metasys
Server.
At Release 8.0 and later, trends can be added to the chart and definition views of the Trend Viewer
through drag and drop functionality.
To Add Trends from the Global Search Viewer
1.

Click View > Panel Layout and select the Two Panel option. In one of the panels, open the
Trend view. In the second panel, open the global search.

2.

Perform a global search for trends on the site.

3.

Select trends from the global search results.
Note: To mass select trends in the search results hold Ctrl and click or hold Shift and
click.

4.

Drag the select trends to the Trend Viewer.

To Add Trends from the All Items Tree
1.

Select a device from the All Items Tree.
Note: To mass select device hold Shift and click.

2.

Drag the selected devices from the All Items Tree to the Trend Viewer window. All trends
associated with the device will populate in the Trend Viewer window.

Removing Trends from the Trend Viewer
1.
2.

Select one trend item from either the Chart Legend or Definition View Trend Items Table.
Click the Remove icon. The Remove confirmation dialog box appears. Click Yes.

Changing the Gridlines
To change the gridlines in the Chart view, right-click > Gridlines > and select type.
To change the gridlines in the Definition view, click the Gridlines drop-down list and select type.

Printing Trend Viewer Information
To print Trend Viewer information, follow the printing instructions in the Printing Specific Help
Topics section.

Tailored Summary Viewer
Use the Tailored Summary Viewer to view and modify large quantities of similar data in a tabular
format.
The Tailored Summary Viewer uses Summary Definitions (Insert > Summary Definition) in the SMP
to define how the similar data is displayed.
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You can use one of the following two workflows for the Tailored Summary Viewer:
•

In the All Items Tree, select the desired objects. Click View > Tailored Summary Viewer. In the
SMP, you can select the Summary Definition to define what and how the information for the
selected objects is displayed.

•

Click Query > Global Search. Select the search location, enter the desired criteria, and click
Search. From the search results, select the desired objects. In the SMP, you can select the
Summary Definition to define what and how the information for the selected objects is
displayed.

In SMP, you can use the Tailored Summary Viewer to view and modify large quantities of data.
Once data appears in a Tailored Summary View, you can select data in the view, right-click the
data you want to modify, and select the Modify function to edit the data pertinent information.
After you make modifications to data in the viewer, you must right-click the header of the view to
refresh the screen.
Note: The display limitation for Tailored Summaries is 100 rows and 7 columns.

Using a Tailored Summary
About this task:
Note: You can perform this task in the online Site Management Portal UI for the Site Director.
1.
2.
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View the Tailored Summary as described in the Viewing a Tailored Summary section.
Work with the Tailored Summary table and Key Data table as outlined in the following
table:
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Table 54: Working with Tailored Summaries
Type of Table

Available Operations

Tailored Summary table

To issue commands, select one or more items (that is, select
the table cells), then right-click and select Command. To
command all items in a column, right-click the column header
and select Command. For example, use this process to send
an operator override command to multiple items.
To make modifications, select one or more items, then rightclick and select Modify. To modify all items in a column, rightclick the column header and select Modify. See the Modify
Dialog section for details. For example, use this process to
change the Authorization Category for multiple items.
To view an item, select an item and right-click and select View.
The item appears in the display panel.
To resize a column, place the cursor between the column
headers so that the cursor is a double-sided arrow. Click and
drag the column to the desired width.
To sort the column data alphanumerically, click a column
header. Click the column header again to sort in the reverse
order.
To rearrange the order of the columns while viewing the
Tailored Summary, select a column header and use drag-anddrop to move it to the desired location.
To keep a snapshot of the Tailored Summary’s data for later
comparison, select and copy the table data. Then paste it
into a program such as Microsoft Excel®. Use the keyboard
shortcuts Ctrl+A, Ctrl+C, and Ctrl+V.
To view a graphic associated with field controller, double-click
the graphic icon that appears in the second column of the
table (by default). The graphic appears in the display panel.
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Table 54: Working with Tailored Summaries
Type of Table

Available Operations
To link a graphic to multiple field controllers, select the field
controllers, then right-click and select Modify. The Global
Modify dialog box appears. Edit the Graphic and Graphic Alias
attributes as desired and click Send. This procedure applies
only to field controllers. See Performing a Global Modify in the
Modify Dialog section for details.
Figure 17: Viewing a Graphic from a Tailored Summary

Key Data table

To issue a command, select one item and right-click and select
Command.
To make modifications to an item, select one item and rightclick and select Modify. See the Modify Dialog section for
details.
To view an item, select one item and right-click and select
View. The item appears in the display panel.
To resize a column, place the cursor between the column
headers so that the cursor has double-sided arrows (
Click and drag the column to the desired width.

).

To rearrange the order of the columns, select a column
header and use drag-and-drop functionality to move it to the
desired location.
To view a graphic associated with a field controller, doubleclick the graphic icon that appears in the first column of the
table (by default). The graphic appears in the display panel.
To link a graphic to a field controller, select the field controller,
then right-click and select Modify. The Modify dialog box
appears. Edit the Graphic and Graphic Alias attributes as
desired and click Send. This procedure applies only to field
controllers. See the Modify Dialog section for details.
Note: You cannot perform global commands/modifications or
sort the data in the Key Data table.
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Summary Definitions Library
You can access a set of pre-built Summary Definitions through the Johnson Controls License Portal.
You can download the Summary Definitions when you download the SCT software, or as a separate
download. To download the Summary Definitions to your computer, log on to the License Portal,
click the Download icon for the System Configuration tool, select the SCT Summary Definitions
check box, and then click Download. To use the pre-built Summary Definitions, import the pre-built
Summary Definition files into your site. For details, see Importing a Summary Definition.
We designed the pre-built Summary Definitions to meet the needs of the users based on common
tasks and functions. The Summary Definitions fit into the following main categories: Configuration,
Diagnostics, and Monitoring (HVAC). The Site Administrators are the intended audience for the
Device and Network Diagnostics definitions. Service Professionals will find the links to graphics and
Key Point definitions in the Mechanical Equipment definitions especially useful.
The following table lists and describes the pre-built definitions, including the definition name,
default columns (in English only), and overview description indicating typical rows, key data, and
other useful information. Click an attribute under Default Columns to view its description.
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Default Columns

Config - Analog
Alarms Main

Displays analog alarm configuration data.
The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.
Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

•

Present Value

•

Alarm Priority

•

Differential

•

Low Alarm Limit

•

High Alarm Limit

•

Alarm Ack Required

•

Normal Ack Required

•

Present Value

•

Unoccupied State

•

Occupancy Reference

•

Cooling Setpoint
Reference

•

Heating Setpoint
Reference

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - Analog
Alarms Refs
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•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Points

•

Config - Trends

Displays the Setpoint and Occupancy References
in the alarm extension. These points are used
to configure the behavior of a Room Control
Module symbol.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Alarms Main

•

Config - Analog Alarms Warning

•

Config - Trends
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Config - Analog
Alarms Warning

Displays the warning alarm configuration data.
The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.
Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

Default Columns
•

Present Value

•

Warning Priority

•

Low Warning Offset

•

High Warning Offset

•

Warning Reference

•

Warning Ack
Required

•

Report Delay

•

Present Value

•

Device Type

•

Min Value

•

Max Value

•

COV Increment

•

Out of Service

•

Relinquish Default

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - Analog
Points

•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Points

•

Config - Trends

Displays the key attributes of an analog point
that may require modifying using the Global
Modify feature or commanding using a Global
Command (see Modify Dialog and Commands
Dialog). The typical rows are any key analog
points (for example, key zone or discharge air
temperatures, key static pressures, and so on).
This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Alarms Main

•

Config - Analog Alarms Warning

•

Config - Trends

•

Config - BACnet Point Info
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Config - BACnet
Controller Info

Displays the key network configuration
attributes of any FEC controllers.

Default Columns

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - BACnet
Engine Info

Config - BACnet
Point Info

Config - Binary
Output Points

•

Config - FEC Controllers

•

Diag - FEC Controllers

Displays the key BACnet configuration attributes
of any NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Config - Engine Summary

•

Config - Engine Network Info

•

Diag - Engines

Displays the key BACnet configuration attributes
of any points on an FEC controller.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Alarms Main

•

Config - Analog Alarms Warning

•

Config - Trends

Displays binary output configuration data.
The typical rows are any key output points (for
example, fans or pump commands).
You can modify the attributes from the Tailored
Summary view using the Global Modify feature.
See the Modify Dialog section.
This Summary Definition is typically used
in a user view with the following Summary
Definition:
•
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•

BACnet Object Name

•

Model Name

•

Description

•

Object Identifier

•

Instance Number

•

BACnet Object Name

•

Model Name

•

Network Address

•

BACnet IP Port

•

Object Identifier

•

Present Value

•

BACnet Object Name

•

Object Identifier

•

Intrinsic Alarm
Defining

•

Present Value

•

Min On Time

•

Min Off Time

•

Heavy Equip Delay

•

Out of Service

•

Relinquish Default

•

Device Type

Config - BACnet Point Information
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Config - Engines
Network Info

Displays the key network configuration
attributes of any NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - Engine
Summary

Config - FEC
Controllers

•

Config - Engine Summary

•

Config - BACnet Engine Info

•

Diag - Engines

Displays the key configuration attributes of any
NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Config - Engine Network Info

•

Config - BACnet Engine Info

•

Diag - Engines

Displays the key network configuration
attributes of any FEC controllers.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - LON
Controllers

•

Config - BACnet Controller Info

•

Diag - FEC Controllers

Displays the key network configuration
attributes of any LonWorks controllers.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.
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Default Columns
•

Model Name

•

Status

•

Version

•

JCI IP Address

•

IP Mask

•

Ethernet MAC
Address

•

DHCP Enabled

•

Description

•

Model

•

Status

•

Last Archive

•

Local Time

•

Local Date

•

Model

•

Status

•

Description

•

Version

•

Address

•

Trunk Number

•

Auto Alarm

•

Status

•

Description

•

Neuron ID

•

Program ID

•

DSN 1

•

XIF Present

•

Message Entry Count
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Config - LON Points

Displays the key configuration attributes of any
points in a LonWorks based controller.

Config - Multistate
Value Alarms

Default Columns

Displays multistate alarm configuration
data. The typical rows are any key multistate
points (for example, modes of operation, fan
status, and so on) that have alarm, trend, and
averaging extensions.
Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

•

Present Value

•

Interface Value

•

Field Units

•

Manual Control

•

Update Interval

•

Target Reference

•

Priority

•

Present Value

•

Normal State

•

Alarm Priority

•

Capture Changes

•

Report Delay

•

Report Delay Active

•

Alarm Message Text

•

Status

•

Description

•

Controller Type

•

Trunk Number

•

Auto Alarm

•

Item Reference

•

Version

•

Name

•

Status

•

Gate Number

•

Network Name

•

Node Number

•

Object Count

•

Poll Delay

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Config - N2
Controllers

•

Monitoring - Alarm History

•

Config - Trends

Displays the key network configuration
attributes of any N2 controllers.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Config - NCM Info
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Displays the key configuration attributes of any
NCM. The NCMs are integrated with an NIE.
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Config - Schedules

Displays the key configuration information and
current status about the listed schedule objects.
You can use the Global Command feature
to enable or disable all the schedules in the
Tailored Summary view.
See the Commands Dialog section.
You also can use this Summary Definition for
features other than schedules.

•

Description

•

Present Value

•

Enabled

•

Item Reference

•

Authorization
Category

Displays the key network configuration
attributes of any TEC controllers.

•

Model

•

Status

•

Version

•

Auto Alarm

Displays the trend extension configuration
data. The typical rows are any key analog points
(for example, Energy Essentials meter points,
key zone or discharge air temperatures, key
static pressures, and so on) that have trend and
averaging extensions.

•

Present Value

•

Description

•

Buffer State

•

Enable

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

•

Repository Enabled

•

Sample Interval

•

Transfer Setpoint

Config - TEC
Controllers

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definition:
•
Config - Trends

Default Columns

Config - BACnet Controller Info

This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Monitoring - Alarm History

•

Monitoring - Analog Points

•

Config - Analog Points

•

Config - Analog Alarms Main
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Diag - Engines

Displays the key diagnostic attributes of any
NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Diag - FEC
Controllers

•

Config - Engine Summary

•

Config - BACnet Engine Info

•

Config - Engine Network Info

Default Columns

Displays the key diagnostic attributes of any FEC
controllers.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Diag - LON Trunks

•

Config - FEC Controllers

•

Config - BACnet Controller Info

Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.
Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information. See the Commands Dialog section.

Diag - MSTP Trunks

Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.
Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information. See the Commands Dialog section.
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•

CPU Usage

•

Battery Condition

•

% Flash Utilized

•

Estimated Flash
Available

•

% Memory Utilized

•

Object Count

•

Board Temperature

•

Model

•

Status

•

Memory Usage

•

CPU Usage

•

Object Count

•

Object Memory
Usage

•

Flash Usage

•

Lost Messages

•

Missed Messages

•

Transmit Errors

•

Transmits Per Minute

•

Transaction Timeouts

•

Bus Health Index

•

Bus Performance
Index

•

Data CRC Errors

•

Framing Errors

•

Token Loop Time

•

Lost Token

•

Buffer Overflows

Metasys Site Management Portal Help

Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Diag - N2 Trunks

Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.
Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information. See the Commands Dialog section.

Diag - VAV Box Error Displays the occupied zone temperature status
Analysis
(ZNT-State) value along with the absolute error
values from all of the possible output controllers
(for example, CLG-ABSERROR, HTG-ABSERROR,
or SAFLOW-ABSERROR). Allows you to easily
compare EWMA to identify devices with poor
relative performance.
The rows for this Summary Definition are the
VAV controllers associated with an air handling
system. The absolute error columns indicate all
the possible values available. We recommend
you remove columns not needed for your
specific application.

Default Columns
•

Command Count

•

Message Timeouts

•

Acknowledgement
Errors (NAK Errors)

•

Offline Occurrences

•

Poll Scan Time

•

Retries

•

Transmits Per Minute

•

Description

•

Current State (ZNTState)

•

Zone Temp Prmy Clg
Error

•

Zone Temp Box Htg
Error

•

Box Htg Output Error

•

Supp Htg Output
Error

•

Supply Flow Error

Note: Depending on the module instance used
by your application, the attributes used for each
column may differ. Refer to the Output Controller
chapter of the Controller Tool Help (LIT-12011147)
for details.

When using this Summary Definition, first
observe the value in the Current State column.
Then refer to the other columns as appropriate.
For example, if the Current State column
indicates that cooling is taking place, refer to the
cooling error columns for more details on the
cooling process.
This Summary Definition is typically packaged
in a user view with the following Summary
Definitions:
•

Monitoring - VMA1600 Overview

•

Monitoring - VMA1600 Flow

•

Diagnostic - VAV Box Effort Analysis

•

Configuration - FEC Controllers
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Default Columns

Diag - VAV Box
Effort Analysis

Displays the occupied zone temperature status
(ZNT-State) value along with the absolute effort
values from all of the possible output controllers
(for example, CLG-ABSEFFORT, HTG-ABSEFFORT,
or SAFLOW-ABSEFFORT). Allows you to easily
compare EWMAs to identify devices with poor
relative performance.
The rows for this Summary Definition are the
VAV controllers associated with an air handling
system. The absolute error columns indicate all
possible values available. We recommend you
remove columns not needed for your specific
application. Keep in mind that only one absolute
error column is active at any point in time based
on the present value of ZNT-State.

•

Description

•

Current State (ZNTState)

•

Zone Temp Prmy Clg
Effort

•

Zone Temp Box Htg
Effort

•

Box Htg Output
Effort

•

Supp Htg Output
Effort

•

Supply Flow Effort

•

Supply Fan Status

•

Return Fan Status

•

Mixed Air Temp

•

Zone Temp

•

Discharge Temp

•

Cooling Command

•

Heating Output

Note: Depending on the module instance used
by your application, the attributes used for each
column may differ. Refer to the Output Controller
chapter of the Controller Tool Help (LIT-12011147)
for details.

This Summary Definition is typically packaged
in a user view with the following Summary
Definitions:

Monitoring - AHUs

•

Monitoring - VMA 1600 Overview

•

Monitoring - VMA1600 Flow

•

Diag - VAV Box Error Analysis

•

Config - FEC Controllers

Displays the key point information based on
standard naming conventions for a Mixed Air
Single Duct systems. The rows for this Summary
Definition are FEC or TEC Series controllers.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated central plant
systems or weather data is typically added to
unique instances of this Summary Definition.
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Monitoring - Alarm
History

Displays the current key status information
of analog points along with the date and
time that the last alarm and return to normal
transitions occurred. The typical rows for this
Summary Definition include any key analog
points (for example, key zone or discharge
air temperatures, key static pressures, and
so on) that have alarm, trend, and averaging
extensions.

Default Columns
•

Present Values

•

Alarm Ack Pending

•

Alarm Ack Required

•

Late Alarm Date

•

Back to Normal Date

•

Last Alarm Time

•

Back to Normal Time

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:
•

Monitoring - Analog Points

•

Config - Analog Points

•

Config - Analog Alarms Main

•

Config - Analog Alarms Warning

•

Config - Trends
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Default Columns

Monitoring - Analog Displays the minimum/maximum/average
Points
values from the averaging extension and the
key description attributes for the item’s Focus
tab. The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.

•

Present Value

•

Averaging Value

•

Min Value

•

Max Value

•

Reliability

•

Item Reference

•

Box Area

•

Pickup Gain

•

Flow

•

Cooling Max Flow
Setpoint

•

Cooling Min Flow
Setpoint

•

Heating Flow
Setpoint

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

Monitoring VMA1400 Flow

•

Monitoring - Alarm History

•

Config - Analog Points

•

Config - Analog Alarms Main

•

Config - Analog Alarms Warning

•

Config - Trends

Displays the key flow setup and monitoring
information for a typical single duct, pressureindependent VAV Box application. The rows for
this Summary Definition are VMA14 controllers
that are associated with an air handling system.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:
•
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Config - VMA 1400 Overview
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Monitoring VMA1600 Flow

Displays the key flow setup and monitoring
information for a typical single duct, pressureindependent VAV Box application. The rows for
this Summary Definition are VMA16 controllers
that are associated with an air handling system.
Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:
•

Default Columns
•

Box Area

•

Pickup Gain

•

Flow

•

Cooling Max Flow
Setpoint

•

Cooling Min Flow
Setpoint

•

Heating Flow
Setpoint

Config - VMA 1600 Overview
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Table 55: Pre-Built Tailored Summary Library
Summary
Definition Name

Description

Default Columns

Monitoring VMA1400 Overview

Displays the key point information for a
typical single duct, pressure-independent VAV
Box application. The rows for this Summary
Definition are VMA14 controllers that are
associated with an air handling system.

•

Zone Temperature

•

Supply Temperature

•

Setpoint

•

Flow

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

•

Flow Setpoint

Displays the key point information for a
typical single duct, pressure-independent VAV
Box application. The rows for this Summary
Definition are VMA16 controllers that are
associated with an air handling system.

•

Zone Temperature

•

Supply Temperature

•

Setpoint

•

Flow

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

•

Flow Setpoint

•

Damper Output

•

Heating Output

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:
•
Monitoring VMA1600 Overview

Config - VMA 1400 Flow

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:
•

Config - VMA 1600 Flow

Tailored Summary Viewer User Interfaces in SMP
Tailored Summary Definition Editor
On a Site Director, the Summary Definition Editor allows you to define and edit an SCT Summary
Definition object. The SCT Summary Definition Editor appears when you view an SCT Summary
Definition object. In the SMP user interface, you view large quantities of live data in a tabular
format. SCT Summary Definition objects always reside on a Site Director in the Configuration
Data > SCT Summary Definitions folder of the All Items tree (that is, you cannot put a SCT Summary
Definition object in another location).

Summary Definition Tab
The Summary Definition Editor's Summary Definition tab allows you to define the table that
appears in the Tailored Summary Viewer.
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Figure 18: Summary Definition Editor - Summary Definition Tab

Table 56: Summary Definition Editor - Summary Definition Tab
Button/Field

Description

Label

Defines the label to display in the first column (that is, the row header
column) in a Tailored Summary. The label is limited to a maximum of
50 characters. This field also can be left blank.

Add/Plus

Allows you to add a column at the end of the column configuration
table. To select a column, click the column heading.
Note: One column is created by default when you create the definition.
You must define a minimum of at least one column. The display limitation for Tailored Summaries is 100 rows and 7 columns. You may not see
optimal performance when tables exceed this recommendation.

Remove/Minus

Allows you to remove the currently selected column from the column
configuration table. To select a column, click the column’s header.
Note: One column is created by default when you create the definition.
You must define a minimum of at least one column, and if there is only
one column, you cannot delete it.

Metasys Site Management Portal Help

127

Table 56: Summary Definition Editor - Summary Definition Tab
Button/Field

Description

Column Configuration
Table

Lets you configure the columns that appear in the Tailored Summary:
•

Column Heading - Defines the name of the column heading. The
name can have a maximum of 50 characters.

•

Child Item - Indicates the item for which the column data is
retrieved based on its item name attribute. You can use the
Select Item dialog box to pick a name, or type in the text box. The
name must match a user-specified pattern (such as ZN-* or ZNT, Zone-T). You can define an unlimited number of wildcards. The
first item found that matches this item name pattern appears in
the Tailored Summary view column. To display an attribute of the
row item, leave this field blank. Otherwise, specify the name of
the child item to display.
Note: To mass search child-item strings, separate your search criteria with commas. For example, ::classid:156,172,155.

•

Attribute - Defines the attribute information for the column. To
display the default attribute, no change is required (that is, leave
the Attribute box set to Default). The attributes are grouped
into categories for easy selection. To specify an attribute, select
a category in the Attribute Filter section of the Select Column
Attribute dialog box, and then select the desired attribute from
the list.

•

User Definable Attributes
Note: To change the order of the columns, select a column and drag it to
the desired placement.
Note: When you display a Tailored Summary, the system searches for
data within all levels of a field device (VMA, for example). For all other
objects (NAE, for example), the system searches for data only one level
down (no subsequent levels).
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Table 56: Summary Definition Editor - Summary Definition Tab
Button/Field

Description

Browse (Child Item)

Opens the Select Item dialog box where you can specify the item
name.
Note: This dialog box provides an easy way to fill in the item name of a
child item. It does not mean that the selected item displays in that column.

Browse (Attribute)

Opens the Select Column Attribute dialog box where you can select
the attribute to display in the column of the table. This process is
necessary only when selecting an attribute other than the default
attribute.
This dialog box has two list boxes to aid in selection:
•

Attribute Filter - Allows you to filter the items appearing in the
Attribute list using common attribute categories. If you filter on
Alarms, for example, the supported alarm attributes appear in
the list for selection.

•

Attribute - Lists the available attributes for selection.
Note: To display the default attribute of the row item, leave the Attribute
box set to Default (Attribute Filter: Common Attributes and Attribute:
Default).

Summary Definition Configuration Tab

The Summary Definition Configuration tab allows you to edit the configuration data for the
Summary Definition.
Table 57: Tailored Summary Definition - Configuration Tab
Attribute

Description

Name

Allows you to enter a name for the Summary Definition object. There is
a plain text limit of 400 characters.

Description

Allows you to enter a description of the Summary Definition object.
There is a plain text limit of 40 characters.

Object Type

Indicates the Object Type.

Authorization Category

Lets you choose the Authorization Category for the Summary Definition
object. The default Authorization Category for the Summary Definition
object is General.

Summary Definition Wizard Descriptions
Use the Create New Summary Definition Wizard to create a Summary Definition object from
scratch. Access this wizard using the Summary Definition option on the Insert menu.
Table 58: Create New Summary Definition Wizard
Screen

Description

Destination

Displays the save location of the new Summary Definition. You can only save
files in the Configuration Data > Summary Definitions folder.

Identifier

Specifies a name for the Summary Definition object. A maximum of 32
characters.
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Table 58: Create New Summary Definition Wizard
Screen

Description

Configure

Defines the data of the Summary Definition and Configuration tabs.

Summary

Displays the summary data of the Summary Definition object.

Tailored Summary Viewer Workflows
The following tables are high-level workflows for creating and using Summary Definitions in the
Tailored Summary Viewer. These workflows assume a desired Summary Definition exists.
Table 59: Tailored Summary Viewer Workflow - Using the All Items Tree
Step

Description

1

In the All Items tree, select the objects you would like the Summary Definition to apply to
in the Tailored Summary Viewer.

2

Click View > Tailored Summary Viewer. The Tailored Summary Viewer appears.
Select a Summary Definition to apply to the objects.

3

Select a Summary Definition to apply to the objects.

Table 60: Tailored Summary Viewer Workflow - Using Query > Global Search
Step

Description

1

Click Query > Global Search. The Global Search Viewer appears.

2

Click Add to select the Search Locations. You can select multiple locations.

3

Enter the search criteria. You can enter an object name, object type, include child objects,
and include search locations in the search criteria. For more information, see Global
Search.

4

Click Search.

5

Select the rows you would like the Summary Definition to apply to in the Tailored Summary
Viewer.

6

Click View > Tailored Summary Viewer. The Tailored Summary Viewer appears.

7

Select a Summary Definition to apply to the objects.

Column Attributes for Summary Definitions
When creating or editing a Summary Definition, the Select Column Attribute dialog box allows you
to select the attributes to display in the Tailored Summary Viewer.
The following table lists examples of the attributes available for display in the Tailored Summary
feature according to the attribute filter. Click an attribute in the table to view its description. For
information on other attributes that do not appear in this table, search within this Help system PDF
by holding down Ctrl + F, or see the Index.
Table 61: Example Column Attributes for Summary Definitions
Attribute Filter
BACnet

Common Attributes
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Example Attributes
•

BACnet IP Port

•

Instance Number

•

Intrinsic Alarming Defined

•

Object Name

•

Authorization Category
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Table 61: Example Column Attributes for Summary Definitions
Attribute Filter

Example Attributes

Field Devices (General)

•

Disable Automatic Alarming

Field Devices (LON)

•

DSN1

•

Neuron ID

•

Program ID

•

XIF Present

•

Memory Usage

•

Object Count

•

Trunk Number

•

Device Status

•

NCM Name

•

Object Count

•

Poll Delay

•

Controller Type

•

Trunk Number

•

Device Type

•

Max Value

•

Min Value

•

Out of Service

•

Command Status Mapping Table

•

Interface Value

•

Target Reference

•

Update Interval

•

Feedback

•

Setpoint

•

APDU Retries

•

Buffer Overflow

•

Bus Health Index

•

Bus Performance Index

•

Missed Messages

•

Transmit Errors

•

Transaction Timeouts

•

Transmits Per Minute

Integrations (N2)

•

Command Count

Space

•

Served By

•

Type

Field Devices (MSTP)

Field Devices (N1)

Field Points (N2)
Field Points (General)

Field Points (LON)

Field Points (N1)
Integrations (MSTP)

Integrations (LON)
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Table 61: Example Column Attributes for Summary Definitions
Attribute Filter

Example Attributes

Supervisory Devices

Trends

•

ADS Repository

•

JCI IP Address

•

Model Name

•

Object Count

•

Buffer State

•

Enable

•

Sample Interval

•

Transfer Setpoint

Defining User Views with Summary Definitions
1.
2.

Create a user view or edit an existing one (for example, an HVAC user view).
Add a folder to the user view to hold the Summary Definitions. For example, add a Summary
Definitions folder, or a folder named according to function (such as VAV Boxes - VMA1400s,
Key Point Information, Engines, or MSTP Trunk Diagnostics).

3.

Drag the definitions from the Summary Definitions folder in the All Items tree to the folder
you created in the user view (or use the user view editor’s add reference option).
Drag the items to reference (for example, supervisory devices or points) from the All Items
tree or from the global search results table to the folder in the user view (or use the user view
editor’s add reference option).
Save the user view.

4.

5.

Defining Key Data
About this task:
Notes:
•

You can perform this task in SCT or the online Site Management Portal UI for the Site Director.

•

See the Focus Tab and Summary Definition Object sections for information on the Key Data
attribute of the Summary Definition.

1.

In the Summary Definitions folder of the All Items tree, right-click the Summary Definition
and click View. The Summary Definition appears in the display panel.
On the Focus tab, click Edit.
In the Key Data list box, click the browse button. The Modify List dialog box appears.
Add Key Data as follows:
a.
Click Add. An undefined item appears in the list.
b.
Click the Browse button of the item. The Select Item dialog box appears.
c.
Select an item.
d.
Click OK.
Notes:

2.
3.
4.

-

5.
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You also can type in the text box and use wildcards (asterisks * only) to search
for the item within the user view folder.
- You can define up to four Key Data items.
Select an item and click Remove to delete the item from the Key Data list.
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6.
7.
8.

Select an item and click Move Up or Move Down to rearrange the order the items appear in
the list.
Click OK.
Click Save.

Viewing a Tailored Summary
About this task:
Note: You can perform this task in the online Site Management Portal UI for the Site Director.
1.
2.

Click the desired user view tab in the navigation pane.
Double-click the user view folder containing the Summary Definitions and referenced items
(for example, the Summary Definitions folder). The Tailored Summary appears in the display
panel. See the Viewing a Tailored Summary section for a description of the Tailored Summary
View user interface.
Note: If the user view does not contain a Summary Definition, only the standard
Summary appears.

3.

4.
5.

Click the Tailored Summary you want to view from the Available Tailored Summaries list
box if more than one Summary Definition appears in the list. By default, the first authorized
Summary Definition in the list is automatically selected.
View the key data and the table data.
Use the right-click menu options to command, modify, or otherwise work with the data. See
Using a Tailored Summary.

Tailored Summary Troubleshooting
Table 62: Tailored Summary Troubleshooting
Problem

Solution

In the Tailored Summary view,
the child item does not display
data from an object after editing
its Object Name attribute.

If you change the Object Name attribute of an object after
configuring the Summary Definition object, the link to the Child
Item breaks. Change the Child Item wildcards in the Summary
Definition object to match the new Object Name attribute.

With a Release 5.0 NAE45 Site
Director, points in a Tailored
Summary display slowly and may
time out.

This issue was resolved in Release 5.1. If this delay is
problematic, we recommend you upgrade to Release 5.1 or
later.

When running a Tailored
Summary, user views with large
point counts display red Xs.

On a summary view with more than 500 objects from a single
NxE, you may occasionally see red Xs if the device is busy. As
the view continues to update data, the red Xs disappear.

Scheduled Reports Viewer
You can access the Scheduled Reports Viewer from the View Menu. The Scheduled Reports Viewer
has three main screens/tabs.
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Table 63: Scheduled Reports Viewer Tabs
Tab

Description

Actions in Progress Allows you to monitor, enable/disable, reschedule, delete, and reschedule
reports that are in progress or pending.
Scheduled Actions

Allows you to enable/disable, delete, edit, and run upcoming scheduled
reports.

Completed Actions

Allows you to view the status of completed reports, reschedule reports,
delete the status entries from the screen, and view the content Scheduled
Report output file.

Change Results Viewer
The Change Results Viewer allows you to view, save, and print the results of global commands
and global modifications sent using the Global Commands and Global Modify features. See the
Commands Dialog and Modify Dialog sections for information on these features.

Change Results Viewer Concepts
Change Results Viewer Overview
The Change Results Viewer displays the result entries for the global commands and global
modifications sent during the current user session. You can access the Change Results Viewer by
selecting Change Results from the View Menu.
Note: The Change Results Viewer screen is available for global commands and global
modifications only. Single object commands and modifications do not appear in the Change
Results Viewer.
Figure 19: Change Results Viewer Screen
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Table 64: Change Results Viewer Screen Components
Column/Button

Description

Change Results Table

Displays the results of all global commands/modifications sent during the
current user session.
If you select an item in the table and place your cursor over it within each
column, tooltips appear providing more information, if available.
Any data that does not fit within the columns is identified by an ellipsis
(. . .). You can resize the column or place your cursor over the table cell to
see its tooltip text.
If you send another global command/modification at a later time during
the current user session, the result entries are added to any existing result
entries from prior commands/modifications sent during the session.
The most recent entry appears at the top of this table by default. If
desired, you can sort the results.
See the Working with the Change Results Viewer section for more
information on manipulating and using the table data.

When

Displays the date and time the command/modification was sent.

Item

Displays the name of the object to which the command/modification was
sent. The object’s full reference identifier appears in a tooltip when you
place the cursor over the name.

Change Type

Displays the type of command/modification sent.

Parameters

Displays the list of parameters for the command/modification that was
sent. For example, for a Release command, an attribute and priority such
as Present Value, 15 (Scheduling) appear in the Parameters column.

Status

Displays the status of the command/modification that was sent (for
example, OK or an explanation of failure).
Notes:
•

An OK status for a command indicates the supervisory device
validated and accepted the command, but does not necessarily
indicate the command executed successfully. There may be cases
where the command is accepted, but fails execution. For example,
a Route command to a trend extension may be accepted by the
supervisory device with a status of OK; but if the actual routing of the
trend data fails due to the ADS offline or other error, the failure is
noted in the Audit log at that point in time.

•

An OK status for a modification indicates the modification executed
successfully.

Clear Results Viewer

Deletes all the entries from the Change Results Viewer and adds an entry
to indicate when it cleared those entries.

Copy

Copies the selected change results to the Clipboard for pasting into other
applications such as Microsoft Excel® or Word®.

Save to File

Saves the current content of the change results table to a text file.

Change Results Viewer Steps
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Working with the Change Results Viewer
Displaying the Change Results Viewer
To display the Change Results Viewer, select Change Results from the View menu. The Change
Results Viewer appears in the display panel.
Note: If no global commands/modifications were issued during the current user session,
the Change Results Viewer appears with a message stating No global commands or
modifications have been issued within the current session.

Selecting Entries in the Change Results Viewer
To select entries in the Change Results Viewer, click an individual entry in the change results table
or use the Ctrl or Shift keys when clicking to select multiple entries.
Note: You also can click and drag your cursor over entries in the change results table to select
entries that appear consecutively. With an entry in the change results table selected, you can
press Ctrl+A to select all entries.

Sorting Change Results in the Change Results Viewer
To sort change results in the Change Results Viewer, click the heading of the desired column in the
change results table. The results sort and a small arrow appears indicating the order of the sort
(ascending or descending). Click the column heading again to change the sort order.

Reordering Columns in the Change Results Viewer
To reorder the columns in the Change Results Viewer, drag the heading of the column to the
desired location.

Printing the Change Results
To print the contents of the Change Results Viewer, follow the Print instructions in the Site
Management Portal User Interface section.

Saving Change Results to File
About this task:
To save the contents of the Change Results Viewer to a file:
1.
2.

Click Save to File. The Save dialog box appears.
Specify the desired location to save the results.
Note: The default name for the text file is ChangeResultsLog.txt. You can change the
name as you wish to further identify these results, or to prevent overwriting previously
saved results.

3.

Click Save.

Copying Change Results to the Clipboard
About this task:
To copy change results in the Change Results Viewer to the clipboard:
1.
2.

Select the desired results according to the Selecting Entries in the Change Results Viewer
section.
Click Copy.
Note: You also can use Ctrl+C to copy the data.

3.
4.
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Open the program to paste the results (for example, Microsoft Excel or Word).
Paste the results according the program’s conventions (generally, Edit > Paste or Ctrl+V).
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Clearing the Change Results Viewer
About this task:
If the size of the results log becomes too large, the Global Command or Global Modify feature
prompts you to clear the change results.
To clear all change results in the Change Results Viewer:
1.
2.

Click Clear Results Viewer. A dialog box appears asking if you want to permanently clear all
command results.
Click Yes.

Extended Labels
Menu Selection: View > Extended Labels (select the check box)
Toggles the display of the item labels in the All Items navigation tree or user navigation tree from
standard to extended. An extended label shows the BACnet object name that was defined when the
object was initially created in braces next to the standard label. This is the name used in the object's
Fully Qualified Reference. The Metasys object name may be the same as the BACnet object name, or
it may have been edited as a label that is more recognizable to the user.
Example:
Standard Label = N2 Trunk1
Extended Label = N2 Trunk1{N2-1}

Validation Labels/Settings
Menu Selection: View > Validation Labels > Validation Settings (in the SCT UI) (select the check box)
In the SCT, this setting toggles the display of the item labels in the All Items navigation tree or
user navigation tree to show extra label information for MVE. When selected, this menu item also
displays the Validation Settings attribute section for objects on the Focus/Configuration tab.
This setting has no effect in the online UI (the validation labels are always visible).

Enable Alarm Pop-Ups
Menu Selection: View > Enable Alarm Pop-Ups (select the check box to enable/disable alarm popups)
For the current user session, this item determines if the pop-up Alarms Window (also referred to as
Metasys - Events or Alarm Bar) automatically displays when an alarm is detected.
Clicking the alarm icon in the status bar re-enables alarm pop-ups and displays the current alarm, if
any.
If you disable the alarm pop-up window and you have the audible alarm option enabled, the
audible alarm sounds when an alarm is detected. See the Alarms Window section in the Site
Management Portal User Interface.

Panel Layout
The Display Frame can be divided into up to four display panels. When viewing an item in a display
panel, the name, status, and default attribute (usually the present value) of the item you display
appear at the top of the display panel. Each display panel can contain different tabs, depending
on the item selected from the navigation tree, and each tab shows different information. Dynamic
attributes displayed in a panel automatically refresh when changes are detected.
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The default display panel is the first empty panel or last unlocked panel if all displayed panels are
filled. Display panels are locked while in Edit mode, or may be locked using the Lock button of the
selected display panel. If all available panels are locked, you cannot display an additional item in
any of the display panels.
You can resize each display panel by dragging its borders, or using an available splitter bar. With
some items, an Edit button appears (except in Simulation mode), allowing you to edit the item’s
configuration attributes.
You can drag and drop items into a display panel and navigate among them using the Back and
Forward display panel buttons. The display panel holds a maximum history of five items.
If you run any of the predefined reports found in the Query Menu, the result of the query appears
in an available panel in a spreadsheet format. Sort the report results by clicking the column
heading, and resize columns by dragging column borders. When you scroll down through the
column, the headers remain visible.
The data presented in a report comes from a snapshot of the system at the time you request the
report. The displayed data does not automatically refresh and does not support an Edit mode. You
can manually refresh the report through the Action Menu.

Display Frame Layout
The user interface allows you to define your own display frame layout. Six options are available:
Figure 20: Panel Layout Options

To change the way the panels are arranged, see Changing the Display Panel Layout. If you have a
multi-panel display and you change to a layout with fewer panels, the locked items/newest items
in the view stay, depending on how many panes are available in the new layout. The other panels
close, and they do not reappear if you switch back to the multi-pane view.
To resize the panels, drag the borders of the panel until it reaches the desired size. To make one
panel (in a multi-panel arrangement), take up the entire Display frame temporarily, click the
maximize button. To restore a maximized panel in a multi-pane view, click the restore button. A
panel can also be maximized/restored by double-clicking its header bar.

Display Panel Tabs
Each display panel contains tabs that vary depending on the item displayed.
For example, most of the point objects, such as the OAT contain the following tabs:
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Table 65: Tabs
Tab

Description

Alarm

Becomes available when you define an Alarm Extension for a point. The New and
Delete buttons allow you to add or delete Alarm Extensions for the point. The Basic
and Advanced radio buttons allow you to filter the attribute display in this tab. The
Edit button allows you to change configurable attributes.

Focus

Becomes available when you define a point object. The Focus tab shows operation
attributes available for the object type to which the object belongs. Note that the
Basic and Advanced radio buttons allow you to filter the attribute display in this tab.
The Edit button allows you to change configurable attributes.

Hardware

Becomes available when you define a point object that has a reference to a physical
input or output. The Hardware tab shows hardware-related attributes available for
the object type to which the point object belongs.

BACnet
Alarm

Becomes available when you define a BACnet intrinsic alarm for a point. The
Intrinsic Alarming Defined attribute is explained in Trend Extension Attributes
section. The BACnet Alarm tab shows BACnet Alarm-related attributes available for
the object type to which the point object belongs. The Basic and Advanced radio
buttons allow you to filter the attribute display in this tab. The Edit button allows
you to change configurable attributes.

Totalization

Becomes available when you create a Totalizator Extension. New and Delete
buttons allow you to add or delete Totalization Extensions for the point. The Edit
button allows you to change configurable attributes.

Trend

Becomes available when you create a Trend Extension for a point object. New and
Delete buttons allow you to add or delete Trend Extensions for the point. The Chart
view allows you to view data samples in a graphical format and retrieve new trend
data. The Table view of the Trend Extension allows you to view the trend’s data
samples in a table format. The Definition view of the Trend Extension allows you to
view and edit the attributes of the trend extension object.

Averaging

Becomes available when you create an Averaging Extension for a point object. The
New button allows you to add Averaging Extensions for the point.

Load

Becomes available when you create a Load Extension for a point object. The New
button allows you to add Load Extensions for the point.

Other items may contain fewer or more tabs. For example, the item representing a network engine
or Metasys Server contains the following tabs:
•

Focus

•

Summary

•

Diagnostic

•

Communication

•

Network

•

Email (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)

•

Pager (removed from the ADS/ADX at Release 10.1 and later)

•

SNMP (disabled in the ADS/ADX at Release 10.1, but enabled in Metasys UI)

•

Alarm

•

Trend
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•

Syslog (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)

• Printer (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)
For information on the tabs available in the system, see the Object and Feature Tabs section.

Display Panel Buttons
Table 66 shows the display panel buttons.
Table 66: Display Panel Buttons
Button

Description
Allows you to edit attributes for the displayed item. The values you can edit vary
depending on the displayed item. Click Save to save your changes.
Note:

•

This button does not appear in Simulation mode.

•

This button appears dimmed if the user has Standard Access mode,
but does not have Modify Items permission for the object being
viewed.

•

The term edit refers to changing items using the Edit button. See the
Modify section. The term modify refers to changing items using the
Modify menu item and the Modify dialog box. See the Modify Dialog
section.

Displays the content previously displayed in that panel. Each panel can have a
display history of up to five items.
Displays the content of the next panel saved in the history.
Locks the selected display panel (prevents another item from being dropped in
this panel and overwriting it). A locked panel can be resized. This button toggles
between locked and unlocked.
Maximizes the active panel to the full size of the Display Frame. You can
also maximize the pane by double-clicking the header bar. The other panels
reappear if you click the restore button.
Restores the panels to their original size and position. You can also restore the
pane by double-clicking the header bar.
Closes just the currently displayed view in the display panel.
Closes all of the views in the display panel (including views stored in history).
Displays commonly used information about the displayed item.
Displays all the information the system contains pertaining to the displayed
item.

Action Menu
In addition to the four modes of operation that determine the items appearing in menus, the Action
menu is context-specific. Different item-specific options appear in the Action menu based on what
is currently selected in the navigation tree. Also, different feature-specific options appear in the
Action menu based on the active panel or feature displayed in the selected display panel.
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Note: The options available in the Action Menu are also available from the Right-click
functionality.
The following table lists the menu items for the Action menu. For details on which options appear
with certain items or features selected, see:
•

Action Menu - Item Specific

• Action Menu - Feature Specific
Click one of the following menu items for a description of the menu item.
Table 67: SMP Action Menu
Menu Item
Command
Modify

Show Extensions

11

22

Ack

33

View Annotations

Locate in Tree

Add Annotation

Discard

Refresh

Import Integration

Refresh Current Tab

Remove From Site

3

44

Import Definition

4

Export Definition
1
2
3
4

Refresh All Tabs

The commands in the Command dialog require authorization.
The attributes in the Modify dialog require authorization.
Available on the Metasys Server only.
Available for the Summary Definitions folder in the All Items tree.

Action Menu - Feature Specific
The following table describes the different menu items that appear in the Action menu based on
the active panel or feature displayed in the selected display panel. Click each active panel or feature
for a description. For more information on the modes of operation, see Metasys Modes.
Note: The Refresh, Refresh Current Tab, and Refresh All Tabs menu items appear in the Action
menu for all other features or active panels.
Table 68: Action Menu - Feature Specific
Active Panel/Feature
Event Viewer

Audit Viewer

Scheduled Reports (available on the Metasys
Server only.)
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Content
•

Refresh

•

Add Annotation (available on the Metasys
Server only.)

•

View Annotations (available on the Metasys
Server only.)

•

Ack

•

Discard

•

Refresh

•

Add Annotation (available on the Metasys
Server only.)

•

View Annotations (available on the Metasys
Server only.)

•

Clear Audit Log

•

Refresh
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Table 68: Action Menu - Feature Specific
Active Panel/Feature
Tailored Summary Viewer
The menu options available are item-specific
(that is, they depend on the type of item
selected in the Summary Definitions and Key
Data tables).

Trend Viewer

Global Search

Change Results Viewer

Content
•

Command

•

Modify

•

Add Annotation (available on the Metasys
Server only.)

•

View Annotations (available on the Metasys
Server only.)

•

Show Extensions

•

Remove From Site (available for a network
engine only).

•

Import Integration (available for a Tailored
Summary with trunk/integration data. For
example, trunk diagnostics).

•

Refresh

•

Command

•

Refresh

No Action menu options for this feature.

Action Menu - Item Specific
The following table describes the different menu items that appear in the Action menu based
on what is currently selected in the navigation tree. Click each item for a description. For more
information on the modes of operation, see Metasys Modes.
Note: The Refresh Current Tab and Refresh All Tabs menu items appear in the Action menu for
all of these items.

142

Metasys Site Management Portal Help

Table 69: Action Menu - Item Specific
Item

Contents In Mode
Online (Standard
Access)

ADS Device Object

Integration

Site Object

Supervisory Device
(Network Engine)

All Other Objects

Offline (SCT)

Simulation

•

Command

•

Modify

•

Modify

•

Rename

•

Add Annotation

•

View Annotations

•

Remove From Site

•

Command

•

Modify

•

Command

•

Modify

•

Show Extensions

•

Show Extensions

•

Add Annotation

•

Import Integration

•

View Annotations

•

•

Show Extensions

•

Import Integration

Export .caf files on
a MSTP Field Bus
integration

•

Command

•

Site Discovery

•

Command

•

Add Annotation

•

View Annotations

•

Command

•

Modify

•

Command

•

Modify

•

Show Extensions

•

Show Extensions

•

Add Annotation

•

Start Simulation

•

View Annotations

•

Rename

•

Show Extensions

•

Remove From Site

•

Command

•

Modify

•

Command

•

Modify

•

Show Extensions

•

Show Extensions

•

Add Annotation

•

View Annotations

•

Show Extensions

Commands
Use commands to force an item to perform a specific action. For example, ON and OFF commands
for a binary output make a fan run or stop, and the Enable and Disable commands in the Trend
extension start and stop the collection of samples.
For information on which commands an item supports, see the appropriate topic in the Object
Help.
For information on how to send a command to a single item, see Commanding an Item in the
Commands Dialog section.
For information on sending a command to multiple items, see Commanding Multiple Items (Global
Command) in the Commands Dialog section.
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Commands Dialog
The Commands dialog box allows you to send a command to a single item (single command
feature) or to multiple items at once (global commands feature). You can open the Global Search
Viewer or a Tailored Summary, for example, in a display panel and select one or more items from
the table to command. For example, you could send a command to open all the reheat valves on
VAV boxes so the balancer can balance the hot water system in your facility.
The single command feature uses the Commands dialog box. The global commands feature uses
the Global Commands dialog box for sending commands and uses the Change Results Viewer for
viewing, saving, and printing the sent global commands.
For information on the Change Results Viewer and how to use it, see the Change Results Viewer
section. The Change Results Viewer is used by both the Global Modify and the Global Commands
features.
See Using Global Commands with the Global Search in this section for steps on using the Global
Search and Global Commands features together.

Commands Dialog Concepts
Commands Overview
You can send a command by selecting one or more Metasys system objects (items) in the
navigation tree or in the display panel. For example, you can open the Global Search Viewer in
a display panel and select one or multiple items from the Search Results table to command. See
Commanding Objects in the Search Results Table in the Global Search section.
For the global commands feature, the Change Results Viewer displays the results of all global
commands sent during the current user session. The viewer includes information such as change
type, time, status, item name, and parameter. You can save the results to a text file or print the
results if you wish to review them at a later time. The Change Results Viewer provides the option to
copy one or more result entries to the clipboard for pasting into Microsoft Excel or Word or other
applications. You also can sort the results table data in ascending or descending order, and resize
and reorganize the columns to suit your needs.
Once you log out of the Metasys system, the current user session closes and the items in the
Change Results Viewer are permanently cleared.
See the Commands Dialog Box, Global Commands Dialog Box, and Change Results Viewer sections.

Commands Dialog Box
The Commands dialog box allows you to configure and send a command to a single item in the
Metasys system. You can access the Commands dialog box from the Action Menu by selecting
Command. You also can access the Commands dialog box from the right-click menu (in supported
views).
Note: Commands issued through the Commands dialog box are not shown in the Change
Results Viewer.
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Figure 21: Global Commands Dialog Box - Commands Tab
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Table 70: Commands Dialog Box Components
Callout

Screen Area/
Item

Description

1

Instructions Area

Provides tips to help you send a command.

2

Show Command
Set Drop-Down
Menu

Allows you to filter the commands list by:
•

All Commands: Shows all commands for the item.

•

Primary Commands: Shows the commonly used
commands for the item. The Preliminary Commands
selection shows only the Archive, Reset Device, and
Route Samples commands.

•

Secondary Commands: Shows the less commonly
used commands for the item. The Secondary
Commands selection shows only the Change
Audit Enabled Class Level and Update Flash Usage
commands.
Note: User Preferences determines the default setting.

3

Commands List

Displays the list of commands available for the selected
item. Unauthorized commands are either grayed out
(disabled) or not shown (hidden), depending on user
preference settings. The default is grayed out. For
commands that require parameter values, the fields
appear after selecting the command.

4

Send

Sends the selected command to the object/item. All
commands are sent at the default priority for the
command.

5

Cancel

Closes the Commands dialog box without sending the
command.

Global Commands Dialog Box
The Global Commands dialog box allows you to configure and send a command to multiple items
in the Metasys system. You can access the Global Commands dialog box from the Action Menu by
selecting Command. However, you must have more than one object selected in the navigation
tree or the display panel to open the Global Commands dialog box. You also can access the Global
Commands dialog box from the right-click menu (in supported views).
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Figure 22: Global Commands Dialog Box - Commands Tab

Figure 23: Global Commands Dialog Box - Items Tab
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Table 71: Global Commands Dialog Box Components
Callout

Screen Area/ Description
Item

1

Instructions
Area

Provides tips to help you send a global command.

2

Commands
Tab:
Commands
List

Displays the list of commands available for the selected items.
Unauthorized commands are either grayed out (disabled) or not
shown (hidden), depending on user preference settings. The default
is grayed out. For commands that require parameter values, the
fields appear after selecting the command.

3

Items Tab

Lists the selected items in table format and indicates:

4

Commands
Tab: Show
Command
Set DropDown Menu

•

if you are authorized/unauthorized to send the command to
the items

•

the command to be sent

•

the number of items to be commanded

Allows you to filter the commands list by:
•

All Commands: Shows all commands for the item.

•

Primary Commands: Shows the commonly used commands
for the item. The Primary Commands selection shows only the
Off, On, Operator Override, Release Operator Override, and
Change Default Value commands.

•

Secondary Commands: Shows the less commonly used
commands for the item. The Secondary Commands selection
shows only the Release and Release All commands.
Note: User Preferences determines the default setting.

5

Send

Sends the selected command to the objects listed in the Items tab.
All commands are sent at the default priority for the command.

6

Cancel

Closes the Global Commands dialog box without sending the
command.

7

Show
Command
Results

When selected, displays the Change Results Viewer in the display
panel after clicking Send.

Global Command Support
The following table lists the objects that can be commanded using the global command feature,
and the available commands.
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Table 72: Global Command Support
Object

1

Commands

Accumulator Object

•

Present Value

Alarm Extensions

•

Enable

•

Disable

•

Cancel Delay Time

•

Cancel Report Delay

•

In Service

•

Out of Service

•

Temporary Out of Service

•

Enable Alarms

•

Disable Alarms

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

Temporary Override

•

Adjust

•

Setpoint (N2 AO only)

•

Enable Alarms

•

Disable Alarms

•

In Service

•

Out of Service

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

Temporary Override

•

Adjust

•

Change Default Value (MS/TP only)

•

Enable Alarms

•

Disable Alarms

•

In Service

•

Out of Service

•

Temporary Out of Service

•

Enable Alarms

•

Disable Alarms

Analog Input Object

Analog Output Object

Analog Value Object

Binary Input Object
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Table 72: Global Command Support
Object

Commands

1

Binary Output Object

Binary Value Object

Engine Device Object

Global Data Object
Integration Objects
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3

•

Release All

•

Release

•

Operator Override

•

Temporary Override

•

Release Operator Override

•

In Service

•

Out of Service

•

Enable Alarms

•

Disable Alarms

•

State Commands

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

Temporary Override

•

State Commands

•

Change Default Value (MS/TP only)

•

Enable Alarms

•

Disable Alarms

•

Apply Staged Files

•

Cancel Staged Files

•

Archive

•

Reset Device

•

Change Audit Enabled Class Level

•

Update Flash Usage

•

Route Samples

•

Rediscover Text Strings

•

Enable

•

Disable

•

Activate Provisioning

•

Analyze Field Bus

•

Clear Statistics

•

Latch Statistics

•

Refresh Provisioning Discovery

•

Sync Field Device Time(s)

2

2
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Table 72: Global Command Support
Object

1

Load Extensions

Multiple Command Object

Multistate Input Object

Multistate Output Object
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Commands
•

Unlock

•

Lock

•

Shed

•

Release Load

•

Comfort Override

•

Release Comfort Override

•

Enable

•

Disable

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

State Commands

•

Enable

•

Disable

•

In Service

•

Out of Service

•

Temporary Out of Service

•

Enable Alarms

•

Disable Alarms

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

Temporary Override

•

State Commands

•

Enable Alarms

•

Disable Alarms

4

4
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Table 72: Global Command Support
Object

Commands

1

Multistate Value Object

•

Release All

•

Release

•

Operator Override

•

Release Operator Override

•

Temporary Override

•

State Commands MSV Mapper (MS/TP FEC MSV only):

•

Set State Command

•

Change Default Value

•

Enable Alarms

•

Disable Alarms

•

Enable

•

Disable

Schedule Object

•

Enable

•

Disable

Trend Extensions

•

Clear

•

Execute

•

Enable

•

Disable

•

Route

•

Reset

•

Enable

•

Disable

Optimal Start Object
5

Totalization Extensions

1

4

You must select and command similar object types. For example, you cannot send a command to both alarm extensions
and trend extensions at once. You need to command the alarm extensions and trend extensions separately.
For binary objects, state commands display as the generic State0 and State1 commands if the States Text attribute is
different. If the States Text attribute is the same, then the specific states text is used (for example, On or Off).
Integrations include BACnet Protocol Eng, Eth IP DataLink, Field Bus MSTP, SA Bus, N2 Trunk, VND, Wireless Supervisor,
BACnet, and N1 Migration.
For multistate objects, state commands display as the generic State0 and State1 commands if the States Text attribute
is different. If the States Text attribute is the same, then the specific states text is used (for example, On, Off, or Auto). In
addition, you can command multistate items together only when the number of states matches.
This works only for schedules in the NxE, not the FAC.

2
3
4
5

Commands Dialog Steps
Commanding an Item
About this task:
To send a command to an item in a graphic, see the User Graphics Tool (UGT) section. To send a
command to an item in a Graphics+ graphic, see the Graphics+ section. To send a command to
multiple items, see the Commanding Multiple Items (Global Command) section.
To command an item:
1.
2.
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Select the item to command in the navigation tree or in the display panel.
From the Action Menu, select Command, or right-click and select Command.
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3.

Filter the list of commands using the Show Command Set drop-down menu, if desired.

4.

Select the command to issue.
Note: After selecting one of the available commands, you may be prompted to specify
additional parameters for the command.

5.

Click Send.
Note: If an error occurs while sending the command, the dialog box remains open.

Commanding Multiple Items (Global Command)
About this task:
This procedure sends a command to more than one item. For information on sending a command
to a single item, see Commands in the Site Management Portal User Interface section.
To command multiple items (send a Global Command):
1.

Select the desired, compatible objects in the navigation tree or in the display panel. Hold
the Ctrl or Shift keys when clicking to select multiple items in the navigation tree, or use
the selection conventions of the feature displayed in the display panel. For example, see
Commanding Objects in the Search Results Table in the Global Search section.
Note: You must select and command similar object types. For example, you cannot
send a command to both alarm extensions and trend extensions at once. You need to
command the alarm extensions and trend extensions separately.

2.

From the Action Menu, select Command, or right-click and select Command. If you selected
objects from the navigation tree, a Preparing Data box appears stating the authorization
information for the selected objects is being retrieved. The Global Commands dialog box
appears.
Notes:
- If you click Cancel on the Preparing Data box, both it and the Global Commands dialog
box close without issuing commands.
- If no commands are available for the selected objects or if you have selected
incompatible object types, a dialog box appears stating so. Click OK. The Commands
dialog box does not open. Go back to Step 1.

3.

On the Commands tab, filter the list of commands using the Show Command Set drop-down
menu, if desired.
On the Commands tab, select the command to send to the objects.

4.

Note: After selecting one of the available commands, you may be prompted to specify
additional parameters for the command.
5.

On the Items tab, review the list of objects to command.
Note: To change the objects in this list, click Cancel and go back to Step 1.

6.
7.

Select the Show Command Results check box to display the Change Results Viewer after
issuing the command.
Click Send. The command is sent to the selected objects and the Change Results Viewer
appears if you selected the Show Command Results check box.
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Note: If you are not authorized to send a global command to one or more objects, a
dialog box appears stating the command will not be sent to unauthorized objects. Click
Yes to continue to send the command to the authorized objects. Click No to return to the
Command dialog box without sending the command to any objects. Click Cancel to close
the Command dialog box without sending the command to any objects. Your system
access and category-based privileges set in the Security Administrator System determine
your authorization.
After the command has been sent to all selected items, the Global Command Completed dialog box appears indicating:
- the command sent
- the date/time the command started and completed
- the number of successful/failed commands
- if any commands were not sent because they were unauthorized
- the total commands attempted
Figure 24: Global Command Completed Dialog Box

8.

Click OK.

Result
See Working with the Change Results Viewer in the Change Results Viewer section.

Using Global Commands with the Global Search
About this task:
To use Global Commands with the Global Search:
1.
2.
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Perform a global search according to the Performing a Global Search procedure in the Global
Search section. For example, search for alarms that you plan to command.
Save the object list if this is a common search (for example, you plan to command the alarms
or review their status often). See Working with Search Results and Saving an Object List in the
Global Search section.
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3.

Select the items in search results table and send a global command (for example, enable
or disable alarms) according to the instructions in the Commanding Multiple Items (Global
Command) section.

Result
Note: In addition to these options, you can perform a global modification on items in the
object list. Select and right-click the items, and modify them as desired. See the Modify Dialog
section.

Modify
About this task:
The term modify refers to changing items using the Modify menu item and the Modify dialog box.
See the Modify Dialog section.
To edit the attributes of an item:
1.
2.

View the details of the item in a display panel.
Select an item tab (for example, Focus).
Note: Some items contain an Advanced radio button. If you select this button, additional
attributes appear.

3.
4.

Click Edit.
Edit the attributes as needed.
Note: If you place your cursor over an edit field, the ToolTip provides information about
the valid format or range for that value. ToolTips also appear for strings.

5.

Click Save.
For information on using the Modify dialog box to modify single or multiple items, see the
Modify Dialog section.

Modify Dialog
Note: The term edit refers to changing items using the Edit button. See the Modify section.
The term modify refers to changing items using the Modify menu item and the Modify dialog
box as described in this section.
The Modify dialog box allows you to modify attributes of a single item (single modify feature) or
multiple items at once (global modify feature). For example, you can open the Global Search Viewer
or a Tailored Summary in a display panel and select one or more items from the table to modify; or
you could send a modification to change the Authorization Category of all VAV boxes in your facility
from General to HVAC. Only attributes common to all items being modified appear in the Global
Modify dialog box.
The single modify feature uses the Modify dialog box. The global modify feature uses the Global
Modify dialog box for sending modifications and uses the Change Results Viewer for viewing,
saving, and printing the sent global modifications.
For information on the Change Results Viewer and how to use it, see the Change Results Viewer
section. The Change Results Viewer is used by both the Global Modify and the Global Commands
features.
See Using Global Modify with Global Search in this section for steps on using the Global Search and
Global Modify features together.
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Single and Global Item Modify Concepts
Modify Dialog Box
The Modify dialog box allows you to modify attributes of a single item in the Metasys system. You
can access the Modify dialog box for the selected item by selecting the Modify menu option from
the Action Menu or the right-click menu. The attributes shown in the modify box are different for
different object types.
Figure 25: Modify Dialog Box

Table 73: Modify Dialog Box Components
Screen Area/Item

Description

Instructions Area

Provides tips to help you send a modification.

Attributes Table

Displays the list of attributes available to modify for the selected item.
Unauthorized modifications are disabled. Attribute value fields appear
after the attribute name.
The check box next to an attribute is automatically selected when you
make a modification in its value field. Modifications are sent for only the
selected (checked) attributes.

Send

Sends the selected modifications to the object/item.

Cancel

Closes the Modify dialog box without sending the changes.

Global Modify Dialog Box
The Global Modify dialog box allows you to modify common attributes of multiple items in the
Metasys system. You can access the Global Modify dialog box for the selected items by selecting the
Modify menu option from the Action Menu or the right-click menu.
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Figure 26: Global Modify Dialog Box - Attributes Tab

Figure 27: Global Modify Dialog Box - Items Tab
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Table 74: Global Modify Dialog Box Components
Screen Area/Item

Description

Instructions Area

Provides tips to help you send global modifications.

Attributes Tab

Displays the list of common attributes available to modify for the selected
items. Unauthorized modifications are disabled. Attribute value fields
appear after the attribute name.
The check box next to an attribute is automatically selected when you make
a modification in its value field. Modifications are sent for only the selected
(checked) attributes.

Items Tab

Lists the selected items in table format and indicates:
•

if you are authorized/unauthorized to modify the items

•

the number of items to be modified

Send

Sends the selected modification to the objects/items listed in the Items tab.

Cancel

Closes the Global Modify dialog box without sending the changes.

Show Modify Results

Displays the Change Results Viewer in the display panel after clicking Send
(when this box is checked).

Modify Attributes
The following table lists the attribute groupings and examples of the attributes available for
modification.
Note: You can easily enter each controller's Fully Qualified Reference (FQR) by entering an
asterisk (*) in the Graphic Alias field.
Table 75: Modify Attributes
Attribute Grouping
General

BACnet Intrinsic Alarming

Alarm Values

Alarm Setup

Graphic Setup
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Example Attributes
•

Change of Value (COV) Increment

•

Display Precision

•

Authorization Category

•

Units

•

BACnet Deadband

•

High Limit

•

Low Limit

•

Differential

•

High Alarm Limit

•

Low Alarm Limit

•

Alarm Ack Required

•

Alarm Message Text

•

Alarm Priority

•

Event Enable

•

Graphic

•

Graphic Alias
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Modify Dialog Steps
Modifying a Single Item
About this task:
This procedure is for modifying a single item. To modify multiple items, see Performing a Global
Modify. For information on editing an item using the Edit button in the display panel, see the
Modify section.
You can modify an item from the navigation tree, display panel view (for example, Tailored
Summary view), or Global Search Results table.
To modify a single item:
1.

2.
3.

Select and right-click a single item in the navigation tree, display panel view, or global
search results. Select the Modify menu item. Or, select a single item and select the Modify
command from the Action menu. The Modify dialog box appears.
Make changes to one or more attributes as desired.
Click Send.

Performing a Global Modify
About this task:
This procedure is for modifying more than one item in a single operation. To modify a single item,
see Modifying a Single Item. For information on editing an item using the Edit button in the display
panel, see the Modify section.
You can globally modify items online and in the SCT. You can perform a global modification on
items from the navigation tree, display panel view (for example, Tailored Summary view), or Global
Search Results table.
Note: Once sent, you cannot undo a global modification; however, you can send another
global modification to readjust values as needed.
To perform a Global Modify:
1.

Select multiple items in the navigation tree, display panel view, or global search results. Rightclick the items and select the Modify menu item. The Global Modify dialog box appears.
Note: The Items tab lists the selected items and your permissions to modify them.

2.

On the Attributes tab, make changes to one or more attributes as desired.
Note: You can easily enter each controller's Fully Qualified Reference (FQR) by entering
an asterisk (*) in the Graphic Alias field.

3.

Select the Show Modify Results check box to display the results of the modifications, if
desired.

4.

Click Send. If you selected to view results, the Change Results Viewer appears in a display
panel. The Change Results Viewer has options to copy the results, save the results to a file,
and clear the results.
Notes:
- If you are not authorized to send a global modification to one or more objects, a dialog
box appears stating the modification can not be sent to unauthorized objects. Click Yes
to continue to send the modification to the authorized objects. Click No to return to the
Modify dialog box without sending the modification to any objects. Click Cancel to close
the Modify dialog box without sending the modification to any objects. Your system
access and category-based privileges set in the Security Administrator System determine
your authorization.
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- On a Metasys for Validated Environments (MVE) site, you are prompted to authorize this
action (only once) with the defined annotation and/or electronic signature requirements.
Note: If you are not authorized to send a global modification to one or more objects,
a dialog box appears stating the modification can not be sent to unauthorized objects.
Click Yes to continue to send the modification to the authorized objects. Click No to
return to the Modify dialog box without sending the modification to any objects. Click
Cancel to close the Modify dialog box without sending the modification to any objects.
Your system access and category-based privileges set in the Security Administrator
System determine your authorization.
After the modification has been sent to all selected items, the Global Modify Completed dialog box appears indicating:
- the attributes that were modified (appears in a comma delimited list)
- the date/time the modification started and completed
- the number of successful/failed modifications
- if any modifications were not sent because they were unauthorized
- the total modifications attempted
Figure 28: Global Modify Completed Dialog Box

Note: The Succeeded value in the Global Modify Completed window reflects the number
of objects modified, not the number of object attributes modified.
5.

Click OK.

Result
See Working with the Change Results Viewer in the Change Results Viewer section.

Using Global Modify with Global Search
About this task:
To use Global Modify with Global Search:
1.
2.
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Perform a global search according to the Performing a Global Search procedure in the Global
Search section. For example, search for alarms that you plan to modify.
Save the object list if this is a common search (for example, you plan to modify the alarms or
review their status often). See Working with Search Results in the Global Search section.
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3.

Select the items in the search results and send a global modify according to the instructions
in the Performing a Global Modify section.

Result
Note: In addition to these options, you can perform a global command on items in the search
results. Select and right-click the items, and command them as desired. See the Commands
Dialog section.

Import Definition
Menu Selection: Action > Import Definition
Imports the pre-built summary definition that is stored on the computer and is only available when
the Summary Definitions folder is selected in the All Items tree. After importing a definition, the
imported Summary Definitions appear in the Summary Definitions folder in the All Items tree.
Note: You also can import Summary Definitions that were previously exported. Refer to
the Exporting a Summary Definition section in the Metasys SCT Help (LIT-12011964) for more
information.

Importing a Summary Definition
1.
2.

In the All Items tree, right-click the Summary Definitions folder and then click Import
Definition.
Browse to the location on the computer where the Summary Definitions are stored.
Note: You can download a set of pre-built Summary Definitions from the Johnson
Controls License Portal and save these files to your computer. You also can import
previously exported Summary Definitions. See the Exporting a Summary Definition
section.

3.
4.

Select one or more Summary Definitions to import.
Click Import. The Notice dialog box appears, indicating the results of the import after all
imports complete.

Figure 29: Notice Dialog Box

5.

Click OK. The imported Summary Definitions appear in the Summary Definitions folder in the
All Items tree.
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Locate in Tree
Menu Selection: Action > Locate in Tree
Displays the expanded Equipment, Spaces, or All Items tree location for an object selected from the
focus window. Locate in Tree is particularly useful in SMP when you are working with multiple focus
windows and mapped points and need to locate where those points are located in the All Items
tree.
Note: Locate in Tree is not compatible with either User Views or the Unlicensed Item trees.

Export Definition
Menu Selection: Action > Export Definition
Exports the summary definition that is stored in the Summary Definitions folder in the All Items tree
to a location on the computer. You can now share the Summary Definition with others and import it
to other sites as desired.
Note: If you import the Summary Definition to another site, you may need to update the key
data references. Refer to the Importing a Summary Definition section in the Metasys SCT Help
(LIT-12011964) for more information.

Exporting a Summary Definition
1.
2.
3.

In the Summary Definitions folder of the All Items tree, right-click the Summary Definition
and select Export Definition. The Export dialog box appears.
Browse to the location on the computer to store the Summary Definition.
Click Export. The Notice dialog box appears, indicating the results of the export.

Figure 30: Notice Dialog Box

4.

Click OK.

Result
Note: You can now share the Summary Definition with others and import it to other sites as
desired. If you import the Summary Definition to another site, you may need to update the key
data references.

View Annotations
Menu Selection: Action > View Annotations
Displays the existing annotations for the selected item in the Audit Viewer, Event Viewer, Tailored
Summary, Global Search results, Navigation Tree, and so on.

Add Annotation
Menu Selection: Action > Add Annotations
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Adds an annotation for the selected item in the Audit Viewer, Event Viewer, Tailored Summary,
Global Search results, Navigation Tree, and so on.

Viewing Extensions
About this task:
To view extensions:
1.
2.

Drag and drop the object into the Panel Layout.
Click the tab along the top for the desired extension.

Extension Wizard
Menu Selection: Actions > Show Extensions (menu option is available only when an item that
supports extensions is selected)
Adds features, such as trending, alarming, averaging, loading and totalization, to an item. Extension
types include:
•

Resource File—Adds a resource file to a field device or integration, if supported.

•

Trend—Adds trending capabilities to an item.

•

Totalization—Adds totalization capabilities to an item.
Note: Select either the Event Totalization or Runtime Totalization radio button if they
appear on the right side of the Select Attribute screen of this wizard. If these selections do
not appear, the attribute you selected uses Analog Totalization.

•

Alarm—Adds attributes for generating alarm and event messages to an item. See the Alarm
and Event Management feature for information.

•

Averaging—Adds averaging capabilities to an item.

Load—Adds the load capability of the Energy Management feature. You can add only one load
extension to an object.
See the Extensions section.
•

Extensions
Extensions add features, such as trending, alarming, and totalization, to an item.
Click one of the following for more information on extensions:
•

For information on searching for extensions, see the Global Search section.

•

For information on commanding extensions, see Commanding Extensions.

•

For more information on managing extension attributes as part of a tailored summary, see the
Summary Definition Object section.

Alarm Extensions
Alarm extensions monitor an attribute of an object and send alarms using the Alarm and Event
Management feature. There are two types of alarm extensions, Analog Alarm and Multistate Alarm.
Use the Analog Alarm extension to monitor attributes with real values. Use the Multistate Alarm
extension to monitor attributes with True or False, or Multistate data types.
For general information on Metasys system objects, see the Object Help section.
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Alarm Extensions Concepts
Analog Alarm Extension
The Analog Alarm extension adds the alarming capability for attributes with real values, such as
the Present Value of an Analog Input Object. This extension detects an alarm based on up to four
limits and can be configured to report that alarm. It also sets the Alarm State attribute of the object
to which it is added. The Analog Alarm Extension is also used with the Graphic Setting Preferences,
which are used to establish color choices for alarm conditions in graphics.
For example, you can configure the Analog Alarm extension to issue an alarm if the temperature in
a room falls below 15.6˚C (60˚F).
Multistate Alarm Extension
The Multistate Alarm extension adds the alarming capability for an attribute with True or False, or
Multistate data types, such as the Present Value of a Binary Input Object.
The Multistate Alarm extension detects the alarm with respect to a difference from a defined
normal state and sets the Alarm State attribute of the object to which it is added. In addition, you
can configure the Multistate Alarm extension to report alarms and True or False and/or Multistate
events.
Normal State
Normal state occurs when the alarm extension is in an acceptable, expected condition, as indicated
by the attribute point to which it is added.
Warning State
Warning state occurs when the analog alarm extension transitions from Normal into the high or
low warning conditions.
Alarm State
Alarm state occurs when the extension transitions into the high alarm, low alarm, or unreliable
conditions.
AO/BO Feedback
The Alarm extensions provide feedback in points to prevent the detection of alarm conditions
that are really false alarms. For the Analog Alarm Extension, this feedback is done through the
configuration of the Setpoint Reference attribute. For the Multistate Alarm Extension, this feedback
is done through the configuration of the Command Reference attribute. When you reference other
attributes using the Setpoint Reference or Command Reference attributes, the alarm analysis works
differently.
Analog Points:
For example, add an Analog Alarm extension to an Analog Input Object (zone temperature). Define
the Present Value of the Analog Input Object as the Input Reference and define the Define the
Present Value of an Analog Output Object (setpoint) as the Setpoint Reference of the Analog Alarm
extension.
If you edit the Setpoint (Define the Present Value attribute of the Analog Output Object), the
Warning Reference attribute of the Analog Alarm extension of the Zone Temperature Analog Input
Object changes to the same value. The Reference Delay Time of the Analog Alarm extension resets
at this same time and prevents a false alarm condition from being detected.
Binary or Multistate Points:
For example, add a Multistate Alarm extension to a Binary Input Object or Multistate Input Object.
Define the Present Value of a Binary Input (fan status) or Multistate Input as the Input Reference;
then define the Present Value of a Binary Output Object (command state) or Multistate Output
Object as the Command Reference of the Multistate Alarm extension.
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If you edit the Command State (Present Value attribute of the Binary Output Object or Multistate
Output Object), the Normal State attribute of the Multistate Alarm extension of the Fan Status
Binary Input Object or Multistate Input Object changes to the same value. The Reference Delay
Time of the Multistate Alarm extension resets at this same time, preventing a false alarm condition
from being detected.
Delay Timer Interaction
There are two timers used to delay the analysis or reporting of an alarm. These timers are used to
allow normal functions to occur before an object’s behavior appears abnormal and generates an
alarm. The first timer is the Alarm State: Reference Delay Timer, which allows a preset amount
of time to pass between commanding an object and making sure that the commanded object has
obeyed the command before considering an alarm condition to be present. The second timer is the
Alarm State: Report Delay Timer, which prevents the analysis of an object’s condition until the
preset time has passed after that object has appeared to obey a command.
The length of the reference delay time is a combination of the reference delay time and the report
delay time settings. If you change the warning reference, both delays go active; and if the reference
delay time is greater than or equal to the report delay time, then the total delay is the sum of both
timer settings. However, if the reference delay time is less than the report delay time, then the
delay is equal to the report delay time setting.
The delay timers of the alarm extensions interact as follows:
Note: If no Warning Limits are defined, the Reference Delay Time and Reference Delay Timer
Active attributes do not apply.
Figure 31: Delay Timer Interaction

Table 76: Delay Timer Interaction Description
Callout

Name

User Action

1

Warning
reference
command

Commands the Warning reference to change, moves the setpoint
and the corresponding High and Low warnings.
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Table 76: Delay Timer Interaction Description
2

Reference Delay
Timer

Timer starts when the Warning Reference changes.

3

Report Delay
Interval

Interval starts if high or low warning is exceeded. The delay is
applied on both the entrance into the alarm condition and the exit
out of the alarm condition.

4

After Report
Delay Interval

Input reference is analyzed for alarm conditions.

See the Multistate Alarm Delay Examples section.
See the Analog Alarm Attributes and the Multistate Alarm Attributes for more information.
Multistate Alarm Delay Examples
About this task:
When attaching alarm extensions to Binary objects, we recommend that the Alarm extension be
attached to a Binary Input Object (BI). When the Binary Output Object (BO) is commanded On, the
command is seen by the command reference of the BI and triggers the Alarm State: Reference
Delay Timer, which changes the Normal state of the associated BI. The Reference: Input of the BI
should change to match the new Normal state during the time set by the Alarm State: Reference
Delay Timer. If it does not, the BI immediately goes into Alarm upon expiration of the Reference
Delay Time. If the BI Reference: Input changes to match the new Normal state, then the Alarm
State: Report Delay Timer starts. The Alarm State: Report Delay time does not delay delivery of a
previously generated report. It delays the analysis of the BI object for an alarm condition until the
Report Delay time has passed. Once the Report Delay time passes, the BI is analyzed for Alarm
conditions.
For example, with a BO controlling a fan and a BI with an Alarm Extension set using the BO as an
Input reference, two possible conditions are affected by the Alarm State delay timers:
1.
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Fan On and Operating Normally—In the following figure, a fan has been commanded On
and is operating normally. In this case, when the BO commands the Fan On, the Normal State
of the BI changes to On and the Reference Delay Time starts. Within the interval set by the
Reference Delay Time, the Input Reference of the BI changes to On and the Report Delay time
starts. After the Reference Delay Time and Report Delay Time have passed, the BI is analyzed
for Alarm conditions.
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Figure 32: Fan On and Operating Normally

Table 77: Fan On and Operating Normally Example Description

2.

Callout

Name

User Action

1

BO Command

Fan is commanded On from BO.

2

BI Normal
State

BI Normal State switches to On.

3

Alarm State:
Reference
Delay Timer

Reference Delay Timer interval starts when BI Normal State
switches to On.

4

BI Input

BI Input switches On during the Reference Delay Timer
interval.

5

Alarm State:
Report Delay

Report Delay interval starts when BI Input switches to On.

6

After Report
Delay Interval

BI is analyzed for alarm conditions.

Fan Is Commanded On but the Fan Is Not Working—In the following figure, the fan is
commanded on but does not turn on due to a problem. In this case, the BO commands the
Fan On, the Normal State of the BI changes to On, and the Reference Delay Time starts.
However, the Input Reference of the BI never changes to On because the Fan does not turn
on. Therefore, the Alarm State: Report Delay Timer never starts. After the interval set by the
Alarm State: Reference Delay Time, the BI goes into an Alarm condition.
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Figure 33: Fan Is Commanded On but the Fan Is Not Working

Table 78: Fan Is Commanded On but the Fan Is Not Working Description
Callout

Name

User Action

1

BO Command

Fan is commanded On from BO.

2

BI Normal
State

BI Normal State switches to On.

3

Alarm State:
Reference
Delay Timer

Reference Delay Timer interval starts when BI Normal State
switches to On.

4

BI Input

BI Input does not turn On during the Reference Delay Timer
interval due to problem with Fan.

5

Alarm State:
Report Delay

After Reference Delay Timer interval. BI is analyzed and goes
into Alarm.

Analog Alarm Attributes
The Analog Alarm Extension contains attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Analog Alarm extension. The list of Attribute
names are displayed in the Focus Window of the Site Management Portal view of the Alarm
Extension. Click the attribute name in the table for a description of the attribute.
Notes:
•

In the Notes column, letters indicate the following: C - Configurable, D - Default Attribute for
Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable.

•

In the SUM (Tailored Summary Pick) column, attributes marked with an X can be used in
the Tailored Summary User View. See the Defining User Views with Summary Definitions
section for information about recommended groupings of Summary Definitions in a Tailored
Summary.

•

In the MOD (Global Modify) column, attributes marked with an X can be mass edited from a
Tailored Summary or Global Search Results.
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•

In the SCT (SCT Configuration Attribute) column, attributes marked with an X are viewable in
the SCT Alarm Extension Focus Window.

Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Alarm Ack
Pending

Notes

Alarm Ack
Required

C,W

Initial
Value
False

Values/ Options/
Range
Ack not pending,
Ack pending

False

Ack not required,
Ack required

Alarm Date

Alarm Message C,N,W
Text

Alarm Priority

C,W

70

Alarm Time

Cooling
Setpoint

C,N,W

Null

Cooling
Setpoint
Reference

C,W

Null

Description
Indicates that an event concerning
a transition into the Alarm state is
waiting for acknowledgment.
Indicates that a transition into the
Alarm state created a message that
requires acknowledgment.
Indicates the last date this extension
transitioned into the Alarm state. Each
time this transition occurs, a message
is created and this date is updated.
Indicates the text you assigned to give
further information in the event of
an alarm. Only status changes to an
alarm state add the alarm message
text reference.
Indicates the priority assigned to the
Alarm state.
Indicates the last time this extension
transitioned into the Alarm state. Each
time this transition occurs, a message
is created and this time is updated.
Indicates the actual monitored Cooling
Setpoint value based on the Setpoint
Reference mapping. You can either
define the Cooling Setpoint and High
Alarm Limit or the Setpoint Reference.
When specified, indicates the Above
Setpoint limit. You must define both
the Cooling Setpoint Reference and
Heating Setpoint Reference, or leave
both blank. If the Cooling Setpoint
Reference is defined, the High Warning
Offset is added to the Cooling Setpoint
Reference value to calculate the High
Warning Limit.

SUM

MOD

SCT

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

The Heating and Cooling Setpoint
References are typically mapped to the
Actual Heating and Cooling Setpoints
created for all FEC based VAV and
Terminal Unit control applications.
The High and Low Warning Offsets are
added to these references to calculate
the High and Low Warning Limits.
These reference points are used in
conjunction with the Room Control
Module Graphics Symbol to provide
indication of above and below setpoint
conditions.
Date
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Indicates the date of the last change
in the Present Value or Reliability
reported by this extension.
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Description

Notes

Differential

C,W

Initial
Value

C,W

0.00

Values/ Options/
Range
Maximum 40
characters before
Release 8.0.
Maximum 64
characters at
Release 8.0 and
later.
Positive value

Description

SUM

MOD

Identifies the alarm extension in detail.

Specifies a deadband range used for
analog object state transitions from
High Alarm Limit, Low Alarm Limit,
High Warning Offset, and Low Warning
Offset. If the Differential is applied to
an object in High Alarm, the object
remains in the state until it changes to
a value less than the High Alarm Limit
minus the value of the Differential.

SCT
X

X

X

X

When the Cooling Setpoint and the
Heating Setpoint are configured, the
Differential specifies:
•

The deadband range for
transitions to the Above and
Below Setpoint states.

•

Enabled

W

True

Error Log

Event Enable
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C,W

True

The deadband range for
transitions from Above and
Below Setpoint states to return
to a Normal state. In this case,
half of the value specified for the
Differential is used. This allows
the value to return to normal
in cases where the control
algorithm controls to a value
close to the setpoint, but may not
achieve or cross the setpoint.
Indicates whether the alarm extension
is enabled.
Indicates the reliability of the following
references:
•

Input Ref Status

•

Warning Ref Status

•

Setpoint Ref Status

•

Cooling Setpoint Ref Status

•

Heating Setpoint Ref Status

•

Occupancy Ref Status

If a reference is not defined, the value
will be No Input.

Determines if an alarm condition is
reported back to the event viewer and
if alarm pop-ups are created.

X

X

X
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Graphic

Notes
C,N,W

Graphic Alias

C,W

Heating
Setpoint

C,N,W

Initial
Value
Null

Values/ Options/
Range
Object Type =
Graphic

Maximum 256
characters

Null

Description

SUM

Indicates the graphic associated with
the extension.

MOD

SCT

X

X

X

X

X

X

X

X

X

X

X

X

X

Do not set the Graphic attribute for
an alarm extension to an aliased
graphic. Aliased graphics do not display
properly when displayed from the
Alarms Window or Event Viewer.
Indicates a portion of the graphic’s
item reference, up to and including
the name of the folder containing this
extension or the controller containing
this extension.
The Heating and Cooling Setpoint
References are typically mapped to the
Actual Heating and Cooling Setpoints
created for all FEC-based VAV and
Terminal Unit control applications.
The High and Low Warning Offsets are
added to these references to calculate
the High and Low Warning Limits.
These reference points are used in
conjunction with the Room Control
Module Graphics Symbol to provide
indication of above and below setpoint
conditions.
You can either define the Cooling
Setpoint and Low Alarm Limit or the
Setpoint Reference.

Heating
Setpoint
Reference

C,W

High Alarm
Limit
High Alarm
Limit
High Warning
Offset

C,N,W

Null

Null
C,N,W

Positive value

Input
Input
Reference

C
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Indicates the value of the Below
Setpoint limit. You must define both
the Cooling Setpoint Reference and
Heating Setpoint Reference, or leave
both blank.
Specifies the actual High Alarm Limit. If
blank, the limit is not used.
Specifies the actual High Alarm Limit. If
blank, the limit is not used.
Indicates the value added to the
Warning Reference or Setpoint
Reference variable to determine the
actual High Warning Limit. If blank, the
offset is not used and warning analysis
is disabled. Both the High Warning
Offset and Low Warning Offset must be
defined, or both must be blank.
Indicates the last value received from
the Input Reference.
Specifies the object and attribute
monitored by this alarm extension.
The reliability of the Input Reference
is monitored and sets the Reliability
attribute of this extension. It also can
be reported in an alarm message.
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Notes
Name
Item Reference

Initial
Value

Values/ Options/
Range

Low Alarm
Limit
Low Warning
Offset

C,N,W
C,N,W

Positive value

Name

C,W

Maximum 400
characters
Ack not pending,
Ack pending

Normal Ack
Pending
Normal Ack
Required

False

C,W

False

Ack not required,
Ack required

Normal Date
Normal Priority C,W

200

Normal Time

Object
Identifier
Object Name
Object Type
Occupancy
Reference

C,W

Analog
Alarm
Null

Present Value

D,R

Normal

Normal,
Low Warning,

Description

SUM

Specifies the name of the alarm that
the alarm extension is referencing.
Specifies the actual Low Alarm Limit. If
blank, the limit is not used.
Indicates the value subtracted from
the Warning Reference or Setpoint
Reference variable to determine the
actual Low Warning limit. If blank, the
offset is not used and warning analysis
is disabled. Both the High Warning
Offset and Low Warning Offset must be
defined, or both must be blank.
Name of the alarm extension attribute.

MOD

SCT

X

X

X

X

X

X

X

X

X

X

X

X

Indicates if an event in transition
to the Normal state is awaiting
acknowledgment.
Indicates that a transition into the
Normal state created a message that
requires acknowledgment.
Indicates the last date this extension
transitioned into the Normal state.
Indicates the priority assigned to the
Normal state.
Indicates the last time this extension
transitioned into the Normal state.
Each time this transition occurs, a
message is created and this time is
updated.
Specifies an internal identifier assigned
to the alarm extension.
Identifies the name of the object
associated with the alarm extension.
Identifies the type of alarm extension.

X

When mapped, the Occupancy
Reference provides a specific graphic
preference color indication of a zone’s
occupancy status. When the reference
is in an unoccupied state, warning
states are not displayed; only alarm
states are displayed. This capability is
typically used in conjunction with the
Room Status symbol graphic floorplan.

X

X

X
X
X

X

X
X

X

Represents the current value of the
extension.

High Warning,
Low Alarm,
High Alarm
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Reference
Delay Time

Notes
C,W

Initial
Value
0

Reference
Delay Timer
Active

False

Reliability

Input Unreliable

Values/ Options/ Description
SUM
Range
0 to 65,535 seconds Specifies the amount of time that the
X
Input has to move within the Warning
Limits after a Warning Reference
change before the object reports the
warning. The Normal state is reported
until the Reference Delay Time expires.
If the Reference Delay Time is changed,
any current timer is canceled and reset
to the new Reference Delay Time.
The Reference Delay Timer Active is
X
True while the alarm extension waits
for the Input value to respond to the
Warning Reference change.
Uses Reliability (Set Indicates the Reliability of the Analog
503).
Alarm extension. Reliability changes
in response to communication
errors between the Analog Alarm
extension and the Input Reference or
Setpoint Reference. When the Analog
Alarm extension is unreliable due to
communication problems, any further
execution of the main logic of the
Analog Alarm extension is cancelled
and no report is issued.

MOD
X

SCT
X

X

The reliability also indicates when the
Input or Setpoint Reference becomes
unreliable. When reliability changes
due to the Input being unreliable, an
event is issued if reporting is enabled.
The exception is Comm Loss reliability,
which results in the same behavior
as the communication problems
described above.

Report Delay

C,W

0

If a Setpoint Reference, High Alarm
Limit, and Low Alarm Limit are defined,
and the value of the setpoint is outside
of the range defined by the limits, then
the Analog Alarm becomes unreliable
and an event message is generated (if
reporting is enabled).
0 to 65,535 seconds Indicates the number of seconds that
the extension waits before generating
a warning or alarm after the Input
value moves outside of the Heating
or Cooling Setpoint or warning limit.
After this time, the Input value is
reevaluated. If the value is still outside
the limit, a report generates. Report
Delay applies only to changes from the
Normal state to the Alarm state. High
or Low Alarms returning to the Normal
state are reported immediately.
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X

X

X
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Report Delay
Active

Notes
C,W

Initial
Value
False

Setpoint
Reference

C,W

Null

Values/ Options/
Range

Time

Version
C,W

1

Set re-directed to
Unoccupied_Set
Attribute

Unoccupied
State Set

Username is
BACnet Object
Name

False

Warning Ack
Pending

False

Ack not pending,
Ack pending

False

Ack not required,
Ack required

Warning Ack
Required
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C,W

SUM

The Report Delay Active is True while
the alarm extension waits for the alarm
or warning to stabilize.
A Setpoint Reference or Warning
Reference is established for controllers
that only provide a Single Setpoint
value. The value established by either
one of these references is used in
conjunction with the High Warning
Offset and Low Warning Offset to
establish the High Alarm Warning Limit
and Low Alarm Warning Limit.
The Common Object Attributes section
details this attribute. Of the three
states that can be assumed by this
attribute (Disabled, Unreliable, and
Normal), two of these, Disabled and
Normal, are managed outside the
scope of this extension. A complete
list of relevant states follows (listed
in hierarchical order from highest to
lowest):

Status

Unoccupied
State

Description

•

Disabled: Enabled attribute
value is False.

•

Unreliable: Reliability attribute
is not reliable.

•

Normal: Expected operating
condition.

Indicates the time of the last change
in the Present Value or Reliability
reported by this extension.
Specifies the version number for the
alarm extension.
Indicates the value of the Occupancy
Reference (if defined) that is
considered the Unoccupied State.
Indicates the set used to select the
Unoccupied State. If Occupancy
Reference is defined, the Unoccupied
State Set uses the same value.
Controls whether the object’s User
Name attribute is also the Object Name
attribute. The Object Name attribute is
not writable, so the only way to change
the Object Name attribute is to edit the
User Name attribute and set the User
Name Is BACnet Obj Name attribute to
True.
Indicates whether an event concerning
a transition into the Warning state is
waiting for acknowledgment.
Indicates whether a transition into the
Warning state creates a message that
requires acknowledgment.

MOD

SCT

X

X

X

X

X

X

X

X

X

X

X

X
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Table 79: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name
Warning Date

Notes

Initial
Value

Warning
Priority
Warning
Reference

C,W

120

C,W

0.00

Values/ Options/
Range

Warning Time

Description
Indicates the last date this extension
transitioned into the Warning state.
Each time this transition occurs, a
message is created and this date is
updated.
Indicates the priority assigned to the
Warning state.
A Setpoint Reference or Warning
Reference is established for controllers
that only provide a Single Setpoint
value. The value established by either
one of these references is used in
conjunction with the High Warning
Offset and Low Warning Offset to
establish the High and Low Warning
limits.
Indicates the last time this extension
transitioned into the Warning state.
Each time this transition occurs, a
message is created and this time is
updated.

SUM

MOD

SCT

X

X

X

X

X

X

X

X

Analog Alarm Extension Examples
The Analog Alarm extension adds the alarming capability for attributes with real values, such as the
Present Value of an Analog Input Object. This extension detects an alarm in two different modes:
the Single Setpoint method, or the Cooling/Heating Setpoint Method.
Single Setpoint Mode
The Single Setpoint Mode uses up to four configurable limits to report an alarm. This method also
sets the Alarm State attribute of the object to which it is added. You can configure Single Setpoint
Mode using either a mapped setpoint reference or a fixed number set in the warning reference. For
example, you can configure the Analog Alarm extension to issue an alarm if the temperature in a
room falls below 15.6˚C (60˚F).
The Analog Alarm Object determines its new alarm state based upon receipt of a change. The new
alarm state is based on the following:
•

Newly reported value and reliability

•

Current alarm state (present value)

•

Differential

•

Defined alarm and warning limits. Once you set the High and Low Alarm Limits, the High
Warning Limit is calculated by adding the High Warning Offset to the Cooling Setpoint
Reference Value. The Low Warning Limit is calculated by subtracting the Low Warning Offset
from the Heating Setpoint Reference Value.

•

Value reported by the Setpoint Reference (if defined) written to Warning Reference Value

•

Delay Timer Active

•

Reference Delay Timer Active
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Figure 34: Single Setpoint Mode

Figure 34 shows the Present Value of the Analog Alarm as it changes.
The Delay Time period begins when the Warning Reference changes. The Input Value is not
calculated during this time. The Input is normal at the end of the Reference Delay Time, so the
Present Value stays normal.
The Report Delay period begins when the Present Value transitions to any state from the Normal
state, or the value of the Command Reference changes. Transitions to and from states other than
Normal are reported immediately.
Cooling/Heating Setpoint Mode
Using the Cooling/Heating Setpoint Mode, the object calculates up to seven different statuses
based on the Cooling Setpoint Reference and the Heating Setpoint Reference. You can also
define an optional Occupancy Reference to suppress the status of the extension and display an
unoccupied status indication color unless there is a high or low alarm.
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Figure 35: Cooling/Heating Setpoint Mode

Figure 35 shows the Present Value of the Analog Alarm as it changes.
The Delay Time period starts when the Cooling Setpoint Reference or Heating Setpoint Reference
value changes. Since the Input is in Low Warning state at the end of the Reference Delay Time, the
Present Value is in a Low Warning state.
The Report Delay period starts when the Present Value transitions to any Alarm or Warning state
from a Normal, Above Setpoint, or Below Setpoint state, or if the value of the Command Reference
changes. All other State Transitions are reported immediately.

Multistate Alarm Attributes
The Multistate Alarm Extension contains attributes common to Metasys system objects. For details,
see the Common Object Attributes.
The following table lists the attributes specific to the Multistate Alarm extension. Click the attribute
name in the table for a description of the attribute.
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
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Table 80: Multistate Alarm Attributes
Attribute Name
Notes
Alarm Ack Pending

Initial Value
False

Alarm Ack Required C,W

False

Alarm Date

Alarm Message Text C,N,W

Alarm Priority
Alarm Time

C,W

Alarm Values

C,W

Capture Changes

Command
Reference

70

False

C,W

Values/Options/Range Description
Ack not pending, Ack
Indicates that an event concerning a
pending
transition into the Alarm state is waiting to be
acknowledged.
Ack not required, Ack
Indicates that a transition into the Alarm
required
state created a message that requires
acknowledgment.
Indicates the last date this extension transitioned
into the Alarm state. Each time this transition
occurs, a message is created and this date is
updated.
Indicates the text you assigned to give further
information in the event of an alarm. Only status
changes to an alarm state cause the alarm
message text reference to be added.
See Event Priority.
Indicates the priority assigned to the Alarm state.
Indicates the last time this extension transitioned
into the Alarm state. Each time this transition
occurs, a message is created and this time is
updated.
Associates an alarm state with a specific priority
and text. Multiple states can be defined for
each alarm, but each state must be unique
and no state can be set to the current alarm
extension normal state. The text and priority are
customizable. Alarm Priority and Alarm Message
Text are used as defaults when custom text and
priority values are not defined.
If True, this attribute forces an event notification
to be generated for each change of the object
input state. If the input goes from one alarm
state to another alarm state or back to normal, an
event notification is generated.
If specified, the value of this referenced attribute
is treated as the normal state by the alarm
extension. The normal state then follows a
feedback value.
For example, define the Present Value of a Binary
Input Object (fan status) as the Input Reference
and define the Present Value of a Binary Output
Object (command state) as the Command
Reference.
For more information on how this attribute works
with regard to AO/BO point feedback, see AO/BO
Feedback.

Date

Indicates the date of the last reported condition.

Event Enable

C,W

True

Graphic

C,N,W

Null

Object Type = Graphic

Indicates that this value must be True for the
extension to report a warning message.
Indicates the graphic associated with the
extension.
Do not set the Graphic attribute for an alarm
extension to an aliased graphic. Aliased graphics
do not display properly when displayed from the
Alarms Window or Event Viewer.
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Table 80: Multistate Alarm Attributes
Attribute Name
Graphic Alias

Notes
C,W

Initial Value

Input

Input Reference

C

Normal Ack
Pending
Normal Ack
Required

False

C,W

False

C,W

200

Normal State

C,W

State 0

Present Value
Reference Delay
Time

D,R
C,W

Normal
0

Normal Date

Normal Priority
Normal Time

Values/Options/Range Description
Maximum 256 characters Indicates a portion of the graphic’s item
reference, up to and including the name of the
folder containing this extension or the controller
containing this extension.
Derived from Input
Indicates the multistate value processed for
Reference, the object
alarms by the extension as defined by the Input
to which the Multistate Reference. The value of the Input is compared to
Alarm extension has
the Normal State.
been attached.
Specifies the object and attribute monitored by
this alarm extension. The last value received from
Input Reference is written to the Input attribute.
The reliability of the Input Reference is monitored
and sets the Reliability attribute to this extension.
It is also reported in an alarm message.
Ack not pending, Ack
Indicates whether an event concerning a
pending
transition into the Alarm state is waiting to be
acknowledged.
Ack not required, Ack
Indicates whether a transition into the
required
Normal state creates a message that requires
acknowledgement.
Indicates the last date this extension transitioned
into the Normal state. Each time this transition
occurs, a message is created and this date is
updated.
See Event Priority.
Indicates the priority assigned to the Normal
state.
Indicates the last time this extension transitioned
into the Normal state. Each time this transition
occurs a message is created and this time is
updated.
Derived from Input
Indicates the attribute value to which the Input is
Reference, the object
compared. If the Input value is different from the
to which the Multistate Normal State, an alarm state occurs.
Alarm extension has
been attached.
Normal, Alarm, Hold
Represents the current value of the extension.
0–65,535 seconds
When a Binary Output Object (BO) (supply fan
command) is commanded On, the Normal State
for the associated Binary Input Object (BI) (supply
fan status) alarm extension is also On. After the
Reference Delay Time, the current state of the BI
is compared to the Normal State. If the BI is still
Off, an alarm is detected. The Reference Delay
Time is also used when the BO is commanded Off.
Specifies the feedback delay in seconds. The
purpose of the Reference Delay Time is to allow
time for equipment to start or stop before the
status is compared to the command.

Reference Delay
Timer Active

False
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The Reference Delay Timer Active is True while the
alarm extension waits for the equipment to start
or stop.
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Table 80: Multistate Alarm Attributes
Attribute Name
Reliability

Notes

Initial Value
Input
Unreliable

Values/Options/Range Description
Uses Reliability (Set 503). Indicates the reliability of the Multistate
Alarm extension. Reliability changes due to
communication errors between the Multistate
Alarm extension and the Input Reference or
Command Reference. When the Multiple Alarm
extension is unreliable due to communication
problems, any further execution of the main logic
of the Multistate Alarm extension is canceled and
no report is issued.
The reliability also indicates when the Input
or Command Reference becomes unreliable.
When reliability changes due to the Input being
unreliable, an event is issued if reporting is
enabled. The only exception is Comm Loss
reliability, which results in the same behavior as
the communication problems described above.

Report Delay

C,W

Report Delay Active C,W

0

0–65,535 seconds

False

Status

Indicates the delay between detecting an alarm
and actually reporting the alarm. The purpose of
this delay is to make sure that the alarm is stable.
If a status feedback device is fluctuating, an alarm
is detected numerous times. The alarm must
be True at the end of the duration of the Report
Delay before the alarm is reported.
The Reference Delay Timer Active is True while the
alarm extension waits for the equipment to start
or stop.
The Common Object Attributes section details this
attribute. A list of relevant states follows (listed in
hierarchical order from highest to lowest):
Disabled: Enabled attribute value is False.
Unreliable: Reliability attribute is not reliable.
Normal: Expected operating condition.
Indicates the time of the last reported condition.

Time

Alarm Commands
The following table lists the commands supported by the Alarm Extensions feature.
Table 81: Alarm Extension Commands
Command
Name

Parameters

Description

Cancel Delay
Time

None

Cancels Reference Delay Timer, if active. A
warning occurs if the delay time on an Alarm
extension is canceled in this state.

Cancel Report None
Delay

Cancels the Report Delay Timer, if active. A
warning occurs if the delay time on an Alarm
extension is canceled in this state.

Totalization Extensions
Totalization Extensions track an attribute over time. There are three types of totalization extensions:
•

Analog Totalization - Tracks and records analog attribute values over time.

•

Event Totalization - Tracks the number of events/transitions of an attribute over time.
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•

Runtime Totalization - Tracks the total time that an attribute resides in a specified state.

For more information on managing time in the Metasys system, see the NAE and ADS
commissioning documents listed in the table in the Welcome section.

Totalization Extensions Concepts
Analog Totalization
The Analog Totalization extension tracks and records the usage of any consumable monitored
through an analog attribute. Some examples of consumables include electricity, gas, steam, and
chilled water.
These three essential parameters determine the Analog Totalization extension’s mode of operation:
•

the Input Reference to be monitored

•

the Timebase on which the computation is based

• the Low CutOff Value that the input must meet or exceed
Use the Analog Totalization extension to determine the usage of the given consumable. For
example, you can determine the amount of gas or steam used by the facility for a given month.
Also, use Analog Totalization to determine how many kilowatt/hours were used in a week or to
totalize a calculated value (for example, degree days).
For general information on Metasys system objects, see the Object Help section.
For detailed information on the Analog Totalization extension, see Analog Totalization Attributes.
Event Totalization
The Event Totalization extension tracks the number of binary events or pulses over time, meaning it
counts the number of transitions that occur at an input reference. Unlike other types of totalization,
event totalization increases the value each time the event occurs, instead of calculating the value
once each minute.
These three essential parameters determine the mode of operation for the Event Totalization
extension:
•

the monitored Input Reference

•

the types of recorded Transitions or events

• the recorded Value Per Pulse (event)
You can use this extension to determine the number of changes in an input value, which may
be helpful for maintaining and monitoring equipment. For example, use Event Totalization to
determine how many times a motor started, how often a sensor was in alarm, or how many cars
entered a parking lot.
For detailed information on the Event Totalization extension, see Event Totalization Attributes.
Runtime Totalization
The Runtime Totalization extension tracks the time that elapses while a designated input, such as a
binary or multistate value, matches a specified state.
These two essential parameters determine the Runtime Totalization extension’s mode of operation:
•

the monitored Input Reference

• the Reference (state) that identifies active runtime
Use this extension to track the amount of time that a piece of equipment, such as a fan or a pump,
is operational. This extension also determines the amount of time that a point is in alarm or the
runtime of fixed loads (such as lighting) for energy consumption and tenant billing.
For detailed information on the Runtime Totalization extension, see Runtime Totalization Attributes.
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Analog Totalization Attributes
The Analog Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Analog Totalization extension. Click the
attribute name in the table for a description of the attribute.
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 82: Analog Totalization Extension Attributes
Attribute Name
Display Precision

Notes
C,W

Executing

Initial Value
10ths
Active

Values/Options/Range
Uses Display Precision
(Set 0)
Active

Description
Indicates the rounded position and the number of
decimal places to display for this extension.
Reflects the status of this extension.

Totalize Limit

Active: The extension is calculating and has not
reached the Totalize Limit.

Inactive

Input Reference

C

Low CutOff Value

C,W

Present Value

C,D,R,W

Inactive: The extension is unreliable or disabled
and is not calculating.
Specifies the object and attribute monitored by
this extension. If this attribute is unreliable or
falls below the Low CutOff Value, totalization is
temporarily suspended.
Specifies the object and attribute monitored by
this extension. If this attribute is unreliable or
falls below the Low CutOff Value, totalization is
temporarily suspended.
Represents the current value of the extension.

Reliability

Reliable

Reset (This attribute W
does not appear in
a view, but may be
scheduled, trended,
and so on.)

False

Uses Reliability (Set 503) Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.
False
Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
True
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)

Reset Date
Reset Time
Rollover

C,W

False

False
True

Rollover Count
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Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.

0

0–4,294,967,295

This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Represents the date of the last Reset condition of
the extension.
Represents the time of the last Reset condition of
the extension.
Defines the special action that the totalization
extension must take when the Present Value
reaches the Totalize Limit value. If the Rollover
attribute is set to False, the Analog Totalization
extension ceases further operation when the
Present Value equals or exceeds the Totalize Limit
value. If it is True, it resets the present Value to 0.0
and resumes a new cycle of totalization.
When the Rollover attribute is True, this value
increases each time Present Value reaches a value
equal to or greater than the Totalize Limit value.
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Table 82: Analog Totalization Extension Attributes
Attribute Name
Scale Factor

Notes
C,W

Initial Value
1.0

Values/Options/Range Description
Minimum Value > 0
Indicates the value used to scale the totalized
value to either a larger or smaller value than
otherwise results.
Seconds
Establishes the time frame on which the
calculated totalization value is based.
Minutes

Timebase

C,W

Hours

Totalize Limit

C,N,W

Hours
Limit > 0

Units

C,W

IP
SI

Value Before Reset

Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.
Indicates the measurement units of this
extension.
Indicates the value of the Present Value at the
time of the last reset operation.

Event Totalization Attributes
The Event Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Event Totalization extension. Click the attribute
name in the table for a description of the attribute. Letters in the Notes column indicate the
following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by
Extension’s Reliability, W - Writable.
Table 83: Event Totalization Attributes
Attribute Name
Display Precision

Notes
C,W

Executing

Initial Value
1s
Active

Values/Options/Range
Uses Display Precision
(Set 0).
Active

Description
Indicates the rounded position and the number of
decimal places to display for this extension.
Reflects the status of this extension.

Totalize Limit

Active: The extension is calculating and has not
reached the Totalize Limit.

Inactive

Input Reference

C

Present Value

C,D,R,W

Reference

C,W

Reliability

Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.
Inactive: The extension is unreliable or disabled
and is not calculating.
Specifies the object and attribute totalized by
this extension. If this attribute is unreliable,
totalization is temporarily suspended.
Represents the current value of the extension.

State 0

Reliable
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States Text attribute
identifies the
enumeration set for this
attribute.
Uses Reliability (Set 503).

Defines the value that the extension processes
for totalization, as defined in the Input Reference
attribute.
Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.
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Table 83: Event Totalization Attributes
Attribute Name
Reset

Notes
W

Initial Value
False

(This attribute does
not appear in a
view, but may be
scheduled and
trended.)
Reset Date

Values/Options/Range Description
False
Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
True
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)

Reset Time
Rollover

C,W

False

False
True

Rollover Count

R,W

0

0–4,294,967,295

Scale Factor

C,W

1.0

Minimum Value > 0

States Text

C,W

States

(This attribute does
not appear in a
view, but may be
scheduled and
trended.)
Totalize Limit
C,N,W

Transition

C,W

This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Entering State Entering State
Count All

Units

C,W

IP
SI

Value Before Reset
Value Per Pulse

C,W

This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Represents the date of the last Reset condition of
the extension.
Represents the time of the last Reset condition of
the extension.
Defines the special action that the totalization
extension takes when the Present Value reaches
the Totalize Limit value. If the Rollover attribute
is set to False, the Runtime Totalization extension
ceases further operation when the Present Value
equals or exceeds the Totalize Limit value. If the
attribute is set to True, it resets the present Value
to 0.0 and resume a new cycle of totalization.
When the Rollover attribute is True, this value
increases each time Present Value reaches a value
equal to or greater than the Totalize Limit value.
Indicates the value that is used to scale the
totalized value to either a larger or smaller value
than would otherwise result.
Indicates the displayed strings for the Present
Value.

1

Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.
Describes the behaviors of the transitions to be
counted. If the value is 0, the system counts the
transition of entering a given reference. If the
value is 1, the system counts all state transitions.
Indicates the measurement units of this
extension. IP=Imperial units; SI=International
System of Units.
Indicates the value of the Present Value at the
time of the last reset operation.
Indicates the unit value of the Input Reference for
pulse totalization. For the event totalization, the
value is 1.

Runtime Totalization Attributes
The Runtime Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Runtime Totalization extension. Click the
attribute name in the table for a description of the attribute.
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Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 84: Runtime Totalization Attributes
Attribute Name

Notes

Initial Value

Values/Options/Range Description

Display Precision

C,W

10ths

Uses Display Precision
(Set 0).
Active

Indicates the rounded position and the number of
decimal places to display for this extension.
Indicates the execution status of this extension:

Totalize Limit

Active: The extension is calculating and has not
reached the Totalize Limit.

Executing

Active

Inactive

Input Reference

C

Present Value

C,D,R,W

Reference

C,W

Reliability

Reset

W

Inactive: The extension is unreliable or disabled
and is not calculating.
Specifies the object and attribute totalized by
this extension. If this attribute is unreliable or
changes from the Reference (state) to another
state, totalization is temporarily suspended.
Represents the current value of the extension.
State 1

Reliable

States Test attribute
identifies the
enumeration set for this
attribute.
Uses Reliability (Set 503).

False

False

(This attribute does
not appear in a
view, but may be
scheduled, trended,
and so on.)
Reset Date

True

Reset Time
Rollover

C,W

Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.

False

False
True

Rollover Count

R,W

0

States Text

C,W

States

(This attribute does
not appear in a
view, but may be
scheduled, trended,
and so on.)

Metasys Site Management Portal Help

0–4,294,967,295

Defines the value that is processed for totalization
by the extension as defined in the Input Reference
attribute.
Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.
Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)
This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Represents the date of the last Reset condition of
the extension.
Represents the time of the last Reset condition of
the extension.
Defines the special action that the totalization
extension takes when the Present Value reaches
the Totalize Limit value. If the Rollover attribute
is set to False, the Runtime Totalization extension
ceases further operation when the Present Value
equals or exceeds the Totalize Limit value. If it
is True, it resets the present Value to 0.0 and
resumes a new cycle of totalization.
When the Rollover attribute is True, this value is
incremented each time the Present Value reaches
a value equal to or greater than the Totalize Limit
value.
Indicates the displayed strings for the Present
Value.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.
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Table 84: Runtime Totalization Attributes
Attribute Name
Timebase

Notes
C,W

Initial Value
Hours

Totalize Limit

C,N,W

Hours

Units

C,W

No Units

Value Before Reset

Values/Options/Range Description
Seconds, minutes, hours, Establishes the time frame on which the
days
calculated totalization value is based.
Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.
Indicates the measurement units of the Present
Value, Totalize Limit, and Value Before Reset
attributes.
Indicates the value of the Present Value at the
time of the last reset operation.

Totalization Commands
The following table lists the commands supported by the Totalization Extensions. Click the
command name for a description of the command.
Table 85: Totalization Commands
Command Name

Parameters

Description

Disable

None

Locks out all outputs and
prevents functionality of
the Totalization extension
and temporarily suspends
totalization.

Enable

None

Forces a Reset on the
Totalization extension and
returns it to normal operation.

Reset

None

Terminates any ongoing
calculations, restores the
present value to its initial
state, creates a reset date
and time stamp, and, for each
triggerable attribute, forces a
COV report.

Reset Rollover

Access level = Supervise

Resets the Rollover Count
attribute.

Trend Extensions
The Trend Extension monitors and records the changes in the behavior of an individual attribute
over time, thereby assisting you with diagnosing various system-wide behavioral characteristics.
The Trend extension collects sample values at timed intervals or only upon changes in the given
value. Trend data is still collected if the object is unreliable. The Trend extension continues to log
data using the previous value preceded by ???, which indicates an unreliable status.
For example, use a Trend extension to collect data from the Analog Input object of a controller on
the N2 Bus, which reports information such as outdoor air temperature or room air temperature.
Trend extensions are different from Trend Studies because Trend Studies query both the ADS and
Engine for historical data. Trend Extensions query only the Engine.
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Note: Although multiple trend extensions can be added to an object on an NxE, these
extensions are combined as a single trend if sent to a Historical Data Repository. This may
not yield the expected result. To use multiple trends on a single object in a Historical Data
Repository, create duplicate AV or BV objects that map to the point in question, then create a
new trend on the parallel AV or BV.
For trend performance information, refer to the Metasys System Configuration Guide (LIT-12011832).

Trend Extensions Concepts
Views
There are three views in the Trend Extension: Chart View, Table View, and Definition View.
Table 86: Views
Button

View

Description

Chart View

Allows you to view trend data in a chart
format.

Table View

Allows you to view trend data in a table
format.

Definition View

Allows you to view the trend extension
attributes.

Trend Extension Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data.
You can zoom, unzoom, and pan within the Chart view. You can also specify the X-axis and Y-axis
ranges.
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Table 87: Chart View
Button

Name

Description

Update

When initially displayed, the Trend Extension view shows
the data samples currently in the local trend buffer. Click
Update to retrieve and display new data samples (for
example, any trend buffer data later than the currently
displayed samples). The Update button adds the new
samples to the display without removing the old samples.
Note: Gaps may appear in the data if the trend buffer has
rolled over since the last update. If you wish to clear the
Trend Extension view and re-display only those samples currently in the trend buffer, use the Refresh Current Tab menu
option (right-click or Action menu).

(Zoom)

Zoom

(Normal)

Toggles the mouse behavior for the chart between zoom
mode and normal mode.
While in zoom mode:
•

drag the mouse over an area of the chart to zoom in
on that area.

•

click Zoom to exit zoom mode and restore the mouse
to normal mode.

•

left-click to zoom out one level.

When you exit zoom mode, the chart remains at the
current zoom level. Use the Restore button to fully zoom
out on the chart.
Note:
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•

You cannot pan while the mouse is in zoom
mode.

•

You can also zoom and unzoom in normal mode
by using the Shift key and the mouse. To zoom,
hold the Shift key down while dragging the
mouse across the chart. To zoom out one level,
left-click the mouse while holding the shift key
down.

Restore

Allows you to return to an unzoomed view and switches the
mouse back to normal mode if the chart’s zoom mode is
active.

Pan

Allows you to pan the view of the chart vertically or
horizontally by dragging the mouse across a zoomed chart.
Panning is not available for unzoomed charts or when
zoom mode is active. To pan left or right, drag the mouse
over the X-axis. To pan up or down, drag the mouse over
the Y-axis.

Points Line

Displays the data using lines and point markers. This is the
default.

Area

Displays the data using an area chart.
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Table 87: Chart View
Button

Name

Description

Bar

Displays the data using a bar chart.
Note: Only use the bar chart when the number of data samples can reasonably be expected to display as bars. If too
many data samples exist when you click this option, the
display becomes unstable and fails to properly update the
screen. To recover, select any other display option.

Points

Displays the data using markers, with no lines.

Line

Displays the data using lines, with no markers.

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click
in the panel to display the menu.
Table 88: Chart View Right-Click Menu
Menu Item

Description

Background Color

Opens the Select a Color dialog box and allows you to configure the
background color.

Gridlines

Allows you to select what type of gridlines to appear on the chart. You can
choose: None, X and Y, X Only, and Y Only.

Chart Type

Allows you to select what type of chart to display. You can choose: Points
Line, Area, Bar, Points, and Line.

Trend Extension Table View
The Table view of the Trend extension allows you to view the trend’s data samples in a table format.
You can copy the trend data to the clipboard for pasting into Microsoft Excel or other applications.
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Table 89: Table View
Button/Field

Name

Description

Update

When initially displayed, the Trend
Extension view shows the data samples
currently in the local trend buffer. Click
Update button to retrieve and display new
data samples (for example, any trend buffer
data later than the currently displayed
samples). The Update button adds the new
samples to the display without removing
the old samples.
Note: Gaps may appear in the data if the
trend buffer has rolled over since the last
update. If you wish to clear the Trend
Extension view and re-display only those
samples currently in the trend buffer,
use the Refresh Current tab menu option
(right-click or Action menu).

Copy to Clipboard

Allows you to copy selected trend data
to the system clipboard for pasting into
Microsoft Excel or other applications.
You can also use Ctrl + C to copy data.

Trend Extension Definition View
The Definition view of the Trend Extension allows you to view and edit the attributes of the trend
extension object. For more information on the Definition view attributes, see the Trend Extension
Attributes section.
Trend Buffer
The trend buffers reside in the NAE and store the trend samples for the NAE. The number of
samples stored in each individual trend buffer is user-configurable (see Trend Extension Attributes).
When the buffer gets full, you can choose to have the new trends overwrite the old ones or to have
the trending stop. Whether the trends are overwritten or trending stops, you can configure the
system to issue an alarm when the buffer gets full. You can also configure to transfer samples to a
configured ADS.
Table 90 shows the relationship between the buffer size and the sample interval. Determine
the sample interval, in seconds, by converting minutes to seconds. Determine the buffer size by
examining the interval, in seconds, against the desired time period size to retain data.
Table 90: Buffer Size and Sample Interval Relationship
Interval Interval
(Min.)
(Sec.)

Buffer for Previous Time Period
1 Hr.

2 Hrs.

4 Hrs.

8 Hrs.

16 Hrs.

1 Day

2 Days

3 Days

1

60

60

120

240

480

960

1,440

2,880

4,320

2

120

30

60

120

240

480

720

1,440

2,160

5

300

12

24

48

96

192

288

576

864

10

600

6

12

24

48

96

144

288

432

15

900

4

8

16

32

64

96

192

288

30

1,800

2

4

8

16

32

48

96

144

190

Metasys Site Management Portal Help

Table 90: Buffer Size and Sample Interval Relationship
Interval Interval
(Min.)
(Sec.)
60

3,600

120

7,200

Buffer for Previous Time Period
1 Hr.

2 Hrs.

4 Hrs.

8 Hrs.

16 Hrs.

1 Day

2 Days

3 Days

1

2

4

8

16

24

48

72

1

2

4

8

12

24

36

Trend Sampling
Trend sampling for the trend buffer occurs periodically (samples taken after a set time expires) if
you set the Sample Interval to a value higher than zero. To sample based on COV reporting of the
object, set the Sample Interval attribute to zero. You can stop or start sampling manually (using the
Enable or Disable command) or control the start and stop with Interlocking a Trend Extension or
scheduling. With interlocking, the trend samples are taken when a defined event occurs. If you use
the scheduling feature, trend samples are taken at certain times on certain days.

Trend Extension Attributes
Alarm Extensions contains attributes common to Metasys system objects. For details, see Common
Object Attributes.
The following table lists the attributes specific to the Trend extension. Click the attribute name in
the table for a description of the attribute.
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 91: Trend Extension Attributes
Attribute Name
Acked Transitions

Notes
C,W

Initial Value
False, False,
False

Buffer Size

C

144

Buffer State

Operational

Client COV
Increment

C,W

COV Resubsc
Interval

C,W

3,600

Enable

C,W

False
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Values/Options/Range Description
Conveys three separate flags that each indicate
if the most recent To Offnormal, To Fault,
or To Normal event transitions have been
acknowledged (if the transition requires
acknowledgement).
1–5,000
Specifies the maximum number of records the
buffer may hold.
Operational, Buffer Full Indicates whether the buffer is full or operational
when the Stop When Full attribute is set to False.
Specifies the increment used to determine that a
change of value occurred (when this trend object
collects data by COV). If the referenced object
and attribute support COV reporting, then this
attribute may have a Null value. In this case, the
value of the trended object for COV increment is
used. This value only applies to trended values of
the real value (floating point) type.
Units = Seconds
Specifies the number of seconds between COV
resubscriptions (when this trend object collects
data by COV). This attribute is only used when
the trended object is a BACnet Integration point
on the IP network. The Subscribe COV requests
specify twice during this interval for the actual
subscription. The first subscription is issued
when the trend object begins operation or when
enabled.
Indicates and controls whether logging is enabled
(True or False).
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Table 91: Trend Extension Attributes
Attribute Name
Event Enable

Notes
C,W

Initial Value
True, False

Event State

Event Time Stamps

Input Reference

C

Intrinsic Alarming
Defined

C,W

False

Last Notify Record

0

Logging Type

Polled

Log Interval
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C,W

60,000

Values/Options/Range Description
Determines whether notifications are enabled
for To Fault and To Normal events. A To Normal
transition occurs when the value of the Records
Since Notify attribute is equal to or greater than
the value of the Notify Threshold attribute. A To
Fault transition occurs when an attempted COV
subscription fails. The To Normal transition must
be enabled and set by default. The Read and Write
methods ensure this value cannot be set to False.
Normal, Fault
Determines whether an active event state is
associated with this extension. The value is set
to Normal when there is no intrinsic alarming
defined for this object. If intrinsic alarming is
enabled (Enable Intrinsic Alarms = True), then this
value is either Normal or Fault (problem occurred
with the object subscribing for Change of Value
[COV]s). This attribute appears on the view when
the site is defined as a BACnet site.
Conveys the times of the last event notifications
for To Offnormal, To Fault, and To Normal events.
Time stamps of type Time or Date have FF if no
event notification of that type has generated since
the object was created.
Defines the attribute of the object being sampled.
This attribute is used for consistent references to
an object or attribute. The Input Reference and
the name of the object and attribute you want to
trend must match exactly.
Enables (True) or disables (False) BACnet intrinsic
alarming for this object. When disabled, writing
to any of the intrinsic alarming attributes returns
a Write_Access_Denied error. When disabled,
reading the intrinsic alarming attributes returns
the default value of each attribute.
Indicates the sequence number associated
with the most recently collected record whose
collection triggered a notification (that is, it
caused the value of the Records Since Notify
attribute to be equal to or greater than the
value of the Notify Threshold attribute). If no
notification has occurred since logging began, the
value of this attribute is 0.
Polled, COV, Trigger
Specifies the method for which the referenced
property is logged (Polled, Change of Value [COV],
or Trigger).
Units = 100ths of a
second

Specifies the periodic time in seconds for which
the referenced property is logged.
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Table 91: Trend Extension Attributes
Attribute Name
Notification Class

Notes
C,W

Initial Value
1

Values/Options/Range Description
Specifies the notification class used for handling
and generating event notifications for this
object. Notification occurs based on the value
of the Records Since Notification attribute. The
Notification Class attribute implicitly refers to a
Notification Class object that has a Notification
Class property with the same value. If the class
number references a non-existent Notification
object, no Notification occurs.
When the Notification Class attribute is written
online, the Notification Object Reference
is updated to the Object Reference of the
Notification Class object with that instance
number, if found. If the Notification Class object
for a Johnson Controls proprietary object is not
found, the reference is left blank.
If both the Notification Object Reference and
the Notification Class attributes are written
simultaneously online (or both are configured
and downloaded), the Notification Class attribute
value is set to the value that was written to the
Notification Object Reference, and the Notification
Class value in the write message is ignored.

Notification Object C,W
Reference

Limited to Notification
Class on the same
device.

Notify Threshold

C,W

Notify Type

C,W

130 (90% of
Buffer Size)
Events

Record Count

C,D,W

0

0–5,000

Specifies the Notification Class object used to
route alarms for the object being configured
(through tree selection). When the Notification
Object Reference is written, the value of the
Notification Class attribute is updated to reflect
the referenced object’s instance number. The
value of the Notification Object Reference
attribute is restricted to Notification Class objects
on the same device as the alarming object.
Validation only occurs during a write, not during a
create (the download does not fail).
Indicates when notification occurs based on the
value of the Records Since Notification attribute.
Conveys if the notifications generated by the
object are Events or Alarms. This attribute is
required if the object supports intrinsic reporting.
Represents the number of samples recorded since
the creation of the trend extension or the last
time the buffer was cleared, when the Stop When
Full attribute is set to True.
Represents the position of the next sample
recorded, when the Stop When Full attribute is set
to False.
A value of zero for this attribute deletes all
records in the log buffer and resets Samples Not
Sent to ADS and Total Record Count to zero. If the
buffer overflows, the Record Count resets to zero.

Records Since
Notify

0
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Indicates the number of records collected since
the last notification occurred or since logging
began if no notification occurred.
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Table 91: Trend Extension Attributes
Attribute Name
Reliability

Notes

Repository Enabled C,W

Initial Value
Reliable

False

Values/Options/Range Description
Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
trend extension monitoring the input becomes
unreliable.
Enables transferring of the trend sample data to
the Metasys Server when this attribute is set to
True and the buffer fills to the level specified by
the Transfer Setpoint attribute.
If you create multiple trend extensions on a single
point and send it to a Historical Data Repository,
then setting Repository Enabled to true causes
the Trend Viewer and/or Trend Study to display a
combination of 15-minute and 1-minute samples.
If Repository Enabled is set to False, then the
Trend viewer displays only the data from the
selected Trend Extension. To use multiple trends
on a single object in a Historical Data Repository,
create duplicate AV or BV objects that map to the
point in question, then create a new trend on the
parallel AV or BV.

Sample Interval

C,W

600

0–604,800
Units = Seconds

Specifies the periodic time in seconds for
which the referenced property is logged. If this
attribute is zero, samples are recorded using COV
reporting.
Notes:

Samples Not Sent
to ADS
Start Time
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0

C,W

0–5,000

•

If you want to take samples on a COV, set
the value of this attribute to 0 seconds.

•

If you are not sampling on a COV, configure
the Sample Interval at 60 seconds or higher
to prevent loss of trend data and reduction
in performance of the network engine and
Metasys Server devices that receive samples
from the configured trend.

Represents the total number of samples requiring
delivery to the Metasys Server repository during
the next transfer.
Specifies the time and date to enable logging
when the Enable attribute is set to True. If the
Start Time contains any wildcard values, then the
conditions to enable logging based on time are
ignored. When the Trend object is inactive due to
the current time being outside of the Start Time
or Stop Time, the Status attribute reflects this
state (assuming it is the highest priority status).
If you define a Stop Time that is before the Start
Time, the Trend object is disabled.

Metasys Site Management Portal Help

Table 91: Trend Extension Attributes
Attribute Name
Status Flags

Notes

Initial Value

Values/Options/Range Description
Indicates the general status of the object in
BACnet terms and contains four independent
states.
The four flags are:
In Alarm—False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service—Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Stop Time

C,W

Stop When Full

C,W

Specifies the time and date to disable logging.
If the Stop Time contains any wildcard values,
then the conditions to disable logging based on
time are ignored. Logging is disabled if the Stop
Time is prior to the Start Time. When the Trend
object is inactive due to the current time being
outside of the Start Time or Stop Time, the Status
attribute reflects this state (assuming it is the
highest priority status). A change in the active/
inactive state due to the Start Time/Stop Time
value has no impact on the Enable attribute. If
the Trend object was disabled due to the Stop
Time, the Trend object attempts to send the trend
samples to the server. If you define a Stop Time
that is before the Start Time, the Trend object is
disabled.
False

When set to False, logging continues. If the
Repository Enabled attribute is set to False, the
previously recorded samples are overwritten.
If the Repository Enabled attribute is set to
True and the buffer fills to the level specified by
the Transfer Setpoint attribute, the previously
recorded samples are sent to the Metasys
Server. The buffer must be cleared for logging to
continue.
Specifies whether logging ceases when the buffer
is full. When set to True, logging ceases and all
accumulated samples remain in the buffer.

Total Record Count
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Represents the total number of records collected
by the Trend Extension since creation. When the
value of Total Record Count reaches its maximum
possible value of 0XFFFFFFFF, the next value it
takes is zero. Once this value has wrapped to
zero, its semantic value (the total number of
records collected) is lost, but its use in generating
notifications remains.
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Table 91: Trend Extension Attributes
Attribute Name
Transfer Setpoint

Notes
C,W

Trigger

C,W

Initial Value
130 (90% of
Buffer Size)

Values/Options/Range Description
1–5,000
Represents the amount of buffer memory (in
number of samples) that must fill before the
trend extension requests a transfer of the current
samples to the Metasys Server for permanent
storage. The value cannot be greater than the
buffer size when Repository Enabled is true.
Causes the collection of data when changed
from False to True, Enable is set to True, and the
trend is within the Start/Stop times. When data
collection completes, this attribute resets to False.
This attribute does not trigger Johnson Controls
COVs.

Trend Extension Commands
The following table lists the commands supported by Trend Extensions. Click the command name
for a description of the command.
Table 92: Trend Extension Commands
Command Name

Parameters

Description

Clear

None

Clears all samples in the buffer.

Disable

None

Stops collection of samples.

Enable

None

Resumes collection of samples.

Execute

None

Takes a single sample.

Route

None

Routes all trends that have not
been previously sent to the
Metasys Server, if defined.

Load Extensions
The Energy Management feature consists of two major components: one DLLR object, and one
or more Load extensions. A Load extension is added to an output object (only one load extension
for each object) to specify that the object should be controlled by Energy Management. Each Load
extension object is configured with the load (energy) rating of its output and the attribute value or
state to write to its output object when the Load object is shed.
The DLLR object determines how much energy needs to be reduced, based on its configuration and
the energy rate from a meter, if the demand limiting strategy is defined. The DLLR object orders as
many Loads as needed to shed to reduce the energy usage by the required amount. The Loads can
be on the same supervisory device as the DLLR object, or on another supervisory device, but must
be within the same site. Each shed Load writes its configured Output Shed Command attribute
value to the Present Value attribute of its output, which decreases energy usage.
For information on the features and operation of DLLR, refer to the DLLR Technical Bulletin
(LIT-12011288).
The Demand Limiting/Load Rolling (DLLR) Object chapter contains information relevant to the DLLR
Object.

Load Extension Attributes
Three types of Load Extension objects are available: Binary, Multistate, and Analog. The following
table describes the attributes of these objects.
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, W - Writable.
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Table 93: Load Extension Attributes
Attribute Name
Active Timer

Notes

Actual Shed Level

Initial Value
None

0

Alarm Reference for C,N,W
Ineligibility

Comfort Override

C,W

Inactive

Values/Options/Range Description
Active Timer set
Indicates which Load timer is in effect: Minimum
Shed, Maximum Shed, Minimum Release, or
None. The Time Remaining attribute indicates
how much time remains for the active timer.
Indicates the level of power shed when a shed
request is active. When the Present Value
attribute value is Shed Compliant, the Actual Shed
Level equals the value of the Shed Levels array
element; otherwise, it equals zero.
Prevents the Load from being shed if the
reference is in alarm. This is an optional reference
to an object that can be set to any object,
including the output object. For example, if the
referenced object is a room temperature sensor,
and the object goes into alarm (a room becomes
too warm), it prevents the supply fan (the Load
object) from being shed. If the Load object is
already shed when the referenced object goes
into alarm, the shed expires as it would normally
but cannot be shed again until the referenced
object exits the alarm state.
Comfort Override set

Configures the Comfort Override command
behavior for this load. From time to time, you
may need to override a load to turn on lights in
a normally empty conference room or provide
more airflow to a zone. The Comfort Override
command is meant for this purpose. You can
issue this command directly from DLLR’s Load
Summary to release loads if they are shed, and
prevent them from being shed. The load cannot
be shed again until the Release Comfort Override
is issued.
This attribute can be set to the following values:
Inactive—No comfort override is in effect.
Override And Release Immediately—Comfort
overrides the Load immediately and prevents it
from being shed. If the Load is currently shed, the
output write is immediately released.
Override But Release After Timer Expires—
Comfort overrides the Load immediately and
prevents it from being shed. If the Load is
currently shed, the output write is released
after the Load’s Minimum Shed Time expires.
If the Minimum Shed Time has already expired
when the command is issued, the output write is
immediately released.

Current Available
Energy Savings
Display Precision

C,W

Display Reference

C,W

10ths
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Uses Display Precision
(Set 0).
Synchronized to the
output object’s Display
Precision.

This attribute is synchronized to the Comfort
Override/Release Comfort commands.
Indicates how much energy would be saved if the
Load were shed now.
Indicates the rounded position and the number of
decimal places to display for this extension.
Indicates the current display precision of the
load’s output object.
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Table 93: Load Extension Attributes
Attribute Name
Duty Window

Notes
W

Initial Value
0

Eligibility

Event State

Expected Shed
Level

Input Reference

0

C

Last Shed Date
Last Shed Time
Load Locked

W

False

Load Priority

C,W

10

Values/Options/Range Description
1–65,535
Indicates the time window for determining shed
compliance.
Load Eligibility set
Indicates to DLLR whether the Load can be shed
and identifies for which strategy or strategies (DL,
LR, or both) the Load can be shed.
Normal, Fault
Determines whether an active event state is
associated with this extension. The value is set
to Normal when there is no intrinsic alarming
defined for this object. If intrinsic alarming is
enabled (Enable Intrinsic Alarms = True), then
this value is either Normal or Fault (problem
occurred with the object subscribing for COVs).
This attribute appears on the view when the site is
defined as a BACnet site.
Indicates the level of power that the Load object
expects to shed when a shed request is active or
pending. When the Present Value attribute value
is Shed Request Pending or Shed Compliant, the
Expected Shed Level equals the value of the Shed
Levels array element; otherwise, the value of the
Expected Shed Level equals zero.
Specifies the object and attribute monitored
by this extension. The reliability of the Input
Reference is monitored and sets the Reliability
attribute of this extension.
Indicates the date on which the Load was last
shed (since download).
Indicates the date on which the Load was last
shed (since download).
Specifies whether the Load is locked. A Load that
is locked while released cannot be shed until
the Load lock is released. A Load that is locked
while shed remains shed until the Load lock is
released. This attribute is synchronized with the
Lock/Unlock commands.
1–10
Indicates how critical the Load’s output is and
determines the order in which loads are shed.
You can define up to 10 load priorities: Priority 1
through Priority 10. Loads at Priority 10 are first to
shed; loads at Priority 1 are the last to shed. The
configured Load Priority is shown with the load
on the Load Summary of the DLLR object. The
shedding order is from top to bottom as listed in
the Load Summary when the Load Priority column
is sorted with the lowest priority loads listed first.
Note: Even though the capacity for
10 priority levels is provided, you can
implement fewer than 10 levels; in an
example with, Priority 1 through Priority
4, Priority 4 loads shed first, and Priority 1
loads shed last.

Load Rating

C,W

Enabled

W
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See Load Rating.
True

Indicates whether the Load object responds to
shed requests.
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Table 93: Load Extension Attributes
Attribute Name
Maximum Shed
Time

Notes
C,N,W

Initial Value
15

Minimum Release
Time

C,W

5

Minimum Shed
Time

C,W

5

On Release

C,W

Release
Immediately

Values/Options/Range Description
1–65,535
Specifies the maximum number of minutes that
a load can be shed before it is automatically
Undefined = 65,535
released. If the Maximum Shed Time value is not
Units = Minutes
defined, the default value of 65,535 is used. The
range is 0 to 65,535 minutes. It is possible for the
Load to be released before this time. A Load does
not remain shed longer than the maximum shed
time unless the load has been locked shed.
1–65,535
Specifies the minimum number of minutes that a
load must be released from shed before it can be
Units = Minutes
shed again. Although DLLR does not shed a load
before this time expires, a load can be manually
shed before this value expires.
1–65,535
Specifies the minimum number of minutes that a
load must be shed before it can be automatically
Units = Minutes
released. A load can be manually released before
this value expires.
Comfort Override Type Specifies how soon the Load should be released
set
when a Release Load command is issued or when
the Shed command attribute is set to Release. If
this attribute is set to Release Immediately, the
load releases immediately even if its Minimum
Shed Timer is active. If this attribute is set to
Release After Timer Expires, the load remains
shed until the Minimum Shed Time expires. If a
release is issued but the Load remains shed until
the Minimum Shed Time expires, the Load’s Shed
Status attribute indicates this using one of the
following states. The state that is used depends
on whether the Load was shed for demand
limiting or load rolling.
Shed For DL—Release Issued
Shed For LR—Release Issued

Output Shed
Command

Set is specified by
output’s States Text
attribute.

Present Value
Rate Units
Reliability

Inactive
C,W

kW
Reliable
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The state that is written to the output’s Present
Value attribute when the Load is shed. DLLR does
not shed the Load if the output’s Present Value
equals the Output Shed Command value, as no
energy would be saved.
Uses BACnet Shed State Indicates the current Load shedding state of the
set.
Load object.
Units set
Specifies the energy units used for the Load
Rating Energy Savings display.
Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference goes unreliable, the
extension monitoring the input goes unreliable.
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Table 93: Load Extension Attributes
Attribute Name
Requested Shed
Level

Notes
W

Initial Value
0

Values/Options/Range Description
1–65,535
Controls the desired level of Load shedding for
one shed. Specifying a value greater than the
value configured in the Shed Levels attribute
sheds to the Shed Levels value. Specifying a value
less than the value configured in the Shed Levels
attribute (such as zero) cancels a shed.
The DLLR object writes this attribute to one and
sheds the Load object. Once the shed completes,
the Load object resets this value to zero.
If the Load object sheds through a non-BACnet
method, such as the Shed command, the Load
sets this attribute to one and returns it to zero
after the shed completes.

Shed Command

W

None

Shed Command set

Indicates the current shed/release state of the
Load. This attribute also offers the option of
shedding or releasing a Load.
Release—Releases the Load. The On Release
attribute determines when the Load is released. If
the Load is already released, there is no change.

Shed Duration

W

0

1–65,535

Shed—Immediately sheds a released Load
regardless of its Minimum On Time. If the Load is
already shed, there is no change.
Indicates the number of minutes to shed the
Load. Writing this attribute to a value less than
the current time minus the Start Time attribute
value cancels a shed.
The DLLR object sets this attribute to shed the
load. After the shed completes, the Load sets it to
zero.
If the Load object sheds through a non-BACnet
method, such as the Shed command or Shed
Command attribute, it sets this value to the
Max Shed Time and returns it to zero when the
shed completes. If no Max Shed Time is defined,
the Load sets this value to its maximum value
(0xFFFF), which is the maximum number of
minutes that a Load can shed without being
locked shed.

Shed Level
Descriptions
Shed Levels

Shed Status

Shed Ineligibility
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C,W

Shed All Load Uses Shed Level
Descriptions set.
1
1–65,535

Provides a description of the shed level supported
by the Load object.
Specifies the shed levels used for the Requested
Shed Level attribute. Set this attribute to a value
of one (1) for the DLLR to automatically shed the
Load. If this attribute is set to another value, the
DLLR does not shed or release the Load; although
the Load can be shed and released manually or
by another feature, the Load is automatically
released upon expiration of its Maximum Shed
Time, unless the Load is Locked Shed.

Released

Indicates if the Load is shed or released, and, if
shed, which strategy was used to shed the Load
(DL or LR).
Indicates whether a load is eligible to be shed at
the current time, and, if ineligible, the cause of
ineligibility.

Shed Status set

Load Ineligibility set
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Table 93: Load Extension Attributes
Attribute Name
Shed Strategy

Notes
C,W

Time Remaining

C,W

Start Time

W

Initial Value
0

Values/Options/Range Description
Shed Strategy set
Indicates which strategy is permitted to shed the
Load (DL, LR, or both).
Indicates how much longer a Load timer is in
effect. The Active Timer attribute indicates which
timer is in effect.
BACnet Date Time
Indicates the date and time that the Load sheds.
structure
Writing this attribute to a wildcard releases a shed
load.
The DLLR object sets this attribute to shed
the Load. Once the shed completes, the Load
object sets the value to date and time wildcards
(NONE_FFFF).

Status Flags

False, False,
False, False

In Alarm, Fault,
Overridden, Out of
Service

If the Load object sheds through a non-BACnet
method, such as the Shed command, it sets this
attribute to the current time, and returns it to
NONE_FFFF after the shed completes.
Indicates the general status of the object in
BACnet terms and contains four independent
states.
The four flags are:
In Alarm—False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service—Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Units

C,W

IP
SI

Indicates the measurement units of this
extension.

Load Rating
Defines how much energy is saved when the Load is shed. This attribute specifies the information
that DLLR needs to control the load. This includes a Shed to value, which is the value to which
DLLR commands the output when the load is shed. Also required is at least one Shed from/
Energy Savings pair, which indicates the amount of energy that would be saved when the output
is commanded from the Shed From value to the Shed to value. For binary outputs, only one Shed
From/Energy Savings pair is needed, since it can have only two possible states (Shed To and Shed
From). For multistate and analog output objects, there can be multiple Shed From/Energy Savings
pairs, since they can have many possible values, and differing amounts of energy might be saved
depending on the value the output had when the shed occurred. The option for adding multiple
load ratings helps improve the accuracy of the shed process.
Note: Enter Energy Savings amounts in decreasing order, with the highest amount listed first.
Enter the same Shed to value in all rows.
Consider an example of a fan that should be shed to 60%. The first Shed from entry is 100%,
because the most energy would be saved when shedding from this state. The second Shed from
entry is 90%, the third entry is 80%, and so on. The entries might look like this:

Metasys Site Management Portal Help

201

Figure 36: Define Load Rating

Also, consider an example of a three-speed fan that can have the following states: High, Medium,
Low, and Off. The operator decides to set the fan to Low when the Load is shed. In this case, the
first Shed from entry is High because the most energy would be saved when shedding from this
state. The second Shed from entry is Medium. A Shed from entry for Off is not required because no
energy is saved by shedding from Off to Low. The entries might look like this:
Table 94: Load Rating Entries
Shed From

Shed To

Energy Savings

High

Low

5.0 kW

Medium

Low

3.2 kW

Load Commanding
Objects with a Load extension and intended for use with the DLLR feature permit the following
operator or scheduled commands.
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Table 95: Commands Available to Load Objects
Command

Parameters

Description

Shed

Type
Percent, Level, or Amount
Value
New shed value

Sheds the load immediately. The output is written
at priority 13 (LR) if the Shed Strategy is set to
Load Rolling Only. Otherwise, it is written at
priority 11 (DL). When this command is issued, the
output is commanded regardless of whether DLLR
is in Shed or Monitor Only mode.
Select only the Level command and use the
default value of 1. The Percent and Amount
command options are intended for future use.

Release Load

None

Releases the load, which releases the command
at the priority at which it was previously written
by the shed command (11 or 13). The On Release
attribute defined in the Load object determines
whether the release occurs immediately when
the command is issued, or waits for the Minimum
Shed timer to expire.

Comfort Override

Release Immediately
Release After Timer
Expires

Releases a shed load that is resulting in occupant
discomfort. This command releases the shed and
prevents a future shed until the Release Comfort
Override command is issued. You can either
select to release the load immediately when the
command is issued, or only after the Minimum
Shed Timer expires. If no parameter is selected,
the default is to release the load immediately.

Release Comfort
Override

None

Releases the Comfort Override command and
allows the load to be shed.

Lock

None

Locks the load in its current shed or released
state. The load remains in this state until an
Unlock (or Disable) command is issued.

Unlock

None

Releases a Lock command. If the load was locked
shed and its Maximum Shed Time expired, it now
releases.

Disable

None

Disables the load, which causes it to release its
output command immediately if it is shed, and
clears any Lock or Comfort Override commands
that have been issued. While disabled, the load is
not eligible to be shed.

Enable

None

Enables the load, which permits it to be controlled
by DLLR.

Load Command Interactions
Table 96 illustrates command interactions that pertain to Load objects.
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Table 96: Load Command Interactions
Load Command(s)
Currently in Effect

Load Command
Not Allowed

Explanation

Shed

Shed

Load cannot be shed because it is already shed.

Shed + Locked

Comfort Override
or
Release Load

Lock must be removed with Unlock command.

Comfort Override

Shed

Comfort Override must be released with Release
Comfort Override command.

Released + Locked

Shed

Lock must be removed with Unlock command.

Released + Locked
and
Comfort Override

Shed

Comfort Override must be released with Release
Comfort Override command.
Lock must be removed with Unlock command.

Resource File Extensions
The Resource File extension represents an actual physical file that gets placed in the System
Configuration Tool’s database or in the file system (Flash Memory of an Engine device). The
resource file is an extension of another object called the parent object. The parent objects for
Resource File extensions can be field devices.
After completing the Field Device, the wizard prompts you to add a resource file extension. The
resource file extension allows you to define the attributes that represent a defined resource file and
allows you to populate resource files for integrations. For example, you can define a set of resource
files to support communication with field devices. The resource file notifies its parent object when
any changes are made to the extension.
Note: When using an HVAC PRO file as a resource file, be sure you use the long print file
format because it provides the Metasys system with more information than the short print
file format. For example, the long print file format imports the units of measure while the
short print file format uses defaults based on the HVAC PRO units setting. For analog values,
it uses the default units of Deg F or Deg C (based on the Metric versus Imperial units specified
in the PRN file). If you use a short form PRN file, the User Interface displays a warning
message stating that you have selected a short format PRN file that does not contain the unit's
information. The warning message indicates the Metasys system is using the default setting
that may not match the original units.
For more information on resource file extensions, see Resource File Attributes.

Resource File Attributes
Resource File Extensions contain attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Resource File extension. Click the attribute
name in the table for a description of the attribute. Attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.
Table 97: Resource File Attributes
Attribute Name
Date

Notes
C

File Name

C

File Size

C
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Initial Value

Values/Options/Range Description
Indicates the modified date as read from the
selected file.
Category = File
See the File Name section.

0

Units = Bytes

Indicates the size, in bytes, as read from the
selected file.
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Table 97: Resource File Attributes
Attribute Name
Information

Notes
C,W

Time

C

Initial Value

Values/Options/Range Description
Size = 80
Indicates the text you assigned to provide further
information about the resource file. This attribute
Category = Default
can be written to from an integration server after
reading the resource file.
Indicates the modified time as read from the
selected file.

File Name
The following table indicates the file containing resources located within the host computer.
Table 98: Resource File - File Name Elements
Element Name

Initial
Value

Values/Options/
Range

Description

Exportable

False

Available in a future
release

Indicates whether you can export the file.
If True, you can export the file. If False, you
cannot export the file. This element of the
File Name attribute is to be available in a
future release.

Object
References
References

Indicates the object references embedded
in the file.
False

Relative Path

Indicates whether the file has references.
If True, the file has references. If False, the
file has no references.
Size = 100
Category = Default

Indicates the file name of the file relative to
the directory containing the MOI file for the
device.

Averaging Extensions
The Averaging extension calculates the average, minimum, and maximum value of an attribute
over a specific interval (for example, space temperature over 24 hours). The extension is able to
sample Boolean, Integer, Unsigned, Enumerated, or Float attribute value types for any extendable
objects within a BACnet device.
For more information on averaging extensions, see Averaging Attributes.

Averaging Attributes
Averaging Extensions contain attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Averaging extension. Click the attribute name
in the table for a description of the attribute.
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
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Table 99: Averaging Extension Attributes
Attribute Name
Input Reference

Notes
C

Initial Value

Max Value
Timestamp

Invalid
DateTime

Min Value
Timestamp

Invalid
DateTime

Object Property Ref

Values/Options/Range Description
Defines the object and attribute pair to be
sampled. The sampled object must be on the
same device as the Averaging object.
If Average Value,
Indicates the date and time that the Maximum
Minimum Value,
Value has changed in the sampling buffer.
or Maximum Value
is Unreliable, the
timestamp is Undefined.
If Average Value,
Indicates the date and time that the Minimum
Minimum Value,
Value has changed in the sampling buffer.
or Maximum Value
is Unreliable, the
timestamp is Undefined.
Designates the particular object and attribute
referenced by the Averaging object. This is a
BACnet Device Property Reference structure type
attribute that specifies bind information from the
object/attribute defined by the Input Reference
attribute. The binding information consists of the
Device Identifier, Object Identifier, Array Index,
and Property Identifier of the trended property.
An on-box object returns nothing for the Device
Identifier. The Device Object configures this
attribute during object creation. Changing Object
Property Ref may change Input Ref, and changing
Input Ref may change Object Property Ref. Since
Object Property Ref is based on Input Ref, and
Input Ref does not support Array Index, Object
Property Ref does not support Array Index either.

Valid Samples

Indicates the number of samples in the sampling
buffer that are valid. A sample is marked invalid
if a read error occurs when reading requested
attributes from the host object. The number of
invalid samples can be determined by subtracting
Valid Samples from Attempted Samples. If the
difference is greater than zero, it indicates an
error during sample collection. After Attempted
Samples, Window Samples, or Window Interval is
written, until a sample is taken, this attribute is set
to zero.

If any of these variables are Unreliable and a BACnet read is performed on the following three attributes, the values
returned are NaN for Average Value, -INF for Minimum Value, and INF for Maximum Value. If these values are Unreliable
and a BACnet read is not performed, the attributes return zero.
Average Value
D,R
NaN
Units of the extended
Indicates the sum of all valid samples in the
attribute
sampling buffer divided by the number of
samples in the buffer. This attribute is set to
NaN with its Reliability set to Unreliable until a
sample is taken and Attempted Samples, Window
Samples, or Window Interval is written.
Maximum Value
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R

-INF

Units of the extended
attribute

Indicates the highest value of the valid samples
in the buffer. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to -INF with its
Reliability set to Unreliable.
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Table 99: Averaging Extension Attributes
Attribute Name
Minimum Value

Notes
R

Initial Value
INF

Values/Options/Range Description
Units of the extended
Indicates the lowest value of the valid samples
attribute
in the buffer. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to -INF with its
Reliability set to Unreliable.
If any of the following three attributes are written or changed, all samples in the sampling buffer become invalid (set to
zero, NaN, -INF, or INF), which makes them Undefined for the UI.
Attempted Samples W
The only acceptable
Indicates the total number of samples in the
value that can be written buffer. The only acceptable number that can be
to this property is
written to this attribute is zero. After Window
zero using the Clear
Samples or Window Interval is written, until a
command.
sample is taken, this attribute is set to zero.
Window Interval
C,W
3,600
Units = seconds
Indicates the period of time in seconds over
which the Minimum Value, Maximum Value, and
Range: 900–360,060
Average Value are calculated. Samples are taken
at a specific sample rate, which cannot be less
than 4 seconds. The sample rate is calculated
by dividing the Window Interval by the number
of samples as defined in the Window Samples
attribute. The default value is 3,600 seconds.
Window Samples
C,W
15
Range: 2–200
Indicates the sum of all valid samples in the
sampling buffer divided by the number of
samples in the buffer. This attribute is set to
NaN with its Reliability set to Unreliable until a
sample is taken and Attempted Samples, Window
Samples, or Window Interval is written.
The following four attributes do not appear in a view, but may be scheduled, trended, and so on.
COV Increment
C,W
0.01
Any value > 0
This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Floating point value of
the Display Precision.

Display Precision

Reliability

C,W

100ths

Reliable

Uses Display Precision
(Set 0).

Specifies the minimum change in Present Value
required for the object to report a change in the
Average Value, Minimum Value, and Maximum
Value attributes.
Defines the decimal rounding and the decimal
places to display for the Present Value and
associated attributes. Average Value, Minimum
Value, and Maximum Value use the same display
precision.

This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Uses Reliability (Set 503). Indicates whether the Average Value, Minimum
Value, and Maximum Value attributes are
Unreliable. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to Unreliable.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Units

No Units

Units of the extended
attribute

Indicates the units of the mapped attribute of the
extended object. Average Value, Minimum Value,
and Maximum Value use the same units.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.
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Averaging Commands
The following table lists the commands supported by the Averaging Extensions. Click the command
name for a description of the command.
Table 100: Averaging Extension Commands
Command Name

Parameters

Description

Enable

None

Clears the sampling buffer and
restarts the sampling process. This
command has the same effect as
the Clear command.

Disable

None

Stops the sampling process.

Clear

None

Writes zero to the Attempted
Samples attribute, clears the
sampling buffer, and restarts the
sampling process. This command
has the same effect as the Enable
command.

Extensions Steps
Creating Extensions
About this task:
To create extensions:
1.

Select the item from the Navigation Tree and select Show Extensions from the Action menu.
Note: Alternatively, you can create extensions when prompted upon completion of a
wizard, or when the item is in the Panel Layout by selecting the tab for the extension and
clicking new.

2.
3.
4.
5.

Select New for the type of extension that you want to create. The corresponding Extension
Wizard appears.
Select the attribute that you want to associate with the item.
Complete the information on the wizard screens. The screens vary depending on the type of
extension you are creating.
Select Finish on the summary page to create the extension.

Editing Extensions
About this task:
To edit extensions:
1.
2.
3.

View the extension.
Select the tab for the extension.
Select the extension you want to edit.
Note: For trend extensions, make sure you select the Definition View button to display
the trend’s attributes.

4.
5.
6.
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Click Edit.
Make your changes.
Click Save.
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Copying and Pasting Extensions
About this task:
Note: You can perform this procedure only in the System Configuration Tool (Offline Mode).
You must first create extensions before you can copy and paste them from one item to
another. See Creating Extensions for details on how to create extensions.
To copy and paste existing extensions:
1.

Select the item from the Navigation Tree that contains the existing extensions that you want
to copy, and select Show Extensions from the Action menu. The Extension wizard appears.
Note: Alternatively, you can right-click the item in the navigation tree and select Show
Extensions from the menu that appears.

2.
3.
4.
5.

Select the check box for one or more of the existing extensions that you want to copy.
Click Copy Checked Extensions.
Click Done.
Select the item from the navigation tree that you want to receive the copied extensions, and
select Paste from the Edit Menu.
Note: Alternatively, you can right-click the item in the navigation tree and select
Edit > Paste from the menu that appears.
When you paste an extension, the extension retains the name of the copied extension and
appends it with a number.

Deleting Extensions
About this task:
For a trend extension that is configured to automatically transfer data to a Metasys Server
(Repository Enabled = True), be sure to route unforwarded data to the Metasys Server before
deleting the trend extension. If you do not, unforwarded trend data is lost.
1.

2.

To delete extensions (using the Navigation Tree):
a.
Select the item from the navigation tree and select Show Extensions from the Action
menu.
b.
Select the check box of the extension you want to delete.
c.
Click Delete.
To delete extensions (when the item is in the Panel Layout):
a.
View the extension.
b.
Select the tab for the extension.
c.
Select the extension.
d.
Click Delete.

Searching for Extensions
You can search for Alarm, Trend, or Totalization extensions using the Global Search feature. This
allows you to find up to 100 extension objects and view their current values.

Commanding Extensions
You can command Alarm, Trend, or Totalization extensions from an Extension View or from the
Global Search Viewer. You can also command Trend extensions from a Trend Viewer or Trend Study
view.
Single Extension
About this task:
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To command a single extension object:
1.
2.
3.
4.

Right-click the extension object you wish to command.
Select Commands from the right-click menu. The Commands dialog box appears.
Choose the command to send.
Click Send.

Result
See the Commands Dialog section for more information.
Multiple Extension
About this task:
To command multiple extension objects together (Global Commanding):
1.

2.
3.
4.
5.

Use the Global Search feature to find the extension objects (Alarm, Trend, or Totalization).
You may also open a saved Object List containing extension objects. See Interlocking a Trend
Extension for more information.
Select the extensions you wish to command (must be of the same type).
Select Commands from the Action menu. The Global Commands dialog box appears.
Choose the command to send.
Click Send.

Result
See the Commands Dialog section for more information.

Interlocking a Trend Extension
About this task:
To interlock a Trend Extension:
1.
2.

Create a trend extension. See the Creating Extensions and the Trend Extensions sections for
information.
Create an Insert Object - Interlock that references the trend extension. See the Insert Object Interlock section.

Discard
Menu Selection: Action > Discard
Discards the selected events currently displayed in the Event Viewer. Discards selected entries from
the audit log when the Audit Viewer is displayed.

Refresh
Menu Selection: Action > Refresh
Refreshes the data displayed in the active frame or panel in the Event Viewer, Audit Viewer, Trend
Viewer, and Scheduled Reports.

Refresh Current Tab
Menu Selection: Action > Refresh Current Tab
Refreshes the data displayed in the current tab of the active frame or panel.
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Refresh All Tabs
Menu Selection: Action > Refresh All Tabs
Refreshes the data displayed in all tabs of the active display panel or the navigation frame.

Ack
Menu Selection: Action > Ack
Acknowledges the selected event(s) currently displayed in the Event Viewer.

Import Integration
Menu Selection: Action > Import Integration
This command is only available when an Integration under an engine is selected in the All Items
tree. After adding an Integration, you can select the integration in the navigation tree and use this
menu selection to add existing devices and points under the integration.

Remove From Site
Menu Selection: Action > Remove From Site
Removes (deletes) the selected engine or Metasys Server from the site. The selected engine or
Metasys Server must be offline to use this option. You also can remove a device from the site in a
Tailored Summary with Engine device data.
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Insert Menu
Click one of the following menu items for a description of the menu item. For more information on
the modes of operation, see Metasys Modes.
Table 101: SMP Insert Menu
Menu Item
Integration

Graphic

Field Device

Trend Study

Field Point

User View

Folder

Summary Definition Wizard

Control System
Object

Site
Menu Selection: Insert > Site
Inserts a site into the archive database in the SCT.
Tip: The Create Device? dialog box appears after inserting a site that asks if you want to
create a device in the site. To invoke the Insert Device wizard, select Supervisory Device, then
click OK. To invoke the Insert Metasys Server wizard, select Metasys Server, then click OK. If
you do not want to add a device at this time, select None, then click OK.

Site Object
The Site object defines the attributes that represent the characteristics of a site. If the Site object
exists on a device, that device is considered a Site Director. Starting at Release 10.0, you can
no longer configure a connection to a cloud-based platform with the attributes in the Remote
Services Connection tab of the Site object. The tab still appears, but you should no longer define its
attributes.
Notes:
•

In SCT, a Site object may exist without a Site Director. In this case, you can open the edit
window and make changes to the custom authorization category; however, you cannot save
any changes until you add a Site Director.

•

When you promote or demote a Site Director offline in SCT, the custom categories are rebuilt
using their default settings.

•

If you need to change the name of the Site object, make sure you first close all user views. This
action ensures that all object references throughout the site reflect the new Site object name.

Site Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
For information on the Custom Enumeration tab, see User Defined Enumeration Editor Tab.
Note: In the Notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable.
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
Advanced Security Enabled

Notes
C,W

Initial Value Description
True
Indicates whether the site uses the advanced security settings. This
attribute provides an improved layer of security between Metasys
Site Directors and devices. With this attribute set to true, backwardcompatible methods of communication between the Site Director
and its network engines are disabled, which means a Site Director
at Release 10.0 or later discards all communication attempts from
network engines prior to Release 10.0.
This attribute, which SCT sets to True for any site archive that is
created at, or upgraded to, Release 10.1, applies to the entire site.
Therefore, if you have any network engine on the site that is running
a Metasys release prior to Release 10.0, change Advanced Security
Enabled for the Site object to False.
If you change this attribute from False to True, a user message
appears to indicate that all network engines prior to Release 10.0
remain online, but are disconnected from the site because they no
longer communicate with the Site Director.
If this message appears, click OK to continue and set the attribute to
True, or Cancel to keep the attribute set to False.

All Items Update in Progress C,W

False

Indicates when the cache update completes after executing an
Update All Items Cache command. Starting at Release 5.0, the All
Items navigation tree in the Metasys UI depends on the data cached
in the Site Director, which is called the All Items cache. The All Items
cache automatically updates for engines at Release 5.0 or later. The
cache does not automatically update for engines at a release prior
to 5.0 after making changes when the UI is logged directly into the
engine (that is, not through the Site Director), or when downloading
an engine from the SCT (not through the Site Director). For these
scenarios, you must use the Update All Items Cache command
to update the All Items cache on the Site Director. This attribute
appears only in the online UI.

Annotation Alarm Priority
Threshold

140

Specifies the value that represents the range of alarm priority
thresholds. The default value is 140. This attribute is checked when
determining whether an event requires annotation on an ADX
MVE installation. If the Event Priority value is below the threshold,
annotation is required. This attribute appears only when you have
MVE installed.

Annotation Exclude

C,W

C,W

For more information, refer to Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).
Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
does not require an annotation on an ADX MVE installation. This
attribute appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Annotation Include

C,W

Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
requires an annotation on an ADX MVE installation. This attribute
appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
BACnet Encoding Type

Notes
C,W

Initial Value Description
ISO 10646
Specifies the type of string encoding to use in BACnet messages.
(UCS-2)
Unicode should be specified unless third-party BACnet devices are
employed on the site. In this case, specify the BACnet encoding
type supported by the third-party BACnet devices. This attribute is
automatically distributed to the site devices.
Note: When a site is upgraded to Release 10.1 with SCT
13.2, and the BACnet Encoding Type for the Site object is
automatically changed to ISO 10646 UTF-8 during the archive
upgrade process. If you require UCS-2 as the BACnet Encoding
Type, make sure you set this attribute back to UCS-2 after the
archive upgrade is complete.
For information on how to set up an NAE as a BACnet system
integrator in a Metasys system network, see the BACnet® Controller
Integration with NAE/NCE Technical Bulletin (LIT-1201531).

BACnet Site

C,W

False

Broadcast Disabled

C,W

False

Certificate Renewal Period

C,W

60

Specifies whether specific information from the BACnet device
for each Metasys object is shown in the UI. When true, BACnet
information integrates into the UI for objects. When false, the
information is omitted. Internally, the BACnet protocol is used at a
certain level regardless of this attribute. This attribute is distributed
automatically to site devices.
For information on how to set up an NAE as a BACnet system
integrator in a Metasys system network, see the BACnet® Controller
Integration with NAE/NCE Technical Bulletin (LIT-1201531).
Specifies if broadcast messages are sent by the device. When false
(default value) or no Broadcast Management object exists, the device
sends broadcast messages as defined by BACnet communication.
When the Broadcast Management object is configured and this
attribute is true, the device does not send network broadcast
messages. This attribute appears only in the Snapshot Focus view on
a Site Director engine.
Regulates when certificate expiration reminders begin. It specifies
the number of days prior to security certificate expiration before
the operator is notified daily that a certificate is about to expire.
For example, if you use the default period of 60 days, and a server
certificate on a network engine expires on January 1, beginning on
November 1, an event requiring acknowledge is sent to the Site
Director once a day or until the self-signed certificate is renewed or a
new trusted certificate is installed.
The Certificate Renewal Period applies only to engines at Release 8.1
or later, and is synchronized to all affected child network engines. A
change to the Certificate Renewal Period may take up to five minutes
to synchronize with all network engines.
For more information about certificate management, see Metasys
SCT Help (LIT-12011964) and Network and IT Guidance Technical Bulletin
(LIT-12011279).

Default Language

C,W

DNS Refresh Period

C,W

214

20

Specifies the site's default language. All devices on the site have a
dictionary using this language. This attribute appears only in the
Snapshot Focus view on a Site Director engine.
Specifies the time in minutes between DNS lookups to update the
IP address of a BACnet Broadcast Management Device (BBMD)
referenced by host name. If an IP address is changed within a DNS
server, the BBMD system automatically obtains the new IP address
upon the expiration of this period. A value of 0 is used to disable
periodic DNS lookups.
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
Default ADS Priority
Threshold

Notes
C,W

Initial Value Description
255
Allows you to specify the priority of an event that triggers the Engine
to connect (dial-up or LAN connection) to the defined Metasys
server and deliver the event messages from the Engine local event
repository to the event repository of that Metasys server. This
attribute is used for Alarm and Event Management only.

Default ADS Connection Type C,W

LAN

Default ADS Delivery Time

12:15 AM

Default ADS Repository

C,W

C,W

0.0.0.0

For example, a value of 20 for this attribute means that any event
having a priority of 20 or higher (1 is highest) forces a connection to
the Metasys server and forwards event messages from the Engine
local event repository to the event repository of that Metasys server.
Specifies whether the Metasys server (identified in the Default
ADS Repository attribute) is connected through a LAN or dial-up
connection. This attribute is distributed automatically to the site
devices.
Specifies the time of day when a connection should be established
to the Metasys server (identified by the Default ADS Repository
attribute). A connection is attempted at least daily at the specified
time to deliver audit, alarm, and trend data to the Metasys server.
This attribute is distributed automatically to the site devices.
All Metasys devices that are part of the Site use the time zone they
are located in.
Specifies the resolvable host name or IP address of a Metasys server.
The Metasys server is the device to which local audit, alarm, and
trend data is delivered. Repository refers to the files in the Metasys
server in which this data is stored. A host name may be specified only
if a DNS server is available to the device. This attribute is distributed
automatically to the site devices.
The Default ADS Repository of the Site is intentionally left blank
and must be updated by the user (online or offline). If the user
does not populate the Default ADS value and leaves the Default
ADS Repository value for all devices at 0.0.0.0, the Metasys server
does not receive any audit, alarm, or trend data. The SCT does not
automatically populate the Default ADS Repository value because
of the many different possibilities that could exist during archive
creation, including multiple Metasys server on a site or no Metasys
server for a site. In these cases, it would not be immediately clear
which Metasys server should be the Default Metasys server under
the Site object.

Default Time Zone

C,W

Central Time
(US and
Canada)
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Specifies the site’s default time zone. The Site object determines and
updates the UTC offset from this value. Once set in the Site object,
the time zone is propagated to the other devices on the site.
All Metasys devices that are part of the Site use the time zone of the
Site Director, even if some of those devices are physically located in a
different time zone.
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
Device Time Servers

Notes
C,W

Initial Value Description
This attribute is used only for Windows time synchronization.
Leave this attribute blank if you are not using Windows time
synchronization. Specifies a list of resolvable host names or IP
addresses of Simple Network Time Protocol (SNTP) server devices
that the devices on the site (except the Site Director) use as their
time server. Do not use an SNTP server name that has a dash (-) as
its last character (for example, SNTP_Server-).
Periodically, each device on the site (except the Site Director)
attempts to sync time from an SNTP server from this list. Contact
with an SNTP server is attempted one at a time in list order until one
successful contact is made.
A host name may be specified only if a DNS server is available to
the site server. If the site server is also an SNTP time server, the site
server may be specified in this attribute. This attribute is distributed
automatically to the site devices.
The NxE or Metasys server designated as the Site Director is the
device time server for the site and provides the time management
for all other engines/servers on the site.
The Engine accepts BACnet Time Sync messages only if no SNTP
server is defined for that Engine.

Dynamic Broadcast
Management

False (SMP)
True (SCT)

Configures the Metasys system with BBMDs automatically when a
Metasys system includes more than one IP subnet so that BACnet
protocol broadcasts reach all Metasys system devices. When set to
True, Dynamic Broadcast Management determines the number of
IP subnets and ensures that each IP subnet has exactly one BBMD.
The feature uses the Third Party BBMDs List attribute in the Site
object when determining the list of devices to be BBMDs. As devices
are added or removed from the site, the selection of broadcast
management devices occurs automatically.
Note: Do not edit the BBMD Broadcast Distribution Table
in the Ethernet IP Datalink network port object if Dynamic
Broadcast Management is set to True.
When Dynamic Broadcast Management is set to False, the BBMD
Broadcast Distribution Table in the Ethernet IP Datalink network
port object is used to determine BBMD devices. Do not use the Third
Party BBMDs List attribute in the Site object. At Release 11.0, you
can edit the BBMD Broadcast Distribution Table with the option of
specifying an IP address or a host name.

Enum Set Memory Used

0

File Name

C,W

Multicast Group Address

C,W

224.0.1.1

Multicast Heartbeat Interval C,W

5

Multicast TLL

C,W

1

Multicast UDP Port

C,W

123
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Indicates amount of memory used by the created auto and custom
sets.
Specifies an XML file containing site organization data within the
file system of the host computer. This attribute appears only in the
Snapshot Focus view on a Site Director engine.
Specifies the IP address used to multicast the SNTP message. The
RFC-2030 defined standard address is 224.0.1.1. The address is
configurable to allow site-specific use.
Specifies the number of minutes between forcing a multicast time
synchronization message.
Specifies the Time-to-Live for a multicast message. The value
indicates the number of router hops allowed before the message is
not sent. Routers must be configured to pass multicast messages to
allow the time sync message to pass.
Specifies the UDP port on which multicast time synchronization polls
and listens for messages. The RFC-2030 defined standard port is 123.
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
Online Archive Transfer in
Progress

Notes

Poll Rate

C,W

Remaining Auto Sets
Remaining Custom Sets
Security Level

C,W

Initial Value Description
False
Indicates whether the Metasys Server is currently archiving changes
to its database as a result of a network engine download from SCT.
This attribute changes to True during the archive process, then
changes to False after the archive update is complete.
Fast
Specifies the frequency at which the Site Director checks its
communication status with site devices. This setting affects
the detection time of offline NxEs, and the amount of network
bandwidth needed to support this detection. At the default setting
Fast, the detection time is short, but the network bandwidth use is
high. At a Slow setting, the detection time is longer, but network
bandwidth use is low. The calculated Detection Interval is shown in
the NxE.

1000

This setting only affects communications with devices at Release 5.2
or later.
Indicates the number of remaining auto sets available.

256

Indicates the number of remaining custom sets available.

Medium (1)

Specifies the security level to be used by this device. This attribute is
distributed to the site's devices automatically.
This attribute appears only in the Snapshot Focus view on a Site
Director engine. Valid options include:
Low [0]: Login required.
Medium [1]: Low plus authorization.

Signature Alarm Priority
Threshold

Signature Exclude

Signature Include

C,W

140

C,W

C,W

High [2]: Medium plus signatures.
Specifies the value that represents the range of alarm priority
thresholds. The default value is 140. This attribute is checked when
determining whether an event requires electronic signature on
an ADX MVE installation. If the Event Priority value is below the
threshold, a signature is required. This attribute appears only when
you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).
Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the
string. If an item reference appears in this attribute, an event for this
item does not require a signature on an ADX MVE installation. This
attribute appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).
Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
requires a signature on an ADX MVE installation. This attribute
appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Site Director Reference

Metasys Site Management Portal Help

Specifies the object name of the Site Director for the site. If the site
has more than one Site Director, the attribute becomes a selection
list from which you can change the Site Director Reference. When
you change the Site Director, a message appears to request you to
log in to the new Site Director.
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Table 102: Site Object Attributes - Site View Tab
Attribute Name
Site Security Level

Notes
C,W

Site Time Servers

C,W

Initial Value Description
Encrypted
Selects whether encrypted only communication or encrypted and
Only
trusted communication is enabled between the Metasys server and
its network engines. Do not set this attribute to Encrypted and
Trusted until all network engines reporting to the Site Director have
been downloaded with trusted certificates. If the site has one or
more network engines with self-signed certificates only, but not
trusted certificates, set this attribute to Encrypted Only.
Specifies a list of resolvable host names or IP addresses of SNTP
server devices that the Site Director uses as its time server.
Periodically, the Site Director attempts to sync time from an SNTP
server from this list. Contact with an SNTP server is attempted one at
a time in list order until one successful contact is made. A host name
may be specified only if a DNS server is available to the site server.
Important items:
- The Site Director provides the time management for the site.
- On the NAE35/NAE45/NCE25, only the first listed address is used.
- An error message appears when you have configured one or more
Site Time Servers and attempt to change the time and date using the
Set Time and Set Date commands.
- The Engine accepts BACnet Time Sync messages only if no SNTP
server is defined for that Engine.
- The Site Time Servers attribute must be set to an SNTP server to
facilitate synchronization when in Multicast mode. Only the first Site
Time Server is used if more than one is specified in Multicast mode.
- When the Time Sync Method is set to Windows, also set the Internet
Time Server in the Windows operating system of the Site Director to
match the IP Address specified for the Site Time Server. In Control
Panel of the Site Director, search for Date and Time. On the Date
and Time dialog box, click the Internet Time tab. Click Change
Settings and enter in the Server field the same IP address that
you defined in the Site Time Server attribute. Click OK to apply the
change.

218

Metasys Site Management Portal Help

Table 102: Site Object Attributes - Site View Tab
Attribute Name
Third Party BBMDs

Notes
C,W

Initial Value Description
The Third Party BBMDs attribute is used by the Dynamic Broadcast
Management feature to help determine the placement of BBMDs.
BBMDs are used in the BACnet protocol to eliminate broadcast
messages sent across multiple subnets on an IP network. A single
device on each subnet, referred to as the BBMD, receives messages
from other BBMDs and broadcasts them locally on its own subnet.
If one or more third-party BBMDs exist, this attribute should specify
the complete list of IP addresses of third-party BBMDs and Metasys
system devices that should act as a BBMD. Each IP subnet should
have exactly one BBMD, either a third-party or Metasys system
device. To function properly, each third-party BBMD must be
configured with the list of all other BBMDs within the system as well.
If the Metasys system does not include any third-party BBMDs, then
this attribute typically should be left empty. A possible exception
would be if you want to designate a particular Metasys system device
as a BBMD, then that device could be added to the Third Party BBMD
list. If no device is specified by this attribute for an IP subnet, the
Dynamic Broadcast Management feature automatically assigns
a Metasys system device. Do not specify more than one Metasys
system device per IP subnet.
The devices are configured in the Third Party BBMD list in the
following ways:
- Address-UDP Port: Use the BACnet UDP Port address. The default is
47808.
- Address-IP: Use the IP address of the device.
- IP Broadcast Mask: Use the BACnet Broadcast Mask as defined by
BACnet standard 135-2004, section J.4.3.2. Specify 255.255.255.255
if messages should be directly sent to remote BBMDs using a unicast
IP address or broadcast messages are not allowed through the IP
router to the remote subnet. Otherwise, specify the subnet mask of
the remote subnet if broadcast messages are allowed through the IP
router to a remote subnet.

Time Sync Method

C,W

Windows

Time Sync Period

C,W

1 hour

Warning Banner

C,W

False
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In most cases, IP routers do not allow broadcast messages to be
passed to a remote subnet; therefore, the mask should be set to
255.255.255.255. If the IT department knows that broadcast
messages are allowed to the remote subnet, then set the mask to
the subnet mask that the BBMD resides upon.
Determines which mode is used to synchronize time. The available
modes are Windows or Multicast. Windows mode uses the Microsoft
W32Time service. Multicast mode uses a specific implementation of
the standard SNTP, which includes periodic multicasting of system
time to maintain better time synchronization across devices.
Specifies the interval at which the Site Director polls the defined site
time server (STS) (for example, the Atomic clock) for the time. We
recommend leaving the default value for this attribute. This attribute
applies only to the Engine.
Enables a special login feature that displays a warning statement
each time you access the Site Management Portal. The banner
appears for logging into the Site Director and any of its child devices.
Select one of the following warning banners: U.S. Department of
Defense (DoD), U.S. General Services Administration (GSA), U.S.
Department of Transportation (DOT) Federal Aviation Administration
(FAA), or None (no banner; default).
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Table 103: Configuring Metasys System Devices in the Third Party BBMD List
Field

Description

Address-UDP Port Use the BACnet UDP Port address. The default is 47808.
Address-IP

Use the IP address of the device.

IP Broadcast Mask Use the Broadcast Mask of the Metasys system device.
Important: This is not the subnet mask for Metasys system devices. Metasys system devices automatically use 255.255.255.255 for the broadcast mask.

Note: The changes made to labels on Authorization Category in the Site object are shown
in the Security Administrator screens. Refer to the Authorization Category Assignment section
of the Security Administrator System Technical Bulletin (LIT-1201528) for more information on
changing Object Categories labels and how these changes affect the UI.
Table 104: Site Object Attributes - Object Categories Tab
Authorization Category

Display Text

Standard Object Categories (Standard Object strings cannot be modified.)
HVAC

HVAC

Fire

Fire

Security

Security

Services

Services

Administrative

Administrative

General

General

Lighting

Lighting

Refrigeration

Refrigeration

Critical Environment

Critical Environment

Air Quality

Air Quality

Power

Power

Energy

Energy

System

System

Custom Object Categories (Display text can be modified).
Custom 1 - Custom 150

Custom 1 - Custom 150 (default)

Note: Devices at a release earlier than 5.2 are
limited to 12 categories.

Site Commands
The following table lists the commands supported by the Site Object.
Table 105: Site Object Commands
Command Name

Parameters

Description

Set Date

Day of Week/
Month/Year

Sets the current date for the Site object.

Set Time

Hour:Minute:
AM/PM

Sets the current time for the Site object.

Update Broadcast None
Management
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Requests the system to select broadcast management devices
over the Metasys network based on the Third Party BBMDs
List attribute for determining BBMD devices.
Metasys Site Management Portal Help

Supervisory Device
Menu Selection: Insert > Supervisory Device
Inserts a supervisory device into the archive database with SCT, including the following network
engines: NAE35, NIE39, NAE45, NAE451L, NIE49, NAE55, NIE59, NAE85, NIE89, NCE25, NIE29, NIE55,
NIE85, SNE10/SNE11/SNE22, and SNC16/SNC25. You can insert a device at a previous Metasys
system release with SCT, beginning with Release 5.2 and later. The SNE and SNC devices are only
available to SMP at Release 10.1 or later, and SCT Release 13.2 and later.
Note: The NAE451L and SNE110Lx network engines are available only to select regions
of Australia, China, Hong Kong, India, Indonesia, Japan, Korea, Malaysia, New Zealand,
Philippines, Singapore, Taiwan, Thailand, Vietnam, and select branches.
On the Configure screen of this wizard, click any tabs that may appear for further device
configuration.

Engine Device Object
The Engine object defines the attributes that represent the externally visible characteristics of a
NAE/NIEx5/NIEx9/NCE or SNE/SNC controller. One Engine Device object exists per controller. The
Johnson Controls Engine object functions differently from the BACnet Device object.
Notes:
•

In this chapter, Engines applies to all models of network engines, including the following:
- Network Control Engines: NCE25
- Network Automation Engines (small-capacity): NAE35 and NAE45
- Network Automation Engines (large-capacity): NAE55 and NAE85
- Network Integration Engines (small-capacity): NIE29, NIE39, NIE49
- Network Integration Engines (large-capacity): NIE59, NIE89
- Series of Network Controllers: SNC16 and SNC25
- Series of Network Engines: SNE10, SNE11, and SNE22

•

The Object Type for this object is labeled Device in the software.

•

If you open the Focus window for an Engine object but the window indicates the engine is
unreachable, you may need to the pair the engine to the Site Director. For details, see Pair
Network Engine with Site Director.

•

For SNE and SNC engines upgraded to Release 11.0, you cannot change the Computer
Name and JCI IP Address at the same time. If you need to change both of these attributes,
change one at a time. The engine resets after each operation.

•

Also, for SNE and SNC engines upgraded to Release 11.0, two USB Control attributes
protect the two USB ports on the engine from intrusion. Before you can use the USB
ports, you need to set the USB Port 1 Enabled and USB Port 2 Enabled attributes under
the Focus window to True. See Engine Attributes.

This object allows you to see data about the controller, such as the IP address and the current date
and time.
For general information on Metasys system objects, see the Object Help section.

Engine Concepts
Flash Memory
A type of nonvolatile memory within the Engine device. The Engine stores the operating system,
software, and archive within this memory. This memory is not used during normal operation of the
Metasys Site Management Portal Help
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Engine device, except when a new graphic is added and the new image is uploaded and stored. The
flash memory is mostly used during shutdown and system restart.

Operating System
Engines use a Microsoft Windows Embedded or Linux operating system (specific operating system
depends on the model), which is shipped preinstalled on the Engine or can be updated after the
engine is installed. In general, the operating system cannot be modified by adding or deleting
programs or drivers, although provisions are made to install factory-authorized patches and
upgrades.

Software
The software is the Johnson Controls programs used in the Engine, also preinstalled at the factory.
This includes graphics, trending, logic, alarm, and other programs. Provisions are made for both the
software and the operating system to be upgraded at the job site when new revisions of Metasys
Engine software are available.

Database
The database is the collection of objects and their parameters as defined by the user. Each
database is unique to the job. A database can be created or edited (with appropriate user authority)
either online using the Site Management Portal UI, or offline using SCT. SCT can also be used to
download a database or upload and create a backup copy of the database.

Archive
A copy of the database, called the archive, is kept in each Engine’s flash memory. This happens
automatically once a day or on operator command. Following restoration of power loss to an
Engine, the archive is copied into main memory to restore normal operation.

Background File Transfer
Network engine models at Metasys Release 10.1 or later support the Background File Transfer
feature. When you use SCT 13.2 or later to perform a download to the NAE55-2, NAE55-3, SNE, and
SNC models, you use the Background File Transfer feature. Background File Transfer permits you
to download a new image and database to a network engine while the engine is still running and
controlling the building. With previous releases, the engine was offline and inaccessible during this
process. The Background File Transfer feature is part of the Manage Archive Wizard > Download
To Device option in SCT.
The two background file transfer types offered in SCT are:
Code and Configuration: download and activate operating system, archive database, security
database, and HTTPS certificates. This file transfer type re-provisions the Flash memory of the
engine, including the operating system, application software, and device configuration.
Configuration only: download and activate archive database, security database, and HTTPS
certificates. This file transfer type updates the device configuration only, including the archive and
security databases, or certificates.
You can choose when to activate the downloaded files. If you activate the files immediately, the files
activate after the download completes. If you do not activate immediately, the files go into a staged
state in which the files are ready to deploy, but not until you are ready. The Staged Files attribute
of a network engine contains information about which files are downloaded but not yet applied.
Eventually, you can issue an Apply Staged Files command with the SMP UI to manually activate the
files you transferred. For more details about Background File Transfer, refer to Metasys SCT Help
(LIT-12011964).

Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
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object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, Q - BACnet Required, W - Writable.
When you promote or demote a network engine Site Director online using the Site Management
Portal UI, you are prompted for the user credentials of the Site Director you specified. These user
credentials are authenticated before the promotion or demotion is permitted.
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Table 106: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Description

Ack Forward Enable

C,W

Specifies whether all events acknowledged or discarded at a
network engine are forwarded to the ADS repository if an ADS
Repository is configured. What is included are:
•

Events and BACnet intrinsic alarm notifications generated
by the engine and acknowledged by a user logged into
the engine SMP.

•

BACnet intrinsic alarm notifications received by an
engine that are acknowledged at a BACnet device and
acknowledged by the engine without a user ID and
forwarded to the repository.
Acknowledgments are not forwarded to an ADS repository on
a dial-up connection.
When you acknowledge BACnet event notifications, events are
annotated with the source or device of the acknowledgment
and your user name as who acknowledged the event. If an
event notification from an engine is acknowledged at a thirdparty BACnet workstation, the event annotation at both the
engine and the site include the source of the annotation. If,
however, an event notification from a third-party device is
acknowledged from a third-party workstation, any engine that
also receives the event notification does not include a source
for the acknowledgment. When that event acknowledgment
is forwarded to the Site Director, the user is specified as
MetasysSysAgent.
When this attribute is not enabled, events acknowledged at
engines are:
•

not forwarded to the ADS repository. All events must be
acknowledged at the Site Director.

•

locally acknowledged at the engine. This
acknowledgment includes sending a BACnet alarm
acknowledgment for alarm notifications received by an
engine.
Regardless of whether this attribute is enabled, when events
are acknowledged or discarded at the Site Director, the
Site Director attempts to forward the acknowledgment and
discards it to the engine that initiated the event.
The Ack Forward Enable attribute must always be false on
Engines configured for validated environments, that is,
whenever signatures are required when acknowledging
events.
The behavior for Ack Forwarding is not well defined when an
Engine is configured both as a site device and as a BACnet
integrated device at the same site. Although an Engine can be
configured both as a site device and as a BACnet integration
device, this configuration is not recommended.
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Table 106: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Description

ADS Connection Type

C,N,W Specifies whether the Metasys Server (defined in the ADS
Repository attribute) is connected through a LAN or dial-up
connection. If a value is specified, it overrides the value of the
Default ADS Connection Type attribute. If no value is specified,
the value of the Default ADS Connection Type attribute is used
(Default ADS Connection Type is a site level setting sent to the
site’s devices). ADS Connection Type is ignored if no Metasys
Server is defined for this site.

ADS Delivery Time

C,N,W Specifies the time of day when a connection should be
established to the Metasys Server (determined by the
ADS Repository attribute). A connection is attempted at a
minimum of once a day at the specified time to deliver audit,
alarm, and trend data to the Metasys Server. If a value is
specified, it overrides the value of the Default ADS Delivery
Time attribute. If no value is specified, the value of the Default
ADS Delivery Time attribute is used (Default ADS Delivery
Time is a site level setting sent out to the site’s devices). ADS
Delivery Time is ignored if no Metasys Server is defined for
this site.

ADS Priority Threshold

C,W
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Specifies the priority of an event that triggers the Engine
to connect (dial or LAN connection) to the defined Metasys
Server and delivers the event messages from the Engine
local event repository to the ADS event repository without
waiting for the ADS Delivery Time. The ADS Priority Threshold
attribute is used for alarm and event management only.
For example, a value of 20 for this attribute means that any
event having a priority of 20 or higher (events of higher
alarm priority have lower alarm priority numbers) forces
a connection to the Metasys Server and forwards event
messages from the Engine local event repository to the
repository of the Metasys Server.
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Table 106: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Description

ADS Repository

C,N,W Specifies the ADS Repository device. This device is the Metasys
Server computer that receives all audit, alarm, and trend data
from a network engine. Repository refers to the three files in
the Metasys Server that store this data. If a value is specified,
it overrides the value of the Default ADS Repository attribute
of the site. If no value is specified, the value of the Default
ADS Repository attribute is used (Default ADS Repository is
a site level setting sent to the site’s devices). When you save
a change to the ADS Repository value, no authentication
between the network engine and the Metasys Server is
required. This is normal operation.
Note: If the Engine uses a dial-up connection to transmit data
to the Metasys Server, then the ADS Repository must be the first
IP address listed in the range specified when configuring the
Metasys Server to Allow Incoming Connections (see External
Modem Config section of the Communications tab).

The Default ADS Repository of the Site is intentionally left
blank and must be updated by the user (online or offline). If
the user does not populate the Default ADS value and leaves
the Default ADS Repository value for all devices at 0.0.0.0,
the Metasys Server does not receive any audit, alarm, or
trend data. The SCT does not automatically populate the
Default ADS Repository value because of the many different
possibilities that could exist during archive creation, including
multiple Metasys Servers on a site or no Metasys Server for a
site. In these cases, it is not immediately clear which Metasys
Server should be the Default ADS under the Site object.
Alarm Repository Size

C,W

Specifies the maximum number of alarms that can be
maintained on the local device.

Alarm Snooze Time

C,W

Specifies the amount of time to delay after an operator
temporarily ignores, or snoozes an alarm before reannouncing the alarm.

Align Intervals
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Specifies whether clock-aligned periodic time synchronization
is enabled. If periodic time synchronization is enabled and
the time synchronization interval is a factor of an hour or a
day (that is, the value divides without remainder), then the
beginning of the period specified for time synchronization
aligns to the hour or day, respectively.
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Attribute Name

Notes Description

APDU Retries

C,W

Indicates the maximum number of times that an Application
Layer Protocol Data Unit (APDU) (as specified by the BACnet
device) is retransmitted. If the device does not perform
retries, it is set to zero. If the value is greater than zero, a
nonzero value appears in the APDU Timeout attribute. If you
write the value of this attribute, you must reset the Engine for
the new settings to take effect. Recommended settings: high
or medium sensitivity: 4; low sensitivity: 5.
Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

APDU Segment Timeout

C,W

Indicates the amount of time in milliseconds between
retransmission of an APDU segment. Recommended settings:
high sensitivity: 4000 ms; medium sensitivity: 10000 ms; low
sensitivity: 20000 ms.
Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

APDU Timeout

C,W

Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received. Recommended
settings: high sensitivity: 6000 ms; medium sensitivity: 10000
ms; low sensitivity: 20000 ms.
Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

Appl SW Version

Identifies the version of the application software installed in
the device. The content of this string is locally defined (dateand-time stamp, a programmer’s name, a host file version
number, and so on).

Archive Date

Indicates the date of the last successful archive of object
instances. The value of this attribute is valid when a valid
archive exists and during the archive download process. The
value of this attribute is *.*.*.* at all other times.

Audit Action When Full

C,W

Specifies the operation of the audit trail feature when the
audit repository is full. If the value is Stop, additional audit
entries are discarded. If the value is Rollover, additional audit
entries replace the oldest audit entries.

Audit Generate Alarm
When Full

C,W

Specifies whether an alarm is generated when the audit
repository is full.

Audit Repository Size

C,W

Specifies the maximum number of audit trail entries that can
be maintained on the local device.

Backup And Restore State

Backup Fail Timeout

Describes the current state of the engine during the BACnet
backup or restore process. Possible values include Idle
(normal operation), Start, Downloading, Provisioning, Staged,
Activation, and Resetting.
C,W
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Specifies how long in seconds that the engine waits for the
BACnet backup or restore process to complete before timing
out and ending the process. Default is 120 seconds.
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Attribute Name

Notes Description

Backup Preparation Time

Specifies how long in seconds that the engine remains
unresponsive after starting the BACnet backup procedure and
before timing out and ending the process. Value is fixed at 60
seconds.

BACnet Communications
Password

C,W

Provides password protection of BACnet services, such as
DeviceCommunicationControl and ReinitializeDevice. Thirdparty workstations may use these services and must provide
the password for the Engine to execute the services. This
attribute is user configurable if the BACnet Site attribute in
the Site object is set to True. Specify a value for the BACnet
Communication Password (maximum 20 characters)
before using any BACnet services. This password is saved in
encrypted form within the engine and within the engine's
archive in SCT. Third-party workstations cannot read or write
this password.

BACnet UDP Port

C,W

Specifies the UDP port number used to communicate with
other BACnet devices over the IP network. This value allows
multiple BACnet networks on a single IP network and prevents
communication between the multiple BACnet networks.
If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.
Note: If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.

BIOS Version

Specifies the BIOS version in the Engine. The format of the
basic input/output system (BIOS) version is <V><major
release>.<minor release>. For example: V2.02. This attribute
is present only for NxE engines at Release 9.0 and earlier that
use a Windows Embedded operating system. It is blank or
does not appear for newer engines.
For NAE55/NIE55, if the BIOS version is earlier than V2.02,
update the BIOS using the BIOS Update Utility. This update
significantly improves overall product performance. For
information on the BIOS Update Utility, refer to the BIOS
Update Utility Technical Bulletin (Part No. 24-10110-42).

Configuration Files

Identifies the files within the image of the engine that you can
back up.

Database Revision

Specifies a logical revision number for the device’s database.
Database Revision is incremented when an object is created or
deleted, an object name changes, or a restore is performed.

Device Addr Binding
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W

Contains a list of BACnet Object Identifiers of an Engine Device
object and a BACnet device address in the form of a BACnet
Address. Entries in the list identify the actual device addresses
that are used when accessing the remote device via a BACnet
service request. The list may be empty if no device identifierdevice address bindings are currently known to the device.
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Attribute Name

Notes Description

Device Object Identifier

Dial-up Audit Forwarding
Threshold

Identifies a numeric code assigned to the engine. The
identifier must be unique across the entire Metasys network.
This attribute appears in the Focus and Configuration tabs.
C,W

Specifies the size limit of the audit repository (as a percent
of the audit repository size) at which the network engine
attempts to deliver audit entries to the Metasys Server when
the engine has a dial-up connection. (For engines connected
over a LAN, audit entries are delivered immediately.) This
attribute applies only if a Metasys Server is configured as the
Site Director for the network engine. When this threshold is
reached, all audits in the Local Audit Repository that have not
been forwarded are forwarded to the defined ADS Repository.
The default is 80%, and to ensure good performance, you
should not change to a lesser number.

DST Status

Indicates whether daylight saving time is in effect (True) or
not (False) at the device’s location.

Duplicate References

Lists references that are duplicated in the system. Entries in
this list are object references that exist on more than one
device within the system.

Enable Application
Generated Audits

C,W

Enables audits of system commands.

Enabled Audit Level

C,W

Specifies which level of audit entries are added to the Audit
Repository. Only audit entries of type Level 1 through (and
including) the specified level are included. All other levels are
not stored in the audit trail. Level 1 and Level 2 audit entries
are always stored in the audit trail.
• Level 1 and 2 (1): Stores all user action and system error
audit messages.
• Level 3 (2): Stores application audit messages in addition to
Level 1 and 2 auditing.
• Level 4 (3): Stores system audit messages in addition to Level
3 auditing.
• Level 5 (4): Stores diagnostic audit messages in addition to
Level 4 auditing.

Event Action When Full

C,W

Specifies the operation of the Alarm and Event Management
feature when the event repository is full. If the value is Stop,
additional event entries are discarded. If the value is Rollover,
additional event entries replace the oldest event entries.

Note: If Display Object Generated Objects is set to true, these
audits appear in the audit viewer of the Engine or Metasys
Server, increasing the number of audits generated.

Firmware Version
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Represents the release of firmware installed in the main code
section of the device. The first digit in the revision number
is advanced on major releases. The second digit is advanced
on minor releases. This attribute is in contrast to the Staged
Firmware Version attribute, which indicates the engine's
firmware version that is currently staged in the engine.
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Notes Description

IEIEJ Function A List

C,W

Provides a list of structures with the following elements:
Network Number, Device ID High Limit, and Device ID Low
Limit. The first set of Who-Is messages is broadcast once the
device reaches the Enable Field Commands phase of startup.
At this time, a timer starts running that calls a method to send
the Who-Is messages at the period specified by IEIEJ Function
A Period.

IEIEJ Function A Period

C,W

Sets the period at which the IEIEJ Function A List sends
the Who-Is message broadcasts. Clearing the value of this
property disables the function A feature. Each destination
is guaranteed to get a Who-Is message within the period
specified by this property; however, if the list contains multiple
destinations, the object attempts to spread out the Who-Is
messages so that they are not all sent out at the same instant.

Internode Comm Timer

C,W

Controls the frequency of communication with remote
Ethernet devices. This value is used by the Ethernet IP
Datalink object. Among other communications, this attribute
defines the frequency of the heartbeat to monitored devices
(monitored at a rate of two times the Internode Comm Timer).
Recommended settings: high sensitivity: 20 seconds; medium
sensitivity: 120 seconds; low sensitivity: 240 seconds.
Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

Interval Offset

C,W

Specifies the offset, in minutes, from the beginning of the
period defined for time synchronization until the actual time
synchronization requests are set. Interval Offset has no effect
when Align Intervals is False.

Is Validated

C

Enables the MVE feature at the engine, which includes
reauthentication with electronic signature and required
annotation when the user makes a change to the system,
such as commanding an object, acknowledging an alarm, or
changing the value of an attribute. This attribute can be set to
True for MVE sites only. This attribute is writable only with the
SCT, and is read-only online.

JCI Exception Schedule

C,W

Indicates how long exception schedules are kept after the
exception date has expired. The default value is Auto Delete
31 days, which is the same behavior prior to this release. New
options are Auto Delete 7 days and Manual Delete.
Notes:
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•

The Engine (using SCT and online UI) and FAC (at CCT)
allows selections for Manual Delete, Auto Delete 31 days,
and Auto Delete 7 days.

•

Manual Delete is needed for locations like Japan
where the local standards state that only the BACnet
workstation can delete exception schedules.
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Attribute Name

Notes Description

Last Restart Reason

Indicates the reasons for the last device restart. The possible
reasons are:
•

UNKNOWN: The device cannot determine the cause of
the last reset. This may occur due to a startup error,
shutdown error, crash, or pushing the hardware reset
button. The state is UNKNOWN if the device is powered
without the battery or if the Device Manager service is
stopped.

•

COLDSTART: A ReinitializeDevice request was received
with a Reinitialized State of Device of COLDSTART or
the device was made to COLDSTART through the user
interface.

•

WARMSTART: A ReinitializeDevice request was received
with a Reinitialized State of Device of WARMSTART or the
device was made to WARMSTART by some other means.
WARMSTART also occurs after a download from SCT.

•

DETECTED_POWER_LOST: The device detected that
incoming power was lost. This state occurs as the result
of a normal power down (with battery).

•

DETECTED_POWERED_OFF: The device detected that its
power switch was turned off.

•

HARDWARE_WATCHDOG: The hardware watchdog timer
reset the device.

•

SOFTWARE_WATCHDOG: The software watchdog timer
reset the device. This state is reported when Device
Manager cannot communicate with the control engine
for any reason.

•

SUSPENDED: The device was suspended. How the device
was suspended or what it means to be suspended is a
local matter.

Last Restore Time

The time at which the engine was last restored. Clicking the
down arrow exposes date and time details.

Local Date

Indicates the date to the best of the device’s knowledge. The
Date type is a series of four one-number elements.
The first number is the year (for example, 2005); the second
number is the month (1..12, 1=January); the third is the day of
month (1..31). To maintain compatibility with BACnet protocol,
a fourth number contains the day of week (1=Monday). A
value of FF * (asterisk) in any of the elements indicates the
value is not specified.
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Attribute Name

Notes Description

Local Site Director

C,W

Specifies a resolvable host name or IP address of the Site
Director. A host name may be specified only if a DNS server
or other means of name resolution is available to the device.
A Site Director may have more than one host name. The host
name specified here must be resolvable to an IP address on
the LAN or WAN on which the site’s devices exist.
The Local Site Director attribute is based on the Computer
Name attribute, not the Name attribute. When you change
the Site Director device’s Computer Name attribute, its Local
Site Director attribute automatically changes to match its
Computer Name. When you change a non-Site Director
device’s Computer Name, its Local Site Director attribute
remains unchanged.
Note: When you promote or demote a Site Director online in
SMP, you may be prompted for the user credentials of the Site
Director you specified. Enter these user credentials for validation before the promotion or demotion is permitted.

For information designating an Engine as the Site Director,
refer to the NAE Commissioning Guide (LIT-1201519).
Local Time

Indicates the time of day to the best of the device’s
knowledge. The Time type is a series of four one-number
elements. The first number is the hour (0..23); the second
number is the minute (0..59); and the third number is
the seconds (0..59). A fourth number has been added to
maintain compatibility with BACnet protocol and contains
the hundredths of second (0..99). A value of * (asterisk) for
any number indicates the value is unspecified. This value
would be used, for example, when the hundredths value is not
important.

Location

C,W

Indicates the physical location of the device.

Max APDU Length

C

Indicates the maximum number of bytes that may be
contained in a single, indivisible application layer protocol
data unit.

Max Message Buffer

C,W

Specifies the largest piece of data that can be sent to a device
at one time, excluding all communications headers. Some
applications need to perform segmentation of data outside
the communications system. This value is used to size the data
in those situations.

Max Segments Accepted

Indicates the maximum number of segments of an APDU
accepted by the device.

Model Name

Indicates the device model, the hardware revision associated
with the firmware, and the code file name used to download
the device.
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Attribute Name

Notes Description

Network Address

C,W

Specifies the BACnet network address. A change to this
attribute takes effect after the next Engine restart (cold or
warm). If you write the value of this attribute, you must reset
the Engine for the new settings to take effect.
Note: If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.

OS Version

Power Consecutive
Sample

Indicates the version number of the operating system in use
by the Engine. This attribute is present only for engines that
are running the Linux operating system.
C,W

Specifies the number of consecutive AC line status samples
(indicate a power loss) must be received before the device
concludes that a power failure has occurred. When the
device concludes that power has failed, the device begins an
orderly shutdown process. The process used for determining
whether a power failure has occurred protects the device
from shutting down during short power failures or certain
brownout conditions. Using default values, a power failure of
less than 5 seconds does not prompt a device shutdown.
Note: If you change the Power Consecutive Sample value on
a network engine with Metasys Release 9.0.7 firmware, you
must restart the engine before the new setting takes effect. A
restart is not necessary for engines that are running a different
releases.

Power Sampling Interval

C,W

Specifies the period at which the AC line status is sampled
to determine whether a power failure has occurred. This
attribute is used in conjunction with the Power Consecutive
Samples attribute.
Note: If you change the Power Sampling Interval value on
a network engine with Metasys Release 9.0.7 firmware, you
must restart the engine before the new setting takes effect. A
restart is not necessary for engines that are running a different
release.

Process ID List

C,W

Process Unmapped
Objects Alarms
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Contains a list of unsigned 32-bit numbers used to compare
the Process ID sent with the BACnet events. If the event
Process ID is not found on this list, then the event is ignored.
An empty list or a list containing only one entry with the value
of zero allows all events to be processed.
Specifies whether the engine should process alarms that
originate from unmapped objects. This attribute applies only
to the ODS and is fixed at False for all other devices.
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Protocol Obj Support

Indicates which standard BACnet object types the device’s
protocol implementation supports.
This attribute is a bit string that uses the Object Type (Set
508). Each bit represents a BACnet object type in that set. For
example, bit 0 represents the BACnet AI object type, whereas
bit 17 represents the BACnet schedule object type. If the bit
is true (1), the object type is supported. If the bit is false (0),
the object type is not supported. The BACnet object types
supported can vary between device models.

Protocol Revision

Indicates the minor revision level of the BACnet standard the
device supports.

Protocol Ser Support

Indicates which standard BACnet protocol services the
device’s protocol implementation supports. For more
information on the Protocol Implementation Conformance
Statement (PICS) and BACnet Interoperability Building Blocks
(BIBBs) of the Engine, see Related Documentation. This object
now supports both the BACnet UTCTimeSynchronization
message and the BACnet TimeSynchronization message (nonUTC version). Third-party devices now have the ability to send
the TimeSynchronization message to an Engine.
This attribute is a bit string that uses the Protocol Ser Support
(Set 136). Each bit represents a BACnet service in that set. For
example, bit 0 represents the Acknowledge Alarm service,
whereas bit 12 represents the Read Property service. If the bit
is true (1), the service is supported. If the bit is false (0), the
service is not supported.

Protocol Version

Represents the BACnet protocol the device supports. Initial
releases are Version 1; subsequent releases increase the
number by one.

Restart Notification
Recipients

C,W

Controls the restrictions on which devices, if any, are notified
when a restart occurs. The value of this attribute is a list of
BACnetRecipients. When the length of this list is empty, the
device cannot send a device restart notification.
The default value of this property is a single entry
representing a broadcast on the local network. If the list has
one or more entry, the device sends a restart notification, but
only to the devices or addresses listed.

Restore Preparation Time

Specifies how long in seconds that the engine remains
unresponsive after starting the BACnet restore procedure and
before timing out and stopping the process. Value is fixed at
60 seconds.

Restore Completion Time

Specifies how long in seconds that the engine remains
unresponsive after ending the BACnet restore procedure and
before timing out and stopping the process. Value is fixed at
600 seconds.
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Attribute Name

Notes Description

Segmentation

Indicates if the device supports segmentation of messages
and (if so) if it supports segmented transmission, reception, or
both.

Site Director Online

Indicates the communication status of this device with the Site
Director. This value is kept current by a command sent by the
Data Refresh COV Monitor task whenever the status changes.
The COV Monitor task performs this check every 80 seconds.
This attribute is triggered so it can be used for an alarm.

Staged Files

List of staged files that are set for activation at a later time.
For example, if the code and archive database are set for later
activation, this field would read Code, Archive Database. If
this attribute is empty, no files are currently staged. Possible
values: Code, Archive Database, Security Database, HTTPS
Certificates.

Staged Firmware Version

D

Indicates the engine firmware version that is staged for later
activation. If this field is empty, no firmware files are currently
staged. This attribute is in contrast to the Firmware Version
attribute, which indicates the engine's firmware version that is
currently active.

System Status

D

Reflects the current physical and logical state of the device.

Time of Device Restart

Indicates the time at which the device was restarted.

Time Sync Recipients

C, W

Lists one or more BACnet recipients to which the engine can
issue a Time Synchronization request. If the list is empty,
the engine cannot send a Time Synchronization request
to a BACnet recipient. The attribute requires several other
parameters that define each recipient, such as its device ID, IP
address information, or broadcast type and information.

Time Synchronization
Interval

C,W

Specifies the periodic interval, in minutes, at which
TimeSynchronization and UTCTimeSynchronization requests
are sent. When set to zero, then periodic time synchronization
is disabled.

Time Zone

C,W

The current time zone in use at the location of the Engine.

Unbound References

USB Port 1 Enabled

Lists references that are not bound in the system. This
attribute indicates that a process cannot find an object either
because the device on which the object is located is offline, the
object has been deleted, or the object reference is incorrect.
C,W
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Specifies whether USB Port 1 on the SNE or SNC network
engine is enabled. This attribute applies only to the SNE and
SNC models. For enhanced security, the USB port is set to
Disabled by default. Before using the USB port, change this
attribute to Enabled.
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USB Port 2 Enabled

C,W

Specifies whether USB Port 2 on the SNE or SNC network
engine is enabled. This attribute applies only to the SNE and
SNC models. For enhanced security, the USB port is set to
Disabled by default. Before using the USB port, change this
attribute to Enabled.

UTC Time Synchronization C,W
Recipients

Lists one or more BACnet recipients to which the engine
can issue a UTC Time Synchronization request. If the list is
empty, the engine cannot send a UTC Time Synchronization
request to a BACnet recipient. The attribute requires the
following parameters that define each recipient: ID (Device
ID), Address (IP Address, Network Number, UDP Port), and
Broadcast (Broadcast Type, Network Number, UDP Port).
Three broadcast types are available: local, remote, and global.

Vendor ID

Distinguishes proprietary extensions to the protocol using a
unique vendor identification code assigned by ASHRAE. The
Johnson Controls Vendor ID is 5.

Vendor Name

Identifies the manufacturer of the device.

Version

Indicates the version number of the firmware image in the
Engine.

Table 107: Engine Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Description

Audit Rate

Specifies the number of audit messages destined for the
Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.

Audits Lost

Specifies the total number of audits that were not forwarded
to the configured repository and were deleted from the
Engine's local repository. This count does not persist through
an Engine reset. The count reflects the number of lost audits
since the last reset.

Average Intermittent
Failure Period

Specifies the average number of seconds that devices in
the transport layer are offline (for diagnostic purposes).
Only times less than one minute are used in this average, to
eliminate device resets. Ideally, this number should be zero,
indicating there are no failures.

BACnet Broadcast Receive
Rate

Indicates the number of BACnet broadcast messages received
by the device in the previous minute. BACnet broadcast
messages are generated as part of the normal BACnet
operation, but are also generated when a BACnet device
searches for another device that does not exist, such as when
a device has objects with references to other nonexistent
objects (called unbound references). This number increases
when the number of unbound references increases on
network connected devices. If this number gets too high, it
indicates possible performance problems.
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Attribute Name

Flags

Description

BACnet Routed Messages
Rate

Indicates the number of BACnet messages received by the
device on the IP network in the previous minute. If this
number is high, it indicates that the performance of the MS/TP
field bus network is affected by broadcast transmit traffic. This
attribute appears only in the Snapshot Focus view.

Battery Condition

Specifies the current battery condition. It is updated every 60
seconds. For the NAE55/NIE55, a value of Fault implies the
battery is missing or defective and a value of OK implies there
is no known problem with the battery.
For the NCE25/NAE35/NAE45, the values are:
•

Good - Battery is operating at normal specifications.
Provided the battery is fully charged, it should supply
backup power to the engine three times a day for 6
minutes each time.

•

Service - Battery useful life is predicted to end soon. We
recommend you replace the battery. Backup power lasts
less than 72 hours.

•

Replace - Battery useful life is over. Replace the battery.
Backup power may fail if the battery is not charged fully.

•

Defective - Battery is either missing, disconnected,
incorrectly installed, or the battery is internally shorted
or otherwise defective. Take corrective action. Backup
power is not provided for any duration.
After a line power failure, the battery is used to supply power
to the device so the device can perform an orderly shutdown
without losing data. After the device shutdown process
finishes, the device discontinues its use of battery power. Valid
data is provided only on the Engine hardware.
Note: The SNC and SNE engines do not have this attribute
because these models use a supercapacitor, not a battery.

Battery Charging

Specifies the current battery charging state in an NCE25/
NAE35/NAE45. A value of False indicates the battery contains
at least 80% of full charge capacity and is not currently
recharging. A value of True indicates the battery contains less
than 80% of full charge capacity and is currently charging. If
the Battery Charging value is True and the battery is charging,
the battery stops charging when it is 100% charged.
Trend this attribute value to determine the current battery
charge cycle time. In Simulation, this attribute is False.
Note: The SNC and SNE engines do not have this attribute
because these models use a supercapacitor, not a battery.
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Attribute Name
Board Temperature

Flags

Description
Specifies the current printed wire board (PWB) temperature in
degrees Celsius. It is updated every 60 seconds. It is obtained
from a temperature sensor built onto the PWB. The device
is designed to run reliably with a PWB temperature at or
below 67 degrees Celsius. If this temperature is exceeded,
appropriate measures should be taken to cool the device.
Note: The SNC and SNE engines do not have this attribute.

COV Rcv Rate

Specifies the number of COV messages the Engine receives
from other supervisory devices or field controllers per minute.
This attribute value updates every minute. Each COV message
represents one object reporting a value change.

COV Tx Rate

Specifies the number of COV messages the Engine sends to
other supervisory devices per minute. This attribute updates
every minute. Each COV message represents one object
reporting a value.

CPU Temperature

Specifies the current CPU temperature in degrees Celsius for
a network engine. The value, obtained from a temperature
sensor built into the CPU, is updated every 60 seconds. For
NxEs and NCEs, set an alarm for the CPU temperature at 70°C;
for SNCs and SNEs, set an alarm for the CPU temperature at
88°C. If the temperature reaches these limits, take appropriate
measures to cool the device.

CPU Usage

Specifies a running average of CPU usage over the last 50
minutes. The value is updated every 30 seconds. The running
average is calculated by adding or subtracting 1% of the
difference between the current and average CPU usage. The
value may not be meaningful until 50 minutes after a system
restart. A value of 0% means the CPU is 100% idle. A value
of 100% means the CPU is 0% idle. A value of 50% or less is
considered OK, although other performance indicators should
also be assessed.

Data Collection Rate

Indicates the data value collection rate of the Ready Time
Series Data feature. It represents the rate of data values
collected, not the rate of data values delivered to the clients.
The feature buffers data values when the data collection rate
is within the maximum expected rate (83,333 data values per
minute) and the client is unknown or offline. In the event
of a remote connection failure, a minimum of 60 hours of
data is buffered locally for automatic delivery when the
error condition is resolved. This feature is only used by a Site
Director and is updated every minute.
Note: Starting at Release 10.0, the remote services connection to a cloud-based platform is no longer available, so this
attribute does not function.
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Flags

Data Usage

Description
Indicates the number of data values currently locally stored by
the Metasys Ready Time Series Data feature as a percentage
of the maximum allowed. Typically, data samples are routinely
delivered to an online client and the data usage remains
small. When the client is unknown or offline, data values
continue to accumulate in local storage until limits are
reached. This feature is used by a Site Director and is updated
every minute.
Note: Starting at Release 10.0, the remote services connection to a cloud-based platform is no longer available, so this
attribute does not function.

Detection Interval

Indicates the time, in seconds, determined by the HTTP
transport mechanism based on the Poll Rate and Network
Tolerance settings. This value determines how fast a site
detects a device going offline.

Duplicate References

Lists references that are duplicated in the system. Entries in
this list are object references that exist on more than one
device within the system.

Estimated Flash Available

Specifies the estimated flash memory available within the
device for use by the user’s database and applications.
This value can be used to determine whether additional use
of flash can be accommodated; however, other performance
indicators should also be assessed. This property’s value is
calculated at the same time as the Flash Usage attribute.
A negative value suggests that the flash usage should be
reduced. Also, a negative value can affect system reliability
now or in future releases of software.

Event Rate

Specifies the number of event messages destined for the
Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.

Events Lost

Specifies the total number of events which failed to be
forwarded to the configured repository and which were
deleted from the Engine's local repository. This count does
not persist through an Engine reset, and reflects the number
of lost events since the last reset.

Flash Usage

Specifies the estimated percent of flash memory currently
in use. The percentage is based on the portion of flash that
is designated for use by the user’s database. The value is
updated on device startup, after a database archive, sync
or download from the SCT (offline mode), and by manual
command (Update Flash Usage). A value greater than 100%
can affect system reliability now or in future software releases.
No restrictions are in place to prohibit use of flash over 100%.
If you are simulating an NAE/NIE, your computer’s hard disk
must be formatted for NTFS. If your computer’s hard disk
is formatted to use FAT32 (32-bit File Allocation Table), the
simulated value for the Flash Usage attribute is not accurate.
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Table 107: Engine Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Description

Maximum Intermittent
Failure Period

Specifies the maximum number of seconds a device was
offline at the transport layer (for diagnostic purposes).
Only times under one minute are recorded, to eliminate
device resets. The value of this attribute does not match the
offline times determined from generated alarms. Ideally, this
number should be zero, indicating there are no failures.

Memory Usage

Specifies the percent of system RAM that is currently in use.
It is calculated as follows:
Total commit charge x 100
Display Precision = 0.01
COV Increment = 0.1

Network Tolerance

C,W

Sets the timeout tolerance of the flexible polling feature (that
is, changes the lower level communication timeouts). When
edited by a user, this attribute is sent to the HTTP transport
layer and determines how long the device waits to connect,
send, and wait to receive HTTP Post responses. The setting
options are LOW, MEDIUM, and HIGH. LOW is the default and
matches the current behavior. The MEDIUM or HIGH setting
increases the tolerance by adding longer timeouts and more
retries and should be used for poor network connections.
Note that it takes longer to detect an offline device as the
tolerance gets higher.

Object Count

Indicates the number (count) of all of the object instances
within the device. Objects of all classes are included.

Object Memory Usage

Specifies the percent of the object database that is currently
in use. Each object created consumes memory within the
object database. This attribute can be used to help determine
the device’s capacity for additional objects; however, other
performance indicators should also be assessed. Generally,
the number of objects you define determines the object
memory usage. This attribute is valid on the Engine hardware.
Note: If you have a large number of objects, the object memory
usage increases and the archive.moi file size increases also. The
archive.moi file is stored in flash memory.

Also, an attempt to create an object known to require X bytes
of object database may fail even if more than X bytes are
available in the object database. This is because the object
database is composed of multiple blocks. If the free space
of each block is fewer than X bytes, the request for X bytes
fails even though the sum total of free space from all blocks is
greater than X bytes.
Pager Dial-up Status
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Specifies the current status of the pager dial-up connection.
Available only in network engines at Release 9.0 and earlier
that use a Windows Embedded operating system.
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Table 107: Engine Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Registration Usage

Description
Indicates the number of registrations used by the Metasys
Ready Time Series Data feature. It is the total usage of all
clients of this feature. Each registration is a sign-up for an
attribute of an object. The feature supports up to 1,000
registrations per fully loaded field bus per site device. This
feature is only used by a Site Director and is updated every
minute.
Note: Starting at Release 10.0, the remote services connection to a cloud-based platform is no longer available, so this
attribute does not function.

Repository Status

Indicates the status of the communication between the device
and the trend log sample repository (for diagnostic purposes).
This attribute uses the Repository Status set.
Uses Repository Status set:
0 = Offline
1 = OK
2 = Undefined
3 = Dialup
4 = RAP
5 = Incompatible Release

Samples Lost

Specifies the number of trend samples lost because the
Metasys server did not retrieve them fast enough (for
diagnostic purposes). This value resets only when the device
restarts.

Sample Rate

Specifies the number of trend samples destined for the
Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.
Note: The sample rate at the Engine is calculated based on the
actual raw samples taken by every trend object. The sample
rate at the Metasys Server is calculated once every poll cycle
and is based on the number of samples received from all the
Engines and the time it took to poll them. Most Engines do not
forward all the samples taken between polls because the Metasys Server transfer setpoint is usually not set to 1 (that is, forward on every sample). The result is that the sample rate at the
Metasys Server is less than the sum of the samples taken at all
the Engines. The total Metasys Server sample rate is 60,000 and
the total Engine sample rate is larger than 100,000.

Time Between Buffer
Reads

Indicates the time, in minutes, between Engine trend
consolidation buffer readings from the Metasys server (for
diagnostic purposes).

Transfer Buffer Full

Indicates the percentage full of the Engine trend consolidation
buffer (for diagnostic purposes).
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Table 107: Engine Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Description

Transport Failure Rate

Specifies the number of transport failures per day (for
diagnostic purposes). This number represents how often HTTP
posts from this engine failed when they were sent to another
device that is considered online. Failures include the inability
to open the connection, to send the message, or to receive
the reply. This value represents failures over the last 24 hours
and is updated hourly, but does not correlate directly to the
number of offline alarms generated by your system. Ideally,
this number should be zero, indicating there are no failures.

Unbound References

Lists references that are not bound in the system. This
attribute indicates that a process cannot find an object either
because the device on which the object is located is offline, the
object has been deleted, or the object reference is incorrect.

Table 108: Engine Device Object Attributes - Communications Tab
Attribute Name

Flags

Initial
Value

Values/Options/Range

Note: The Communications tab is only present for older network engines that have gray exteriors. The
tab has three different configurations: Serial Port Cable Config, Internal Modem Config, and External
Modem Config. Each configuration has the same set of attributes, which are described in this table.

Allow Incoming
Connections

C,W

True

Whether the communications port is enabled to
accept an incoming call from another device.

Baud Rate

C,W

115200

The configured baud rate set for the communications
port.

Enabled

C,W

True

Whether the communications port is enabled to
initiate a call to another device.

Extra Initialization
Commands

C,W

Maximum Baud Rate

C,W

115200

The maximum configured baud rate set for the
communications port.

Wait for Dial Tone
Before Dialing

C,W

False

Whether the network engine should wait for the dial
tone before attempting to place a call.
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An optional list of modem initialization commands,
such as characters and symbols, necessary to
establish a reliable connection.
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Table 109: Engine Device Object Attributes - Network Tab
Attribute Name

Flags

Initial
Value

Values/Options/Range

Allow Http

C,W

True

Available at network engines at Release 8.1 or later. It
determines whether the operating system firewall in
the network engine blocks incoming traffic over the
HTTP port (port 80). If the attribute is set to True, all
incoming traffic over port 80 at the network engine is
allowed; if set to False, all incoming traffic over port
80 at the network engine is blocked. Changing this
attribute does not interfere with NAE Update Tool
operations.
You can set this attribute independently on each
network engine, and can modify it using a schedule
or other control action. You can configure a tailored
summary to view the value of the attribute on all
network engines at the site. You can also use the mass
editing capability in SCT to modify the attribute across
multiple devices.
To provide the highest level of security, it is
recommended that you set this attribute to False.
However, if the network engine is a Site Director and
has one or more child engines reporting to it that
have not been upgraded to Release 8.1 or later, set
the attribute to True. For a list of the tools and utilities
that require port 80, refer to the Allow Http section of
the NAE Commissioning Guide (LIT-1201519).

Completion Domains

C,W

Specifies a domain name that is appended to the
computer name of a network engine to help the
engine broadcast over the building network. For
example, if you specify a completion name of
mycorp.com and the name of the network engine
is NAE-1, the engine is identified on the network as
NAE-1.mycorp.com. Use this attribute for network
engines that have difficulty communicating with their
site director.
If DHCP is enabled on the engine, the DHCP
server populates the list of completion domains
automatically. In this case, if you manually delete a
domain from the list, it is readded when you save the
change.
Note: Depending on the model of the network engine,
the full list of configured completion domains may not
appear under the drop-down box in View mode. In this
case, switch to Edit mode to view the full list of completion domains.
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Table 109: Engine Device Object Attributes - Network Tab
Attribute Name

Flags

Computer Name

C,W

DHCP Enabled

C,W

DNS Server IP
Addresses

C,W

Domain Name

C,W

Initial
Value

Values/Options/Range
Identifies the network engine to the Metasys network.
Changing the Computer Name online breaks any
existing references between the NAE object and
other objects on the site, and may break the existing
network connection to other devices on the network.
We do not recommend changing the Computer
Name online. Instead, change the Computer Name
attribute offline with the SCT by right-clicking the NAE
in the navigation tree and selecting Rename. Both the
Computer Name and Name attributes are changed
to the new name you select. The Item Reference then
updates to show the new Computer Name.
Notes:

True

•

If you change the value of this attribute, a
confirmation message appears informing you
that the Engine must be reset before the new
name can be applied.

•

The Computer Name must not consist of all
numbers. For example, a computer name of
N1234 is acceptable but 1234 is not.

True = DHCP enabled; network engine requests IP
address from DCHP server; if no server is present,
APIPA addressing is used.
False = DHCP disabled; network engine uses a static IP
address.
List of IP addresses.
Note: If you change the value of this attribute, the
Engine automatically resets.

Ethernet 1 Speed

The current connection speed of the network
engine on the first Ethernet port. Only SNC and SNE
engines have this attribute. The attribute shows Not
Connected if no connection is present.

Ethernet 2 Speed

The current connection speed of the network engine
on the second Ethernet port. Only the SNC has two
Ethernet ports and therefore has this attribute. The
attribute shows Not Connected if no connection is
present.

Ethernet MAC Address

The MAC address of the network engine.

JCI IP Address

C,W

The currently assigned IP address of the network
engine.

IP Mask

C,W

The currently assigned IP mask of the network engine.

IP Router Address

C,W

The currently assigned IP router that the network
engine is using.
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Table 109: Engine Device Object Attributes - Network Tab
Attribute Name

Flags

Initial
Value

Values/Options/Range

Obtain DNS Address
Automatically

C,W

True (1)

Whether the DNS IP address is populated
automatically.

Routing Mode

C,W

Disabled

The current state of the BACnet routing mode.
Options are Disabled, Enabled, Enabled Without
Broadcast.

Table 110: Engine Device Object Attributes - Hardware Tab
Attribute Name

Flags

Initial
Value

Values/Options/Range

Note: The Hardware tab is present only for SNC network engines.

Application Class Set
Version

64

Indicates the version of the application class set for
the SNC.

0

Indicates the number assigned to the control
sequence in testing mode.

Controller Number

999

Indicates the unique address of the field controller as
set by the rotary switch block on the engine.

Device Model Class
Set Version

65

Indicates the version of the device model class set for
the SNC.

Control Sequence In
Test

C,W

Pcode

Indicates the product code number of the SNC (for
example, M4-SNC25150-0).

Startup OFF State
Auto Release Time

C,W

0

Indicates the amount of time a BO is held in the
OFF state at the priority set by the Startup OFF State
Command Priority setting at field controller startup.
This instance only applies to BO objects that have
their Startup OFF State Enable parameter set to TRUE.
The default value is 0. A value of 0 disables this
parameter. The range is 0 to 3600 seconds.

Startup OFF State
Command Priority

C,W

9

Indicates the priority at which a BO is held in the OFF
state for the Startup OFF State Auto Release Time at
field controller startup. This instance only applies to
BO objects that have their Startup OFF State Enable
parameter set to TRUE.
The default value is 9. Priority 6 is not a valid selection.
The range is 1 to 16.

Engine Commands
The following table lists the commands supported by the Engine Device Object.
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Table 111: Engine Device Object Commands
Command Name

Parameters

Description

Activate Changes

Value

Activates the pending attribute changes to network ports
of the network engine. The command activates all pending
changes to all network ports on the engine; individual ports
cannot be activated separately. Also, this command is offered
only when the staging area in the engine has files that are
waiting for activation, which is indicated when the Changes
Pending attribute of one or more integration objects is set
to True. After you issue this command, the Changes Pending
attributes of the integration objects in the engine are set
to False. Command options: Update Changes Pending
Attributes Except Network Number and Update All
Changes Pending Attributes and Restart Device.
Note: This command is only available for network engines at
Release 11.0 or later.

Apply Staged Files None

Activates all staged files in the engine. The command is
offered only when the staging area has files for the selected
engine. If code is in staging, the engine switches over to the
re-provisioned, inactive partition. After activation, the staging
area is empty.
Note: This command is only available for network engines at
Release 10.1 or later.

Archive

None

Archives the object instances to the nonvolatile memory.

Cancel Staged
Files

None

Flushes all staged files in the engine. The command is offered
only when the selected engine has staged files. After you issue
this command to cancel the staged files, the Apply Staged
Files command is no longer available until after you issue
another staged download from SCT.
Note: This command is only available for network engines at
Release 10.1 or later.

Change Audit
Enabled Class
Level
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Value

Changes the Audit Enabled Class Level attribute. Integer
range is 1-4.
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Table 111: Engine Device Object Commands
Command Name

Parameters

Description

Rediscover Text
Strings

None

Requests the system to rediscover text strings for some binary
and multistate BACnet integrated objects. In some cases, the
Site Director can lose text strings when online configuration
changes are made. When this occurs, the words Text not
found appear in the Site Management Portal, Ready Access
Portal, and Advanced Reporting. The following configuration
changes (and other variations) can cause this:
•

If a child NxE contains user defined enumerations, and
then its site director is re-imaged or downloaded without
previously uploading.

•

If an NxE contains user defined enumerations, and then
its Local Site Director is changed to any device other than
itself.

To correct from these situations, issue the Rediscover Text
Strings command to the NxE containing the objects that are
displaying the errors.
Note: After you send this command to a site director, also send
it to all child devices with custom text strings that include a BACnet Integration.

Reset Device

None

Initiates an orderly reset that saves recent changes to the
engine archive database to Flash memory and restarts the
engine operating system. When the engine requires a reset,
the title bar of the object in the Display panel displays Reset
Needed.

Route Samples

None

Forwards all trend samples from the engine to the ADS
Repository, which is most often the Site Director. Issue this
command before you upgrade an engine to ensure that the
Site Director has all possible samples. Wait about 5 minutes
for all samples to be forwarded.

Update Flash
Usage

None

Commands the engine to recalculate the Flash Usage value
recorded under the Diagnostic tab of the network engine. This
value is an estimated percent of flash memory currently in
use.

Metasys Server
Menu Selection: Insert > Metasys Server
Inserts a Metasys server at any supported release into the archive database with SCT, including the
following servers: ADS/ADX, ADS-L-A, ADS-L-E, OAS, and ODS).
Note: Some products or models mentioned in this document are available only to specific
markets. Refer to the Application and Data Server (ADS) Lite for Europe (E) Product Bulletin
(LIT-12011690) and the Application and Data Server (ADS) Lite for Asia (A) System Product Bulletin
(LIT-12011694) for availability.
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Tip:
•

The first Metasys server you add to the site becomes the Site Director. The Site Director
coordinates all Web browser communication to the Metasys network. You can only
have one Site Director per site. Any subsequent Metasys servers are primarily used for
archiving historical data.

•

On the Configure screen, select each tab for further configuration options.

ADS Device Object
The ADS Device object defines the attributes that represent the externally visible characteristics of a
Metasys Server. One ADS Device object exists per Metasys Server. This object allows you to see data
about the Metasys Server, such as the name of the current POP server host name or information on
printer destinations.

ADS Concepts
ADS Attributes
This section describes the attributes that are under the Focus/Configuration and Diagnostics tabs
of the ADS device object. However, starting at Release 10.1, the Edit button for the other tabs that
appear (Email, SNMP, Syslog, and Printer) is disabled. The following text appears in the window
when you click any of these tabs:
This feature is now only available on the Metasys UI

For more information on Metasys UI, refer to Metasys UI Help (LIT-12011953).
The ADS object also contains attributes common to many Metasys system objects. These common
attributes are not described here but are covered in the Common Object Attributes section.
Note: In the Notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable.
Table 112: ADS Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Values/Options/
Range

Description

ADS Repositories

C,W

Lists the Metasys Server host names
or IP addresses to which incoming
trend and Alarm/Event data forwards.
A Metasys Server cannot have its own
host name or IP address in this field.
Refer to the ADS/ADX Commissioning
Guide (LIT-1201645) for details on
configuring repositories.

ADS Repositories Status

C,W

Offline, OK

Indicates the status of the devices
listed in the ADS Repositories
attribute.
Note: When forwarding data to a
secondary Metasys Server (that is,
data forwarded to a Metasys Server
is forwarded to another Metasys
Server), the status does not calculate.
This attribute shows only the status
for the initial forward.

Alarm Snooze Time
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C,W

0–75
Units = Minutes

Specifies the amount of time to delay
before re-announcing an alarm.
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Table 112: ADS Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Values/Options/
Range

Description

Enabled Audit Level

C,W

Specifies which level of audit entries
are added to the audit repository.
Only audit entries of type Level 1
through and including the specified
level are included. All other levels are
not stored in the audit trail. Level 1
and Level 2 audit entries are always
stored in the audit trail.

See the attribute
description for details
on the Enabled Audit
Level.
Range = 1–4 with 5
Audit Levels
Level 1 (N/A) User
Action
Level 2 (1) Critical
System Events
Level 3 (2) Application
Level 4 (3) Non-critical
System Events
Level 5 (4) Diagnostic

•

Level 1 and 2 (1): Stores all user
action and system error audit
messages.

•

Level 3 (2): Stores application
audit messages in addition to
Level 1 and 2 auditing.

•

Level 4 (3): Stores system audit
messages in addition to Level 3
auditing.

•

Level 5 (4): Stores diagnostic
audit messages in addition to
Level 4 auditing

FIPS Compliance Status

Specifies whether the Metasys
Server is FIPS compliant: Compliant
(Licensed), Compliant (Unlicensed),
or Non-Compliant (Unlicensed).
FIPS compliance involves three
steps: purchasing a Metasys FIPS
license, enabling FIPS in the server's
operating system, and installing the
Metasys FIPS feature. If you complete
the first two steps, but do not install
the FIPS feature, the value of this
attribute is Non-Compliant (Licensed).

Host Name

Indicates the host name of the NxE
whose value appears in the Transfer
Buffer Full Worst NxE attribute.
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Table 112: ADS Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Values/Options/
Range

Description

JCI IP Address

C,W

Represents the IP address of this
Metasys Server. The IP address
identifies the Metasys Server on the
network and assists in the routing
of messages. Each Metasys Server
must have a unique IP address for the
network to operate properly. A write
to this attribute is ignored because
configuration is completed through
the Windows network configuration.
A read of this attribute returns either
the user-specified value or the value
determined from DHCP.
Certain IP addresses are invalid and
cannot be written successfully. The
network address portion of the IP
address is computed by including
all bits in which the corresponding
bit from the IP mask is 1. The device
address portion of the IP address
is computed by including all bits in
which the corresponding bit from
the IP mask is 0. Neither the network
address nor device address can be all
zero bits or all one bits. For example,
if the IP mask is 255.255.0.0, the
following IP addresses are invalid:
0.0.100.100 and 100.100.0.0.
The JCI IP Address attribute can be set
explicitly, or it may be automatically
set using the DHCP server. Using the
DHCP server, you can change this
attribute even if you set it up explicitly.
See the DHCP Enabled attribute.
Note: This attribute only appears in
the ADS object in the SCT and is used
by the SCT during a download or
upload of the Metasys Server database.

Local Data

Displays the date on the Metasys
Server.

Local Time

Displays the time on the Metasys
Server.

Model Name

Contains the name of the device
model. In this case, it is ADS.
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Table 112: ADS Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Values/Options/
Range

Number of NxEs
Reporting

Description
Specifies the number of NxE devices
that registered this Metasys Server
as their trend repository. For an ODS
or OAS, this number is always one
count higher than the actual number
of NxEs reporting because the ODS
and OAS also have a trend repository
that is included in the count.

Sample Rate

Units = Per Hour
See attribute
description for
calculation details.

Specifies the number of trend samples
destined for the Metasys server in the
last hour (for diagnostic purposes).
The value of this attribute updates
every 5 minutes.

Service Time

Units = Seconds

Displays the amount of time in
seconds that it takes for the ADS/ADX
device to poll all NxEs on the site for
trend samples.

Transfer Buffer Full Worst
NxE

Units = %

Indicates the buffer fullness, in
percent, of the NxE with the fullest
trend buffer of the trend poll cycle.

Metasys Site Management Portal Help

251

Table 113: ADS Device Object Attributes - Diagnostic Tab
Attribute Name

Values/Options/
Range

Description

Average Intermittent
Failure Period

IP address and Value
Units = seconds

Specifies the average number of
seconds devices in the transport layer
are offline (for diagnostic purposes).
Only time periods less than 1 minute
are used in this average, to eliminate
device resets. Ideally, this number
should be zero, indicating there are
no failures.

Data Collection Rate

Units = Per Minute
Maximum value =
83333

Indicates the data value collection rate
of the Ready Time Series Data feature.
It represents the rate of data values
collected, not the rate of data values
delivered to the clients. The feature
buffers data values when the data
collection rate is within the maximum
expected rate (83,333 data values per
minute) and the client is unknown
or offline. In the event of a remote
connection failure, a minimum of 60
hours of data is buffered locally for
automatic delivery when the error
condition is resolved. This feature is
only used by a Site Director and is
updated every minute.

Data Usage

Units = %

Indicates the number of data values
currently locally stored by the
Ready Time Series Data feature as a
percentage of the maximum allowed.
Typically, data samples are routinely
delivered to an online client and the
data usage remains small. When the
client is unknown or offline, data
values continue to accumulate in local
storage until limits are reached. This
feature is used by a Site Director and
is updated every minute.
For the ADS, data values are
accumulated in memory and stored in
batches in a disk-based queue limited
to 10,000 entries. This attribute is
based on the worst case queue usage
of all clients of this feature.
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Table 113: ADS Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Values/Options/
Range

Description

Incoming Audit Rate

Units = Per Hour

Specifies the average rate of audits,
per hour, received from other devices
(NxEs or ADS/ADXs) during the
previous hour. The value of this
attribute updates every 5 minutes.
This rate only includes audits
generated by devices at Release 5.2 or
later.

Incoming Event Rate

Units = Per Hour

Specifies the average rate of events,
per hour, received from other devices
(NxEs or ADS/ADXs) during the
previous hour. The value of this
attribute updates every 5 minutes.
This rate only includes events
generated by devices at Release 5.2 or
later.

Maximum Intermittent
Failure Period

IP address and Value
Units = seconds

Specifies the maximum number
of seconds a device was offline at
the transport layer (for diagnostic
purposes). Only time period under
1 minute are recorded, to eliminate
device resets. The value of this
attribute does not match the offline
time period determined from
generated alarms. Ideally, this
number should be zero, indicating
there are no failures.

Outgoing Event Rate

Units = Per Hour

Specifies the average rate of events
per hour, sent to other repositories
(ADS/ADXs). This value of this
attribute updates every 5 minutes.
This rate only includes events
generated by devices at Release 5.2 or
later.
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Table 113: ADS Device Object Attributes - Diagnostic Tab
Attribute Name

Flags

Values/Options/
Range

Description

Registration Usage

Units = None

This attribute indicates the number
of registrations used by the Metasys
Ready Time Series Data feature. It
is the total usage of all clients of
this feature. Each registration is a
sign-up for an attribute of an object.
The feature supports up to 1,000
registrations per fully loaded field bus
per site device. This feature is only
used by a Site Director and is updated
every minute.

Transport Failure Rate

IP address and Value
Units = Failures Per
Day

Specifies the number of transport
failures per day (for diagnostic
purposes). This number represents
how often HTTP posts from this server
failed when they were sent to another
device that is considered online.
Failures include the inability to open
the connection, to send the message,
or to receive the reply. This value
represents failures over the last 24
hours and is updated hourly, but does
not correlate directly to the number
of offline alarms generated by your
system. Ideally, this number should be
zero, indicating there are no failures.

ADS Commands
The following table lists the commands supported by the ADS Device Object.
Table 114: ADS Device Object Commands
Command Name

Parameters

Description

Rediscover Text
Strings

None

Resets the States Text across the server by rediscovering text
strings from all mapped BACnet objects. When the Rediscover
Text Strings command is sent from the Site Director device
UI to another supervisory device and the UI is running on the
supervisory device, you must close and restart the UI on the
supervisory device in order for the text to appear correctly.

ADS Features
The ADS (including the ADX) is a Metasys Server that runs on a computer platform and is installed
within the Metasys network. With an ADS, you can provide a location to install the SCT and a
location to send trend logs (Trend Studies), event logs (Alarm and Event Management), and audit
trails (Audit Trail). The ADS can also be configured to take the role of the Site Director to coordinate
system access and present data to the user in a web browser running on the same computer or
connected over the LAN, WAN, Internet, or telephone line through a dial-up connection.
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Notes:
•

Online/offline modes as explained here do not apply to the ADS. However, the ADS can be
online and offline in the same sense as any other device on the network can be connected
or disconnected from the network.

•

You may need to change the Windows Defender tool settings on your operating system
(OS) when using an ADS. Windows Defender is a spyware identification and removal
application that is part of the OS. For Windows 10, Windows 8.1, and Windows 8, this
application is on by default. For Windows Server 2016, and Windows Server 2012 R2, and
Windows Server 2012, this application is off by default. Windows Defender scans the
OS for spyware every night at 2 A.M. If you expect heavy use of the ADS at this time (for
example, due to trend collection), reschedule the scan to a time when the ADS is not as
active.

•

You may need to change the Disk Defragmentation settings on your OS when using an
ADS. Disk Defragmentation is scheduled to run by default every Wednesday at 1 A.M.
If you expect heavy use of the ADS at this time (for example, due to trend collection),
reschedule the scan to a time when the ADS is not as active.

Trend Repository Database
The trend repository database resides within the server that stores the trend data. For more
information, click one of the following:
•

Trend Studies

•

Trend Extensions

Event Repository Database
The event repository database resides within the server that stores the event data. For more
information, see the Alarm and Event Management section.
Audit Repository Database
The audit repository database resides within the server that stores the audit data. For more
information, see the Audit Trail section.
ADS Computer Name
For information on ADS computer name guidelines and changing the computer name, refer to
the Appendix: Changing the ADS or ADX Name and the Computer Name in the ADS/ADX Commissioning
Guide (LIT-1201645).

Integration
Menu Selection: Insert > Integration
Integrates the following types of buses or networks into the network engine:
•

BACnet IP - Inserts a BACnet IP integration into the network engine.

•

Field Bus MSTP - Inserts an MS/TP network integration for the network engine.

•

SA Bus - Specifies the SA Bus under the Local Hardware IO folder of an SNC. The SA Bus is
prebuilt for the SNC; it is not manually defined.

•

LON Trunk - Inserts a LonWorks network into the network engine. The LON trunk integration
is not available for network engines updated to Release 9.0.7, but is available on many
network engines at Release 10.0 or later.

•

N1 Migration - Inserts an N1 Migration trunk into the NIE55.
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Note: Be sure to configure the Network Name attribute of the N1 Migration. Once you
insert the N1 Migration, you cannot edit the Network Name attribute. The workaround is
to delete the existing N1 Migration and insert a new N1 Migration ensuring you enter the
desired Network Name before completing the Insert Integration wizard.
•

N2 Trunk - Inserts an N2 trunk into the network engine.

•

VND Integration - Inserts a vendor integration into the network engine.

•

Wireless Supervisor - Inserts a Wireless Sensor System integration into the system. (You can
have only one Wireless Integration per network engine.) The Wireless Supervisor integration is
not available for network engines updated to Release 9.0.7 or later.

•

XL5K Integration - Inserts a Honeywell® Excel 5000 (XL-5000) network integration for the
NIEx5. (You can have only one XL5K Integration object per NIEx5.) - Inserts a Honeywell Excel
5000 (XL-5000) network integration for the NIEx5. (You can have only one XL5K Integration
object per NIEx5.) The XL5K integration is not available for network engines updated to
Release 9.0.7 or later.
Tip: Select the Hardware tab (if it appears) on the Configure screen for further configuration.

After adding an integration, you can select the integration in the navigation tree and click
Action > Import Integration to add existing devices and points under the integration.
See one of the following sections for more information:
•

BACnet IP Integration Object

•

MS/TP Field Bus Integration Object

•

SA Bus Integration Object

•

LON Integration Object

•

N1 Migration Object

•

N2 Master Datalink Object (N2 Trunk)

•

Generic Integration Object

•

VND Integration Object

•

Wireless Receiver Supervisor Object

•

XL5K Integration Object

BACnet IP Integration Object
The BACnet IP Integration object manages the communication with a BACnet/IP network. All
integrated BACnet devices and objects appear under the BACnet IP Integration object in the
Navigation Tree.
The BACnet IP Integration object serves as the root for all integrated BACnet/IP Field Controller
objects on an Ethernet trunk. The BACnet IP Integration object is a direct child of a supervisory
controller and integrates BACnet/IP devices using the Ethernet trunk.
For general information on Metasys system objects, see the Object Help section.
For detailed information on the BACnet IP Integration object, see BACnet IP Integration Attributes.

BACnet IP Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
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information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes marked with the letter C are configurable, attributes
marked with an N are not required, and attributes marked with the letter W are writable.
Table 115: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Alarm State
APDU Retries

Description
Indicates the current status of the object. The
expected state is Normal.

C,W

Indicates the maximum number of times the
device can retransmit a data frame. If the device
does not perform retries, it has a value of 0. If
this value is greater than 0, a non-zero value
appears in the APDU Segment Timeout attribute.
Recommended settings: high sensitivity: 3
(default); medium sensitivity: 4; low sensitivity: 5.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

APDU Timeout C,W

Indicates the amount of time in milliseconds
between retransmissions of a complete data
frame requiring acknowledgment for which no
acknowledgment has been received. This attribute
applies to smaller data messages where the
entire message fits within a single frame on the IP
network. Recommended settings: high sensitivity:
6000 ms; medium sensitivity: 12000 ms (default);
low sensitivity: 20000 ms.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

APDU
Segment
Timeout

C,W

Indicates the amount of time in milliseconds
between retransmissions of a data frame
segment requiring acknowledgment for which no
acknowledgment has been received. This value
is not 0 if the device supports segmentation of
transmitted data frames. Recommended settings:
high sensitivity: 8000 ms; medium sensitivity:
11000 ms (default); low sensitivity: 20000 ms.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

Count
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Indicates the number of BACnet objects defined
for this integration.

257

Table 115: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

Device
Discovery
Range

C,W

Contains the destinations for the Who-Is message
sent during the device autodiscovery process.
When the list is empty, the object sends a global
broadcast in the form of the Who-Is. Adding
entries to the list limits the scope of the WhoIs broadcast to only the networks and device
instance ranges specified. Multiple entries to
this list cause the object to send multiple Who-Is
messages sequentially.
The following are device discovery range network
numbers to use (broadcast type:network
numbers):
Local: 0 (locked for editing)
Global: 65,535 (locked for editing)
Remote: 1 to 65,345 (editable)

Discover All
C,W
as General
BACnet Device

Structure elements:
•

network number
(see attribute
description)

•

high limit device
instance (Range:
1–4,194,302)

•

low limit device
instance (Range:
1–4,194,302)

Default is False for all
engines and OAS
Default is True for
ODS

Toggles the integration between pure BACnet
mode and BACnet with proprietary messaging.
When set to True, proprietary messaging is
disabled. This may be useful for special cases
where customers do not want Private Transfer
messages on the BACnet/IP trunk. This attribute
must be set before devices are added to the
Integration.
Also, if you used device discovery prior to the
change, restart the supervisory device to complete
the change in the attribute value. You can do this
after the change or after you have added devices
to the integration. The default value is False.
Note: When this attribute is True, proprietary
Objects, Attributes, and Services on Johnson Controls devices (such as FECs, FACs, and VMAs) are
not available.

Internode
Comm Timer

C,W

Controls the frequency of communication with
MS/TP devices. Among other communications,
this attribute defines the frequency of the
heartbeat to monitored devices (monitored
at a rate of two times the Internode Comm
Timer). Recommended settings: high sensitivity:
30 seconds medium sensitivity: 120 seconds
(default); low sensitivity: 240 seconds.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.
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Table 115: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

JCI Network
Port APDU
Retries

C,W

Indicates the maximum number of times the
device can retransmit a data frame. If the device
does not perform retries, it has a value of 0. If this
value is greater than 0, a non-zero value appears
in the JCI Network Port APDU Segment Timeout
attribute. Recommended settings: high sensitivity:
3 (default); medium sensitivity: 4; low sensitivity:
5.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

JCI Network
Port APDU
Timeout

C,W

Indicates the amount of time in milliseconds
between retransmissions of a complete data
frame requiring acknowledgment for which no
acknowledgment has been received. This attribute
applies to smaller data messages where the
entire message fits within a single frame on the IP
network. Recommended settings: high sensitivity:
6000 ms; medium sensitivity: 12000 ms (default);
low sensitivity: 20000 ms.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

JCI Network
Port APDU
Segment
Timeout

C,W

Indicates the amount of time in milliseconds
between retransmissions of a data frame
segment requiring acknowledgment for which no
acknowledgment has been received. This value
is not 0 if the device supports segmentation of
transmitted data frames. Recommended settings:
high sensitivity: 8000 ms; medium sensitivity:
11000 ms (default); low sensitivity: 20000 ms.
Note: If you change the value of this attribute, you
must reset the network engine for the new settings to take effect. Also, this attribute is only visible in Snapshot Focus view.

JCI Network
Port Type
Page Size
Pending
Network
Number

Specifies the Network Port type: BACnet IP
Integration Port.
C,W

10–65,535
Default=1,000

Determines how many points are discovered per
page.

1001

Specifies the network number that is assigned to
the integration when the user sends the Activate
Changes command to the engine. This command
has two options; select the Update All Changes
Pending Attributes and Restart Device option.
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Table 115: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

Periodic
Update

C,W

0–65,535
Units = seconds
Default = 60

Specifies how frequently integrated BACnet
objects update their attribute values. Every period,
the BACnet IP Integration object prompts each
integrated BACnet object that needs to update
its attribute values. Also see the Execution Time
attribute. Default=60.

Poll Delay

C,W

Milliseconds
10–50

Specifies the time in milliseconds between BACnet
object polls for attribute values. The polls start at
the time specified in the Periodic Update attribute.
As the Poll Delay increases, the overall time in the
Execution Time attribute increases. It is useful
to specify a Poll Delay on sites where the rate of
reading the remote objects causes too high a
burden on the Metasys network or third-party
device. The initial value of the Poll Delay attribute
is blank (zero).
Recommended setting: high sensitivity: 20
seconds; medium sensitivity: 60 seconds; low
sensitivity: 120 seconds.

Preserve
Discovered
Devices

C,W

Default = True

Controls the behavior when field device discovery
is started. When this value is True (default), any
devices which were previously discovered or
already mapped remain in the list of discovered
devices, without any attempt to reestablish
communication with them. If this value is False,
an attempt is made to reestablish communication
with all devices, and devices which do not respond
are not shown in the list of discovered devices.
Set this value to False to rediscover devices which
have been re-addressed on the network.

Requested
Vendor ID

C,N,W 0–65,535

Specifies a Vendor ID when discovering new
devices to limit the device list displayed to that
specified Vendor ID. The default value of this
attribute is Null (stored as zero) which allows all
vendors to be discovered and displayed.
The current list of Vendor IDs can be viewed
at http://www.bacnet.org/VendorID/BACnet
%20Vendor%20IDs.htm.
Note: If you do not want to display devices
already discovered or mapped, then set Preserve
Discovered Devices to False.
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Table 116: BACnet IP Integration Attributes - Diagnostic Tab
Attribute Name

Notes

Description

Duplicate Device
Identifier

Lists any duplicate BACnet Device Object Identifiers found
after you perform an auto-discovery of BACnet/IP devices.
The list contains the instance number of the BACnet Device
Object Identifier and the network address (represented in
hex notation) of each device with the same identifier instance
number as another device on the network. The devices in this
list are not included in the list of auto-discovered devices in
the integration tree under the Engineering tab of the BACnet
IP Integration object. The physical locations of BACnet/IP
devices with duplicate device identifiers must be determined,
and their object identifiers changed to make them unique
network-wide.

Execution Timer

Records the amount of time taken for the last periodic
update of all integrated BACnet objects. You can use the
value for this attribute to tune the Periodic Update attribute.
If the Execution Time is greater than the Periodic Update,
this indicates that the attribute values of integrated BACnet
objects are constantly being updated over the network.
Range: 0 to 4,294,967,295
Units = seconds

Polled Object Count

Indicates the number of mapped BACnet objects currently
being polled on a periodic basis. The polling is limited to
those mapped BACnet objects currently being accessed
either by a feature or by the UI. The Instance Number is
typically smaller than the total Count.

BACnet IP Integration Object Commands
The following table lists the commands supported by the BACnet IP Integration Object.
Table 117: BACnet IP Integration Object Commands
Command Name

Parameters

Description

Sync Field Device
Times

None

Sends a high-priority time synchronization command to all
child BACnet IP Integration devices, based on each device
mapper object's Manual Time Sync Type attribute.
If the Manual Time Sync Type is set to:
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•

UTC: UTC time synchronization message is sent.

•

Local: a local time synchronization message is sent.

•

None: no message is sent.

•

Auto: the mapper object's Protocol Services Supported
attribute is used to determine which type of time
sync is supported, and if: utcTimeSynchronization
is set, the code functions as if Time Sync Type is
set to UTC. utcTimeSynchronization is not set and
timeSynchronization is set, local time is sent. neither
utcTimeSynchronization nor timeSynchronization is set,
no time is sent.
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MS/TP Field Bus Integration Object
The MS/TP Field Bus Integration is the root for all Field Devices and BACnet objects on the MS/TP
Field Bus in the Metasys system. When you add a Field Bus integration to an NAE or NIEx9, you
create an MS/TP communication link on a specified hardware port. The MS/TP Field Bus Integration
object offers diagnostic data related to the MS/TP network. After you create a Field Bus integration,
you can use the Insert Field Device and Insert Field Point wizards within SMP to add BACnet devices
and associated BACnet objects to the trunk. The integration wizards support both manual object
creation and automatic Device and Point discovery. The Field Bus integration supports third-party
BACnet MS/TP devices and all FEC family BACnet MS/TP devices.
Important: When you add an MS/TP Field Bus Integration on an OAS for Remote Field Bus, do
not select a Trunk Number value of 1 or 2. The OAS reserves these trunks for the USB ports.

MS/TP Field Bus Integration Attributes
The MS/TP Field Bus Integration object contains attributes common to many Metasys system
objects. You can find a description of these common attributes in the Common Object Attributes
section. This section includes attributes of the Focus/Configuration and Diagnostics tabs.
Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter N
indicate values not required.
Table 118: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Alarm State

Description
Indicates the current status of the object. The expected state is
Normal.

APDU
Length

W

Indicates the maximum number of octets that may be contained in
a single indivisible application on this port. Supports up to 65535.
This value must be greater than 50. This attribute appears only in the
Snapshot Focus view of the object.

APDU
Retries

C,W

Indicates the maximum number of times the device can retransmit a
data frame. If the device does not perform retries, it has a value of 0.
If this value is greater than 0, a non-zero value appears in the APDU
Segment Timeout attribute. Recommended settings: high or medium
sensitivity: 3 (default); low sensitivity: 5.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

APDU
Timeout

C,W

Indicates the amount of time in milliseconds between retransmissions
of a complete data frame requiring acknowledgment for which no
acknowledgment has been received. This attribute applies to smaller
data messages where the entire message fits within a single frame
on the MS/TP bus. Recommended settings: high sensitivity: 6000 ms;
medium sensitivity: 12000 ms (default); low sensitivity: 30000 ms. The
default number is 12000ms.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.
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Table 118: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Description

APDU
Segment
Timeout

C,W

Indicates the amount of time in milliseconds between retransmissions
of a data frame segment requiring acknowledgment for which no
acknowledgment has been received. This value is not 0 if the device
supports segmentation of transmitted data frames. Recommended
settings: high sensitivity: 8000 ms; medium sensitivity: 11000 ms
(default); low sensitivity: 29000 ms. The default number is 11000ms.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

Changes
Pending
Command

Indicates whether an object configuration change has not yet been
activated. If this attribute is True, reset the engine or issue an Activate
Changes command to the network engine.
W

Count

Describes an attribute that initiates specific functionality dependent
upon the enumerated value written to it. In addition to basic defined
commands described by BACnet PR18, there may also be vendor
specific commands. Currently, only discarding of pending changes is
supported. The default value for this attribute is Idle.
Contains the number of FEC series and non-FEC series BACnet objects
mapped on the field bus.

Device
Discovery
Range

C,W

Specifies the destinations for the messages sent during the device
auto discovery process. This list is empty by default. When the list
is empty, a global broadcast message is sent. Adding entries to the
list limits the scope of the broadcast message to only the specified
networks and device instance ranges. If multiple entries appear in the
list, the messages are sent sequentially. This attribute appears only in
the Snapshot Focus tab.

Discover All
As General
BACnet
Device

C,W

Toggles the integration between pure BACnet mode and BACnet with
proprietary messaging. When set to True, proprietary messaging is
disabled. This may be useful for special cases where customers do not
want Private Transfer messages on the BACnet trunk. Note that when
this attribute is True, proprietary Objects, Attributes, and Services on
Johnson Controls devices (such as Field Equipment Controllers (FECs),
Advanced Application Field Equipment Controllers (FACs), and VAV
Modular Assemblies (VMAs)) are not available. This attribute must
be set before devices are added to the Integration. If you change the
value, restart the supervisory device to make the change effective.
You can restart immediately or after you have completed the mapping
process. The default value is False.

Execution
Priority

C,W

Indicates the order in which any given object within a group of objects
is allowed to run or change data within a system. This attribute should
not be changed for this object. This attribute appears only in the
Snapshot Focus tab.
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Table 118: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Description

Internode
Comm
Timer

C,W

Controls the frequency of communication with MS/TP devices. Among
other communications, this attribute defines the frequency of the
heartbeat to monitored devices (monitored at a rate of two times the
Internode Comm Timer). Recommended settings: high sensitivity: 30
seconds; medium sensitivity: 120 seconds (default); low sensitivity:
240 seconds.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

JCI Network
Port APDU
Retries

C,W

Indicates the maximum number of times the device can retransmit
a data frame. If the device does not perform retries, it has a value
of 0. If this value is greater than 0, a non-zero value appears in the
JCI Network Port APDU Segment Timeout attribute. Recommended
settings: high or medium sensitivity: 3 (default); low sensitivity: 5.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

JCI Network
Port APDU
Timeout

C,W

Indicates the amount of time in milliseconds between retransmissions
of a complete data frame requiring acknowledgment for which no
acknowledgment has been received. This attribute applies to smaller
data messages where the entire message fits within a single frame
on the MS/TP bus. Recommended settings: high sensitivity: 6000 ms;
medium sensitivity: 12000 ms (default); low sensitivity: 30000 ms. The
default number is 12000ms.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

JCI Network
Port APDU
Segment
Timeout

C,W

Indicates the amount of time in milliseconds between retransmissions
of a data frame segment requiring acknowledgment for which no
acknowledgment has been received. This value is not 0 if the device
supports segmentation of transmitted data frames. Recommended
settings: high sensitivity: 8000 ms; medium sensitivity: 11000 ms
(default); low sensitivity: 29000 ms. The default number is 11000ms.
Note: If you change the value of this attribute, you must reset the network engine for the new settings to take effect.

Max APDU
Length

264

C,W

Indicates the maximum number of bytes that may be contained in
a single, indivisible application layer protocol data unit. This value
should not be changed during normal installation or operation. The
default value is 1476 bytes.
If you write the value of this attribute, you must issue a Reset Device
command to the network engine for the new settings to take effect.
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Table 118: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Description

Max Info
Frames

C,W

Specifies the maximum number of information frames the node may
send before it passes the token. This attribute is present if the device
is a node on an MS/TP network. If Max Info Frames is not writable or
otherwise user configurable, its value is one. If you change this value,
you must activate it with the Activate Changes > Update Changes
Pending Attributes Except Network Number command to the
Engine. The pending value is updated immediately but it is not applied
until you activate the change.
Note: If the device is an MS/TP master node, both the Max Info Frames
and Max Master attributes are required.

Max Master

C,W

Out of
Service

Specifies the highest possible address for devices on this network and
is less than or equal to 127 (default). This attribute is present if the
device is a bus supervisor device on an MS/TP network. Typically this
address is kept at 127 to allow other devices on the bus to use any of
the lower valid addresses.
Indicates whether the field bus is out of service. This value is always
false.

Page Size

C,W

Determines how many points are discovered per page. The default
value is 1,000.

Periodic
Update

C,W

Specifies how frequently integrated BACnet objects that do not
support COV subscription update their attribute values. Every period,
the MS/TP Field Bus Integration object prompts each integrated
BACnet object that needs to update its attribute values. This attribute
applies only to non-FEC series devices. See the Poll Delay attribute
description for information on how these attributes interact. The
default value is 20 seconds.

Poll Delay

C,W

Specifies the time in milliseconds between BACnet object polls for
attribute values. The polls start at the time specified in the Periodic
Update attribute. As the poll delay increases, the overall time in the
Execution Time attribute increases.
It is useful to specify a Poll Delay on sites where the rate of reading
the remote objects causes too high of a burden on the Metasys
network or third-party device. The initial value of the Poll Delay
attribute is blank (zero).

Preserve
Discovered
Devices

C,W

Controls the behavior when field device discovery is started. This
attribute exists for historical reasons and is ignored by the MS/TP
Field Bus Integration object for FEC series or non-FEC series devices.
The value of the attribute is shown in the snapshot view. If an auto
discovery has been completed since the last device restart, a complete
new auto discovery is performed for all FEC Series or non-FEC Series
devices for each subsequent auto discovery in which Restart is
selected. The default is True.

Reliability

Indicates the current reliability of the integration. The normal state is
Reliable.
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Table 118: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Description

Requested
Vendor ID

C,N

Used as a filter when discovering new devices to limit the device list
to whatever is specified as the Vendor ID value. The default value
of this attribute is Null (stored as zero), which allows all vendors
to be discovered and displayed. Note that this filter applies only to
non-Johnson Controls devices. Johnson Controls devices are always
included in the discovered device list.
The current list of Vendor IDs can be viewed at http://
www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm.
Note: If you do not want to display devices already discovered or
mapped, then set Preserve Discovered Devices to False.

Status Flags

Indicates the general status of the object in BACnet terms and
contains four independent states.
The four selections are:
In Alarm—False if the Event State attribute value is Normal;
otherwise, the In Alarm flag is True. (Set only by BACnet Intrinsic
Alarming.)
Fault—True (1) if the Reliability attribute is not reliable; otherwise, the
Fault flag is False.
Overridden—Overridden flag is True if the Present Value is
overridden from the hardware source level.
Out of Service—Out of Service flag is True if the Out of Service
attribute value is True; otherwise, the Out of Service flag is False.

Synchronize C,W
Time

Broadcasts time synchronization to all devices on the field bus
when the field device comes online or when the time changes by
a significant amount. When changed from false to true, a time
synchronization is sent immediately to all devices on the field bus. The
default is True.

Synchronize C,W
Time Zone

Enables and disables time zone synchronization messages to devices
(such as FACs) on a trunk that support real-time clock capabilities.
When this attribute is set to True (default), time zone synchronization
messages are broadcast to devices on the field bus. The broadcast
occurs either when individual devices come online or to all devices
when any of the time zone related attributes change (Default Time
Zone, UTC Offset, Standard Time Offset, Daylight Savings Time Offset,
Standard Time Start, and Daylight Savings Time Start). When changed
from false to true, time zone synchronization is automatically sent to
all devices on the field bus.
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Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Active Baud Rate

Displays the actual data rate on the wire for transmitting and
receiving. When set to Auto, the port is waiting to synchronize with
the network.

Broadcast Receive Rate

Indicates the number of BACnet broadcast messages received on
the MS/TP field bus network of the device in the last minute. If this
number is high, it indicates that the performance of the specific MS/
TP field bus network is affected by broadcast receive traffic.

Broadcast Receives

Indicates the number of broadcast messages received.

Broadcast Transmit Rate

Indicates the number of BACnet broadcast messages transmitted on
the MS/TP field bus network for the device in the last minute. If this
number is high, it indicates that the performance for the specific MS/
TP field bus network is affected by broadcast transmit traffic.

Broadcast Transmits

Indicates the number of broadcast message transmissions.

Buffer Overflows

Indicates the number of data frames lost at this MS/TP device
because there was no buffer available to which to save it. This
number includes outgoing and incoming messages.

Bus Analysis Date

Displays the date when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Time

Displays the time when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Progress

Indicates the progress of the full MS/TP field bus scan initiated by the
Analyze Field Bus command.

Bus Device Configuration
List

Lists MS/TP devices that either have been detected on the FC bus or
have been configured on field devices existing under the MS/TP Field
Bus Integration Object.
The Bus Device Configuration List provides configuration information
for each device, including which devices are responding, which
devices may have been configured incorrectly, and the addresses of
all devices. Only bus supervisor devices provide all this information.
This object creates the list when you issue an Analyze Field Bus
command.

Bus Health Index

Indicates the overall health of the MS/TP field bus based on the
number of errors occurring at the network engine. The most
desirable value is 0. The higher the number, the worse the bus
health/higher the number of errors. The Bus Health Index is reevaluated every 30 seconds and gradually returns to zero if no new
errors occur.
This object derives the value for the Bus Health Index from
periodically reading the Header CRC Errors, Data CRC Errors, Framing
Errors, and Lost Token attribute values to create a moving average of
total errors. The Weighted Bus Health Constant attribute determines
the responsiveness of the Bus Health Index.
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Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Bus Performance Index

Indicates the responsiveness of the bus supervisor device on the MS/
TP field bus. The most desirable value is 1. Values from 2.5 to 6 are
marginal and updates to devices on the bus may be slow. If the value
is greater than 6, the performance is poor and may indicate offline
conditions.
The device derives the value for the Bus Performance Index by
comparing the measured token loop time at the network engine
and the predicted token loop time calculated when the MS/TP Field
Bus Integration object is first created or when the network engine
device count changes. This object uses the difference as input for
determining the weighted moving average of the token loop time.
The Weighted Bus Performance Constant attribute determines the
responsiveness of the Bus Performance Index.

Bytes In

Indicates the number of data bytes received by this device. This
number includes all messages from all devices.

Bytes Out

Indicates the number of data bytes sent by this device. This number
includes all messages to all devices.

Data CRC Errors

Counts errors detected in the data portion of data frames sent to the
device. Many data frames are used only for protocol control and do
not contain a data portion, and thus cannot have Data CRC Errors.
The Header CRC Errors check must be successful before the device
attempts a Data CRC check. This attribute supplies an error count for
the Bus Health Index attribute.

Data Expecting Reply
Frames Rxed

Displays the number of data frames received by the device that
require an immediate reply. This value includes proprietary frames
that have been received and are expecting a reply.

Data Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that requires
an immediate reply from the destination device.
This value includes proprietary frames that have been sent and are
expecting a reply.

Data Not Expecting Reply
Frames Rxed

Displays the number of data frames received by this item that do not
require an immediate reply. This value includes proprietary frames
that have been received and are not expecting a reply.

Data Not Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that do not
require an immediate reply. This value includes proprietary frames
that have been sent and received a reply.

Duplicate Device Identifiers Lists any duplicate object identifiers found after an auto-discovery
of MS/TP BACnet devices finishes. If any devices are listed, then
the list of automatically discovered devices may be incomplete.
The list contains the instance number of the Object Identifier and
the network address (represented in hex notation) of each device
with the same identifier instance number as another device on the
same bus. MS/TP devices with duplicate device identifiers may be
integrated without problem, but should be physically located and
their object identifiers changed to make them unique network-wide.

268

Metasys Site Management Portal Help

Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Execution Time

Records the amount of time taken for the last periodic update of all
referenced mapped BACnet objects. The value for this attribute can
be used to tune the Periodic Update attribute. If the Execution Time
is greater than the Periodic Update, attribute values of referenced
BACnet objects are constantly being updated over the network.
This attribute applies only to non-FEC series devices. See the Poll
Delay attribute description for information on how these attributes
interact.

Framing Errors

Counts the number of errors detected in the individual data bytes
received by the device. A framing error occurs when the device
receives a stop bit in the wrong state. This attribute supplies an error
count for the Bus Health Index attribute. Framing errors are usually
caused by electrical noise on the bus, message collisions, incorrect
baud rate settings, bus wiring or termination errors, or devices that
are not operating within the BACnet specified timing. Framing errors
generally cause CRC errors since the frame has been corrupted.

Header CRC Errors

Counts the number of errors detected in the header portion of
frames received by the device. Many frames are only used for
protocol control and only contain a header portion. This attribute
supplies an error count for the Bus Health Index attribute.

Internal Errors

Indicates the number of internal MS/TP driver operation errors
resulting from an incorrect state, insufficient memory, errors from
the serial port driver, incorrect internal state transitions, and other
error states.

Logging Object Reference

Indicates the object (by way of the BACnet Object Identifier) that
acquires, presents, and stores the Logging Record data (that is,
snapshot) from the underlying system. When the object specified
in the Logging Object Reference field issues the Get Monitor Data
command, the Logging Record is acquired and updated.

Lost Token

Indicates the number of times the device detects a lost token. A
lost token indicates that the bus encountered a serious network
disruption. Serious disruption may occur when the bus first starts up
or when wiring changes are made. This attribute supplies an error
count for the Bus Health Index attribute.

Max Output Queue Used

Displays the largest number of outgoing frames the device has
held in a queue for transmission. The largest possible value for this
attribute depends on the capabilities of the engine. Generally, the
maximum value is reached during device startup, but is not reached
during normal operation.

Maximum Token Loop Time Indicates the maximum time in milliseconds last seen at the device
for the token to complete one circuit of the MS/TP field bus (go
from the originating bus supervisor device through several other
devices and return to the original bus supervisor device). The value
is reset when the statistics are cleared. Maximum loop time is closely
associated with the worst-case performance encountered since the
last time the value was reset.
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Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Overrun Errors

Displays the number of times the MS/TP port hardware loses
received data because the device is too slow in reading the data. An
overrun error occurs when the hardware receives a byte before it
moves the prior byte to a buffer.

PFM Frames Rxed

Displays the number of Poll For Master (PFM) frames received by
the device. On a clean network, this should only count the first PFM
frame received when the device (or another with a MAC address
below that of the device) comes online. These frames are used
to discover other devices on the network and should be seldom
received.

PFM Frames Txed

Displays the number of PFM frames sent by the device. In normal
operation on a clean network, only the bus supervisor (MAC address
0) and the highest numbered master device on the network should
be sending PFM frames. These frames are used to discover other
devices on the network.

Packets Timed Out

Counts the number of data frames expected by the device that did
not arrive within the time allowed.

Packets Too Long

Counts any attempts to transmit or receive a data frame that is
longer than allowed by the device or by MS/TP.

Polled Object Count

Indicates the number of mapped BACnet objects that are currently
polled on a periodic basis. This attribute applies only to non-FEC
series devices.

Port Status

Indicates the state of the port.

Predicted Token Loop

Indicates the theoretical time in milliseconds needed for the token to
complete one circuit of the MS/TP field bus.
The object derives this value from the defined bus baud rate, number
of devices on the bus, and an estimate of the type and amount
of messages transmitted on the bus during this time. This object
compares the value of this attribute with that of the Token Loop Time
attribute to help calculate the value of the Bus Performance Index
attribute.

Reply Postponed Frames
Rxed

Counts the number of data frames sent at the device that requires
an immediate reply where the destination device requests additional
time to prepare the reply. This may happen normally if the reply
involves a large amount of data. It may also indicate that a device on
the network is overloaded.

Reply Postponed Frames
Txed

Counts the number of data frames received at the device that
requires an immediate reply where this device requests additional
time to prepare the reply. This may happen normally if the reply
involves a large amount of data. It may also indicate that this device
is overloaded.

Reply to PFM Frames Rxed

Counts the number of Reply to PFM frames the device receives. On
a clean network in normal operation, the device receives only one
Reply to PFM frame when either the device comes online or the next
higher numbered device comes online during normal operation.
These frames announce the presence of this device on the network.
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Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Reply to PFM Frames Txed

Counts the number of Reply to PFM frames the device transmits.
On a clean network during normal operation, only one Reply to PFM
frame needs to be sent when the device first comes online. These
frames are used to announce the presence of other devices on the
network.

Reply Too Slow Application
Errors

Counts the number of data frames received at this device that
requires an immediate reply where the device cannot assemble reply
data within the time allowed and cannot internally detect the need
for additional time. These errors generally indicate an overloaded
device if they occur frequently.

Reply Too Slow Datalink
Errors

Counts the number of data packets sent by the device that requires
an immediate reply from the destination device, but do not receive
any reply within the time allowed. This number does not include
Reply Postponed responses. The affected frames likely require a retry
and bus performance is reduced when this happens.

Reset Date

Contains the date of the last Clear Statistics command (when the
statistics for the device were last reset).

Reset Time

Contains the time of the last Clear Statistics command (when the
statistics for the device were last reset).

Retries

Displays the number of times the device tried to pass a token as the
next node did not start using it within the time allowed by BACnet
protocol.

Test Request Frames Rxed

Displays the number of Test Request Frames the device receives. Test
Request Frames are a normal part of bus analysis, but should not be
received during normal operation. A Test Response Frame should be
sent in reply to each Test Request Frame received.

Test Request Frames Txed

Displays the number of Test Request Frames the device transmits.
Test Request Frames are a normal part of bus analysis, but should
not be sent during normal operation. A Test Response Frame should
be received in response to each test Request Frame sent to an online
device. Test Request Frames may also be sent to offline devices
where no response is received.

Test Response Frames Rxed Displays the number of Test Response Frames the device receives.
Test Response Frames are a normal part of bus analysis, but should
not be received during normal operation. A Test Response Frame
should be received in response to each test Request Frame sent to
an online device.
Test Response Frames Txed Displays the number of Test Response Frames transmitted by this
MS/TP port. Test Response Frames are a normal part of bus analysis,
but should not be sent during normal operation. A Test Response
Frame should be sent in response to each test Request Frame
received.
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Table 119: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Token Frames Rxed

Displays the number of Token Frames the device receives. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message; thus, the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.

Token Frames Txed

Displays the number of Token Frames the device transmits. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message, thus the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.

Token Loop Time

Indicates how much time passes between the periods when the
device allows initiation of messages on the network. This time is a
strong indicator of network performance and is associated strongly
with the amount of traffic or errors on the network. Shorter time
period indicate a more responsive network. Longer time period
indicate an increasingly busy and slow network.
The object compares the value of this attribute with that of the
Predicted Token Loop Time attribute to help calculate the value of
the Bus Performance Index attribute.

Unexpect Frames Rxed

Displays the number of data frames of an illegal type that the device
receives. During normal operation, only certain kinds of MS/TP data
frames are allowed to be sent during each phase of operation. If
the device receives some other kind of data frame (other than the
allowed types for the current phase of operation), the device counts
the data frame as an Unexpected Frame. The device may often
detect Unexpected Frames when connecting running devices to a live
MS/TP bus.

Weighted Bus Health
Constant

Determines the responsiveness of the Bus Health Index. The default
value is 0.50.

Weighted Bus Performance Determines the responsiveness of the Bus Performance Index. The
Constant
default value is 0.50.
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Table 120: MS/TP Field Bus Integration Attributes - Hardware Tab
Attribute Name

Flags

Initial
Value

Values/Options/Range

Baud Rate Selection

C,W

38400

Indicates the baud rate of the network engine FC bus.
Baud
Rate

Description

Auto

Use baud rate of running network. This value
is the recommended setting for everything
on the FC bus except the bus supervisor port.
See Active Baud Rate.

1200

Use 1200 baud only. This value is not
recommended and may not be allowed on
some devices.

9600

Use 9600 baud only. This value is the lowest
standard MS/TP baud rate.

19200 Use 19200 baud only. This value is not
recommended.
38400 Use 38400 baud only. This value is the
recommended baud rate for bus supervisor
ports.
76800 Use 76800 baud only.
Configured Network
Number

C,W

Trunk Number

2000

Contains the network number of the MS/TP bus
used for BACnet message addressing. A value of 0
indicates a local network (the device is not intended as
a router). Do not change this number after you start
device mapping or discovery because it may invalidate
the devices that have been found.

1

Displays the trunk number where the field bus is
located.

MS/TP Field Bus Integration Commands
The following table lists the commands supported by the MS/TP Field Bus Integration Object.
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Table 121: MS/TP Field Bus Integration Commands
Command Name

Parameters

Description

Analyze Field Bus

None

Scans the entire MS/TP field bus (addresses 0–
254) and compiles a list of all devices on the bus.
The Analyze Field Bus command also provides
configuration information for each device that
responds. The data collected helps to determine
devices that may be configured incorrectly and thus
affect the bus performance. Because of the high bus
traffic load created by the scan, this command should
not be used on a regular basis. This command is
primarily intended for use during commissioning.
Track the progress of this analysis in the Bus Analysis
Progress attribute. The results of this command
appear in the Bus Device Configuration List attribute.
The date and time of the last completed scan appear
in the Bus Analysis Date attribute and Bus Analysis
Time attribute, respectively. See MS/TP Field Bus
Integration Attributes for more information about
these attributes.

Clear Statistics

None

Clears the statistics for the integrated MS/TP network.

Latch Statistics

None

Updates the displayed statistics with the current
values.

Sync Field Device
Time(s)

None

Sends a high-priority time synchronization command
to all child BACnet Integration devices, based on
each device mapper object's Manual Time Sync Type
attribute.
If the Manual Time Sync Type is set to:
•

UTC: UTC time synchronization message is sent.

•

Local: a local time synchronization message is
sent.

•

None: no message is sent.

•

Auto: the mapper object's Protocol Services
Supported attribute is used to determine which
type of time sync is supported, and if:
- utcTimeSynchronization is set, the code
functions as if Time Sync Type is set to UTC.
- utcTimeSynchronization is not set and
timeSynchronization is set, local time is sent.
- neither utcTimeSynchronization nor
timeSynchronization is set, no time is sent.

SA Bus Integration Object
The SA Bus integration is a private bus on the SNC engine over which sensors, smart actuators,
and I/O modules communicate to the SNC. Unlike the MS/TP Field Bus, the SA Bus integration is
automatically created under the Local Hardware IO object of an SNC engine. All points defined on
this proprietary SA Bus are listed under the SA Bus integration.
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The SA Bus integration object offers provisioning and diagnostic data related to the SA Bus
network. The SA Bus Provisioning tab reports the current firmware versions of the connected SA
Bus devices, and whether any devices have new firmware waiting for them on the SNC. If a pending
firmware change is present, System Status indicates Waiting for Activation. To provision the new
firmware, you issue an Active Provisioning command to the SA Bus.
When the SNC application is started, the SNC downloads the necessary objects to the IOM and the
IOM transitions from Instances Deleted to Operational.

SA Bus Integration Attributes
The SA Bus Integration object contains attributes common to many Metasys system objects. You
can find a description of these common attributes in the Common Object Attributes section. This
section includes attributes of the Focus/Configuration, Provisioning, and Diagnostics tabs.
Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter N
indicate values not required.
Table 122: SA Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Alarm State
Object
Name

Indicates the current status of the object. The expected state is
Normal.
C, W

Object
Identifier
Username
is BACnet
Object
Name

Description

Identifies a name for the SA Bus object.
Specifies an internal identifier assigned to the SA Bus.

C, W

Version

Controls whether the object’s User Name attribute is also the Object
Name attribute. The Object Name attribute is not writable, so the only
way to change the Object Name attribute is to edit the User Name
attribute and set the User Name Is BACnet Obj Name attribute to
True.
Specifies the version number for the SA Bus.

Table 123: SA Bus Integration Attributes - Provisioning Tab
Attribute Name

Description

Provisioning Status

Lists the current status of equipment controllers defined on the
SA Bus of an SNC. Information presented includes Model, Address,
System Status, State, and Progress. When the SNC application
is started, the System Status changes from Instances Deleted to
Operational. The System Status attribute is polled once every 60
seconds, so a refresh in status may not be immediate.

Provisioning Files

Lists the current status of provisioned files for the equipment
controllers defined on the SA Bus of an SNC. Information presented
includes Model, Address, File Name, Current Version, Staged Version,
and Available Version.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Active Baud Rate

Displays the actual data rate on the wire for transmitting and
receiving. When set to Auto, the port is waiting to synchronize with
the network.

Broadcast Receive Rate

Indicates the number of BACnet broadcast messages received on
the MS/TP field bus network of the device in the last minute. If this
number is high, the performance of the specific MS/TP field bus
network is affected by broadcast receive traffic.

Broadcast Receives

Indicates the number of broadcast messages received.

Broadcast Transmit Rate

Indicates the number of BACnet broadcast messages transmitted
on the MS/TP field bus network for the device in the last minute. If
this number is high, the performance for the specific MS/TP field bus
network is affected by broadcast transmit traffic.

Broadcast Transmits

Indicates the number of broadcast message transmissions.

Buffer Overflows

Indicates the number of data frames lost at this MS/TP device
because there was no buffer available to which to save it. This
number includes outgoing and incoming messages.

Bus Analysis Date

Displays the date when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Time

Displays the time when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Progress

Indicates the progress of the full MS/TP field bus scan initiated by the
Analyze Field Bus command.

Bus Device Configuration
List

Lists MS/TP devices that either have been detected on the SA Bus or
have been configured on field devices existing under the MS/TP Field
Bus Integration Object.
The Bus Device Configuration List provides configuration information
for each device, including which devices are responding, which
devices may have been configured incorrectly, and the addresses of
all devices. Only bus supervisor devices provide all this information.
This object creates the list when you issue an Analyze Field Bus
command.

Bus Health Index

Indicates the overall health of the MS/TP field bus based on the
number of errors occurring at the network engine. The most
desirable value is 0. The higher the number, the worse the bus
health/higher the number of errors. The Bus Health Index is reevaluated every 30 seconds and gradually returns to zero if no new
errors occur.
This object derives the value for the Bus Health Index from
periodically reading the Header CRC Errors, Data CRC Errors, Framing
Errors, and Lost Token attribute values to create a moving average of
total errors. The Weighted Bus Health Constant attribute determines
the responsiveness of the Bus Health Index.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Bus Performance Index

Indicates the responsiveness of the bus supervisor device on the MS/
TP field bus. The most desirable value is 1. Values from 2.5 to 6 are
marginal and updates to devices on the bus may be slow. If the value
is greater than 6, the performance is poor and may indicate offline
conditions.
The device derives the value for the Bus Performance Index by
comparing the measured token loop time at the network engine
and the predicted token loop time calculated when the MS/TP Field
Bus Integration object is first created or when the network engine
device count changes. This object uses the difference as input for
determining the weighted moving average of the token loop time.
The Weighted Bus Performance Constant attribute determines the
responsiveness of the Bus Performance Index.

Bytes In

Indicates the number of data bytes received by this device. This
number includes all messages from all devices.

Bytes Out

Indicates the number of data bytes sent by this device. This number
includes all messages to all devices.

Data CRC Errors

Counts errors detected in the data portion of data frames sent to the
device. Many data frames are used only for protocol control and do
not contain a data portion, and thus cannot have Data CRC Errors.
The Header CRC Errors check must be successful before the device
attempts a Data CRC check. This attribute supplies an error count for
the Bus Health Index attribute.

Data Expecting Reply
Frames Rxed

Displays the number of data frames received by the device that
require an immediate reply. This value includes proprietary frames
that have been received and are expecting a reply.

Data Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that requires
an immediate reply from the destination device.
This value includes proprietary frames that have been sent and are
expecting a reply.

Data Not Expecting Reply
Frames Rxed

Displays the number of data frames received by this item that do not
require an immediate reply. This value includes proprietary frames
that have been received and are not expecting a reply.

Data Not Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that do not
require an immediate reply. This value includes proprietary frames
that have been sent and received a reply.

Duplicate Device Identifiers Lists any duplicate object identifiers found after an auto-discovery
of MS/TP BACnet devices finishes. If any devices are listed, then
the list of automatically discovered devices may be incomplete.
The list contains the instance number of the Object Identifier and
the network address (represented in hex notation) of each device
with the same identifier instance number as another device on the
same bus. MS/TP devices with duplicate device identifiers may be
integrated without problem, but should be physically located and
their object identifiers changed to make them unique network-wide.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Execution Time

Records the amount of time taken for the last periodic update of all
referenced mapped BACnet objects. The value for this attribute can
be used to tune the Periodic Update attribute. If the Execution Time
is greater than the Periodic Update, attribute values of referenced
BACnet objects are constantly being updated over the network.
This attribute applies only to non-FEC series devices. See the Poll
Delay attribute description for information on how these attributes
interact.

Framing Errors

Counts the number of errors detected in the individual data bytes
received by the device. A framing error occurs when the device
receives a stop bit in the wrong state. This attribute supplies an error
count for the Bus Health Index attribute. Framing errors are usually
caused by electrical noise on the bus, message collisions, incorrect
baud rate settings, bus wiring or termination errors, or devices that
are not operating within the BACnet specified timing. Framing errors
generally cause CRC errors since the frame has been corrupted.

Header CRC Errors

Counts the number of errors detected in the header portion of
frames received by the device. Many frames are only used for
protocol control and only contain a header portion. This attribute
supplies an error count for the Bus Health Index attribute.

Internal Errors

Indicates the number of internal MS/TP driver operation errors
resulting from an incorrect state, insufficient memory, errors from
the serial port driver, incorrect internal state transitions, and other
error states.

Logging Object Reference

Indicates the object (by way of the BACnet Object Identifier) that
acquires, presents, and stores the Logging Record data (that is,
snapshot) from the underlying system. When the object specified
in the Logging Object Reference field issues the Get Monitor Data
command, the Logging Record is acquired and updated.

Lost Token

Indicates the number of times the device detects a lost token. A
lost token indicates that the bus encountered a serious network
disruption. Serious disruption may occur when the bus first starts up
or when wiring changes are made. This attribute supplies an error
count for the Bus Health Index attribute.

Max Output Queue Used

Displays the largest number of outgoing frames the device has
held in a queue for transmission. The largest possible value for this
attribute depends on the capabilities of the engine. Generally, the
maximum value is reached during device startup, but is not reached
during normal operation.

Maximum Token Loop Time Indicates the maximum time in milliseconds last seen at the device
for the token to complete one circuit of the MS/TP field bus (go
from the originating bus supervisor device through several other
devices and return to the original bus supervisor device). The value
is reset when the statistics are cleared. Maximum loop time is closely
associated with the worst-case performance encountered since the
last time the value was reset.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Overrun Errors

Displays the number of times the MS/TP port hardware loses
received data because the device is too slow in reading the data. An
overrun error occurs when the hardware receives a byte before it
moves the prior byte to a buffer.

Packets Timed Out

Counts the number of data frames expected by the device that did
not arrive within the time allowed.

Packets Too Long

Counts any attempts to transmit or receive a data frame that is
longer than allowed by the device or by MS/TP.

PFM Frames Rxed

Displays the number of Poll For Master (PFM) frames received by
the device. On a clean network, this should only count the first PFM
frame received when the device (or another with a MAC address
below that of the device) comes online. These frames are used
to discover other devices on the network and should be seldom
received.

PFM Frames Txed

Displays the number of PFM frames sent by the device. In normal
operation on a clean network, only the bus supervisor (MAC address
0) and the highest numbered master device on the network should
be sending PFM frames. These frames are used to discover other
devices on the network.

Polled Object Count

Indicates the number of mapped BACnet objects that are currently
polled on a periodic basis. This attribute applies only to non-FEC
series devices.

Port Status

Indicates the state of the port (Active or Inactive).

Predicted Token Loop

Indicates the theoretical time in milliseconds needed for the token to
complete one circuit of the MS/TP field bus.
The object derives this value from the defined bus baud rate, number
of devices on the bus, and an estimate of the type and amount
of messages transmitted on the bus during this time. This object
compares the value of this attribute with that of the Token Loop Time
attribute to help calculate the value of the Bus Performance Index
attribute.

Reply Postponed Frames
Rxed

Counts the number of data frames sent to the device that require an
immediate reply of which the destination device requests additional
time to prepare the reply (hence, a postponement). This delay may
occur if the reply involves a large amount of data or the device is
overloaded.

Reply Postponed Frames
Txed

Counts the number of data frames received at the device that
requires an immediate reply of which the device requests additional
time to prepare the reply (hence, a postponement). This delay may
occur if the reply involves a large amount of data or the device is
overloaded.

Reply to PFM Frames Rxed

Counts the number of Reply to PFM frames the device receives. On
a clean network in normal operation, the device receives only one
Reply to PFM frame when either the device comes online or the next
higher numbered device comes online during normal operation.
These frames announce the presence of this device on the network.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Reply to PFM Frames Txed

Counts the number of Reply to PFM frames the device transmits.
On a clean network during normal operation, only one Reply to PFM
frame needs to be sent when the device first comes online. These
frames are used to announce the presence of other devices on the
network.

Reply Too Slow Application
Errors

Counts the number of data frames received at this device that
requires an immediate reply where the device cannot assemble reply
data within the time allowed and cannot internally detect the need
for additional time. If these errors occur frequently, the device could
be overloaded.

Reply Too Slow Datalink
Errors

Counts the number of data packets sent by the device that requires
an immediate reply from the destination device, but do not receive
any reply within the time allowed. This number does not include
Reply Postponed responses. The affected frames likely require a
retry. Bus performance is reduced when this happens.

Reset Date

Specifies the date of the last Clear Statistics command (when the
statistics for the device were last reset).

Reset Time

Specifies the time of the last Clear Statistics command (when the
statistics for the device were last reset).

Retries

Displays the number of times the device tried to pass a token as the
next node did not start using it within the time allowed by BACnet
protocol.

Test Request Frames Rxed

Displays the number of Test Request Frames the device receives. Test
Request Frames are a normal part of bus analysis, but should not be
received during normal operation. A Test Response Frame should be
sent in reply to each Test Request Frame received.

Test Request Frames Txed

Displays the number of Test Request Frames the device transmits.
Test Request Frames are a normal part of bus analysis, but should
not be sent during normal operation. A Test Response Frame should
be received in response to each test Request Frame sent to an online
device. Test Request Frames may also be sent to offline devices
where no response is received.

Test Response Frames Rxed Displays the number of Test Response Frames the device receives.
Test Response Frames are a normal part of bus analysis, but should
not be received during normal operation. A Test Response Frame
should be received in response to each test Request Frame sent to
an online device.
Test Response Frames Txed Displays the number of Test Response Frames transmitted by this
MS/TP port. Test Response Frames are a normal part of bus analysis,
but should not be sent during normal operation. A Test Response
Frame should be sent in response to each test Request Frame
received.
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Table 124: SA Bus Integration Attributes - Diagnostic Tab
Attribute Name

Description

Token Frames Rxed

Displays the number of Token Frames the device receives. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message; thus, the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.

Token Frames Txed

Displays the number of Token Frames the device transmits. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message, thus the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.

Token Loop Time

Indicates how much time passes between the periods when the
device allows initiation of messages on the network. This time is a
strong indicator of network performance and is associated strongly
with the amount of traffic or errors on the network. Shorter time
period indicate a more responsive network. Longer time period
indicate an increasingly busy and slow network.
The object compares the value of this attribute with that of the
Predicted Token Loop Time attribute to help calculate the value of
the Bus Performance Index attribute.

Unexpect Frames Rxed

Displays the number of data frames of an illegal type that the device
receives. During normal operation, only certain kinds of MS/TP data
frames are allowed to be sent during each phase of operation. If
the device receives some other kind of data frame (other than the
allowed types for the current phase of operation), the device counts
the data frame as an Unexpected Frame. The device may often
detect Unexpected Frames when connecting running devices to a live
MS/TP bus.

Weighted Bus Health
Constant

Determines the responsiveness of the Bus Health Index. The default
value is 0.50.

Weighted Bus Performance Determines the responsiveness of the Bus Performance Index. The
Constant
default value is 0.50.
Table 125: SA Bus Integration Attributes - Hardware Tab
Attribute Name

Initial
Value

Values/Options/Range

APDU Retries

3

Indicates the maximum number of times the device can
retransmit a data frame. This attribute is fixed at 3.

APDU Segment Timeout 4000
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Indicates the amount of time in milliseconds between
retransmissions of a data frame segment requiring
acknowledgment for which no acknowledgment has been
received. This attribute is fixed at 4000 ms.
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Table 125: SA Bus Integration Attributes - Hardware Tab
Attribute Name

Initial
Value

Values/Options/Range

APDU Timeout

6000

Indicates the amount of time in milliseconds between
retransmissions of a complete data frame requiring
acknowledgment for which no acknowledgment has been
received. This attribute is fixed at 6000 ms.

Baud Rate Selection

38400

Indicates the baud rate of the network engine SA Bus. This
attribute is fixed at 38400 baud.

Configured Network
Number

65000

Contains the network number of the SA bus used for
BACnet message addressing. A value of 0 indicates a local
network (the device is not intended as a router).

JCI MAC Address

0

Contains the unique hardware number that identifies the
SA Bus within a network.

Max APDU Length

1476

Indicates the maximum number of bytes that may be
contained in a single, indivisible application layer protocol
data unit.

Max Master

127

Specifies the highest possible address for devices on this
network and is less than or equal to 127 (default). This
attribute is present if the device is a bus supervisor device
on an MS/TP network. Typically this address is kept at 127
to allow other devices on the bus to use any of the lower
valid addresses.

SA Bus Integration Commands
The following table lists the commands supported by the SA Bus Integration Object.
Table 126: SA Bus Integration Commands
Command Name

Parameters

Description

Activate Provisioning

None

Requests the SNC to provision the new firmware that
is pending in its memory. This process activates the
firmware. You can monitor the status of this action
under the Progress column of the Provisioning tab.

Clear Statistics

None

Clears the statistics for the integrated SA Bus.

Latch Statistics

None

Updates the displayed SA Bus statistics with the
current values.

Refresh Provisioning
Discovery

None

Refreshes the SA Bus Provisioning view on the SA Bus
of the SNC. Send this command if an SA Bus device
that is connected to the SNC is not showing up in the
SA Bus Provisioning view. The command takes several
minutes as the SNC searches for devices over its SA
Bus. Found devices are added to the Provisioning
view. For example, use this command to locate an
IOM that is stuck in a boot-code-only mode because of
some type of failed provisioning cycle. For most cases,
the Refresh Provisioning Discovery command is rarely
needed.
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LON Integration Object
The LON Integration object defines LonWorks network integration for the NAE. The object contains
pertinent attributes and holds a list of LonWorks network-related configuration resource files.
Note: The LON trunk integration is not available for network engines updated to Release 9.0.7.

LON Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 127: LON Integration Attributes - Diagnostic Tab
Attribute Name

Data Type

Description

Bind Retry Count

Number

Indicates the number of objects for which the Lon
Integration code is still verifying with the field controller
that it has the correct type information.

Count

Number

Displays the number of LonWorks network point object
defined for the trunk.

Device Offline Polling
Cycle Time

Number

Indicates how often all offline devices are polled.

Device Online Polling
Cycle Time

Number

Indicates how often all online devices are polled.

Error Log

One value
from a set

Shows the error log according to the last standard
LonWorks network Query Status message.

LON Integration DLL
Date

Date

Displays the current date stamp on the
LonIntegration.DLL.

LON Integration DLL
Size

Number

Displays the current size of the LonIntegration.DLL.

LON Integration DLL
Time

Time

Displays the current time stamp on the
LonIntegration.DLL.

Lost Messages

Number

Shows the number messages lost according to the last
standard LonWorks network Query Status message.

Missed Messages

Number

Shows the number messages missed according to the last
standard LonWorks network Query Status message.

Neuron Model

One state
from a set

Shows the Neuron model according to the last standard
LonWorks network Query Status message.

Node State

One state
from a set

Shows the state of the node according to the last standard
LonWorks network Query Status message.

Offline

True or False

Displays the offline or online status of connected
hardware. The LonWorks network server updates this
attribute value.

Permanent Status
Item Count

Number

Displays the number of items polled as a result of COV
signups.

Point Scan Time

Number

Displays the calculated number of seconds the server
takes to read all defined points.

Priority 1 Poll Item

Number

Displays the number of items in the Priority 1 list.
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Table 127: LON Integration Attributes - Diagnostic Tab
Attribute Name

Data Type

Description

Priority 2 Poll Item

Number

Displays the number of items in the Priority 2 list.

Priority 3 Poll Item

Number

Displays the number of items in the Priority 3 list.

Priority 1 Poll Time

Number

Indicates how often the items in the Priority 1 list are
polled.

Priority 2 Poll Time

Number

Indicates how often the items in the Priority 2 list are
polled.

Priority 3 Poll Time

Number

Indicates how often the items in the Priority 3 list are
polled.

Receive Transaction
Full

Number

Shows the number of times the transaction full message
appeared in the last standard LonWorks network Query
Status message.

Reset Cause

One cause
from a set

Shows the cause of the last reset according to the last
standard LonWorks network Query Status message.

Reset Date

Date

Contains the date stamp of the last local Neuron statistics
reset command.

Reset Time

Time

Contains the time stamp of the last local Neuron statistics
reset command.

Status Cache Hits

Number

Displays the number of READATTRIBUTE calls that
occurred while the object was already being polled.

Status Cache Misses

Number

Displays the number of READATTRIBUTE calls that
occurred while the object was not being polled.

Temporary Status
Item Count

Number

Displays the number of items polled as a result of
READATTRIBUTE calls.

Transaction Timeouts

Number

Shows the timeouts that appeared in the last standard
LonWorks network Query Status message.

Transmit Errors

Number

Shows the number of transmit errors that appeared in the
last standard LonWorks network Query Status message.

Transmits Per Minute

Number

Displays the calculated number of transmissions per
minute.

Version Number

Number

Shows the version number according to the last standard
LonWorks network Query Status message.

XIF Present

True or False

Indicates whether the XIF is present. The XIF is a resource
file required for the NAE to understand a particular device
type. This attribute is not used in the SCT.

LON Integration Commands
The following table lists the commands supported by the LON Integration Object.
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Table 128: LON Integration Object Commands
Command Name Parameters

Description

Clear Statistics

Resets the statistics for the integrated LonWorks network.
The contents of the Query Status message reflect these
statistics:

None

•

Transmit Errors

•

Transaction Timeouts

•

Receive Transaction Full

•

Lost Messages

•

Missed Messages

•

Reset Cause

•

Node State

•

Version Number

•

Error Log

•

Neuron Model

Disable

None

Disables the entire LonWorks network integration. No
requests are made to the field trunk and no data broadcasts
to the network are processed.

Enable

None

Allows the integration to function normally.

Latch Statistics

None

Updates the displayed statistics with the current values. The
following attributes reflect the statistics:
•

Transmit Errors

•

Transaction Timeouts

•

Receive Transaction Full

•

Lost Messages

•

Missed Messages

•

Reset Cause

•

Node State

•

Version Number

•

Error Log

•

Neuron Model

N1 Migration Object
Note: This object is for use with the NIEx5 only. For more information on N1 migration, see
the Related Documentation table in the Welcome section.
The N1 Migration object contains all the necessary information to communicate with points on an
existing Metasys network. Add the new Metasys system hosting the migration server to the existing
Metasys network as an OWS at a fixed IP Address. All existing Metasys networks are defined as N1
Migration objects in the host NIE. Many of the existing point objects are defined as mapped devices
to the NIE.
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Note: The N1 Migration object is not available for network engines updated to Release 9.0.7 or
later.

N1 Migration Concepts
Migration Overview
When you add a new Metasys system N1 Migration object, the N1 migration component establishes
communication with the N1 network. The N1 Migration object is only an object on the new Metasys
system controller to which it was added.
After the N1 Migration object establishes communication with the existing Metasys system, the
N1 Migration object creates 2 new calendars that are a portal to the existing NCM calendar. (See
Today’s Schedule in the Scheduling section.) One calendar is a list of alternates, and one calendar is
a list of holidays.
Note: An Ethernet connection is the only method for the NIE to connect to the N1 network.
ARCnet jobs must use an Ethernet router.
See the N1 Migration Attributes section for more information on N1 migration attributes.
Mapped Points
Existing features of the Metasys system are supported by moving their functionality to the host
NIE. These features are: trend, totalization, point history, and scheduling. When possible, existing
objects maintain their configuration parameters in the new Metasys system. For example, alarm
limits, alarm state, and units. The table below lists points specific to the Metasys system.
Table 129: Mapped Points
Existing Metasys System
Object

New Metasys System Mapped Object

Accumulator Object

N1 Pulse Counter Object

Analog Input

Analog Input Object

Analog Output

Analog Output Object

Analog Data

Analog Output Object

Binary Input

Binary Input Object

Binary Output

Binary Output Object

Binary Data

Binary Output Object

Control System

Generic Integration Object (GIO)

Multistate Input

Multistate Input Object

Multistate Output

Multistate Output Object

Multistate Data

Multistate Output Object

Multiple NIEs
Migration can be split across multiple NIEs with the following constraints:
•

Only one N1 Migration object can exist per NIE per N1 network.

•

Multiple NIEs can reference the same N1 network.

•

Only one NCM object can exist per NCM per N1 Migration object.

•

Multiple NCM objects can reference the same NCM as long as they exist on different NIEs.

•

Only one point object can exist per NIE per N1 object.

•

Multiple point objects can reference the same N1 object as long as they exist on different NIEs.
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N1 Migration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.
Table 130: N1 Migration Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Description

Broadcast
Address

C,W

Connected Status

Edits the address to use directed broadcasts. The user typically does
not edit this attribute.
Displays if the NIE communicated with the Metasys N1 network for the
object mapping service and UI service. This attribute drives the status
of the object.

Device Name

C,W

Displays the defined case-insensitive device name. The device name is
required for the existing Metasys system to detect the On-Line status
and Off-Line status of the NIE. This attribute must match the name of
the NIE in the existing N1 network.

Discovery IP
Address

C,W

Displays the defined NCM IP address of the existing Metasys system.
Use for self discovery of the existing Metasys system. You need at least
1 NCM in the existing N1 network that the NIE can talk to, to find the
other N1 devices and get N1 points.

Discovery Gate
Address

C,W

Displays the defined NCM Gate address on the existing Metasys
system. Use for self discovery of the existing Metasys system. You need
at least 1 NCM in the existing N1 network that the NIE can talk to, to
find the other N1 devices and get N1 points.

Discovery Node
Number

C,W

Displays the defined NCM Node address on the existing Metasys
system. Use for self discovery of the existing Metasys system. You need
at least 1 NCM in the existing N1 network that the NIE can talk to, to
find the other N1 devices and get N1 points.

Duty-Standby

C,W

Displays whether the existing Metasys system is a Duty/Standby
network. The NIE has to know if the existing N1 network is a Duty/
Standby.

Enable Polling

C,W

When True, this attribute causes the integration in the NIE to place any
system into a 20 second fast polling table being viewed. This attribute
also places a system into this table on an object’s Focus view. This
provides faster updates to objects being viewed in any Metasys system
UI. When viewing points from several systems, the Service Time for the
NCM increases. Take care when enabling this fast polling feature as it
may affect the service times.
Note: To prevent delays in event reporting due to the fast scan operation,
follow the existing report routing guidelines.
Note: Do not set this attribute to True when for NIEs used with validated
environments (that is, when Trend data must be collected within 2 minutes).

Gate Number

C,W

Displays how the NIE is defined in the existing N1 network. This
attribute is read from the NCM.
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Table 130: N1 Migration Object Attributes - Focus/Configuration Tab
Attribute Name

Notes Description

Message Timeout C,W

Displays the reply timeout in seconds. The reply timeout is how long
the NIE waits for a reply from an NCM. The user typically does not edit
this attribute.

Migrate Object
Configuration

C,W

When True, this attribute displays the basic object configuration from
the existing Metasys system object used to write basic configurations
for newer Metasys objects. For example, units or descriptor. This
attribute (when True) tells the new Metasys system to bring alarm
setup information from the existing N1 network and creates Alarm
Extensions (Analog Alarm and Multistate Alarm) for new objects that
are added.

Migrate
Schedules

C,W

Displays the attached existing Metasys system schedules used to create
the newer Metasys system Schedule. The schedules that appear in
the new Metasys systems are portals to the schedules in the existing
N1 network. Schedules appear in the new format and offer the same
functionality. Changes made to the schedules in the new Metasys
system are also made to the N1 schedules in the NCM.

Migrate
Totalization
Configuration

C,W

Displays the totalization configuration from the existing Metasys
system object used to create the newer Metasys system Totalization
Extensions when an existing object is mapped to a newer object.

Migrate Trend
Configuration

C,W

Displays the trend configuration from the existing Metasys system
object used to create the newer Metasys system Trend Extension when
an existing object is mapped to a newer object. This attribute creates
one or more trend extensions for existing N1 network trends.

Network Name

C

Displays the defined network name.
Note: Be sure to configure the Network Name attribute of the N1 Migration. Once you insert the N1 Migration, you cannot edit the Network
Name attribute. The workaround is to delete the existing N1 Migration
and insert a new N1 Migration ensuring you enter the desired Network
Name before completing the Insert Integration wizard.

Note Number

C,W

Displays how the NIE is defined in the existing N1 network.

Poll Delay

C,W

Displays the polling time for non-triggerable attributes in milliseconds.
The poll delay is the time between NIE polls to the N1 network points.

Retry Counter
Limit

C,W

Contains the number of retry attempts made. The NIE waits for the
Message Timeout, then retries sending messages the number of times
defined in this attribute.

Retry Wait Timer

C,W

Contains the time between communication retries (in seconds). This
attribute is the time the NIE waits for a low-level Ack from the NCM. The
user typically does not edit this attribute.

Synchronize Time C,W

Displays whether the NIE is the master time keeper for the existing N1
network system. Time updates are sent to the existing system once
daily and when the time changes.

UDP Port

Displays the UDP Port as defined in the existing Metasys system.

C,W

N2 Master Datalink Object (N2 Trunk)
The N2 Master Datalink object creates the communication link between the N2 controllers and the
supervisory controller. The N2 Master Datalink object is the root for all N2 objects in the Metasys
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system. When you add an N2 Trunk to an engine, you establish communication with the specific N2
controller network. The N2 Master Datalink object offers diagnostic data related to the N2 controller
network. This object allows you to see N2 Bus communication statistics.
Note: The Object Type for this object is labelled N2 Trunk in the software.

N2 Master Datalink (N2 Trunk) Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects). The
writable attributes in the N2 Master Datalink object are writable only if the UDP Port attribute is not
zero. If the UDP Port attribute is zero and you attempt to write these attributes, an error message
appears.
Table 131: N2 Master Datalink Object Attributes - Diagnostic Tab
Attribute Name

Values/Options/
Range

Buffer Overflow
Checksum Errors

Description
Indicates the number of input buffer overflows.

0 to 4,294,967,295

Command Count

Indicates the number of checksum errors.
Indicates the number of N2 user or process commands.

Count

0 to 65,535

Specifies the number of N2 point objects defined for this
trunk.

COV-COS Count

0 to 4,294,967,295

Indicates the number of Changes of Value/Changes-ofState since the last reset.

Data CRC Errors

Indicates the number of System 9100 checksum errors.

Framing Errors

Indicates the number of UART framing errors.

Hardware
Overflows

Indicates the number of UART hardware overruns.

HP Point Scan
Time

0 to 65,535
Seconds

Indicates the calculated number of seconds the N2
master takes to scan high priority N2 point objects, such
as those used in alarming and interlocks.

LP Point Scan
Time

0 to 65,535
Seconds

Indicates the calculated number of seconds the N2
master takes to scan low priority N2 point objects (all
N2 point objects that do not fall in the high priority
category).

Message Receives 0 to 4,294,967,295

Indicates the number of messages received from the N2
controllers.

Message
Transmits

0 to 4,294,967,295

Indicates the number of message transmissions to the
N2 controllers.

NAK Errors

0 to 4,294,967,295

Indicates the number of negative acknowledge errors.
A NAK is returned by an N2 device to indicate that it
received and decoded a command correctly, but the
command did not make sense or could not be carried
out. An example of a NAK is an attempt to read an
Analog Input beyond the range of the device.
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Table 131: N2 Master Datalink Object Attributes - Diagnostic Tab
Attribute Name

Values/Options/
Range

Description

Offline
Occurrences

0 to 4,294,967,295

Indicates the number of offline occurrences by the N2
controllers.

Offline Polls

0 to 4,294,967,295

Indicates the number of offline polls to the N2 devices.

Online Polls

0 to 4,294,967,295

Indicates the number of online polls to the N2 devices.

Parity Errors

Poll Scan Times

Indicates the number of messages that contain invalid
hexadecimal characters (hexadecimal characters are 1-9
and A-F).
0 to 65,535 Seconds

Indicates the calculated number of seconds the N2
master takes to poll all defined N2 devices.

Reset Date

Indicates the date of the Clear Statistics command.

Reset Time

Indicates the time of the Clear Statistics command.

Retry Attempts

0 to 4,294,967,295

Indicates the number of message retry attempts.

Transmits Per
Minute

65,535

Indicates the calculated number of message
transmissions per minute.

VMA BAC Errors

0 to 4,294,967,295

Indicates the number of VMA BACnet errors

VMA COV Errors

0 to 4,294,967,295

Indicates the number of VMA Change-of-Value errors.

VMA FMT Errors

0 to 4,294,967,295

Indicates the number of VMA Format errors.

N2 Master Datalink (N2 Trunk) Commands
The table below lists the commands supported by the N2 Master Datalink Object (N2 Trunk).
Table 132: N2 Master Datalink Object Commands
Command Name

Parameters Description

Clear Statistics

None

Allows the user to clear the N2 statistics.

Latch Statistics

None

Updates the displayed statistics with the current values.

Generic Integration Object
The GIO is a single software representation of the hardware/internal data points from a device
that has been integrated into your Metasys network. One GIO can represent one or more control
strategies (for example, temperature control or static pressure control). Up to 256 data points can
become attributes of the GIO and each attribute of the GIO works with Metasys features, such as
historical data management, alarm and event handling, and basic monitoring and commanding
capabilities.
You can map data points to the GIO in either online or offline mode. When you map the data points,
you define their label, units, display precision, category, and whether or not the data point should
be commandable. You can command points from the GIO using Generic Integration Attributes
commands.
The GIO is useful when you have multiple hardware/internal data points from an integrated device
and it logically makes sense to view them as a single entity rather than individual Metasys objects
(that is, AI, BI, AO, BO, and so on). While you may be able to browse to each device, there may only
be a few data points you need to see on a regular basis. The GIO lets you group the data points you
need to see in one place and organize them in the following categories:
•
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•

outputs

• parameters
When the GIO appears in Metasys software, the attributes are organized by tabs bearing the names
of the three categories (Input Category, Output Category, and Parameter Category tabs). Each tab
includes the status, description, and value of the items in that category.
Note: Currently, the GIO supports N1 Migration Object and LON Integration Object. You can
no longer manually add a GIO to a LON trunk; however, the GIO is still supported in existing
databases, even after upgrading to the next software release.
For general information on Metasys system objects, see Common Object Attributes.

Generic Integration Concepts
N1 Integration and the GIO
For N1 integration, use the Control System object from your existing Metasys network. Hardware
and internal points are already defined in the Control System object so there is one to one mapping
between a Control System object and the GIO. N1 point mapping is one to one and the Metasys
system restricts which characteristics of the GIO (for example, label, display precision) can be edited
once they are added to the system.

LonWorks Network Integration
Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still
supported in existing databases, even after upgrading to the next software release.
In LonWorks network integration, the GIO presents multiple LonWorks network variables (with
their individual data elements) and/or NexSys controller points of an integrated LonWorks network
controller as a single Metasys object. During the configuration of a GIO for an integrated LonWorks
network controller, the user is presented with the internal network variables and NexSys controller
points in a tree structure which then allows the user to add these data points as attributes of the
GIO object. The characteristics of the GIO attributes (label, units, display precision, field units,
category) and the commandability of the GIO attributes can be edited.

Generic Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, attributes marked with the letter D are default
display attributes, and attributes marked with the letter N indicate values not required.
Table 133: Generic Integration Object (GIO) Attributes
Attribute Name

Notes

Description

Display Reference N

Represents the label of the Display Attribute. The Display
Reference is not stored in the object, but read when
requested.

Offline

W

Indicates whether the Present Value is offline.

Overridden

W

Indicates whether the Present Value is in override.

Present Value

DW

Indicates the current value of the object in the defined
units.

Reliability

W

Indicates whether the Present Value is unreliable.

Target Reference
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Identifies the source that provides the data elements linked
to the individual attributes of the GIO.
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Table 133: Generic Integration Object (GIO) Attributes
Attribute Name

Notes

Description

Attribute Info

C,W

Contains a list of structures that store data about each
attribute defined within a GIO. The elements listed in
this table appear as columns on the Hardware tab of the
Configure screen of the Insert Point Wizard - GIO.
Table 134: Hardware Tab Configuration Columns

Display Attribute
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C

Element
Name

Description

Adjust
Allowed

Indicates whether or not this attribute
supports the Adjust command.

Category

Specifies the attribute category (input,
output, or parameter). 0 - Input, 1 - Output,
2 - Parameter

Display
Precision

Specifies the display precision for an
attribute with a real value (floating point).

Element Ref

Specifies the element within the target
reference associated with this attribute to
provide it data for value/status/reliability.

Field Units

Represents the units that can be used for
the attribute. Uses Unit Set (Set 869)

Label

Contains the user label for the attribute
name. This is the name used whenever you
view the attribute in Metasys software.

Override
Allowed

Indicates whether or not this attribute
supports the Override command.

Units or
Enum Set

Specifies the units for an attribute that is
a real value (floating point). If an attribute
is one value from a set, this attribute sets
the states text from the sets listed in the
Alphabetical Set List.
Use Unit Set (Set 869) to set the units of a
real value.

Specifies the attribute that represents the value of the
GIO. The value of this attribute is used as the Present
Value of the GIO. For example, for a GIO representing
a temperature control strategy, you might choose the
attribute representing room temperature to be the Display
attribute. Then, the room temperature appears as the GIO
Present Value.
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Table 133: Generic Integration Object (GIO) Attributes
Attribute Name

Notes

Description

Remote Object
Name

C,W

Contains the name of the object in the format of
system.object.

GIO 1 Attr. . .GIO
256 Attr

W

Represents user-definable attributes that can be part of
a GIO. Each attribute represents a potential entry in the
Attribute Info attribute which in turn represents a physical
or logical piece of data within an integrated device.
These attributes only appear on the Hardware tab of the
Configure screen of the Insert Point Wizard - GIO.

Generic Integration Commands
The table below shows the command supported by the Generic Integration Object.
Table 135: GIO Commands
Command Name

Parameters

Attribute Command None

Description
Allows you to select one of the user-definable
attributes of the GIO. When you select an attribute
and click the ellipses button, the Attribute
Commands available for that attribute appear.
This allows you to command individual attributes
represented by the GIO.

GIO Command Details
Attribute Commands
Attribute commands are commands you can issue from the GIO to individual attributes of the GIO.
To access the attribute commands, do one of the following:
•

In the navigation tree, right click on the GIO object and select Commands then select an
attribute for the GIO Attribute Command, and click the ellipsis button.

•

In a category view for the GIO (in the display frame), right-click on the attribute you want to
command, and select Commands.
The attribute commands that appear are based on the data type of the attribute and whether
Override Allowed and Adjust Allowed are True or False. See Table 133 for more information about
these elements.
Table 136: Attribute Commands
Command
Adjust

Notes
Real values only (floating points)

1

Operator Override

2

Release Operator Override
Change Units

All values but True/False

Change Name
Change Display Precision

Real values only (floating points)

State0...StateN

Two state or multistate values
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Table 136: Attribute Commands
Command

Notes

True

True/False only

False

True/False only

1
2

Adjust Allowed must be True.
Override Allowed must be True.

VND Integration Object
The VND (Vendor) Integration object defines a vendor integration for the NAE.

VND Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.
Table 137: VND Integration Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value Description

Enabled

C,W

True

If True, allows the use of the vendor integration. If
False, prevents the use of the vendor integration.

True

Displays the offline or online status of connected
hardware.

Offline

Table 138: VND Integration Attributes - Diagnostic Tab
Attribute Name

Notes

Initial Value Description

Count

W

0

Displays the number of vendor device and point
objects defined for the trunk. This count does not
include extensions.

Errors In

W

0

Indicates the number of field communication
errors (bad format, for example) received. The
Clear Statistics command resets this value.

Errors Out

W

0

Indicates the number of field communication
attempts that failed. The Clear Statistics
command resets this value.

Function Time
Exceeded

0

Indicates the number of functions to the Vendor
DLL that took longer than 100 milliseconds to
execute. The Clear Statistics command resets this
value.

Message Receives

0

Indicates the number of messages received field
devices. This value resets to zero at midnight. The
Latch Statistics command updates this value.

Message
Transmits

0

Indicates the number of messages sent to field
devices. This value resets to zero at midnight. The
Latch Statistics command updates this value.
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Table 138: VND Integration Attributes - Diagnostic Tab
Attribute Name

Notes

Initial Value Description

Permanent Status
Item Count

0

Displays the number of items polled as a result of
COV signups.

Priority 1 Poll Time

0

Indicates how often the items in the Priority 1 list
are polled. Units = Seconds

Reset Date

Contains the date stamp of the last Clear Statistics
command.

Reset Time

Contains the time stamp of the last Clear Statistics
command.

Temporary Status
Item Count

0

Displays the number of items polled.

Transmits In

0

Indicates the rate of transmissions received by
the integration.

Transmits Out

0

Indicates the rate of transmissions sent by the
integration.

VND Integration Commands
The table below lists the commands supported by the VND Integration Object.
Table 139: VND Integration Object Commands
Command Name

Description

Clear Statistics

Resets the statistics for the integrated vendor network.

Disable

Disables the entire vendor network integration. No
requests are made to the field trunk and no data
broadcasts to the network are processed.

Enable

Allows the integration to function normally.

Latch Statistics

Updates the displayed statistics with the current values.

Wireless Receiver Supervisor Object
The Wireless Receiver Supervisor object is the root of the Wireless Sensor integration. The Wireless
Sensor integration allows the NAE to communicate with the wireless sensing system over the
Ethernet network. The Wireless sensing system consists of wireless receivers and wireless sensors.
Each integrated wireless field device (Wireless Receiver Object) and field point object (Wireless
Sensor Object) appears under the Wireless Receiver Supervisor object in the Navigation Tree. Only
one Wireless Receiver Supervisor object can be configured in each NAE or NIEx9.
Note: The Wireless Receiver Supervisor object is not available for network engines updated to
Release 9.0.7 and later.

Wireless Receiver Supervisor Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.
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Table 140: Wireless Receiver Supervisor Object Attributes - Focus/Configuration Tab
Attribute Name
UDP Port -- Setup

Notes
WC

Retries -- Setup

W

Poll Delay -- Setup

W

Message Timeout -Setup

WC

Description
Indicates the UDP Port on the NAE used to communicate to the Ethernet to RS-485
converter. The port must be 1024 or higher, but cannot be equal to the BACnet UDP Port,
the N2 Trunk UDP Port, or 9999.
Displays the number of times the device tried to pass a token as the next node did not
start using it within the time allowed by the protocol.
Specifies the time in milliseconds between BACnet object polls for attribute values.
The polls start at the time specified in the Periodic Update attribute. As the poll delay
increases, the overall time in the Execution Time attribute increases.
It is useful to specify a Poll Delay on sites where the rate of reading the remote objects
causes too high of a burden on the Metasys network or third-party device. The initial value
of the Poll Delay attribute is blank (zero).
Specifies the delay in milliseconds between the last character going out and the first
character received.
Note: The Message Timeout attribute is writable only if is not zero. If User Datagram
Protocol (UDP) Port is zero and you attempt to write Message Timeout, an error
message appears.

Low Battery -- Status

Alarm State -- Status

Indicates if any wireless sensors defined as children of the Wireless Receiver Objects have
a low battery. The Low Battery status is an advanced warning that can occur many days
before a wireless sensor ceases to function. You can configure an alarm for this attribute
to allow the building operator time to locate the sensor and change the battery.
The Alarm State attribute indicates that the object transitioned into alarm or unreliable
conditions. This attribute does not appear in the SCT UI.

Wireless Receiver Supervisor Commands
The table below lists the commands supported by the Wireless Receiver Supervisor Object.
Command Name

Description

Clear Statistics

Resets all the attributes containing diagnostic statistics
for this Wireless Receiver Supervisor and all its Wireless
Receiver Objects and Wireless Sensor Objects.

XL5K Integration Object
The XL5K Integration object defines Honeywell Excel 5000 (XL-5000) network integration for the
NIEx5. The object contains pertinent communications attributes and statistics. Only one XL5K
Integration object can be configured in each NIE.
Note: The XL5K Integration object is not available for network engines updated to Release
9.0.7 or later.

XL5K Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.
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Table 141: XL5K Integration Attributes - Focus/Configuration Tab
Attribute Name
Enabled

Notes
C,W

Offline

Initial Value Description
True
If True, allows integration between the XL5K system and the Metasys
system extended architecture.
False
Indicates the offline/online state of the connected hardware.

Table 142: XL5K Integration Attributes - Diagnostic Tab
Attribute
Name

Data Type

Description

Count

Number

Indicates the number of scannable points for all XL5K Controller
objects defined for this object.

Point Scan
Time

Number

Indicates the total amount of time to scan for point data.

Reset Date

Date

Indicates the date of the last Clear Statistics command or due to
automatic midnight rollover.

Reset Time

Time

Indicates the time of the last Clear Statistics command or 12:00:00 if
due to automatic midnight rollover.

Transaction
Timeout

Number

Indicates the number of transmissions (packets) since the last Clear
Statistics command where no response data was obtained and the
transmission was retried.

Transmit
Error

Number

Indicates the number of transmissions (packets) since the last Clear
Statistics command that have errors (for example, bad data was
returned).

Transmits
Per Minute

Number

Indicates the calculated number of transmissions per minute.

Transmits
Today

Number

Indicates the number of transmissions (packets) since midnight.

XL5K Integration Commands
The table below lists the commands supported by the XL5K Integration Object.
Table 143: XL5K Integration Commands
Command Name

Parameters

Clear Statistics

None

Disable

None

Enable

None

Latch Statistics

None

Field Device
About this task:
Menu Selection: Insert > Field Device
Inserts one of the following types of field device objects under the selected integration:
•

BACnet Integration

•

MS/TP Field Bus Integration
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•

LonWorks Network Integration (LON Trunk)

•

N2 Integration (N2 Trunk)

•

VND Controller (Vendor)

•

Wireless Supervisor Integration

•

XL5K (Excel 5000/XL-5000) Integration

To insert a field device select the menu selection:
1.
2.

In the Destination selection, select the parent item for your new item.
In the Definition selection:
a.
Select Assisted Device Definition and click the Invoke Auto Discovery button to discover
existing controllers or devices on the network. This is available in the Site Management
Portal (SMP) only.
Note: In the wizard Auto Detect Utility window, if Results are from a previous
discovery appears next to the Close button, the displayed results are from the last
time a discovery was run. These cached results may not reflect all items currently
on the network. To clear the old results and perform a new auto discovery, click
Restart. Click any column header to sort discovered devices.

3.
4.
5.

b.
Select Manual Device Definition and select the desired address from the menu.
In the Identifier selection, enter a unique identifier.
In the Configure selection, click any tabs that may appear for further device configuration.
Click Finish to confirm the field device configuration.
Note: If the navigation tree does not automatically update for defined points after
adding a field device using Auto Discovery (+ sign appears next to device in tree), select
Refresh All Tabs on the Action Menu to update.
See one of the following sections for more information:
- BACnet IP Integration Object
- MS/TP Field Bus Integration Object
- N2 Master Datalink Object (N2 Trunk)
- LON Integration Object
- N1 Migration Object
- VND Controller
- Wireless Receiver Object
- XL5K Integration Object

BACnet Protocol Engine Object
The BACnet Protocol Engine object maintains diagnostic statistics on communications with the
BACnet devices on the network.

BACnet Protocol Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.
298

Metasys Site Management Portal Help

Table 144: BACnet Protocol Engine Object Attributes - Focus/Configuration Tab
Attribute Name
Alarm State

Notes

Initial Value
Offline

Enabled

C,W

True

Graphic Alias

C,W

Item Reference

Poll Delay

C,W

120

Description
Indicates that the object transitioned into alarm or
unreliable conditions. This attribute appears only in
the Snapshot Focus tab.
If True, allows integration between the Metasys
system and the IP field controller.
Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.
Contains a unique reference name for the object
that is the full path name of the object through
the All Items navigation tree using the unique
identifier you specified when you manually created
the object.
Specifies the time in milliseconds between BACnet
object polls for attribute values. The polls start at
the time specified in the Periodic Update attribute.
As the Poll Delay increases, the overall time in the
Execution Time attribute increases. It is useful
to specify a Poll Delay on sites where the rate of
reading the remote objects causes too high a
burden on the Metasys network or third-party
device.
Recommended setting: high sensitivity: 20 seconds;
medium sensitivity: 60 seconds; low sensitivity: 120
seconds (default).

Version

1.0

Displays the version number of the object software
code.

Table 145: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name

Notes

Description

Abort Rcv

Contains the number of abort messages received. Aborts
occur in response to a number of situations, such as
communication or memory problems.

Abort Tx

Contains the number of abort messages sent.

Ack Rcv

Contains the number of complex acknowledgment
messages received.

Ack Tx

Contains the number of complex acknowledgment
messages sent.

Allocated Record Count

Indicates the number of state machines that have been
allocated.

Clear Statistics

W

Clears the statistics for the integrated BACnet Protocol
network.

Conf Req Rcv

Contains the number of confirmed request messages
received.

Conf Req Tx

Contains the number of confirmed request messages sent.

Error Rcv

Contains the number of error messages received. An
example of an error is an attempt to rite to a read-only
attribute.
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Table 145: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name

Notes

Error Tx
Latch Statistics

Description
Contains the number of error messages sent.

W

Updates the displayed statistics with the current values.

Local Abort Tx

Contains the number of application layer abort messages
generated locally (for example, messages that used up
all allowed retries and did not get an acknowledge from
the remote device).

Net Messages Rcv

Contains the number of messages received at the network
layer.

Net Messages Tx

Contains the number of messages transmitted at the
network layer.

Net Rejects Rcv

Contains the number of reject messages received at the
network layer.

Net Routed Messages

Contains the number of messages routed through the
network layer from one network (for example, IP) to
another (for example, MS/TP).

Net Routes Busy

Contains the number of messages not sent because the
network route is busy or not initialized.

Net Unknown Message Rcv

Contains the number of unknown messages received at
the network layer.

Net Unknown Routes

Contains the number of messages not sent due to
unknown route information.

Peak Pending Queue
Count

Indicates the largest number of client requests that were
queued for transmission.

Peak Unknown Queue
Count

Indicates the largest number of client requests the
unknown queue contained at one time.

Pending Queue Count

Indicates the number of client requests currently queued
for transmission.

Rcv Messages Discarded

Indicates the number of messages received from the
network that were not processed due to lack of resources
or because there were too many requests for the Metasys
Engine to process.

Rcv Message Rate

Indicates the number of messages received in the last
minute.

Rcv Record Count

Indicates the number of active state machines currently
in use for receipt of requests from other BACnet devices
(that is, the number of requests being processed at this
moment).

Record Count

Indicates the number of active state machines holding
information on pending messages.

Reject Rcv

Contains the number of reject messages received. Rejects
occur in response to a variety of communication problems
much like aborts and errors.

Reject Tx

Contains the number of reject messages sent.
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Table 145: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name

Notes

Description

Req Retries Tx

Contains the number of confirmed request messages resent due to timeout.

Reset Date

Indicates the date of the last Clear Statistic command.

Reset Time

Indicates the time of the last Clear Statistic command.

Seg Ack Rcv

Contains the number of segmented complex
acknowledgement messages received.

Seg Ack Tx

Contains the number of segmented complex
acknowledgement messages sent.

Seg Conf Req Rcv

Contains the number of segmented confirmed request
messages received.

Seg Conf Req Tx

Contains the number of segmented confirmed request
messages sent.

Seg Retries Tx

Contains the number of segmented confirmed request
messages re-sent due to timeout.

Segment Ack Rcv

Contains the number of segment acknowledgment
messages received.

Segment Ack Tx

Contains the number of segment acknowledgment
messages sent.

Segment Rcv

Contains the number of segment messages received.

Segment Tx

Contains the number of segment messages sent.

Simple Ack Rcv

Contains the number of simple acknowledgment messages
received.

Simple Ack Tx

Contains the number of simple acknowledgment messages
sent.

Transaction Timeouts

Indicates the number of MS/TP Postpone messages
sent due to a late reply to a received Confirmed Request
message (that is, this device’s applications could not
process the request before a low-level MS/TP answer was
required).

Transmits Per Minute

Displays the calculated number of transmissions per
minute.

Tx Messages Discarded

Indicates the number of client requests aborted due to lack
of resources. Usually, this situation occurs due to memory
issues in the controller.

Tx Record Count

Indicates the number of active state machines currently in
use for transmission of client requests.

Unconfirmed Rcv

Contains the number of unconfirmed messages received.

Unconfirmed Tx

Contains the number of unconfirmed messages sent.

Unknown Queue Count

Indicates the number of current client requests that need
network address resolution.
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BACnet Protocol Engine Commands
The following table lists the commands supported by the BACnet Protocol Engine Object.
Table 146: BACnet Protocol Engine Commands
Command Name

Parameters

Description

Clear Statistics

None

Resets all of the attributes containing diagnostic
statistics.

Latch Statistics

None

Updates the displayed statistics with the current
values.

BACnet Device Object
The BACnet Device object defines a standardized BACnet object with attributes that represent the
external, visible characteristics of a device. Only one device object exists in each BACnet Device.
Notes:
•

The Johnson Controls network engine device object includes attributes and methods
not required by the BACnet Device object. For information on the network engine device
object, see the Engine Device Object section.

•

The Object Type for this object is labeled Non-FEC BACnet Device in the software.

BACnet Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter D
indicate the default attribute for the display.
Table 147: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name
Alarm State

Notes

Initial Value

Description
Indicates the current state of the object.

Align Intervals

W

False

APDU Retries

W

3

APDU Segment Timeout

W

4,000

Specifies whether clock-aligned periodic time synchronization is
enabled. If periodic time synchronization is enabled and the time
synchronization interval is a factor of an hour or a day (that is,
the value divides without remainder), then the beginning of the
period specified for time synchronization aligns to the hour or day,
respectively.
Indicates the maximum number of times that an Application
Protocol Data Unit (APDU) is retransmitted. The default value is 3.
If this device does not perform retries, then this attribute is zero. If
the value of this attribute is greater than zero, a nonzero value is
placed in the Device object APDU Timeout attribute.
Indicates the amount of time in milliseconds between
retransmissions of an APDU segment. This value is nonzero if
APDU Retries is nonzero. The APDU Segment Timeout attribute is
present if segmentation of any kind is supported.
In order to achieve reliable communication, the values of the
APDU Segment Timeout attributes of the Device objects of all
intercommunicating devices should contain the same value.
Note: If segmentation of any kind is supported, this attribute
is required.
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Table 147: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name
APDU Timeout

Notes

Initial Value
See next
column

Description
Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgement for which
no acknowledgement has been received. This value is nonzero if
APDU Retries is nonzero.
In order to achieve reliable communication, the values of the APDU
Timeout attributes of the Device objects of all intercommunicating
devices should contain the same value.
The default is 6,000 milliseconds for devices that permit
modification of this attribute. The default value is 60,000
milliseconds for all other devices.
Contains a list of BACnet COV Subscriptions, each of which
consists of a Recipient, a Monitored Property Reference, an Issue
Confirmed Notifications flag, a Time Remaining value, and an
optional COV Increment. This attribute provides a network-visible
indication of those COV subscriptions active at any given time.
Whenever a COV Subscription is created with the Subscribe COV or
Subscribe COV Property service, a new entry is added to the Active
COV Subscriptions list. Similarly, whenever a COV Subscription is
terminated, the corresponding entry is removed from the Active
COV Subscriptions list.

Active COV Subscriptions

Note: If the device supports execution of either Subscribe
COV or Subscribe COV Property service, this attribute is
required.
Alarm State
Appl SW Version

Backup Fail Timeout

11

W

120

Indicates the current status of the object. The expected state is
Normal.
Identifies the version of the application software installed in the
device. The content of this string is locally defined (date-and-time
stamp, a programmer’s name, a host file version number, and so
on).
Indicates the number of seconds that the device being backed
up or restored waits before unilaterally ending the backup or
restore procedure. This attribute is writable (the device performing
the backup, or the operator, configures this with an appropriate
timeout).
Units = Seconds
Identifies the files within the device that determine what device
image can be backed up. The contents of this attribute are only
required to be valid during the backup procedure. If the device
supports the BACnet backup and restore procedure, this attribute
is supported.

Configuration Files

Note: If the device supports the backup and restore
procedures, the Configuration Files and Last Restore Time
attributes are required.
Database Revision

Description

W

Device Addr Binding

W
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Specifies a logical revision number for the device’s database.
Database Revision is incremented when an object is created or
deleted, an object name changes, or a restore is performed.
Contains a string of printable characters used to describe
the application being run by the device or other descriptive
information.
Unrestricted range.
Contains a list of BACnet Object Identifiers of a BACnet Device
object and a BACnet device address in the form of a BACnet
Address. Entries in the list identify the actual device addresses
that are used when accessing the remote device through a BACnet
service request. The list may be empty if no device identifier-device
address bindings are currently known to the device.
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Table 147: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name
DST Status

Notes
W

Graphic

C,W

Graphic Alias

C,W

Interval Offset

C,W

Initial Value

0

Last Restore Time

Description
Indicates whether daylight saving time (DST) time is in effect (True)
or not (False).
True, False
Indicates the graphic associated with the object.
Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this object or the
controller containing this point. Maximum 256 characters
Specifies the offset, in minutes, from the beginning of the
period defined for time synchronization until the actual time
synchronization requests are set. Interval Offset has no effect
when Align Intervals is False. Units = Minutes
Specifies when the device’s image was last restored. If the device
supports the BACnet backup and restore procedures, this attribute
is supported.
Note: If the device supports the backup and restore
procedures, the Configuration Files and Last Restore Time
attributes are required.

List of Session Keys

Local Date

W

Local Time

W

Location

W

Manual Time Sync Type

C,W

Contains a list of the cryptographic keys used to communicate
with other security-conscious BACnet Devices. This attribute is not
readable or writable by any device except a device designated the
Key Server. A session key consists of a 56-bit encryption key and a
BACnet Address of the peer with which secure communications is
requested.
Indicates the date. If the device has no knowledge of time or date,
Local Date is omitted.
Indicates the time of day. If the device has no knowledge of time or
date, Local Time is omitted.
Indicates the physical location of the device.
Automatic

Max APDU Length

Max Info Frames

Configures the type of BACnet Time Synchronization to send to a
BACnet device.
•

UTC: UTC time synchronization message is sent.

•

Local: A local time synchronization message is sent.

•

None: No message is sent.

•

Auto: The mapper object's Protocol Services Supported
attribute is used to determine which type of time sync is
supported, and if:
•
utcTimeSynchronization is set, the code functions as if
Time Sync Type is set to UTC.
•
utcTimeSynchronization is not set and
timeSynchronization is set, local time is set.
•
neither utcTimeSynchronization nor
timeSynchronization is set, an error is returned.

Specifies the maximum number of octets contained in a single,
indivisible application layer protocol unit. Underlying data link
technology constrains the value of this attribute.
10 (FEC)
20 (NxE)

Greater or equal to 50
Specifies the maximum number of information frames the node
may send before it passes the token. This attribute is present if the
device is a node on an MS/TP network. If Max Info Frames is not
writable or otherwise user configurable, its value is one.
Note: If the device is an MS/TP master node, both the Max
Info Frames and Max Master attributes are required.
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Table 147: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name
Max Master

Notes

Initial Value
127

Description
Specifies the highest possible address for master nodes and is
less than or equal to 127. This is present if the device is a master
node on an MS/TP network. If Max Master is not writable through
BACnet services, its value is 127.
Note: If the device is an MS/TP master node, both the Max
Info Frames and Max Master attributes are required.

Max Segments Accepted
Model Name
Offline

False

Profile Name

Contains a string of characters that represents the name of the
object profile to which the object conforms. A profile name must
begin with a vendor identifier code in base-10 integer format,
followed by a dash. The vendor identifier code indicates the
organization that administers the remaining characters of the
profile name, and publishes and maintains the profile document
identified by the profile name. The vendor identifier does not need
to match the vendor identifier of the device in which the object
resides.
Indicates which standardized object types the device’s protocol
implementation supports. This attribute reflects the minimum
set of object types, but implementation often supports additional
standard and non-standard object types with their own set of
attributes. (The list of attributes supported for a particular object
may be acquired by use of the Read Property Multiple service with
an attribute reference of All.)
Indicates the minor revision level of the BACnet standard. This
starts at 1 and increases for each subsequent release.

Protocol Obj Support

Protocol Revision

Protocol Ser Support

Protocol Version

Restart Notification
Recipients

C,W

Segmentation

System Status

Indicates the maximum number of segments of an Application
Protocol Data Unit (APDU) accepted by the device.
Contains a name assigned by the vendor to represent the model of
the device.
Displays the offline or online status of connected hardware.

D
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If the Protocol Version attribute changes, this number reverts to
zero. This attribute is required for all devices with BACnet Protocol
Version 1, Protocol Revision 1 and above. If this attribute is not
present, the device is Protocol Version 1, Protocol Revision 0.
Indicates which standardized protocol services the device’s
protocol implementation supports. This attribute reflects the
minimum set of services, but implementation often supports
additional standardized services.
Represents the BACnet protocol the device supports. Initial
releases are Version 1; subsequent releases increase the number
by one.
Controls the restrictions on which devices, if any, are notified
when a restart occurs. The value of this attribute is a list of BACnet
Recipients. When the length of this list is empty, the device
cannot send a device restart notification. The default value of
this property is a single entry representing a broadcast on the
local network. If the list has one or more entry, the device sends a
restart notification, but only to the devices or addresses listed.
Indicates if the BACnet device supports segmentation of messages.
If so, it supports segmented transmission, reception, or both.
Segmented Both, Segmented Transmit, Segmented Receive, No
Segmentation
Reflects the current physical and logical state of the device.
Operational, Operational Read Only, Download Required,
Download in Progress, Nonoperational, Backup in Progress
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Table 147: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name
Time Synchronization
Interval

Notes
C,W

Time Sync Recipients

W

Initial Value
0

Description
Specifies the periodic interval, in minutes, at which
TimeSynchronization and UTCTimeSynchronization requests are
sent. When set to zero, then periodic time synchronization is
disabled.
Controls the restrictions placed on a device’s use of the Time
Synchronization service. If the list is of length zero, a device is
prohibited from automatically sending a Time Synchronization
request. If the list is of length one or more, a device automatically
sends a Time Synchronization request but only to the devices
or addresses listed. If it is present, this attribute is writable. If
the PICS indicates that this device is a Time Master, then Time
Synchronization Recipients is present.
Note: If PICS indicates the device is a Time Master, this is
required. If present, this attribute is writable.

UTC Offset

W

UTC Time Synchronization C,W
Recipients

VT Classes Supported

Indicates the number of minutes offset between local standard
time and UTC. The time zones to the west of the zero degree
meridian are positive and those to the east are negative. Subtract
the value of the UTC Offset from the UTC received in the UTC Time
Synchronization service requests to calculate the correct local
standard time.
Range: -1440 though +1440
Lists one or more BACnet recipients to which the device can issue
a UTC Time Synchronization request. If the list is empty, the device
cannot send a UTC Time Synchronization request to a BACnet
recipient. The attribute requires several other parameters that
define each recipient, such as its device ID, IP address information,
or broadcast type and information.
Contains a list of BACnet Video Terminal (VT) Classes that indicate
a particular set of terminal characteristics. A device often supports
multiple types of behaviors for differing types of terminals or
differing types of operator interface programs. If either VT Classes
Supported or Active VT Sessions is present, then both are present.
Both are required if support of VT Services is indicated in the PICS.
Note: If either Video Terminal (VT) Classes Supported
or Active VT Sessions is present, both are present. If the
Protocol Implementation Conformance Statement (PICS)
indicates support for VT Services, both of these attributes are
present.

Vendor ID
Vendor Name
1

Distinguishes proprietary extensions to the protocol with a unique
ASHRAE vendor ID code.
Identifies the manufacturer of the device.

If the device supports the backup and restore procedures, this attribute must be present and writable.

BACnet Device Object Commands
The following table lists the commands supported by the BACnet Device Object.
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Table 148: BACnet Device Object Commands
Command Name

Parameters

Description

Rediscover Text
Strings

None

Resets the States Text across a supervisory device by
rediscovering text strings from all mapped BACnet objects.
Note: When the Rediscover Text Strings command is sent from
the Site Director device UI to another supervisory device and
the UI is running on the supervisory device, you must close and
restart the UI on the supervisory device in order for the text to
appear correctly.

Reset Field Device Type: Cold
Start or
Warmstart
Password

Resets the BACnet device.

Sync Field Device
Times

Sends a high-priority time synchronization command to child
devices, based on the device mapper object's Manual Time
Sync Type.

None

IP Field Controller Object
The IP Field Controller object defines a standardized BACnet object with attributes that represent
the external, visible characteristics of a device. Only one Device object exists in each IP Field
Controller. The IP Field Controller object appears as a child of a BACnet Integration object.

IP Field Controller Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable.
Table 149: IP Field Controller Object Attributes - Focus/Configuration Tab
Attribute Name
JCI System Status

Notes

Alarm State
Enabled

C,W

Initial Value
Operational

Description
Reflects the current status of the system.

Offline

Indicates that the object transitioned into alarm or
unreliable conditions.
If True, allows integration between the Metasys
system and the IP field controller.
Displays True when a Control Sequence in the
device is currently in a test mode. When True, the
device is marked offline, although communication
with the device is acceptable.
Indicates whether the IP field controller is offline.

True

In Test

False

Offline

True

Vendor Name

W

Identifies the manufacturer of the device.

Model Name

W

Indicates the product code for the device.

Startup Code Version

Fixed Boot Version

Pcode
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Specifies the version of the Startup code running in
the controller. The Startup code is responsible for
initial power up operations.
Indicates the version of the Boot code in the field
device. The Boot code is responsible for loading the
Main code.
Displays the device orderable product code.
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Table 149: IP Field Controller Object Attributes - Focus/Configuration Tab
Attribute Name
Location

Notes
W

COV Min Send Time

Initial Value

Description
Indicates the physical location of the device.

15 seconds

Local Time

W

Local Date

W

UTC Offset

C

Configures the object to send COV messages on a
periodic basis instead of on every change of value
that exceeds the COV Increment.
*.*.*.0 (HH:MM:SS AM/ Indicates the time of day. If the device has no
PM)
knowledge of time or date, Local Time is omitted.
Unspecified
Indicates the date. If the device has no knowledge
of time or date, Local Date is omitted.
0 minutes
Indicates the number of minutes offset between
local standard time and UTC. The time zones to the
west of the zero degree meridian are positive and
those to the east are negative. Subtract the value
of the UTC Offset from the UTC received in the UTC
Time Synchronization service requests to calculate
the correct local standard time.
False
Indicates whether daylight saving time (DST) time
is in effect (True) or not (False).
Object Name:
Indicates the graphic associated with the object.

DST Status
Graphic

C,W

Graphic Alias

C,W

Reference:

Item Reference

Version

1.0

Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.
Contains a unique reference name for the object
that is the full path name of the object through
the All Items navigation tree using the unique
identifier you specified when you manually created
the object.
Displays the version number of the object software
code.

Table 150: IP Field Controller Object Attributes - Diagnostic Tab
Attribute Name
CPU Usage

Initial Value
0.0%

Flash Usage

0.0%
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Description
Specifies a running average of CPU usage over the last
50 minutes. The value is updated every 30 seconds. The
running average is calculated by adding or subtracting
1% of the difference between the current and average
CPU usage. The value may not be meaningful until 50
minutes after a system restart. A value of 0% means
the CPU is 100% idle. A value of 100% means the CPU
is 0% idle. A value of 50% or less is considered OK,
although other performance indicators should also be
assessed. Under device simulation, the value is 0.
Specifies the estimated percent of flash memory
currently in use. The percentage is based on the
portion of flash that is designated for use by the user’s
database. The value is updated on device startup,
after a database archive, sync or download from the
SCT (offline mode), and by manual command (Update
Flash Usage). A value greater than 100% can affect
system reliability now or in future software releases.
No restrictions are in place to prohibit use of flash over
100%.
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Table 150: IP Field Controller Object Attributes - Diagnostic Tab
Attribute Name
Memory Usage

Initial Value
0.0%

Description
Specifies the percent of system RAM that is currently in
use. It is calculated as follows:
Total commit charge x 100
Display Precision = 0.01

Object Memory Usage

0.0%

COV Increment = 0.1
Specifies the percent of the object database that
is currently in use. Each object created consumes
memory within the object database. This attribute
can be used to help determine the device’s capacity
for additional objects; however, other performance
indicators should also be assessed. Generally, the
number of objects you define determines the object
memory usage. This attribute is valid on the Engine
hardware and under device simulation.
Note: If you have a large number of objects,
the object memory usage increases and
the archive.moi file size increases also. The
archive.moi file is stored in flash memory.
Also, an attempt to create an object known to require
X bytes of object database may fail even if more than
X bytes are available in the object database. This is
because the object database is composed of multiple
blocks. If the free space of each block is fewer than
X bytes, the request for X bytes fails even though the
sum total of free space from all blocks is greater than X
bytes.

Object Count

0

Has Unbound References

False

Indicates the number (count) of all of the object
instances within the device. Objects of all classes are
included.
Lists references that are not bound in the system.
This attribute indicates that a process cannot find an
object either because the device on which the object is
located is offline, the object has been deleted, or the
object reference is incorrect.

Ethernet IP Datalink Object
The Ethernet IP Datalink object manages the Ethernet communications bus and the messages
transmitted on it. By working with this object, you can access Ethernet card statistics.
For general information on Metasys system objects, see the Object Help section.

Ethernet IP Datalink Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. The set of attributes varies based on the version
of the network engine. For example, a network engine at Release 11.0 on a BACnet site has a set
of Status and BACnet attributes that do not apply to a network engine at Release 10.1 or earlier.
Attributes that are marked with a letter C are configurable and attributes marked with the letter W
are writable.
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Table 151: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Address
Length
APDU Length
or
Max APDU
Length

C,W

APDU Retries

C,W

Initial
Value

Description

6

Indicates the number of octets for the device address (Data
Link Address).

1024

Indicates the maximum number of bytes that may be
contained in a single, indivisible application layer protocol
data unit (APDU). Units = bytes
Note: If you write the value of this attribute, you must reset
the Engine for the new settings to take effect.

APDU Segment C,W
Timeout

4

Indicates the maximum number of times that an APDU is
retransmitted. If the device does not perform retries, it is set
to zero. If this value is greater than zero, a non-zero value
appears in the APDU Timeout attribute.

10000

Indicates the amount of time in milliseconds between
retransmission of an APDU segment. This value is non-zero
if the device supports segmentation of transmitted APDUs.
Units = milliseconds
Note: At Metasys Release 10.0 and later the default value is
10,000. In earlier releases, the default value is 4,000.

APDU Timeout C,W

10000

Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received.
Units = milliseconds
1,000–65,535
Note: At Metasys Release 10.0 and later the default value is
10,000. In earlier releases, the default value is 6,000.

BACnet IP
Mode

BBMD IP
Mode

Indicates whether the network port object is in use by the
BBMD. Possible values: Normal IP Mode or BBMD IP Mode.

BACnet IP UDP
Port

47808

Indicates the IP UDP Port number that the device uses to
transmit and receive messages.

BACnet UDP
Port

47808

Indicates the UDP Port number that the device uses to
transmit and receive messages.

False

Determines whether a BBMD is allowed to register foreign
devices, either True or False. If you change this value,
you must activate it with the Activate Changes > Update
Changes Pending Attributes Except Network Number
command to the Engine. The change is updated immediately
online but it is not fully applied until you activate the change.

BBMD
Accept F.D.
Registrations

C,W

BBMD
Broadcast
Distribution
Table

C,W

Specifies a list of BBMDs on the building network by IP
address or hostname. The hostname must be in the DNS
table of the DNS server in order to be resolved. If you
change this value, you must activate it with the Activate
Changes > Update Changes Pending Attributes Except
Network Number command to the Engine.
Note: Do not edit this table if Dynamic Broadcast Management is set to False in the Site object.
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Table 151: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Initial
Value

Description

BBMD Foreign
Device Table

Specifies a list of any foreign devices registered with the
BBMD and described in the sequence of IP address, time to
live, and remaining time to live.

Broadcast
Address

Indicates the address used when sending broadcast
messages. Maximum length = 6 octets

Changes
Pending

False

Indicates whether a change to a network port object
attribute has yet to be activated. Possible values: True or
False. If True, issue an Activate Changes command to the
network engine.

Command

Idle

Indicates the BACnet command specific to the network port
object. Possible values: Idle or Discard Changes. Discard
Changes discards any pending changes to the network port
object.

1001

Indicates the BACnet network number configured for the
data link.

Configured
Network
Number

C,W

Device Address

Indicates the address of the device (Data Link Address).
Maximum length = 6 octets

DNS Refresh
Period

C,W

20

Specifies the time in minutes between DNS lookups to
update the IP address of a BACnet Broadcast Management
Device (BBMD) referenced by host name. If an IP address
is changed within a DNS server, the BBMD system
automatically obtains the new IP address upon the
expiration of this period. A value of 0 is used to disable
periodic DNS lookups.

Internode
Comm Timer

C,W

120

Controls the frequency of communication with IP devices
over the Ethernet. Among other communications, this
attribute defines the frequency of the heartbeat to
monitored devices (monitored at a rate of two times the
Internode Comm Timer). Recommended settings: high
sensitivity: 30 seconds; medium sensitivity: 120 seconds
(default); low sensitivity: 240 seconds.
Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

IP Address

Indicates the currently assigned IP address of the network
engine.

IP Default
Gateway

Indicates the IP address of the network engine's default
gateway.

IP DHCP
Enable

Indicates whether the network engine is set for DHCP or
static IP address assignment. Possible values: True or False.

IP DNS Server

C,W

IP Subnet
Mask
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Lists the DNS server(s) assigned to the network engine.
Indicates the currently assigned IP subnet mask address of
the network engine.
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Table 151: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Initial
Value

Description

JCI Network
Port APDU
Retries

C,W

4

Indicates the maximum number of times that an APDU is
retransmitted. If the device does not perform retries, it is set
to zero. If this value is greater than zero, a non-zero value
appears in the APDU Timeout attribute.

JCI Network
Port APDU
Segment
Timeout

C,W

10000

Indicates the amount of time in milliseconds between
retransmission of an APDU segment. This value is non-zero
if the device supports segmentation of transmitted APDUs.
Units = milliseconds

JCI Network
Port APDU
Timeout

C,W

10000

Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received.
Units = milliseconds
1,000–65,535

JCI Network
Port Type

Indicates the type of port in use by the network engine.

Link Speed

Indicates the Ethernet link speed of the network engine.
Possible values: 1.0E8, 1.0E7, or 1.0E6.

MAC Address

Contains the unique hardware number that identifies the
network engine within a network.

Network
Number
Quality

Describes how the network number was acquired. Possible
values: Network Number Configured (always for NAE or
SNx), Network Number Learned/Configured, Network
Number Learned, Network Number Unknown.

Network Type

Indicates the type of network that the network engine is
using. Example: BACnet/IP over IPv4

Out of Service

De-couples the object from the physical input. When Out of
Service is True, the object decouples the Present Value and
Reliability from the hardware. The Reliability is writable when
Out Of Service is True. When de-coupled, the Present Value
can be changed to simulate specific conditions or for test
purposes.
Additionally, the Out of Service state of the Status Flags
attribute is set to True and the Fault state is decoupled from
the physical input when Out of Service is True.

Pending
Network
Number

Protocol Level
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1001

Indicates the BACnet network number that is currently
pending for configuring the datalink object. Once you
issue an Activate Changes command to the engine, the
Configured Network Number is set to the Pending Network
Number.
Indicates the protocol level of the engine. Example: BACnet
application
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Table 151: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Initial
Value

Description

Reliability

Indicates the current reliability of the integration. The
normal state is Reliable.

Status Flags

Indicates the general status of the object in BACnet terms
and contains four independent states.
The four selections are:
In Alarm—False if the Event State attribute value is Normal;
otherwise, the In Alarm flag is True. (Set only by BACnet
Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is not reliable;
otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the Present Value is
overridden from the hardware source level.
Out of Service—Out of Service flag is True if the Out of
Service attribute value is True; otherwise, the Out of Service
flag is False.

Table 152: Ethernet IP Datalink Attributes - Diagnostic Tab
Attribute Name Data Type

Description

Broadcast
Receives

Number

Indicates the number of broadcast messages received.

Broadcast
Transmits

Number

Indicates the number of broadcast message transmissions.

Discarded
Frames

Number

Indicates the count of received messages discarded due to
critical low resources (that is, the System Memory Resource,
Object Engine Queue Resource, or Protocol Engine Input Queue
Resource).

Message
Receives

Number

Indicates the number of messages received.

Message
Transmits

Number

Indicates the number of message transmissions.

Reset Date

Date

Indicates the date of the last Clear Statistics command.

Reset Time

Time

Indicates the time of the last Clear Statistics command.

Retry Attempts

Number

Indicates the number of retry attempts.

Transmit
Failures

Number

Indicates the number of message transmit failures.

MS/TP Field Device Object
The MS/TP Field Device object is used to represent FEC family MS/TP devices on the MS/TP Field
bus. The MS/TP Field Device object appears as a child of an MS/TP Field Bus Integration object.
Note: The Object Type for this object is labeled FEC Family BACnet Device in the software.
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Supported Controllers
The Field Device object supports these MS/TP controllers:
•

CGMs

•

CVMs

•

VMA16s

•

IOMs

•

FECs

•

FACs

MS/TP Field Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter D
indicates the default attribute for the display.
Table 153: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial
Value

Alarm State

Description
Indicates the current state of the object.

COV Min Send Time

W

15

Configures the object to send COV messages on a
periodic basis instead of on every change of value
that exceeds the COV Increment.

Enabled

CW

True

If True, allows communication between the
Metasys system and the MS/TP controller.

False

Indicates whether the device is at the end of the
bus.

End of Line
Fixed Boot Version

Indicates the version of the Boot code in the field
device. The Boot code is responsible for loading
the Main code.

Graphic

CW

Indicates the graphic associated with the object.

Graphic Alias

CW

Indicates a portion of the graphic’s item
reference, up to and including the name of the
folder containing this object or the controller
containing this point.

In Test

Displays True when a Control Sequence in the
device is currently in a test mode. When True, the
device is marked offline, although communication
with the device is acceptable.

JCI System Status

Reflects the current status of the system.

Location

Indicates the physical location of the device.
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Table 153: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Manual Time Sync Type CW

Initial
Value

Description

Automatic Configures the type of BACnet Time
Synchronization to send to a BACnet device.
•

UTC: UTC time synchronization message is
sent.

•

Local: A local time synchronization message
is sent.

•

None: No message is sent.

•

Auto: The mapper object's Protocol Services
Supported attribute is used to determine
which type of time sync is supported, and if:
- utcTimeSynchronization is set, the code
functions as if Time Sync Type is set to
UTC.
- utcTimeSynchronization is not set and
timeSynchronization is set, local time is
set.
- neither utcTimeSynchronization nor
timeSynchronization is set, an error is
returned.

Model Name

Indicates the product code for the device.

Offline

Indicates whether the MS/TP controller is offline.

Pcode

Displays the device orderable product code.

Present Value

D

Protocol Obj Supported
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Online

Indicates the current status of communication
with the field device (Online, Offline, or Comm
Disabled). A status of Comm Disabled indicates
that the field device has been disabled. A status
of Offline indicates that either communication
problems exist, or the field device is currently in
test mode.
Indicates which standardized object types the
device’s protocol implementation supports.
Protocol Conformance Class reflects the
minimum set of object types, but implementation
often supports additional standard and nonstandard object types with their own set of
attributes. (The list of attributes supported for
a particular object may be acquired by use of
the ReadPropertyMultiple Web method with an
attribute reference of All.)
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Table 153: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial
Value

Description

Protocol Ser Supported

Indicates which standardized protocol services
the device's protocol implementation supports.
Protocol Conformance Class reflects the minimum
set of services, but implementation often supports
additional standardized services.

Startup Code Version

Specifies the version of the Startup code running
in the controller. The Startup code is responsible
for initial power up operations.

Vendor ID

Identifies the unique manufacturer’s identifier,
as defined by ASHRAE. For Johnson Controls, this
value is 5.

Vendor Name

Identifies the manufacturer of the device (should
be Johnson Controls).

Table 154: MS/TP Field Device Object Attributes - Diagnostic Tab
Attribute Name

Notes

Initial
Value

Values/Options/Range

CPU Usage

Specifies a running average of CPU use. The value
is updated every minute.

Flash Usage

Specifies the estimated percent of flash memory
currently in use. The percentage is based on the
portion of flash that is designated for use by the
user’s database. A value greater than 100% can
affect system reliability now or in future software
releases. There are no restrictions in place to
prohibit use of flash over 100%.

Has Unbound
References

Indicates that a process cannot find an object
either because the device on which the object is
located is offline, the object has been deleted, or
the object reference is incorrect.

Memory Usage

Specifies the percent of field device RAM currently
in use.
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Table 154: MS/TP Field Device Object Attributes - Diagnostic Tab
Attribute Name

Notes

Initial
Value

Values/Options/Range

Object Count

Indicates the number (count) of all of the object
instances within the device. Objects of all types
are included.

Object Memory Usage

Specifies the percent of the object database that
is currently in use. Each object created consumes
memory within the object database. This attribute
can be used to help determine the device’s
capacity for additional objects; however, other
performance indicators should also be assessed.
Also, an attempt to create an object known to
require X bytes of object database may fail even
if more than X bytes are available in the object
database. This is because the object database
is composed of multiple blocks. A free space
block of at least X contiguous bytes available for
allocation may not exist, even if the total free
space is more than X bytes.

LON Controller Object
The LON Controller object defines attributes that represent the external, visible characteristics of a
device residing on a LonWorks network.
Note: The LON Controller object is not available for network engines updated to Release 9.0.7
or later.

LON Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, attributes marked with the letter C are configurable and attributes
marked with the letter W are writable.
Table 155: LON Controller Object Attributes - Focus/Configuration Tab
Attribute Notes
Name

Initial
Value

Description

Enabled

C,W

True

If True, allows integration between the Metasys system and the
LON controller.

Graphic

C,W

Indicates the graphic associated with the object.

Graphic
Alias

C,W

Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this object or the
controller containing this point.

Offline

False
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Displays the offline or online status of connected hardware. The
LonWorks network server updates this attribute value.
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Table 155: LON Controller Object Attributes - Focus/Configuration Tab
Attribute Notes
Name

Initial
Value

Description

Present
Value

Offline

Displays the communication status of the object.

XIF
Present

Indicates whether a XIF file matching this controller’s Program
ID was found.

Table 156: LON Controller Object Attributes - Diagnostic Tab
Attribute Name Notes

Initial Value

Command Count

Description
Displays the total number of commands sent to this
controller.

Error Log

NOERROR

Shows the error log according to the last standard
LonWorks network Query Status message.

Lost Message

0

Shows the number messages lost according to
the last standard LonWorks network Query Status
message.

Missed
Messages
Neuron Model

Shows the number messages missed according to
the last standard LonWorks network Query Status
message.
Neuron_3150

Node State

Shows the Neuron model according to the last
standard LonWorks network Query Status message.
Shows the state of the node according to the last
standard LonWorks network Query Status message.

Offline Poll
Count

0

Displays the total number of times this controller was
sent a poll while offline.

Receive
Transaction Full

0

Shows the number of times the transaction full
message appeared in the last standard LonWorks
network Query Status message.

Reset Cause

Clear

Shows the cause of the last reset according to the
last standard LonWorks network Query Status
message.

Reset Date

Contains the date stamp of the last local Neuron
statistics reset command.

Reset Time

Contains the time stamp of the last local Neuron
statistics reset command.

Total Messages
to Device

0

Displays the total number of messages sent to this
controller.

Total Single
Message Failures

0

Displays the total number of failures for single
messages sent to this controller.

Transaction
Timeouts

0

Shows the timeouts that appeared in the last
standard LonWorks network Query Status message.
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Table 156: LON Controller Object Attributes - Diagnostic Tab
Attribute Name Notes

Initial Value

Description

Transmit Errors

0

Shows the number of transmit errors that appeared
in the last standard LonWorks network Query Status
message.

Version Number

0

Shows the version number according to the last
standard LonWorks network Query Status message.

LON Controller Commands
The following table lists the commands supported by the LON Controller Object.
Table 157: LON Controller Commands
Comman
d Name

Paramete Description
rs

Clear
Statistics

None

Resets the statistics for the integrated LonWorks network. The contents
of the Query Status message reflect these statistics:
•

Transmit Errors

•

Transaction Timeouts

•

Receive Transaction Full

•

Lost Message

•

Reset Cause

•

Node State

•

Version Number

•

Error Log

•

Neuron Model

Disable

None

Disables the entire LonWorks network integration. No requests are made
to the field trunk and no data broadcasts to the network are processed.

Enable

None

Allows the integration to function normally.

Latch
Statistics

None

Resets the statistics for the integrated LonWorks network. The contents
of the Query Status message reflect these statistics:
•

Transmit Errors

•

Transaction Timeouts

•

Receive Transaction Full

•

Lost Message

•

Reset Cause

•

Node State

•

Version Number

•

Error Log

•

Neuron Model

Metasys Site Management Portal Help

319

N2 Controller Object
The N2 Controller object defines a physical device such as a DX-9100, VMA, or UNT controller on the
N2 Bus of the NAE and is required for mapping data from the controller into the system. The N2
Controller object monitors the device and reports online/offline transitions. This object also allows
you to access information about the N2 controllers.

N2 Controller Concepts
Supported Controllers
This table lists all N2 controllers supported by the system.
Metasys Integrator units, VAV, UNT, and AHU controllers are supported at all revision levels.
Table 158: Supported Controllers
Device/
Controller Type

Revision

Protocol Type Comments

DR-9100

Rev 1.x - 2.x

Sys91

Room Controller

DR-9101

Rev 2.x

Sys91

Room Controller

DC-9100

Rev 1.x - 2.x

Sys91

Plant Controller

DO-9100

Rev 1.x

Sys91

Digital Optimizer

DX-9100 (V.1)

Rev 1.x

Sys91

Digital Controller

DX-9100 (V.2)

Rev 2.x

Sys91

Digital Controller

TC-9100
TC-9102
TC-9109

Rev 1.x - 3.x

Sys91

Temperature Controller

XT-9100

Rev 1.x

Sys91

Extension Module

XTM-101

Rev 1.x

Sys91

Extension Module

XTM-105

Rev 1.x

Sys91

Extension Module

XTM-905

Rev 1.x

Sys91

Extension Module

LCP-100

Revs all

Sys91

Lab and Central Plant Controller

Metasys
Integrator Unit

Revs all

N2 Open

Metasys Integrator Unit

UNT

Revs all

N2 Open

Unitary Controller

VAV

Revs all

N2 Open

Variable Air Volume Controller

AHU

Revs all

N2 Open

Air Handling Unit Controller

PHX

Revs all

N2 Open

Phoenix Interface Module

VMA (VMA14)

Revs all

N2B

VAV Modular Assembly

VND

N2 Open

Metasys Compatible Vendor Devices (by
others)

ILC

N2 Other

Intelligent Lighting Controller

N2 Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 159: N2 Controller Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Description

Graphic
Graphic Alias

C,N,W
C,W

Indicates the graphic associated with the N2 controller.
Indicates a portion of the graphic’s item reference, up to and including the name
of the folder containing this N2 controller.
Indicates if the NAE is or is not currently communicating with this N2 controller.

D

Represents the current communication state of the object.

Offline
Present Value

N2 Controller Commands
The table below lists the commands supported by the N2 Controller Object.
Table 160: N2 Controller Commands
Command
Name

Description

Disable

Puts the controller offline and leaves it offline (Comm. Disabled).

Enable

Brings the controller from the offline state to the online state (Comm. Enabled).

VND Controller
The VND (Vendor) Controller object defines a physical vendor device on a bus of the NAE and is
required for mapping data from the controller into the system.

VND Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 161: VND Controller Attributes - Focus/Configuration Tab
Attribute Name
Enabled

Note
C,W

Initial Value
True

Graphic

C,N,W

Null

Graphic Alias

C,W

Offline
Present Value

True
D
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Values/Options/Range Attribute Description
If True, allows communication to the vendor
device. If False, prevents communication to the
vendor device.
Object Type = Graphic
Indicates the graphic associated with the vendor
device.
Maximum 256 characters Indicates a portion of the graphic’s item
reference, up to and including the name of the
folder containing this vendor device.
Displays the offline or online status of connected
hardware.
Offline, Online, Pass
Represents the current communication state of
Through, Comm
the object.
Disabled, Comm Enabled
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Table 162: VND Controller Attributes - Diagnostic Tab
Attribute Name

Notes

11

Initial Value

Count

0

Errors In

0

Errors Out

0

Message Receives

0

Message Transmits

0

Values/Options/Range Attribute Description

Reset Date
Reset Time
Transmits In

0

Transmits Out

0

1

Displays the number of point objects defined for
the vendor device.
Indicates the number of field communication
errors (bad format, for example) received. The
Clear Statistics command resets this value.
Indicates the number of field communication
attempts that failed. The Clear Statistics command
resets this value.
Indicates the number of messages received by
the vendor device. This value resets to zero at
midnight. The Latch Statistics command updates
this value.
Indicates the number of messages sent to
the vendor device. This value resets to zero at
midnight. The Latch Statistics command updates
this value.
Contains the date stamp of the last Clear Statistics
command.
Contains the time stamp of the last Clear Statistics
command.
Indicates the rate of transmissions received by the
vendor device.
Indicates the rate of transmissions sent by the
vendor device.

C - Configurable, W - Writable

VND Controller Commands
The table below lists the commands supported by the VND Controller.
Table 163: VND Controller Object Commands
Command Name

Parameters

Description

Clear Statistics

None

Resets the statistics for the vendor device.

Disable

None

Disables the vendor device.

Enable

None

Allows the vendor device to function normally.

Latch Statistics

None

Updates the displayed statistics with the current
values.

Wireless Receiver Object
The Wireless Receiver object is the field device of the Wireless Sensor integration. The Wireless
Receiver object establishes communication with the wireless receiver hardware.
All integrated wireless field devices (Wireless Receiver objects) and field point objects (Wireless
Sensor Object) appear under the Wireless Receiver Supervisor Object in the Navigation Tree.
Note: The Wireless Receiver object not available for network engines updated to Release 9.0.7
or later.

Wireless Receiver Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
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object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 164: Wireless Receiver Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Initial
Value

Values/Options/
Range

Attribute Description

Disable
Automatic
Alarming

C,W

False

False
True

Specifies whether automatic online/
offline device event reporting is
disabled (True) or enabled (False). This
attribute only applies to the device and
not to the device’s mapped objects.
Devices with the Disable Automatic
Alarming attribute set to True suppress
the alarm event but still indicate they
are offline in the navigation tree with
a red X. Alarm extensions are not
affected by this attribute.

Graphic

C,W

Graphic Alias

C,W

Indicates the graphic associated with
the object.
Maximum 256
characters

Host Name

IP Address

Indicates a portion of the graphic’s
item reference, up to and including
the name of the folder containing this
object or the controller containing this
point.
Indicates the host name of the wireless
receiver. When a host name is given,
the system attempts to resolve the
Host Name and IP Address using DNS/
DHCP (assuming that the installer
assigned a host name to the wireless
receiver and enabled DHCP). If the
device can be located using the ping
hostname command, the system
can resolve the host name to an IP
address. After resolving the host name,
the system updates the IP address.

C,W

0.0.0.0
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xxx.x.x.xxx

Indicates the IP Address of the wireless
receiver.
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Table 164: Wireless Receiver Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Initial
Value

Values/Options/
Range

Low Battery

Attribute Description
Indicates if any wireless sensors
defined as children of the Wireless
Receiver object have a low battery.
The Low Battery status is an advanced
warning that can occur many days
before a wireless sensor ceases to
function. You can configure an alarm
for this attribute to allow the building
operator time to locate the sensor and
change the battery.

Max Data Life

C,W

Network
Address

C

150

Present Value

Range = 120–480
seconds

Indicates the maximum amount of
time in seconds that the wireless
receiver module waits for a
transmission from a wireless sensor
before generating a report that tells
the NAE that the Wireless Sensor
Object is unreliable due to Data Life
Timeout.

Range = 1–50

Indicates the network address of the
wireless receiver. You can define only
up to 50 wireless receivers per Wireless
Receiver Supervisor Object.

Uses Controller
Status (Set 43).

Indicates the online/offline state of the
wireless receiver.

Table 165: Wireless Receiver Object Attributes - Diagnostic Tab
Attribute Name

Notes

11

Initial Value

Date of
Manufacture
Firmware Version
Hardware Version
1

Values/Options/Range Attribute Description
mmyy

Indicates the date the wireless receiver was
manufactured.
Indicates the firmware version of the wireless
receiver.
Indicates the hardware version of the wireless
receiver.

C - Configurable, W - Writable

Wireless Sensor Object
There is a Wireless Sensor object in the field point object for each wireless temperature sensor
mapped to the NAE. The Wireless Sensor object receives communications from the wireless sensor.
All integrated wireless field points (Wireless Sensor objects) appear under the Wireless Receiver
Objects (field devices), which appear under the Wireless Receiver Supervisor Object in the
Navigation Tree.
Note: The Wireless Sensor object is not available for network engines updated to Release 9.0.7
or later.
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Wireless Sensor Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 166: Wireless Sensor Object Attributes - Focus/Configuration Tab
Attribute Name
Low Battery

Notes

Initial Value

Max Value

C,W

3.0

Values/Options/Range Attribute Description
Reliability from the
Indicates if any wireless sensors defined as
Reliability attribute.
children of the Wireless Receiver Objects have
a low battery. The Low Battery status is an
advanced warning that can occur many days
before a wireless sensor ceases to function. You
can configure an alarm for this attribute to allow
the building operator time to locate the sensor
and change the battery. The sensor sends a low
battery signal when there is 30 days of battery life
left.
Range = -10 to 100
Indicates the maximum value allowed for the
Setpoint. This is the value of the Setpoint attribute
Units from the Units
when the Setpoint adjust dial on the wireless
attribute.
sensor is in the fully clockwise position.
If the Min Value is greater than the Max Value, the
Setpoint is forced to the Min Value. Otherwise,
these attributes are all used to compute the
Setpoint with the following formula:

Min Value

-3.0

Range = -10 to 100
Units from the Units
attribute.

SP = [(Max Value - Min Value) x (dial position x
0.01)] + Min Value
Indicates the minimum value allowed for the
Setpoint. This is the value of the Setpoint attribute
when the Setpoint adjust dial on the wireless
sensor is in the fully counterclockwise position.
If the Min Value is greater than the Max Value, the
Setpoint is forced to the Min Value. Otherwise,
these attributes are all used to compute the
Setpoint with the following formula:

Occupancy Request C,W

Occupancy Status

Occupancy Time

Uses Unocc Occ (Set
106).

C,W

2
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Range = 2–240 minutes

SP = [(Max Value - Min Value) x (dial position x
0.01)] + Min Value
Represents an object reference to the Binary
Value object that represents the BV 0 Occupancy
Request object of the Zone Sensor device.
Changes to Occupied after pushing the
Temporary Occupied button on the Transmitter,
if supported by that model. The Occupied state
is held for the minutes defined by the Occupancy
Time attribute, or until cancelled by a release
command.
Indicates the time in minutes that the Occupied
Output (if defined) is overridden to the Occupied
state after pushing the Temporary Occupied
button on the Transmitter.
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Table 166: Wireless Sensor Object Attributes - Focus/Configuration Tab
Attribute Name
Occupied Output

Notes
C,N,W

Initial Value

Values/Options/Range Attribute Description
Provides an optional reference to a binary object
located anywhere on the Metasys network.
The binary object is commanded to Occupied/
Unoccupied when the Occupancy Status attribute
changes states.
The Present Value attribute of the referenced
object at the Priority Scheduling optimal start
(OST) priority writes to the output commands.
The Present Value attribute of the referenced
object at the Priority Scheduling OST priority
writes the None Data Type value to the release
commands.
These operations assume that the referenced
object is an output object that has a Present Value
that can be written to. Keep this in mind when
mapping objects from controllers. You would
normally map these points as input points (AI, BI,
MSI), but for proper operation you must map the
points as output points (AO, BO, MSO).

Offset

C,W

0

Range = +/- 3 degrees
Units from the Units
attribute.

Present Value

Property Code

C,W

1

Reliability Action

C,W

None

Setpoint

Units from the Units
attribute and reliability
from the Reliability
attribute.
Range = 1–31

Uses Reliability Action
(Set 14).

Units from the Units
attribute and reliability
from the Reliability
attribute.

Indicates the offset value that is added to the
zone temperature reading before updating
the Present Value, forcing the Present Value to
match a calibrated temperature measured at the
wireless sensor.
Indicates the zone temperature reading at the
wireless sensor.

Indicates the Property Code address of the
wireless sensor. This setting must match the
Property Code address switch setting of the
wireless temperature sensor.
Indicates the action taken on the three output
references ( Zone Temp Output, Setpoint Output,
and Occupied Output) when the wireless sensor
object goes Unreliable. The actions are No Action
or Release commands.
Indicates the Setpoint based on three variables:
the Setpoint Adjustment reading (the setpoint
adjust dial position) at the wireless sensor, the
Min Value, and the Max Value.
The wireless sensor model determines the
Setpoint Adjustment. Options include:
- None
- Warmer/Cooler (Range = +/- 5 Deg F)
- Remote Setpoint (Range = 55 to 85 Deg F/13 to
29 Deg C)
If the Min Value is greater than the Max Value, the
Setpoint is forced to the Min Value. Otherwise,
these attributes are all used to compute the
Setpoint with the following formula:
SP = [(Max Value - Min Value) x (dial position x
0.01)] + Min Value

326

Metasys Site Management Portal Help

Table 166: Wireless Sensor Object Attributes - Focus/Configuration Tab
Attribute Name
Setpoint Output

Notes
C,N,W

Initial Value

Values/Options/Range Attribute Description
Provides an optional reference to a temperature
Setpoint object located anywhere on the Metasys
network. The temperature Setpoint object is
commanded when the wireless sensor reports an
updated Setpoint value.
The Present Value attribute of the referenced
object at the Priority Scheduling OST priority
writes to the output commands.
The Present Value attribute of the referenced
object at the Priority Scheduling OST priority
writes the None Data Type value to the release
commands.
These operations assume that the referenced
object is an output object that has a Present Value
that can be written to. Keep this in mind when
mapping objects from controllers. You would
normally map these points as input points (AI, BI,
MSI), but for proper operation you must map the
points as output points (AO, BO, MSO).

Time Remaining

Units = Minutes

Transmitter Id

C,W

0

Range = 1–511

Units

C,W

Deg F

Uses Unit Set (Set 869).

Zone Temp Output C,N,W

Indicates the time remaining before the Occupied
Output (if defined) is released from the Occupied
state.
Indicates the sensor transmitter Id address of
the wireless sensor. This setting must match
the transmitter Id address switch setting of the
wireless sensor.
Indicates the engineering units displayed on the
user interface (Deg F or Deg C). All temperature
and Setpoint values convert to the proper units.
Provides an optional reference to a temperature
input object located anywhere on the Metasys
network. The temperature input object is
commanded when the wireless sensor reports an
updated Present Value.
The Present Value attribute of the referenced
object at the Priority Scheduling OST priority
writes to the output commands and writes the
None Data Type value to the release commands.
These operations assume that the referenced
object is an output object that has a Present Value
that can be written to. Keep this in mind when
mapping objects from controllers. You would
normally map these points as input points (AI, BI,
MSI), but for proper operation, you must map the
points as output points (AO, BO, MSO).
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Table 167: Wireless Sensor Object Attributes - Diagnostic Tab
Attribute Name
Initial Value
Missed Transmissions

Values/Options/Range

RF Quality

Rx Data Life Errors

Signal Strength

Units = Percent

Attribute Description
Indicates the number of wireless sensor transmissions
missed by the wireless receiver. The Wireless Receiver
Supervisor Object’s Clear Statistics command resets
this attribute.
Indicates the signal quality level with respect to
unwanted wireless noise or interference. This attribute
displays a number from 0 to 100. A number less than
50 indicates too much interference.
Indicates the diagnostic measure of the number of
Data Life detected by the receiver module. Data Life
errors occur when a wireless sensor does not report
its status to the wireless receiver before the Max Data
Life timer expires. The Wireless Receiver Supervisor
Object’s Clear Statistics command resets this attribute.
Indicates the wireless signal strength of the wireless
sensor as recorded by the wireless receiver module.

Wireless Sensor Commands
The table below lists the commands supported by the Wireless Sensor Object.
Table 168: Wireless Sensor Object Commands
Command Name

Parameters

Description

Release

None

Releases the effects of the Temporary
Occupancy button pressed at the wireless
sensor. This command resets the Time
Remaining attribute and releases any defined
outputs.

XL5K Controller Object
The XL5K Controller object (Honeywell Excel 5000 [XL-5000]) maps a C-Bus field device to the
Metasys system. The object contains pertinent addressing information.
Note: The XL5K Controller object is not available for network engines updated to Release 9.0.7
and later.

XL5K Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W Writable.
Table 169: XL5K Controller Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Enabled

C,W

True

Graphic

C,W
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Values/
Options/
Ranges

Attribute Description

If True, allows the controller to be integrated into
the Metasys system extended architecture.
Indicates the graphic associated with the object.
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Table 169: XL5K Controller Attributes - Focus/Configuration Tab
Attribute Name

Notes

Graphic Alias

C,W

Initial Value

Offline
Present Value

0 (Offline)

Values/
Options/
Ranges
Maximum 256
characters

Attribute Description

Indicates a portion of the graphic’s item
reference, up to and including the name of the
folder containing this object or the controller
containing this point.
Indicates the offline/online state of the
connected hardware.
Uses Controller Indicates the communication status of the
Status
device.

Table 170: XL5K Controller Attributes - Diagnostic Tab
Attribute Name
Error Percent

Initial Value

Values/Options/Ranges

Errors Today

Packets Today
Point Scan Time

Attribute Description
Indicates the computed error rate for communications
to the device using the following equation: (Errors
Today + Retries Today) / Number of Packets Today.
Indicates the number of transmissions (packets) since
midnight that had errors (for example, the data was
returned, but the data contained errors).
Indicates the number of transmissions (packets) since
midnight.
Indicates the total amount of time to scan for point
data from this controller.
Indicates the number of transmissions (packets) since
midnight where no response data was obtained,
causing the transmission to be retried.
Indicates the calculated number of transmissions per
minute.

Retries Today

Transmits Per Minute

XL5K Controller Commands
The table below lists the commands supported by the XL5K Controller Object.
Table 171: XL5K Controller Commands
Command Name

Parameters

Clear Statistics

None

Resets the statistics for the integrated XL-5000
network.

Disable

None

Disables the XL-5000 controller integration. No
requests are made to the field trunk for that
controller and all packets received from the
Honeywell field device are ignored.

Enable

None

Allows the integration to function normally.

Latch Statistics

None

Updates the displayed statistics with the current
values.

Field Point
Menu Selection: Insert > Field Point
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Inserts one of the following types of field points into a field device under an integration:
•

•

N2 Trunk
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO)

•

•

BACnet
All field points listed for the N2 trunk plus Analog Value Object (AV), Averaging Extensions,
Binary Value Object (BV), Calendar Object, Electric Demand Control Object, Electric
Demand Monitoring Object, Event Enrollment Object, Generator Load Control Object,
Group Object, Life Safety Point Object, Life Safety Zone Object, Multistate Value Object
(MV), Notification Class Object, Schedule Object, Trend Log

•

•

IP Field Controller
Analog Input Object (AI), Analog Output Object (AO), Analog Value Object (AV),
Accumulator Object, Binary Input Object (BI), Binary Output Object (BO), Binary Value
Object (BV), Calendar Object, Multistate Value Object (MV), Notification Class Object,
Schedule Object, Trend Log

•

•

MS/TP Field Bus Integration
Analog Input Object (AI), Analog Output Object (AO), Analog Value Object (AV),
Accumulator Object, Binary Input Object (BI), Binary Output Object (BO), Binary Value
Object (BV), Calendar Object, Multistate Value Object (MV), Notification Class Object,
Schedule Object, Trend Log

•

•

LON Trunk
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO), Generic Integration Object (GIO)
Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still
supported in existing databases, even after upgrading to the next software release.

•

•

N1 Migration
All field points listed for the N2 trunk plus Generic Integration Object (GIO) and N1 PID
Loop Object.

•

•

VND Integration (Vendor)
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO)

•

•

Wireless Supervisor Integration
Wireless Sensor Object

•

•

XL5K (Excel 5000/XL-5000) Integration
XL5K Integration Object

Tip: On the Select Definition Mode screen, select Assisted Point Definition to automatically
discover existing points on the network. Or on the Select Definition Mode screen, select
Manual Point Definition.
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Tip: Specifying the Instance Number for a field device point is different depending on if you
are defining the point online or offline with SCT. If you are inserting the point online, you
specify the Instance Number on the Select Data Source screen. If you are inserting the point
offline with SCT, the Select Data Source screen is blank, and you define the Instance Number
on the Configure screen under the Hardware tab, which is two screens later in the Insert Point
wizard.
Tip: When adding a LonWorks point manually, the Target Reference appears blank. Manually
type the path for the Target Reference (path into the controller for the data being mapped by
the object) in the text box on the Select Data Source screen.
Tip: Select the Hardware tab on the Configure screen for further configuration.
See one of the following sections for more information:
•

Related Documentation

•

N2 Master Datalink Object (N2 Trunk)

•

BACnet IP Integration Object

•

MS/TP Field Bus Integration Object

•

LON Integration Object

•

N1 Migration Object

•

VND Integration Object

•

Wireless Sensor Object

•

XL5K Integration Object

Analog Input Object
The AI object processes data from a physical analog input point that resides on a field device and
presents the data to the Metasys system in a consistent format that is independent of the source.
Analog Input Objects appear under the field device object in the All Items navigation tree.
When the source of the data is an analog input in an N2 controller on the N2 Trunk, a Network
Communication Module (NCM) on an integrated N1 network, or an integrated BACnet device, the
Analog Input Object exchanges data with the native analog object in the source to synchronize
attribute data that are common to both. The source is identified under the hardware tab of the
Analog Input Object.
For general information on Metasys system objects, see Common Object Attributes.

Analog Input Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
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Table 172: Analog Input Object Attributes - Focus/Configuration Tab
Attribute Name
COV Increment

Notes
C,W

BACnet Notes Initial Value
B,W
0.1

Device Type

C,N,W

C,N,W

Null

Display Precision

C,W

C,W

10ths

Intrinsic Alarming
Defined

C

Max Value

C,W

B,W

1.7E38

Min Value

C,W

B,W

-1.7E38

Out of Service

C,W

B,W

False

False

Out of Service
Expiration Time

Unspecified

Present Value

DNRW

DNRW

Reliability

W

B,W

Reliable

Descriptions
Defines the minimum change in the Present Value
required for the object to report a change to other
feature objects.
For MS/TP Analog Inputs, COV Increment may not
be writable, based on its configuration.
Contains a description of the physical device
connected to the object.
Defines the decimal rounding and the decimal
places to display for the Present Value and
associated attributes.
Enables the BACnet Intrinsic Alarming feature in
the object and the definition of related attributes.
For detailed information, see BACnet Intrinsic
Alarming.
Defines the highest reliable value (in engineering
units) for the Present Value.
Defines the lowest reliable value (in engineering
units) for the Present Value.
De-couples the object from the physical input.
When Out of Service is True, the object decouples the Present Value and Reliability from
the hardware. The Reliability is writable when
Out Of Service is True. When de-coupled, the
Present Value can be changed to simulate specific
conditions or for test purposes.
Additionally, the Out of Service state of the Status
Flags attribute is set to True and the Fault state is
decoupled from the physical input when Out of
Service is True.
Holds the time and date of when the Temporary
Out-of-Service command last issued expires. The
time and date to expire is calculated by adding
the duration specified for the Temporary Out
of Service command to the current time. Once
the current time becomes equal to the time
mentioned in this attribute, the Out of Service
attribute is set to False.
Indicates the current value of the analog input
object in the defined Units. When Out of Service is
True, this attribute is writable.
Indicates whether the Present Value is unreliable.
Examples:
Reliable - No detectable faults
Unreliable High - Present Value is greater than
the Max Value.
Unreliable Low - Present Value is less than the
Min Value.
When Out of Service is True, the Reliability
attribute may be written directly.

Resolution
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B

Indicates the smallest possible change in Present
Value (in engineering units) and is equal to the
Display Precision. This attribute has the data type
required by the standard BACnet property.
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Table 172: Analog Input Object Attributes - Focus/Configuration Tab
Attribute Name
Status Flags

Notes

BACnet Notes Initial Value
B
False,
False,
False,
False

Descriptions
Indicates the general status of the Analog
Input object in BACnet terms and contains four
independent states. The four flags are:
In Alarm - False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault - True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden - Overridden flag is True if the
Present Value is overridden at the hardware
source level.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Units

C,W

Update Interval

Use COV Min Send
Time

Use Remote
Alarming

W

Deg F

B

0

W

False

B,C,W

False

Indicates the engineering measurement units
used by the object.
Indicates the time period (in hundredths of a
second) between updates to Present Value when
the input is not overridden or out of service.
Configures the MS/TP Analog Input object to
send COV messages on a periodic basis instead
of on every change of value that exceeds the COV
Increment. This attribute is typically set to True
for objects with values that fluctuate greatly, such
as air pressure, to decrease the number of COV
messages. The change of value still must exceed
the COV Increment to be reported. This attribute
is available only on Metasys system field devices,
such as the MS/TP field devices.
When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Analog Input Commands
The table below lists the commands supported by the Analog Input Object.
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Table 173: Analog Input Commands
Command
Name

Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects.

In Service

Cancels the affect of an Out of Service command and returns the
Out of Service attribute to False. The Present Value and Reliability
will revert back to the values obtained from the physical input.

None

Note: For BACnet objects, this command is dependent on the ability to write the Out Of Service attribute of the BACnet Analog Input
object in the remote BACnet device. Objects in the N30, for example,
do not support this command.

Out of Service The value to
be written
to the
Present Value
attribute.

Temporary
The value to
Out of Service be written
to the
Present Value
attribute,
along with
the hours and
minutes that
the out of
service state
is temporarily
active.
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Allows a user to override the object’s hardware input for
simulation or other purposes. The Out Of Service command will
change the Out of Service attribute to True, write the Present
Value to the value of the command parameter and write the
Reliability attribute to Reliable. The Present Value and Reliability
will no longer track the physical input.
When an Out Of Service command is issued, the NxE does not
communicate subsequent changes (operator or system) to the
field device.
Notes:
•

For BACnet objects, this command is dependent on the ability
to write the Out Of Service attribute of the BACnet Analog
Input object in the remote BACnet device. Objects in the N30,
for example, do not support this command.

•

For integrated N2 objects, this command is dependent on the
ability to set the AI point in the N2 controller to an override
state. System 91 controllers, for example, do not support this
command.

Allows a user to temporarily override the object’s hardware
input for simulation or other purposes for a specified period of
time stated in hours and minutes. This command has the same
function as an Out of Service command but with the time element.
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Analog Output Object
The AO object’s attributes represent the external, visible characteristics of an analog output. This
object integrates N1, N2, and BACnet controllers into supervisory controllers, resulting in:
•

a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

•

flexibility in point mapping

•

permanent update of setpoints in controllers. The user has the ability to write to the
permanent memory of some controllers.

•

support for all Metasys controllers

•

For example, this object allows you to command a damper to a given position from a
supervisory controller.
For general information on Metasys system objects, see Common Object Attributes.

Analog Output Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
Table 174: Analog Output Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes

BACnet
Notes

Initial Value

Values/Options/
Range

Description

COV
Increment

C,W

B,W

0.1

Any value > 0

Specifies the minimum change in Present Value
required for the object to report a change.

Current
Command
Priority
Device Type

B

1 - 16

C,W

W

Null

Display
Precision

C,W

C,W

10ths

Intrinsic
Alarming
Defined

C

Max Value

C,W

B,W

100.0

Min Value

C,W

B,W

0.0

Limit: 20
characters

False
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This attribute is
not Writable for a
PAO.
This attribute is
not Writable for a
PAO.

For MS/TP Analog Outputs, COV Increment may
not be writable, based on its configuration.
Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.
Contains a description of the physical device
connected to the object.
Defines the decimal rounding and the decimal
places to display of the Present Value and
associated attributes.
Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes. For detailed information, see BACnet
Intrinsic Alarming.
Defines the highest reliable value (in engineering
units) for the Present Value.
Defines the lowest reliable value (in engineering
units) for the Present Value.
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Table 174: Analog Output Object Attributes - Focus/Configuration Tab
Attribute
Notes
Name
Out of Service C,W

Present Value DNRW

BACnet
Notes
B,W

Initial Value

Values/Options/
Range

Used to de-couple the object from the physical
output. When Out of Service is True, the object
de-couples the Present Value and Reliability
from the hardware. The Reliability is writable
when Out Of Service is True. When de-coupled,
the Present Value can be changed to simulate
specific conditions or for test purposes.

B,W

0.0

B,W

0

Additionally, the Out of Service state of the
Status Flag attribute is set to True and the Fault
state is decoupled from the physical input when
Out of Service is True.
Indicates the current value of the Analog Output
object in the defined Units. When Out of Service
is True, this attribute is writable.
Lists values of the object in level of importance.

Priority Array
Reliability

W

Description

No Fault Detected
(Reliable), Open
Loop, Shorted
Loop, No Output,
Unreliable Other

Indicates whether the Present Value is
unreliable.
Examples:
Reliable - No detectable faults
Unreliable High - Present Value is greater than
the Max Value.
Unreliable Low - Present Value is less than the
Min Value.

Resolution

B

Status Flags

B

When Out of Service is True, the Reliability
attribute may be written directly.
Indicates the smallest possible change in Present
Value (in engineering units) and is equal to the
Display Precision.

0.1

False,
False,
False,

This attribute has the data type required by the
standard BACnet property.
In Alarm, Fault,
Indicates the general status of the Analog
Overridden, Out of Output object in BACnet terms and contains four
Service
independent states. The four flags are:
In Alarm - False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)

False

Fault - True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden - Overridden flag is True if the
Present Value is overridden at the hardware
source level.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.
Units
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C,W

W

%

This attribute is
not Writable for a
PAO.

Indicates the engineering measurements units
used by the object.
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Table 174: Analog Output Object Attributes - Focus/Configuration Tab
Attribute
Notes
Name
Use COV Min W
Send Time

BACnet
Notes

Use Remote
Alarming

B,C,W

Initial Value
False

False

Values/Options/
Range

Description
Configures the object to send COV messages
on a periodic basis instead of on every change
of value that exceeds the COV Increment. This
attribute is typically set to True for objects
with values that fluctuate greatly, such as
air pressure, to decrease the number of COV
messages. The change of value still must exceed
the COV Increment to be reported. This attribute
is available only on Metasys system field devices,
such as the MS/TP field devices.
When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Analog Output Commands
The table below lists the commands supported by the Analog Output Object.
For the Release Operator Override, Release, and Release All commands, if all Command Priorities
have been released and a Relinquish Default is not defined, the supervisory controller gives control
to the actual hardware. The Setpoint command is supported by N2 protocol only. Note that this
command does not work on new controllers.
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Table 175: Analog Output Commands
Command
Name

Parameters

Description

Adjust

The value to be written to the
Present Value. The value must
be less than Max Present
Value and greater than Min
Present Value.

Releases Command Priorities 9 through 15
(Scheduling) and then writes to the Present Value
at the Default (16) command priority. The value
must be less than Max Present value and greater
than Min Present Value.
Important: Be aware that an operator Adjust
command releases the actions of any processes
running to the object in the network engine or FEC
controllers that use Priorities 9 through 16. Consider this behavior when creating control strategies.

If Local Control is True, this command is rejected.
The command is only sent when one of the
following conditions is met:
•
Disable
Alarms

NOT Local Control and NOT Out Of Service, or

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

In Service

Cancels the affect of an Out of Service command
and returns the Out of Service attribute to False.
The Present Value and Reliability will revert back
to the values obtained from the physical hardware
output.

None

Note: For BACnet objects, support of this command is dependent on the ability to write the Out
Of Service attribute.

Operator
Override
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The value to be written to the
Present Value.

Updates the Present Value at Command Priority
Operator Override (8).
The Operator Override command sends the
specified command to the internal network
engine object, which is then only sent to the field
device when not Out Of Service.
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Table 175: Analog Output Commands
Command
Name

Parameters

Description

Out of Service None

Allows a user to override the object’s hardware
output for simulation or other purposes. The
Out of Service command changes the Out of
Service attribute to True. The Present Value and
Reliability no longer track the physical output.
No commands are sent to the actual hardware.
When the Out of Service attribute is set to False,
the current Present Value is sent to the actual
hardware.
When an Out Of Service command is issued,
the network engine does not communicate
subsequent changes (operator or system) to the
field device.
For BACnet objects, support of this command
is dependent on the ability to write the Out Of
Service attribute.

Release
Operator
Override

None

Releases Command Priority Operator Override (8)
from Present Value.

Release

Attribute name
Command priority

Releases the identified Command Priority from
the specified attribute and allows the next highest
priority to control it.

Release All

Attribute name

Releases Command Priorities 3 through 16
(Default), from the specified, writable attribute.
Command Priorities 1 and 2 remain.
Important: The Release All command may not
cause an immediate return to automatic operation. The Release All command clears all command priorities, including those that come from
applications and features. When this happens, the
output point goes to its Relinquish Default condition. In some cases, the application or feature may
have sent a command that does not match Relinquish Default. In this instance, the output point
does not end in the state that the applications or
features intended. This situation can cause unexpected operation to occur; for example, a space
could overcool or overheat, a fan might run longer
than expected, and so on. If an operator has overridden an input, use the Release Operator Override command.

Setpoint

None

Writes the value to the permanent memory of the
field device and may change the Present Value if
there is no override.

Temporary
Override

The value to be written to
the Present Value attribute,
in addition to the duration
of the override in hours and
minutes.

Overrides a point temporarily for a specified
period of time. After the specified time period
passes, the Override is automatically released.
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Analog Value Object
Menu Selection: Insert > Object > AV
Analog Value (AV) objects have similar software characteristics and capabilities to Analog Input
Objects; however, Analog Value objects are not associated with any physical hardware and are
the result of a control process or operator entry. This object allows you to hold an analog value
for other objects to reference. For example, an LON Integration Object can reference and base its
operation on an analog value such as Outdoor Air Temperature Low Limit.
For general information on Metasys objects, see Common Object Attributes.

Analog Value Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
Table 176: Analog Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Connected
To Internal
Application
COV
Increment

Current
Command
Priority
Display
Precision

Notes

C,W

BACnet
Notes
B, W

Initial Value

Description

No

Values/Options/
Range
No or Yes

B,W

0.01

Any value > 0

Defines the minimum change in the Present
Value required for the object to report a change.

B

C,W

C,W

1 - 16

10ths

Failsoft
Currently
Active

Intrinsic
Alarming
Defined
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Yes or No

C

False

Indicates whether the object is connected to an
internal application.

The COV Increment attribute is required if the
object supports COV reporting.
Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.
Defines the decimal rounding and the decimal
places to display of the Present Value and
associated attributes.
Specifies whether the Failsoft feature is currently
overriding the input value to a reliable default. If
No, Failsoft is disabled or, if Failsoft is enabled,
the value is reliable. If Yes, Failsoft is enabled and
the value is unreliable. This attribute is only used
if Property Ref Value is defined to reference an
application.
Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes. For detailed information, see BACnet
Intrinsic Alarming.
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Table 176: Analog Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Max Value

Min Value

Notes
C,W

C,W

BACnet
Notes
B,W

B,W

Initial Value
1.7E38

-1.7E38

Values/Options/
Range
This value is not
writable for FEC
objects.
This value is
writable if the AV
is the ZN-SP on a
Net Sensor. This
method is the only
way to set the
range for the Net
Sensor.
This value is not
writable for FEC
objects.
This value is
writable if the AV
is the ZN-SP on a
Net Sensor. This
method is the only
way to set the
range for the Net
Sensor.
False

Monitor Only

Out of Service

W

Present Value D,R,W

D,R,W

False

Always False

Priority Array

Property Ref
Value

N

Referenced
Reliability
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Object Name,
Reference,
Attribute

No Input

Description
Defines the highest reliable value (in engineering
units) for the Present Value.
This value is not writable for Analog Value
objects in the FEC.
This value is writable if the AV is the ZN-SP on a
Net Sensor. This method is the only way to set
the range for the Net Sensor.

Defines the lowest reliable value (in engineering
units) for the Present Value.
This value is not writable for Analog Value
objects in the FEC.
This value is writable if the AV is the ZN-SP on a
Net Sensor. This method is the only way to set
the range for the Net Sensor.

Defines the behavior of the object as an input
or output. If you do not specify a Property Ref
Value, the attribute is set to False. This attribute
appears only in the Snapshot Focus view.
This attribute is always False for this object due
to the absence of hardware.
Indicates the current value of the analog value.
Present Value is optionally commandable.
The optional Priority Array must be present
for Present Value to be commandable. Values
written to Present Value are compared with the
Min Value and Max Value attributes and set the
Reliability.
Contains prioritized commands in effect for the
object. The highest priority command is sent to
the Present Value attribute.
Specifies an object and attribute (usually from an
application) for which the AV object is providing
the standard interface. The object and attribute
contained in this attribute must be a local object
and is often a non-BACnet data source and
destination. When this property is not defined,
the Monitor Only property is set to False. This
attribute appears only in the Snapshot Focus
view.
Specifies the current reliability of the value sent
to or from the object/attribute referenced by
Property Ref Value. This attribute is only used
if Property Ref Value is defined to reference an
application.
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Table 176: Analog Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Referenced
Value

Notes

Referenced
Value COS
Count

W

Reliability

W

Status Flags

BACnet
Notes

Initial Value

Values/Options/
Range

Specifies the current value sent to or from the
object/attribute referenced by Property Ref
Value. This attribute is only used if Property Ref
Value is defined to reference an application.
Counts how many times the Present Value
and Reliability have changed. If the Monitor
Only attribute is True, the count is how many
times the Property Ref Value has updated the
AV. If Monitor Only is False, the count is how
many times Property Ref Value has updated the
AV. This attribute helps to diagnose excessive
changes that can cause logic to execute taking
up too much bandwidth. Reset the count by
entering 0 for this attribute. This attribute is only
used if Property Ref Value is defined to reference
an application.

0

B,W

B

Reliable

False,
False,
False,
False

Description

See the attribute
description
for details on
Reliability.

Indicates whether the Present Value is
unreliable.

No Fault Detected
(Reliable), Over
Range, Under
Range, Unreliable
Other

Unreliable High - Present Value is greater than
the Max Value.

See the attribute
description for
details on Status
Flags.

Examples:
Reliable - No detectable faults

Unreliable Low - Present Value is less than the
Min Value.
When Out of Service is True, the Reliability
attribute may be written directly.
Indicates the general status of the Analog
Input object in BACnet terms and contains four
independent states. The four flags are:

In Alarm - False if the Event State attribute value
In Alarm, Fault,
is Normal; otherwise, the In Alarm flag is True.
Overridden, Out of (Set only by BACnet Intrinsic Alarming.)
Service
Fault - True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden - Overridden flag is True if the
Present Value is overridden at the hardware
source level.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.
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Table 176: Analog Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Units

Use Remote
Alarming

Notes
W

BACnet
Notes
W

Initial Value

B,C,W

False

Values/Options/
Range

Blank

Description
Reflects the Units attribute of the object
referenced by the Present Value Reference
attribute.
When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the network engine. If the remote integrated
object does not contain attributes for originating
alarms, then Use Remote Alarming defaults
to False causing the local mapper object to
originate alarms. When Use Remote Alarming
is false, any alarms from the remote integrated
object are ignored at the network engine. If the
value of Use Remote Alarming is changed, a
restart of the network engine may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Analog Value Commands
The table below lists the commands supported by the Analog Value Object.
Table 177: Analog Value Object Commands
Command

Parameters

Description

Adjust

None

The value to be written to the Present Value attribute. The value
must be less than Max Present value and greater than Min
Present Value.

Disable
Alarms

None

Disables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects.

Operator
Override

None

The value to be written to the Present Value attribute.

Release
Operator
Override

None

Releases Command Priority Operator Override (8) from Present
Value.

Release

None

Releases the identified command priority from the specified,
writable attribute, and allows it to be controlled by the next
highest priority.
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Table 177: Analog Value Object Commands
Command

Parameters

Description

Release All

None

Releases Command Priorities 3 through 16 from the specified,
writable attribute. Command Priorities 1 (Manual Emergency) and
2 (Fire Application) remain.
Important:

The Release All command may not cause an immediate
return to automatic operation. The Release All command
clears all command priorities, including those that come
from applications and features. When this happens, the
output point goes to its Relinquish Default condition. In some
cases, the application or feature may have sent a command
that does not match Relinquish Default. In this instance, the
output point does not end in the state that the applications
or features intended. This situation can cause unexpected
operation to occur; for example, a space could overcool or
overheat, a fan might run longer than expected, and so on.
Also, if an operator has overridden an input, use the Release
Operator Override command.
Temporary
Override

The value to
be written
to the
Present Value
attribute, in
addition to
the duration
of the
override in
hours and
minutes.

Overrides a point temporarily for a specified period of time. After
the specified time period passes, the Override is automatically
released.

Accumulator Object
Menu Selection: Insert > Object > Accumulator
The accumulator object allows you to count pulses, which are often provided by energy meters. The
accumulator objects can feed their Present Values to the Pulse Meter Object.
Note: The Accumulator’s Interface Value updates when the hardware is read by the Pulse
Meter Object or when the hardware’s current value changes.
The following table describes the types of accumulator objects and how to add them to the Metasys
system. The Integration (Device) Type column indicates the type of integration and device in which
the accumulator object resides.
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Table 178: Accumulator Types
Integration
(Device) Type

Description

IP BACnet
Integration
(BACnet
Device)

Provides integration of BACnet
To add an accumulator from a BACnet
controllers with supervisory
device on an IP BACnet integration:
controllers through a BACnet
1. From the SMP UI or SCT UI, add a
accumulator mapper. This object
BACnet integration.
provides information on the UI
(including Present Value and Scale) 2. Add a BACnet device type compatible
with the field device that contains an
from a BACnet integration with an
accumulator.
accumulator that exists in a BACnet
3. Map the accumulator at the engine
device.
(that is, add the Accumulator point to
Note: A BACnet accumulator is
the mapped BACnet device using the
mapped at the engine through
the Insert Point wizard.
Insert Point wizard).

MS/TP Field
Bus
(BACnet
Device)

Provides integration of BACnet
To add an accumulator from a BACnet
controllers with supervisory
device on an MS/TP field bus:
controllers through a BACnet
1. From the SMP UI or SCT UI, add an
accumulator mapper. This object
MS/TP field bus.
provides information on the UI
(including Present Value and Scale) 2. Add a BACnet device type compatible
with the field device that contains an
from a BACnet Integration with an
accumulator.
accumulator that exists in a BACnet
3. Map the accumulator at the engine
device.
(that is, add the Accumulator point to
Note: A BACnet accumulator is
the mapped BACnet device using the
mapped at the engine through
the Insert Point wizard.
Insert Point wizard).

MS/TP Field
Bus
(FEC Family
BACnet Device)

Provides integration of pulse
To add an accumulator from an FEC family
meters integrated to the Dry
BACnet device on an MS/TP field bus:
Contact Pulse (MISC-MTR) binary
1. From the SMP UI or SCT UI, add an
input of an FEC family BACnet
MS/TP field bus.
device. CCT creates an Accumulator
2. Add an FEC family BACnet device
object for the pulse meter input of
compatible with the field device that
the FEC family BACnet device. This
contains a visible accumulator (defined
FEC accumulator is shadowed by
by CCT).
the engine.
3. Map the accumulator at the engine
Note: An FEC accumulator object
(that is, add the Accumulator point
is mapped at the engine through
the Insert Point wizard.
to the mapped field device using the
Insert Point wizard).
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Table 178: Accumulator Types
Integration
(Device) Type

Description

Steps and Tips

N2 Trunk
(N2 Device)

Provides integration of the wide
variety of N2 controller binary
input/pulse counters, resulting
in a consistent interface for point
mapping any N2 controller types.

To add an accumulator from an N2 device
on an N2 trunk:

Note: An N2 accumulator or pulse
counter is mapped at the engine
through the Insert Point wizard.

1.

From the SMP UI or SCT UI, add an N2
trunk.

2.

Add an N2 device type compatible with
the field device.

3.

Map the accumulator (Accumulator
or Pulse Counter type) at the engine
(that is, add the Accumulator point to
the N2 device using the Insert Point
wizard).

4.

Define the Rollover Limit:
Note:

You must set the rollover limit in the
N2 accumulator to match the rollover
limit of the N2 field device selected.
For example, AHU or UNT devices
have a rollover limit of 4,294,967,295.
A DX-9100 CNT point has a rollover
limit set by the GX-9100 configuration
tool. An XT-9100 or XTM CNT point
has a rollover limit set by either the
GX-9100 configuration tool or XTM
configuration tool.
Map BI7 or BI8 for an AHU, BI4 for
a UNT or VAV, or ADI network point
types for a DX-9100 or XTM.
Other
Integrations
(For Example,
LonWorks, N1,
VND, and XL5K
Devices)

Allows you to monitor the
increasing pulse count from any
attribute that has an incrementing
value. This provides greater
flexibility for creating accumulator
objects.
Note: An object with an attribute
that has an incrementing value
is mapped at the engine through
the Insert Object wizard.
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To add an accumulator from a device on
other integrations:
1.

From the SMP UI or SCT UI, add the
desired integration.

2.

Add a device type compatible with the
field device.

3.

Map the accumulator at the engine
(that is, add the Accumulator object
using the Insert Object wizard).

4.

Reference a value that continually
counts up until the value wraps back
to zero when it passes the Rollover
Limit value defined in the accumulator
object.
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The following figure illustrates the interaction between the different types of accumulators and the
accumulator in the engine, showing the key attributes and functionality.
Figure 37: Accumulator Interaction

An FEC family BACnet device that resides on the MS/TP field bus has a binary input with a Dry
Contact Pulse signal (MISC-MTR) created in CCT. This provides an FEC accumulator. A BACnet device
that resides on either the BACnet integration or the MS/TP field bus has an accumulator. Both the
FEC accumulator and BACnet accumulators have BACnet Prescale, Units, and Limit Monitoring
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Interval attributes that interact with the accumulator in the engine through the prescaled Present
Value.
An N2 controller resides on the N2 trunk, and has an attribute that counts. Similarly, other devices
that reside on other integrations (for example, a LonWorks device on a LonWorks integration) that
have attributes that count may take advantage of the accumulator functionality. The accumulator in
the engine uses the count value.
The accumulator in the engine uses the prescaled Present Value or counts from the devices with
the key engine accumulator attributes listed in the figure. For details on the calculations used by
and functionality of these attributes, see the Accumulator Attributes section.
The accumulator’s prescaled Present Value is used by the Pulse Meter, DLLR, or IEIEJ objects. You
can trend the prescaled Present Value, which may then be used by Energy Essentials. You also can
trend the accumulator’s Pulse Rate, Scaled Present Value, or Value Before Change attributes.
Note: The prescaled Present Value, as well as its associated commands and attributes (Preset
Value, Value Before Change, Max Value, Value Set), do not necessarily have the same units as
Scaled Present Value or the Units attribute.
The header of the focus window shows the Scaled Present Value after the scale factor has been
applied to the Present Value, as well as the units that apply to the Scaled Present Value.

Accumulator Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Notes for Anti Spike:
•

Any mapper object used to deliver a raw count value to the Accumulator must provide an
unreliable value during startup if the value was not updated from the field controller at the
time it is read by the accumulator. For example, a LON counter mapped as an AI point object
reports as unreliable until it reads a value from the field controller. If the LON counter is
mapped as an AO point object, it reports as reliable even if the value is not initialized, causing
improper values to be recorded at the accumulator. This may occur regardless of the value of
Anti Spike.

•

Any mapper object used to deliver a raw count value to the accumulator must be allowed
to count up without disruption from manual commands, schedules, interlocks, or any other
function that may change its value outside the normal counting process. Any such changes
may cause the Accumulator to record improper values regardless of the value of Anti Spike.

•

When replacing the input device, set Anti Spike to True before the replacement is brought
online for the first time. This setting prevents the accumulator value from spiking upward due
to an uncontrolled count value change at the input device. Failure to set Anti Spike to True can
upset the accumulator value. You can use a manual preset to restore the correct value after
the new device is online.
Note: In the Integration Type column, devices include: BACnet (Third-Party BACnet device),
FEC (FEC family BACnet device), N2, and Other (for example, LonWorks, N1, VND, and XL5K).
In the Notes column, letters indicate the following: B - Exposed as standard BACnet property,
C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by
Extension’s Reliability, W - Writable.
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Table 179: Accumulator Object Attributes - Focus/Configuration Tab
Attribute Name
Anti Spike

Integration Type Notes
N2
C,W
Other

Description
When True, causes the object to use the first good input count value
received after previously being unreliable as strictly an initial value. Any
archived or last known value for input count is ignored. If the input device
resets or loses power, uncontrolled changes to the input count value are
filtered out and do not result in a spike in accumulator values. Use this
setting in cases where the input device is not known to preserve its count
value over a power loss (for example, in a LonWorks integration an LNPRG20 GPI, and in an N2 integration a UNT).
When False, causes the object to use the first good input device count
value received after previously being unreliable as a valid change from the
archived or last known value for input count. This means the first good
input device value is used to catch up on any counts that were missed
while the input device was unable to communicate due to either an NAE
restart or communication loss.
Do not set this value to False unless the input device is known to preserve
its count value during a power loss (for example, in an N2 integration,
an XTM-105 with a XPB-821 or in a LonWorks integration LN-PRG300-2,
LNPRG400-2, LN-PTRG500-2, LN-PRG600, or in a vendor integration
BTR Netcom GmbH device LC14 [Model # 11045013-US], an IDEC SX5LSBCN081, or a WATANBE Electric Industry WRBC-DI16F-A002).

Device Type
Display Precision

All
All

C,N,W
C,W

Input Ref

Other

C

Interface Value

N2

Internal Units

All

C,W

Intrinsic Alarming All
Defined

C,W

JCI Logging Object All
Reference

C,W

Limit Monitoring
Interval

All

C,W

Logging Object
Reference

All
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Contains a description of the physical device connected to the object.
Determines how many decimal places to display in the Scaled Present
Value.
Identifies the attribute reference to the object property that is the pulse
count input for the Accumulator object (for the Other integrations type:
LonWorks , N1, VND, and XL5K, for example). This must be a continuously
increasing positive numeric attribute of another object, such as the
present value of a totalization extension to an analog meter.
Indicates current value from the hardware interface. This attribute is the
same as input count, but is specific to the N2 accumulator.
Contains the engineering units for the Present Value, Value Set, Max
Value, and Value Before Change attribute.
Indicates whether intrinsic alarming is enabled when the site is defined
as a BACnet site. When intrinsic alarming is defined for accumulators
on the MS/TP field bus, the pulse rate of the accumulated point can be
monitored. For detailed information, see BACnet Intrinsic Alarming.
Indicates the object (Johnson Controls proprietary reference) that
resides in the same device as the Accumulator object which, when it
acquires Logging Record data from the Accumulator object, causes the
Accumulator object to acquire, present, and store the Logging Record
data (that is, snapshot) from the underlying system. When the object
specified by the Logging Object Reference issues the Get Monitor Data
command, the Logging Record is acquired and updated.
Specifies the monitoring period in seconds for determining the Pulse
Rate. The Pulse Rate is the number of pulses received during the previous
Limit Monitoring Interval period.
Indicates the object (Johnson Controls proprietary reference) that
resides in the same device as the Accumulator object which, when it
acquires Logging Record data from the Accumulator object, causes the
Accumulator object to acquire, present, and store the Logging Record
data (that is, snapshot) from the underlying system. When the object
specified by the Logging Object Reference issues the Get Monitor Data
command, the Logging Record is acquired and updated.
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Table 179: Accumulator Object Attributes - Focus/Configuration Tab
Attribute Name
Logging Record

Integration Type Notes
All

Description
Specifies a list of values to acquire, save, and return when read by other
objects or devices.
•

Timestamp - Indicates the value of the Present Value
attribute.timestamp - Indicates the local date and time when the
data was acquired.

•

Present Value - Indicates the value of the Present Value attribute.

•

Accumulated Value - Indicates the short-term accumulated value
of the counter. The algorithm used to calculate the accumulated
value is a function of the value of accumulator status. If this is the
initial read, the value returned is zero.

•

Accumulator Status - Indicates the reliability of the data in this list
of values. The accumulator status values include:
- Normal - Indicates that no event affecting the reliability of
the data has occurred during the period from the preceding
to the current qualified reads of the Logging Record attribute
(Accumulated Value = current Present Value - previous
Present Value).
- Starting - Indicates that the data of the Logging Record
attribute is either the first data acquired since startup by the
object identified by Logging Object (that is, timestamp has
no wildcard values) or that no data has been acquired since
startup by the object identified by Logging Object (that is,
timestamp has all wildcard values).
- Recovered - Indicates that one or more writes to Value
Set or changes to Value Before Change occurred since the
Logging Record was acquired by the object identified by
Logging Object (Accumulated Value = [current Present Value Value Set] + [Value Before Change - previous Present Value]).
- Abnormal - Indicates that the accumulation has been
carried out, but some unrecoverable event such as the clock’s
time changing a significant amount since the Logging Record
was acquired by the object identified by Logging Object.

Max Value

Out of Service

All

All

C,W

W

- Failed - Indicates that the accumulation value is not reliable
due to some problem.
Indicates the maximum value allowed for the Present Value. The Present
Value is not allowed to exceed this value, and wraps back to zero when
this value is passed. Accumulation does not stop.
If the present value of the Accumulator object is being trended and its
data is sent to the ADS repository, change this value to 32,767 so that the
historian database (JCIHistorianDB) can properly store its value.
When set to True, indicates that the object is not tracking pulse count or
rate.
Used to de-couple the object from the physical input. When Out of Service
is True, the object de-couples the Present Value and Reliability from
the hardware. The Reliability is writable when Out Of Service is True.
When de-coupled, the Present Value can be changed to simulate specific
conditions or for test purposes.
When the Accumulator object is placed Out of Service, the current value
of the Present Value is saved. While Out of Service, an N2, FEC, or Other
Accumulator continues to track the count of this saved value in the
background, thereby ensuring that no counts are lost. When placed back
in service, this new count is copied to the Present Value attribute.
A third-party BACnet accumulator behaves according to the design of the
third-party vendor.
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Table 179: Accumulator Object Attributes - Focus/Configuration Tab
Attribute Name
Periodic Update

Integration Type Notes
FEC
C,W
N2
Other

Description
This attribute only appears in the snapshot view of the mapper object
and on the Engineering tab of the integration. This attribute applies to
all integrations, except for BACnet integrations. Represents the time,
in seconds, between successive COV messages issued by the local
Accumulator object at a field device, or updates made to the Accumulator
object on the UI.
The field device Accumulator object pushes its Present Value count
up to the Supervisory controller through the COV mechanism. By
requiring a minimum time between successive COVs, the Update Interval
ensures that the integration does not get flooded with COVs from the
Accumulator.
This attribute only appears in the snapshot view of the mapper object and
on the Engineering tab of the integration.

Prescale

All

C,W

Indicates the coefficients used to convert the accumulated pulses into the
Present Value. This attribute uses moduloDivide integer division (where
5/2 is 2). The algorithm used is:
Present Value = (prescale.multiplier x accumulated-pulses)/

Present Value

All

NW

Reliability

All

W

Rollover Limit

N2

C,W

Other

prescale.moduloDivide.
Allows you to reset the Present Value. This command writes a supplied
value to the Value Set attribute. The Present Value attribute then gains its
value from the value written to the Value Set attribute. The Value Before
Change takes on the previous value of the Present Value attribute (that
is, the original value before the write processed), and the Value Change
Time is set to the current date and time. This preserves the Present Value
before the command took place. Use this command to change Present
Value if the Accumulator object is in or out of service.
Indicates whether the Present Value is reliable and why. You can write to
Reliability when it is out of service.
Represents the actual rollover value of the input pulse counter. This
attribute applies to N2 and Other Accumulators. This value is used to
compute a change rate, which is added to the Accumulator property to
calculate the Pulse Rate and Present Value.
You must set the rollover limit in the N2 accumulator to match the rollover
limit of the N2 field device selected. For example, AHU or UNT devices
have a rollover limit of 4,294,967,295. A DX-9100 CNT point has a rollover
limit set by the GX-9100 configuration tool. An XT-9100 or XTM CNT point
has a rollover limit set by the either the GX-9100 configuration tool or XTM
configuration tool.
This BACnet property does not appear in a view in the Metasys system.
Indicates the conversion factor to be multiplied with the value of the
Present Value attribute to provide a Scaled Present Value in the units
indicated by the Units attribute. By default, the Present Value and Scaled
Present Value are equal. These values remain equal if you do not use the
accumulator’s Scale attribute.

Scale

All

Scale As Float

All

C,N,W

Scale As Integer

All

C,N,W

This attribute does not appear in a view; it is a BACnet property.
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Indicates the floating conversion factor to be multiplied with the value of
the Present Value attribute to calculate the Scaled Present Value for the
chosen units. If set to zero (the default value), the Scale As Integer value is
used and Scale As Float is ignored.
Indicates the power of ten to be multiplied with the value of the Present
Value attribute to get Scaled Present Value. This attribute only applies if
Scale As Float is zero. For example, when Scale As Integer is set to two,
the Present Value is multiplied by 100; while setting Scale As Integer to
-1 multiplies the Present Value by 0.1. When zero (the default value), the
Present Value and Scaled Present Value are equal (see Scaled Present
Value).
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Table 179: Accumulator Object Attributes - Focus/Configuration Tab
Attribute Name
Scaled Present
Value

Integration Type Notes
All

Status Flag

All

Description
Indicates the value of the Present Value attribute conversion. The Present
Value is multiplied by the Scale as Float value when that attribute contains
a value (not zero). Otherwise, the Present Value is multiplied by 10 to the
power of the Scale As Integer value (for example, if Scale As Integer is 3, it
is multiplied by 1,000 and if Scale As Integer is -2, it is multiplied by 0.01).
This is the actual value of the object.8
Indicates the general status of the Accumulator object in BACnet terms
and contains four independent states. The states are:
In Alarm - False if the Event State attribute value is Normal; otherwise,
the In Alarm flag is True.
Fault - True if the Reliability attribute is not reliable; otherwise, the Fault
flag is False.
Overridden - Overridden flag is always False.

Units
Use Remote
Alarming

All
BACnet

C,W
C,W

Value Before
All
Change
Value Change Time All
Value Set

All

W

Out of Service - Out of Service flag is True if the Out of Service attribute
value is True; otherwise, the Out of Service flag is False.
Contains the engineering units for the Scaled Present Value attribute.
When the attribute Intrinsic Alarming Defined is set to True, determines
where alarms for the object originate. If the remote integrated object
contains attributes for originating alarms, then Use Remote Alarming
defaults to True, causing the local mapper object to accept alarms from
the remote integrated object that are routed to the NxE. If the remote
integrated object does not contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing the local mapper object
to originate alarms. When Use Remote Alarming is false, any alarms from
the remote integrated object are ignored at the NxE. If the value of Use
Remote Alarming is changed, a restart of the NxE may be required to
assure correct operation.
Indicates the Present Value prior to the last write to the Value Set
property or Present Value command.
Indicates the time of the last change to the Value Before Change attribute
or Preset Value command.
Allows you to reset the Present Value. The Present Value attribute gains its
value from the value written to the Value Set attribute. The Value Before
Change takes on the previous value of the Present Value attribute (that
is, the original value before the write processed), and the Value Change
Time is set to the current date and time. You also can use the Preset Value
command to change Present Value if the Accumulator object is in or out
of service.

Accumulator Commands
The table below lists the commands supported by the Accumulator Object.
Table 180: Accumulator Object Commands
Command
Name

Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.
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Table 180: Accumulator Object Commands
Command
Name

Parameters

Description

Get Monitor
Data

None

The Accumulator object and the object specified
by the Logging Object Reference must reference
one another for the Get Monitor Data command
to work.
•

On the Action Tables tab of the object
specified by the Logging Object Reference,
the Accumulator object must be set to receive
the Get Monitor Data command.

•

In the JCI Logging Object Reference field of
the Accumulator object, the object issuing
the Get Monitor Data command must be
selected. When the JCI Logging Object
Reference is specified, the Logging Object
Reference takes on the object type and
instance of the specified object.
The object specified by the Logging Object
Reference can be a Multiple Command object or
an Interlock object. Both are capable of issuing
the Get Monitor Data command.
Acquires and updates the Logging Record when
the object specified by the Logging Object
Reference issues the Get Monitor Data command.
In Service

None
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A third-party BACnet accumulator behaves
according to the design of the third-party vendor.
Cancels the effect of an Out of Service write or
command. The Present Value and Reliability revert
to the values obtained from the physical input.
The Present Value attribute continues to receive
inputs from the hardware input while in the Out of
Service state and continues to increment its count
internally. When the Out of Service is cancelled,
the Present Value attribute of the N2, FEC, or
Other Accumulator updates with this new internal
count.
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Table 180: Accumulator Object Commands
Command
Name

Parameters

Out of Service The value to be written to the
Present Value attribute.

Description
Allows a user to override the object’s hardware
input for simulation or other purposes. The Out
Of Service command writes the Present Value to
the value of the command parameter and writes
the Reliability attribute to Reliable. The Present
Value and Reliability no longer track the physical
input, but the N2, FEC, or Other Accumulator
continues to track pulses while out of service.
When placed back in service, the Present Value
resumes counting pulses.
When an Out Of Service command is issued, the
NxE does not communicate subsequent changes
(operator or system) to the field device.
A third-party BACnet accumulator behaves
according to the design of the third-party vendor.

Preset
Counter

The value to be written to
Allows you to set the value to write to the N2
the N2 device accumulator or device accumulator or pulse counter hardware
pulse counter hardware point. point. You cannot adjust this attribute for a UNT
or AHU. This attribute may be used with DX-9100,
XTM, or XT hardware.

Present Value

The value to be written to the
Value Set attribute.

Allows you to reset the Present Value. This
command writes a supplied value to the Value
Set attribute. The Present Value attribute then
gains its value from the value written to the
Value Set attribute. The Value Before Change
takes on the previous value of the Present Value
attribute (that is, the original value before the
write processed), and the Value Change Time is
set to the current date and time. This preserves
the Present Value before the command took
place. Use this command to change Present Value
if the Accumulator object is in or out of service.

Binary Input Object
The BI object’s attributes represent the external, visible characteristics of a binary input. As a
binary input, this object can be in either an Active or Inactive state. The Polarity attribute allows for
normally open relays that are Active when energized and normally closed relays that are Inactive
when energized.
The Binary Input object integrates N1, N2, and BACnet controllers into supervisory controllers,
resulting in:
•

a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

•

flexibility in point mapping

• support for all Metasys controllers. See the N2 Controller Object section.
For example, this object allows you to map a fan status into a supervisory controller.
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For general information on Metasys system objects, see Common Object Attributes.

Binary Input Concepts
BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is
determined by the Polarity attribute.
The table below describes this relationship as defined by BACnet standards. Johnson Controls
Polarity is always Normal. Johnson Controls N2 protocol does not support changes to the Polarity
attribute.
Table 181: BACnet Polarity Relationships
Present Value

Polarity

Physical State of the
Hardware Input

Physical State of the
Monitored Device

Inactive

Normal

Off or Inactive

not running

Active

Normal

On or Active

running

Inactive

Reverse

On or Active

not running

Active

Reverse

Off or Inactive

running

Binary Input Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
Table 182: Binary Input Object Attributes - Focus/Configuration Tab
Attribute
Name
Active Text

Notes

BACnet
Notes
B

Initial Value

Values/Options/
Range
Limit: 20
characters

Description
Characterizes the intended effect of the Active
state of Present Value from the viewpoint of the
operator. The content of this string is a local
matter but is intended to represent a readable
description of the Active state.
For example, if the physical input is a switch
contact, then the Active Text attribute is assigned
a value such as Fan 1 On. If either the Active Text
or the Inactive Text attribute is present, both of
them are present.
If either Inactive Text or Active Text is present,
both are present.

Active Time
Reset

W

B, W

Represents the last date and time Elapsed Active
Time was set to a zero value. If either Elapsed
Active Time or Time of Active Time Reset is
present, all are present.
If either Elapsed Active Time or Time of Active
Time Reset is present, both are present.
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Table 182: Binary Input Object Attributes - Focus/Configuration Tab
Attribute
Name
COS Count

Notes
W

COS Time

Device Type

BACnet
Notes
B

Initial Value

Values/Options/
Range
0–4,294,967,295

Represents the number of times the Present
Value attribute changes state since the COS
Count attribute was most recently set to zero. A
change of state is any event that alters Present
Value. This attribute persists in the archive.
If Change of State Time, Change of State Count,
or Time of State Count Reset is present, all are
present.
Represents the date and time at which the most
recent change of state occurred. A change of
state is any event that alters the Present Value
attribute. When Out of Service is False, a change
to the Polarity attribute alters Present Value and
is considered a change of state. When Out of
Service is True, changes to Polarity do not cause
changes of state.

B

C,W

Description

B,W

Null

Elapsed Active
Time

B

Null

Inactive Text

B

Limit: 20
characters
0–4,294,967,295
Units = seconds

Limit: 20
characters

If Change of State Time, Change of State Count,
or Time of State Count Reset is present, all are
present.
Contains a description of the physical device
connected to the object.
Represents the accumulated number of seconds
Preset Value is Active since the Elapsed Active
Time attribute was most recently set to zero.
This attribute value updates automatically a
minimum of once a day.
Characterizes the intended effect of the Inactive
state of Present Value attribute from the
viewpoint of the operator. The content of this
string is a local matter, but it is intended to
represent a readable description of the Inactive
state.
For example, if the physical input is connected to
a switch contact, then the Inactive Text attribute
is assigned a value such as Fan 1 Off. If either the
Inactive Text or Active Text attribute is present,
both are present.
If either Elapsed Active Time or Time of Active
Time Reset is present, both are present.

Intrinsic
Alarming
Defined
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C

False

Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes. For detailed information, see BACnet
Intrinsic Alarming.
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Table 182: Binary Input Object Attributes - Focus/Configuration Tab
Attribute
Notes
Name
Out of Service C,W

BACnet
Notes
B,W

Initial Value

Values/Options/
Range

False

Description
Indicates (when True) that the Present Value
and Reliability attributes are decoupled from the
physical input to the object and their values may
be changed for simulation or testing purposes.
Functions that depend on the values of the
Present Value or Reliability attributes continue to
respond to changes while Out of Service is True,
as if those changes had come from the physical
input.
Additionally, the Out of Service state of the
Status Flags attribute is set to True and the Fault
state is decoupled from the physical input when
Out of Service is True.

Polarity

B,W

Normal, Reverse

Present Value DNRW

B,W

0

Reliability

W

B,W

Reliable

State Count
Reset

W

B, W

States Text

C,W

States Text
Error Status

One state
from a set

Off
On
OK

Indicates the relationship between the
physical state of the input and the logical state
represented by Present Value.

The Johnson Controls N2 Polarity attribute is
always Normal.
Indicates the current value of the binary input.
Polarity determines the relationship between
Present Value and the state of the input. When
Out of Service is True, Present Value is writable.
No Fault Detected Indicates if the Present Value is unreliable.
(Reliable),
Examples:
No Sensor,
Reliable - No detectable faults
Open Loop,
Communication Failure - Communication to the
Shorted Loop,
sensor or device reading the sensor has failed.
Unreliable Other,
When Out of Service is True, the Reliability
Communication
attribute may be written directly.
Failure
Represents the date and time the COS Count
attribute was most recently set to a zero value.
If COS Time or Changeof State Count is present,
both are present.
If Change of State Time, Change of State Count,
or Time of State Count Reset is present, all are
present.
Indicates the displayed strings for the Present
Value.
Out of Memory, OK Out of Memory: Indicates that memory overrun
has been encountered while adding custom
enumeration for state text from field device to
the user dictionary.
OK: Indicates that an addition of custom
enumeration for state text from the field device
to user dictionary is successful and state text
from the device can be used.
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Table 182: Binary Input Object Attributes - Focus/Configuration Tab
Attribute
Name
Status Flags

Notes

BACnet
Notes
B

Initial Value
False,
False,
False,
False

Values/Options/
Range
In Alarm, Fault,
Overridden, Out of
Service

Description
Indicates the general status of the input object
in BACnet terms and contains four independent
states.
The four flags are:
In Alarm - False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault - True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden - Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W

False

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Binary Input Commands
The table below lists the commands supported by the Binary Input Object.
Table 183: Binary Input Commands
Command
Name

Number of Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.
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Table 183: Binary Input Commands
Command
Name

Number of Parameters

Description

In Service

None

Cancels the affect of an Out of Service command
and returns the Out of Service attribute to False.
The Present Value and Reliability reverts to the
values obtained from the physical input.
Note: For BACnet objects, support of this command is dependent on the ability to write the Out
Of Service attribute.

Out of Service The value to be written to the
Present Value.

Allows a user to override the object’s hardware
input for simulation or other purposes. The Out
of Service command changes the Out of Service
attribute to True, writes the Present Value to the
value of the command parameter, and writes the
Reliability attribute to Reliable. The Present Value
and Reliability no longer track the physical input.
When an Out Of Service command is issued, the
NxE does not communicate subsequent changes
(operator or system) to the field device.
Note: For BACnet objects, support of this command is dependent on the ability to write the Out
Of Service attribute.

Temporary
The value to be written to the
Out of Service Present Value attribute, along
with the hours and minutes
that the out of service state is
temporarily active.

Allows a user to temporarily override the object’s
hardware input for simulation or other purposes
for a specified period of time stated in hours and
minutes. This command has the same function
as an Out of Service command but with the time
element.

Binary Output Object
The BO object’s attributes represent the external, visible characteristics of a binary output. As a
binary output, this object can be in either an Active or Inactive state. The Polarity attribute allows
for normally open relays that are Active when energized and normally closed relays that are
Inactive when energized. This object integrates N1, N2, and BACnet controllers into supervisory
controllers, resulting in:
•

a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

•

flexibility in point mapping

• support for all Metasys controllers. See N2 Controller Object.
For example, this object allows you to start or stop a fan from a supervisory controller.
For general information on Metasys system objects, see Common Object Attributes.

Binary Output Concepts
BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is
determined by the Polarity attribute.
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Note: The table below describes this relationship as defined by BACnet standards. Johnson
Controls Polarity is always Normal. Johnson Controls does not support changes to the Polarity
attribute.
Table 184: BACnet Polarity Relationships
Present Value

Polarity

Physical State of the
Hardware Input

Physical State of the
Monitored Device

Inactive

Normal

Off or Inactive

not running

Active

Normal

On or Active

running

Inactive

Reverse

On or Active

not running

Active

Reverse

Off or Inactive

running

Binary Output Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
Table 185: Binary Output Object Attributes - Focus/Configuration Tab
Attribute Name
Active Text

Notes

BACnet Notes Values/Options/Range Description
Limit: 20 characters
Characterizes the intended effect of the Active
state of Present Value from the viewpoint of the
operator. The content of this string is a local
matter but is intended to represent a readable
description of the Active state.
For example, if the physical output is a switch
contact, then the Active Text attribute is assigned
a value such as

Active Time Reset

W

COS Count

W

B, W

0–4,294,967,295

COS Time

Device Type

360

C,W

W

Limit: 20 characters

Fan 1 On. If either the Active Text or the Inactive
Text attribute is present, both of them are
present.
Represents the last date and time Elapsed Active
Time set to a zero value. If either Elapsed Active
Time or Active Time Reset is present, both are
present.
Represents the number of times the Present
Value attribute changed state since the COS Count
attribute was last set to zero. A change of state is
any event that alters Present Value. This attribute
persists in the archive.
Represents the date and time at which the most
recent change of state occurred. A change of
state is any event that alters the Present Value
attribute. When Out of Service is False, a change
to the Polarity attribute alters Present Value and is
considered a change of state. Changes to Polarity
do not cause changes of state.
Contains a description of the physical device
connected to the object.
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Table 185: Binary Output Object Attributes - Focus/Configuration Tab
Attribute Name
Notes
Elapsed Active Time

Heavy Equip Delay

C,W

BACnet Notes Values/Options/Range Description
0–4,294,967,295
Represents the accumulated number of seconds
Present Value is Active since the Elapsed Active
Units = seconds
Time attribute was last set to zero. This attribute
value updates automatically a minimum of once a
day.
Not supported Range: 0–255 Seconds
Indicates the amount of time that this output
point adds to the Accumulated Delay attribute
of the Heavy Equipment Controller (HEC) object
when this point is started. The next output point
is delayed by that amount of time of the HEC
Accumulated Delay is not already decremented to
zero.
The NAE device’s five internal Heavy Equipment
Controller objects (see HED Controller) time
their delays independently of one another. For
example, HED 1 and HED 4 can count down their
delays at the same time.

HED Controller

C,W

Not supported 1–5

Identifies the Heavy Equipment Controller (HEC)
object managing the delays.
The NAE device has five internal Heavy Equipment
Controller objects for use by BO and Multistate
Output (MO) objects. The BO and MO objects
reference the heavy equipment delay (HED)
controller objects by number (1-5).

Inactive Text

Limit: 20 characters

All BO and MO objects on an NAE share the five
internal HED controller objects. For example, if
BO1 and MO3 on NAE-1 reference HED controller
1, they are using the same HED controller.
Characterizes the intended effect of the Inactive
state of Present Value attribute from the
viewpoint of the operator.
The content of this string is a local matter, but it
is intended to represent a readable description of
the Inactive state.

Intrinsic Alarming
Defined

C

Min Off Time

C,W

Not supported False
True
W

0–604,800
Units = seconds

Min On Time

C,W

W

0–604,800
Units = seconds

Out of Service

W

False
True
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For example, if the physical output is connected to
a switch contact, then the Inactive Text attribute
is assigned a value such as Fan 1 Off. If either the
Inactive Text or Active Text attribute is present,
then both are present.
Enables the definition of the intrinsic alarm
related attributes. For detailed information, see
BACnet Intrinsic Alarming.
Represents the fewest number of seconds Present
Value remains in the Inactive state after entering
the Inactive state.
Represents the fewest number of seconds Present
Value remains in the Active state after entering
the Active state.
Used to decouple the object from the physical
output. When out of service is True, the object will
decouple Present Value and Reliability from the
hardware. The Reliability will be writable when
Out Of Service is True. Not all devices support
setting this attribute to True.
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Table 185: Binary Output Object Attributes - Focus/Configuration Tab
Attribute Name
Polarity

Notes

BACnet Notes Values/Options/Range Description
Normal, Reverse
Indicates the relationship between the physical
state of the output and the logical state
represented by Present Value. If the Polarity
attribute is Normal, then the Active state of
the Present Value attribute is also the Active
or On state of the physical output as long as
Out of Service is False. If the Polarity attribute
is Reverse, then the Active state of the Present
Value attribute is in the Inactive or Off state of the
physical output as long as Out of Service is False.
If Out of Service is False for a constant physical
output state, a change in the Polarity attribute
produces a change in Present Value. If Out of
Service is True, the Polarity attribute has no effect
on Present Value. The N2 Polarity attribute is
always Normal.

Present Value

D,R,W

D,R,W

Inactive, Active States
Text attribute identifies
the value set for this
attribute.

Priority Array

Indicates the current value of the binary output.
Polarity determines the relationship between
Present Value and the state of the output.
Lists values of the object in level of importance.

Reliability

No Fault Detected
(Reliable), No Output,
Open Loop, Shorted
Loop, Unreliable Other,
Communication Failure

State Count Reset

W

States Text

C,W

States Text Error
Status

One state
from a set

B, W

Out of Memory, OK

Indicates whether the Present Value is unreliable
and why. When Out of Service is True, the
Reliability may be written directly.

Represents the date and time the COS Count
attribute was last set to a zero value. If the COS
Time, Change of State Count, or State Count Reset
attribute is present, all of these attributes are
present.
Indicates the displayed strings for the Present
Value.
Out of Memory: Indicates that memory overrun
has been encountered while adding custom
enumeration for state text from field device to the
user dictionary.
OK: Indicates that an addition of custom
enumeration for state text from the field device to
user dictionary is successful and state text from
the device can be used.

362

Metasys Site Management Portal Help

Table 185: Binary Output Object Attributes - Focus/Configuration Tab
Attribute Name
Status Flags

Notes

BACnet Notes Values/Options/Range
In Alarm, Fault,
Overridden, Out of
Service

Description
Represents four true or false flags that indicate
the general health of an analog output. Three
flags are associated with the values of other
attributes of the object.
The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag is
False (0).
Overridden - Overridden flag is Logical 1 if the
Present Value is decoupled from the hardware
output because operator intervention provided a
different value or local override is active.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Binary Output Commands
The table below lists the commands supported by the Binary Output Object.
Note: For the Release Operator Override, Release, and Release All commands, if all Command
Priorities have been released and a Relinquish Default is not defined, the supervisory
controller gives control over to the actual hardware.
Table 186: Binary Output Commands
Command
Name

Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.
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Table 186: Binary Output Commands
Command
Name

Parameters

Description

In Service

None

Cancels the affect of an Out of Service command
and returns the Out of Service attribute to False.
The Present Value and Reliability will revert back
to the values obtained from the physical hardware
output.
Note: For BACnet objects, support of this command is dependent on the ability to write the Out
Of Service attribute.

Operator
Override

The value to be written to the
Present Value.

Updates the Present Value at Command Priority
equal to Operator Override (8).
The Operator Override command sends the
specified command to the internal NxE object,
which is then only sent to the field device when
one of the following conditions is met:
•

NOT Local Control and NOT Out Of Service, or

•

NOT Local Control and after issuing the In
Service command.

Out of Service None

Allows a user to override the object’s hardware
output for simulation or other purposes. The
Out of Service command changes the Out of
Service attribute to True. The Present Value and
Reliability no longer track the physical output.
No commands are sent to the actual hardware.
When the Out of Service attribute is set to False,
the current Present Value is sent to the actual
hardware.
When an Out Of Service command is issued, the
NxE does not communicate subsequent changes
(operator or system) to the field device.
For BACnet objects, support of this command
is dependent on the ability to write the Out Of
Service attribute.

Release
Operator
Override

None

Releases Command Priority Operator Override (8)
from Present Value.

Release

1.

Attribute name

2.

Command priority

Releases the identified command priority from the
specified, writable attribute, and allows it to be
controlled by the next highest priority.
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Table 186: Binary Output Commands
Command
Name

Parameters

Description

Release All

Attribute name

Releases Command Priorities 3 through 16
(Default) from the specified, writable attribute.
Command Priorities 1 and 2 remain.
Important:

The Release All command may not cause an
immediate return to automatic operation.
The Release All command clears all
command priorities, including those that
come from applications and features. When
this happens, the output point goes to
its Relinquish Default condition. In some
cases, the application or feature may have
sent a command that does not match
Relinquish Default. In this instance, the
output point does not end in the state that
the applications or features intended. This
situation can cause unexpected operation to
occur; for example, a space might overcool
or overheat, a fan might run longer than
expected, and so on.
If an operator has overridden an input, use
the Release Operator Override command.
State0 ...
State1

None

Releases Command Priorities 9 through 15
(Scheduling) and then writes to the Present Value
at the Default (16) command priority. If this is
the highest, it is sent to the controller. The state
command names and number of commands are
dependent on the States Text attribute.
Important: Be aware that an operator state command releases the actions of any processes running to the object in the NxE or FEC controllers
that use Priorities 9 through 16. Consider this
behavior when creating control strategies.

If Local Control is True, this command is rejected.
Temporary
Override

The value to be written to
the Present Value attribute,
in addition to the duration
of the override in hours and
minutes.

Overrides a point temporarily for a specified
period of time. After the specified time period
passes, the Override is automatically released.

Binary Value Object
Menu Selection: Insert > Object > BV
BV objects have similar software characteristics and capabilities to a Binary Input Object; however,
Binary Value objects are not associated with any physical hardware and are the result of a control
process or operator entry. This object allows you to hold a binary value for other objects to
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reference. For example, an Interlock can reference and base its operation on a binary value such as
duty/standby.
For general information on Metasys system objects, see Common Object Attributes.

Binary Value Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Extension’s Reliability, W - Writable.
Table 187: Binary Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Active Text

Active Time
Reset

Connected
To Internal
Application
COS Count

Notes

W

BACnet
Notes

Values/Options/
Range
Limit: 20
characters

B, W

B, W

W

Initial Value

No

No or Yes

0

0–4,294,967,295

Description
Characterizes the intended effect of the Active
state of Present Value from the viewpoint of the
operator. The content of this string is a local
matter but is intended to represent a readable
description of the Active state. If either the Active
Text or the Inactive Text attribute is present, both
of them are present.
If either Inactive Text or Active Text is present,
both are present.
Represents the last date and time Elapsed Active
Time set to a zero value. If either Elapsed Active
Time or Time of Active Time Reset is present,
both are present.
Indicates whether the object is connected to an
internal application.
This attribute is persisted in the archive.
Represents the number of times the Present
Value attribute changed state since the COS
Count attribute was last set to zero. A change of
state is any event that alters Present Value. This
attribute persists in the archive.

COS Time

Elapsed Active
Time

If Change of State Time, Change of State Count,
or State Count Reset is present, all are present.
Represents the date and time at which the most
recent change of state occurred. A change of
state is any event that alters the logical state of
Binary Value.

Null

Null

0–4,294,967,295
Units = seconds

If Change of State Time, Change of State Count,
or State Count Reset is present, all are present.
Represents the accumulated number of seconds
Present Value is Active since the Elapsed Active
Time attribute was last set to zero. This attribute
value updates automatically a minimum of once
a day.
If either Elapsed Active Time or Active Time Reset
is present, both are present.
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Table 187: Binary Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Failsoft
Currently
Active

Notes

BACnet
Notes

Initial Value

Inactive Time

Values/Options/
Range
Yes or No

Limit: 20
characters

Description
Specifies whether the Failsoft feature is currently
overriding the input value to a reliable default. If
No, Failsoft is disabled or, if Failsoft is enabled,
the value is reliable. If Yes, Failsoft is enabled and
the value is unreliable. This attribute is only used
if Property Ref Value is defined to reference an
application.
Characterizes the intended effect of the Inactive
state of Present Value attribute from the
viewpoint of the operator.
The content of this string is a local matter, but it
is intended to represent a readable description
of the Inactive state.
If either the Inactive Text or Active Text attribute
is present, both are present.

Intrinsic
Alarming

C

Min Off Time C,W

Not
supported

False

W

0

False
True

0–4,294,967,295
Units = seconds

Min On Time

C,W

W

0

0–4,294,967,295
Units = seconds

Monitor Only

False

Out of Service

W

Present Value D,R,W

D,R,W

False

Always False

Inactive, Active
States Text
attribute identifies
the value set for
this attribute.

If either Inactive Text or Active Text is present,
both are present.
Enables (True) or disables (False) BACnet intrinsic
alarming for this object. When disabled, writing
to any of the intrinsic alarming attributes returns
a Write_Access_Denied error. When disabled,
reading the intrinsic alarming attributes returns
the default value of each attribute. For detailed
information, see BACnet Intrinsic Alarming.
Represents the least number of seconds Present
Value remains in the Inactive state after entering
the Inactive state.
Represents the least number of seconds Present
Value remains in the Active state after entering
the Active state.
Defines the behavior of the object as an input
or output. If you do not specify a Property Ref
Value, the attribute is set to False. This attribute
appears only in the Snapshot Focus view.
Indicates the offline/online state of the
connected hardware. This attribute exists for
compatibility with BACnet protocol and indicates
whether the physical input that the object
represents is in service. When out of service,
the physical input is not coupled to changes
in the Present Value. The object does not send
commands to the hardware. This attribute is
always False due to the absence of hardware.
Indicates the current value of the binary
value. When Out of Service is True, Present
Value is writable. Present Value is optionally
commandable. If Present Value is commandable,
Priority Array and Relinquish Default are both
present.
Present Value is commandable; it is also writable.
This attribute is writable when Out of Service is
True.
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Table 187: Binary Value Object Attributes - Focus/Configuration Tab
Attribute
Notes
Name
Priority Array

Property Ref
Value

BACnet
Notes

Initial Value

N

Values/Options/
Range

Object Name,
Reference,
Attribute

Referenced
Reliability

No Input

Referenced
Value

Referenced
Value COS
Count

W

0

Reliability

W

W

State Count
Reset

W

B, W

Reliable

Description
Lists values of the object in level of importance.
If Priority Array or Relinquish Default is
present, both are present. If Present Value is
commandable, Priority Array and Relinquish
Default are both present and Present Value is
writable.
Specifies an object and attribute (usually from an
application) for which the BV object is providing
the standard interface. The object and attribute
contained in this attribute must be a local object
and is often a non-BACnet data source and
destination. When this property is not defined,
the Monitor Only property is set to False. This
attribute appears only in the Snapshot Focus
view.
Specifies the current reliability of the value sent
to or from the object/attribute referenced by
Property Ref Value. This attribute is only used
if Property Ref Value is defined to reference an
application.
Specifies the current value sent to or from the
object/attribute referenced by Property Ref
Value. This attribute is only used if Property Ref
Value is defined to reference an application.
Counts how many times the Present Value
and Reliability have changed. If the Monitor
Only attribute is True, the count is how many
times the Property Ref Value has updated the
BV. If Monitor Only is False, the count is how
many times Property Ref Value has updated the
BV. This attribute helps to diagnose excessive
changes that can cause logic to execute taking
up too much bandwidth. Reset the count by
entering 0 for this attribute. This attribute is only
used if Property Ref Value is defined to reference
an application.

No Fault Detected Indicates whether the Present Value is unreliable
(Reliable),
and why.
Unreliable Other,
Communication
Failure
Represents the date and time the COS Count
attribute was last set to a zero value. If COS Time,
Change of State Count, or Time of State Count
Reset is present, all are present.
If Change of State Time, Change of State Count,
or State Count Reset is present, all are present.

States Text
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C,W

Inactive, Active

Indicates the displayed strings for the Present
Value. For BACnet compliant objects, if no States
Text is specified when the object is created, the
Inactive Text and Active Text are used to derive
the equivalent States Text if possible.
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Table 187: Binary Value Object Attributes - Focus/Configuration Tab
Attribute
Name
States Text
Error Status

Notes

BACnet
Notes

Initial Value
OK

Values/Options/ Description
Range
Out of Memory, OK Out of Memory: Indicates that memory overrun
has been encountered while adding custom
enumeration for state text from field device to
the user dictionary.
OK: Indicates that an addition of custom
enumeration for state text from the field device
to user dictionary is successful and state text
from the device can be used.
In Alarm, Fault,
Contains four true or false flags that indicate
Overridden, Out of the general health of the object. Three of the
Service
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you can achieve a clearer
picture of the object status.

Status Flag

The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if
the Present Value has been overridden by
some mechanism local to the BACnet device
or because operator intervention provided a
different value.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.
Use Remote
Alarming

B,C,W

False

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Binary Value Commands
The table below lists the commands supported by the Binary Value Object.

Metasys Site Management Portal Help

369

Table 188: Binary Value Commands
Command
Name

Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable Alarms None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Operator
Override

Updates the Present Value at Command Priority
Operator Override (8).
The Operator Override command sends the
specified command to the internal NxE object,
which is then only sent to the field device when
one of the following conditions is met:

The value to be written to the
Present Value attribute.

•

NOT Local Control and NOT Out Of Service, or

•

NOT Local Control and after issuing the In
Service command.

Release
Operator
Override

None

Releases Command Priority Operator Override (8)
from Present Value.

Release

1.

Attribute name

2.

Command priority

Releases the identified command priority from the
specified, writable attribute, and allows it to be
controlled by the next highest priority.

Release All

Attribute name

Releases Command Priorities 3 through 16 from
the specified, writable attribute. Command
Priorities 1 (Manual Emergency) and 2 (Fire
Application) remain.
Important: The Release All command may not
cause an immediate return to automatic operation. The Release All command clears all command priorities, including those that come from
applications and features. When this happens, the
output point goes to its Relinquish Default condition. In some cases, the application or feature may
have sent a command that does not match Relinquish Default. In this instance, the output point
does not end in the state that the applications or
features intended. This situation can cause unexpected operation to occur; for example, a space
could overcool or overheat, a fan might run longer
than expected, and so on. If an operator has overridden an input, use the Release Operator Override command.

State0

None

Releases Command Priorities 9 through 15
(Scheduling) and then writes to the Present Value
at the Default (16) command priority.
Important: Be aware that an operator state command releases the actions of any processes running to the object in the NxE or FEC controllers
that use Priorities 9 through 16. Consider this
behavior when creating control strategies.
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Table 188: Binary Value Commands
Command
Name

Parameters

Description

State1

None

Releases Command Priorities 9 through 15
(Scheduling) and then writes to the Present Value
at the Default (16) command priority.
Important: Be aware that an operator state command releases the actions of any processes running to the object in the NxE or FEC controllers
that use Priorities 9 through 16. Consider this
behavior when creating control strategies.

Temporary
Override

The value to be written to
the Present Value attribute,
in addition to the duration
of the override in hours and
minutes.

Overrides a point temporarily for a specified
period of time. After the specified time period
passes, the Override is automatically released.

Calendar Object
Menu Selection: Insert > Object > Calendar
The Calendar object is used behind the scenes by the Scheduling feature by maintaining a list of
dates designated as exceptions to the normal schedule. Exception Schedule days are days when
you do not want the Schedule to operate, such as holidays. They can be defined as specific dates or
ranges of dates. Typically, a Schedule object references a Calendar object, which lists the days the
weekly schedule should not operate. A Schedule object working from a chosen Calendar reads the
Present Value of the Calendar object, which indicates if the current day is within the Date List (Entry
Detail) of the Calendar.
A different set of activities from those in the weekly schedule can be defined in the Schedule object
to occur on these exception days. Multiple Schedule objects can reference a single Calendar object
so that only the Calendar object needs to be changed to affect all schedules.
This object allows you to accommodate for a special day or days, like a holiday, in which the
building controls should run differently from usual, in accordance with the change in the number of
people and the amount of activity in the building.
When you create a Calendar object at a BACnet client and map the object to a network engine, a
new Calendar object is created under that folder in the navigation tree.
For general information on Metasys system objects, see Common Object Attributes.
For more information on the Scheduling feature and how to create a calendar, see Scheduling.
For more information on Global Calendars, see Global Calendar. For detailed information on the
Calendar object, see the following table.

Calendar Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the Notes and BACnet Notes columns, attributes marked with the letter C are
configurable, attributes marked with the letter D are the default for display, and attributes
marked with the letter W are writable.
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Table 189: Calendar Attributes - Calendar Tab
Attribute Name
Date List (Entry Detail)

Notes
C,W

Global Calendar Object
Reference

C,W

Global Calendar Update

BACnet Notes Initial Value Description
W
Lists dates defined as entries to the Calendar object.
Each entry is either an individual date, range of
dates, or month/week-of-month/day-of-week
specification. If the current date matches any
calendar entry, the Present Value is set to True. Also,
individual fields of an entry can be left unspecified,
thus acting as wildcards, or include all options. If a
device allows writing to Date List, all date choices are
permitted.
W
Specifies a globally referenced calendar (if any)
used as the master calendar for the site. Specifying
a global calendar allows a site to synchronize
many calendars so that only a single calendar
(master calendar) needs to be changed. If you are
using calendar references, you usually set up field
controllers that reference a calendar on the engine,
and engines that reference a calendar on a single
supervisory engine, which is designated as the
master calendar.
Specifies a time and date when the local calendar
date list was last updated from the master calendar.
If no calendar is referenced by the device, then the
global calendar update remains unspecified.
Note: If a calendar references a master
calendar, the date list is not writable and the
Edit button within the SMP UI is unavailable.

Present Value

D

D

False

Indicates the current value of the Calendar. Present
Value is True if the current date is in the Date List
(Entry Detail) and False if the current date is not in
the Date List.

Scheduling
The scheduling feature allows you to automate routine functions such as changing the operating
mode of a room from occupied to unoccupied for heating or cooling needs and helping perform
energy optimization strategies. Each schedule consists of a list of weekly scheduled events as well
as a list of exception events. Each event consists of a value to write to a list of Scheduled Items
at a particular time. The event by default ends at midnight unless ended earlier. The scheduling
feature’s user interface provides a graphical view for configuring the schedule and displaying when
events are scheduled to occur.

Scheduling Concepts
Calendar
The Calendar Object resides in an Engine or FAC and is the internal basis for the calendar
functionality of the scheduling feature. Create a Calendar and use it to define a list of holidays or
special events that can be used in multiple schedule objects to define different events that need
to occur. The schedule executes an exception schedule based on the list of dates defined in the
calendar. For example, use a calendar to define different building operations on days such as
holidays when the building is not occupied.
A schedule can reference calendars on any Engine or FAC on the site.
Use the calendar feature to:
•
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create new calendars You cannot create a new Calendar in an FAC from SMP or CCT.
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•

edit existing calendars

•

copy and paste a calendar to another device or item (offline mode), only in the NAE

•

toggle the calendar view between a graphical, one-month view, or 12-month view

•

enable or disable a calendar

• reference a global calendar
The following table describes the functions of the Calendar View’s buttons.
Table 190: Calendar Button Functions
Button

Function
Opens Edit mode
Shows the Date, Date Range, and Week and Day details of the
calendar entries and allows you to create new entries or edit
existing entries when in Edit mode.
Increases or decreases the currently displayed year by one year.
Increases or decreases the currently displayed month by one
month.
Returns the display to the current month.
Toggles the calendar display between the 1-month view and 12month view.

Schedule
The Schedule Object resides in an Engine or FAC and is the internal basis for the Scheduling feature.
Create a Schedule and use the Scheduling feature to define the items and times when the Schedule
writes values to the referenced attributes of the Scheduled Items. Each schedule includes the
following:
•

a view of today’s schedule that shows what actions the schedule is currently configured to
perform today, including the Default Schedule Command. This view is not available in the SCT.

•

a weekly schedule that uses events for each day (Monday through Sunday) to configure the
times when the Schedule writes values to its referenced attributes (Scheduled Items)

•

an exception schedule that uses events to configure exceptions to the weekly schedule
(optional)

•

a list of items that the schedule controls (referenced by the schedule, called Scheduled Items)
(optional)

•

an effective period that optionally allows you to activate or inactivate the schedule for a
selected period of time
Use the scheduling feature to:
•

create new schedules You cannot create a new Schedule in an FAC from SMP or CCT.

•

edit existing schedules

•

add references to items for scheduling to a schedule using a navigation tree of the site
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•

delete references to items for scheduling from a schedule

•

copy and paste a schedule to another device or item (offline mode), only in Engines

•

enable or disable a schedule, not in an FAC

•

change the effective period of a Schedule

• provide day and time inputs within control logic
The following tables describe the functions of the Schedule View’s buttons and attributes and rightclick menu.
Table 191: Schedule Button Functions
Button

Function

Edit

Opens Edit mode

Effective Period

Click the Browse icon to open the Effective Period dialog box
which allows you to specify the From and To values for the
effective period.

Schedule Output Type

Binary, Analog, Multistate, Derived from Values — each
of these choices brings up unique choices in the Default
Schedule Command and State Text fields.

Default Schedule Command

Binary: Release option or a choice of Off and On
Analog: Release option or a choice to input a number
Multistate: Release option or a choice of State 0 to State 31
Derived from Values: Release option or a choice of Off and On
Note: If the Default Schedule Command is set to Release, the
scheduling feature’s control over the scheduled items ends.
Release should only be used for the Default Schedule Command
if the scheduled items support the Release command.

States Text

Allows you to specify the state of the selected event, which is
unique for each Schedule Output Type.

Display Mode

Allows you to toggle between views: Today's Schedule, Weekly
Schedule, Exception Schedule, or Scheduled Items.

Table 192: Schedule Right-click Menu (this menu is accessible only when Edit mode is used)
Menu Option

Description

Display Mode - Weekly Schedule
Binary

The States Text selection controls the right-click menu. For
example, select between Off and On, Off and Reset, Absent and
Present, Active and Inactive, or Alarm and Normal.

Add Event(s)

Opens the Define New Event(s) dialog box and allows you to add
an event to the schedule.

End Event

Allows you to specify an event end time. The end time
corresponds to the location of your mouse cursor when you
opened the menu. Drag the end of the event to adjust the end
time.

Analog

Right-click and select Add Event(s), or select an event, right-click,
and select Modify Selected Event(s). Add Event(s) allows you to
specify the Day or Days, Hours, Minutes and Value of a new event.
Modify Selected Event(s) allows you to modify the Hours, Minutes,
and Value of an existing event.
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Table 192: Schedule Right-click Menu (this menu is accessible only when Edit mode is used)
Menu Option

Description

Add Event(s)

Opens the Define New Event(s) dialog box and allows you to add
an event to the schedule.

End Event

Allows you to specify an event end time. The end time
corresponds to the location of your mouse cursor when you
opened the menu. Drag the end of the event to adjust the end
time.

Multistate

The States Text selection controls the right-click menu. For
example, toggle between Not Operating, Normal Start, Heating,
Cooling, Fan Only, or Minimum DAT Control.

Modify Selected Event(s)

Opens the Modify Event(s) dialog box and allows you change the
times and value of the selected event. You can also double-click an
event to access the Modify Event(s) dialog box.

Delete Selected Event(s)

Deletes the selected event.

Display Mode - Scheduled Items
All Scheduled Output Types

Choose between Make Key Item or Remove Item.

Today’s Schedule
The scheduling feature includes a view called Today’s Schedule. Today’s Schedule is a read-only
view that shows the schedule timeline for the current day. The timeline displays the projected
schedule output that is written to the scheduled objects for the current day, combining the default
Schedule Command with events from both the Weekly Schedule and Exception Schedule. Today’s
Schedule also displays a table of times and values, which details the changes in the schedule’s
output for the current day.
Weekly Schedule
The scheduling feature has a weekly schedule that provides a schedule for each day of the week,
Monday through Sunday. Each daily schedule begins at 00:00 and ends at 23:59. Each day consists
of events that initiate the writing of values to the referenced attributes of the scheduled items
based on the day of the week. For example, you can schedule a fan to start at 7:00 and stop at 22:00
on Mondays.
To edit the weekly schedule, double-click or right-click the weekly schedule. Right-clicking brings up
the context menu (see Table 192).
Exception Schedule
The exception schedule provides a list of exceptions to the weekly schedule. Exceptions define a
different set of events that supersede the events for particular days in the weekly schedule. An
exception can be defined for a date, a date range, a week and day, or a reference to a Calendar. The
following table contains information on the four types of exceptions. Wild cards can also be used to
define exceptions; see Wildcards for more information.
Table 193: Exception Types
Exception Type

Description

Date

Occurs on a specific date.

Date Range

Occurs during a range of dates.
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Table 193: Exception Types
Exception Type

Description

Week and Day

Occurs on certain weekdays during certain weeks of certain months. For
example, the second Tuesday in any month or any Wednesday in June.

Calendar Reference

Occurs during all dates selected in the referenced calendar. Associating
an exception with a calendar allows you to reference a large number of
dates.

Note: The N1 exception schedule only supports the Date exception. For example, to schedule
the same exception 3 days in a row using an N1 Exception schedule requires the use of three
separate date exception entries. Date range, week and day, and calendar reference exceptions
are not supported.
Each exception can have one or more events that run during the exception time period. Recall the
example in the Schedule topic where you scheduled a fan to start at 7:00 and stop at 22:00 on all
Mondays. You can create a date type exception to this weekly schedule if you want the fan to start
and stop at different times on a certain day. For example, you can create an exception for Monday,
May 26, and define an Off event at the start of the day (00:00), an On event at 9:00 in the morning
(instead of 7:00), and another Off event at 17:00 in the evening (instead of 22:00). If you do not
define the Off event at 00:00, the Weekly Schedule takes effect between 00:00 and 09:00, and the
fan turns on at 07:00 as originally scheduled.
You can assign a precedence level (1–16, where 1 receives the highest precedence) to each
exception, regardless of type, to determine the order of execution. If you define two or more
exceptions for the same date, the exception with the highest precedence executes. For example, an
exception with a precedence of 2 executes over an exception with a precedence of 8 if they are both
defined for the same date.
If all exceptions for the same date have the same precedence, the exception that appears first in
the exception list executes first; therefore, if you have multiple exceptions defined for one day, the
exceptions apply by precedence level and then by the order of the items in the exception list.
Double clicking the exception schedule allows you to edit the exception schedule.
The JCI Exception Schedule attribute for the engine object (also an FAC mapped to an engine)
allows you to set how long exception schedules are kept after the exception date has expired.
The default value is Auto Delete 31 days. Two options, Auto Delete 7 days and Manual Delete are
available for this attribute. See the JCI Exception Schedule attribute configuration in the Engine
Device Object section for more information.
Note: Manual Delete is needed for locations like Japan where the local standards state that
only the BACnet workstation can delete exception schedules.
Events
An event describes the time when the scheduling feature writes user-defined values to the
referenced item attributes (Scheduled Items). Weekly schedules and exception schedules use an
event to define when the scheduling feature should change its output.
Each day of a weekly schedule and each exception day of an exception schedule has its own set
of events. Days can have multiple events (for example, a start event and a stop event). When the
time defined by an event arrives, the scheduling feature writes the value for the defined event
to the referenced attribute of each item in the list of scheduled items. Unless specified to end
earlier, all events end at midnight. If an event is ended before midnight, and no other events are
scheduled, the scheduling feature writes the Default Schedule Command to the referenced item
attributes. If the Default Schedule Command is set to Release, the scheduling feature’s control over
the scheduled items ends. Values are sent to the referenced attributes at priority 15.
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Note: Release should only be used for the Default Schedule Command if the scheduled items
support the Release command.
Scheduled Items
Scheduled items are the objects and attributes that the event values are written to. A schedule can
operate with an empty Scheduled Items list. The scheduling feature writes the defined value to
the scheduled items at the time defined by an event. Schedules defined in an NAE can reference
any item that can be mapped into an Engine or Metasys Server. Schedules defined in an FAC can
reference items only within that FAC, even if those items are not mapped to an Engine. Adding
items to a schedule involves selecting the item and then selecting the attribute of the item that you
want the schedule to change. At the times defined by an event, the schedule writes the defined
values to the scheduled attribute associated with each referenced item.
When there are no events active in the weekly schedule or exceptions, the schedule writes the
Default Schedule Command to the referenced attributes. If the Default Schedule Command is set to
Release, the schedule’s control over the scheduled items ends.
Note: Release should only be used for the Default Schedule Command if the scheduled items
support the Release command.
The table of scheduled items provides the Status Log entry for each scheduled item. The status log
indicates any errors that occurred when the scheduling feature attempted to write values to the
scheduled items.
A single schedule can only apply values of one data type to all items in its list of scheduled items;
therefore, the first item in the Scheduled Items list becomes the key item. The key item determines
the data type of the values that the schedule writes to the attributes of all scheduled items.
See the following example scenario for a description of how scheduled items work.
Example Scenario
If you use CCT and create a MASD air handling system in a field controller, you can select the OCCSCHEDULE multi-state value as the scheduled item. The state selection modes for this item include
Occupied, Unoccupied, and Standby. The application automatically manages the setpoint and logic
changes when the unit switches between Occupied and Unoccupied.
Dates - Calendar Entry and Exception Schedule
You can use the following date formats for defining exceptions to the weekly schedules using
calendar entries or exception schedules:
•

Date

•

Date Range

•

Week and Day

BACnet Clarification for Date Entries
ASHRAE has published a BACnet addendum 135-2008H Part 8 to clarify what is allowed in the
format of calendar entries for single dates and range of date formats in the Calendar object and
the exception schedule (the dates you want the Schedule to operate in a special way, such as
holidays). If the BACnet Compatible attribute in the Device object is set to True, these BACnet rules
are enforced.
For a Calendar object Date entry, the entry can be either a specific date or a date pattern:
•

a specific date has all fields filled with specific values, including the Day of Week

• a date pattern has some fields filled with odd, even, last, or the any wildcard
For a Calendar object Date Range entry, the new rules restrict each part (start date and end date) to
be one of the following:
•

a fully specified date (all fields defined)
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•

a completely unspecified date (no fields defined - all fields use the any wildcards, which means
the Start Date is immediate or the End Date is never)
Note: For Date Range, the Metasys system currently allows partial wildcard fields for the
start and end dates, which leads to unpredictable operation in some cases. Therefore, to
avoid undesired results, do not use partial wildcard fields for the start date or end date. The
examples in Table 194 illustrate valid date range entries and their meanings. The examples
in Table 195 show three invalid date range entries. Be sure to follow the new BACnet rules to
avoid these kinds of entries.

Table 194: Valid Wildcard Date Range Examples
Example Duration
1
From
To
2
From
To
3
From
To

Month
Aug
any
any
Jul
Jan
April

Day
30
any
any
4
1
30

Year
2015
any
any
2015
2015
2015

Day of Week
Sunday
any
any
Saturday
Thursday
Thursday

Meaning
Starts on Sunday, August 30, 2015 and
continues indefinitely.
Continues until Saturday, July 4, 2015
Starts on Thursday, January 1, 2015 and
ends on Thursday, April 30, 2015

Table 195: Invalid Wildcard Date Range Examples
Example
1
2
3

Duration
From
To
From
To
From
To

Month
any
any
any
any
May
September

Day
3
6
any
any
any
any

Year
any
any
any
any
2014
2014

Day of Week
any
any
Saturday
Sunday
Saturday
Sunday

Note: No partial wildcard (any) fields for start date or end date are allowed in order to
eliminate cases that could not be clearly interpreted and implemented.
Date and Date Range
You can use a single date or a range of dates when defining exceptions to a weekly schedule. The
following table describes the options available for defining a single date or a range of dates entry
for a calendar or exception schedule.
Table 196: Date and Date Range Format
Menu

Date

Date Range

Month

any
January through December
Odd (odd numbered months)
Even (even numbered months)

any
January through December

Day

any
1 through 31
Last (the last day of the month)
Even (even numbered months)
Odd (odd numbered months)

any
Last (the last day of the month)
1 through 31

Year

any
2006–2048

any
2006–2048

Day of Week

any
Monday through Sunday

any
Monday through Sunday
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Tip: If you specify a single date (that is, you define the specific day, month, and year), the
system figures out the Day of Week for you. For example, if you enter July 9, 2015 and leave the
Day of Week entry as any, the system fills in Thursday. Also see Data Consistency Checking.
Note: For exception schedule entries, you also need to define the Precedence at which the
schedule executes the exception schedule.
Week and Day
You can use a week and day entry when defining exceptions to the weekly schedule. The following
table describes the options available for defining a week and day calendar or exception schedule
entry (for example, the Saturday of the first week in May). A mixture of any and specified entries is
allowed. Week and day entries apply to all years.
Table 197: Week and Day Format
Menu

Options

Month

any, January through December, Odd (odd numbered months), Even (even
numbered months)

Week of Month

any
1 = Days 1 through 7
2 = Days 8 through 14
3 = Days 15 through 21
4 = Days 22 through 28
5 = Days 29 through 31
6 or last = Last seven days of the month

Day of Week

any, Monday through Sunday

Note: For exception schedule entries, you also need to define the Precedence at which the
schedule executes the exception schedule.
Wildcards
You can use wildcards to define date entry calendar or exception schedule exceptions. You can also
program special dates, such as even or odd months, or the last day of the month. Wildcards are the
fields of an exception schedule or calendar entry date specified by the any selection. For example,
an exception date of December 25, any year, and any day of week means the events defined in the
exception schedule occur on December 25 of every year regardless of the events defined in the
weekly schedule. To use wildcards, select any from the drop-down menu of the Exception Detail or
Calendar Entry dialog box.
For exceptions, the wildcard part of the date appears as any in the list of exceptions. For example,
December 25, any year Precedence 8 appears in the list of exceptions after saving the selections
described in the following table for a single Date entry.
Table 198: Schedule Wildcard Example - Single Date
Parameter

Value

Month

December

Day

25

Year

any

Day of Week

any

Precedence

8
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For calendars, the wildcard part of the date appears as any in the calendar entries list. For example,
Month = February, Day = 2, Year = any appears in the calendar entries list after saving the
selections described in the following table for a single Date entry.
Table 199: Calendar Wildcard Example - Single Date
Parameter

Value

Month

February

Day

2

Year

any

Day of Week

any

You can use wildcards for the following types of exceptions and calendar entries:
•

Date

•

Date Range (all Start Date or End Date fields must be set to any)

•

Week and Day

Wildcards - Date
For a single date, a wildcard opens a particular field to the full range of possible values for that
field. The following table describes the meaning for each type of unspecified wildcard or special
date field.
Table 200: Unspecified Wildcard Date Field Meanings
Unspecified Field

Meaning

Month

Any = every month
Odd = only odd numbered months (1, 3, 5, 7, 9, 11)
Even = only even numbered months (2, 4, 6, 8, 10, 12)

Day of Month

Any = every day of the month (unless limited by Day of Week entry)
6 or Last = last day of the month
Odd = only odd numbered days of the month (1, 3, 5, 7, 9, 11, and so on)
Even = only even numbered days of the month (2, 4, 6, 8, 10, 12, and so on)

Year

Any = every year

Day of Week

Any = every day of the week, unless a particular day of the month is
specified by the Day of Month field

The following table shows some sample wildcard dates or special dates and their meanings.
Table 201: Sample Wildcard Date Meanings
Month

Day of
Month

Year

Day of
Week

Meaning

any

01

any

any

The first day of every month, every year

Mar

05

any

any

March 5 of every year

Mar

any

2010

any

Every day in March 2010

any

any

any

any

Every day

any

any

any

Friday

Every Friday

any

any

2010

Friday

Every Friday in 2010

Mar

any

2010

Friday

Every Friday in March of 2010

Mar

12

2010

Friday

Only on Friday, March 12, 2010
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Table 201: Sample Wildcard Date Meanings
Month

Day of
Month

Year

Day of
Week

Meaning

Apr

13

any

Monday

Every April 13 that occurs on a Monday

Even

2

2010

any

The second of every even numbered month
in 2010: February 2, April 2, June 2, August
2, and so on

any

last

2010

any

The last day of every month in 2010

May

odd

any

any

Every odd numbered day in May

May

even

any

any

Every even numbered day in May

Wildcards - Date Range
For a range of dates, the start date and end date can be fully specified dates (all fields defined)
or completely unspecified dates (all fields use any). If the start date is a fully specified date, then
the end date can be a completely unspecified date (all fields use any wildcards). If the start date
is a completely unspecified date (all fields use any wildcards), then the end date must be a fully
specified date. The Day of Week must be set to match the day of the week for all specified dates.
See Table 194 for an example.
Wildcards - Week and Day
You can use wildcards for Week and Day entries. The Week and Day selection identifies a month,
a week of the month, and a day of the week. The possible selections include any as the week of
the month (that is, the entire month), 1 (Days 1–7), 2 (Days 8–14), 3 (Days 15–21), 4 (Days 22–28), 5
(Days 29–31), and 6 or last (the last seven days). The following table shows some sample wildcard
week and day exceptions.
Table 202: Sample Wildcard Week and Day Exceptions
Month

Week of Month Day of Week

Meaning

any

any

any

Every day of the year

any

1
Days 1–7

Monday

Monday of the first week of every month

Jan

any

Tuesday

Every Tuesday in January

Feb

2
Days 8–14

any

Every day of the week in the second week of February

any

any

Wednesday

Wednesday of every week of every month

Mar

any

any

Every day of every week in March

any

3
Days 15–21

any

Every day of the third week of every month

Apr

4
Days 22–28

Thursday

Thursday in the fourth week of April

any

5
Days 29–31

any

29th, 30th, and 31st (as applicable) of every month

Jun

6 or Last
Saturday
Last seven days
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Effective Period
The effective period defines the active or inactive date range for a schedule (weekly and exception
schedule) using the date range rules. In Edit mode, the Browse icon opens the Effective Period
dialog box. By default, a schedule is always active.
For example, you can create two schedules with the same items/objects and configure one for the
heating season and the other for the cooling season. Then you can define the effective period of
the heating schedule from October through March and the cooling schedule from April through
September of each year.
Trend Scheduling
Use the Schedule feature to configure time and day periods for recording trend data for object
trend extensions. In the schedule, add the trend extension to the Scheduled Items list and select
the desired trend extension attribute. Make sure the trend extension is the Key Item in the
Scheduled Items list. Then use the weekly schedule to define the days and times you want to record
trend data for the selected object trend extension.
For more information on trend extensions and trending, see the examples below and click one of
the following:
•

Extensions

•

Trend Extensions

• Trend Studies
For instructions on how to schedule a trend extension, see Scheduling a Trend Extension.
Example 1:
To collect trend samples starting at 6:00 AM Monday through Friday and at 8:00 AM on Saturday
and Sunday, and stopping trend collection at 8:00 PM on all days, configure a schedule as follows:
In the Scheduled Items list, add the desired object trend extension and select the trend extension’s
Enabled attribute as the Scheduled Attribute. Make sure the trend extension is the key item.
On the Weekly Schedule tab, set the Default Schedule Command to False and configure the event to
begin and end according to the following table:
Table 203: Example 1 - Event Configuration
Time

Value

Monday - Friday
6:00 AM - 8:00 PM (06:00 - 20:00)

True

Saturday - Sunday
8:00 AM - 8:00 PM (08:00 - 20:00)

True

Example 2:
You may want to define how many trend samples are collected during specific periods of time.
You can use a shorter trend sampling interval to collect more trend samples during the day when
there is more activity in the building, and use a longer trend sampling interval to collect fewer trend
samples at night when there is less activity in the building.
To take samples every 60 seconds from 6:00 AM to 6:00 PM Monday through Friday, every 600
seconds from 6:01 PM to 5:59 AM Monday through Friday, and every 600 seconds from 12:00
Midnight to 11:59 PM on Saturday and Sunday, configure a schedule as follows:
In the Scheduled Items list, add the desired object trend extension and select the trend extension’s
Sample Interval attribute as the Scheduled Attribute. Make sure the trend extension is the key item.
On the Weekly Schedule tab, set the Default Schedule Command to 600 seconds and configure the
event to start and end according to the following table:
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Table 204: Example 2 - Event Configuration
Time

Value

Monday - Friday
6:00 AM - 6:00 PM (06:00 - 18:00)

60 (seconds)

Fast Clock
A device that includes schedules activates the fast clock feature when the current date and time are
changed in the device, the device restarts following a power failure or reset, or the device is put into
simulation mode. The fast clock feature ensures the schedule and its associated scheduled items
are in the correct state based on day and time of the device.
The fast clock evaluates the events scheduled for the current day from midnight to the current
time, to find the last scheduled time and value for the current day. If the fast clock does not find any
scheduled events, then the value associated with the latest time for the current day is used. Then
the fast clock writes this value to all scheduled attributes of all items referenced by the schedule’s
list of scheduled items.
Data Consistency Checking
The exception schedule or calendar verifies the existence of exception and calendar dates and that
the start date of a date range occurs earlier than the end date for schedules and calendars when:
•

Exception and calendar dates have all four fields defined and do not use wildcards (Month, Day
of Month, Year, and Day of Week). For example, if you entered Monday, January 10, 2010, in
the Exception Detail or Calendar Entry Detail dialog box, a warning message appears because
January 10, 2010, is not a Monday.

•

Exception and calendar dates have Month, Day of Month, and Year defined and use a wildcard
for the Day of Week field. For example, if you entered February 29, 2010, and any in the Day
of Week field of the Exception Detail or Calendar Entry Detail dialog box, a warning message
appears because there is no 29th day in February, 2010.

•

Exception and calendar date ranges have all fields of both the start and end dates defined. For
example, if you entered a start date of Tuesday, July 2, 2010, and an end date of Monday, July 6,
2010, in the Exception Detail or Calendar Entry Detail dialog box, a warning message appears
because July 2, 2010, is not a Tuesday.

•

Exception and calendar date ranges have Month, Day of Month, and Year defined and use a
wildcard for the Day of Week field for both the start and end dates. For example, if you entered
a start date of August 27, 2010, and any in the Day of Week field, and an end date of August 6,
2010, and any in the Day of Week field in the Exception Detail or Calendar Entry Detail dialog
box, a warning message appears because the end date occurs before the start date.
Because the Schedule can reference Calendars residing in another device, the scheduling feature
performs the following calendar reference verification:
If a schedule references a calendar in another device and that device goes offline, the schedule
assumes that while the device is offline, the calendar’s Present Value does not change. For
example, a schedule residing on NAE1 refers to a calendar residing on NAE2 and the Calendar
Object’s Present Value attribute is True; however, if NAE2 is offline at midnight, the schedule
assumes the calendar’s Present Value changes to False at midnight. This means that the exception
schedule is not active.
If a schedule refers to a calendar and that calendar is deleted, the schedule assumes the Calendar
object Present Value is False and the exception schedule is not active.
When the date changes, the daily schedule ends and the Schedule object executes the next day’s
regular schedule, exception schedule, or Default Schedule Command.
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Global Calendar
About this task:
The Global Calendar allows you to make facility-wide changes to calendars, such as defining
holidays. These changes are tedious if you need to edit many calendars. To solve this problem, you
can reference a Global Calendar object in each FAC or NxE. When you edit the values of the Global
Calendar object, the dates automatically download into all the local calendars.
Note: If a local calendar references a global calendar, the local calendar date list is not writable
and the Edit button is unavailable. However, if a local calendar writes to a BACnet attribute, the
calendar may be edited. In this case, do not write to the local calendar date list, because this
overrides the dates in the global calendar.
To reference a Global Calendar object:
1.

In the Configuration tab, click the Browse icon to choose the Global Calendar Object
Reference. (See Creating a Schedule or Calendar.)

Figure 38: Global Calendar Object Reference - Configuration Tab

2.
3.
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In the Advanced Focus tab, click Edit, then click the Browse icon to choose the Global
Calendar Object Reference. (See Editing the Attributes of a Schedule or Calendar.)
Click Save. The Configuration tab adds the date and time of the last Global Calendar Update.
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Figure 39: Global Calendar Update

Scheduling Steps
Creating a Schedule or Calendar
About this task:
Note:

1.
2.

•

The procedure for creating a schedule or a calendar in offline mode (using SCT) is the
same as the online procedure using the Object. See Metasys Modes for more information
about the modes of operation.

•

You cannot create schedules or calendars in an FAC from SCT or SMP.

From the Insert menu, select Object. The Insert Object Wizards appears.
Select Schedule or Calendar and follow the Insert Object Wizard instructions.
Note: Add extensions to the schedule or calendar at the wizard prompt, if desired. See
Extensions.

Displaying an Existing Schedule or Calendar
To display an existing schedule or calendar, drag and drop the item from the navigation tree into a
display frame or double-click the item in the navigation tree.
Note: Alternatively, you can right-click the item and select View from the menu that appears.
Displaying Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop down menu, select the view you want to see (Today’s Schedule,
Weekly Schedule, Exception Schedule, or Scheduled Items).
3. Place the cursor over a leading or trailing edge of a time bar segment. The time-of-day
appears in 24-hour format in a small pop-up window.
Adding Weekly Scheduled Events
1. Display a Schedule.
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2.

From the Display Mode drop down menu, select Weekly Schedule.

3.
4.

Click Edit.
Click the new (green plus) button or double-click a time bar segment and the Define New
Event(s) dialog box appears.
Note: Alternatively, you can right-click a time bar segment and select Add Event(s). The
Define New Event(s) dialog box allows you to define the new event for multiple days.

5.
6.
7.

8.

Select one or more days, the starting time (hour and minute), and a value for the event using
the check boxes and drop-down menus and click OK.
Repeat Step 4 and Step 5 as necessary.
To specify an event end time, make sure no event is selected, right-click where you want the
event to end and select End Event from the pop-up menu. Drag the end of the event to adjust
the end time.
Click Save.
Note: Once you click Save, the schedule object goes into effect and writes the new value
to the scheduled items if necessary.

Editing Scheduled Events
1. Display a Schedule.
2.
3.
4.

From the Display Mode drop-down menu, select Weekly Schedule.
Click Edit.
Double-click the time bar segment. The Modify Event(s) dialog box appears.
Note: Alternatively, you can select and right-click the event on the time bar and select
Modify Selected Event(s) from the menu.

5.

Adjust the starting time (hour and minute) and value as desired for the event using the check
boxes and drop-down menus and click OK.
Note:
- You can also change the value of an event by selecting and right-clicking the event
and selecting a value from the menu, if the value type is Boolean (True/False),
binary, or multistate with less than eight states.
- To specify an event end time, make sure no event is selected, right-click where you
want the event to end, and select End Event from the pop-up menu. Once you
specify an end time, you can drag the tail edge right or left to adjust the end time.
- You can adjust start times and end times of events by dragging the edges of
the time bar segment to the right or left. When adjusting a time, a small pop-up
window shows the digital time of day based on a 24-hour clock, and adjusts in 5minute increments.
- You cannot drag the end of an event that ends at midnight. To do this, first rightclick and select the End Event. Once the event ends prior to midnight, you can then
drag to adjust the end time.
- If you have a gap in the schedule between two events, you can drag the edge of one
to meet the edge of the other. Once you do, the events become locked together
so that the second begins as soon as the first ends, the begin/end points move
together, and the gap is removed from the schedule.

6.
7.
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Repeat Step 4 and Step 5 as necessary.
Click Save.
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Note: Once you click Save, the schedule object goes into effect and writes the new value
to the scheduled object if necessary.
Deleting Scheduled Events
1. Display a Schedule.
2. From the Display Mode drop down menu, select Weekly Schedule.
3. Click Edit.
4. Select the event on the time bar and click the delete (red minus) button (or press the Delete
key).
Note: Alternatively, you can select and right-click the event on the time bar and select
Delete Selected Event(s) from the menu.
5.
6.

Repeat Step 4 as necessary.
Click Save.

Adding Exception Schedules
About this task:
To add exception schedules:
1.

Display a Schedule.

2.
3.
4.

From the Display Mode drop down menu, select Exception Schedule.
Click Edit.
Click the new (green plus) button to add exception schedules. The Exception Detail dialog
box appears. You can add exception schedules to the list using one of the following exception
types:
- Date/Date Range
- Week and Day
- Calendar Reference

5.

Select the radio button next to the type of exception. Depending on the type of exception
date selected, a different set of drop-down menu options appears. The Calendar Reference
exception type has a Browse icon that brings up a dialog box for selecting a calendar.
Note: When mapping a schedule into the Metasys system from a third-party BACnet
device, you must also map any calendar objects referenced by the schedule (that is,
calendar exceptions) in order to properly view and edit them in the schedule exception
list.

6.
7.
8.
9.
10.
11.

12.
13.

Make your selections from the drop-down menus or for the Calendar Reference, click the
Browse icon and select a calendar from the Select Items dialog box and click OK.
Click OK on the Exception Detail dialog box.
Select the exception schedule in the exception list.
Click the new event (green plus) button above the time bar or right-click the time bar and
select Add Event(s). The Define New Event(s) dialog box appears.
Select the starting time (hour and minute), and a value for the event using the check boxes
and drop-down menus and click OK.
To specify an event end time, make sure no event is selected, right-click where you want the
event to end and select End Event from the pop-up menu. Drag the end of the event to adjust
the end time.
Repeat Step 4 through Step 11 as necessary.
Click Save.
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Note: Once you click Save, the schedule object goes into effect and writes the new value
to the scheduled items if necessary.
Editing Exception Schedules
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Exception Schedule.
3. Click Edit.
4. Double-click the exception schedule. The Exception Details dialog box appears.
5. Make your modifications using the drop-down menus or for the calendar reference, click the
Browse icon and select a calendar from the Select Items dialog box and click OK.
6. Click OK on the Exception Details dialog box.
7. Select the exception schedule in the exception list.
8. Select and right-click the event in the time bar and select Modify Selected Event(s) from the
menu. The Modify Event(s) dialog box appears.
Note: Alternatively, you can double-click an event to open the Modify Event(s) dialog
box.
9.

Select the starting time (hour and minute), and a value for the event using the check boxes
and drop-down menus and click OK.

10. Repeat Step 4 through Step 9 as necessary.
Note: To change the value of an event, select and right-click an event and select a value
from the menu.
11. Adjust the start and end times of events by dragging the edge of the event to the right or left.
12. Click Save.
Note: Once you click Save, the schedule object goes into effect and writes the new value
to the scheduled object if necessary.
Removing Exception Schedules
1. Display a Schedule.
2. From the Display Mode drop down menu, select Exception Schedule.
3. Click Edit.
4. Select the exception in the exception list.
5. Click the delete (red minus) button (or press the Delete key).
6. Click Save.
Adding Scheduled Items
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Click the add (green plus) button.
5. Select one or more items from the Select Item dialog box and click OK.
Note: To select multiple items, use the Control or Shift key.
6.
7.
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The system automatically chooses the default attribute for each item you selected. To choose
a different attribute, click the Browse icon and select the attribute that you want to schedule.
Click Save.
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Note: The first item in the list of scheduled items (Table of Scheduled Items) determines
the data type used when the schedule writes values to the attributes of the scheduled
item.
Editing Scheduled Items
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Right-click the item name and select an option from the pop-up menu. For example, select
make key item to promote the selected item to the key item of the schedule. When you add a
key item, or choose the Make Key Item menu option for an item, the States Text (or Display
Units) is updated to match the key item.
Important: When you add the first item to the Scheduled Items list, or if you promote
an item to key item, the values in the scheduled events change to a default value if
they are incompatible with the new key item. The default for numeric values is 0 or
0.0. The default for attributes that support multiple values is the first value available in
the set of possible values (for example, False or Off). After changing the key item, we
strongly recommend reviewing and adjusting the values for all events in the schedule as
necessary.
5.

6.

The system automatically chooses the default attribute for each item you selected. To choose
a different attribute, click the Browse icon and select the attribute that you want to schedule.
For example, selecting Present Value means that the schedule writes a value to the Present
Value attribute of that item.
Click Save.

Removing Scheduled Items
1. Display a Schedule.
2. From the Display Mode drop-down menu, select Scheduled Items.
3. Click Edit.
4. Select the item name.
5. Click the remove (red minus) button or right-click and select remove object from the pop-up
menu.
Editing the Effective Period of a Schedule
1. Display a Schedule.
2. On the Schedule tab, click Edit.
3. Click the Browse icon of the Effective Period attribute. The Effective Period dialog box
appears.
4. Select the start and end dates using the drop-down menus.
5. Click Apply.
6. Click OK.
7. Click Save.
Creating a New Calendar Entry
1. Display a Calendar.
2. Click Edit.
3. Click Entry Detail. The Calendar Entry Detail dialog box appears.
4. Click New.
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5.
6.
7.
8.
9.

Select the Date, Date Range, or Week and Day radio button. Depending on the type of entry
selected, a different set of drop-down menu options appears.
Make your selections.
Click Apply.
Click OK.
Click Save.
Note:
- Alternatively, create date and date range calendar entries visually by selecting an
individual calendar date or by selecting and dragging the mouse over a range of
dates.
- Wildcard date entries appear with a contrasting blue background on the calendar
and have an asterisk next to the date. Once you create a wildcard entry, visually
selecting and deselecting it does not change the entry. To edit the entry, click Entry
Detail on the calendar display frame.

Editing a Calendar Entry
1. Display a Calendar.
2. Click Edit.
3. Click Entry Detail. The Calendar Entry Detail dialog box appears.
4. Select the entry from the calendar entries list.
5. Use the drop-down menus to edit the entry.
6. Click Apply.
7. Click OK.
8. Click Save.
Note:
- Alternatively, edit Date and Date Range calendar entries visually by selecting an
individual calendar date or by selecting and dragging the mouse over a range of
dates.
- Wildcard date entries appear with a contrasting blue background on the calendar
and have an asterisk next to the date. Once you create a wildcard entry, visually
selecting and deselecting it does not change the entry. To edit the entry, click Entry
Detail on the calendar display frame.
Deleting a Calendar Entry
1. Display a Calendar.
2. Click Edit.
3.
4.
5.
6.
7.

Click Entry Detail. The Calendar Entry Detail dialog box appears.
Select the entry from the Calendar Entries list.
Click Delete.
Click OK.
Click Save.
Note: Alternatively, you can delete calendar entries visually by selecting the individual
calendar date a second time or by selecting and dragging the mouse over the range of
dates a second time. This method cancels the selection, thus deleting the entry.

Toggling Between Calendar Views
About this task:
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Note: The cursor turns into a hand when you place it over the header area of a calendar.
1.

Display a Calendar.

2.

Place the cursor over the header of a calendar until it changes shape from an arrow to a hand
and click. The view switches between 1-month and 12-month view.

Editing the Attributes of a Schedule or Calendar
1. Display a Schedule or Calendar.
2. Select the Focus tab.
3. Click Edit.
4.

Make your modifications using the drop-down menus and text boxes. See the Schedule
Object or Calendar Object for details about the attributes of these items. Select the Advanced
radio button if needed.
Note: Selecting false in the Enabled drop-down menu of the Schedule disables (turns
off) the schedule.

5.

Click Save.

Copying and Pasting a Schedule or Calendar (Offline Mode Only)
About this task:
Note:

1.
2.
3.
4.
5.

•

This procedure is available only in offline mode (SCT).

•

This function is not available for schedules/calendars in an FAC.

In offline mode, select the schedule or calendar from the navigation tree.
Select Copy from the Edit menu.
Select the desired destination for the copied schedule or calendar in the navigation tree.
Select Paste from the Edit menu. The Paste Object Wizard appears.
Edit the name of the schedule or calendar as desired and click Paste.

Deleting a Schedule or Calendar
1. Select the schedule or calendar you want to delete in the navigation tree.
2. Select Delete Items from the Edit menu, or press the Delete key.
Scheduling a Trend Extension
About this task:
Note: See the Trend Scheduling topic for information and examples on scheduling trend
extensions.
1.
2.

3.

4.

Create a Schedule or display the desired Schedule.
In the Scheduled Items list, add the desired object trend extension and the desired
scheduled attribute. Follow the steps in the Adding Scheduled Items procedure. Make sure
the trend extension is the key item. See Trend Extensions for information on the trend
extension attributes you want to schedule.
On the Weekly Schedule tab, configure the events as desired. Follow the steps in the Adding
Weekly Scheduled Events and Editing Scheduled Events procedures to schedule specific days
and times to perform the defined trending capability.
Click Save.
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Scheduling the Enabled Audit Level
About this task:
To schedule the Enabled Audit Level based on time using the Scheduling feature:
1.
2.
3.

4.

Create a Schedule or display the desired Schedule.
In the Scheduled Items tab, add the desired Engine or Metasys Server and select the
Enabled Audit Level attribute. Follow the steps in the Adding Scheduled Items procedure.
On the Weekly Schedule tab, configure the events as desired. Follow the steps in the Adding
Weekly Scheduled Events and Editing Scheduled Events procedures to schedule specific days
and times to change the Enabled Audit Level. See the Engine Device Object or ADS Device
Object’s Enabled Audit Level attribute description for information on the levels you want to
schedule.
Click Save.

Copying Events within the Weekly Schedule
About this task:
To copy the events from one day in the Weekly Schedule to one or more days in the same Weekly
Schedule:
1.
2.
3.

With the Weekly Schedule in Edit mode, left-click and highlight the name of the day whose
events you want to copy.
Right-click the highlighted day and select Copy from the pop-up menu.
Left-click to highlight the name of the day (or days) where you want to copy the schedule.
Note: You can select multiple days by holding the Control or Shift key while selecting
days.

4.

Right-click the highlighted name of any target day and select Paste from the pop-up menu.
The copied schedule overwrites the schedule for the selected days.

Event Enrollment Object
Menu Selection: Insert > Object > Event Enrollment
The Event Enrollment object’s attributes represent and contain information for managing
events. Events are changes in the value or state of an object that meet specific criteria. The Event
Enrollment object defines the event criteria and provides a connection between an event and a
notification message sent to recipients. A recipient device is enrolled for notification if:
•

it is one of the recipients in a Notification Class Object referenced by the Event Enrollment
object

•

a Notification Class object is not referenced and it is the recipient of the Event Enrollment
object

When you create an Event Enrollment object at a network engine using a BACnet client, a new Event
Enrollment object is created under that folder in the navigation tree.

Event Enrollment Concepts
Event Relationships
Event Types, Event States, and Event Parameters are interrelated attributes.
Note: Any Event Type generates a Fault Event State if the object referenced in the Object
Property Reference becomes unreliable and the Object Property Ref attribute is linked to
Reliability.
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Table 205: Event Relationships
Event Type

Event State

Event Parameters

Change of Bitstring

Normal
Offnormal

Time Delay
Bitmask
List of Bitstring Values

Change of Character String Normal
Offnormal

Time Delay

Change of State

Normal
Offnormal

Time Delay
List of Values

Change of Value (COV)

Normal

Time Delay
Bitmask
COV Increment

List of Values

Note: Only one of either the Bitmask or the
COV Increment property is used.

Command Failure

Normal
Offnormal

Time Delay
Feedback Property Reference

Double Out of Range

Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Floating Limit

Normal
High Limit
Low Limit

Time Delay
Setpoint Reference
Low Diff Limit
Hi Diff Limit
Deadband

Out of Range

Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Signed Out of Range

Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Unsigned Out of Range

Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Unsigned Range

Normal
High Limit
Low Limit
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Time Delay
Low Limit
High Limit
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Event Parameters
The table below lists the parameters in the Event Parameters attribute. For a description of the
algorithms to which these parameters apply, refer to ANSI/ASHRAE BACnet Standard 135 - 1995.
Table 206: Event Parameters
Parameter

Description

Bitmask

This parameter applies to the Change of Bitstring event algorithm and
the Change of Value event algorithm in the special case where the
referenced attribute is a Bit String data type. It represents a bitmask
that is used to indicate which bits in the referenced attribute are
monitored by the algorithm. A value of one in a bit position indicates
that the bit in this position in the referenced attribute is monitored
by the algorithm. A value of zero in a bit position indicates that the
bit in this position in the referenced attribute is not significant for the
purpose of detecting this Change of Bitstring or Change of Value.

Deadband
High Diff Limit
Low Diff Limit
High Limit
Low Limit

These parameters apply to these event algorithms: Signed Out of
Range, Unsigned Out of Range, Unsigned Range, Floating Limit, Out
of Range, Double Out of Range. The only exception is that Deadband
does not apply to Unsigned Range.

Feedback Property
Reference

This parameter (BACnet Object Property Reference) applies to the
Command Failure algorithm. Feedback Property Reference identifies
the object and attribute that provides the feedback to ensure that the
commanded attribute changes value. This attribute may reference
only object properties that have lists of true and false values.

List of Bitstring Values

This is a list that applies to the Change of Bitstring event algorithm.
This list defines the set of states for which the referenced attribute
is Offnormal. Only the bits indicated by the Bitmask are significant.
If the value of the referenced attribute changes to one of the values
in the List of Bitstring Values, then the Event State attribute of the
Event Enrollment object makes a transition To Offnormal and sends
the appropriate notifications.

List of Values

This is a list of BACnet Property States that applies to the Change of
State event algorithm. This event algorithm applies to referenced
properties that have discrete or lists of values. The List of Values is
a subset of the possible values that the attribute may have. If the
value of the referenced attribute changes to one of the values in the
List of Values, then the Event State attribute of the Event Enrollment
object makes a transition to To Offnormal and sends the appropriate
notifications.

COV Increment

This parameter applies to the Change of Value event algorithm. It
represents the increment by which the referenced attribute must
change in order for the event to occur.

Setpoint Reference

This parameter (BACnet Object Property Reference), applies to the
Floating Limit event algorithm. Setpoint Reference indicates the
setpoint reference for the reference attribute interval.
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Table 206: Event Parameters
Parameter

Description

Time Delay

This parameter applies to all event types and represents the seconds
that the conditions monitored by the event algorithm persist before
an event notification is issued.

Referenced Property
Increment

This parameter represents the increment by which the referenced
property must change for an event to occur.

Event Type
Indicates the type of event algorithm used to detect events and report to enrolled devices. See the
BACnet standard for more information on algorithms. See Event Relationships for more information
on the event types.
The table below describes the event types with their respective data types.
Table 207: Event Types
Event Type

Data Type

Description

Change of
Bitstring

Bitstring

Generates an off-normal transition when the value of the
referenced property is equal to one of the user-defined Bitstring
Values (List Elements after applying the Bitmask) and the
values are equal for the amount of seconds defined by the Time
Delay parameter. The Bitmask defines the bits important for
monitoring.

Change of
Character String

String

Generates an off-normal transition when the value of the
referenced property is equal to one of the values in the List of
Values (List Elements) and the values are equal for the number of
seconds defined by the Time Delay parameter.

Change of State

Bool, Byte,
Enum,
Long, Short,
Ulong,
Ushort

Generates an off-normal transition when the value of the
referenced property is equal to one of the values in the List of
Values (List Elements) and the values are equal for the number of
seconds defined by the Time Delay parameter.

Change of Value

Bitstring,
Float

Generates a normal transition when the value of the referenced
property changes by an amount equal to or greater than
the referenced property increment (Change of Value [COV]
Increment) for the number of seconds defined by the Time Delay
parameter.

Command
Failure

Bool, Byte,
Double,
Enum, Float,
Long, Short,
Ulong,
Ushort

Generates an off-normal transition if the values of the referenced
property and the Feedback Reference are not equal for a time
greater than the number of seconds defined by the Time Delay
parameter.

1
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Table 207: Event Types
Event Type

Data Type

Description

Double Out of
Range

Double

Generates a transition to high limit alarm if the value of
the referenced property is higher than the range of values
determined by the High Limit for a time greater than the number
of seconds defined by the Time Delay parameter. This event type
accepts a double data type.

1

Generates a transition to low limit alarm if the value of the
referenced property is lower than the range of values determined
by the Low Limit for a time greater than the number of seconds
defined by the Time Delay parameter. This event type accepts a
double data type.
Floating Limit

Float

Generates a transition to high limit alarm if the value of
the referenced property is higher than the range of values
determined by the current values of the Setpoint Reference,
High Limit, Low Limit, and Deadband for a time greater than the
number of seconds defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the
referenced property is lower than the range of values determined
by the current values of the Setpoint Reference, High Limit, Low
Limit, and Deadband for a time greater than the number of
seconds defined by the Time Delay parameter.

Out of Range

Float

Generates a transition to high limit alarm if the value of
the referenced property is higher than the range of values
determined by the current values of the High Limit and Deadband
for a time greater than the number of seconds defined by the
Time Delay parameter. The high limit value may be True, False, or
an analog value.
Generates a transition to low limit alarm if the value of the
referenced property is lower than the range of values determined
by the current values of the Low Limit and Deadband for a time
greater than the number of seconds defined by the Time Delay
parameter. The low limit value may be True, False, or an analog
value.

Signed Out of
Range

Float
(positive or
negative)

Generates a transition to high limit alarm if the value of
the referenced property is higher than the range of values
determined by the current values of the High Limit and Deadband
for a time greater than the number of seconds defined by the
Time Delay parameter.
Generates a transition to low limit alarm if the value of the
referenced property is lower than the range of values determined
by the current values of the Low Limit and Deadband for a time
greater than the number of seconds defined by the Time Delay
parameter.
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Table 207: Event Types
Event Type

1

Data Type

Description
Generates a transition to high limit alarm if the value of
the referenced property is higher than the range of values
determined by the current values of the High Limit and Deadband
for a time greater than the number of seconds defined by the
Time Delay parameter.

Unsigned Out of Float
Range

Generates a transition to low limit alarm if the value of the
referenced property is lower than the range of values determined
by the current values of the Low Limit and Deadband for a time
greater than the number of seconds defined by the Time Delay
parameter.
Unsigned Range Byte, Ulong, Generates a transition to high limit alarm if the value of the
Ushort
reference property is higher than the range of values determined
by the High Limit for a time greater than the number of seconds
defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the
reference property is lower than the range of values determined
by the Low Limit for a time greater than the number of seconds
defined by the Time Delay parameter.
1

Bitstring, Bool=boolean (true/false), Byte, Double, Enum (enumerated), Float (floating point), Long, Short, String, Ulong
(unsigned long), Ushort (unsigned short). Also see Table 321.

Event Enrollment Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Note: In the Notes and BACnet Notes columns, attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.
Table 208: Event Enrollment Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

BACnet
Notes

Acked Transitions

Alarm Message
Text

C,W

Event Detection
Enable
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Description
Conveys three separate flags that each indicate if the most recent To Offnormal,
To Fault, and To Normal event transitions have been acknowledged (if the
transition requires acknowledgement).
Contains the user-defined text included with the event notification. Starting at
Release 10.0, this attribute is replaced by Event Message Texts Config. The
value of this attribute is kept in sync with the first element of the Event Message
Texts Config attribute. Any modification to either one changes the other. Also,
for upgraded systems that use Alarm Message Text, any text in this field is
moved to the first element of the Event Message Texts Config field.
Indicates if event detection and reporting is enabled for the Event Enrollment
object. This is a read-only attribute that is always set to True.
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Table 208: Event Enrollment Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Event Enable

C,W

BACnet
Notes
W

Event Message
Texts

Event Message
Texts Config

Event State

Event Time
Stamps
Execution Priority C,W

C,W

Graphic
Graphic Alias

C,W
C,W

C,W
C,W

Notification Object C,W
Reference

W

Description
Conveys three flags that determine if notifications are enabled for To Offnormal,
To Fault, and To Normal transitions. When a flag is set, this means that the
corresponding transition causes notification to be sent to all enrolled devices.
When a flag is cleared, this means that the corresponding transition is not
reported. The object’s Event State continuously updates, regardless of the value
of the Event Enable attribute.
An array of three character strings that holds the message texts that identify
the last state of the Event Enrollment object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL. If a particular event is yet to
occur, the respective entry in the array is blank (null).
An array of three character strings that defines the message texts used to
identify the last state of the Event Enrollment object. The states in sequential
order are: TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL, which you may
customize by entering text in each field. The first element of this attribute is kept
in sync with the Alarm Message Text attribute so that any modification to either
one changes the other. Starting at Release 10.0, use this attribute instead of
Alarm Message Text.
Indicates the current state of the event. The permitted values for Event State are
specific to the Event Type. The value of Event State is independent of the Event
Enable flags.
Conveys the times of the last event notifications for To Offnormal, To Fault, and
To Normal events.
Indicates the relative importance of performing the function of the object within
the device.
Indicates the graphic associated with the object.
Indicates a portion of the graphic’s item reference, up to and including the
name of the folder containing this object or the controller containing this point.
Specifies the notification class used when handling and generating event
notifications for the object. This attribute implicitly refers to the Notification
Class Object that has a Notification Class attribute of the same value.
Note: The Notification Class attribute is used if the Recipient attribute is
not used. As best practice, use the Notification Class attribute.

Notify Type
Reliability

C,W
W

W
W

Conveys if the notifications generated by the object are Events or Alarms.
Specifies the current reliability of the event enrollment object. Possible values:
No Fault Detected (reliable), Communication Failure, and Configuration Error.

Table 209: Event Enrollment Object Attributes - Event Tab
Attribute
Name

Flags

BACnet
Notes

Values/Options/Range

Event
Parameters

C,W

W

Determines the method used to monitor the referenced object. This attribute
provides the parameter values used for the algorithm.
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Table 210: Event Types
Event Type

Description

Change of
Bitstring

Generates an off-normal transition when the value of the referenced property
is equal to one of the user-defined Bitstring Values (List Elements after applying
the Bitmask) and the values are equal for the amount of seconds defined by the
Time Delay attribute you’re using. The Bitmask defines the bits important for
monitoring.

Change of
Character
String

Generates an off-normal transition when the value of the referenced property
includes one of the values in the List of Values (List Elements) and the values are
equal for the number of seconds defined by the Time Delay parameter.

Change of
State

Generates an off-normal transition when the value of the referenced property
(Input Reference) is equal to one of the values in the List of Values (List Elements)
and the values are equal for the number of seconds defined by the Time Delay
attribute of the object you’re using.

Change of
Value

Generates a normal transition when the value of the referenced property (Input
Reference) changes by an amount equal to or greater than the referenced
property increment (Change of Value [COV] Increment) for the number of
seconds defined by the Time Delay attribute of the object you’re using.

Command
Failure

Generates an off-normal transition if the values of the referenced property (Input
Reference) and the Feedback Reference are not equal for a time greater than
the number of seconds defined by the Time Delay attribute of the object you’re
using.

Double Out of
Range

Generates a transition to high limit alarm if the value of the referenced property
is higher than the High Limit for a time greater than the number of seconds
defined by the Time Delay parameter. This event type accepts a double data type.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the Low Limit for a time greater than the number of seconds
defined by the Time Delay parameter. This event type accepts a double data type.

Floating Limit

Generates a transition to high limit alarm if the value of the referenced property
is higher than the range of values determined by the current values of the
Setpoint Reference, High Limit and Deadband for a time greater than the number
of seconds defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the
Setpoint Reference, Low Limit, and Deadband for a time greater than the number
of seconds defined by the Time Delay parameter.

Out of Range

Generates a transition to high limit alarm if the value of the referenced property
is higher than the range of values determined by the current values of the High
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the Low
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.
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Table 210: Event Types
Event Type

Description

Signed Out of
Range

Generates a transition to high limit alarm if the value of the referenced property
is higher than the range of values determined by the current values of the High
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the Low
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.

Unsigned
Range

Generates a transition to high limit alarm if the value of the reference property
is higher than the range of values determined by the High Limit for a time
greater than the number of seconds defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the reference property
is lower than the range of values determined by the Low Limit for a time greater
than the number of seconds defined by the Time Delay parameter.

Event Enrollment Commands
The table below lists the commands supported by the Event Enrollment Object.
Table 211: Event Enrollment Commands
Command Name

Parameters

BACnet Support

Description

Disable

None

No

Prevents distribution of event
notifications.

Enable

None

No

Allows distribution of event
notifications.

Group Object
Menu Selection: Insert > Object > Group
Notes:
•

Click the Add button to select the items belonging to this group from the Select Item dialog
box.

•

Click the item in the group list and use the up and down arrows to move the item in the list.

•

Click the item in the group list and click Remove to remove the item from the group.

•

Do not add a Group object to an equipment definition for the Metasys UI. The Metasys UI does
not support the Group object.
The Group object’s attributes represent a collection of other objects and one or more of their
attributes. This object provides the user with the ability to customize the organization of objects
within the site. The Group object simplifies the exchange of information between objects by
calling all members of the group at once. A group consists of any combination of object types. For
example, you can use the Group object to monitor the temperature in different rooms throughout a
floor of a building.
For general information on Metasys system objects, see Common Object Attributes.
For detailed information on the Group object, see Group Attributes.
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Group Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the Notes columns, attributes marked with the letter C are configurable, and
attributes marked with the letter W are writable. For more information about attribute
characteristics, see Attributes.
Table 212: Group Object Attributes - Group Tab
Attribute Name

Notes

BACnet
Notes

List of Group
Members

C,W

W

Initial Value Description
Contains the references (Input
References) that define the members of
the group. These group members are
referenced during a transaction. The
list of group members consists of two
parts:
•

Object ID

•

Element

All members of the group are objects
that reside in the same device that
maintains the Group object. Nesting
is not allowed. This attribute is only
shown in the Snapshot view.
Present Value

Lists the values of all the attributes
specified in the List of Group Members.
This is a read-only attribute; it cannot
be used to write a set of values to the
members of the group. The Present
Value list reconstructs each time
the attribute is read by fetching the
member attributes. This attribute is
only shown in the Snapshot view.

IEIEJ BACnet System Objects
IEIEJ BACnet System Objects comply to the Institute of Electrical Installation Engineers of Japan
(IEIEJ) Standard Protocol based on BACnet specifications. Use these objects to comply with these
guidelines.
For more information on IEIEJ BACnet System Objects, click one of the following:
•

Electric Demand Monitoring Object

•

Generator Load Control Object

•

Electric Demand Control Object
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IEIEJ BACnet System Object Descriptions
Electric Demand Monitoring Object
Menu Selection: Insert > Object > Electric Demand Monitoring
The Electric Demand Monitoring Object is a specialized object that monitors the power
consumption in a fixed 30-minute window. This object uses an Accumulator or Analog Input and
calculates the demand every minute. The object calculates a projected demand for the end of
the 30-minute window, and compares that demand value to the target demand. If the projected
demand value exceeds the target demand value, the object triggers an alarm notification. The
default view of the object is a graph of the demand values.
Note: In the Notes column, letters indicate the following: A - Archive, C - Configurable, D Default Attribute, F - PMI Refreshing R - Associate with Reliability, W - Writable.
Note: In the BACnet Notes column, letters indicate the following: O - BACnet optional property,
P - BACnet proprietary property, Q- BACnet required property.
Table 213: Electric Demand Monitoring Object Attributes
Attribute
Notes
Name
Present Value D,F,R

BACnet
Notes
Q

Initial Value
1

Values\Options
\Range
1=Normal
2=Alarm Level 1
3=Alarm Level 2

Description
For the Electric Demand Monitoring object, the
Present Value displays the present demand
alarm level. There are three states:
- Normal State (no alarm generated)
- Alarm level 1

Contract
Receiving
Power
Alarm Value
of Power

W,C,A

Q

0

0.0 kW to 99999.9
kW

W,C,A

Q

0

0.0 kW to 99999.9
kW

Target Value
of Power

W,C,A

Q

0

0.0 kW to 99999.9
kW

Units

W,C,A

Q

kW

Default - kW

O

Null

Pulse Attributes
reference PV
of (AI, AV, or
Accumulator)

JCI List of
C,A
Pulse Counter
Reference
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- Alarm level 2
This attribute represents the electric power
contracted from a power company as a value of
electric energy of 60 minutes.
This attribute shows the alarm value of electric
power as a value of electric energy of 60
minutes. If this value is exceeded, the Present
Value becomes 3 and generates alarm level 2.
This attribute shows the electric power that can
be supplied by a generator as a value of electric
energy of 60 minutes. If this value is exceeded,
the Present Value becomes 2 and generates
demand alarm level 1.
This attribute represents the engineering unit of
all real type properties that show electric energy.
This attribute indicates the references to electric
power Pulse input devices. This reference can
be either an Accumulator, an AV, or an N2 Pulse
Counter object.
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Table 213: Electric Demand Monitoring Object Attributes
Time Synchro- W,C,A
nization Mode

P

Internal
Normal

1=External

This displays three modes:

2=Internal Normal External: If the external signal is Pulse type, the
(0 min, 30min)
demand interval stops and starts whenever a
3=Internal Custom Pulse is received. If the external signal is Analog,
the demand interval stops and starts when the
(arbitrary)
value changes (increments or decrements).
Internal Normal: When the time is XX:00:00 and
XX:30:00, demand timing will stop and start.
Internal Custom: Demand interval begins after
startup of an NAE, the addition of the object, or
when a demand reset command is issued. The
demand interval stops and starts 30 minutes
from the starting time. For example, if it stops
and starts at XX:12:03, then it will stop and start
next at XX:42:03.

Time to Mask W,C,A

P

EOI Object

C,A

P

Input Mode

W,C,A

P

Pulse

JPN Rate
Constant

W,C,A

P

50,000

Pulse
Constant

W,C,A

P

100

Rollover Limit
Reliability
Time Interval

5

0
Q

1

0 min to 25 min

This attribute indicates the time that is not
treated as an alarm even if the measured value
exceeds an Alarm Value of Power or Target
Value of Power after starting the demand
monitoring of a 30-minute-period.
If operating in External mode, refer to the AI, AV,
or BI object to input the external interval signal.
Only this property is configurable.
1=Pulse(PI)
This attribute switches the reference input signal
2=Analog(AI or AV) between Pulse signal such as PI, and Analog
signal such as AI and AV. When input mode is
Analog, any change of value is an EOI. In Pulse
mode (typically BI), only transitions to True are
EOI pulses.
0 to 50,000
The numeric value that is input onto a Pulse
object is the electric energy. Set a constant to
multiply.
0 to 50,000
The numeric value that is input onto a Pulse
object is the electric energy. Set a constant to
multiply.
This attribute specifies the highest counter value
before the Pulse Counter rolls over to zero.
0 min to 30 min
For the Electric Demand Monitoring (EDM)
object, power usage is calculated from the
difference between one minute previous and the
value of JCI List of Pulse Counter Reference.
If the difference in usage is zero, recognize it as
an input error and set the status to unreliable.
However, even when the object is normal, this
property remains active, because the reliability
check is masked if the power usage is low and
the difference in usage is zero.
In addition, EDM is unreliable if the mask time
is set with this property, because the difference
in calculation is reset in a 30 minute period. If
it is unreliable at the start of 30 minutes, EDM
becomes unreliable. That is, it is unmasked at
the start time, for example HH:00 or HH:30, and
becomes unreliable.
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Electric Demand Control Object
Menu Selection: Insert > Object > Electric Demand Control
The Electric Demand Control Object interacts with the Electric Demand Monitoring Object to control
electrical loads so the actual demand stays below the target demand. The Present Value is a value
that indicates the level of shed activity needed to stay within the target demand. External logic must
be used to interpret this value and to switch on/off loads.
Note: In the notes column, letters indicate the following: A - Archive, B - BACnet Array, C Configurable, D - Default Attribute, F - PM Refresh, O - BACnet Optional, Q - BACnet Required, R
- Associate with Reliability, W - Writable.
Table 214: Electric Demand Control Object Attributes
Attribute Name
Present Value

Notes
W,D,R,F,Q

Initial Value Values/Options/Range
1

Control Type

W,C,A

Time Ctrl

JCI Demand
Monitoring Object
Reference

C,A

NULL

Priority For Writing

W,C,A,O

Control_Type_ Enum_Set (New
Define)

Low Limit = 3
High Limit = 16
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Description
See the Present Value attribute in
Generator Load Control
See the Control Type attribute in
Generator Load Control.
This attribute refers to the Electric
Demand Monitoring object
reference. The Electric Demand
Control object is unreliable if the
input source object is unreliable, or
if the reference is offline and data
acquisition with BACnet cannot be
performed.
This attribute defines the priority
when instructed to inject or trip
by demand control based on this
object. It is a 1 to 16 unsigned
integer, with 1 being the highest
priority, and 16 being the lowest
priority.
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Table 214: Electric Demand Control Object Attributes
Level Value

ALL 0

This attribute represents the level
of available electric power of a
generator, measured in a 60 minute
period. It defines the load capacity
to be decreased when a device at a
specified level is turned off.
Although the Level Value attribute is
an array of 16 values, only the values
1, 2, 3, 9, 15, and 16 are configurable.
Level Value: Control Status of
Register Points Device
1: All levels recovered (all demand
controlled devices are ON).
2: Level 2 devices are turned OFF. All
other devices are ON.
3: Level 2 and 3 devices are turned
OFF. All other devices are ON.
<4-8>:n/a
9: Devices at level 1 to 9 are turned
OFF. All other devices are ON.
<10-14>:n/a
15: Devices at level 1 to 15 are
turned OFF. All other devices are ON.

Transition Interval

W,C,A

30

Units = seconds

16: All levels are turned OFF (all
demand controlled devices are OFF).
See the Transition Interval
attribute in Table 215.

Generator Load Control Object
Menu Selection: Insert > Object > Generator Load Control
This object is similar to the Electric Demand Control Object but specifically controls the loads on a
backup generator. A given generator can supply a fixed maximum amount of power. A reference to
the current load on the generator and the value of the maximum generator output are configured
in the object. The Present Value is a value that indicates the level of shed activity needed so the
demand does not exceed the maximum power output of the generator. External logic must be used
to interpret this value and switch on/off loads.
Note: In the Notes column, letters indicate the following: A - Archive, B - BACnet Array, C Configurable, D - Default Attribute, F - PM Refresh, O - BACnet Optional, Q - BACnet Required, R
- Associate with Reliability, W - Writable.
Table 215: Generator Load Control Object Attributes
Attribute

Notes

Initial Value

Present Value

W,D,R,F,Q

1
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Values
Description
\Options
\Range
(from Standard For the Generator Load Control and Electric Demand
object)
Control objects, the Present Value attribute ranges
from 1 to 16. Level 1 represents all level release; 16
is the highest level and 2 is the lowest level. When
the Present Value increases from 2 to 16, turn ON
control to selected facilities. When the Present
Value decreases from 16 to 2, turn OFF control
to selected facilities. This value presets to 1 when
monitoring starts.
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Table 215: Generator Load Control Object Attributes
Control Type

W,C,A

Time Ctrl

Adjust Value of Load

Q

0

Priority for Writing

W,C,A,Q

11

Target Value to Supply W,C,A,Q

0

JCI Control Start
Reference

C,A

NULL

JCI Current Consumed C,A
WH Reference

NULL

Sampling Interval

5

W,C,A

Control_ Type_ This attribute provides the means for determining
Enum_Set (New the Present Value. Time Control refers to the
Define)
value of the Adjust Value of Load property, and
determines the Present Value. Value Control refers
to the values of Adjust Value of Load property, and
determines the Present Value.
Units = kW
This attribute expresses the value of electric power
that can be supplied by a generator minus the
current electric power consumed by a generator in
kW units.
Low Limit = 3
This attribute defines the priority when instructed
High Limit = 16 to start or stop by demand control based on this
object. It is a 1 to 16 unsigned integer, with 1 being
the highest priority, and 16 being the minimum
priority.
Units = kW
This attribute shows the electric power that can be
supplied by a generator.
This attribute refers to the power voltage of
a generator. The Present Value of BI or BV is
configured as an object or a property to be set. If
the object referred to is not reliable, or the reference
of the input object is offline, the Generator Load
Control object is unreliable.
This attribute refers to the power consumption
of a generator. The Present Value of AI or AV is
configured as an object and a property to be set.
If the object is not reliable, or the reference of the
input object is offline, the Generator Load Control
object is unreliable.
Units = seconds This attribute refers to the interval of time in
seconds needed to determine the Present Value.
The values of Sampling Interval and Consecutive
Samples should be configured in consideration of
the update time (polling period) of the object that
is set as the reference input. If the object reaches
the value that is set in Consecutive Samples, the
Present Value is obtained.
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Table 215: Generator Load Control Object Attributes
Transition Interval

W,C,A,O

60

Consecutive Samples

W,C,A

6

Recovery Power Offset W,C,A

0

Level Value

ALL 0

Units = seconds This attribute is the interval of time in seconds
needed to determine when the Present Value can
be increased by one level in Value Control. The
values of Transition Interval are configured in
consideration of the update time (ramping period how fast the Present Value can be ramped up from
one level to another) of the load controlled by the
object. This interval only applies to values that are
positively increasing. If the Present Value of the
object is decreasing, this interval does not apply.
When the Present Value is changed to a positive
direction such as from 1 to 4, the Present Value
should ramp up one level at a time to prevent
generator failure because of overload. This property
defines an interval to decide when the next increase
occurs. For example, if Generator Load Control
(GLC) changes the Present Value from 1 to 2, then
once the Time Transition Interval expires, GLC
changes the Present Value to 3, and so on, until it
reaches the desired level. While in transition, the
desired level can change and the ramping can be
adjusted to the new level.
See the Sampling Interval attribute for details.
Units = kW

This attribute represents the offset that counts
toward the determining conditions for performing
applying control (decrement of level).
This attribute represents the level of available
electric power of a generator, measured in a 60
minute period. It defines the load capacity to be
decreased when a device at a specified level is
turned off.
Although the Level Value attribute is an array of
16 values, only the values 1, 2, 3, 9, 15, and 16 are
configurable.
Level Value: Control Status of Register Points
Device
1: All levels recovered (all demand controlled
devices are OFF).
2: Level 2 devices are turned ON. All other devices
are OFF.
3: Level 2 and 3 devices are turned ON. All other
devices are OFF.
<4-8>:n/a
9: Devices at level 1 to 9 are turned OFF. All other
devices are OFF.
<10-14>:n/a
15: Devices at level 1 to 15 are turned ON. All other
devices are OFF.
16: All levels are recovered (all demand controlled
devices are ON).

Life Safety Point Object
The Life Safety Point object’s attributes represent the state of smoke detectors, fire detectors,
security alarms, and similar devices. As a Life Safety Point, the state of this object can be one of 24
states.
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The Life Safety Point object is a standardized object that represents a BACnet Safety Point Object as
defined in the 2008 BACnet specification.

Life Safety Point Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the BACnet Notes column, letters indicate the following: B - Exposed as standard
BACnet property, O - BACnet optional property, P - BACnet proprietary property, Q- BACnet
required property.
Table 216: Life Safety Point Object Attributes - Focus/Configuration Tab
Attribute Name
Accepted Modes

BACnet
Notes
Q

Direct Reading

O

Event State

Life Safety Mode

W,Q

Maintenance
Required

O

Operation Expected Q
Out of Service

B,C,W

Values/Options/Range

Description

Uses BAC LifSfty Mode (BACnet
Specifies all the values the Life Safety Mode
Lifesafety Mode) (Set 189).
attribute accepts when written.
Units = Redirected to Units attribute Indicates an analog quantity that reflects the
measured or calculated reading from an initiating
device.
Uses BAC Event State (Set 5).
Indicates if an active event state is associated with
the object. If the object supports intrinsic reporting,
this attribute indicates the event state of the object.
If not, the attribute is Normal.
Uses BAC LifSfty Mode (BACnet
Specifies the operating mode of the Life Safety
Lifesafety Mode) (Set 189).
Point object. The Life Safety Point object generates
Change-of-Life-Safety event notifications for any
mode transition if the flags in the Event Enable
attribute are set.
Uses BAC LifSfty Maint (BACnet
Indicates that maintenance is required for the
Lifesafety Maintained) (Set 187).
life safety point. This may indicate periodic
maintenance or parameter-determined
maintenance, such as a dirtiness value for an
associated detector.
Uses BAC LifSfty Oper (Set 190).
Specifies the next operation expected by this object
to handle a specific life safety situation.
Indicates (when True) that the Present Value
and Reliability attributes are decoupled from the
physical input to the object and their values may
be changed for simulation or testing purposes.
Functions that depend on the values of the Present
Value or Reliability attributes continue to respond
to changes while Out of Service is True, as if those
changes had come from the physical input.
Additionally, the Out of Service state of the Status
Flags attribute is set to True and the Fault state is
decoupled from the physical input when Out of
Service is True.

Present Value

W,D,R,Q

Uses BAC LifSfty State (BACnet
Lifesafety State) (Set 186).

Reliability

B,W

Uses Reliability (Set 503)

Setting

O

Units = No Unit
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Indicates the current value of the Life Safety Point
object in the defined Units. When Out of Service is
True, this attribute is writable.
Indicates whether the Present Value is unreliable.
When Out of Service is True, the Reliability attribute
may be written directly.
Specifies the next operation expected by this object
to handle a specific life safety situation.
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Table 216: Life Safety Point Object Attributes - Focus/Configuration Tab
Attribute Name

Values/Options/Range

Description

Silenced

BACnet
Notes
Q

Uses BAC LifSfty SilState (BACnet
Life Safety Silent State) (Set 188).

Tracking Value

O

Uses BAC LifSfty State (BACnet
Lifesafety State) (Set 186).

Units

O

Uses Unit Set (Set 869)

Indicates whether the most recently occurring
transition for this object produced an audible or
visual indication that has been silenced by the
recipient of a Life Safety Operation service request
or a local process.
Reflects the non-latched state of the Life Safety
Point object. This attribute continuously tracks
changes in the latched state of the object.
Indicates the units of the quantity represented by
Direct Reading.

Life Safety Point Commands
The table below lists the commands supported by the Life Safety Point Object.
Table 217: Life Safety Point Commands
Command Name

Number of
Parameters

Description

In Service

None

Cancels the affect of an Out of Service command and returns
the Out of Service attribute to False. Present Value and
Reliability revert back to the values obtained from the physical
input.
Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Out of Service

The value to
be written to
the Present
Value.

Allows a user to override the object’s hardware input for
simulation or other purposes. The Out of Service command
changes the Out of Service attribute to True, writes the
Present Value to the value of the command parameter, and
writes the Reliability attribute to Reliable. Present Value and
Reliability no longer track the physical input.
When an Out Of Service command is issued, the NxE does not
communicate subsequent changes (operator or system) to
the field device.
Note: For BACnet objects, support of this command is dependent on the ability to write the Out Of Service attribute.

Life Safety Zone Object
The Life Safety Zone object represents a grouping of Life Safety Points. The Life Safety Zone can
also represent a grouping of Life Safety Zones.
The Life Safety Zone object is a standardized object that represents a BACnet Safety Zone Object as
defined in the 2008 BACnet specification.

Life Safety Zone Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Metasys Site Management Portal Help

409

Note: In the BACnet Notes column, letters indicate the following: B - Exposed as Standard
BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable
Table 218: Life Safety Zone Object Attributes - Focus/Configuration Tab
Attribute Name

BACnet
Notes

Values/Options/Range

Description

Accepted Modes

Q

Event State

B

Uses BAC LifSfty Mode (BACnet
Lifesafety Mode) (Set 189).
Uses BAC Event State (Set 5).

Life Safety Mode

W,Q

Uses BAC LifSfty Mode (BACnet
Lifesafety Mode) (Set 189).

Maintenance
Required

O

Uses BAC LifSfty Maint (BACnet
Lifesafety Maintained) (Set 187).

Operation Expected

Q

Uses BAC LifSfty Oper (Set 190).

Out of Service

B,C,W

Specifies all the values the Life Safety Mode
attribute accepts when written.
Indicates if an active event state is associated
with the object. If the object supports intrinsic
reporting, this attribute indicates the event
state of the object. If not, the attribute is
Normal.
Specifies the operating mode of the Life
Safety Point object. The Life Safety Point
object generates Change-of-Life-Safety event
notifications for any mode transition if the
flags in the Event Enable attribute are set.
Indicates that maintenance is required for the
life safety point. This may indicate periodic
maintenance or parameter-determined
maintenance, such as a dirtiness value for an
associated detector.
Specifies the next operation expected by this
object to handle a specific life safety situation.
Indicates (when True) that the Present Value
and Reliability attributes are decoupled from
the physical input to the object and their
values may be changed for simulation or
testing purposes. Functions that depend on
the values of the Present Value or Reliability
attributes continue to respond to changes
while Out of Service is True, as if those
changes had come from the physical input.
Additionally, the Out of Service state of the
Status Flags attribute is set to True and the
Fault state is decoupled from the physical
input when Out of Service is True.

Present Value

W,D,R,Q

Reliability

B,W

Silenced

Tracking Values

O

Uses BAC LifSfty State (BACnet Lifesafety Indicates the current value of the Life Safety
State) (Set 186).
Zone object. When Out of Service is True, this
attribute is writable.
Uses Reliability (Set 503)
Indicates whether the Present Value is
unreliable.
Uses BAC LifSfty SilState (BACnet Life
Indicates whether the most recently occurring
Safety Silent State) (Set 188).
transition for this object produced an audible
or visual indication that
has been silenced by the recipient of a Life
Safety Operation service request or a local
process.
Uses BAC LifSfty State (BACnet Lifesafety Reflects the non-latched state of the Life
State) (Set 186).
Safety Zone object. This attribute continuously
tracks changes in the latched
state of the object.
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Table 219: Life Safety Zone Object Attributes - Members Tab
Attribute Name
Member Of

Data Type
List of

Zone Members

List of

BACnet Notes Description
O
Indicates the Life Safety Zone objects of which this Life
Safety Point is considered to be a zone member. Each object
in the Member Of list is a Life Safety Zone object.
Q
Indicates which Life Safety Point and Life Safety Zone objects
are members of the zone represented by this object.

Life Safety Zone Commands
The table below lists the commands supported by the Life Safety Zone Object.
Table 220: Binary Input Commands
Command Name

Number of Parameters

In Service

Description
Cancels the affect of an Out of Service
command and returns the Out of Service
attribute to False. Present Value and
Reliability revert back to the values
obtained from the physical input.
Note: For BACnet objects, support of this
command is dependent on the ability to
write the Out Of Service attribute.

Out of Service

The value to be written to
the Operation Expected.

Allows a user to override the object’s
hardware input for simulation or other
purposes. The Out of Service command
changes the Out of Service attribute to
True, writes the Present Value to the value
of the command parameter, and writes
the Reliability attribute to Reliable. Present
Value and Reliability no longer track the
physical input.
When an Out Of Service command is issued,
the NxE does not communicate subsequent
changes (operator or system) to the field
device.
Note: For BACnet objects, support of this
command is dependent on the ability to
write the Out Of Service attribute.

Loop Object
Menu Selection: Insert > Object > Loop
The Loop object allows a third-party BACnet workstation to represent a control loop in a
standard way. If you use the Site Management Portal as the primary mechanisms to view system
information, you do not need to use the Loop object.
The Loop object represents the key information from a PID logic module. The object does not
execute the PID algorithm but simply allows you to represent the key parameters of a PID logic
module in a Focus tab view.
The Loop object uses the data provided by mapped field points to execute the BACnet intrinsic
alarming algorithm. First, create a folder and map the field points representing the loop
information. Then use the Insert Object wizard to add the Loop object to the same folder and
configure references to the mapped points representing the loop information. The Loop object
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reads the information indicated by the references, and presents the values received in the Focus
tab of the Loop object.
The behavior of the Loop object’s intrinsic alarming algorithm is as follows:
•

The loop object generates a TO OFFNORMAL event when the difference between the Setpoint
Value and the Controlled Variable Value remain outside the band defined by the Error Limit
and the Time Delay has been exceeded.

•

The loop object generates a TO NORMAL event when the difference between the Setpoint
Value and the Controlled Variable Value is within the band defined by the Error Limit.
Note: You must configure references to the BACnet required properties to successfully
create the Loop object. These references appear red in the wizard until configured. You may
optionally configure references for the BACnet optional properties. If you do not define the
optional references for some reason, the Loop object responds to a read for the corresponding
value with an Unknown Property error. These BACnet required and optional properties are
noted with footnotes in the attribute table. See Loop Attributes.

Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters for the attributes indicate the following: C - Configurable, N
- Value Not Required, W - Writable.
Table 221: Loop Attributes - Focus/Configuration Tab
Attribute Name
Action

Notes
C,W

Values/Options/Range
Direct
Reverse
Uses BACEventState set.

Alarm State

Bias

11

Bias Reference

C,N,W

Controlled Var Variable

22
Controlled Variable Reference C,W

COV Increment

Derivative Constant
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Restricted to field mapper
points.

Description
Indicates whether the loop is direct or reverse
acting.
Indicates whether the object has an active alarm
state associated with it. The intrinsic alarming
algorithm determines the Alarm State value.
Indicates the bias value used by the loop
algorithm. If the Bias Reference does not
contain a value, a read of the Bias attribute
returns an Unknown Property error.
Provides the object reference for the Bias
attribute. The Loop object reads and signs up
for changes in the Present Value attribute of the
object referenced by the Bias Reference. The
value received is stored as the Bias.
Reflects the Present Value of the field point
mapper defined by the Controlled Variable
Reference.
Defines the field point mapper that represents
the source of the input to the control loop.
Defines the minimum change in the Present
Value required for the object to report a change
to other feature objects.
Indicates the value of the derivative gain
parameter used by the loop algorithm. If the
Derivative Constant Reference does not contain
a value, a read of the Derivative Constant
attribute returns an Unknown Property error.
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Table 221: Loop Attributes - Focus/Configuration Tab
Attribute Name

Notes
Derivative Constant Reference C,N,W

Values/Options/Range

Display Precision

Uses Display Precision set.

1

C,W

Integral Constant

Integral Constant Reference

1

C,N,W

JCI Out of Service Reference

C,W

JCI Out of Service Value
Reference

C,W

Manipulated Variable

C,W

Restricted to field points.

C

False

2

Reference
Manual Tuning

Max Output
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Description
Provides the object reference for the Derivative
Constant attribute. The Loop object reads
and signs up for changes in the Present Value
attribute of the object referenced by the
Derivative Constant Reference. The value
received is stored as the Derivative Constant.
Indicates the rounded position and the number
of decimal places to display for this object.
Indicates the value of the integral gain
parameter used by the loop algorithm. If the
Integral Constant Reference does not contain a
value, a read of the Integral Constant attribute
returns an Unknown Property error.
Provides the object reference for the Integral
Constant attribute. The Loop object reads
and signs up for changes in the Present Value
attribute of the object referenced by the Integral
Constant Reference. The value received is stored
as the Integral Constant.
Provides the object reference for the JCI Out
of Service attribute. The Loop object reads
and signs up for changes in the Present Value
attribute of the object referenced by the JCI Out
of Service Reference. The reference must be a
BI, BO, or BV object. When the state of the JCI
Out of ServiceReference is True, the PID loop
algorithm is placed out of service.
Provides the object reference for the JCI Out
of Service Value Reference attribute. The Loop
object reads and signs up for changes in the
Present Value attribute of the object referenced
by the JCI Out of Service ValueReference. The
reference must be an AI, AO, or AV object. When
the Loop object is out of service, its Present
Value assumes the value of this referenced
object.
Defines the field point mapper that represents
the destination of the output of the control loop.
Controls whether the gain values of the PID
Loop object can be changed. These values
include Proportional Constant, Derivative
Constant, Integral Constant, Bias, Maximum
Output, and Minimum Output. When the value
of this attribute is False, these referenced values
cannot be changed.
Indicates the maximum value of the output
(Present Value) as limited by the PID loop
algorithm. This value is normally used to prevent
the algorithm from controlling beyond the
range of the controlled device, and to prevent
integral term wind up. If the Maximum Output
Reference does not contain a value, a read of
the Max Output attribute returns an Unknown
Property error.

413

Table 221: Loop Attributes - Focus/Configuration Tab
Attribute Name
Maximum Output Reference

1

Notes
C,N,W

Values/Options/Range

Min Output

1

Minimum Output Reference

C,N,W

Present Value
Present Value Reference

C,W

Restricted to field points.

Proportional Const

Proportional Constant

C,N,W

1

Reference

Reliability

Uses Reliability set.

Setpoint

2

Setpoint Variable Reference
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C,W

Description
Provides the object reference for the Max
Output attribute. The Loop object reads and
signs up for changes in the Present Value
attribute of the object referenced by the
Maximum Output Reference. The value received
is stored as the Max Output.
Indicates the minimum value of the output
(Present Value) as limited by the PID loop
algorithm. This value is normally used to prevent
the algorithm from controlling beyond the
range of the controlled device, and to prevent
integral term wind up. If the Minimum Output
Reference does not contain a value, a read of
the Min Output attribute returns an Unknown
Property error.
Provides the object reference for the Min Output
attribute. The Loop object reads and signs up
for changes in the Present Value attribute of
the object referenced by the Minimum Output
Reference. The value received is stored as the
Min Output.
Indicates the current output value of the loop
algorithm.
Provides the object reference for the Present
Value attribute. The Loop object reads and signs
up for changes in the Present Value attribute
of the object referenced by the Present Value
Reference. The value received is stored as the
Present Value.
Indicates the value of the proportional gain
parameter used by the loop algorithm. If the
Proportional Constant Reference does not
contain a value, a read of the Proportional Const
attribute returns an Unknown Property error.
Provides the object reference for the
Proportional Const attribute. The Loop object
reads and signs up for changes in the Present
Value attribute of the object referenced by the
Proportional Constant Reference. The value
received is stored as the Proportional Const.
Reflects the Reliability attribute of the object
referenced by the Present Value Reference
attribute, providing an indication of whether
the Present Value of the loop in question is
reliable. This attribute may have a value of
Reliable or Open when the field point mapper’s
Reliability is Reliable or Open. This attribute
may have a value of Unreliable when the field
point mapper’s Reliability is a value other than
Reliable or Open.
Reflects the Present Value of the field point
mapper defined by the Setpoint Variable
Reference.
Defines the field point mapper that represents
the setpoint for the control loop.
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Table 221: Loop Attributes - Focus/Configuration Tab
Attribute Name
Units

Notes

Update Interval
1

Values/Options/Range
Uses Units set.

Units = milliseconds

Description
Reflects the Units attribute of the object
referenced by the Present Value Reference
attribute.
Indicates the time period, in milliseconds,
between updates to the Present Value attribute.

You may optionally configure a reference for this BACnet optional property. If you do not define the optional reference
for some reason, the Loop object responds to a read for the corresponding value with an Unknown Property error.
You must configure references to this BACnet required property to successfully create the Loop object. This reference
appears red in the wizard until configured.

2

Loop Commands
The table below lists the commands supported by the Loop Object.
Table 222: Loop Commands
Command
Name

Parameters

Description

Disable
Alarms

None

Disables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects. This command
restores the previous Event Enable values.

Enable
Alarms

None

Enables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects. This command
sets the Event Enable values to False, False, False.

In Service

None

Places the PID loop object algorithm in service.

Manual
Tuning

None

Enables or disables the ability to change gain values of the
PID Loop object, including Proportional Constant, Derivative
Constant, Integral Constant, Bias, Maximum Output, and
Minimum Output.

Out of
Service

Real value

Places the PID loop object algorithm out of service. The value
specified in the command is written to the JCI Out of Service
Value Reference. The Present Value of the Loop object assumes
the value of the JCI Out of Service Value Reference while out of
service.

Multistate Input Object
The Multistate Input object’s Present Value attribute represents results of an algorithmic process
within the device in which the object resides. For example, the Present Value of the Multistate Input
object could be either the result of a combination of multiple binary inputs, the threshold of one
or more analog inputs, or the result of a mathematical computation. Present Value is an integer
representing the state of the object. The State Text attribute associates a description with this state.
Note: Do not confuse the Present Value state with the Event State attribute, which reflects the
Offnormal state of the Multistate Input.
The Multistate Input object integrates N1, N2, and BACnet controllers with supervisory controllers,
resulting in:
•

a consistent interface to point objects for all controller types

•

flexibility in point mapping

•

support for Metasys N2 controllers. See the N2 Controller Object.

Metasys Site Management Portal Help

415

For example, this object allows you to display the speeds of a multispeed fan at a supervisory
controller.
For general information on Metasys system objects, see Common Object Attributes.

Multistate Input Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.
Table 223: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name
Current
Command
Priority
Device Type

Notes

BACnet
Notes
B

Initial Value

C,W

W

Null

Intrinsic
Alarming
Defined

C

Not
Supported

False

Number of
States

C,W

W

4

Out of Service C,W

W

False

Values/Options/
Range
1 - 16

Description

Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.
Limit: 20
Contains a description of the physical device
characters
connected to the object.
False
Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
True
attributes. For detailed information, see BACnet
Intrinsic Alarming.
Minimum Value = 2 Defines the number of states Present Value can
Maximum Value = have.
16
False
Used to decouple the object from the physical
input that feeds its Present Value and Reliability.
True
When out of service is True, the object does not
read the Present Value and Reliability from the
hardware.
In addition, the Reliability attribute and the
corresponding state of the Fault flag of the
Status Flags attribute is decoupled from the
input when Out of Service is True. While the Out
of Service attribute is True, Present Value and
Reliability may be changed to any value either as
a means of simulating specific fixed conditions
or for testing purposes. Other functions that
depend on the state of the Present Value or
Reliability attributes respond to changes made to
these attributes while Out of Service is True, as if
those changes had occurred in the input.

Present Value D,N,R,W

D,N,R,W

States Text
attribute identifies
the value set for
this attribute.

Reflects the current value of the input as one of
n states, where n is the number of states defined
in the Number of States attribute. When Out of
Service is True, Present Value is writable.
This attribute is required to be writable if Out of
Service is True.
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Table 223: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name
Reliability

Notes

Initial Value

W

BACnet
Notes
W

C,W

C

Off Low

State Text

States Text
States Text
Error Status

Med Hi
OK

Values/Options/ Description
Range
No Fault Detected Indicates if the Present Value is unreliable and
(Reliable), No
why. When Out of Service is True, the Reliability
Sensor, Over
may be written directly.
Range, Under
Range, Open Loop,
Shorted Loop,
Multi State Fault,
Unreliable Other
Uses Reliability (Set
503).
Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.
Indicates the displayed strings for the Present
Value.
Out of Memory:
Specifies the status of States Text on the
Indicates that
supervisory device. This attribute cannot be
memory overrun archived or configured.
occurred while
the system was
adding custom
enumeration for
state text from the
field device to the
user dictionary.
OK: the addition
of custom
enumeration for
state text from the
field device to the
user dictionary is
successful, and
state text from
the device can be
used.
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Table 223: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name
Status Flags

Notes

BACnet
Notes

Initial Value

Values/Options/
Range
In Alarm, Fault,
Overridden, Out of
Service Uses BAC
Status Flags (Set
9).

Description
Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status. The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if the
Present Value is decoupled from the hardware
output because operator intervention provided a
different value.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise
the Out of Service flag is False.

Use Remote
Alarming

B,C,W

False

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Multistate Input Commands
The table below lists the commands supported by the Multistate Input Object.
Table 224: Multistate Input Object Commands
Command Name

Parameters

Description

Disable Alarms

None

Disables all types of alarming:
alarm extensions, BACnet
intrinsic alarming, and BACnet
Event Enrollment objects.

Enable Alarms

None

Enables all types of alarming:
alarm extensions, BACnet
intrinsic alarming, and BACnet
Event Enrollment objects.
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Table 224: Multistate Input Object Commands
Command Name

Parameters

Description

In Service

None

This command cancels the
effect of an Out of Service
(Command) command and
returns the Out of Service
attribute to False. The Present
Value and Reliability will revert
back to the values obtained
from the physical input.
Note: For BACnet objects,
support of this command
is dependent on the ability
to write the Out Of Service
attribute.

Out of Service (Command)

The value to be written to the This command allows a
Present Value attribute.
user to override the object's
hardware input. The Out Of
Service command changes
the Out of Service attribute
to True, writes the Present
Value to the value of the
command parameter and
writes the Reliability attribute
to Reliable. The Present Value
and Reliability will no longer
track the physical input.
When an Out Of Service
command is issued, the
NxE does not communicate
subsequent changes (operator
or system) to the field device.
For BACnet objects, support of
this command is dependent
on the ability to write the Out
Of Service attribute.

Temporary Out of Service

The value to be written to the
Present Value attribute, along
with the hours and minutes
that the out of service state is
temporarily active.

Allows a user to temporarily
override the object’s hardware
input for simulation or other
purposes for a specified
period of time stated in hours
and minutes. This command
has the same function as an
Out of Service command but
with the time element.

Multistate Output Object
The Multistate Output object’s attributes represent the desired state of one or more physical
outputs or processes of the device in which the object resides. The actual functions associated with
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a particular state are determined locally (not part of protocol). Present Value represents the state
with a number, and State Text associates a description with each state.
The Multistate Output object integrates N1, N2, and BACnet controllers with supervisory controllers,
resulting in:
•

a consistent interface to point objects for all controller types

•

flexibility in point mapping

• support for Metasys controllers
For example, this object allows you to command the modes of an access control device from a
supervisory controller.
Note: The N1 migration Multiple Command object maps to this Multistate Output object.
For general information on Metasys system objects, see Common Object Attributes.

Multistate Output Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the notes and BACnet notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.
Table 225: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name
Current
Command
Priority
Device Type

Notes

BACnet
Notes
B

C,W

W

Heavy Equip
Delay

C,W

Not
supported

Initial Value

0

Values/Options/
Range
1 - 16

Limit: 20
characters
Range: 0–255
Seconds

Description
Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.
Contains a description of the physical device
connected to the object.
Indicates the amount of time that this output
point adds to the Accumulated Delay attribute of
the Heavy Equipment Controller object when this
point is started. The next output point is delayed
by that amount of time of the HEC Accumulated
Delay is not already decremented to zero.
The NAE device’s five internal Heavy Equipment
Controller objects (see HED Controller) time
their delays independently of one another. For
example, HED 1 and HED 4 can count down their
delays at the same time.
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Table 225: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name
HED
Controller

Notes
C,W

BACnet
Notes
Not
supported

Initial Value

Values/Options/
Range
1–5

Description
Identifies the Heavy Equipment Controller object
managing the delays.
The NAE device has five internal Heavy
Equipment Controller objects for use by Binary
Output and Multistate Output objects. The BO
and MO objects reference the HED controller
objects by number (1–5).
All BO and MO objects on an NAE share the five
internal HED controller objects. For example, if
BO1 and MO3 on NAE-1 reference HED controller
1, they are using the same HED controller.
Also see Heavy Equip Delay.

Intrinsic
C
Alarming
Defined
Number of
C,W
States
Out of Service C,W

Not
supported

False

W

4

Present Value D,R,W

D,R,W

Enables the definition of the intrinsic alarm
related attributes. For detailed information, see
BACnet Intrinsic Alarming.
2–16
Defines the number of states possible for
Present Value.
False
Used to decouple the object from the physical
output. When Out of Service is True, the object
True
decouples Present Value and Reliability from the
hardware. The Reliability will be writable when
Out Of Service is True. Not all devices support
setting this attribute to True.
States Text
Indicates the current value of the output as
attribute identifies one of n states, where n is the number of states
the value set for
defined in Number of States.
this attribute.
Lists object commands in level of importance.
True

W

Priority Array
Reliability

False

Reliable

No Fault Detected Indicates if the Present Value is unreliable and
(Reliable), Open
why. When Out of Service is True, the Reliability
Loop, Shorted
may be written directly.
Loop, No Output,
Unreliable Other
Uses Reliability (Set
503).

State Text

Off Low
Med Hi

States Text

C,W

C,W

Off Low
Med Hi
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Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.
Indicates the displayed strings for the Present
Value.
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Table 225: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name
States Text
Error Status

Notes

BACnet
Notes

Initial Value
OK

Values/Options/
Range
Out of Memory:
Indicates that
memory overrun
occurred while
the systems was
adding custom
enumeration for
state text from the
field device to the
user dictionary.

Description
Specifies the status of States Text on the
supervisory device. This attribute cannot be
archived or configured.

OK: The addition
of custom
enumeration for
state text from the
field device to the
user dictionary is
successful, and
state text from
the device can be
used.
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Table 225: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name
Status Flags

Notes

BACnet
Notes

Initial Value

Values/Options/
Range
In Alarm, Fault,
Overridden, Out of
Service
Uses BAC Status
Flags (Set 9).

Description
Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status. The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if the
Present Value is decoupled from the hardware
output because operator intervention provided a
different value or local override is active.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W

False

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Multistate Output Commands
The table below lists the commands supported by the Multistate Output Object.
Table 226: Multistate Output Object Commands
Command Name

Parameters

Description

Disable Alarms

None

Disables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.

Enable Alarms

None

Enables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.
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Table 226: Multistate Output Object Commands
Command Name

Parameters

Description

In Service

None

Cancels the effect of an Out of Service
command and returns the Out of
Service attribute to False. The Present
Value and Reliability will revert back to
the values obtained from the physical
hardware output.
Note: For BACnet objects, support
of this command is dependent on
the ability to write the Out Of Service
attribute.

Operator Override

The value to be written to the
Present Value attribute.

Updates the Present Value at
Command Priority Operator Override
(8).
The Operator Override command
sends the specified command to the
internal NxE object, which is then only
sent to the field device when one of
the following conditions is met: a)
NOT Local Control and NOT Out Of
Service, or b) NOT Local Control and
after issuing the In Service command.

Out of Service

None

Overrides the object's hardware
output. The Out of Service command
changes the Out of Service attribute to
True. The Present Value and Reliability
no longer track the physical output.
No commands are sent to the actual
hardware. When the Out of Service
attribute is set to False, the current
Present Value is sent to the actual
hardware.
When an Out Of Service command is
issued, the NxE does not communicate
subsequent changes (operator or
system) to the field device.
For BACnet objects, support of this
command depends on the ability to
write the Out Of Service attribute.

Release Operator
Override

None

Releases Command Priority Operator
Override (8) from Present Value.

Release

1.

Attribute name

2.

Command priority

Releases the identified command
priority from the specified, writable
attribute, and allows it to be controlled
by the next highest priority.
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Table 226: Multistate Output Object Commands
Command Name

Parameters

Description

Release All

Attribute name

Releases Command Priorities 3
through 16 (Default) from the
specified, writable attribute. Command
Priorities 1 and 2 remain.
Important: The Release All command may not cause an immediate return to automatic operation.
The Release All command clears all
command priorities, including those
that come from applications and features. When this release happens, the
output point goes to its Relinquish
Default condition. In some cases,
the application or feature may have
sent a command that does not match
Relinquish Default. In this instance,
the output point does not end in the
state that the applications or features intended. This situation can
cause unexpected operation to occur;
for example, a space might overcool
or overheat, a fan might run longer
than expected, and so on. If an operator has overridden an input, use the
Release Operator Override command.

State0 … StateN

None

Releases Command Priorities 9
through 15 (Scheduling) and then
writes to the Present Value at the
Default (16) command priority. If this
is the highest priority, it is sent to the
controller. Both the state command
names and the number of commands
are dependent on the States Text and
Number of States attributes.
Important: Be aware that an operator state command releases the
actions of any processes running
to the object in the NxE or FEC controllers that use Priorities 9 through
16. Consider this behavior when creating control strategies.

If Local Control is True, this command
is rejected.
Temporary Override

The value to be written to the
Present Value attribute, in
addition to the duration of the
override in hours and minutes.

Overrides a point temporarily for a
specified period of time. After the
specified time period passes, the
Override is automatically released.

Note: For the Override Release, Release, and Release All commands, if all Command Priorities
have been released and a Relinquish Default is not defined, the supervisory controller gives
control over to the actual hardware.
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Multistate Value Object
The Multistate Value object’s attributes represent the desired state of one or more physical outputs
or processes of the device in which the object resides. The actual functions associated with a
particular state are determined locally (not part of protocol). Present Value represents the state
with a number and State Text associates a description with each state.
Multistate Value objects have similar software characteristics and capabilities to a Multistate Input
Object; however, Multistate Value objects are not associated with any physical hardware and are
the result of a control process or operator entry.
The Multistate Value object provides a means to map up to 32 different states to an object.
This object allows you to hold a multistate value for other objects to reference. For example, a
specific multistate value can be available for the Interlock object to reference and to base its
operation on this value.
For general information on Metasys system objects, see Common Object Attributes.

Multistate Value Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.
Table 227: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes

Connected
To Internal
Application
Current
Command
Priority
Failsoft
Currently
Active

Intrinsic
Alarming
Defined

BACnet
Notes

Initial Value

Values/Options/
Range

Description

B,W

No

No or Yes

Indicates whether the object is connected to an
internal application.

1 - 16

Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.
Specifies whether the Failsoft feature is currently
overriding the input value to a reliable default. If
No, Failsoft is disabled or, if Failsoft is enabled,
the value is reliable. If Yes, Failsoft is enabled and
the value is unreliable. This attribute is only used
if Property Ref Value is defined to reference an
application.
Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes. For detailed information, see BACnet
Intrinsic Alarming.
Defines the behavior of the object as an input
or output. If you do not specify a Property Ref
Value, the attribute is set to False. This attribute
appears only in the Snapshot Focus view.
Defines the number of states possible for
Present Value.

B

Yes or No

C

Not
supported

False

True

Monitor Only

Number of
States

False

False

C,W

W

4

2 to 32

This attribute is not writable through the MS/TP
integration. You must configure this attribute
through CCT.
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Table 227: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Notes
Name
Out of Service

BACnet
Notes

Present Value D,R,W

D,R,W

Initial Value
False

Values/Options/
Range
Always False

Description

Indicates the offline/online state of the
connected hardware. This attribute exists for
compatibility with BACnet protocol and indicates
whether the physical input that the object
represents is in service. When out of service, the
object does not read the hardware. This attribute
is always False.
States Text
Reflects the current value of the multistate value
attribute identifies object as one of n states, where n is the number
the value set for
of states defined in the Number of States
this attribute.
attribute. The Present Value is equal to the last
value corresponding to the States Text attribute.
Present Value is optionally commandable. If
Present Value is commandable for a given object
instance, then Priority Array and Relinquish
Default are also present for that instance. If Out
of Service is true, Present Value is writable.
Note: If Present Value is commandable,
then it must be writable. If Out of Service is
True, this attribute is True.

Priority Array

Property Ref
Value

If Present Value
is commandable,
this attribute is
present.

N

Object Name,
Reference,
Attribute

Referenced
Reliability

No Input

Referenced
Value

Referenced
Value COS
Count

W

0
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Contains prioritized commands that are in effect
for this object. See the BACnet standard for a
description of the prioritization mechanism.
If either Priority Array or Relinquish Default is
present, both are present. If Present Value is
commandable, Priority Array and Relinquish
Default are both present.
Specifies an object and attribute (usually from an
application) for which the MV object is providing
the standard interface. The object and attribute
contained in this attribute must be a local object
and is often a non-BACnet data source and
destination. When this property is not defined,
the Monitor Only property is set to False. This
attribute appears only in the Snapshot Focus
view.
Specifies the current reliability of the value sent
to or from the object/attribute referenced by
Property Ref Value. This attribute is only used
if Property Ref Value is defined to reference an
application.
Specifies the current value sent to or from the
object/attribute referenced by Property Ref
Value. This attribute is only used if Property Ref
Value is defined to reference an application.
Counts how many times the Present Value and
Reliability have changed. This attribute helps
to diagnose excessive changes that can cause
logic to execute taking up too much bandwidth.
Reset the count by entering 0 for this attribute.
This attribute is only used if Property Ref Value is
defined to reference an application.
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Table 227: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Reliability

Notes
W

BACnet
Notes
W

Initial Value
Reliable

Values/Options/
Range
No Fault Detected
(Reliable),
Multistate Fault,
Unreliable Other

Indicates whether the Present Value is reliable
and why. If Fault Values is present, Reliability is
also present. A To Fault event generates under
these conditions: Reliability is not equal to No
Uses Reliability (Set Fault Detected, and the To Fault flag is enabled in
Event Enable.
503).

State Text

States Text
States Text
Error Status

C,W

C,W
OK

Description

Out of Memory:
Indicates that
memory overrun
has been
encountered while
adding custom
enumeration for
state text from
field device to the
user dictionary.

The Reliability attribute is always present in NAE
implementations.
Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.
Indicates the displayed strings for the Present
Value.
This attribute shows the status of States Text
on the supervisory device. This attribute is not
archivable or configurable.

OK: Indicates
that an addition
of custom
enumeration for
state text from
the field device
to user dictionary
is successful and
state text from
the device can be
used.
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Table 227: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name
Status Flags

Notes

BACnet
Notes

Initial Value

Values/Options/
Range
In Alarm, Fault,
Overridden, Out of
Service
Uses BAC Status
Flags (Set 9).

Description
Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status.
The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if
the Present Value has been overridden by
some mechanism local to the BACnet device or
because the operator provided a different value.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W

False

When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Multistate Value Commands
The table below lists the commands supported by the Multistate Value Object.
Table 228: Multistate Value Object Commands
Command Name

Parameters

Description

Disable Alarms

None

Disables all types of alarming: alarm
extensions, BACnet intrinsic alarming, and
BACnet Event Enrollment objects.

Enable Alarms

None

Enables all types of alarming: alarm
extensions, BACnet intrinsic alarming, and
BACnet Event Enrollment objects.
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Table 228: Multistate Value Object Commands
Command Name

Parameters

Description

Operator Override

State0–StateN

Updates the Present Value at Command
Priority Operator Override (8).
The Operator Override command sends
the specified command to the internal
NxE object, which is then only sent to the
field device when one of the following
conditions is met: a) NOT Local Control
and NOT Out Of Service, or b) NOT Local
Control and after issuing the In Service
command.

Release Operator Override

None

Releases Command Priority Operator
Override (8) from Present Value.

Release

1.

Attribute name

2.

Command priority

Releases the identified command priority
from the specified, writable attribute,
and allows it to be controlled by the next
highest priority.

Release All

Attribute name

Important: The Release All command
may not cause an immediate return to
automatic operation. The Release All
command clears all command priorities,
including those that come from applications and features. When this happens,
the output point goes to its Relinquish
Default condition. In some cases, the
application or feature may have sent a
command that does not match Relinquish
Default. In this instance, the output point
does not end in the state that the applications or features intended. This situation can cause unexpected operation to
occur; for example, a space could overcool or overheat, a fan might run longer
than expected, and so on. If an operator
has overridden an input, use the Release
Operator Override command.

Releases Command Priorities 3 through
15 from the specified, writable attribute.
Command Priorities 1 (Manual Emergency)
and 2 (Fire Application) remain.
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Table 228: Multistate Value Object Commands
Command Name

Parameters

State0 … StateN

None

Description
Important: Be aware that an operator
state command releases the actions of
any processes running to the object in the
NxE or FEC controllers that use Priorities 9
through 16. Consider this behavior when
creating control strategies.

Note: The MS/TP Multistate Value supports
an equivalent Set
State command which
takes State0-StateN as
Releases Command Priorities 9 through
parameters.

15 (Scheduling) and then writes to the
Present Value at the Default (16) command
priority. The state command names and
number of commands are dependent
on the States Text and Number of States
attributes.

Temporary Override

The value to be written
to the Present Value
attribute, in addition
to the duration of the
override in hours and
minutes.

Overrides a point temporarily for a
specified period of time. After the specified
time period passes, the Override is
automatically released.

Notification Class Object
Menu Selection: Insert > Object > Notification
Notes:
•

On the Configure screen, click the Recipient List tab for further configuration.

•

Click the Add button to add a BACnet device as a recipient item to the list. The Notification
Recipient dialog box appears. See the Tips for the Notification Recipient section that
follows.

•

Click the check box next to an item in the list and click Remove if you want to remove the
item from the list.

•

Click the check box next to an item in the list and click Details to view that item’s
Notification Recipient dialog box information.

•

Select an item in the list and use the up and down arrows to change the order of the item
in the list.

Tips for the Notification Recipient:
•

To send a notification to a specific BACnet device, select the OID radio button and enter the
object identifier for that device in the Device OID box. Enter the Process ID.

•

To send a notification to a specific address, select the Address radio button and enter the IP
Address, Network Number, UDP Port, and Process ID. See the Recipient List attribute of the
Notification Class object for details.

•

Select the check boxes for the days that the notifications should be sent. To define the times
when the notification is active, slide the arrows on the time bar to define Start and Stop times.

The Notification Class object provides a means to send alarm messages (Event Notification
Messages) that are generated by other objects to any BACnet device. Typically, it is used to route
alarm messages to third-party BACnet devices. Notification Classes are useful for event-initiating
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objects that have identical needs in terms of how their notifications should be handled, what the
destinations for their notifications should be, and how they should be acknowledged.
When you create a Notification Class object at a BACnet client and map the object to a network
engine, a folder called Notification is created and a new Notification Class object is created under
that folder in the navigation tree.
For more information about the wizard used to insert a Notification Class object, see Insert Object Notification. For general information on Metasys system objects, see Common Object Attributes.

Notification Class Concepts
Notification Class
A notification class defines how event notifications are prioritized according To Offnormal, To Fault,
and To Normal events; whether these categories of events require acknowledgment (nearly always,
by a human operator); and what destination devices or processes receive notifications.

Prioritization
Prioritization provides a means to ensure that alarms or event notifications with critical time
considerations are not unnecessarily delayed. Priorities may be assigned To Offnormal, To Fault,
and To Normal events individually within a notification class.

Acknowledgment
Acknowledgment provides assurance that a notification has been acted upon by some other agent,
rather than received correctly by another device. In most cases, acknowledgments come from
human operators. To Offnormal, To Fault, and To Normal events may, or may not, require individual
acknowledgment within a notification class.

Destinations
You can send event notifications to multiple destinations or to different destinations based on
the time of day or day of week. Notification Classes specify a list of destinations, each of which is
qualified by time, day of week, and type of handling. The Recipient List attribute describes how the
destination parameters relate to the Notification Class object. If an event that uses a Notification
Class object occurs, the day is one of the days of the week that is valid for a given destination,
and the time is within the window specified in the destination, then a notification is sent to the
destination defined in the Recipient List. You can qualify destinations by any combination of the
three event transitions: To Offnormal, To Fault, and To Normal.
The destination also defines the recipient device that receives the notification. The recipient
device is specified by either its unique Device Object Identifier or by its Network Address and MAC
Address. In the latter case, a unicast address or a broadcast, local/remote, or global address is
used. The destination information specifies whether the notification is sent using a confirmed or
unconfirmed event notification.
The Ack Required attribute of the Notification Class object and the type of event transition
determine whether the event notification message requires acknowledgment.

Notification Class Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the notes and BACnet notes columns, attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.
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Table 229: Notification Class Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

BACnet
Notes

Initial Value

Ack Required

C,W

W

False,
False,
False

Notification Class
Object

Priority

C,W

W

120
200
70

Route to Metasys

C,W

Not
supported

True

Send Notifications
to Supervisor

C,W

Not
supported

True

Values/
Description
Options/
Range
To Offnormal Conveys three separate flags that
represent whether acknowledgement is
To Fault
required in notifications generated for To
To Normal
Offnormal, To Fault, and To Normal event
Uses BAC
transitions, respectively.
Event Bits (Set
525).
0 to
Indicates the numeric value of this
4,294,967,295 notification class and equals the instance
number of the Notification Class object.
Event initiating objects use this number
to reference a specific Notification Class
object.
To Offnormal Conveys the priority to be used for event
notifications for To Offnormal, To Fault,
To Normal
and To Normal events, respectively. A
To Fault
lower number indicates a higher priority.
Range = 0 to
255
True, False
Determines whether or not the
Notification Class object routes alarms to
the Metasys alarming system.
True, False
Determines whether or not the
Notification Class object routes alarms to
the supervisory device.

Table 230: Notification Class Object Attributes - Recipient List Tab
Attribute Name
Recipient List

Data Type
List of value
sets

Notes
C,W

BACnet Notes Initial Value
W

Values/Options/Range
See Recipient List.
Uses BAC Day Bitset (Set 176), Recipient
Choice (Set 526), and BAC Event Bits (Set
525).

Recipient List
Conveys a list of one or more recipient destinations to which notifications are sent when eventinitiating objects using this class detect the occurrence of an event. Each destination structure
contains the following:
•

From Time, To Time (Start and Stop Times) - The window of time (inclusive) during which
the destination may be used. To specify all times, use 00:00:00 for Start Time and 23:59:59 for
Stop Time.

•

IP Address - The 4 byte IP Address of the destination if routing by IP address. This value is
ignored when Network Number is set to 65,535. When set to 255.255.255.255 IP Address or
the broadcast IP Address, notifications are broadcast based on the Network Number. A value
of 0 sends a local broadcast. A value of 1–65,534 sends a remote broadcast.

•

Issue Confirmed Notifications (Confirmed, Unconfirmed) - Indicates whether to send
Confirmed or Unconfirmed event notifications through radio button selection. This selection is
ignored when using global broadcast notifications.

•

MSTP Address - The MS/TP address of the destination if routing by MS/TP address.
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•

Network Number - The network number for the destination if routing by IP or MS/TP
address: 0 designates the address of the local network 1–65,534 identifies a destination
address on the specified network 65,535 specifies the use of global broadcast notification (note
that the IP Address is not used and the notifications are unconfirmed)

•

Process Identifier - The process ID within the recipient device that receives the event
notification messages.

•

Recipient (Device Object ID) - The destination devices to receive event notification
messages.

•

Recipient Choice (Object ID or Address) - The choice of whether to use an Object Identifier
or the Address of the destination to route the notifications. If set to Address, the notification
is sent either to the specified address or broadcast. See IP Address and Network Number
descriptions for details.

•

Transitions (Off Normal, Fault, Normal) - Three flags which indicate the types of transitions
(To Offnormal, To Fault, or To Normal) sent to the destination.

•

UDP Port Number - The UDP Port number used to send the notification message to the
destination if routing by address. When the port is set to 0, this value when written is replaced
with the port used by the supervisory device on the IP network.

•

Valid Days - The days of the week on which notifications may be sent to this destination
during the value of From Time, To Time (Start and Stop Times).

Notification Class Commands
The table below lists the commands supported by the Notification Class Object.
Table 231: Notification Class Object Commands
Command Name

Parameters

BACnet Supported

Add Recipient

See Recipient List.

Yes

Disable

0

No

Enable

0

No

Remove Recipient

See Recipient List.

Yes
Only supported by the BACnet
Notification Class.

Schedule Object
The Schedule object works behind the scenes of the Scheduling feature. The Schedule object
updates attribute values of objects according to the time of day. These times can be specified for
days of the week and as exceptions.
When you create a Schedule object at a BACnet client and map the object to a network engine,
a folder called Schedule is created and a new Schedule object is created under that folder in the
navigation tree.

Schedule Object Attributes
The display of the Schedule object uses two tabs, the Schedule Object Schedule Tab and the
Schedule Object Focus/Configuration Tab. If you add extensions, see Extensions for information on
the extension tabs.

Schedule Object Features
Table 232 shows the icon of the Schedule object. The key words are included in the table to help
users who may search the help system using a description of the icon to find this chapter.
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Table 232: Schedule Object Icon
Icon

Key Words
Stopwatch, Pocket Watch, Clock

Schedule Object Schedule Tab
Table 233: Operation and Display Attributes
Attribute

Description

Effective Period

The Effective Period attribute defines the range of dates
within which the Schedule object is active. By default, these
dates are unspecified, causing the Schedule object to be
active for all days. When the Schedule is not within the
Effective Period, the Schedule is considered Inactive and the
Schedule’s status is set to Inactive. Wildcard may be used in
the date fields.

Schedule Output Type

Schedule Output Type Options

Default Schedule Command
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•

Binary: Select this option to set the schedule’s Value
type to Binary (one of two states, such as Off and On).

•

Analog: Select this option to set the schedule’s Value
type to Analog (for example, 72.0).

•

Multistate: Select this option to set the schedule’s
Value type to Multistate (one of a set of states, such as
Off, Low, Medium, and High).

•

Derived from Key Item: Select this option to set the
schedule’s Value type to match the Value type of the
attribute scheduled for the Key Item. For example,
all values are Boolean (True/False) if the Key Item’s
Enabled attribute is scheduled.

•

Derived from Value: This type is only set by the system
- it cannot be manually selected. This type indicates that
the current schedule type matches preexisting values.

The Default Schedule Command attribute indicates the
command of the Schedule object when no event is in effect,
due to no scheduled command or a conscious gap in the
schedule. The Default Schedule Command is executed
every midnight unless another event is in place to begin at
midnight.
The Default Schedule Command also supports the Release
command. The Release command releases the Scheduling
function’s control of the scheduled objects. Setting the
Default Schedule Command to Release is the only available
method to release the schedule’s control of scheduled
objects through the Schedule object. Release should only be
used for the Schedule Default Command if the scheduled
items support the Release command.
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Table 233: Operation and Display Attributes
Attribute

Description

States Text

The States Text attribute indicates the displayed strings for
the Present Value when the Schedule Output Type is either
binary or multistate. This attribute allows you to change what
states the Schedule’s Present Value displays if you want it to
be different from the key item.

Display Units

The Display Units attribute indicates the displayed units of
the Present Value when the Schedule Output Type is analog.
This attribute allows you to change the units displayed with
the Schedule’s Present Value if you want them to be different
from the key item.

Display Mode
The Display Mode drop-down menu allows you to select what is displayed in the lower panel of the
Schedule Tab.
Table 234: Display Mode
Attribute

Description

Today’s Schedule

Contains the schedule timeline for the current day. The
timeline displays the projected schedule output that will
be written to the scheduled objects for the current day,
combining the default Schedule Command with events from
both the Weekly Schedule and Exception Schedule. Today’s
Schedule also displays a table of times and values, which
details the changes in the schedule’s output for the current
day.
Note: Today’s Schedule does not display in the SCT. It also does
not display for mapped third-party schedules.

Weekly Schedule

Contains a timeline of events for each day of the week Monday, Tuesday, . . . Sunday. Each event has a time and value
that the Schedule writes to the scheduled objects. An event
ends at midnight, but it can be ended earlier by specifying an
end time or by scheduling another event to start. Events in the
Exception Schedule override times and values in this Weekly
Schedule. If the Weekly Schedule has no events defined on a
particular day and time, and there are also no exception events
scheduled, the Default Schedule Command takes effect.
Note: Weekly Schedule does not display for third-party schedules that do not support a weekly schedule.
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Table 234: Display Mode
Attribute

Description

Exception Schedule

Contains a list of exceptions to the weekly schedule. The times
and values in the exception replace anything that is in the
weekly schedule. If more than one exception is scheduled on
the same day, the highest priority (precedence) exception
takes effect. If all exceptions are of the same precedence, they
are executed in time order. Exceptions override the Weekly
Schedule only when events are scheduled for the exception.
Any time that an exception event is not in effect, such as
when an event is ended before midnight (or no exception
events are defined), the Weekly Schedule takes effect. If the
Weekly Schedule also has no scheduled events at that time, the
Default Schedule Command takes effect.
Notes:

Scheduled Items

•

Schedule an exception for the full time period that you
want to override the object. For example, if you want a
piece of equipment to be On between 09:00 and 18:00
and Off at other times, define an Off event at 00:00, an
On event at 09:00, and an Off event at 18:00. If you do not
define an Off event at 00:00, the period between 00:00
and 09:00 is not included in the Exception, and either the
Weekly Schedule or Default Schedule Command takes
effect.

•

By default, exception schedules which have already
occurred are deleted after 31 days. You can disable
automatic deletion of exception schedules or change the
number of days until the exception schedules are deleted
to 7 days by configuring the JCI Exception Schedule
attribute. For more information, see JCI Exception
Schedule in the Engine Device Object section.

•

Exception Schedule does not display for third-party
schedules that do not support exceptions.

Contains the list of items to be commanded by the schedule
object. If empty, the Schedule does not directly command
objects but its Present Value can still be used as an input to
other logic, such as an Interlock or Control System. The online
display also includes a Status Log that shows the status of
the schedule’s attempts to control each of the scheduled
items. If no objects are scheduled, the Schedule Output Type
determines what type of command may be scheduled.

Schedule Object Focus/Configuration Tab
The online UI displays the Focus tab. The SCT displays the Configuration tab.
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Table 235: Object Attributes
Name

The Name attribute contains a freely definable user-friendly Name for the
object that is independent of the Item Reference or the location of the
object in the physical network. The Name is used as the label in the All
Items navigation tree. The Name is shown in alarm reports, the event and
audit viewers, and in summaries. The Name does not need to be unique
to the site.
The Name defaults to the object identifier you used during manual object
creation, but can be edited later. For integrated BACnet objects, the name
defaults to the BACnet Object Name in the remote BACnet device. For
integrated N1 network objects, the name defaults to the System.Object
Name in the NCM.
Example: ConferenceCenter-Room2-LightingSchedule
The Name attribute allows up to 400 characters, but 40 or less is best for
the display layout.
Name is a common object attribute; for more information, see Common
Object Attributes.

Description

The Description attribute contains a user-defined description of the object.
The Description attribute allows up to 40 characters before Release 8.0
and up to 64 characters at Release 8.0 and later, but is not required.
Description is a common object attribute; for more information, see
stops the object from commanding the referenced attributes. Setting
the Enabled attribute to False does not change the Out of Service
attribute.Common Object Attributes.

Object Type

stops the object from commanding the referenced attributes.The
Object Type attribute indicates the type of object as displayed in the
Metasys software and as exposed to a BACnet network. The Object type
of the Schedule object is Schedule. The Schedule object is a standard
BACnet schedule object and conforms to the BACnet protocol 135-2004
specification. Object Type is a common object attribute; for more
information, see Common Object Attributes.

Authorization
Category

The Authorization Category attribute classifies the object by the category
of system or equipment that it monitors to aid in the determination of
user access privileges and alarm routing.
Examples: HVAC, Fire, Security

Table 236: Status Attributes
Enabled
Status Flags

Setting the Enabled attribute to False stops the object from updating its
Present Value and
•

•

In Alarm: This flag is always False for the Schedule object.
Fault: False means that the Reliability attribute is reliable,
otherwise the flag is True.
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•

Overridden: This flag is always False for the Schedule object.

•

Out of Service: True means that the Out of Service attribute is also
True, otherwise the flag is False.
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Table 236: Status Attributes
Reliability

The Reliability attribute indicates the reliability of the object. If there are
data type mismatches in the weekly schedule, exception schedules, or
Default Schedule Command, the object reports that it is unreliable. This
attribute does not appear in the SCT.

Out of Service

When True, the object no longer updates the Present Value itself. This
attribute does not appear in the SCT.
Note: Disabling the object does not impact the ability to put the Schedule
Out Of Service and write to its Present Value and thus to its Outputs.

Error Status

The Error Status attribute indicates whether the Present Value was
successfully written to the list of property values in the Scheduled Items
list. The Error Status displays Ok if the object was able to send its latest
Present Value to every object in the Scheduled Items list. Otherwise,
the Error Status displays the error of the first failed command. See the
status log in the Scheduled Items view for the status for each attempted
command. This attribute does not appear in the SCT, and does not appear
for mapped third-party schedules.

Alarm State

The Alarm State attribute indicates that the object transitioned into alarm
or unreliable conditions. This attribute does not appear in the SCT.

Table 237: Engineering Values Attributes
Item Reference

The Item Reference attribute contains a unique reference name for
the object that is the full path name of the object through the All Items
navigation tree using the unique identifier you specified when you
manually created the object. Item Reference is a common object attribute;
for more information, see Common Object Attributes.

Version

The Version attribute displays the version number of the object software
code. Version is a common object attribute; for more information, see
Common Object Attributes.

Table 238: Execution Attributes
Execution Priority

The Execution Priority attribute indicates the relative importance of
performing the function of the object within the device.

Priority for Writing

The Priority for Writing attribute defines the priority at which the
referenced attributes are commanded. Seven is the highest priority and
16 is the lowest supported by the Schedule object, with the default of 15.
Note: We do not recommend using priorities 7 or 8 as they may interfere
with the operator override functionality.

Schedule Commands
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Table 239: Schedule Commands
Command Name

Number of
Parameters

Description

Disable

None

The Disable command stops all future scheduled events.
Neither the Weekly Schedule nor the Exception Schedule run
again until the Schedule object is re-enabled. While disabled,
the status log in the Scheduled Items view lists the object as
disabled. The schedule remains disabled until re-enabled.

Enable

None

The Enable command allows the Schedule object to resume
normal scheduling operation. The Schedule object starts
the schedule as soon as it is enabled. When it is re-enabled,
the Schedule object writes its current value to the scheduled
items.

Folder
Menu Selection: Insert > Folder
Inserts a folder into the navigation tree of the system for grouping and categorizing items and
information in the navigation tree.
Note: Do not create an Equipment folder or Facility Graphics folder manually. The Metasys UI
and SCT save configuration information into folders with these names, and they are created
automatically if required. Equipment objects and Metasys UI graphics are not viewable in SMP.

Program Object
Menu Selection: Insert > Program Object
Inserts a program control system into the site. See Logic Connector Tool (LCT) for more information
on program control systems and the Logic Connector Tool.

Program Object
The Program object (previously the Control System object) stores information needed for the userdefined control strategies created (graphically) with the Logic Connector Tool (LCT). The Control
System object application now includes BACnet command object functionality and appears as the
Program object in the Metasys software. The Program object attributes allow manipulation of the
LCT application.
For general information on Metasys system objects, see Common Object Attributes.

Program Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.
Note: In the notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable. For more information about attribute characteristics,
see Attributes.
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Table 240: Program Attributes - Focus/Configuration Tab
Attribute Name
Description of Halt

Notes

Enabled

C,W

Initial Value

Values/Options/Range

Ready

0 = Ready

Instance Of
Program Change

W

1 = Load
2 = Run
3 = Halt
4 = Restart
5 = Unload
Program Location
Program State

0 = Idle
1 = Loading
2 = Running
3 = Waiting
4 = Halted

Reason for Halt

5 = Unloading
0 = Normal
1 = Load Failed
2 = Internal
3 = Program

Reliability

4 = Other
Uses Reliability set.

Logic Connector Tool (LCT)
Use the Logic Connector Tool to create the logic within a control system using a graphical
presentation. The control logic may include System Blocks and Logic Blocks. The Edit Mode allows
you to edit logic, and the View Mode allows viewing and limited commanding capabilities. When
running the LCT on the SCT (Metasys system in offline mode), commanding is disabled.
The Logic Connector Tool allows control system viewing and editing through any browser logged in
to any online or configuration server with access to a Program (Control System) Object and Metasys
system.
Logic runs approximately every 5 seconds. It is important that control applications that require
particular timing use internal logic to determine time between executions.
Note: You cannot insert logic on a Metasys server.

Logic Connector Tool Concepts
Logic Connector Tool Workspace
The Logic Connector Tool runs inside an active display panel. The workspace for the Program
(Control System) Object defaults to a white background. You have the option to add a lined or
dotted grid to the workspace using the appropriate buttons on the Toolbar. The workspace displays
all building blocks and the connections between them, and serves as the destination for dragged
and dropped blocks.

LCT Modes
The Logic Connector Tool runs in either Edit Mode or View Mode.
You can generate logic and make logic changes when you are using Metasys in offline mode (using
the SCT) or online mode. (See Metasys Modes.) After generating logic or making any changes to
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existing logic in offline mode, download the database to the online device to ensure the latest
information is used.
Edit Mode
Access Edit mode by clicking the Edit mode button (see Toolbar). You must be in Edit mode to edit
logic or create logic. The LCT opens in View mode.
In Edit mode, you have access to all toolbar items, System blocks, and Logic blocks.
Right-clicking in Edit mode brings up basic choices such as cut, copy, paste, delete, duplicate, hide,
label, zoom, and connect, depending on the type of item you select.
Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,
For mouse shortcuts in Edit mode, see Mouse Shortcuts: Edit Mode.
View Mode
The Logic Connector Tool displays in the View mode when you are browsing a site running Metasys
software in offline mode (using the SCT) or online mode. (See Metasys Modes.) See Errors in View
Mode.
In View mode, you have access only to a limited number of items on the toolbar. The System and
Logic blocks do not appear in this mode. The LCT opens in View mode. You must enter the Edit
Mode to edit any of the control system logic.
The View mode allows you to edit attributes (from the Configuration tab) and send commands to
any of the input reference blocks in the diagram.
Dynamic values display on the connection line between two logic blocks. Values refresh every
15 seconds unless you click the Refresh button on the Toolbar. Click the Trace mode icon on the
toolbar and the tool displays online values, but hides logical connections between blocks. If you
click a block, the tool traces all connections to and from that block (from the first input to the last
output).
Right-clicking in View mode has no effect.
For mouse shortcuts in View mode, see Mouse Shortcuts: View Mode.

Toolbar
The Logic Connector Tool uses the toolbar described here:
Note: When using a zoom tool in View mode, if you click outside of the display panel
containing the logic system, the zoom level automatically changes back to the default.
Table 241: LCT Toolbar
Icon

Command

(Standard
Windows
Icons not
Shown)
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Visible In
Edit
Mode

Action

View
Mode

Edit Mode

X

Changes the control system to Edit mode.

Refresh

X

Refreshes the values for control system
components.

Save

X

Saves the logic system and changes it to View mode.
If there are unconnected points, the logic system
warns to fix them prior to a save.

Cancel

X

Cancels current changes and returns to View mode.
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Table 241: LCT Toolbar
Icon

Command

(Standard
Windows
Icons not
Shown)

Visible In

Action

Edit
Mode

View
Mode

Print

X

X

Print dialog appears

Print
Preview

X

X

Print Preview dialog appears

Cut

X

Cuts an item of the control system.

Copy

X

Copies an item in the control system.

Paste

X

Pastes a cut or copied item into the logic system.

Undo

X

Undoes the previous action (except for a save) for
up to 4 actions.

Redo

X

Redoes the previous undone action (for up to 4
actions).

No Grid

X

Removes the grid from the diagram.

Lines Grid

X

Displays a line grid behind the diagram.

Points Grid

X

Displays a point grid behind the diagram.

Select

X

Text

X

Pan

X

X

Turns the cursor into a hand that allows you to pan
over the diagram by dragging.

Zoom

X

X

Zooms a selected area.

Interactive
Zoom

X

X

Zooms in and out on a diagram when you hold the
mouse down.

Zoom - Fit
Window

X

X

Zooms the diagram to fit within the window.

X

Removes all the connection lines in the diagram.
Live values remain.

X

Allows you to select the percentage zoom applied to
the diagram.

Trace Mode
Selective
Zoom

X

Logic
Checker

X
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X

Turns the cursor into a selection cursor.
Turns the cursor into a text cursor that allows you to
create a text box.

Checks the control system logic and places a balloon
with an icon over unconnected points. See the Logic
Checker section.
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Table 241: LCT Toolbar
Icon

Command

(Standard
Windows
Icons not
Shown)

Visible In
Edit
Mode

Sequence
(Show
Sequence
Order)

X

Overview

X

Action

View
Mode

Shows the logical sequence order of the connected
blocks. A value of -1 indicates that logic does not
execute on the block.
X

Shows an overview of the entire control system.

Logic
Logic contains the following components:
•

System Blocks that reference another control system

•

Logic Blocks that represent functions performed on objects

• Math Category between the Logic blocks
Once a logic process completes, it runs again in approximately 5 seconds. For example, if a logic
process starts at 10:00:00 and completes at 10:00:04, it runs again at 10:00:09. It is important that
control applications that require particular timing use internal logic to determine time between
execution.
If your logic references multiple Engines or multiple Metasys servers, and one device needs to
be downloaded, upload all Engines and Metasys servers prior to making changes in SCT. This
procedure ensures your logic works consistently.
System Blocks
System blocks support drag and drop functionality. When you deposit a System block onto the
workspace, a configuration wizard guides you through the configuration of the control system.
System blocks are useful when you have complex logic because they allow you to nest one control
system in another control system. When you create a System block, the Metasys software creates a
Program (Control System) Object under the first Program object in the navigation tree.
See Adding Items to Logic.
Logic Blocks
Logic blocks support drag and drop functionality. If the list of Logic blocks is too long to fit into the
Logic block list area, use the scroll bar to expose additional blocks.
Logic blocks are not visible on the navigation tree. If the LCT window is not large enough to show
all the logic blocks, you cannot scroll down to see the hidden blocks. To make sure you see them all,
enlarge the panel displaying the logic by dragging the borders or reducing the number of panels.
See the following table for a list of Logic blocks.
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Table 242: Logic Blocks
Logic Block
Name

Description

Math

Performs mathematical functions on one or more inputs, producing a single
output.
1–8 inputs

Bool

Performs Boolean functions on 2–8 inputs, producing a single output. This
category also includes the Latch function.

Statistical

Performs statistical functions on 2–8 inputs producing a single output.

Selector

Performs multiplexing for 2–8 inputs, producing a single output. Based on the
current mode assigned to each input, the selector chooses which input to pass
through to the output.

Control

Performs control functions on three inputs, producing a single output.

Psychro
(Psychrometric)

Performs psychrometric functions on the defined inputs, producing a single
output.

Attributes

Gives the user the ability to expose values from within their control logic, either
as an input or output. These blocks are considered attributes of the Program
(Control System) Object in which they are included, and may be viewed or
configured from the standard Focus view. A control system is limited to a
combination of 24 inputs and 24 outputs. See the Program (Control System)
Object for more information.

Constant

Passes a constant value to building block inputs.

Calculation

Controls the amount an output can change per control system execution or
extrapolates an output using two inputs for reference.

Timing

Passes its input to its output at the next execution of the control system (every
5 seconds). Timing blocks are used to break up feedback loops. The Timing
category also includes the Time and Timer blocks.

Math Category
Math blocks perform calculations on input. See the following table for details.
Table 243: Math Blocks
Block

Math Type

Inputs

*

Multiply

2–8

+

Add

2–8

X/Y

Divide

2

X-Y

Subtract

2

Neg

Negative

1

Abs

Absolute

1

Sqr

Square Root

1

Cos

Cosine

1

Sin

Sine

1

Tan

Tangent

1

ATan

Arc Tangent

1

ACos

Arc Cosine

1
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Table 243: Math Blocks
Block

Math Type

Inputs

ASin

Arc Sine

1

Exp

Exponent

1

LN

Natural Log

1

LOG

Log

1

X^Y

X^Y

2

The number of inputs to a Math logic block depends on the number of inputs supported by the
type of math function. The Logic Connector Tool allows you to add multiple connections to the
output of the block.
Note: Trigonometry blocks (SIN, COS, TAN, ASIN, ACOS, ATAN) perform calculations based on
radians only.
See Editing Blocks in Edit Mode for information on editing Math blocks.
Bool Category
Bool blocks apply Boolean functions to input. The number of inputs to a Bool logic block depends
on the number of inputs supported by the type of Boolean function. The Logic Connector Tool
allows you to add multiple connections to the output of the block.
Table 244: Bool Blocks
Bool Type

Inputs

AND

2–8

OR

2–8

XOR

2

NOT

1

LTCH

See LTCH (Latch) for details.

See Editing Blocks in Edit Mode for information on editing Bool blocks.
LTCH (Latch)
The Latch block holds a binary value until you command it to reset. Latch blocks help capture
rapidly changing binary states that might otherwise be missed. The Input of the Latch block is
a binary attribute, sampled every time the logic system runs (every 5 seconds). Use an Attribute
Reference block to create the Input for Latch.
Reset determines if the Output of the block changes with a change in the value of the Input. When
Reset is True, the Output of the Latch block stays its original value, even if the Input changes value.
Reset is also a binary attribute. To change the value of Reset, double-click the binary attribute block
in View Mode and issue an Inactive or Active command.
This table translates the value of the Input or Reset binary attribute into True and False values for
the Latch block:
Table 245: Latch Blocks
Binary Attribute Value

Command/State

True or False

1.0

Active

True

0.0

Inactive

False

The following table and figure summarize the operation of the Latch block:
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Table 246: Latch Block Operation
Input

Reset

Output

Goes from False to True

False

True
Even if the Input goes to False, the Output stays
True as long as Reset is False.

Goes from False to True

True

False

Goes from True to False

False

True
Even if the Input goes to True, the Output stays
False as long as Reset is False.

Goes from True to False

True

False

Figure 40: Latch Block Example

Statistical Category
Statistical blocks perform statistics on input. The number of inputs to a Statistical logic block
depends on the number of inputs supported by the type of statistic. The Logic Connector Tool
allows you to add multiple connections to the output of the block.
Table 247: Statistical Block Connections
Statistical Type

Inputs

AVG

2–8

MAX

2–8

MIN

2–8

See Editing Blocks in Edit Mode for information on editing Statistical blocks.
Selector Category
Selector logic blocks (Mux) have 2–8 inputs, one mode input, and one output. Depending on the
current value of the mode input, the Selector chooses which input passes through to the output.
The Logic Connector Tool allows you to add multiple connections to the output of the block.
See Editing Blocks in Edit Mode for information on editing Selector blocks.
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Control Category
Most control logic blocks have three inputs, and you can add multiple connections to the output
of the block. The blocks compare input number 1 with input number 2 using the differential (input
number 3). The type of control depends on the statistical type. The Sequencer functions differently.
See SEQ (Sequencer) for details.
Table 248: Control Blocks
Block

Statistical Type

Inputs

X>Y

greater than

3

X<Y

less than

3

X<=Y

less than or equal

3

X>=Y

greater than or equal

3

<>

not equal

3

=

equal

3

SEQ

Sequencer

See SEQ (Sequencer) for
details.

See Editing Blocks in Edit Mode for information on editing Compare blocks.
SEQ (Sequencer)
Sequencer blocks activate devices in a sequential order based on the rank of the device and
whether the device is enabled. Lower ranked devices are activated before higher ranked devices,
and higher ranked devices are deactivated before lower ranked devices.
The Input value at which the sequencer activates or deactivates each device is based on the make
and break limits configured for the Sequencer. See Editing SEQ (Sequencer) Blocks for information
on configuring the make and break limits. The defaults for a 3-stage Sequencer with a range of 0–
100 are the following:
Table 249: SEQ (Sequencer Blocks)
Make Limits (Activation
Points)

Break Limits (Deactivation
Points)

Stage 1

33

1

Stage 2

67

34

Stage 3

99

68

Sequencer blocks can output a value for minimum of 2 and maximum of 8 devices. The following
table describes the components of a Sequencer block:
Table 250: Sequencer Block Components
Component

Description

Input

Determines the number of activated stages.

Instant Shutdown

Determines if the Sequencer is enabled or disabled. Use a binary object
attribute
(1.0=Enabled, 0.0=Disabled).
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Table 250: Sequencer Block Components
Component

Description

Rotate Now

Activates reordering of output sequence. The manner in which the outputs
Device 1 Output through Device 8 Output are reordered for activation is based
on a combination of two factors: the ranking defined for each device, and
whether the device is enabled. All enabled outputs are scheduled for output
selection prior to disabled outputs. And, within each of these categories
(enabled and disabled outputs), the selections are ordered beginning with
the lowest ranked and proceeding on through to the highest ranked output.
Unlike all other reordering scenarios, the issue of whether or not a device is
currently active is not taken into account in this situation.
Use a binary object attribute (1.0=Rotate now, 0.0=Do not rotate now).

Device 1–8 Enable

Establishes whether or not the output is enabled. Use a binary object attribute
(1.0=Enabled, 0.0=Disabled).

Device 1–8 Rank

Establishes the order in which device outputs are activated. Use an analog
object attribute (reference block) or a Constant block.

Table 251: Sequencer Block Example
Binary Attribute Value

Command/State

True or False

1.0

Active

True

0.0

Inactive

False

See Editing SEQ (Sequencer) Blocks for information on editing Sequencer blocks.
Psychrometric Category
Psychrometric logic blocks have 2 inputs, and you can add multiple connections to the output of the
block.
Table 252: Psychrometric Blocks
Symbols

Description

Upper Input

Lower Input

EN-DP (EnDp)

Enthalpy - Dew Point

DB

DP

EN-RH (EnRh)

Enthalpy - Relative Humidity

DB

RH

RH-DP (RhDp)

Relative Humidity - Dew
Point

DB

DP

RH-WB (RhWb)

Relative Humidity - Wet Bulb

DB

WB

WB-DP (WbDp)

Wet Bulb - Dew Point

DB

DP

WB-RH (WbRh)

Wet Bulb - Relative Humidity

DB

RH

ABH

Absolute Humidity

DB

RH

DP

Dew Point

DB

RH

See Editing Blocks in Edit Mode for information on editing Psychrometric blocks.
Attributes Category
Attribute blocks let you expose values in your logic and configure inputs and outputs. Control
systems can contain a maximum of 24 inputs and 24 outputs.
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Input and Output Attributes
In View Mode, a double-click on an Attribute Input or Output block has no effect. In the Edit Mode,
when you drag and drop an attribute block from the palette, configuration wizards launch to help
you configure the attribute.
Attributes support a maximum of 24 input or 24 output blocks of Numeric, Enum, or Bool.
Attributes expose values at different stages of the Metasys system for a user to see at a glance or
connect to/from.
See Editing Blocks in Edit Mode for information on editing Attribute blocks.
Note: Once an attribute is configured as Numeric, Enum, or Boolean, it cannot be changed.
Attribute Reference
After inserting an attribute reference (Input Ref or Output Ref), you can edit which object/attribute
is being referenced. See Editing Blocks in Edit Mode. If you double-click in View mode, a Command
dialog box appears for Input refs only.
Constant Category
Constant logic blocks can have multiple connections to the output of the block. Constant logic
blocks can be any one of the following:
Table 253: Constant Blocks
Block

Statistical Type

Enum

Enumeration

Float

Float

Rel.

Release
Note: Sends the Release command at a specific priority based on the connection.

See Editing Blocks in Edit Mode for information on editing Constant blocks.
Calculation Category
RL (Rate Limiter)
The Rate Limiter block controls the rate at which its Output changes with variations in its Input
value. If rate limiting is disabled, this block passes the value of the Input to the Output. If rate
limiting is enabled, this block limits changes to its Output to an increment determined by the Step
Equation, executed according to the rate limit. This table describes the components of the Rate
Limiter block:
Table 254: RL (Rate Limiter Blocks)
Symbol

Description

IN

Input

EN

Enabled
Enables rate limiting. Use a binary object attribute reference for EN:
0 = Disabled (Inactive command)
1 = Enabled (Active command)

Rate Limiter blocks use the Step Equation to determine the maximum increment (step) the Output
can change to match the Input if the two differ. The Step Equation recalculates the step every time
system logic executes (every 5 seconds).
The Step Equation looks like this:
Step = Rate Limit/60,000 * Actual Period
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Where:
Rate Limit:

Rate per minute to increase or decrease the Output until it matches the Input

Actual Period:

Time in milliseconds since the last execution of the block. The system logic and
Step Equation execute every 5 seconds (5,000 milliseconds).

For example, if the Rate Limiter block is set up like this:
Rate Limit = 10
Actual Period = 5,000 (milliseconds)
The Step Equation looks like this:
Step = 10/60,000 * 5,000
Step = 0.8
So, the maximum increment the Output can change on its way to match the Input is 0.8.
See Editing Blocks in Edit Mode for information on editing Rate Limiter blocks.
Span
The Span block applies a range and extrapolated values to an input to produce an output. This table
describes the Span block components:
Table 255: Span Blocks
Symbol

Description

IN

Input

IL

Input Low

OL

Output Low

IH

Input High

OH

Output High

The Span block creates a linear relationship between the low input/output and high input/output
pair. If the Input for the Span block falls between the low and high input, the Output of the Span
block is found on the line between the low and high pairs.
The following example shows a graphical picture of how the Span block works:
Figure 41: Span Block Example 1
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The line connecting the low and high pairs (blue line) represents the linear relationship between
them. When you enter an Input for the Span block, the logic finds where the line crosses that input
and provides the corresponding output. (The output must lie on the thick blue line.) Using the
figure above, if you enter 5 for the Span block Input, the block would find 5 on the Input axis and
provide an output of 5.5 because that is where the line crosses an Input value of 5. (The green line
shows this relationship.)
If the Span block is set up to Clamp (see Editing Span Blocks) the value of the Output, the Output
of the block is restricted to the range between (and including) the low and high Output you enter
for the block. Range clamping is the default setting. For example, assume you are using the values
in the figure below and have clamping set to True. If you enter an Input of 5, you still generate
an Output of 5.5, because the original line crosses an Input of 5 at 5.5, which is between 4 and 8
(low and high output). If you enter an Input of 12, you generate an Output of 8, because where the
original line crosses an Input of 12 is higher than the high output (see where thin blue and thin
green lines intersect). If clamping is True for both high and low, the output must lie on the newly
drawn thick blue line.
Figure 42: Span Block Example 2

The Span block works for the reverse span as well (if the Output High is lower than the Output
Low). See Editing Blocks in Edit Mode for information on editing Span blocks.
Timing Category
Delay blocks have one input and one output and are commonly used to break up feedback loops.
The Timing category also includes the TMR (Timer) and Time blocks.
See Editing Blocks in Edit Mode for information on editing Timing blocks.
TMR (Timer)
This table describes the components of the TMR blocks:
Table 256: TMR (Timer) Blocks
Output

Description

IN

Input

RS

Reset. Cancels the timer. Reset does not apply to Minimum On or Minimum
Off timers. Use a binary object attribute for Reset (1.0=Reset Active, 0.0=Reset
Inactive).
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The LCT contains five different types of timers. Each type uses a Duration (how long the timer is
active) and unique functions to generate an Output. The different types of timers are listed below.
Click the name of the timer for a description and figure of timer operation.
•

Pulse Timer Function

•

On Delay Timer Function

•

Off Delay Timer Function

•

Minimum On Timer Function

• Minimum Off Timer Function
For information on setting Duration and the type of Timer, see Editing Timing Blocks.
Pulse Timer Function
The following table and figures illustrate the function of the Pulse timer.
Table 257: Pulse Timer Function
Feature

Description

Activation

Goes active if the Input goes from low to high in two consecutive executions
(logic executes every 5 seconds. The Pulse timer remains active for the
amount of time specified in Duration, then goes to inactive. High to low
transitions do not activate this timer.

Output

Stays high as long as the timer is active. After the Duration expires, the Output
goes low at the next logic execution.

Reset

Cancels timer activity and makes the output low. If the Reset goes from high
to low, the timer re-evaluates the Input at the next low to high transition.

Example

Captures a short pulse on a binary input and keeps the Output True long
enough so that the logic can react to it.

Figure 43: Pulse Timer Example 1
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Figure 44: Pulse Timer Example 2

On Delay Timer Function
The following table and figures illustrate the function of the On Delay timer.
Table 258: On Delay Timer Function
Feature

Description

Activation

Goes inactive in a low to high Input transition, depending on the state of
the input during the duration period. If the Input returns to a low state
(inactive), the timing cycle is canceled and the Output remains inactive. If the
Input remains in a high state, the Output goes to the high state at the next
execution of logic.
In a high to low Input transition, the Output becomes inactive the next time
the logic executes (logic executes every 5 seconds).

Output

See row above.

Reset

Cancels timer activity and makes the output inactive. If the Reset goes from
active to inactive, the timer re-evaluates the Input at the next low to high
transition.

Example

Delays the supply fan start 20 seconds after the return fan starts.
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Figure 45: On Delay Timer Example 1

Figure 46: On Delay Timer Example 2

Off Delay Timer Function
The following table and figures illustrate the function of the Off Delay timer.
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Table 259: Off Delay Timer Function
Feature

Description

Activation

In a low to high Input transition, the Output becomes active the next time the
logic executes (logic executes every 5 seconds).
Goes inactive in a high to low Input transition, depending on the state of
the input during the duration period. If the Input returns to a high state
(active), the timing cycle is canceled and the Output remains active. If the
Input remains in a low state, the Output goes to the low state at the next
execution of logic.

Output

See row above.

Reset

Cancels timer activity and makes the output inactive. If the Reset goes from
active to inactive, the timer re-evaluates the Input at the next low to high
transition.

Example

Keeps the fan running to purge the coils after a heating or cooling system is
turned off. Off Delay is useful when your building contains electrical heat and/
or DX cooling.

Figure 47: Off Delay Mode Example 1
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Figure 48: Off Delay Mode Example 2

Minimum On Timer Function
The following table and figures illustrate the function of the Minimum On timer.
Table 260: Minimum On Timer Function
Feature

Description

Activation

See row below.

Output

Goes active when there is a low to high Input transition when the timer
executes (logic executes every 5 seconds). The Output remains active until the
time specified in Duration passes AND the Input returns to inactive.

Reset

Has no effect on Minimum On timer.

Example

Keeps a chiller running for a minimum time after startup to stabilize
equipment.
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Figure 49: Minimum On Timer Example 1

Figure 50: Minimum On Timer Example 2

Minimum Off Timer Function
The following table and figures illustrate the function of the Minimum Off timer.
Table 261: Minimum Off Timer Function
Feature

Description

Activation

See row below.

Output

Goes inactive when there is a high to low Input transition when the timer
executes (logic executes every 5 seconds). The Output remains inactive until
the time specified in Duration passes AND the Input returns to active.
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Table 261: Minimum Off Timer Function
Feature

Description

Reset

Has no effect on Minimum Off timer.

Example

Keeps a chiller off from a minimum time after shutdown to equalize
refrigerant.

Figure 51: Minimum Off Timer Example 1

Figure 52: Minimum Off Timer Example 2
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Time
A Time block has no configurable input because it extracts time and date information from the
network. Network time/date is set at the Site Director. The outputs of a Time block are six time/date
values:
Table 262: Time Blocks
Output

Description

Format

HH

Hour

0–23 (24-hour time)

MM

Minute

0–59

YR

Year

four-digit year

MO

Month

1–12

DA

Day

1–31

DOW

Day of the Week

1=Monday
2=Tuesday
3=Wednesday
4=Thursday
5=Friday
6=Saturday
7=Sunday

Connections
Connection lines connect blocks in the logic. The LCT does not do a datatype check; that is, you
can connect Boolean and Constant values, and any other combination. But, the tool does not allow
inputs to connect to inputs, or outputs to outputs. The tool determines the connection line routing,
and the only way to change the routing is to move the blocks or use the hide feature.

Control Systems
Control systems are collections of subsystems, Logic Blocks, or combinations of both that may be
connected together.
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General Logic Connector Tool Rules
Table 263: General LCT Rules
What Are You
Doing?

What Components Are
You Using?

Moving, Sizing,
Typing

All blocks

Connecting

Connecting

System blocks

Math, Bool, Statistical,
Selector, Control,
Psychrometric, Calculation

These Rules Apply:
•

Left-click to drag and drop blocks

•

Block size is fixed

•

Font size and type are fixed

Attribute Properties:
•

Read Only

•

Writable

•

Prioritized Write

Connection Type
Allowed:
•

Output

•

Input or Output

•

Input, Output, or
Both

All inputs should be connected for these Logic
blocks. If you attempt to save logic that is
missing inputs, an error message displays.
You may save anyway or supply inputs where
necessary. We do not recommend saving with
missing inputs. In the Edit view, blocks with
missing inputs have red input points. When
the inputs are connected, the connection point
turns blue.

Logic Checker
The Logic Checker is not the same logic check run with a LCT save. It must be selected from the
Toolbar. The Logic Checker scans the control system logic and reports any configuration issues it
finds.
Table 264: Logic Checker
Condition

Message Text

Message Text Position

An output is not connected.

Missing Output Connection

Top-center of the block

An input is not connected.

Missing Input Connection

Top-center of the block

A feedback loop exists in the
logic.

Feedback Loop Is Present

Top-center of a connection in
the loop

An attribute is not connected.

Attribute Is Not Connected

Top-center of the attribute

Duplicate attribute name is
defined.

Duplicate Attribute Name

Top-center of the attribute

Errors in View Mode
While in View Mode, the tool displays the status of System Blocks, references (Attribute Reference),
and Math Category. If any connection is unreliable, the tool inserts a red circle at the center of the
connection. If you place your cursor over the circle, the error condition appears as transparent text
over the block. For example, the error could be a write or offline error.
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Printing
The Logic Connector Tool supports printing of the following paper sizes in either landscape or
portrait orientation:
•

Letter (8.5 x 11 in)

•

Folio (8.5 x 13 in)

•

Legal (8.5 x 14 in)

•

Tabloid (11 x 17 in)

•

A1

•

A2

•

A3

•

A4

• A5
The Logic Connector Tool supports printing of just the existing control system.

Mouse Shortcuts
Use mouse shortcuts to speed up LCT use.
Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the LCT.
Table 265: Edit Mode Mouse Shortcuts
Component

Single LeftClick

Double Left-Click

Right-Click

System Block

Select

Lets you edit the block (Editing
System Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Math Block

Select

Lets you edit the block (Editing
Math Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Bool Block

Select

Lets you edit the block (Editing
Bool Blocks) (except for LTCH
blocks).

Cut, Copy, Paste, Duplicate,
Delete

Statistical
Block

Select

Lets you edit the block (Editing
Statistical Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Selector Block Select

Lets you edit the block (Editing
Selector Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Control Block

Select

Lets you edit the block (Editing
Control Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Psychrometric Select
Block

Lets you edit the block (Editing
Psychrometric Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Attribute
Block

Select

Lets you edit the block (Editing
Attribute Blocks: Input and
Output).

Cut, Copy, Paste, Duplicate,
Delete

Attribute
Reference
Block

Select

Lets you edit the block (Editing
Attribute Reference Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Constant
Block

Select

Lets you edit the block (Editing
Constant Blocks).

Cut, Copy, Paste, Duplicate,
Delete, Label
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Table 265: Edit Mode Mouse Shortcuts
Component

Single LeftClick

Double Left-Click

Right-Click

Calculation
Block

Select

Lets you edit the block (Editing
Calculation Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Timing Block

Select

Lets you edit the block (Editing
Timing Blocks) (except for Time
blocks).

Cut, Copy, Paste, Duplicate,
Delete

Connection:
Prioritized

Select

Calls up a box to set connection
priority.

Hide, Delete

Connection:
NonPrioritized

Select

Has no action.

Hide, Delete

Text Block

Select

Opens the box for editing.

Cut, Copy, Paste, Duplicate,
Delete, Properties

Workspace

Select (drag
to lasso
items)

Releases a connection if one is in
progress.

Cut, Copy, Paste, Duplicate,
Delete, Connect, Zoom (with
subcategories)

Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the LCT.
Table 266: View Mode Mouse Shortcuts
Component

Single Left-Click

Double Left-Click

Right-Click

System Block

Select

-

-

Math Block

Select

-

-

Bool Block

Select

-

-

Statistical Block

Select

-

-

Selector Block

Select

-

-

Control Block

Select

-

-

Psychrometric Block

Select

-

-

Attribute Block

Select

-

-

Attribute Reference Block

Select

-

-

Constant Block

Select

-

-

Timing Block

Select

-

-

Calculation Block

Select

-

-

Connection

Select

-

-

Text Block

-

-

-

Logic Connector Tool Steps
Generating a Logic System (Overview)
About this task:
To generate a complete logic system:
1.

On the Insert Menu, select Control System. The Insert System wizard appears.
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2.

Follow the instructions. The Program (Control System) Object appears in the Navigation Tree.

3.
4.
5.

Drag the program/control system to the workspace. The LCT opens in View Mode.
Change to Edit mode (Changing LCT Modes) to add or edit items in the workspace.
Add symbol blocks (Adding Items to Logic) and add text blocks (Adding Text Blocks) to the
workspace.
Connect the blocks (Connecting Blocks).
Edit blocks (Editing Blocks in Edit Mode).
Save the program/control system (Saving a Control System).
Download the program/control system to the online controller, if you created or edited the
logic in offline mode (using the SCT).

6.
7.
8.
9.

Result
Note:
•

You must create a unique name for each program/control system created under the same
folder. You can create programs/control systems with the same names as long as they are
stored in different folders.

•

When defining logic with scientific notation where the number of digits to the left of the
decimal point is large, the system extends the range of values displayed without scientific
notation to include all values with an absolute value less than 10 million and greater than
or equal to one millionth (0.000001 <= |value| < 10,000,000.0).

Changing LCT Modes
To change from View Mode to Edit Mode, click the Edit mode button on the Toolbar.
To change from Edit Mode to View Mode, click the Cancel or Save button on the Toolbar.

Viewing Existing Logic
1.
2.

Browse to either an archive database or an online controller.
Drag and drop the desired Program (Control System) Object from the tree structure to the
workspace. The Logic Connector Tool opens in View Mode.

Adding Items to Logic
Drag and Drop
About this task:
To add items to a control system using the drag and drop method:
1.

In the Edit Mode of the LCT, left-click and drag an item from the left side of the tool view and
drop it in the workspace.
Notes:
- If the item is a System block, a configuration wizard appears. Answer the questions to
set up the new object/system or create a reference to an object or control system.
- There is not interaction between the user navigation tree and logic.

2.

Edit the block to match your needs. See Editing Blocks in Edit Mode.

Copy and Paste
About this task:
Note: You can copy and paste existing objects into the workspace from the workspace only.
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To add items to a control system using the copy and paste method:
1.
2.

Right-click an existing object and select Copy.
Right-click in the workspace and Paste the object.
Note: The copy and paste method supports copying and pasting of multiple blocks. To
copy and paste more than one block, hold down the Shift key while selecting blocks with
the cursor or use the select tool to lasso the blocks.

Connecting Blocks
1.

Make sure the Logic Connector Tool is running in Edit Mode.

2.

Place the cursor over the starting connection point until it changes shape from an arrow to a
magic wand and click the point.
Click the ending connection point.
Notes:

3.

- If the connection is valid, the cursor is a magic wand. If the connection is not valid, a
circle with an X through it appears, and the tool does not connect the points.
- After you successfully connect two points, the line between them turns blue until you
click somewhere else in the workspace.
- You do not need to click the exact connection point. If you click in the block, the tool
automatically creates a connection to/from the nearest block’s connection point. To
cancel the connection after clicking the first block, click anywhere in the workspace.
4.

The Priority Connection dialog box appears. Choose a priority from 1–16 (1 is the highest
priority).
Note: To change the priority at a later time, you must delete the connection and reinsert
it.

Re-Routing a Connection
1. Make sure the LCT is running in Edit Mode.
2. Place the cursor over an existing end connection point until the cursor changes into a cursor
with lines protruding from the tip.
Note: You may only move the destination point. To completely change the connection,
see Deleting Connections.
3.
4.

Click the connection point. The tool removes the connection.
Click a new connection point. The tool creates the newly routed connection.

Hiding Output Connections
1. Make sure the LCT is running in Edit Mode.
2.
3.
4.

Place the cursor over the output connection point and right-click and a menu appears.
Select Hide from the menu. The tool removes all connections from the output and replaces
the lines with numbered symbolic representations of the connections.
To see the connections again, right-click the starting connection point and select Unhide.
Note:
Double-click the hidden connection to label it. If multiple connections are from the
same hidden input, it is shown as Label: number where number is the number of
connections.
Do not start labels with a number and then follow it with any of these characters: $ . - ,
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Deleting Connections
1.
2.
3.

Make sure the LCT is running in Edit Mode.
Select the connection and right-click.
Select Delete from the menu.

Result
OR
1.

Select the connection.

2.

Press the Delete key on the keyboard.

Editing Blocks in Edit Mode
About this task:
To edit blocks in Edit mode:
1.
2.

Enter Edit Mode (Changing LCT Modes).
See one of the following sections for information on the block you are editing.

Editing System Blocks
About this task:
To edit System Blocks in Edit mode:
1.
2.

Double-click a System block. The Expose Attributes dialog box appears.
Configure the inputs, outputs, and attributes of the subsystem.
Note:
- Select the Add button to add an attribute to configure. To remove attributes from
the System, select the check box next to one or more attributes and click the
Remove button.
- To view the control system for the System block, drag and drop the control system
from the Navigation Tree to the Panel Layout.
- If you click Cancel to disregard your changes to the System block the changes are
not saved, as expected. However, if you once again edit the same System block,
and an error prompt appears stating An error occurred. Object does not
exist, simply try these steps again. The error does not reoccur with the second
attempt.

Editing Math Blocks
About this task:
To edit Math blocks in Edit mode:
1.
2.

Double-click a Math block. The configuration dialog box appears.
Edit the fields and configure the number of inputs based on the selected type of logic.
Table 267: Math Block Configuration
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Field

Description

Input

The number of inputs depends on the type of Math block you use.
You cannot reduce the input count lower than the number of current
connections.

OK

Accepts changes.

Cancel

Cancels changes.
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Editing Bool Blocks
About this task:
Note: LTCH (Latch) blocks are not editable.
To edit Bool blocks in Edit mode:
1.
2.

Double-click a Bool block. The configuration dialog box appears.
Edit the fields and configure the number of inputs based on the selected type of Boolean
logic.
Table 268: Bool Block Configuration
Field

Description

Input

The number of inputs depends on the type of Bool block you use.
You cannot reduce the input count lower than the number of current
connections.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Statistical Blocks
About this task:
To edit Statistical blocks in Edit mode:
1.
2.

Double-click a Statistical block. The configuration dialog box appears.
Edit the fields and configure the type of statistical block and number of inputs.
Table 269: Statistical Block Configuration
Field

Description

Type

Allows you to switch between the statistical types.

Input

You cannot reduce the input count lower than the number of current
connections.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Selector Blocks
About this task:
To edit Selector blocks in Edit mode:
1.
2.

Double-click a Selector (Mux) block. The Selector Edit dialog box appears.
Edit the fields and configure the number of inputs, the enumeration set, and the mode for
each input.
Table 270: Selector Block Configuration
Field

Description

Input

The number of inputs determines the list of inputs.

Enum Category Filters the enumeration set list based on the chosen category.
Enum Set

When Enum Set changes, all modes are reset.
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Table 270: Selector Block Configuration
Field

Description

Input 1
Mode(s)

Click the button and a dialog box appears that allows you to select which
modes associate with each input. In the dialog box, select the check box
next to the desired mode(s). If a mode is already assigned to another input,
the mode appears dimmed. Select Default to select all modes for an input
that are not currently selected by any other input.

Input 2
Mode(s)

Click the button and a dialog box appears that allows you to select which
modes associate with each input. In the dialog box, select the check box
next to the desired mode(s). If a mode is already assigned to another input,
the mode appears dimmed. Select Default to select all modes for an input
that are not currently selected by any other input. There is one of these per
input (2–8).

OK

Accepts changes.

Cancel

Cancels changes.

Editing Control Blocks
About this task:
To edit Control blocks in Edit mode:
1.

Double-click a Control block. The configuration dialog box appears.
Note: See Editing SEQ (Sequencer) Blocks for Sequencer configuration information.

2.

Edit the fields to configure the type of comparison.
Table 271: Control Block Configuration
Field

Description

Type

The Type of comparison performed by the block. This field defaults to what
was dragged over, but may be changed.

OK

Accepts changes.

Cancel

Cancels changes.

Editing SEQ (Sequencer) Blocks
About this task:
To edit SEQ (Sequencer) blocks in Edit mode:
1.
2.

Double-click a Sequencer block. The Sequencer dialog box appears.
Edit the fields to configure the sequencer.
Table 272: SEQ (Sequencer) Block Configuration
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Field

Description

Outputs

Determines the number of binary outputs for the block.

Min On Time

Specifies the minimum time an output must be on before being
deactivated to an off condition. When an output is activated, a timer
starts. Until the timer reaches the minimum time, the output cannot be
deactivated. However, an Instant Shutdown or a Rotate Now command is
applied immediately, and overrides the Min On Time value.
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Table 272: SEQ (Sequencer) Block Configuration
Field

Description

Min Off Time

Specifies the minimum time an output must be off before being
reactivated to an on condition. When an output is deactivated, a timer
starts. Until the timer reaches the minimum time, the output cannot be
activated. However, an Instant Shutdown or a Rotate Now command is
applied immediately, and overrides the Min Off Time value.

Interstage On
Delay

Defines the minimum time that must elapse between the sequential
activation of Sequencer stages.

Interstage Off
Delay

Defines the minimum time that must elapse between sequential
deactivation of Sequencer stages.

Make/Break
Limits

The box next to Make/Break indicates if Proactive is selected and, when
you click, launches the Make/Break Dialog box.
In the Make/Break Dialog box:
•

Default check box: Disables all make/break limit text boxes and uses
the default values. The default values are set so that each device is on
for a proportional amount of time. If you do not select Default, you
must enter at least one set of values for a stage.

•

Proactive check box: Disables the Stage 1 make/break limit boxes
(because that stage is always on) and shifts all the make/break limits
down one stage.

•

Make Limit: Turns on the stage when the input value to the block
reaches this limit.

•

Break Limit: Turns off the stage when the input value to the block
decreases to this value.

Make/Break Limit Rules:
•

The current stage make limit must be less than the next stage make
limit.

•

The current stage break limit must be less than the current stage
make limit,
•

OR
the current stage make limit must be greater than the current
stage break limit.

•

The current stage break limit must be less than the next stage break
limit.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Psychrometric Blocks
About this task:
To edit Psychrometric blocks in Edit mode:
1.
2.

Double-click a Psychrometric block. The configuration dialog box appears.
Edit the fields and configure the elevation based on the selected logic type.
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Note: If you double-click an ABH or DP block, the Unit Type field does not appear.
Table 273: Psychrometric Block Configuration
Field

Description

Elevation

Allows you to configure the current elevation of the site (in feet or meters).

Unit Type

Allows you to choose International System of Units (SI) or Imperial (IP)
units.
Units for Unit Type SI are kilograms of water per kilogram of dry air.
Units for Unit Type IP are pounds per cubic foot.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Attribute Blocks: Input and Output
About this task:
To edit Attribute blocks in Edit mode:
1.
2.

Double-click an attribute block.
Edit the fields and configure the input/output (see Editing Attribute Inputs and Editing
Attribute Outputs).

Editing Attribute Inputs
Table 274: Attribute Input
Field

Description

Name

Name of the input

Units

The units for the output.
This field only appears for floating inputs.

Display
Precision

Tells the Metasys software what precision to use when formatting data.
This field only appears for floating inputs.
Note: Display Precision is used in the Focus view of data, not the graphical view.

Enum Category Set category determined by the user interface (either Two State or Multi State).
This field only appears for Enum inputs.
Enum Set

Set determined by the category selected in Enum Category.
This field only appears for Enum inputs.

Trigger

This is checked if you want the attribute to trigger the control system to execute
if its value changes by more than the defined increment.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Attribute Outputs
Table 275: Attribute Output
Field

Description

Name

Name of the output

Units

The units for the output

Display
Precision

Tells the Metasys software what precision to use when formatting data.
This field only appears for floating outputs.
Note: Display Precision is used in the Focus view of data, not the graphical view.
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Table 275: Attribute Output
Field

Description

Enum Category Set category determined by the user interface (either Two State or Multi State).
This field only appears for Enum outputs.
Enum Set

Set determined by the category selected in Enum Category.
This field only appears for Enum outputs.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Attribute Reference Blocks
About this task:
To edit Attribute Reference blocks in Edit mode:
1.
2.

Double-click an Attribute Reference block. The Attribute Reference Edit dialog box appears.
Edit the fields and configure the object or attribute to which the block refers (Editing Attribute
Reference Inputs or Editing Attribute Reference Outputs).

Editing Attribute Reference Inputs
Table 276: Attribute Reference Input
Field

Description

Label

Enter a label here for the block.
Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

Object

Browses to the object to which the reference is linked. Leaving this field blank
leaves a placeholder for a future reference. The dragged object's name appears
in this field and the object's attributes appear in the drop-down list in the
attribute field.

Attribute

The attribute to which the reference is linked. When you are configuring for an
Input reference, the drop-down list contains numeric attributes only.

Units

Units for the attribute

Trigger

This is checked if you want the attribute to trigger the control system to execute
immediately instead of waiting for the next control system scan if the value
changes by more than the defined increment. Otherwise, the control system
executes normally.

Increment

Sets the increment.

OK

Accepts changes.

Cancel

Cancels changes.
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Editing Attribute Reference Outputs
Table 277: Attribute Reference Output
Field

Description

Label

Enter a label here for the block.
Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

Object

Browses to the object to which the reference is linked. Leaving this field blank
leaves a placeholder for a future reference. The dragged object’s name appears
in this field and the object’s attributes appear in the drop-down list in the
attribute field.

Attribute

The attribute to which the reference is linked. When you are configuring an
Output reference, the drop-down list contains numeric, writable attributes only.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Constant Blocks
About this task:
To edit Constant Category blocks in Edit mode:
1.

Double-click a Constant block. One of two dialog boxes appears depending on the type of
constant you select.
Note: There are no configurable parameters for the Rel. (Release) constant. When you
double-click, nothing happens.

2.

Edit fields and configure the constant value (Editing Constant Enum, Editing Constant Float).

Editing Constant Enum
Table 278: Constant Enum
Callout

Description

Enum Category

Set category determined by the user interface (either Two State or Multi State).

Enum Set

Set determined by the category selected in Enum Category.

Enum

Set state determined by the set and set category.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Constant Float
Table 279: Constant Float
Callout

Description

Value

The value of the float.

Units

The units used by the float.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Calculation Blocks
Editing RL (Rate Limiter) Blocks
About this task:
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To edit RL (Rate Limiter) blocks in Edit mode:
1.
2.

Double-click a Rate Limiter block. The RL dialog box appears.
Edit the Rate Limit and Startup Value for the RL block.
Table 280: RL (Rate Limiter) Block Configuration
Field

Description

Rate Limit

Specifies the rate per minute to increase/decrease the Output until it
matches the Input.

Startup Value

Specifies the value the rate limiter block will start at when the engine is
restarted and block enable is true.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Span Blocks
About this task:
To edit Span blocks in Edit mode:
1.

Double-click a Span block. The Span dialog box appears.

2.

Edit the fields to enable or disable clamping.
Table 281: Span Block Configuration
Field

Description

Clamp High

Selects whether (True) or not (False) to clamp the Output at the Output
High (OH). For more information on clamping, see Span.

Clamp Low

Selects whether (True) or not (False) to clamp the Output at the Output
Low (OL). For more information on clamping, see Span.

OK

Accepts changes.

Cancel

Cancels changes.

Editing Timing Blocks
Note: Time (logic) blocks are not editable.
Editing Delay Blocks
About this task:
To edit Timing Category blocks in Edit mode:
1.
2.

Double-click a Delay block. The Delay dialog box appears.
Edit the field to configure the delay.
Table 282: Delay Block Configuration
Field

Description

Startup Value

Displays the initial value of the Delay block.

OK

Accepts changes.

Cancel

Cancels changes.

Editing TMR (Timer) Blocks
About this task:
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To edit TMR (Timer) blocks in Edit mode:
1.
2.

Double-click a Timer block. The TMR dialog box appears.
Edit the timing functions of the block.
Table 283: TMR (Timer) Block Configuration
Field

Description

Duration

Specifies the length of the timer function in seconds. The range is 5–86,400
seconds.

Setup

Determines the type of timer you use:
•

Pulse

•

On Delay

•

Off Delay

•

Minimum On

•

Minimum Off

OK

Accepts changes.

Cancel

Cancels changes.

Adding Text Blocks
1.
2.
3.
4.
5.

Click the Text icon on the Toolbar.
Click the workspace to select a location for the text. The text block appears.
Select the Select icon on the toolbar.
Double-click the text block to display the text editor. Edit the text and click OK.
Select the text block and drag the sides to resize the block.
Notes:
- To edit the text, double-click the block. The block opens for editing.
- To change the text properties, right-click the text block and select Properties from the
menu. You can change the font (type, size, bold, italic, bold italic), text color, background
color, and border visibility/color.
- Colon (:) and quote (“) characters cannot be entered by the user in this field.

Running the Logic Checker
About this task:
To run the Logic Checker:
1.
2.
3.

Select the Logic Checker icon from the Toolbar.
If the Logic Checker does not detect errors, a No Warnings Found dialog box appears. Click
OK to return to the logic.
If the Logic Checker detects errors, a Configuration Warnings Were Found dialog box
appears. After you click OK, the tool returns you to the logic with Information symbols over
the warning elements.
Note: The Information symbols remain unless you ignore them and save the logic or fix
the errors and run the Logic Checker successfully.

Saving a Control System
To save a control system, click Save on the Toolbar. The LCT scans for logic errors.
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Notes:
•

The logic check done with the Save command is not the same as the Logic Checker run from
the toolbar.

•

If inputs are missing, an error message appears asking if you want to continue with the save.
Click No to return to the logic. Click Yes to save anyway. We do not recommend saving with
errors.

Printing a Control System
To print a control system, click the print icon on the Toolbar.
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Object
The Insert Object wizard inserts one of the following object types.

Auto Shutdown Object
Menu Selection: Insert > Object > Auto Shutdown
Note: On the Configure screen, click the [...] button to select an object from the Select Item
dialog box. Then select the desired Control attribute from the drop-down menu.
When a selected multistate control point is in a specified shutdown state, the Auto Shutdown
object suppresses alarm reporting from a list of dependent objects to prevent nuisance alarms.
The Auto Shutdown object accomplishes this by sending an enable/disable command to each
of the dependent object's Alarm objects, based on the control point’s current state (the value of
the Control attribute) and the defined shutdown state. For BACnet intrinsic alarming and Event
Enrollment objects, these commands set and reset the BACnet Alarm Event Enable property flags
(To Off Normal, To Fault, and To Normal) that cause or prevent alarms. A startup delay is provided
so that points are not released immediately from shutdown.
An example of a use for the Auto Shutdown object is to prevent alarms set to monitor the discharge
air temperature of a fan when that fan is turned off. When the fan is turned off, the fan state value
is sent to the Auto Shutdown object. The Auto Shutdown object then evaluates the current state
of the point against the Shutdown State defined in the Auto Shutdown object. If the current point
state matches the Shutdown State, the Auto Shutdown object sends a Disable command to the
Alarm object of every referenced dependent object in the Dependents list.
Consequently, when the fan is turned back on, the Auto Shutdown object again evaluates the
current state and, if the current state does not match the Shutdown State, starts the Startup Delay
timer. Once the timer expires, the Auto Shutdown object sends an Enable command to the Alarm
object of every referenced dependent object in the Dependents list.
Note: Changing the Dependents or Shutdown State attribute causes an immediate
reevaluation of the current state. However, changes to the Startup Delay time do not take
effect until the next change in the control point state.

Auto Shutdown Attributes
This object contains attributes common to many Metasys system objects. These additional common
object attributes are described in the Common Object Attributes section.
Note: In the Notes column, letters indicate the following: C - Configurable, R - Affected by
Extension’s Reliability, and W - Writable.
Table 284: Auto Shutdown Attributes - Focus/Configuration Tab
Attribute Name
Control

Notes
C

Dependents

C,W

Enabled

Initial Value

True

Execution Priority

C,W

Normal

Present Value

R

Off

Values/Options/Range Description
Determines, in conjunction with the Shutdown
State, if an alarm shutdown should occur. This is
the current state of the references control point.
Number of Entries = 1–32 Uses each dependent object identified in this list
of object references to locate the Alarm object
that is to have its alarm reporting controlled by
the control point.
Indicates whether the Auto Shutdown object is
enabled (True) or disabled (False).
Indicates the relative importance of performing
the function of the object within the device.
On = 1
Off = 0
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Table 284: Auto Shutdown Attributes - Focus/Configuration Tab
Attribute Name
Reliability

Notes

Shutdown State

C,W

Startup Delay

C,W

Initial Value
Input
Unreliable

5

States Text

Values/Options/Range Description
Various
Reflects the reliability of the control point. When
the control point is not reliable, the Reliability
attribute becomes Input Unreliable.
Uses the value set of the Determines the definition of the shutdown state.
control point once the
When the control point goes to the state defined
Auto Shutdown object
as the shutdown state, Auto Shutdown disables
reads the control point alarms from the point.
value.
Units = Minutes
Represents the time in minutes that must elapse
before alarm reporting is re-enabled, once the
control point changes from the Shutdown State to
any other state.
Indicates the displayed strings for the Present
Value.

Auto Shutdown Commands
The table below lists the commands supported by the Auto Shutdown Object.
Table 285: Auto Shutdown Commands
Command
Name

Parameters

Description

Disable

None

Disables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Enable

None

Enables all types of alarming: alarm extensions,
BACnet intrinsic alarming, and BACnet Event
Enrollment objects.

Data Broadcast Object
Menu Selection: Insert > Object > Data Broadcast
Note: On the Configure screen, click the [...] button to select the input reference object from
the Select Item dialog box. Then select the desired attribute to reference from the drop-down
menu.
The Data Broadcast object provides a means of sharing globally useful data with third-party BACnet
devices. The data value from an object/attribute to be shared is referenced by this object. Typically,
this data may be the outdoor air temperature, or a value indicating whether a building is occupied.
The Data Broadcast then broadcasts an Unconfirmed COV Notification message containing the
referenced data value when it changes.
On a site containing only Metasys devices, the Data Broadcast object is not useful, and should not
be created.
As the number of these objects on a site increases, the network performance may suffer due to
excessive broadcasts. Therefore, use Data Broadcast objects only when necessary.

Data Broadcast Concepts
Unconfirmed COV Notification
Unconfirmed COV Notification is a BACnet service that can be used to distribute object attributes of
wide interest to many devices simultaneously without a subscription.
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Data Broadcast Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 286: Data Broadcast Object Attributes - Focus/Configuration Tab
Attribute Name
COV Period

Notes
C,N,W

Initial Value
Null

Input Reference

C

Null

Message Transmits

0

Reliability

Input
Unreliable

Values/Options/Range Description
Units = seconds
Broadcasts an Unconfirmed COV on a periodic
basis. When set to a value from 30 to 86,400, this
Range = 30–86,400
object issues an Unconfirmed COV containing
the attribute value and status flags at least once
every period. This broadcast occurs even when
the value remains unchanged. If an actual change
of value occurs during the period and a COV is
sent, the timer for the periodic COV resets. To
disable the periodic broadcast feature, clear the
value from the COV Period and save the change.
The null entry represents not sending period
Specifies the object and attribute value that is
monitored for COVs. This object’s attribute value,
if reliable, is then broadcast in an Unconfirmed
COV Notification message.
Provides a count of the number of Unconfirmed
COV Notification messages that have been sent
by the Data Broadcast object. After reaching
4,294,967,295, the value rolls over to 0 and the
count continues.
Specifies the reliability of the Data Broadcast
object. The reliability changes to Input Unreliable
when errors with the Input Reference occur.

Data Broadcast Commands
The following table lists the commands supported by the Data Broadcast Object.
Table 287: Data Broadcast Commands
Command Name

Parameters

Description

Disable

None

Locks all outputs and prevents the object
from broadcasting any messages.

Enable

None

Specifies that the Data Broadcast object
broadcasts Unconfirmed COV Notification
messages when the Input Reference
changes.

Demand Limiting/Load Rolling (DLLR) Object
Menu Selection: Insert > Object > DLLR
The Demand Limiting feature helps you save money by limiting peak energy usage. The Load
Rolling feature helps save money by reducing overall energy consumption. The DL portion of DLLR
selectively turns off (sheds) equipment, such as fans and lights, or adjusts setpoints to limit energy
use during peak times. The LR portion acts continuously to maintain a specified energy reduction
by shedding unnecessary loads. A facility can implement either one or both of these strategies.
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The DLLR object represents the attributes, commands, and reports that define the DLLR
functionality. For information on the features and operation of DLLR, refer to the DLLR Technical
Bulletin (LIT-12011288).

DLLR Object Attributes
The DLLR object is divided into three tabs, the Focus/Configuration Tab, the Profile Tab, and the
Load Summary Tab. If you add extensions to this object, see Extensions for descriptions of the
extension tabs.

DLLR Object Features
DLLR Object Icon
Table 288: DLLR Object Icon
Icon

Key Words
Gears, Spinning gears

Focus/Configuration Tab
Object Attributes
Name
The Name attribute contains a freely definable user-friendly name for the object that is
independent of the Item Reference or the location of the object in the physical network. The Name
is used as the label in the All Items navigation tree. The Name is shown in alarm reports, the event
and audit viewers, and in summaries. The Name does not need to be unique to the site.
The Name defaults to the object identifier you used during manual object creation but can be
edited later.
Description
The Description attribute contains a user-defined description of the object.
Object Type
The Object Type attribute indicates the Object Type as displayed in the Metasys software and as
exposed to a BACnet network.
Example: DLLR (Demand Limiting Load Rolling).
AuthorizationCategory
The AuthorizationCategory classifies the object by the category of system or equipment that it
monitors to aid in the determination of user access privileges and alarm routing.
Examples: Energy, HVAC, Fire, Security
Status Attributes
Enabled
The Enabled attribute provides a mechanism to stop DLLR operation. When disabled, DLLR releases
all shed loads except those that are locked shed. Also, DLLR does not perform any calculations,
report alarms, or issue any commands to any loads when disabled. DLLR attributes can be changed,
but no actions are taken until DLLR is enabled.
When enabled, DLLR operation starts again. If Shed mode is active, the configured DLLR strategies
begin shedding loads as needed. If Monitor Only mode is configured, simulated load shedding
begins.
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Alarm State
Indicates the current Warning or Alarm state of an object. This attribute is set by an Alarm
Extension associated with the object.
DLLR Status
The DLLR Status attribute indicates the current DLLR status. The statuses include:
•

Normal - no errors or problems in the DLLR object

•

LR cannot meet target - the Load Rolling algorithm was unable to shed enough loads to meet
its target.

•

DL cannot meet target - the Demand Limiting algorithm was unable to shed enough loads to
meet its target.

•

Meter Off Normal - a meter is defined, but it is offline or its value is not reliable.

•

EOI Off Normal - an EOI attribute is defined, but it is offline or its value is not reliable. This also
indicates that the EOI Attribute is replaced with the fixed window algorithm.

•

Disabled - the DLLR object is not being used to shed (or simulate the shedding of) loads.

•

No meter defined for DL - a meter is not currently defined for DL; a requirement if the Shed
Strategy includes Demand Limiting.

Meter Status
The Meter Status attribute indicates the status of the meter, if the meter is defined. The meter
status includes:
•

Undefined

•

Normal

•

Off Normal

EOI Status
The EOI Status attribute indicates the status of the EOI object, if the EOI object is defined. The EOI
Status attribute uses the same status set as Meter Status.
Operational Data Attributes
Energy Rate
The Energy Rate attribute displays the current rate from the meter, if a meter is defined.
Interval Demand
The Interval Demand attribute displays the average energy demand over the current interval.
Amount Shed
The Amount Shed attribute indicates how much energy is currently shed. It is the default attribute
of the DLLR object and is displayed near the top of the DLLR object window.
Calculated Demand
When DLLR is in Monitor Only mode, the Calculated Demand attribute indicates the energy rate
when DLLR is in Shed mode (energy rate - amount shed). This attribute is blank when DLLR is in
Shed mode.
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Setup Attributes
Mode
The Mode attribute controls whether DLLR is actively shedding Loads (Shed mode) or is simulating
Load shedding (Monitor Only mode). The mode pertains to both the Demand Limiting and Load
Rolling strategies simultaneously. The Modes include:
•

Monitor Only - simulated shedding occurs, where loads appear shed but output points are not
actually commanded or turned off.

•

Shed - true shedding occurs where output points are commanded.

Shed Strategy
The Shed Strategy attribute allows you to specify which shedding strategy the DLLR uses. The Shed
Strategies include:
•

Demand Limiting and Load Rolling

•

Demand Limiting Only

•

Load Rolling Only (default)

Meter Object
The Meter Object identifies the Metasys object (for example, Pulse Meter, AI, AV) that is used for the
energy rate if the Demand Limiting strategy is configured. If only the Load Rolling strategy is used,
a meter is not required.
The Meter Object should be defined on the same supervisory controller as the DLLR Object. Do not
use an N1 Integration object for the meter unless you can guarantee that the NCM Service Time is
always less than 60 seconds because the DLLR algorithm requires an updated meter value every
minute.
DLLR Startup Behavior
The DLLR Startup Behavior attribute selects which mode the feature is set to whenever the
supervisory controller is restarted or its database is downloaded. Two selections are offered:
•

Startup in Monitor Only mode - DLLR starts in Monitor Only mode, even if it had been
commanded or configured to Shed mode before the restart or download. Also, if the DLLR
object was disabled while in Shed mode, it reverts to Monitor Only mode when enabled.

Startup in last commanded mode - DLLR starts in the mode that was active at the time the
controller was restarted or its database downloaded.
Regardless of the selection, the following also apply:
•

•

Any Comfort Override commands that were in place before the startup are persisted.

•

Any previous Shed commands are not automatically persisted to loads on startup. DLLR
evaluates the current situation and completes all calculations before issuing any new Shed
commands to loads.

•

When DLLR starts issuing Shed commands to loads, it resumes where it left off with the first
eligible, lowest-priority load.

Monitor Mode Release
The Monitor Mode Release attribute allows you to specify the load output release behavior when
DLLR is commanded to Monitor Only mode from Shed mode. If set to Release immediately, the
outputs of loads that are not locked are immediately released regardless of whether their Minimum
Shed Time has expired. If set to Release After Min Shed Time, the outputs of loads that are not
locked are released only after their Minimum Shed Time expires. Possible behaviors include:
•

Release Immediately

•

Release After Min Shed Time
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Profile Tracking Period
The Profile Tracking Period attribute determines the time period for the Current Profile and
Previous Profile attributes in the Profile tab. This is customarily set to the utility’s billing period. If
you change the Profile Tracking Period, the Current Profile is copied to the Previous Profile, and a
new Current Profile is started. When Manual is selected, the Current Profile and Previous Profile are
only changed when the user commands the DLLR object to Reset Profile. Possible settings include:
•

Manual

•

Hourly

•

Daily

•

Weekly

• Monthly
Table 289 describes when the start and end times are set based on the tracking period.
Table 289: Profile Tracking Periods
Profile Tracking Start Time
Period

End Time

Hourly

At the top of the current hour
Example: 08:00:00 A.M.

60 minutes from the current hour
Example: 09:00:00 A.M.

Daily

12:00:00 A.M. current day

12:00:00 A.M. next day

Weekly

12:00:00 A.M. Monday of current
week

12:00:00 A.M. Monday of next week

Monthly

12:00:00 A.M. first day of current
month

12:00:00 A.M. first day next month

Manual

The moment when the Reset Profile
command is issued.

Always Not Specified

There are three exceptions to when the Start Times and End Times can vary from what is shown in
Table 289. The Start Times and End Times differ when:
•

a Reset Profile command is issued to the DLLR object while in Shed or Monitor Only mode

•

a Reset Initialization Parameters command is issued to the DLLR object while in Monitor Only
mode

•

the controller is downloaded or reset
Note: The Start Times and End Times are not reset when DLLR changes from Monitor Only
mode to Shed mode. Also, when the DLLR object is disabled, the current profile is copied
to the previous profile, the current profile values are all set to 0, and the times are all set to
undefined.

Stop DLLR Audits in Monitor Only Mode
The Stop DLLR Audits in Monitor Only Mode attribute specifies whether an audit entry is created
each time a load is shed or released when DLLR is in Monitor Only mode and the NAE’s Enabled
Audit Level is set to 3 or 4. (When DLLR is in Active mode, an audit entry is always created to record
that event.) The default is False, but if you set it to True, no audit entries are created in Monitor Only
mode.
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Demand Limiting Attributes
Active Demand Limit
The Active Demand Limit attribute always displays the actual demand target being used by
the demand limiting strategy. If a ramp down is in progress, it displays the ramp down value;
otherwise, it displays the Current Demand limit.
DL Tariff Targets
The DL Tariff Targets attribute is the list of energy targets for the Demand Limiting strategy. Each
target consists of a target value and an entry from the Target Description set identifying the type of
target, such as On-Peak. If the Demand Limiting strategy is used, there must be at least one target
defined. Only one target is active at any time. The Active DL Target attribute specifies which target
is currently active. The Target Description set includes:
•

Continuous

•

Off-Peak

•

On-Peak

•

Semi-Peak

•

Shoulder

•

Summer Off-Peak

•

Summer On-Peak

•

Winter Off-Peak

•

Winter On-Peak

•

Summer Semi-Peak

•

Winter Semi-Peak

•

Summer Shoulder

•

Winter Shoulder

Active DL Target
The Active DL Target specifies which of the defined Demand Limiting targets is currently active.
When this attribute changes, the Active DL Target Changed attribute indicates True until the start of
the next interval. This attribute uses the Target Description enumeration set.
Current Demand Limit
The Current Demand Limit attribute represents the demand limiting target that is set by the
user (DL Tariff Targets indexed by Active DL Target). This attribute defines the maximum allowed
average demand during the current elapsing interval, and allows you to change the value of the
demand limiting target. To change the value of the demand limiting target, write a new value to this
attribute.
Algorithm
The Algorithm attribute specifies which algorithm is used for the Demand Limiting strategy (Fixed
Window or Sliding Window). In most cases, the Sliding Window Algorithm is required by North
American utilities, while the Fixed Window Algorithm is used by European utilities.
Demand Interval Length
The Demand Interval Length attribute specifies the length in minutes of an interval for the Demand
Limiting strategy. This value is normally obtained from the energy utility. The DLLR Interval Lengths
set specifies the possible interval lengths (15, 30, or 60).
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Current Amount Shed by DL
The Current Amount Shed by DL attribute displays how much energy is currently shed for the
Demand Limiting strategy. When Shed Strategy is set to Demand Limiting and Load Rolling, this
attribute indicates how much of the Amount Shed is due to Demand Limiting alone.
Sliding Window Alg (Algorithm) Attributes
Unc (Uncontrolled) Interval Demand
The Uncontrolled Interval Demand attribute displays the average uncontrolled energy demand
(interval demand plus amount shed) over the current interval. It indicates what the demand would
be if the DLLR object had not shed any loads.
Ramp Down In Progress
The Ramp Down In Progress attribute indicates whether a target ramp down is in progress.
Fixed Window Alg (Algorithm) Attributes
Profile Limit
The Profile Limit attribute displays the current value of the Demand Limit profile, which is the
current demand limit adjusted by the safety factor for this minute.
EOI Attribute
The EOI attribute is a reference to the Metasys object (for example, BI, BV) supplying the EOI pulse,
which is used for the Fixed Window algorithm only. The EOI pulse is used to synchronize DLLR’s
demand interval to the utility’s demand interval. If this is not specified, DLLR performs its own
interval timing, which is not as accurate.
This EOI attribute can be any binary type object, as long as the following requirements are met:
•

A permanent communication path must exist between this attribute and the DLLR object;
therefore, the EOI point and DLLR object should reside on the same supervisory controller.

•

The attribute must be a numerical attribute, in which a change from 0 to 1 indicates the end
of interval and the beginning of the next interval. The EOI Status attribute is set to Off Normal
when the object supplying the EOI pulse becomes offline or unreliable to the DLLR object.

Load Rolling Attributes
LR Tariff Targets
The LR Tariff Targets attribute lists the energy targets for the Load Rolling strategy. Each target
consists of a target value and an entry from the Target Description set identifying the type of
target, such as On-Peak. If the Load Rolling strategy is used, there must be at least one target
defined. Only one target is active at a time. The Active LR Target attribute specifies which LR Target
is currently active. The Target Description set includes:
•

Continuous

•

Off-Peak

•

On-Peak

•

Semi-Peak

•

Shoulder

•

Summer Off-Peak

•

Summer On-Peak

•

Winter Off-Peak

•

Winter On-Peak

•

Summer Semi-Peak
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•

Winter Semi-Peak

•

Summer Shoulder

•

Winter Shoulder

Active LR Target
The Active LR Target attribute specifies which of the defined Load Rolling targets is currently
active. When this attribute changes, the Active LR Target Changed attribute indicates True until the
start of the next interval if demand limiting is configured, or the next minute if load rolling only is
configured. This attribute uses the Target Description enumeration set.
Current LR Target
The Current LR Target attribute represents the load rolling target that is set by the user (LR Tariff
Targets indexed by Active LR Target). This target defines the amount of energy that should be shed
each minute for the load rolling strategy. You can change the value of the load rolling target by
writing to this attribute.
Current Amount Shed by LR
The Current Amount Shed by LR attribute indicates how much energy is currently shed for the Load
Rolling strategy. When Shed Strategy is set to Demand Limiting and Load Rolling, this attribute
indicates how much of the Amount Shed is due to Load Rolling alone.
Display Attributes
Rate Units
The Rate Units attribute specifies the energy units used for instantaneous energy demand
attributes and referenced in the DLLR Profile and Load Summary (for example, kW). If a meter is
defined, the Rate Units attribute indicates the units of the meter.
Consumption Units
The Consumption Units attribute specifies the consumption energy units (for example, kWh).
Display Precision
The Display Precision attribute defines the decimal display precision for all real values (floating
values) in the DLLR object.
Advanced Operational Data Attributes
Minutes Since Meter Failure
If the Meter is offline or unreliable, the Minutes Since Meter Failure attribute indicates the number
of minutes (up to the interval length) since the meter was last reliable.
Advanced Demand Limiting Attributes
Unreliable Meter Options
The Unreliable Meter Options attribute allows you to specify what should happen to Demand
Limiting if the meter becomes unreliable or goes offline. These options are as follows:
•

Stop Shedding - no more shedding occurs until the meter is again reliable. Currently, shed
loads continue to be shed until their Max Shed Time expires.

•

Maintain the Current Shed Rate - as loads are released, DLLR sheds other Loads to maintain
the current amount of shed load.

Use Unreliable Meter Shed Rate - sheds or releases loads as needed to maintain the amount
of load specified in the Unreliable Meter Shed Rate.
The second and third options cause Demand Limiting to act similarly to the Load Rolling strategy. If
the Demand Limiting strategy is not defined, an offline or unreliable meter prompts no actions.
•
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Also, when the meter goes offline or unreliable, DLLR sets its Meter Status attribute to Off Normal
and continuously updates its Minutes Since Meter Failure attribute (up to the interval length) until
the meter is again reliable. The Minutes Since Meter Failure value is listed under the Operational
Data section of the DLLR object - Advanced view.
Unreliable Meter Shed Rate
The Unreliable Meter Shed Rate attribute specifies how much load the DLLR object should keep
shed if the meter goes unreliable, provided the Use Unreliable Meter Shed Rate option is selected
for the Unreliable Meter Options attribute.
DL to Shed
The DL to Shed attribute indicates how much energy needs to be shed to meet the current Demand
Limit target for this minute. A negative value indicates how much energy can be released this
minute.
DL Not Shed
The DL not Shed attribute indicates how much energy was unable to be shed (this minute) to meet
the current Demand Limit target for this minute. A positive value indicates a potential problem that
Demand Limiting might not be able to meet its target during this interval.
Current Amount Eligible to be Shed by DL
The Current Amount Eligible to be Shed by DL attribute represents the amount of energy available
for Demand Limiting to shed at this moment. It does not include the energy of loads already shed.
Active DL Target Changed
The Active DL Target Changed attribute displays True when the Active DL Target value is changed.
It remains True until the start of the next interval, when it is reset to False. This attribute allows an
alarm to be raised when the DL target changes.
Sliding Window Alg (Algorithm) Advanced Attributes
Target Ramp Down Enabled
The Target Ramp Down Enabled attribute specifies whether a target reduction causes an
incremental ramp down over the course of one interval, as opposed to an immediate target drop
that could result in major immediate Load shedding.
Sensitivity
The Sensitivity attribute specifies the level of aggression for shedding Loads when using the Sliding
Window algorithm. A High sensitivity sheds more loads sooner than a Low sensitivity.
•

Low setting - allows you to start shedding loads later and shedding loads over a shorter
period of time. This setting reduces the amount of equipment that is turned off; however, it
increases the possibility of exceeding the target.

•

Medium setting - (default) allows you to start shedding slightly earlier than a low setting and
later than a high setting. This setting turns off equipment earlier than with a low setting, but
does not have to turn off as much equipment at once as with the high setting.

•

High setting - allows you to begin shedding sooner into the demand peak. This setting
decreases the possibility of exceeding the target; however, it increases the amount of
equipment that is turned off.

Smoothed ABS Error
The smoothed absolute error is based on the forecast error and is used to provide a safety margin
to prevent the interval demand from exceeding the target. It equals the average percentage of
variation in the uncontrolled energy rate.
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Error Limit
The Error Limit attribute limits the Smoothed ABS Error to a percentage of the Active Demand Limit.
It can be used to reduce the size of the safety margin to avoid unnecessary overshedding. This
value should be changed with care, since it increases the possibility of exceeding the demand limit
target. The default value is 10%.
Fixed Window Alg (Algorithm) Advanced Attributes
Limit Elevation
The Limit Elevation attribute indicates the amount (in percent) by which the demand limit is
increased at the beginning of the next interval to obtain the starting value of the demand limit
profile. A high value may result in increased shedding toward the end of an interval. Changing this
interval affects the next interval, not the current interval.
As shown in Figure , the demand limit profile specifies for each minute the maximum allowed
average power during the whole interval. If too much energy is consumed during the first half of
the interval, because the limit elevation allowed this consumption, then more loads are shed during
the second half of the interval, even though the actual metered power is then below the demand
limit profile. In other words, the net effect of limit elevation is to defer aggressive load shedding to
the second half of the fixed demand interval.
Figure 53: Use of Limit Elevation on a Demand Limit Profile

Active Elevation
The Active Elevation attribute indicates the amount (in percent) by which the demand limit was
increased during the elapsing interval to obtain the starting value of the demand limit profile. The
Active Elevation represents the Limit Elevation that is used for the current interval.
Time Until EOI
The Time Until EOI attribute indicates the number of minutes until the expected end of the interval.
Time Since EOI
The Time Since EOI attribute indicates the number of minutes since the latest EOI.
Energy Since EOI
The Energy Since EOI indicates the consumed energy since the latest EOI.
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Demand Since EOI
The Demand Since EOI indicates the average power since the latest EOI.
Max Allowed Peak Until EOI
The Max Allowed Peak Until EOI attribute indicates the maximum allowed average power until the
next EOI.
Advanced Load Rolling Attributes
LR to Shed
The LR to Shed attribute indicates how much energy needs to be shed to meet the current Load
Rolling target for this minute.
LR Not Shed
The LR not Shed attribute indicates how much energy was unable to be shed (this minute) to meet
the current Load Rolling target for this minute. A non-zero value indicates an error situation in
which Load Rolling was unable to meet its target this minute.
Active LR Target Changed
The Active LR Target Changed attribute displays True when the Active LR Target value is changed. It
is set to False at the start of the next interval if demand limiting is configured, or at the start of the
next minute if load rolling only is configured. This attribute allows the DLLR object to raise an alarm
when the LR target changes.
Control Attributes
Allow Reset in Shed Mode
The Allow Reset in Shed Mode attribute controls whether the Reset Initialization Parameters
command can be issued while DLLR is in Shed mode. When True, the Reset Initialization Parameters
command can be issued once if DLLR is in Shed mode. As soon as the command is issued, this
attribute is automatically reset to False and must be manually set to True before the command can
be issued again in Shed mode.

Profile Tab
The DLLR Object Profile indicates energy usage for the current and previous tracking periods.
The current Energy Rate and Active Demand Limit values are also shown. The profile includes the
following parameters:
How Daylight Saving Time Affects Start Times and End Times
If daylight saving time is used at your facility, the Profile reacts accordingly. For example, when
daylight saving time begins, the system clock on the supervisory controller advances from 1:59
A.M. to 3:00 A.M. If an hourly tracking period is used, the Profile starts a new tracking period at that
moment, setting the Current Start Time to 3:00 A.M. and the Current End Time to 4:00 A.M. The
Profile also changes the Previous Start Time to 1:00 A.M. and the Previous End Time to 3:00 A.M.
The previous profile indicates that 2 hours have elapsed, but contains only 1 hour of energy data.
When daylight saving time ends, the system clock on the supervisory controller changes from 1:59
A.M. to 1:00 A.M. In this scenario, the system does not reach 2:00 A.M. until 2 hours after 1:00 A.M.
The current profile contains 2 hours of profile data, even though the Current Start Time is 1:00 A.M.
and the Current End Time is 2:00 A.M.
Whereas start/end date and times are not affected when the other tracking periods are used (daily,
weekly, monthly, or manual), the period in which daylight saving time begins always contains 1
hour of data fewer than in a standard period. The period in which daylight saving time ends always
contains 1 hour of data more than a standard period.
Start Time
Start Time indicates when the DLLR Object starts to record demand profile data.
488

Metasys Site Management Portal Help

The Start Time depends on the situation. For example, at startup, the Start Time is set to when the
controller was restarted. If the Profile Tracking Period has expired, Start Time is set to when the
next tracking period begins.
The Start Time is also reset if the Profile Tracking Period is changed, a Reset Profile command is
issued to the DLLR object while in Shed or Monitor Only mode, a Reset Initialization Parameters
command is issued to the DLLR object while in Monitor Only mode, or the controller is downloaded.
Note that the Start Time is not reset when DLLR changes from Monitor Only mode to Shed mode.
See the How Daylight Saving Time Affects Start Times and End Times section.
End Time
The End Time for current profile indicates the predicted end time. The End Time for the previous
profile indicates the actual end time. If the Profile Tracking Period is set to Manual, the End Time
indicates Unspecified for the Current Profile.
See the How Daylight Saving Time Affects Start Times and End Times section.
Energy Consumption
Energy indicates the calculated total energy consumption.
Peak Interval Demand
Peak Interval Demand indicates the total Peak Interval Demand with date and time.
Peak
Peak indicates the highest measured energy demand.
Projected Peak
Projected Peak indicates the highest energy demand that would have occurred if DLLR had not
been enabled and had not shed any loads.
Targets
The Targets list the Energy Consumption, Peak Interval Demand, Peak, and Projected Peak for each
target that is active during the current profile tracking period. Only configured targets are listed.

Load Summary Tab
In the Runtime view, the Load Summary provides real-time information about each load associated
with the DLLR object, as well as the Energy Rate and Current LR Target values. By default, all of
the loads associated with this DLLR object are displayed in the order in which they were added to
the object. They are sorted by priority, starting with the lowest Shed priority (10) at the top of the
list. This matches the order in which DLLR seeks eligible loads to shed. Clicking on column headers
allows you to sort the information. Reordering is available for all columns except Status and Load
Rating.
Note: The entry Unspecified in the Last Shed Time column means that the load has never
been shed or has not been shed since the last controller download.
The Load Summary is automatically refreshed at the standard UI refresh rate. You can command
one or more loads directly from the Load Summary by selecting them and right-clicking the
mouse to display the appropriate command window. Right-clicking a single load also allows you to
command the output or navigate to the output’s focus view.
The Setup option on the Load Summary changes the view to allow editing of some of the fields.
When the Setup view for the Load Summary is displayed, the Associate Load(s) button is used to
add new loads to the table. The Remove Load(s) button removes loads from the table. The MultiEdit
button edits more than one load at a time when several loads are highlighted.
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Energy Rate and Current LR Target
The top portion of the Load Summary indicates current values for the Energy Rate and Current LR
Target.
Status
Status displays an icon to indicate the current status of the load. Table 290 provides icon
descriptions.
Table 290: Load Summary Icons and Their Status
Status Icon

11

Load Status
Load appears to be offline; system is awaiting confirmation.
Load is offline.
Load is disabled.
Load is shed.
Load is locked.
Load is in comfort override.

<no icon>
1

Load is released.

Positioning the mouse on an icon in the Status column displays a tooltip.

Point Name and Point Reference
The Point Name and Point Reference fields display in colors that indicate the load output’s current
condition. Table 291 describes the default colors.
Table 291: Default Coloration of Point Name and Point Reference Fields
Condition of Output

Point Name and Point Reference Field Color

Normal

White

Overridden

Orange

Offline

Black

Trouble/Warning

Yellow

Alarm

Red

1

1

The actual colors used are set in the Status Colors section of Metasys Preferences > Graphic Settings. For details, refer
to the ADS/ADX Commissioning Guide (LIT-1201645) or NAE Commissioning Guide (LIT-1201519).

Load Priority
The priority of the load affects the order in which it is shed. Priority 10 loads are the lowest priority
and are shed first. Priority 1 loads are not shed unless no higher priority loads are available for
shedding.
Shed Strategy
Shed Strategy indicates whether the load can be shed for Demand Limiting, Load Rolling, or both.
Minimum Shed Time
Minimum Shed Time specifies the minimum number of minutes that a load must be shed before it
can be automatically released. A load can be manually released before this value expires. The range
is 0 to 65,535 minutes.
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Maximum Shed Time
Maximum Shed Time (optional) specifies the maximum number of minutes that a load can be shed
before it is automatically released. If the Maximum Shed Time value is not defined, the default
value of 65,535 is used. The range is 0 to 65,535 minutes.
Minimum Release Time
Minimum Release Time specifies the minimum number of minutes that a load must be released
from shed before it can be shed again. Although DLLR does not shed a load before this time
expires, a load can be manually shed before this value expires. The range is 0 to 65,535 minutes.
Load Rating
Load Rating indicates how much energy is saved when the load is shed. This is specified in the same
units as the Rate Units.
Output Present Value
The Output Present Value indicates the current value of the load’s output.
Ineligibility
Ineligibility indicates the reason that the load cannot be shed at this time. This field is blank if the
load is eligible to be shed.
Active Timer
The Active Timer displays the shed or release timer if one is in effect.
Time Remaining
The Time Remaining displays the minutes remaining if a shed or release timer is in effect.
Last Shed Time
The Last Shed Time displays the last time that the load was shed.

DLLR Object Commands
After a DLLR Object is defined, an authorized user can issue one of several commands (see DLLR
Object Commanding). Metasys objects with a Load extension are intended for use with the DLLR
feature permit operator or scheduled commands.

DLLR Object Commanding
After a DLLR object is defined, an authorized user can issue one of several commands to the object.
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Table 292: Commands Available to DLLR Objects
Command

Parameters

Description

Set Mode

Monitor Only
Shed

Selects between Monitor Only mode and Shed mode for the
Demand Limiting and Load Rolling strategies. The selected
mode applies to both strategies; in other words, you cannot
put DL in Monitor Only mode and keep LR in Shed mode.

Set Target

Type
Demand
Limiting
Load Rolling

Sets the active Target Level used for either the Demand
Limiting or Load Rolling strategy. Optionally, you can specify
a new value for the target and select a Target Description.
The Target Description is an element of the DL Targets and LR
Targets attributes, which describes the purpose of the target.
Examples include Continuous, Off-Peak, On-Peak, and SemiPeak.
You also can:

Target Level
Value
New value

11

•

Change the value of the current target by writing to the
Current Demand Limit and Current LR Target attributes.

•

Set which target is active using the Active DL Target and
Active LR Target attributes.

Reset Profile

None

Copies the current DLLR profile to the previous DLLR profile
and starts a new, current profile. Use this command if
DLLR’s Profile Tracking Period is set to Manual. It is not
necessary to use this command if a definitive tracking period
is selected, such as Monthly, because DLLR resets the profile
automatically.

Reset Interval

None

Restarts the Demand Limiting calculations associated with the
current interval - Fixed Window Algorithm only.
You can specify a new start of a demand interval for the
Demand Limiting strategy. If you are using the Fixed Window
Algorithm, and there is no EOI input defined, issue this
command at the start of the utility company’s interval, the first
time that DLLR runs. It synchronizes DLLR to the start minute
of the utility company’s billing interval (15, 30, or 60 minutes).
Thereafter, DLLR uses a pseudo EOI pulse, so that the start of
each subsequent interval is synchronized. If an EOI input is
defined, DLLR automatically starts each interval at the correct
time.
When the Reset Interval command is received, the DLLR object
resets interval parameters and starts a new Demand Interval.
Note: If the Sliding Window Algorithm is used, do not use this
command, as the interval is reset each minute.

Disable
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None

Stops DLLR operation. When disabled, DLLR releases all shed
loads except those that are locked shed. Also, DLLR does
not perform any calculations, report alarms, or issue any
commands to any objects when disabled. DLLR attributes can
be changed, but no actions are taken until DLLR is enabled.
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Table 292: Commands Available to DLLR Objects
Command

Parameters

Description

Enable

None

Starts DLLR operation. If Shed mode is active, the configured
DLLR strategies begin shedding loads as needed. If Monitor
Only mode is configured, simulated load shedding begins.

Reset
Initialization
Parameters

None

Initializes DLLR as if it were running the demand limiting
algorithm for the first time. Use it in Monitor Only mode for
testing new potential demand tariff targets without using any
data from a previous test. It releases all shed loads, clears all
load timers, reinitializes DLLR, and clears the Energy Profile.
Note: Since these actions would adversely affect a smoothly
running DLLR feature, you cannot issue this command while
in Shed mode unless you manually set the Allow Reset in Shed
Mode attribute to True. If you issue the Reset Initialization Parameters command while in Shed mode, the Allow Reset in Shed
Mode attribute reverts to False immediately after the command
is issued.

1

Possible target descriptions: Continuous, Off-Peak, On-Peak, Semi-Peak, Shoulder, Summer Off-Peak, Summer On-Peak,
Winter Off-Peak, Winter On-Peak, Summer Semi-Peak, Winter Semi-Peak, Summer Shoulder, Winter Shoulder.

Global Data Object
Menu Selection: Insert > Object > Global Data
The Global Data object provides a means for distributing information about changes in a single
attribute value to other attribute reference points. This minimizes hardware costs and system
complexity. For example, an NAE might have multiple AHUs on its network, but only one has an
outdoor air sensor. The Global Data object can share the value from the single sensor with the
other AHUs.
The data types defined for the Global Data object’s input and corresponding outputs should match.
Otherwise, each output attempts to convert the value being received to the data type defined for
it. The software does not check for data type consistency. Global data sharing is restricted to within
one site.
For general information on Metasys system objects, see Common Object Attributes.

Global Data Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes unique to
the Global Data object. See the Object and Feature Tabs section for information on the attributes
that appear on the other tabs of this object (for example, the Hardware and Options tab appear on
point objects).
Table 293: Global Data object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Alternate Master

C,N,W

None

Execution Priority

C,W

Normal

11

Initial Value
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Values/Options/Range

Description
Defines an alternate to the
Master. When the Master
becomes unreliable, this attribute
becomes the master attribute.
Indicates the relative importance
of performing the function of the
object within the device.
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Table 293: Global Data object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Failsoft

C,W

Master

C,W

None

Present Value

C

Master

Priority For Writing

Refresh Timer

C,W

C,W

11

Initial Value

15

2 min

Values/Options/Range

Description
Routes to all the outputs if Setup
is configured as Fail Soft. Fail
Soft routes when the object
becomes unreliable and when the
output transitions from Reliable
to Unreliable. This attribute is
initialized to a specific value.
Contains an attribute reference.
The value associated with this
attribute is written to each of
the designated subordinate
destinations.

n=4
0 = Master, 1 = Alt Master, 2 =
Last Reliable, 3 = Fail Soft
16 (lowest priority) to 7
(highest priority)

Default value is 0. No range
check done.

Stores data about the value
shared with the subordinates.
Defines the priority at which
the referenced attributes are
commanded. Seven is the highest
priority and 16 is the lowest
supported by the Global Data
object, with the default of 15.
We do not recommend using
priorities 7 or 8 as they may
interfere with the operator
override function.
Indicates the amount of time, in
minutes, between updates to the
subordinates from the Master
or Alternate Master. Updates
initiated by the refresh timer
occur in addition to updates
initiated by a COV from the
Master/Alt Master. For example,
if the Refresh Timer attribute’s
value is 2, the Global Data object
updates the subordinates with
information from the Master/Alt
Master every 2 minutes and with
each COV.
If this attribute is set to zero
instead, updates are only sent
upon receipt of additional COV
reports.

Reliability
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Reliable, Input Unreliable

Indicates whether a value is
questionable. This attribute value
equals Input Unreliable only
if both the configured Master
and Alternate Master inputs are
unreliable.
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Table 293: Global Data object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Setup

C

11

Initial Value

Values/Options/Range

Description

Last Reliable

n=2

Defines whether the Fail Soft or
Last Reliable value needs to be
the output if the object becomes
unreliable.
Contains a list of attribute
references. Each subordinate
identified in this list of attribute
references receives its value from
the Master.

0 = Master, 1 = Alt Master

Subordinates List

1

C,N,W

None

Minimum number of entries =
0

C - Configurable, N - Value Not Required, W - Writable

Global Data Commands
The table below lists the commands supported by the Global Data Object.
Table 294: Global Data Object Commands
Command Name

Parameters

Description

Disable

None

Prevents the object from responding to any
change in the Master, including reliability
changes.

Enable

None

Updates the Subordinates List with COVs.
Immediately after receiving this command,
the Master referenced value is routed to each
of the output references.

Interlock
Menu Selection: Insert > Object > Interlock
The Interlock object provides a means to establish conditional control over one or more other
objects. It consists of an IF conditional statement, True command statements, and False command
statements. Through these statements, the user specifies a set of conditional checks (using one or
more points) for which a series of commands is used to control a collection of one or more other
objects.
Three essential parameters of the IF conditional statement, shown in the following list, determine
the Interlock object’s mode of operation:
•

list of attribute references

•

constants

•

operators

This object allows a user to place a VAV controller in the occupied mode whenever the main fan is
on and in the occupied mode.
Note: On the Configure screen, click the Interlock Definition and Action Tables tabs for further
configuration.
Tips for the Interlock Definition tab of the Configure screen:
•

Click the Add button to add items to the list from the Select Item dialog box.

•

Click the check box next to an item in the list and click Delete to remove the item from the list.

•

Select the type of logic to use for the items in the list from the Logic menu. See the Interlock’s
Logic attribute description for the types of logic.
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Tips for the Action Tables tab of the Configure screen:
•

Check the All Commands Priority check box if you wish to use the same priority for all
commands in the action tables. Clear the All Commands Priority check box to enable
individual priority selection for the commands in the action tables.

•

For the Actions for Condition: True and Actions for Condition: False tables, click the Add
button to add items to the table from the Select Item dialog box.

•

For the Actions for Condition: True and Actions for Condition: False sections, click the check
box next to an item in the table and click Delete if you want to remove the item from the table.

For general information on Metasys system objects, see Common Object Attributes.
For information on the logic used in the interlock object, see the Logic attribute description.

Interlock Configuration
Configure the attributes of the Focus/Configuration, Interlock Definition, and Action Tables tabs of
the Interlock object. See the Interlock Attributes section for descriptions of the attributes on these
tabs.
On the Focus/Configuration tab, click the Advanced radio button to view and edit all the attributes
available on this tab.
On the Interlock Definition tab, define the items/objects to control and the desired conditional
logic.
Tips for this tab include:
•

Click the Add button to add items to the list from the Select Item dialog box. You can also
select items from the All Items tree or from the Global Search results and drop them into the
Interlock Definition table.

•

Click the check box next to an item in the list and click Delete to remove the item from the list.

•

Select the type of logic to use for the items in the list from the Logic menu. See the Logic
attribute description for the types of logic.
On the Action Tables tab, define the commands and the priority for the items/objects under
control.
Figure 54: Example of Interlock Action Table Headers and Options

Tips for this tab include:
•

Check the All Commands Priority check box if you wish to use the same priority for all
commands in the action tables. Clear the All Commands Priority check box to enable
individual priority selection for the commands in the action tables.

•

Check the Add New Items to All Conditions check box if you wish to add new items to both
the Actions for Condition: True and Actions for Condition: False tables. The Add New Items
to All Conditions is selected by default.
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•

For the Actions for Condition: True and Actions for Condition: False tables, click the Add
button to add items to the table from the Select Item dialog box. You can also select items
from the All Items tree or from the Global Search results and drop them into the Interlock
Action tables.

•

For the Actions for Condition: True and the Actions for Condition: False tables, click the
check box next to an item in the table and click Delete if you want to remove the item from the
table.

•

To select all items within a table, click the Select All column header. To unselect all items within
a table, click the Select All column header again.

•

To mass command items in the Actions for Condition: True or the Actions for Condition:
False, select similar items that have the same configured attributes and enumerations
(for example, select multiple BVs). Right-click the Command column header and click Set
Command. Or, click Set Command. The Set Command for Selected Items appears.

Figure 55: Right-Click Set Command Option

•

To mass set delay, select multiple items (can be dissimilar items), input a delay in the Set Delay
field, and click Set Delay.

Interlock Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 295: Interlock Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

11

Executing

Description
Specifies the current execution status of the object. It is True when the
object receives a state command and starts

Execution Priority

C,W

Last Executed Date
Last Executed Time
Present Value

N
N
D,R,W

sending commands. When all actions are completed for a given state, this
flag is set to False.
Indicates the relative importance of performing the function of the object
within the device.
Indicates the date stamp for the beginning of executing the current state.
Indicates the time stamp for the beginning of executing the current state.
Represents the current value of the object. Present Value is set based on the
relationships set up in the Interlock

Priority Array

definition.
Lists values of the object in level of importance.

Reliability

Indicates if the Present Value is questionable.

Restore Command
Priority

C,W

Selects which commands (at a selected priority) persist through a device
restart. When the bit is set, the command
(at a selected priority) is saved at shutdown and restored at startup.
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Table 295: Interlock Object Attributes - Focus/Configuration Tab
Attribute Name
Send OK

Notes

11

Description
Indicates the success or failure of the subordinate commands. If any
subordinate commands failed, this attribute is set to False.
When a send error is detected, a five minute timer is set. When the timer
expires, the interlock is reevaluated and
all commands are sent again. Commands may fail if the subordinate object
is off-box and offline or if the subordinate object is

set for local control.
States Text
C,W
Indicates the displayed strings for the Present Value.
1
C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable
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Table 296: Interlock Object Attributes - Interlock Definition Tab
Attribute Name

Notes

Logic

C,W

11

Description
Specifies the Boolean logic (And/Or) to be employed in combination with
source inputs in deriving a True or False
outcome.
When the source input operator is unreliable, the interlock operates
according to the following rules:
• Complex - Uses the equation defined by the Logic Equation attribute. If
any input is unreliable, the expression cannot be evaluated; therefore, the
interlock is unreliable and does not execute.
• Match All (AND) - Every one of the source conditions must be True. If an
input is reliable, it is evaluated. If the result is False, the interlock evaluates
to False and executes. All inputs are checked for trouble (Reliability !=
Reliable). If any input is not reliable, the expression cannot be evaluated;
therefore, the interlock is unreliable and does not execute.
• Match Any (OR) - One or more of the source conditions must be True. If an
input is reliable, it is evaluated. If the result is True, the interlock evaluates to
True and executes. All inputs are checked for trouble (Reliability != Reliable).
If no inputs are reliable, the expression cannot be evaluated; therefore, the
interlock is unreliable and does not execute.

Logic Equation

C,W

Contains a logic equation when the Logic attribute is set to Complex.
Use the logic equation to define the relationship between the master
conditions using logic operators and parentheses for determining
precedence.
Valid characters in the Logic Equation string are:
* AND operator
+ OR operator
( Open parenthesis (for grouping)
) Closed parenthesis (for grouping)
numbersMaster condition numbers
spacesSpaces are allowed for readability

Source

C,W

Lists objects whose attributes are used for input into the logic expression to
decide if the condition is True or False.
Information needed:
• Item - Name of the source object
• Attribute - Varies according to object. Default = Present Value
• Relation - Equal, Not Equal, Greater Than, Less Than, Greater Than or Equal,
Less Than or Equal
• Value - The value used in the Relation. Varies according to the object.

1

• Differential - Accounts for variations in the value. Required (and only used)
if the value is analog.
C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable
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Table 297: Interlock Object Attributes - Action Tables Tab
Attribute Name

Notes

Action Table 1 (True)

C,W

11

Description
Action Tbl 1 (True)
Lists commands issued by this object when the condition is true:
• Item - The name of the object to be commanded. Do not use any object
that contains special characters, such
as the ampersand (&). Otherwise, the Interlock may not function properly.
• Command - The type of command to send to the object.
• Priority - The priority at which to send the command.
• Delay - The amount of time, in seconds, each command waits to be sent,
after a change in condition.
• Parameters - These vary according to command.
Any object capable of accepting commands can be defined in either action
table. The available commands depend on the type of object and the user’s
access capability. An object may be sent more than one command by
identifying the object more than once and specifying a different command.
The user does not have to specify objects for both the True and False Action
Tables. If no command is specified for an object, no command is sent.

Action Table 2 (False)

C,W

Lists commands issued by this object when the condition is false:
• Item - The name of the object to be commanded. Do not use any object
that contains special characters, such
as the ampersand (&). Otherwise, the Interlock may not function properly.
• Command - The type of command to send to the object
• Priority - The priority at which to send the command
• Delay - The amount of time, in seconds, each command waits to be sent,
after a change in condition
• Parameters - These vary according to command.
Any object capable of accepting commands can be defined in either action
table. The available commands depend on the type of object and the user’s
access capability. An object may be sent more than one command by
identifying the object more than once and specifying a different command.
The user does not have to specify objects for both the True and False Action
Tables. If no command is specified for an object, no command is sent.

Commands Priority

C,W

Determines the order by importance for all commands sent. If the All
Commands Priority option is not selected, the commands are sent at each
individual priority specified in the Action Tbl attribute.
If the All Commands Priority option is selected, then every item in the
Action Table is sent a command at the priority specified. For example, if the
command chosen is Operator Override, the command priority automatically
sets to Operator Override (8) for every item listed in the Action Table.
When the All Commands Priority option is selected, you cannot change the
command priority within the Action Table.
An object defined in the Action Tables must use commands greater than
Priority 16 (default) if no Relinquish Default attribute is defined for that
object. Otherwise, commands sent at Priority 16 to objects without a
Relinquish Default will not be accepted by that object. Commands with a
lower priority number are of higher priority (importance) or are more critical
than commands with a higher priority number. For example, Manual Life
Safety (1) is of higher priority than Scheduling (15).
If the Commands Priority is defined as 16 (Default), then any existing
commands from Scheduling (15) through Priority 9 (9) will be released when
the command is sent.
The Commands Priority uses the priorities in the Write Priority (Set 1).

1
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C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by Object Reliability, W - Writable

Metasys Site Management Portal Help

Interlock Attribute Details
Logic Equation
Contains a logic equation when the Logic attribute is set to Complex.
Use the logic equation to define the relationship between the master conditions using logic
operators and parentheses for determining precedence.
Valid characters in the Logic Equation string are:
*AND operator
+OR operator
(Open parenthesis (for grouping)
)Closed parenthesis (for grouping)
numbersMaster condition numbers
spacesSpaces are allowed for readability
Equation Syntax
•

Open and close parenthesis must match.

•

Empty parenthesis are not allowed ().

•

The equation must be at least 3 characters in length, not including spaces.

•

The numbers must not exceed the master condition numbers.

•

There is no implied precedence for the operators (*,+).

•

Any combination of different operators must be grouped with parenthesis to determine
precedence.

•

Operators of the same type do not require the use of parenthesis.

•

A grouping may contain only one operator type.

•

Numbers or groupings must be separated by an operator (*,+).

•

Groups can be nested.

Table 298: Examples
Incorrect

Correct

1+2+3*4

1+2+(3*4) or (1+2+3)*4

1*2+3*4

(1*2)+(3*4) or 1*(2+3)*4

1*2*3+4

1*((2*3)+4) or (1*2)*(3+4) or (1*2*3)+4

(1+2)*(3+4)+(6*7)

((1+2)*(3+4))+(6*7) or (1+2)*((3+4)+(6*7))

(3*4)(1*2)

(3*4)*(1*2)

(3*+1)

(3*1)

(3*

(3*1)

Sample Logic Equation
((1+2)*(3+4))+(6*7)
Where the equation says that master condition ((1 OR 2) AND (3 OR 4)) OR (6 AND 7) results in a
TRUE (Action Tbl 1) execution.
Objects are given numbers in the left column that correspond to the order you add them to the
Interlock Definition list (the first added is 1, the second added is 2, and so on). Use these numbers
to represent the corresponding objects in the Logic Equation.

Metasys Site Management Portal Help

501

Interlock Commands
The table below lists the commands supported by the Interlock.
Table 299: Interlock Commands
Command
Name

Parameters

Description

Disable

None

Locks out all outputs and prevents the Interlock
functionality.

Enable

None

Ensures object reacts to any changes it may have missed
while it was disabled, and returns it to normal operation.

Operator
Override

The value to be
Updates the Present Value at Command Priority Operator
written to the
Override.
Present Value
Important: The Operator Override command sends the
specified command to the internal NxE object, which is
attribute. This
then only sent to the field device when one of the followparameter has a True
ing conditions is met: a) NOT Local Control and NOT Out
or False data type.

Release
Operator
Override

None

Releases Command Priority Operator Override from
Present Value.

Re-command

None

Reissues the commands for the current state.

Release

Attribute name
Command priority

Releases the identified command priority from the
specified, writable attribute, and allows it to be controlled
by the
next highest priority.

Release All

Attribute name

Releases Command Priorities 3 through 16 from the
specified, writable attribute. Command Priorities1 and 2
remain.
Note: The Release All command may not cause an immediate return to automatic operation. The Release All command clears all command priorities, including those that
come from applications and features. When this happens,
the output point goes to its Relinquish Default condition.
In some cases, the application or feature may have sent
a command that does not match Relinquish Default. In
this instance, the output point does not end in the state
that the applications or features intended. This situation
can cause unexpected operation to occur; for example, a
space could overcool or overheat, a fan might run longer
than expected, and so on. If an operator has overridden an
input, use the Release Operator Override command.

Multiple Command Object
Menu Selection: Insert > Object > Multiple Command
Note:
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•

On the Configure screen, click the Action Tables tab for further configuration.

•

Select or enter the desired value for the Relinquish Default. Edit the States Text and
Number of States attributes on the Focus tab.
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•

Check the All Commands Priority check box if you wish to use the same priority for all
commands. Clear the All Commands Priority check box to enable individual priority
selection for the commands.
- For each of the Actions for Condition (State 0 - State N) tables, click the Add button
to add items to the table from the Select Item navigation tree.
- For each of the Actions for Condition (State 0 - State N) tables, click the
check box next to an item in the table and click Delete to remove the item
from the table.

The Multiple Command object issues a series of commands to multiple objects by means of a single
command action. Commanding this object results in the execution of the commands for the given
state. This object supports States 1–32.
This object allows a user to start building controls for the day with one command or to prevent
selected points from generating COS and alarm messages when a control point is in a specified
state (Auto Shutdown).
For example, based on a single input, such as Room Occupied, a defined set of actions can occur:
setpoint goes to 72˚, a fan comes on, lights come on, and the door unlocks.
For general information on Metasys system objects, see the Common Object Attributes section.

Multiple Command Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R Affected by Extension’s Reliability, W - Writable.
Table 300: Multiple Command Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Values/Options/Range Description

Enabled
Executing

Execution Priority

False

C,W

Last Executed Date N
Last Executed Time N
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False, True

Indicates whether the Multiple Command object is
enabled or disabled.
Specifies the current execution status of the
object. It is True when the object receives a state
command and starts sending commands. When
all actions are completed for a given state, this
flag is set to False.
Indicates the relative importance of performing
the function of the object within the device.
Indicates the date stamp for the beginning of
executing the current state.
Indicates the time stamp for the beginning of
executing the current state.
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Table 300: Multiple Command Object Attributes - Focus/Configuration Tab
Attribute Name
Present Value

Notes
D,W

Initial Value

Send OK

Values/Options/Range Description
States Text attribute
Indicates the current value of this object.
identifies the states set
for this attribute.
Indicates the success or failure of the subordinate
commands. If any subordinate commands failed,
this attribute is set to False. When a send error
is detected, a 5-minute timer is set. When the
timer expires, the object is reevaluated and all
commands are sent again. Commands may fail if
the subordinate object is off-box and offline or if
the subordinate object is set for local control.

Table 301: Multiple Command Object Attributes - Action Tables Tab
Attribute Name
Action Table
(State0. . . StateN)

Notes
C,W

Initial Value

Values/Options/Range
Object Reference,
Delay, Command ID,
Parameters, Priority

Description
Lists actions to take for each supported state.
Each action of the table contains a subordinate
object reference, a delay, a command and its
associated parameters, and a priority. The
priority in this table is used only when Commands
Priority is set to No Priority. The delay is the
number of seconds before the given command
is issued. Command delays can be lengthened
or shortened to result in commands being sent
out after, before, or at the same time as any other
command.
The total number of commands identified in the
Action Table command set should not exceed 40.

Command Priority

C,W

16

Relinquish Default

Uses Write Priority (Set
1).

Determines the order by importance for all
commands sent. If it is set to Priority None,
commands will be sent at each individual priority
specified in the Action Table attribute.
Specifies the default value to be used for the
Present Value attribute when no commands
are currently controlling this object. If this
attribute is configured to any value other than
None, the object sends commands for the value
immediately.

Action Table (State0. . . StateN)
Tips for the Action Tables tab:
•

Click the Add button to add items to the list from the Select Item dialog box. You can also
select items from the All Items tree or from the Global Search results and drop them into the
Action table.

•

Click the check box next to an item in the list and click Delete to remove the item from the list.

•

To select all items within a table, click the Select All column header. To unselect all items within
a table, click the Select All column header again.

•

To mass command items, select similar items that have the same configured attributes and
enumerations (for example, select multiple BVs). Right-click the Command column header and
click Set Command. Or, click Set Command. The Set Command for Selected Items appears.

504

Metasys Site Management Portal Help

Figure 56: Right-Click Set Command Option

Multiple Command Commands
The table below lists the commands supported by this object.
Table 302: Multiple Command Object Commands
Command Name

Parameters

Dscription

Disable

None

Specifies that (when the Multiple
Command object is disabled) outputs
are locked and commands are prevented
from being sent.

Enable

None

Specifies that (when the Multiple
Command object is enabled) the object it
is capable of issuing commands.

Multistate0...Multistate31

None

Releases Command Priorities 9 through
15 (Scheduling) and then writes to
the Present Value at the Default (16)
command priority. The state command
names and number of commands
are dependent on the States Text and
Number of States attributes.

Operator Override

State 0–31

Updates the Present Value at Command
Priority Operator Override.
The Operator Override command sends
the specified command to the internal
NxE object, which is then only sent to the
field device when one of the following
conditions is met: a) NOT Local Control
and NOT Out Of Service, or b) NOT Local
Control and after issuing the In Service
command.

Release

1.

Attribute name

2.

Command priority

Releases the identified command priority
from the specified, writable attribute,
and allows it to be controlled by the next
highest priority.
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Table 302: Multiple Command Object Commands
Command Name

Parameters

Dscription

Release All

Attribute name

Releases Command Priorities 3
through 16 from the specified, writable
attribute. Command Priorities 1 (Manual
Emergency) and 2 (Fire Application)
remain.
Important: The Release All command
may not cause an immediate return to
automatic operation. The Release All
command clears all command priorities,
including those that come from applications and features. When this happens, the output point goes to its Relinquish Default condition. In some cases,
the application or feature may have sent
a command that does not match Relinquish Default. In this instance, the output point does not end in the state that
the applications or features intended.
This situation can cause unexpected
operation to occur; for example, a space
could overcool or overheat, a fan might
run longer than expected, and so on.
If an operator has overridden an input,
use the Release Operator Override command.

Release Operator Override None

Releases Command Priority Operator
Override from Present Value.

N1 Pulse Counter Object
The N1 Pulse Counter object aids in the integration of N1 controllers with supervisory controllers,
resulting in:
•

consistent interface to N1 point objects for all controller types, so they appear as a
homogenous set to the user interface

• flexibility in point mapping
This object allows you to read pulses from an electric or gas meter at a supervisory controller.
Note: The Pulse Counter object may feed its Present Value to the Pulse Meter Object.
For general information on Metasys system objects, see the Object Help section.

N1 Pulse Counter Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R Affected by Extension’s Reliability, W - Writable.
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Table 303: N1 Pulse Counter Object Attributes - Focus/Configuration
Attribute Name
Present Value

Notes
D,R,W

Initial Value

Reliability

Values/Options/Range Description
0 to 4,294,967,295
Actual value of the Pulse Count the last time it was
read.
Uses Reliability (Set 503). Indicates whether the Present Value is reliable
and why.

N1 Pulse Counter Commands
The following table lists the commands supported by the N1 Pulse Counter Object.
Table 304: N1 Pulse Counter Object Commands
Command Name

Parameters

Description

Preset Counter

None

Defines a preset value in the counter. This
command is available only if you have the
Supervise Access level command priority.

Enable Alarms

None

Enables alarms for the N1 pulse counter.

Disable Alarms

None

Disables alarms for the N1 pulse counter.

N1 PID Loop Object
The N1 PIDL object generates outputs to maintain a measured value at a desired level. The PIDL
performs Proportional, Integral, and Derivative control. The PID Loop object manipulates outputs
for closed loop control at a given Digital Control Module (DCM101 or DCM140).
Note: For the PIDL object, the only difference between DCM101 and DCM140 operation is that
the DCM101 has up to 16 PID Loops, and the DCM140 has up to 20 PID Loops.
The PID Loop object generates outputs for closed loop control by using a collection of inputs and
other variables to perform calculations and issue commands. Each PID Loop object can accept up to
six analog inputs, and issue commands to a maximum of eight analog outputs. Inputs come from
AI objects. Outputs are sent to AOD objects or other PID Loops.
A primary function of the PID Loop object is to perform Proportional plus Integral plus Derivative
calculations in order to maintain steady and accurate control of a closed loop. PID calculations take
into account the past, present, and future (forecasted) performance of loop inputs for the purpose
of adjusting outputs to correct levels. You can configure the PID Loop object to compute any or all
of the following:
•

Proportional Only: Present performance is analyzed by computing the difference between
the PID Loop setpoint and its feedback. This difference is called an error. With proportional
control, the output signal is directly proportional to the difference between the input and the
setpoint (that is, the error).

•

Proportional plus Integral: Present and past performance are analyzed in this calculation to
affect the output. The error computed in the proportional calculation is now integrated (that is,
accumulated over time). If the loop failed to reach setpoint in the past, the integration causes
the output to increase or decrease to maintain setpoint.

Proportional plus Integral plus Derivative: This calculation uses past, present, and future
(forecasted) performance. The derivative part of the computation analyzes the rate of change
of the feedback to predict the future value of the feedback. As the feedback changes faster, the
PID Loop issues outputs that slow down the rate of change.
You can use the PID Loop object with a variety of control schemes, including sequencing a number
of physical devices to maintain control of a closed loop. Additional functions of the PID Loop
object include Self-tuning PID Control, bumpless transfer, and an auxiliary switch. Self-tuning PID
•
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Control automatically and continually self-tunes the PID Loop to ensure correct feedback levels. The
auxiliary switch allows another PID Loop object or a control process to take control of the closed
loop. When control of a closed loop is turned over to the PID Loop object, the bumpless transfer
function provides for a smooth and predictable transition.

N1 PID Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R Affected by Extension’s Reliability, W - Writable.
Table 305: N1 PID Loop Object Attributes - Focus/Configuration Tab
Attribute Name
COV Increment

Notes
C,W

Initial Value
0.1

Device Type

C,N,W

Display Precision

C,W

10ths

Max Value

C,W

1.7E38

Min Value

C,W

-1.7E38

Out of Service

C,W

Feedback

Present Value (Value) D,N,R,W
Reliability

W

0

Values/Options/Range
Any value > 0

Description
Defines the minimum change in the
Present Value required for the object to
report a change.
20 Character Limit
Contains a description of the physical
device connected to the object.
Defines the decimal rounding and the
decimal places to display for the Present
Value and associated attributes.
Indicates the Feedback value, which
results from the PIDL Input Conditioning
process. This process scales each of the
six PIDL inputs and determines a sum, a
maximum, or a minimum.
Defines the highest reliable value (in
engineering units) for the Present Value.
Defines the lowest reliable value (in
engineering units) for the Present Value.
De-couples the object from the physical
input. When Out of Service is True,
the object de-couples the Setpoint
and Reliability from the hardware.
The Reliability is writable when Out of
Service is True. When de-coupled, the
Setpoint can be changed to simulate
specific conditions or for test purposes.
Represents the current value of the
object.
No Fault Detected (Reliable), Indicates whether the Setpoint is
Open Loop, Shorted Loop, No unreliable.
Output, Unreliable Other
Examples:
•

Reliable - No detectable faults

•

Unreliable High - Setpoint is
greater than the Max Value.

•

Unreliable Low - Setpoint is less
than the Min Value.

When Out of Service is True, the
Reliability attribute may be written
directly.
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Table 305: N1 PID Loop Object Attributes - Focus/Configuration Tab
Attribute Name
Setpoint

Notes

Initial Value

Units

C,W

No units

Values/Options/Range

Description
Indicates the desired value for the
control loop feedback signal.
Contains the engineering units for the
Present Value attribute.

N1 PID Loop Commands
The following table lists the commands supported by the N1 PID Loop Object.
Note: For the Release Operator Override, Release, and Release All commands, if all Command
Priorities have been released and a Relinquish Default is not defined, the supervisory
controller gives control to the actual hardware.
Table 306: N1 PID Loop Object Commands
Command Name

Parameters

Command Description

Adjust

The value to be written to the
Setpoint. The value must be less
than Max Value and greater than
Min Value.

Releases Command Priorities 9 through
15 (Scheduling) and then writes to the
Setpoint at the Default (16) command
priority. The value must be less than
Max Value and greater than Min Value.
If Local Control is True, this command
is rejected.
The command is only sent when one
of the following conditions is met: a)
NOT Local Control and NOT Out of
Service, or b) NOT Local Control and
after issuing the In Service command.

Disable Alarms

None

Disables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.

Enable Alarms

None

Enables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.

In Service

None

Cancels the effect of an Out of Service
command and returns the Out of
Service attribute to False. The Setpoint
and Reliability revert back to the values
obtained from the physical hardware
output.
Note: For BACnet objects, support
of this command is dependent on
the ability to write the Out of Service
attribute.

Operator Override

The value to be written to the
Setpoint.
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Updates the Setpoint at Command
Priority Operator Override (8).
The Operator Override command
sends the specified command to the
internal NxE object, which is then only
sent to the field device when not Out of
Service.
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Table 306: N1 PID Loop Object Commands
Command Name

Parameters

Command Description

Out of Service

None

Allows a user to override the object's
hardware output. The Out of Service
command changes the Out of Service
attribute to True. The Setpoint and
Reliability no longer track the physical
output. No commands are sent to
the actual hardware. When the Out
of Service attribute is set to False, the
current Setpoint is sent to the actual
hardware.
When an Out of Service command is
issued, the NxE does not communicate
subsequent changes (operator or
system) to the field device.
For BACnet objects, support of this
command is dependent on the ability
to write the Out of Service attribute.

Release Operator
Override

None

Releases Command Priority Operator
Override (8) from Setpoint.

Release

Attribute name
Command priority

Releases the identified Command
Priority from the specified attribute
and allows the next highest priority to
control it.

Release All

Attribute name

Releases Command Priorities 3 through
16 (Default), from the specified,
writable attribute. Command Priorities
1 and 2 remain.

Optimal Start Object
Menu Selection: Insert > Object > Optimal Start
Note: On the Configure screen, click the [...] button to select the object from the Select Item
dialog box and then select the desired attribute for the Cooling Setpoint, Heating Setpoint, and
Zone Temperature.
The Optimal Start object aids in the reduction of energy costs during a building’s transition from
unoccupied to occupied. This scenario is accomplished by turning on the preheating/precooling as
late as possible to reach comfort levels prior to occupancy and turning off the heating/cooling as
early as possible while maintaining occupied zone comfort until zone vacancy.
This object allows you to save energy by coordinating the startup and shutdown times of
equipment according to when people occupy certain rooms or areas of the building.

Optimal Start Concepts
Optimal Start Overview
After you create an Optimal Start Object using the known characteristics of your building, the
OST calculates the best times for startup and shutdown. For Optimal Start mode (Optimal Start
Equation), the OST commands the Zone WC Mode Obj attribute to occupied and starts the heating
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or cooling sequence at the appropriate time. For Optimal Start mode, the OST commands the Zone
Occ Mode Obj attribute to unoccupied at the appropriate time.
If you set the Adaptation Enabled attribute to True (1), the OST automatically adjusts the Cooling
Constant and Heating Constant as needed.
Note: Warmup and cooldown (WC) is also referred to as the prestart period in the OST object.

Optimal Start
The goal of Optimal Start Object is to reach either the Heating Setpoint or Cooling Setpoint
at occupancy. The Optimal Start object selects the appropriate setpoint depending on the
temperature before starting the equipment. To meet this goal, the Optimal Start object calculates:
•

Heating Constant and Cooling Constant represent the rate at which the temperature inside the
building changes when the heating or cooling equipment is running

•

the temperature difference between the Zone Temperature and the Heating Setpoint or
Cooling Setpoint before occupancy

•

how many minutes of precooling (cooldown) or preheating (warmup) are required based on
the above difference

•

optimal start time when the Zone WC Mode Obj (BO, BV, MO, or MV object) is controlled by the
optimal start process
The Optimal Start object interacts with a Schedule Object, binary objects, and analog objects in an
Optimal Start application. See the Object Help section for information on these objects. See the
Optimal Start Object section for attribute information on the Optimal Start object.
Figure 57 illustrates optimal start.
Figure 57: Optimal Start - Heating

Optimal Start Equation
The following equation calculates the optimal start time:
2

[(Heating or Cooling Constant/100) x Temperature Difference ] + Heating or Cooling Deadtime =
Optimal Start Time
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Table 307: Optimal Start Equation
Variable

Description

Heating or Cooling
Constant

This variable is the value of the Heating or Cooling Constant attribute of
the OST object and represents the rate of warmup or cooldown in the zone
after equipment startup. If Adaptation Enabled is Yes, the Optimal Start
object learns each day and sets a new value. This variable can be edited by
the user.

Temperature
Difference

This variable is the difference between the Zone Temperature and the value
of the Heating Setpoint or Cooling Setpoint attribute before the warmup or
cooldown period.
Units = delta deg F or delta deg K

Heating or Cooling
Deadtime

This variable is the value of the Heating or Cooling Deadtime attribute of
the OST object and is the amount of time required to raise or lower the
Zone Temperature 1.0 degree.
Units = minutes. If Adaptation Enabled is Yes, the Optimal Start object
learns each day and sets a new value. This variable can be edited by the
user.

Optimal Start Example
For an example of the optimal start process, assume:
•

The Zone Occ Mode Obj is scheduled to be occupied at 7:00 A.M. and unoccupied at 5:00 P.M.

•

Zone Temperature = 55˚F before the warmup period

•

Heating Setpoint (since in Heating mode) = 70˚F

•

Heating Deadpoint (since in Heating mode) = 5 minutes

•

Heating Constant (since in Heating mode) = 10 (The optimal start process has run for several
days, and the Heating Constant has been adjusted to 10 based on past performance.)

• Temperature Difference = 70˚F - 55˚F = 15˚F
Therefore:
2

Optimal Start Time = [(10/100) x 15 ] + 5
2

= (0.1 x 15 ) + 5
= (0.1 x 225) + 5
= 22.5 + 5
= 27.5
= 28 minutes
The optimal start process turns on the Zone WC Mode Obj at 6:32 A.M. (28 minutes prior to the
scheduled 7:00 A.M. start time.)

Adaptation
Each day, at occupancy, the optimal start process adapts the Heating or Cooling Constant. It
checks the Zone Temperature at occupancy time. If the Zone Temperature did not reach a value
within the range defined by the Temp Differential and the Heating Setpoint or Cooling Setpoint
before the occupancy time, the Heating Constant or Cooling Constant is increased. This increase
moves the optimal start time closer to the earliest start time defined in the OST object. If the Zone
Temperature reached a value within the range defined by Temperature Differential and the Heating
Setpoint or Cooling Setpoint prior to occupancy, the Heating Constant or Cooling Constant is
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decreased. This decrease moves the optimal start time closer to the occupancy start time defined in
the Schedule Object.

Optimal Stop
The goal of optimal stop is to set the zone to the unoccupied mode prior to actual zone vacancy.
The OST must do this while the zone is still occupied, without causing comfort level alarms. The
Optimal Start object calculates the number of minutes before the zone is scheduled to change
from occupied to unoccupied. The OST then uses the same equation (Optimal Start Equation) for
deriving the optimal start time to determine the earliest stop time, except for two differences:
•

To ensure occupancy comfort, the OST sets the Temperature Difference factor to the Temp
Differential attribute.

•

The Deadtime is set to 0.
2

(Heating or Cooling Constant/100) x (Temperature Difference) + Heating or Cooling Deadtime
(always = 0) = Optimal Stop Time

Object Interaction
Different objects interact in an Optimal Start application. The following figure illustrates a sample
Optimal Start application. The table describes the objects and their role in an Optimal Start
application.
Figure 58: Optimal Start Object Interaction

Table 308: Optimal Start Application Object Interaction
#

Object or
Attribute

Role

1

Optimal Start
(OST) Object

Receives temperature, setpoint, and scheduling data to determine
optimal start and optimal stop times for the building zone.

2

Schedule Object Provides occupied and unoccupied times for the building zone.

3

Zone Occupancy Refers to the binary or multi-state output and value objects that
Mode
command a zone to occupied or unoccupied. It is commanded by the
Schedule object to occupied and by the Optimal Start to unoccupied,
possibly earlier than scheduled if the Maximum Prestop Time attribute
is non-zero.
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Table 308: Optimal Start Application Object Interaction
#

Object or
Attribute

Role

4

Zone Warmup
or Cooldown
Mode

Refers to the binary or multi-state output and value objects that
command the zone to warm up or cool down. It is commanded by
the Optimal Start object at the optimal start time and released at the
occupied time. It will not be released if the Zone Warmup or Cooldown
(WC) Mode and the Zone Occupancy Mode objects are the same.

5-8

Zone
Temperature,
Cooling
Setpoint,
Heating
Setpoint,
Outdoor Air
Temperature

Refers to the analog attributes (within Analog Input objects, Analog
Value objects, for example) that are referenced by the Optimal
Start object and provide the temperatures and setpoints for use in
calculations.

Object/Attribute Involvement
Building an Optimal Start application means that the OST object and its associated Schedule object
must have their attributes configured to reference the appropriate objects in order to achieve the
desired operation. The following table lists the objects and attributes involved and guidelines for
data entry.
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Table 309: Optimal Start Object/Attribute Involvement
Object Type/ Function
Optimal Start Object

Attributes Involved
Zone Schedule Object

Zone Occ Mode Obj

Zone WC Mode Obj

Data Entry Guidelines
Enter the Object Name of the Schedule object that schedules
occupied and unoccupied times for the binary object
controlling the zone occupancy mode of the heating and
cooling equipment for the zone.
This object must be defined in the schedule and have valid
start and stop times for the current day for the Optimal
Start object to run. Only one start time and stop time can be
defined per day, and the start time must precede the stop
time.
Enter the Object Name of the binary object controlling the
occupancy mode of the heating and cooling equipment for
the zone.
Enter the Object Name of the binary (BO, BV) or multi-state
(MO, MV) object controlling the warmup and cooldown mode
of the heating and cooling equipment for the zone. This can
be the same object as the Zone Occ Mode Object.
Note: If the Zone Occ Mode Obj and the Warmup/
Cooldown Mode Obj are the same point, then the point
is commanded by the Scheduling at the scheduled
time.

Cooling Setpoint
Heating Setpoint
Zone Temperature
Outdoor Air Temp

Enter the Object/Attribute Name of the analog value that
represents the cooling setpoint.
Enter the Object/Attribute Name of the analog value that
represents the heating setpoint.
Enter the Object/Attribute Name of the analog value that
represents the temperature in the zone being controlled.
Enter the Object/Attribute Name of the analog value that
represents the outdoor air temperature.
If this attribute is not defined, or the referenced analog
attribute is offline, the outdoor air temperature is assumed
to be within the design temperatures limits for the OST
calculations.
If an analog attribute reference is defined for the outdoor air
temperature, its value determines if the Optimal Start object
should adapt heating and cooling constants and deadtimes.
If its value is outside the design temperature limits, deadtime
and constant calculations are skipped.
If its value is outside the design temperatures before the
warmup or cooldown period, the optimal start time is set to
the maximum prestart time.
If its value is outside the design temperatures before the
unoccupied period, Prestop does not occur.

Schedule Object

List of Object Property
References

Enter the Object Name of the binary object controlling the
occupancy mode of the heating and cooling equipment for
the zone as one of the Property References.

Optimal Start Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, R - Affected by Extension’s Reliability, W - Writable.
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Values/Options/
Range

Adaption Enabled

C,W

True

Indicates whether OST uses adaptive learning
to change the building heating and cooling
constants and heating and cooling deadtimes.
Indicates the last calculated prestart date. This
value is updated each time the optimal start
time is calculated (between early start time and
optimal start time).
Indicates the last calculated prestart time. This
value is updated each time the optimal start
time is calculated (between early start time and
optimal start time).
Indicates the last calculated prestop date. This
value is updated each time the optimal stop
time is calculated (between early stop time and
optimal stop time).
Indicates the last calculated prestop time. This
value is updated each time the optimal stop
time is calculated (between early stop time
and optimal stop time). If Max Prestop Time is
zero, the value of this attribute is equal to the
unoccupied time.
Set redirected to
Specifies the command sent to the Zone WC
ZWC States Text;
Mode Obj point at prestart time when in cooling
Number of States mode. The enumeration set and number of
redirected to ZWC states for this attribute are redirected and
Nbr States
filled in at runtime from the Zone WC Mode
Obj point. The default value is set to a value of
Only available in
1 upon creation so the attribute requires no
the online UI
configuration.
1–999
Defines the rate at which the zone cools down
after equipment startup. If adaptation is
enabled, this constant is adapted without user
intervention. If adapting and the OST object
Cooling Setpoint and Heating Setpoint attributes
reference the same object on a field controller,
then the cooling constant is adapted even if the
mode is not cooling, meaning both constants
change.
1–480
Indicates the time required after startup to lower
the temperature by one degree. This value is
Units = Minutes
adapted by the OST algorithm, if adaptation
is enabled. If adapting, cooling, and heating
setpoints are the same attribute, the Cooling
Deadtime is adapted even if the mode is not
cooling, meaning both deadtimes change.

Calc Prestart Date

Cal Prestart Time

Calc Prestop Date

Calc Prestop Time

CoolDown Command W

1

Cooling Constant

C,W

75.0

Cooling Dead Time

C,W

10 minutes

Cooling Design Temp C,W

Cooling Setpoint
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C,W

35.0 deg C or
95.0 deg F

Description

-20 to 120

Indicates the highest outside temperature
at which the cooling system maintains zone
Units =
Temperature Units comfort in the cooling mode.
Identifies the attribute of an object used
to define the zone occupied target cooling
temperature. This attribute may be the same as
the Heating Setpoint attribute.
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Cooling Stpt Status

Values/Options/
Range
Offline = 0

Description

Identifies the OST object’s connection status
to the Cooling Setpoint attribute. If this status
Uses Offline Online is Offline, the Present Value is set to Not
Operational.
(Set 91).
Online = 1

– Offline: Cooling Setpoint attribute is offline.

Display Precision

C,W

0.1

Heating Constant

C,W

75.0

Heating Deadtime

C,W

10 minutes

Heating Design Temp C,W

Heating Setpoint

-20.6 deg C or
-5.0 deg F

C,W

Heating Stpt Status

– Online: Cooling Setpoint attribute is online.
Indicates the rounded position and decimal
places to display for this object.
Defines the rate at which the zone heats up after
equipment startup. If adaptation is enabled, this
constant is adapted without user intervention.
If adapting and the OST object Cooling Setpoint
and Heating Setpoint attributes reference
the same object on a field controller, then the
heating constant is adapted even if the mode is
not heating, meaning both constants change.
1–480
Indicates the time required after startup to raise
the temperature by one degree. This value is
Units = Minutes
adapted by the OST algorithm, if adaptation
is enabled. If adapting, cooling, and heating
setpoints are the same attribute, the Heating
Deadtime is adapted even if the mode is not
heating, meaning both deadtimes change.
-35 to 90
Indicates the lowest outside temperature at
which the heating system maintains zone
Units =
Temperature Units comfort in the heating mode.
Identifies the attribute of an object used
to define the zone occupied target heating
temperature. This attribute may be the same as
the Cooling Setpoint attribute.
Offline = 0
Identifies the OST object’s connection status
to the Heating Setpoint attribute. If this status
Online = 1
is Offline, the Present Value is set to Not
Operational.
Uses Display
Precision (Set 0).
1–999

– Offline: Heating Setpoint attribute is offline.
Max Prestart Time

C,W

120 minutes

5–480
Units = Minutes

Max Prestop Time

C,W

0 minutes

0–60
Units = Minutes

Min Prestart Time

C,W

20 minutes

0–240
Units = Minutes
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– Online: Heating Setpoint attribute is online.
Indicates the maximum period of time required
to bring the zone up to occupancy setpoint
temperature under the worst conditions (earliest
optimal start time).
Indicates the maximum period of time that the
heating/cooling system can be shut down and
still maintain the occupied zone temperature
until entering the unoccupied mode (earliest
optimal stop time). By setting this time to zero
(the default value), optimal stop is disabled.
Indicates the minimum period of time before
occupancy to start the heating/cooling system.
This time allows for the required amount of air
changes in the zone prior to occupancy (latest
optimal start time).
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

OST Type

C,W

Initial Value

Values/Options/
Range
Heating/Cooling Heating and
Cooling = 0
Heating Only = 1
Cooling Only = 2

Outdoor Air Temp

Description
Defines the OST supported configuration. When
the zone is in a mode not supported by the OST
object, the Present Value is idle. OST-supported
modes include:

Uses OST Type (Set – Heating and Cooling
– Heating Only
126).
– Cooling Only
Identifies the attribute of an object used to
determine the outdoor temperature:

C,N,W

– If this attribute is not defined, or is offline, the
outdoor air temperature is not used in the OST
calculations and is assumed to be within the
design temperatures.
– If an Analog attribute reference is defined
for the outdoor air temperature, it aids in
determining if the Optimal Start object should
adapt constants and deadtimes.
– If the attribute is defined and outside the
design temperatures, deadtime and constant
calculations are skipped.
– If the attribute is defined and is outside the
design temperatures during Prestart, the
optimal start time is set to early start time.
– If the attribute is defined and outside the
design temperatures during Prestop, do not
Prestop.
Present Value

D

Idle

Idle = 0

Represents the current value of the object:

Prestart Heating = – Idle: Waiting for next occupied time for a
1
supported mode (heating or cooling).
Prestart Cooling = – Prestart Heating: Heating optimal start time is
2
pending.
Calculating
Deadtime = 3

– Prestart Cooling: Cooling optimal start time is
pending.

Calculating
Constant = 4

– Calculating Deadtime: Valid only if Adaptation
Enabled.

Occupied = 5

– Calculating Constant: Valid only if Adaptation
Enabled.

Prestop = 6

Not Operational = – Occupied
7
– Prestop: Waiting to reach optimal stop time. If
Max Prestop Time = 0, then mode is Occupied,
Uses OST State
not Prestop.
(Set 125).

– Not Operational: Optimal Start object is not
operational due to errors in its connection status
to other required objects. The specific problem
can be determined by viewing the other status
attributes. The Optimal Start object could also
be Not Operational (or Unreliable) if the Zone
Occ Mode Obj is in the schedule but there are
no valid start and stop times for that day (due to
holiday or schedule offline, for example).
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Prestart Cooling
Command

W

1

Prestart Heating
Command

W

1

Prestop Command

W

0

Relative Temp Units

C

Relative deg F

Reliability

Schedule Occupied
Command

Reliable

W

1

Schedule Unoccupied W
Command

0

Send OK

Metasys Site Management Portal Help

Values/Options/ Description
Range
Set redirected to
Specifies the command sent to the Zone Occ
zone occupied
Mode Obj point at prestart time when in cooling
mode (ZOM) States mode. The enumeration set and number of
Text; Number of
states for this attribute are redirected and
States redirected filled in at runtime from the Zone Occ Mode
to ZOM Nbr States Obj point. The default value is set to a value of
1 upon creation so the attribute requires no
Only available in
configuration.
the online UI
Set redirected to
ZOM States Text;
Number of States
redirected to ZOM
Nbr States

Specifies the command sent to the Zone Occ
Mode Obj point at prestart time when in heating
mode. The enumeration set and number of
states for this attribute are redirected and
filled in at runtime from the Zone Occ Mode
Obj point. The default value is set to a value of
Only available in
1 upon creation so the attribute requires no
the online UI
configuration.
Set redirected to
Specifies the command sent to the Zone
ZOM States Text; Occ Mode Obj point at prestop time. The
Number of States enumeration set and number of states for this
redirected to ZOM attribute are redirected and filled in at runtime
Nbr States
from the Zone Occ Mode Obj point. The default
value is set to a value of 0 upon creation so the
Only available in
attribute requires no configuration.
the online UI
Uses Unit Set (Set Specifies the units associated with the Temp
869).
Differential attribute.
Uses Reliability (Set Indicates if a value is questionable due to
503).
operational errors in the Optimal Start object’s
connection status to other required objects.
Without a valid start and stop time for the
current day (due to holiday or schedule offline,
for example), the value is also Unreliable.
Set redirected to
Specifies the command sent to the Zone
ZOM States Text; Schedule Obj point at prestart time when in
Number of States occupied mode. The enumeration set and
redirected to ZOM number of states for this attribute are redirected
Nbr States
and filled in at runtime from the Zone Schedule
Obj point. The default value is set to a value of
Only available in
1 upon creation so the attribute requires no
the online UI
configuration.
Set redirected to
Specifies the command sent to the Zone
ZOM States Text; Schedule Obj point at prestart time when in
Number of States unoccupied mode. The enumeration set and
redirected to ZOM number of states for this attribute are redirected
Nbr States
and filled in at runtime from the Zone Schedule
Obj point. The default value is set to a value of
Only available in
0 upon creation so the attribute requires no
the online UI
configuration.
Indicates if the status of the last command was
sent to the Zone WC Mode Obj, Zone Occ Mode
Obj, or Zone Schedule Obj.
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Values/Options/
Range

Stpt Reached Time

Temp Differential

C,W

Temperature Units

C

Warmup Command

W

3.0 delta deg F or 0–10
1.67 delta K
Units = Relative
Temp Units
Deg F
Uses Unit Set (Set
869).
1
Set redirected to
ZWC States Text;
Number of States
redirected to ZWC
Nbr States
Only available in
the online UI

Zone Occ Mode Obj

C,W

Zone Occ Time
Zone Schedule Obj

C,W

Zone Schedule Status

Offline = 0
Online = 1

Description
Indicates the time at which the zone
temperature was equal to (within differential)
the zone setpoint. This point is set between the
optimal start time and occupied. If this point is
not reached during that time, then it continues
to be monitored during the occupied time until
the zone temperature reaches the setpoint.
Indicates the value added and subtracted to the
zone setpoint to define a temperature range.
Indicates the units associated with the attributes
for temperatures.
Specifies the command sent to the Zone WC
Mode Obj point at prestart time when in heating
mode. The enumeration set and number of
states for this attribute are redirected and
filled in at runtime from the Zone WC Mode
Obj point. The default value is set to a value of
1 upon creation so the attribute requires no
configuration.
Identifies the object used to command a zone
to occupied or unoccupied. This object must
be specified in the Zone Schedule Obj. This is
commanded by scheduling to occupied and by
OST if prestop is enabled.
If the Zone Occ Mode Obj and the Warmup/
Cooldown Mode Obj are the same point, then
the point is commanded by Scheduling at the
scheduled time.
Indicates the scheduled zone occupied time,
obtained from the Zone Schedule Obj.
Identifies the Schedule object, which schedules
the Zone Occ Mode Obj. This object must be
defined in the schedule and have valid start and
stop times for the current day in order for OST to
run. Otherwise, the OST object’s Present Value
is Not Operational. Only one Start and Stop time
can be defined per day, and the Start time must
precede the Stop time. The Start time must be
defined as binary State ON (1) and Stop time
must be defined as binary State OFF (0).
Identifies the OST object’s connection status to
the Zone Schedule Obj. If this status is Offline,
the Present Value is set to Not Operational.
– Offline: Zone Schedule Obj is offline
– Online: Zone Schedule Obj is online.

Zone Temperature

C,W

Zone Temp At Start

N
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Identifies the attribute of an object used to
determine the zone temperature.
Specifies the zone temperature at the last
optimal start time.
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Table 310: Optimal Start Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Zone Temp Status

Values/Options/
Range
Offline = 0
Online = 1

Description
Identifies the OST object’s connection status
to the Zone Temperature attribute. If this
status is Offline, the Present Value is set to Not
Operational.
– Offline: Zone Temp attribute is offline.

– Online: Zone Temp attribute is online.
Indicates the scheduled zone unoccupied
(vacancy) time, obtained from the Zone Schedule
Obj.
Must be defined as Identifies the object used to command a zone to
an N2 BO, BV, MO, Warmup or Cooldown mode. This object may be
or MV object.
the same as the Zone Occ Mode Obj. This object
is commanded by the OST at the optimal start
time. This object is released at the occupied time
unless this object is also the value for the Zone
Occ Mode Obj.

Zone Unocc Time

Zone WC Mode Obj

C,W

Optimal Start Commands
The table below lists the commands supported by the Optimal Start Object.
Table 311: Optimal Start Object Commands
Command Name

Parameters

Command Description

Cancel Prestart

None

Delays pending start until latest prestart time. Only
valid during Prestart and before the optimal start time.

Cancel Prestop

None

Cancels the pending stop. Only valid during Prestop
and before the optimal stop time.

Disable

None

Prevents the object’s functionality; no calculations take
place.

Enable

None

Allows the object to perform its calculations once a
minute.

Optimal Start Steps
Building an Optimal Start Application
About this task:
To build an Optimal Start application:
1.

2.
3.
4.

Add the N2 Controller object and the analog and binary objects required for the OST
application to the database. See the Object Help section for information on objects and
the Related Documentation table in the Welcome section for information on the SCT. See
Creating Items with Wizards for information on creating objects and other items.
Add the Schedule Object (see Scheduling), referencing the binary object controlling Zone
Occupancy Mode.
Make sure valid occupied and unoccupied times are entered into the Schedule object.
Add the Optimal Start Object referencing the above Schedule object, the Binary objects
designated as Zone Occupancy Mode and Zone Warmup or Cooldown Mode, and the analog
attributes of objects designated as temperatures and setpoints.

Result
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Note: See the Site Management Portal User Interface section for information on creating,
editing, commanding, and deleting objects. See the Scheduling section for information on
scheduling.

Optimal Start Troubleshooting
Table 312: Optimal Start Application Troubleshooting
Problem

Solution

Present Value of the Optimal The Optimal Start object’s Present Value attribute may indicate
Start Object indicates Not
Not Operational because of errors in its connection status to other
Operational
required objects.
To verify the Optimal Start object’s connection status to other
required objects:

Optimal Start Object is not
adapting Constants and
Deadtimes

•

Verify that the required Schedule object, binary objects, and
analog objects are all defined and online.

•

Verify that the binary object controlling Zone Occupancy Mode
is in the List of Prop Refs for the Schedule Object.

•

Verify that valid occupied and unoccupied times for the current
day are defined in the Schedule object.

To ensure the Optimal Start object is adapting constants and
deadtimes:
•

Verify that the Adaptation Enabled attribute indicates True.

•

Verify that the value of the Zone Temperature attribute is not
within the value of the Temp Differential attribute relative to
the Heating or Cooling Setpoint (plus or minus one degree)
before the warmup or cooldown period.

•

Verify that the value of the Outdoor Air Temp attribute is
within the values of the Cooling Design Temp and Heating
Design Temp attributes.

Pulse Meter Object
Menu Selection: Insert > Object > Pulse Meter
The Pulse Meter object accumulates the differences between consecutive reads of the integer value
provided by an Accumulator Object or Counter Input Object (defined by CCT), and calculates the
rate of change between each reading of the value. This object also totals the counted pulses and
converts them into units of consumption.
The Pulse Meter object must reference a counter/accumulator object to access the counter value
that resides in the counter/accumulator hardware device (which is hardwired to the pulse input).
The counter/accumulator object is hardware specific, while the Pulse Meter object is hardware
independent.
Multiple Pulse Meter objects may share the same counter/accumulator object, and must reside on
the same device as the counter/accumulator hardware device.
Note: The Pulse Meter object only handles counters that count forward.
Each Pulse Meter object may have different purposes, such as one calculates the rate over a 60second period, while others calculate the rate over a 5-minute period. For example, some Pulse
Meters are supposed to run only during certain times of the day.
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Pulse Meter Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R Affected by Extension’s Reliability, W - Writable.
Table 313: Pulse Meter Object Attributes - Focus/Configuration Tab
Attribute Name
Calculation

Notes

Initial Value
0

Consump Unreliable

W

False

Values/Options/Range
0–4,294,967,295

Attribute Description
Increases by one each time the Pulse
Meter object executes its main routine
until it rolls over and starts again with
zero.
Indicates that the Consumption
attribute may contain unreliable data.
The following conditions can set the
Consump Unreliable attribute to True:
– If the calculated rate is too high,
which happens if the Rate Limit is
exceeded.
– If the Pulse Meter object is disabled.

Consumption

W

0

Consumption Units

C,W

kWh

Counter Object

C,W

Display Precision

C,W

10ths

Execution Trigger

W

False

Meter Active

C,W

True

Present Value

D,R

Previous Consumption W

0

Pulse Consumption

C,W

1.000000

C,W

3600.000000

Pulse Count

Rate Constant
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– If the value of the Accumulator
object is unreliable.
Units = Consumption Units Indicates the consumption since the
last reset of the Pulse Meter object.
Uses Unit Set (Set 869).
Indicates the measurement units for
all consumption attributes.
Specifies the associated Accumulator
Object or Counter Input Object
(defined by CCT).
Specifies the rounded position and
decimal places to display for this
object’s analog values.
When written to True, the execution
function runs.
True, False
Specifies whether the pulse meter
object currently should be metering.
Units = Rate Units
Represents the currently calculated
rate of consumption.
Units = Consumption Units Indicates the last value of
Consumption before the last reset.
Units = Consumption Units Specifies the physical quantity that
each single pulse represents.
0–4,294,967,295
Indicates the pulse counter value as
last reported from the Counter Input
Object (define by CCT), or the last
Present Value of the Accumulator
Object.
Specifies the value multiplied by the
Consumption Units to get the Present
Value units to match Rate Units.
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Table 313: Pulse Meter Object Attributes - Focus/Configuration Tab
Attribute Name
Rate Default

Notes
C,W

Initial Value
0.0

Values/Options/Range
> = 0, Units = Rate Units

Rate Limit

C,W

3.402823466

> = 0, Units = Rate Units

C,W

E38
kW

Uses Unit Set (Set 869).

Rate Units
Rate Unreliable

False

Reliability

Reliable

Uses Reliability (Set 503).

False

True while reset in
progress

Reset

W

Reset Date

W

Reset Time

W

Rollover Limit

C,W

32767

0–4,294,967,295

Sample Time

C,W

60

Units = seconds, Value > 9

Attribute Description
Specifies the value of Present Value
when the calculated rate exceeds the
Rate Limit.
Specifies the highest allowed Present
Value before using Rate Default.
Indicates the measurement units for
all rate attributes.
Indicates that the Present Value is
unreliable because of a misreading of
a counter.
Indicates if a value is questionable.
When written to True, it transfers the
current value of the Consumption
attribute into the Previous
Consumption attribute before
resetting Consumption to zero.
Indicates the date of the last resetting
of Consumption attribute.
Indicates the time of the last resetting
of Consumption attribute.
Specifies the highest counter value
before the pulse counter rolls over to
zero. This value must match that of
the counter, or the Max Value of the
Accumulator.
Specifies the period of automatic
executions of the algorithm in
seconds.

Pulse Meter Commands
The table below lists the commands supported by the Pulse Meter Object.
Table 314: Pulse Meter Object Commands
Command Name

Parameters

Command Description

Enable

None

Enables the calculation of the pulse count and
consumption for the Pulse Meter object.

Disable

None

Disables the calculation of the pulse count and
consumption for the Pulse Meter object.

Reset

None

Resets the Pulse Meter, including the Consumption
attribute.

Start Meter

None

Resumes metering.

Stop Meter

None

Stops metering.

Signal Select Object
Menu Selection: Insert > Object > Signal Select
The Signal Select object can process values from multiple zones to adjust various setpoints and can
function with either analog or binary points.
For analog point types, the Signal Select object determines (one or more of) the low input, average
input, and/or high input values for use in updating an attribute value of another object.
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For binary point types, the Signal Select object determines (one or more of) the average state,
the logical Or state, and/or the logical And state values for use in updating an attribute value of
another object.
Computations take place at startup and at each time an input value experiences a change in value
or reliability. The results of these calculations are sent to specified output points as commands. For
example, this object allows you to average multiple zone temperatures and base a control, such as
adjusting a setpoint, on that average.

Signal Select Concepts
Average Output Computation
In the case of binary types of input references, if the majority of inputs are at State 1 or the inputs
are evenly split between State 1 and State 0, the Average output is commanded to State 1. If the
majority of inputs are at State 0, the Average output is commanded to State 0.

Logical OR Computation
If any input is at State 1, the OR output is commanded to State 1. If all inputs are at State 0, the OR
output is commanded to State 0.

Logical AND Computation
If all inputs are at State 1, the AND output is commanded to State 1. If any input is at State 0, the
AND output is commanded to State 0.

Signal Select Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, N - Value Not Required, W - Writable.
Table 315: Signal Select Object Attributes - Focus/Configuration Tab
Attribute Name

Notes

Initial Value

Average Output

C,N,W

None

Execution Priority

C,W

Normal

Failsoft

C,W

High OR

C,N,W

None
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Values/Options/Range

Description
Specifies the object attribute whose
value is updated using the calculated
average of all of the inputs of the
Signal Select Object.
Indicates the relative importance of
performing the function of the object
within the device.
Routes to all the outputs if Setup is
configured as Fail Soft. Fail Soft routes
when the object becomes unreliable
and when the output transitions from
Reliable to Unreliable.
Specifies the object attribute whose
value is updated using the highest
input of all the inputs in the Signal
Select object, for analog point types.
For binary point types, the value is
updated using a logical OR condition of
all inputs of the Signal Select object.
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Table 315: Signal Select Object Attributes - Focus/Configuration Tab
Attribute Name
Input List

Notes
C,W

Initial Value

Values/Options/Range
Minimum number of
elements in the list =1,
Maximum number of
elements in the list = 12

Low AND

C,N,W

None

Point Type

C,W

Analog

Analog or Binary

Present Value

W

Master

N=3
0 = Calculated, 1 = Last
Reliable, 2 = Fail Soft
Reliable or Input
Unreliable

Reliability

Setup

W

Last Reliable

n=2
0 = Last Reliable, 1 = Fail
Soft

Description
Contains the list of attribute references
used in the Signal Select calculations.
An analog type defined as a binary
input is converted to a binary value
prior to each computation, and a
binary value is converted to a binary
input.
Object attribute whose value is
updated using the lowest input of all
the inputs in the Signal Select object,
for analog point types. For binary point
types, the value is updated using a
logical AND condition of all inputs of
the Signal Select object.
Specifies the type of input values
monitored by the Signal Select object,
the calculations it performs, and the
outputs it produces. Point type can be
analog or binary.
Indicates the current value of the
signal select object.
Indicates a value of Unreliable only if
all of the configured inputs in question
are unreliable.
Indicates the current setup value of the
signal select object.

Signal Select Commands
The table below lists the commands supported by the Signal Select Object.
Table 316: Signal Select Object Commands
Command Name

Parameters

Description

Disable

None

Locks out all outputs and prevents the
Signal Select functionality.

Enable

None

Ensures object reacts to any changes it
may have missed while it was disabled
and returns it to normal operation.

Solar Clock Object
Menu Selection: Insert > Object > Solar Clock
The solar clock object computes Present Value (Night/Day), Sun Position (Azimuth and Elevation),
and Sunrise and Sunset times based on the local position (Latitude and Longitude) and local time
and time zone information. This information is needed to control external motorized louvers as part
of bioclimatic facades for buildings and may also be used to position tracking photovoltaic solar
arrays. The Sunrise/Sunset times can be used for external lighting control.
This object runs on a periodic basis to compute its attributes. The equations to compute azimuth,
elevation, sunrise, and sunset attributes were obtained from the National Oceanic and Atmospheric
Administration (NOAA) Web site (http://www.noaa.gov/). The object obtains the Local Time, UTC
Offset, DST Status, and DST Offset from the BACnet Device object.
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Latitude and Longitude for this object are provided in decimal degrees. Often, these values are
provided as degrees, minutes, and seconds. There are numerous Web sites that can convert the
latitude and longitude values, if necessary. In addition, you can obtain your current location on
the planet from free tools such as Google Earth. Google Earth includes an option to provide your
location in decimal degrees.
Note: For correct sunrise and sunset calculations, you must apply north/south and east/west
rules. North latitudes are preceded by a plus, South latitudes are preceded by a minus. West
Longitudes are preceded by a minus, East Longitudes are preceded by a plus. See Table 317.
Table 317: Latitude and Longitude Examples
Location

Landmark

Latitude

Longitude

Milwaukee, WI, USA

Brengel Technology Center

43.037507

-87.904456

Paris, France

Notre Dame Cathedral

48.854212

2.347641

Cape Town, South
Africa

Green Point Stadium

-34.903488

18.411073

Sydney, Australia

Opera House

-33.857184

151.215176

Beijing, China

Tiananmen Square

39.06514

116.391213

For general information on Metasys system objects, see Common Object Attributes.

Solar Clock Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Note: For correct sunrise and sunset calculations, you must apply north/south and east/west
rules. North latitudes are preceded by a plus, South latitudes are preceded by a minus. West
Longitudes are preceded by a minus, East Longitudes are preceded by a plus. See Table 317.
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: A - Archive, C - Configurable, W - Writable.
Table 318: Solar Clock Object Attributes - Focus/Configuration Tab
Attribute Name
Present Value

Notes

Initial Value

Values/Options/Range
1 = Day
0 = Night

Latitude

W,C,A

Units = Degrees Angular
Range = -90–90

Longitude

W,C,A

Units = Degrees Angular
Range = -180–180
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Description
Represents an Enumeration value
that is true when the current time
is between the computed time of
Sunrise and Sunset, where 1 = Day
and 0 = Night.
Defines the angular distance, in
decimal degrees, of the current
location north or south of the
equator. Lines of latitude are also
known as parallels. The International
standard defines north latitudes as
positive values.
Defines the angular distance, in
decimal degrees, of the current
location east or west of the Prime
Meridian. Lines of longitude are
also known as meridians. The
International standard defines east
longitude as positive values.
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Table 318: Solar Clock Object Attributes - Focus/Configuration Tab
Attribute Name
Periodic Update

Notes
W,C,A

Initial Value
5

Values/Options/Range
Units = Minute
Range = 2–60

Azimuth

Units = Degrees Angular

Elevation

Units = Degrees Angular

Sunrise

Display = HH:MM

Solar Noon

Display = HH:MM

Sunset

Display = HH:MM

Offset

W,A

Units = Minutes
Range = -60–60
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Description
Determines how often sun position
and Present Value attributes update
during normal operation. The default
value is 5 minutes.
Defines the angular measurement in
a spherical coordinate system. The
vector from an observer (origin) to
a point of interest (sun) is projected
perpendicularly onto a reference
plane; the angle between the
projected vector and the reference
vector on the reference plane is
called the azimuth. It is defined as the
angle from due north in a clockwise
direction.
Defines the angle between the
direction of the geometric center
of the sun's apparent disk and the
idealized horizon.
Defines the time of apparent sunrise
in hours and minutes. Sunrise may
not occur in the same calendar day
as sunset. Due to changes in air
pressure, relative humidity, and other
factors, we cannot predict the exact
effects of atmospheric refraction on
sunrise time. The error may increase
with higher latitudes (closer to the
poles).
Defines the time when the sun
crosses the meridian of the
observer's location. At solar noon, a
shadow cast by a vertical pole points
either directly north or directly south,
depending on the observer's latitude
and the time of year.
Defines the time of apparent sunset
in hours and minutes. Sunset may
not occur in the same calendar day
as sunrise. Due to changes in air
pressure, relative humidity, and other
factors, we cannot predict the exact
effects of atmospheric refraction on
sunset time. The error may increase
with higher latitudes (closer to the
poles).
Defines an offset to the computed
Sunrise and Sunset times. The offset
value is used to compute Present
Value. A positive value makes the day
longer and a negative value makes
the day shorter.
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Table 318: Solar Clock Object Attributes - Focus/Configuration Tab
Attribute Name
Equation of Time

Notes

Initial Value

Solcar Declination

Values/Options/Range
Units = Minutes

Units = Degrees

Description
Represents an astronomical term
accounting for changes in the time of
solar noon for a given location over
the course of a year. Earth's elliptical
orbit and Kepler's law of equal areas
in equal times are the factors behind
this phenomenon.
Defines the declination of the Sun.
The declination varies from 23.44° at
the winter solstice in the northern
hemisphere, through 0° at the vernal
equinox, to +23.44° at the summer
solstice. The variation in the solar
declination is the astronomical
description of the sun going south
in the northern hemisphere for the
winter. For a ground-based view of
the seasonal solar paths for different
latitudes, use 0° for the Equator, 23°N
for the Tropic of Cancer, 40°N for
Boulder, CO, 71°N for the Arctic Circle,
and 90° for the North Pole.

Solar Clock Object Commands
This object has no commands.
For managing outside lighting schedules, use the day/night present value status of this object with
an Interlock Object's definition to drive the Action Tables for the Actions of Conditions setup.

Trend Log Object
Menu Selection: Insert > Object > Trend Log
The Trend Log object monitors and records the changes in the behavior of an individual attribute
over time, thereby assisting you with diagnosing various system-wide behavioral characteristics.
For example, use a Trend Log to collect data from the Analog Input object of a field controller,
which reports information such as outdoor air temperature or room air temperature.
The trend log collects sample values at timed intervals or only upon changes in the given value.
Trend data is still collected if the object is unreliable. The trend log continues to log data using the
previous value preceded by ???, which indicates an unreliable status.
Note: When you create a Trend Log object at a network engine using a BACnet client, a folder
called Trend Log is created and a new Trend Log object is created under that folder in the
navigation tree.
You cannot define a Trend extension under the Trend Log object like you can with other objects. As
a requirement for adding a trend log object from the UI, you select an input reference, then enable
the trend log so that it can begin to collect samples.
Trend Log samples are stored locally with a default buffer size of 144 and a maximum of 5000
samples. Unlike a Trend extension on an object, repository storage is not available with the Trend
Log object. The intention is that data sampled by the trend log object is stored at the BACnet client.
For general information on Metasys system objects, see Common Object Attributes.
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Trend Log Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
The Trend Log object has the same list of attributes as a trend extension. For information about the
Trend tab of the Trend Log object, see Trend Extensions.
Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: A - Archive, C - Configurable, W - Writable.
Table 319: Trend Log Object Attributes - Focus/Configuration Tab
Attribute Name
Acked Transitions

Notes
C,W

Initial Value
False, False,
False

Buffer Size

C

144

Buffer State

Operational

Client COV
Increment

C,W

COV Resubsc
Interval

C,W

3,600

Enable

C,W

False

Event Enable

C,W

True, False
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Values/Options/Range Description
Conveys three separate flags that each indicate
if the most recent To Offnormal, To Fault,
or To Normal event transitions have been
acknowledged (if the transition requires
acknowledgement).
1–5,000
Specifies the maximum number of records the
buffer may hold.
Operational, Buffer Full Indicates whether the buffer is full or operational
when the Stop When Full attribute is set to False.
Specifies the increment used to determine that a
change of value occurred (when this Trend Log
object collects data by COV). If the referenced
object and attribute support COV reporting, then
this attribute may have a Null value. In this case,
the value of the trended object for COV increment
is used. This value only applies to trended values
of the real value (floating point) type.
Units = Seconds
Specifies the number of seconds between COV
resubscriptions (when this Trend Log object
collects data by COV). This attribute is only used
when the trended object is a BACnet Integration
point on the IP network. The Subscribe COV
requests specify twice during this interval for the
actual subscription. The first subscription is issued
when the Trend Log object begins operation or
when enabled.
Indicates and controls whether logging is enabled
(True or False).
Determines whether notifications are enabled
for To Fault and To Normal events. A To Normal
transition occurs when the value of the Records
Since Notify attribute is equal to or greater than
the value of the Notify Threshold attribute. A To
Fault transition occurs when an attempted COV
subscription fails. The To Normal transition must
be enabled and set by default. The Read and Write
methods ensure this value cannot be set to False.
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Table 319: Trend Log Object Attributes - Focus/Configuration Tab
Attribute Name
Event State

Notes

Initial Value

Event Time Stamps

Input Reference

C

Intrinsic Alarming
Defined

C,W

False

Last Notify Record

0

Logging Type

Polled

Log Interval

C,W

60,000
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Values/Options/Range Description
Normal, Fault
Determines whether an active event state is
associated with this extension. The value is set
to Normal when there is no intrinsic alarming
defined for this object. If intrinsic alarming is
enabled (Enable Intrinsic Alarms = True), then this
value is either Normal or Fault (problem occurred
with the object subscribing for Change of Value
[COV]s). This attribute appears on the view when
the site is defined as a BACnet site.
Conveys the times of the last event notifications
for To Offnormal, To Fault, and To Normal events.
Time stamps of type Time or Date have FF if no
event notification of that type has generated since
the object was created.
Defines the attribute of the object being sampled.
This attribute is used for consistent references to
an object or attribute. The Input Reference and
the name of the object and attribute you want to
trend must match exactly.
Enables (True) or disables (False) BACnet intrinsic
alarming for this object. When disabled, writing
to any of the intrinsic alarming attributes returns
a Write_Access_Denied error. When disabled,
reading the intrinsic alarming attributes returns
the default value of each attribute.
Indicates the sequence number associated
with the most recently collected record whose
collection triggered a notification (that is, it
caused the value of the Records Since Notify
attribute to be equal to or greater than the
value of the Notify Threshold attribute). If no
notification has occurred since logging began, the
value of this attribute is 0.
Polled, COV, Trigger
Specifies the method for which the referenced
property is logged (Polled, Change of Value [COV],
or Trigger).
Units = 100ths of a
Specifies the periodic time in seconds for which
second
the referenced property is logged.

531

Table 319: Trend Log Object Attributes - Focus/Configuration Tab
Attribute Name
Notification Class

Notes
C,W

Initial Value
1

Values/Options/Range Description
Specifies the notification class used for handling
and generating event notifications for this
object. Notification occurs based on the value
of the Records Since Notification attribute. The
Notification Class attribute implicitly refers to a
Notification Class object that has a Notification
Class property with the same value. If the class
number references a non-existent Notification
object, no Notification occurs.
When the Notification Class attribute is written
online, the Notification Object Reference
is updated to the Object Reference of the
Notification Class object with that instance
number, if found. If the Notification Class object
for a Johnson Controls proprietary object is not
found, the reference is left blank.
If both the Notification Object Reference and
the Notification Class attributes are written
simultaneously online (or both are configured
and downloaded), the Notification Class attribute
value is set to the value that was written to the
Notification Object Reference, and the Notification
Class value in the write message is ignored.

Notification Object C,W
Reference

Limited to Notification
Class on the same
device.

Notify Threshold

C,W

Notify Type

C,W

130 (90% of
Buffer Size)
Events

Record Count

C,D,W

0

0–5,000

Specifies the Notification Class object used to
route alarms for the object being configured
(through tree selection). When the Notification
Object Reference is written, the value of the
Notification Class attribute is updated to reflect
the referenced object’s instance number. The
value of the Notification Object Reference
attribute is restricted to Notification Class objects
on the same device as the alarming object.
Validation only occurs during a write, not during a
create (the download does not fail).
Indicates when notification occurs based on the
value of the Records Since Notification attribute.
Conveys if the notifications generated by the
object are Events or Alarms. This attribute is
required if the object supports intrinsic reporting.
Represents the number of samples recorded since
the creation of the trend extension or the last
time the buffer was cleared, when the Stop When
Full attribute is set to True.
Represents the position of the next sample
recorded, when the Stop When Full attribute is set
to False.
A value of zero for this attribute deletes all
records in the log buffer and resets the Total
Record Count to zero. If the buffer overflows, the
Record Count resets to zero.

Records Since
Notify
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0

Indicates the number of records collected since
the last notification occurred or since logging
began if no notification occurred.
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Table 319: Trend Log Object Attributes - Focus/Configuration Tab
Attribute Name
Reliability

Notes

Initial Value
Reliable

Sample Interval

C,W

600

Values/Options/Range Description
Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
trend extension monitoring the input becomes
unreliable.
0–604,800
Specifies the periodic time in seconds for
which the referenced property is logged. If this
Units = Seconds
attribute is zero, samples are recorded using COV
reporting.
If you want to take samples on a COV, set the
value of this attribute to 0 seconds.

Start Time

C,W

Status Flags

If you are not sampling on a COV, configure
the Sample Interval at 60 seconds or higher
to prevent loss of trend data and reduction in
performance of the network engine that receives
samples from the configured trend.
Specifies the time and date to enable logging
when the Enable attribute is set to True. If the
Start Time contains any wildcard values, then the
conditions to enable logging based on time are
ignored. When the Trend Log object is inactive
due to the current time being outside of the Start
Time or Stop Time, the Status attribute reflects
this state (assuming it is the highest priority
status). If you define a Stop Time that is before
the Start Time, the Trend Log object is disabled.
Indicates the general status of the object in
BACnet terms and contains four independent
states.
The four flags are:
In Alarm—False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is not
reliable; otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service—Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Stop Time

C,W
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Specifies the time and date to disable logging. If
the Stop Time contains any wildcard values, then
the conditions to disable logging based on time
are ignored. Logging is disabled if the Stop Time
is prior to the Start Time. When the Trend Log
object is inactive due to the current time being
outside of the Start Time or Stop Time, the Status
attribute reflects this state (assuming it is the
highest priority status). A change in the active/
inactive state due to the Start Time/Stop Time
value has no impact on the Enable attribute. If
the Trend Log object was disabled due to the Stop
Time, the Trend Log object attempts to send the
trend samples to the server. If you define a Stop
Time that is before the Start Time, the Trend Log
object is disabled.
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Table 319: Trend Log Object Attributes - Focus/Configuration Tab
Attribute Name
Stop When Full

Notes
C,W

Initial Value
False

Total Record Count

Trigger

C,W

Values/Options/Range Description
Specifies whether logging ceases when the buffer
is full. When set to True, logging ceases and all
accumulated samples remain in the buffer. When
set to False, new samples begin to replace old
samples.
Represents the total number of records collected
by the Trend Extension since creation. When the
value of Total Record Count reaches its maximum
possible value of 0XFFFFFFFF, the next value it
takes is zero. Once this value has wrapped to
zero, its semantic value (the total number of
records collected) is lost, but its use in generating
notifications remains.
Causes the collection of data when changed
from False to True, Enable is set to True, and the
trend is within the Start/Stop times. When data
collection completes, this attribute resets to False.
This attribute does not trigger Johnson Controls
COVs.

Trend Log Object Commands
The following table lists the commands supported by the Trend Log Object. Click the command
name for a description of the command.
Table 320: Trend Log Commands
Command Name

Parameters

Description

Clear

None

Clears all samples in the buffer.

Disable

None

Stops collection of samples.

Enable

None

Resumes collection of samples.

Execute

None

Takes a single sample.

Route

None

Performs no action because
you cannot route samples when
there is no capability to specify a
repository.

Object Help
The Object Help describes each object in the system, the attributes of the objects, and the
characteristics and functions of each attribute. The Object Help provides detailed information
to aid in creating objects, entering values for configuring attributes, understanding how to read
attributes, and defining the interaction between objects in regard to the attributes.

Object Help Concepts
Objects
Objects are self-contained functional items in the Metasys system that contain processes to
manage building automation system components. Objects appear as items in the Navigation Tree
that shows the hierarchical physical or logical relationship between the objects as created by the
user. These objects are generally referred to as items in the Metasys user interface.
Each object that exists in a system is based on a specific object type. There is an object type to
manage the functions of the site, object types to manage the operation of the various device types
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installed on the site, object types to manage the physical input/output points of each field device,
and others.
Examples: Site Object, Engine Device Object, Analog Input Object, Program (Control System) Object.
Objects communicate with the rest of the system and with the user through their attributes. The
object type defines the basic function of the object, but the actual behavior of each object also
depends on the values assigned to its configuration attributes and received by its input attributes
from other objects. The object writes its status conditions and the results of internal processes to its
output attributes.
When an object type has an equivalent BACnet Object Type, the attribute list includes the BACnet
Properties required by the BACnet protocol specification and some of the optional properties.
These objects may be accessed from a BACnet network. For detailed information on BACnet objects
and properties, refer to ANSI/ASHRAE Standard 135-2008 - A Data Communication Protocol for Building
Automation and Control Networks.

Object Extensions
Object extensions provide additional features to objects and include Alarm, Trend Log, Totalization
(Analog, Runtime, and Event), Load, Averaging, and Resource File. Object extensions do not appear
in the navigation tree. The attributes of Object Extensions are displayed under specific tabs when
viewing object details. You may define object extensions when the object is first created using the
configuration wizard or add them later.
For more information on extensions, see the Extensions section.

Attributes
Attributes contain data that an object exposes to the system. The data in some attributes is set by
the user or by other objects and features in the system and is used by the object to perform its
function. Other attributes contain data produced by the object itself. The Attribute table for each
object lists the characteristics of each attribute to help you configure the object.
There is a set of attributes common to many Metasys system objects. These attributes are
described in the Common Object Attributes section. Each object attribute section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to that object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of the object (for example, the Hardware and Options tab
appear on point objects and the Email tab appears on Engine and Server objects). The attributes
listed in the tables appear in alphabetical order.
The column headings in the Attribute table are defined as follows:
Attribute Name
Gives the name of the attribute as it appears on the user interface.
Example: High Limit
See the Status and Display Attribute Location topic.
Data Type
Lists the data type of the attribute value. The following table defines the various data types used in
the Metasys system.

Metasys Site Management Portal Help

535

Table 321: Data Types
Data Type

Formal Name

Definition

Attribute Reference

Attribute
Reference

Reference of an attribute from which data is read
or to which data is sent. The format is <Object
Reference.Attribute Name>

Date

Date

Day of week, day, month, year
Example: Wednesday, February 19, 2003

List

List

List of attributes or properties of other objects that is
created or used by a particular function of this object.

Number

Byte

Number from 0–255 with no decimal point. Allowable
range appears in column headed Values/Options/Range

Unsigned
Integer Short

Number from 0 to 65,535 with no decimal point. Allowable
range appear in column headed Values/Options/Range.

Unsigned Long

Number from 0 to 4,294,967,295 with no decimal point.
Allowable range appears in column headed Values/
Options/Range.

Signed Integer

Signed number that is also an integer with no decimal
point. The value may be positive or negative. Allowable
range appears in column headed Values/Options/Range.
Examples:
•

DLLR: Shed Pending, Shed Lost

•

Accumulator: Scale As Integer

Object Reference

Object
Reference

Item Reference of an object to which a command is sent

One State/Type/
Node from a Set

Enumeration

Discrete state/type/mode taken from a set of numbered
possible values and normally represented on the user
interface by text.

Real Value

Float

Number with a decimal point to show required precision
Example: 24.5

Set of Related
Values

Structure

A set of values of mixed data types representing one
physical entity

Series of True or
False States

Bit String

Series of true/false states that each have an independent
meaning but together define the overall state of an
attribute or object

Set of Values

Array

A set of a specified number of values of the same data
type

Text

String

A line of characters (letters and numbers)

Time

Time

Hours, minutes, seconds
Example: 12:30:56 AM
Each Time data type has a time chooser for graphical time
selection, where writable.

True or False

Boolean

Data that can only be true or false
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Notes
The Notes column lists specific characteristics of the attribute and its value. The characteristics
(or flags) in Notes specify how the attribute is used in the object and how it can be set within the
Metasys system.
Table 322: Notes
Note

Definition

C - Configurable

Indicates if the value of the attribute is defined by the user when first creating
the object and cannot be changed by the object itself. Configurable (C)
attributes that are writable (W) can be changed by the user online or by a
process or feature in the running system after the object has been created.

D - Default
Attribute for
Display

Indicates that this is the primary value of this object, and is used when the
user interface needs to display a single value from the object. For example, this
attribute is displayed in the header bar of the display panel for an object.

N - Value Not
Required

Indicates that this configurable attribute may contain a blank value. (Other
configurable [C] attributes without N must contain a valid value for the object
to function.) For example, a value for a high or low limit attribute is not required
and a blank value indicates that the alarm processing is not required.

R - Affected by
Indicates that the reliability of the value of this attribute is dependent on the
Object Reliability object being in a reliable state.
W - Writable

Indicates that the user can edit the value of the attribute online or by a process
or feature in the running system or network. A write to a configurable (C)
attribute replaces the existing value. A write to other attributes is handled as an
override to the value calculated by the object or as a command for some action
by the object.

BACnet Notes
The BACnet Notes column specifies if the attribute is exposed as a standard BACnet property and if
it can be modified from a BACnet network.
Table 323: BACnet [System] Notes
Note

Definition

B - Exposed as
Indicates that the attribute can be accessed as a standard BACnet Property of
Standard BACnet the equivalent BACnet Object Type from a BACnet network.
Property
W - Writable

Indicates that the value of the attribute can be modified by a message from a
device on the BACnet network.

Note: The types listed in Table 322 may also appear in the Note column, as applicable.
Initial Value
A configurable attribute takes the initial value when the object is being created if the user does not
enter another value. Other attributes take the initial value on startup and until the object calculates
a new value.
Values/Options/Range
Based on the attribute’s data type, this column may show the range of valid values or a reference to
the set of possible values for this attribute. If the complete set of values for the attribute is small, all
possible values are shown in this column.

Metasys Site Management Portal Help

537

Status and Display Attribute Location
The Status and default display attribute (typically the Present Value) of objects appear just below
the header of the Display Panel displaying the object.

Object Naming Attributes
Every object can be identified by one of three naming attributes.
Name - a freely definable user name for the object
Item Reference - a fixed name used internally by the system
BACnet Object Name - the name exposed to a BACnet network based on the Item Reference, or
the name based on the User Name Is BACnet Obj Name common attribute setting
See the Object and Feature Tabs section for more information on these attributes.

Commands
The Commands table for each object lists the commands that the object supports. Commands allow
you to perform an action on an object, such as Start or Stop. The user executes these commands
through the user interface. If an object does not support any commands, the Commands table
does not appear in the Help. For a description of each command, click the command name in the
Commands table.
The column headings in the Commands table are defined as follows:
Command Name - Gives the name of the command as it appears in the user interface.
Parameters - Gives the parameters required in the command along with some descriptive
information.

State, Mode, and Type Sets
State, Mode, and Type Sets provide the source of readable text for the user interface when the
displayed value can be one of many states, modes, or types. For example, the Status attribute of
every object is displayed as one of the texts listed in the Object Status (Set 505).
References to specific sets appear throughout the Object Help, usually in the Values/Options/Range
column of the object’s attribute table.

Enum Finder
The Enum Finder provides users advanced searching capabilities of enum sets for objects with the
States Text attribute. With the object displayed in the focus window, click the Search (magnifying
glass) icon next to the States Text attribute in the Configuration Tab in Edit mode to access the
Enum Finder.
Table 324: Enum Finder Dialog Box
Screen Area

Description

Search Criteria

Allows you to enter enum set search criteria.

Results

Displays the prioritized search results for cross column searching of Set ID,
Set Name, Enum ID, and Enum Value based on search criteria.

Additional Search
Criteria (+) icon

Adds additional Search Criteria rows.

Ok

Applies the selected enum set to the States Text attribute of the object
displayed in the focus window.

Cancel

Closes the Enum Finder without applying changes.

1.
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With the object displayed in the focus window, click Edit in the Configuration tab.
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2.

Click the Search icon next to the States Text attribute drop-down. The Enum Finder dialog box
appears.

3.

Enter enum search criteria text or numerical strings in the Search Criteria text box. The
Results table auto-populates with results listed in priority order by best matches against
search criteria.
Note: For optimal searching, add more search criteria by clicking the Additional Search
Criteria (+) icon.

4.

Select the enum set from the Results table and click Ok. The Enum Finder closes and the set is
populated in the States Text attribute of the object displayed.

5.

Click Save.

Common Object Attributes
The Object and Feature Tabs are used by most of the object types in the Metasys system. Each
particular object in the object list contains a reference to the use of common object attributes.

Object List
The entire list of objects that are available in the Metasys system appears in the table of contents in
the Help system and PDF. Also see the Extensions section for object extensions.

Object Creation
Objects can be created offline in the system database on the SCT and later downloaded to the host
device as part of the edited database. You can also create objects with a browser if you have the
Access Privileges to configure objects using the Security Administrator System. The user interface
screens and procedures are similar in either case. Creating an object involves placing it at the
desired position in the Navigation Tree and defining all the attributes that are required for it to
operate. The procedure begins with the Insert Menu, and a wizard guides you through all the
necessary configuration steps.
See the Creating Items with Wizards section for the steps to create objects/items.

Object Deletion
Objects can be deleted offline in the system database on the SCT and later downloaded to the host
device as part of the edited database. You can also delete objects with a browser if you have the
Access Privileges to configure objects using the Security Administrator System. The user interface
screens and procedures are similar in either case. Deleting an object involves selecting it in the
Navigation Tree and using the Delete Items command.
See the Deleting Objects or Items section for more information.
Note: Before deleting an object, you should delete all references to the object within other
objects and reconfigure any objects that are referenced in the object to be deleted. If the
references are not edited or deleted, the referenced objects may not operate correctly. See the
Engine Device Object for an example of how to locate incomplete references.

Common Object Attributes
The Common Object Attributes are used by most of the object types in the Metasys system. Each
object type also has specific attributes that apply only to that object type. A reference to the use
of Common Object Attributes and a description of specific object attributes are given under each
particular object in the Object List.

Common Attributes
This section lists the attributes that are common to Metasys system objects.
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Note: For detailed information on BACnet properties, refer to ANSI/ASHRAE Standard 135-2008 A Data Communication Protocol for Building Automation and Control Networks.
Table 325: Common Object Attributes - Focus/Configuration Tab
Attribute Name

11

Notes

BACnet
1

Notes

Alarm State

Initial
Value

Description

Normal

Indicates the current alarm state of the object.

Archive Date

Authorization
Category

C,W

W

General

Indicates the date of the last successful archive of object instances.
The value of this attribute is valid if a valid archive exists and during
the archive download process. The value of this attribute is 0xFF at all
other times.
Classifies the object by the category of system or equipment that it
monitors to aid in the determination of user access privileges and
alarm routing.
Examples: HVAC, Fire, Security
Note: When you are defining a new object, manually select
the Authorization Category from the drop-down list on the
Configuration tab. This extra step is only required if you need to
select a category other than General. For example, if the user is
only assigned the HVAC category, manually select HVAC under
the Configuration tab during object definition.

Description

C,N,W

Enabled
Item Reference

BNW

No text

True
C

Contains a user-defined description of the object or, for some
integrations, the device description. After the description is defined by
the user, the description is not read from the device again.
Indicates whether the object is set to execute/enabled (True) or not
execute/disabled (False).
Contains a unique reference name for the object that is the full
path name of the object through the All Items navigation tree using
the unique identifier you specified when you manually created the
object. The Item Reference begins with the site and device identifiers
(separated by a colon), followed by the identifiers of any parent
objects, such as an integration object, field device, or any nested
folders, and ends with the identifier of the object itself.
You define the identifier of each object as it is created and the system
builds the Item Reference automatically. Once the object is defined,
the Item Reference cannot be changed directly. But, the Computer
Name attribute of a Site Director or device is the object identifier. If
you change the Site Director or device Computer Name attribute, the
Item Reference then updates to show the new Computer Name.
If a device has a domain specified in the Domain Name attribute,
the name for the domain appears in the Item Reference after the
Computer Name:
Computer Name.Domain Name
The following characters are not allowed in references:
@?*#[]"‘“”\:/<>|$.,'_&
Figure 59 shows an example for a field point object in an N2
integration.
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Table 325: Common Object Attributes - Focus/Configuration Tab
Attribute Name
Name

11

Notes

BACnet
1

Notes

C,W

Initial
Value

Description

Item ID

Contains a freely definable user-friendly Name for the object that is
independent of the Item Reference or the location of the object in
the physical network. The Name is used as the label in the All Items
navigation tree. The Name is shown in alarm reports, the event and
audit viewers, and in summaries. The Name does not need to be
unique to the site unless the name is used as the BACnet Object Name.
When the name is used as the BACnet Object Name, it must be unique
among the BACnet Object Names in the device (if it is not a Device
object) or unique among the other device objects (if it is a Device
object).
The following characters cannot be used in an object name:
@?*#[]"‘“”\:/<>|$.,'_&
The Name defaults to the object identifier you used during manual
object creation, but can be edited later. For integrated BACnet objects,
the name defaults to the BACnet Object Name in the remote BACnet
device. For integrated N1 network objects, the name defaults to the
System.Object Name in the Network Communication Module (NCM).
Example: ConferenceCenter-Room2-SpaceSetPoint
For devices, both the Computer Name and Name attributes default
to the object identifier you used during manual object creation.
But, do not confuse the Computer Name attribute with the Name
attribute. Changing the NAE Name attribute does not impact the
object references or network communication with other devices on the
site.

Object Count
Object Identifier

Object Name

C

B

B

Changing the Computer Name online breaks any existing references
between the NAE object and other objects on the site, and may break
the existing network connection to other devices on the network.
We do not recommend changing the Computer Name online. If you
change the Computer Name attribute in the SCT (right-click the NAE in
the navigation tree and select Rename), both the Computer Name and
Name attributes are changed to the new name you select. The Item
Reference then updates to show the new Computer Name.
Indicates the number of object instances within the device. This count
includes objects of any type.
Indicates the instance number of the Object Type used in the BACnet
Object ID as exposed to a BACnet network. The object ID must be
unique within the host device. The object ID of the Device object must
be unique within the BACnet network.
Indicates the Object Name as exposed to a BACnet network. This
attribute is equivalent to the Item Reference without the site identifier.
You cannot edit this attribute, but it changes when the Item Reference
attribute updates.
In addition, you can change the Object Name attribute by editing the
User Name attribute and setting the User Name Is BACnet Obj Name
attribute to True.
Example: NAE3/N2 Trunk1.AHU4.Supply Temp

Object Type

B

Indicates the Object Type as displayed in the Metasys software and as
exposed to a BACnet network.
Example: AI (Analog Input)
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Table 325: Common Object Attributes - Focus/Configuration Tab
Attribute Name

11

Notes

BACnet
1

Notes

Status

Initial
Value

Description

Normal

Displays the highest priority Status for the object.
The value of the Status attribute displays next to the Default Attribute
for Display (typically Present Value) in the header bar of the Display
panel.
Examples: (in order of priority - supported states depend on Object
Type)
– Out Of Service: The Out Of Service attribute value is True.
– Offline: Communication with the physical hardware has failed.
– Unreliable: Reliability attribute is not reliable.
– Alarm: Object or alarm extension has an alarm state.
– Normal: No abnormal condition for this object detected.
– Output Clipped: Present Value is outside the limits of Min Value and
Max Value. Status remains Output Clipped until the output changes.

User Name Is
C,W
BACnet Obj Name

C,W

False

Version

Controls whether the object’s User Name attribute is also the Object
Name attribute. The Object Name attribute is not writable, so the only
way to change the Object Name attribute is to edit the User Name
attribute and set the User Name Is BACnet Obj Name attribute to True.
Displays the version number of the object software code. As the
functionality of objects is enhanced, the version numbers are
incremented.
Example: 3.1 where 3 is the major revision and 1 is a minor revision

1

B - Exposed as Standard BACnet Property, C - Configurable, N - Value Not Required, W - Writable

Figure 59: Example of Item Reference

Object and Feature Tabs
This section describes the tabs of the display panel for the objects and features in the system. Each
display panel can contain different tabs depending on the item being viewed, and each tab shows
different information.
Note: This section contains detailed information about the tabs used by multiple objects/
features. When a tab only appears for a specific object/feature, the details of that tab are
defined in that object/feature section. However, this section includes a brief description of
such tabs and provides links to the detailed object/feature sections.

Action Tables Tab
The Action Tables tab appears on Interlock and Multiple Command objects. See the Interlock Object
and Multiple Command Object sections for details.

Alarm Tab
The Alarm tab appears on an object that has an alarm extension. See Alarm Extensions in the
Extensions section.
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Associated Graphic Tab
The Associated Graphic tab appears when a graphic is referenced from the object using the Graphic
attribute. See the User Graphics Tool (UGT) section for details on working with this tab.

Averaging Tab
The Averaging tab appears on an object that has an averaging extension. See Averaging Extensions
in the Extensions section.

BACnet Alarm Tab
Attributes associated with the BACnet Intrinsic Alarming for an object are shown under the BACnet
Alarm tab of the display panel. This tab appears when the site is defined as a BACnet site and the
object has intrinsic alarming enabled (that is, Intrinsic Alarming Defined set to True).
Note: In the notes columns, attributes marked with the letter C are configurable, and
attributes marked with the letter W are writable. In the BACnet notes column, attributes
marked with the letter B are exposed as a standard BACnet property. For more information
about attribute characteristics, see Attributes.
Table 326: BACnet Alarm Tab Attributes
Attribute Name
Acked Transitions

Notes

BACnet Notes Values/Options/Range Description
B
To Offnormal, To Fault, Displays three states that independently indicate
To Normal
the receipt of acknowledgments for To Offnormal,
To Fault, and To Normal events. Transitions to High
Applies to all point
Limit and Low Limit Event States are considered
objects and the
Offnormal events.
Accumulator.
These states are set to False when the
corresponding event occurs and an
acknowledgment is expected as defined in the
Notification Class Object referenced by the
Notification Class attribute of this object.
The states are set to True upon receipt of the
corresponding acknowledgment.

Alarm Message
Text

W

W

Maximum 256
characters
Applies to all point
objects and the
Accumulator.
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Specifies the body of the user-defined alarm
message. Starting at Release 10.0, this attribute
is replaced by Event Message Texts Config. The
value of this attribute is kept in sync with the
first element of the Event Message Texts Config
attribute. Any modification to either one changes
the other. Also, for upgraded systems that use
Alarm Message Text, any text in this field is moved
to the first element of the Event Message Texts
Config field.
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Table 326: BACnet Alarm Tab Attributes
Attribute Name
Alarm Values

Notes
C,W

BACnet Notes Values/Options/Range Description
W
Inactive, Active
Specifies the value (or list of values for multistate
objects) that Present Value must reach before an
States Text attribute
identifies the value set event generates. If the object supports intrinsic
reporting, this attribute is required.
for this attribute.
Applies to BI, BV, MI, and To Offnormal event generates under these
conditions:
MV objects.
For MI and MV objects, – Present Value maintains the value(s) specified
you can select multiple by Alarm Value(s) for a minimum period of time,
values from a list, unlike specified in the Time Delay attribute.

the other objects that
– To Offnormal flag is enabled in the Event Enable
are limited to one value. attribute.
Once equal to the Alarm Value(s), the Present
Value must become not equal to Alarm Value(s)
before a To Normal event is generated under these
conditions:
– Present Value remains not equal to the Alarm
Value(s) for a minimum period of time, specified by
the Time Delay attribute.
– To Normal flag is enabled in the Event Enable
attribute.
BACnet Deadband

C,W

B,W

Event Enable

C,W

B,W

Event Message
Texts

C, W

Error Status

Applies to AI, AO, and AV Defines the value by which the Present Value must
objects.
change below the High Limit or above the Low
Limit before the object generates a To Normal
event.
Applies to the BO object. Indicates whether the Present Value was
successfully written to the object defined by the
Feedback Reference. The Error Status displays Ok if
the object was able to send its latest Present Value
to the feedback object. Otherwise, the Error Status
displays the error of the first failed command.
To Offnormal, To Fault, Contains three states that independently enable
To Normal
To Offnormal, To Fault, and To Normal events.
Transitions to High Limit and Low Limit Event
Applies to all point
States are considered Offnormal events. An
objects and the
unreliable condition generates a Fault event.
Accumulator.
To Offnormal, To Fault,
To Normal
Applies to all point
objects and the
Accumulator.

Event Message
Texts Config

C, W

To Offnormal, To Fault,
To Normal
Applies to all point
objects and the
Accumulator.
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An array of three character strings that holds
the message texts that identify the last state of
the object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL. If a
particular event is yet to occur, the respective entry
in the array is blank (null).
An array of three character strings that defines
the message texts used to identify the last state
of the object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL,
which you may customize by entering text in each
field. What you enter here appears in the Event
Message Texts attribute array. Starting at Release
10.0, this attribute replaces Alarm Message Text,
but the two attributes are kept in sync so that any
modification to either one changes the other.
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Table 326: BACnet Alarm Tab Attributes
Attribute Name
Event State

Notes

Event Time Stamps

BACnet Notes Values/Options/Range Description
B
Normal, Fault
Indicates the active alarm state of the Intrinsic
(unreliable), High Limit, Alarming feature if enabled for the object. In
Low Limit
BACnet terms, High Limit and Low Limit states are
Offnormal.
Applies to all point

B

Fault Values

C,W

W

Feedback
Reference
Feedback Value

C,W

W

C,W

W

objects and the
Accumulator.
BACnet formatted Time Indicates the times of occurrence of the last
Stamps
To Offnormal, To Fault, and To Normal event
transitions. Time and Date time stamps are
Applies to all point
shown as * if no transition of that type has been
objects and the
generated. Sequence time stamps are 0 if no
Accumulator.
transition of that type has been generated. If
intrinsic reporting is supported by the object, this
attribute is required.
Numbers: 0 to 65,535
Specifies any states the Present Value must equal
before a To Fault event issues. If Present Value
States Text attribute
identifies the value set becomes equal to any of the states in the Fault
Values list, and no physical fault is detected for
for this attribute.
any inputs represented by the Present Value
The list of numbers
come from a list of the attribute, then the Reliability attribute has the
value Multistate Fault. If the object supports
Alarm Values.
intrinsic reporting, the Fault Values attribute is
Applies to MI and MV
required.
objects.
Applies to BO and MO
Indicates the object reference of the feedback
objects.
object.
Inactive, Active
Indicates the status of a feedback value from
which Present Value must differ before an event
States Text attribute
identifies the value set generates. The amount Present Value differs from
Feedback Value to generate an event is locally
for this attribute.
determined. This attribute is required if the object
Applies to BO and MO
supports intrinsic reporting.
objects.
A To Offnormal event generates under these
conditions:

– Present Value differs from the Feedback Value for
a minimum period of time, specified in Time Delay.
– Event Enable attribute enables the To Offnormal
flag.
Once equal to the Feedback Value, the Present
Value must become different from the Feedback
Value before a To Normal event generates under
these conditions:
– Present Value remains not equal to the Feedback
Value for a minimum period of time, specified by
Time Delay.
– Event Enable attribute enables the To Normal
flag.
Graphic

C,W

C,W

Graphic Alias

C,W

C,W

Applies to all point
objects and the
Accumulator.
Maximum 256
characters
Applies to all point
objects and the
Accumulator.
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Indicates the graphic associated with the alarm
extension.
Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.
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Table 326: BACnet Alarm Tab Attributes
Attribute Name
High Limit

Notes
C,W

BACnet Notes Values/Options/Range Description
B,W
Applies to AI, AO,
Defines the high limit that the Present Value
AV, and Accumulator
attribute must exceed before an event is
objects.
generated.
The object generates a To Offnormal event when
the Present Value exceeds the High Limit for a
minimum period of time, defined in the Time Delay
attribute; the High Limit Enable is True in the Limit
Enable attribute; or the To Offnormal is True in the
Event Enable attribute.
The object generates a To Normal event when the
Present Value falls below the High Limit minus the
Deadband for a minimum period of time, specified
in the Time Delay attribute; the High Limit Enable
flag is set in the Limit Enable attribute; or the To
Normal flag is set in the Event Enable attribute.
For the Accumulator object, this attribute indicates
the upper limit of the Pulse Rate range.

Life Safety Alarm
Values

Uses BAC LifSfty State
Specifies any states that the Present Value must
(BACnet Lifesafety State) equal before the point generates a To Offnormal
(Set 186).
event and enters the Life-Safety-Alarm event state.

Limit Enable

C,W

B,W

Low Limit

C,W

B,W

Applies only to Life
Safety Zone and Life
Safety Point objects.
Applies to AI, AO,
AV, and Accumulator
objects.
Applies to AI, AO,
AV, and Accumulator
objects.

Contains two flags that independently enable
and disable reporting of High Limit and Low Limit
events and their return to Normal. This attribute is
required if the object supports intrinsic reporting.
Defines the low limit that the Present Value
attribute must fall before an event generates.
The object generates a To Offnormal event when
the Present Value falls below the Low Limit for a
minimum period of time, defined in the Time Delay
attribute; the Low Limit Enable is True in the Limit
Enable attribute; or the To Offnormal is True in the
Event Enable attribute.
The object generates a To Normal event when
the Present Value exceeds the Low Limit plus the
Deadband for a minimum period of time, specified
in the Time Delay attribute; the Low Limit Enable
flag is set in the Limit Enable attribute; or the To
Normal flag is set in the Event Enable attribute.
For the Accumulator object, this attribute indicates
the lower limit of the Pulse Rate range.

Notification Class

C,W

B,W

0 to 4,294,967,295
This is the BACnet
Object Identifier of the
Notification Class Object
used for routing.

Defines the notification class for handling and
generating event notifications for the object. This
attribute implicitly refers to the Notification Class
Object that has a Notification Class attribute of the
same value.

Applies to all point
objects and the
Accumulator.
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Table 326: BACnet Alarm Tab Attributes
Attribute Name
Notes
Notification Object C,W
Reference

Notify Type

C,W

Pulse Rate

C,W

Time Delay

C,W

BACnet Notes Values/Options/Range Description
C,W
Set to Notification Class: Allows selection of a Notification Class object.
1
When the Notification Object Reference is written,
the value of the Notification Class attribute is
Applies to all point
updated to reflect the referenced object’s instance
objects and the
number. The value of the Notification Object
Accumulator.
Reference attribute is restricted to Notification
Class objects on the same device as the Alarming
object.
B,W
Alarm, Event
Defines whether the transitions generated by the
object are Events or Alarms.
Applies to all point
objects and the
Accumulator.
Applies to the
Accumulator object.

B,W

0 to 65,535
Units = seconds
Applies to all point
objects and the
Accumulator.

Indicates the number of input pulses received
during the most recently completed period
specified by the Limit Monitoring Interval. This
value is monitored by the Intrinsic Alarming logic
for this object. This attribute is writable only when
the object is out of service.
Defines the minimum number of seconds that
the Present Value must remain outside the range
defined by the High Limit and Low Limit attributes
before the object generates a To Offnormal event.
Also defines the minimum time the Present Value
must remain within the range defined by the
High Limit and Low Limit attributes, including
the Deadband attribute value, before the object
generates a To Normal event.
When used with the Feedback Value, this value
specifies the minimum number of seconds that the
Present Value must remain equal to the Feedback
Value before a To Offnormal event generates or
different from the Feedback Value before a To
Normal event generates.
For the Accumulator object, this value defines
the minimum number of seconds that the Pulse
Rate must remain outside of the range defined by
the High Limit and Low Limit attributes before the
object generates an event or alarm.

Calendar Tab
The Calendar tab appears on Calendar objects, which are used behind the scenes by the Scheduling
feature.

Communications Tab
The Communications tab appears on Engine Device objects.

Configuration Tab
The Configuration tab appears when you define an object in the SCT or in a wizard. The
Configuration tab shows operation attributes available for the object type to which the object
belongs. The attributes displayed on the Configuration tab vary by object type. For example, the
Analog Input object’s Configuration tab has different attributes than the Metasys server object’s
Configuration tab. See the specific object section for details on its Configuration tab.
Note: This tab is called the Focus tab in the online Site Management Portal.
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Diagnostic Tab
The Diagnostic tab only appears for objects containing diagnostic data. The attributes displayed
on the Diagnostic tab vary by object type. For example, the Diagnostic tab of the BACnet Protocol
Engine Object has different attributes than the Engine Device Object. See the specific object section
for details on its Diagnostic tab.

Email Tab
The Email tab appears on Engine or Server objects. The Email DDA Attributes appear on the Shared
Configuration section of the Email Tab. The Email DDA Destination Configuration Attributes appear
when you edit a specific Email destination on the Email tab.
Notes:
•

At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS. For
these devices, use the Metasys UI to modify the attributes on this tab.

•

At Metasys Release 7.0 or later, Email Tab Destinations and all DDA communications feature
alphabetical sorting. See table below.

Table 327: Email Sorting Icons
Icon

Icon Name

Description

Ascending

Sorts destinations in
alphabetical order

Descending

Sorts destinations in reverse
alphabetical order

Table 328: Email DDA Shared Configuration Attributes
Attribute Name

Description

SMTP Server Host

Specifies either a host name or IP address of a SMTP server. A host
name can be specified only if a DNS is available to the device. This
attribute is used in conjunction with Email DDA attribute. If no Email
DDA destinations are configured, this attribute is ignored.

SMTP Port

Signifies the TCP port on which Email DDA should connect to deliver
an email message. By default, this field is set to 25 (SMTP); however,
some internal SMTP servers may be set up to non-standard ports,
which require that this field be changed to match the listening port
of the mail exchanger. If no Email DDA attribute exists, this attribute
is ignored.

Authentication Type

Specifies the type of authentication used to send and receive emails.
Depending on the selection you make, the fields on the Email tab
become enabled or disabled to help you fill in only the fields required
for that authentication type. If you select SMTP, the SMTP User Name
and SMTP Password attributes become enabled. If you select POPbefore-SMTP, the POP User Name and POP Password attributes
become enabled.

SMTP User Name

Specifies a user name for the SMTP server. This attribute is ignored
if the SMTP Server Host is empty. This attribute applies only when
using SMTP authentication. If no Email DDA destinations are
configured, this attribute is ignored. See SMTP Password.
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Table 328: Email DDA Shared Configuration Attributes
Attribute Name

Description

SMTP Password

Specifies the password for the SMTP user name. This attribute is
ignored if the SMTP Server Host is empty. This attribute applies only
when using SMTP authentication. If no Email DDA destinations are
configured, this attribute is ignored. See SMTP User Name.

POP Server Hostname

Specifies the hostname for the POP server. This attribute applies only
when using POP authentication. If no Email DDA destinations are
configured, this attribute is ignored.

POP User Name

Specifies a user name for the POP server. This attribute is ignored
if the POP Server Hostname is empty. This attribute applies only
when using POP authentication. If no Email DDA destinations are
configured, this attribute is ignored.

POP Password

Specifies the password for the POP user name. This attribute is
ignored if the POP Server Hostname is empty. This attribute applies
only when using POP authentication. If no Email DDA destinations
are configured, this attribute is ignored.

From Email Address

Specifies the email address from which all emails are sent. The From
Email Address is a required field. If this attribute is not populated,
the Email DDA does not attempt to send an email message.

SSL Email Enabled

When enabled or set to True, emails attempt to send over an SSL
encrypted connection. If SSL is not supported, the email sends
unencrypted unless SSL Email Ignoring Errors option is set to False.
This attribute is disabled by default.

SSL Email Ignoring Errors

When True, the email is still sent even if the email server certificate
appears to be invalid. When false, the email is sent only if the
operating system can verify that the server sent a valid SSL
certificate. The feature is only enabled if SSL Email Enabled is True.
Note: Make sure that proper certificate revocation, such as Online
Certificate Status Protocol (OCSP) stapling, is enabled and configured. For more information about OCSP configuration, refer to
https://docs.microsoft.com/en-us/openspecs/windows_protocols/msocsp/5792b4c4-c6ba-439a-9c2a-52867d12fb66.

Email Diagnostics

Displays diagnostic information regarding the communication
between the Email DDA (SMTP Client) and the SMTP Server. This
attribute displays both successful and unsuccessful email message
deliveries.

Metasys Site Management Portal Help

549

Table 329: Email DDA Destination Configuration Attributes
Attribute Name

Description

Label

Identifies the user-friendly destination name in the list of Email
DDAs. Maximum characters: 80

Email Address

Specifies the email address of one or more recipients. You must use
valid email addresses set up on an email server for the device to
successfully send the email alarms. When entering more than one
email address, separate the addresses with a comma (for example,
Jonathan.Smith@jci.com,Jane.Smith@jci.com).
Click the Browse icon to select email addresses defined by the user
accounts in the Security Administrator system. See the Metasys/
BACnet Alarming Overview section for more information about the
Email DDA and selecting email addresses.
Maximum characters: 256

Priority

Specifies the priority of the outbound email message. This attribute
defines the X-Priority field within the email’s MIME header. XPriority is one of several ways to define the significance of an email.
Not all email clients interpret it the same way. Refer to your email
client’s documentation for more information.
You can choose from the following values:
•

High

•

Normal

• Low
See the Hi Normal Low (Set 100).
Subject

Specifies the user-defined text that appears in the subject field of
the email message.
Maximum characters: 256

Retries

Specifies the number or attempts made to send a message if there
is a failure before the system discards it.
Range: 0–10

Enabled

Defines whether or not the destination is enabled. When this
attribute is False, the Engine or Server does not deliver alarms to
the configured recipients.
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Table 329: Email DDA Destination Configuration Attributes
Attribute Name

Description

Filters

Specifies the rules to filter alarms. This attribute uses Alarm Value
(Set 108).
See Filters for more information.

Format

Defines the format of the message, indicating which fields are
present in the received message.
The following fields are optional:
•

Acknowledge Required (not an option for pager)

•

Authorization Category

•

Item Description

•

Item Fully Qualified Reference

•

Message

•

Previous Status

•

Priority

•

Site Name

•

Value

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Filters
Defines the rules used to filter alarms. This attribute appears on the Email, Pager, Printer, and
SNMP tabs. See Event Message Routing, Filtering, and Destinations in the Alarm and Event
Management section for more information on filtering.
Table 330: Filter Parameters
Filters

Operators Allowed

Values

Acknowledge Required

== or !=

True or False

Current Status

== or !=

Object Status Set

Start Day of Week

<, <=, >, >=, ==, or !=

Day of the week.
Any value from Monday to Sunday

Start Time

<, <=, >, >=, ==, or !=

Time

End Day of Week

<, <=, >, >=, ==, or !=

Day of the week.
Any value from Monday to Sunday

End Time

<, <=, >, >=, ==, or !=

Time

Item Type

== or !=

Object Type Set

Authorization Category

== or !=

Authorization Category Set

Previous Status

== or !=

Object Status Set

Priority

<, <=, >, >=, ==, or !=

Number value

Note: If you specify
a filter with a value
of >10, you receive
only alarms with
priorities between
11 and 255.
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If you define multiple filters for a destination, the DDA combines all the criteria with an AND
condition (all filter criteria must be met).

Engineering Tab
About this task:
The Engineering tab appears on integration objects in the system. This tab allows you to view and
edit attributes of items such as devices and points on an integration.
To use the Engineering tab to view and edit attributes:
1.
2.

Right-click the integration object on the Navigation tree and select View. The Integration
object appears.
Click the Engineering tab, and navigate to an item in the Integration Tree.
Note: You may need to click Relearn to discover the integrated devices and points on
the network and populate the Integration Tree with the data.

3.
4.
5.

Double-click the selected item. The Details screen for the selected item appears.
Click the Edit button.
Make the desired changes and click Save.

Event Tab
The Event tab appears on Event Enrollment objects.
See the BACnet Event Enrollment Object Alarming and Event Enrollment Configuration Examples in
the Alarm and Event Management for Metasys Systems Integrated with BACnet Devices section.
For detailed information, refer to the BACnet Event Enrollment Object Alarming and Event Enrollment
Configuration Examples topics in the Alarm and Event Management for Metasys Systems Integrated with
BACnet Devices section of the Metasys SMP Help (LIT-1201793).

Focus Tab
The Focus tab appears when you define an object in the online Site Management Portal. The
Focus tab shows operation attributes available for the object type to which the object belongs. The
attributes displayed on the Focus tab varies by object type. For example, the Analog Input object’s
Focus tab has different attributes than the Metasys server object’s Focus tab. See the specific object
section for details on its Focus tab.
Note: This tab is called the Configuration tab in the SCT or in a wizard.

Graphic Tab
The Graphic tab appears on a device object that has an associated Graphic defined. See the Graphic
Object for details on working with this tab.

Group Tab
The Group tab appears on Group objects.

Hardware Tab
The Hardware tab shows hardware-related attributes associated with the hardware source of an
integration, device, or a point (for example, when an object has a reference to a physical input or
output).
Note: Each Hardware attribute table is organized and divided into sections of Integration
Hardware attributes, Device Hardware attributes, and Point Hardware attributes (calling out
when attributes are shared between these object types). These sections are indicated by
headings that span across the table.
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BACnet Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network.
Note: Each Hardware attribute table is organized and divided into sections of Integration
Hardware attributes, Device Hardware attributes, and Point Hardware attributes (calling out
when attributes are shared between these object types). These sections are indicated by
headings that span across the table. Attributes marked with the letter C are configurable and
attributes marked with the letter W are writeable.
Table 331: BACnet Hardware Tab Attributes
Attribute Name
Disable Automatic
Alarming

Notes
C,W

Initial Value
False

Instance Number

C

None

Remote Device
Addr

None

Remote Object
Name

None

Values/Options/Range Description
False
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
True
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
0–65,535
Contains the number of mapped BACnet objects
that are being polled on a periodic basis or are
part of the BACnet Object Identifier (along with
the Object Type). The BACnet Object Identifier is
used to establish communication with the object.
BACnet device address
Contains the BACnet address of the remote
BACnet device where the integrated BACnet
object resides.
Contains the BACnet Object Name of the
integrated BACnet object as defined in the remote
BACnet device.

IP Field Controller Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 332: IP Field Controller Hardware Attributes
Attribute Name
Computer Name

Notes
W

Initial Value

Values/Options/Range Description
Contains the host name of the device.

Controller Number C,W

0

Range = 000–999

DHCP Enabled

True

False

C,W

True
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Contains the three rotary switches that identify
the device within the various levels of your site.
Each rotary switch is selectable from 0 to 9,
producing a number ranging from 000 to 999.
Specifies whether a unique IP address is assigned
automatically (True) or manually (False). A unique
IP address is assigned automatically by the DHCP
server or manually by the user.
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Table 332: IP Field Controller Hardware Attributes
Attribute Name
Disable Automatic
Alarming

Notes
C,W

Domain Name

W

Ethernet MAC
Address
Instance Number

W

IP Mask

C,W

IP Router Address

C,W

JCI IP Address

C,W

C,W

Initial Value
False

Values/Options/Range Description
False
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
True
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Contains the network domain in which the device
belongs to.
00:00:00:00:00:
Contains the unique hardware number that
00
identifies the device within a network.
0
Range = 0–4,194,303
Contains the Object Instance part of the BACnet
Object Identifier, which is used with the Object
Type value to define the full BACnet Object
Identifier value. The BACnet Object Identifier is
used to establish communication with the object.
0.0.0.0
Contains the bit mask that defines which bits are
used to separate between the host portion of the
address and the domain portion of the address.
The IP Mask consists of four numbers ranging
from 0 to 255 separated by three periods.
Listof[0]
Contains the address of the device which is used
to forward messages to a remote IP network.
0.0.0.0
Contains the unique address other networks
connected to the IP use to identify the device. The
JCI IP address consists of four separate numbers
ranging from 0 to 255 separated by three periods.

LonWorks Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable, and attributes marked with the letter W are writable.
Table 333: LonWorks Hardware Tab Attributes
Attribute Name
Alarm Event State

Notes
C,W

Command Status
Mapping Table

C,W

Custom Scale/
Offset

C,W

Device Class
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Initial Value
True

Values/Options/Range Description
False
Specifies whether Node State changes will cause
alarms. The value of True allows Node State
True
alarms to be processed by the NxE. The value of
False masks Node State alarms from the NxE.
Applies to BI, BO, MI, and Limits or modifies the mapping to the field
MO objects only.
states/commands used by the object. This string
refers to one of the conversion identifiers in the
CommandStatusMap.xml file.
Applies to AI and AO
Provides a customs scaling function for
objects only.
converting the field data to the defined units of
the object. This attribute is for AI and AO objects
only.
Maximum Length = 40
Indicates the class of a device. The LonWorks
network server is responsible for populating the
Category = Default
Program ID (which includes the Manufacturer,
Device Class, Device Subclass, Transceiver, and
Model). If no standard Program ID exists, the
value is n/a.
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Table 333: LonWorks Hardware Tab Attributes
Attribute Name
Device Subclass

Notes

Initial Value

Disable Automatic
Alarming

C,W

False

Domain ID

C

01

Driver Name
DSN 1

Ipcdrv

Values/Options/Range Description
Maximum Length = 40
Indicates the device subclass usage of a device.
The LonWorks network server is responsible for
Category = Default
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.
False
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
True
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Maximum Length = 12
Defined by MCL software for the particular
LonWorks network trunk. The validation code
Category = Default
Hex bytes of length 0,1,3, checks for proper format (zero, one, three, or six
hexadecimal bytes).
or 6
Maximum Length = 30
Category = Default
Maximum Length = 30

C

Category = Default

DSN 2

C

Maximum Length = 30
Category = Default

Enable Polling

C,W

Field Units

C,W

File Filter

Applies to AO, BO, and
MO objects only.
DegF

W

Uses Unit Set (Set 869).
This attribute is for AI
and AO objects only.
Maximum Length = 40
Category = Default

Displays to the name of the installed LonWorks
network driver.
Displays the native LonWorks network address
(in Domain-Subnet-Node format). DSNs must
be unique on the LonWorks network. DSN 1 is
required. Use the format xx/xx/xx.
Displays the native LonWorks network address
(in Domain-Subnet-Node format). DSNs must
be unique on the LonWorks network. DSN 1 is
required, but DSN 2 can be left blank. Use the
format xx/xx/xx.
Indicates whether polling is enabled or disabled
when the Engine is in complete control of this
item.
Lists the engineering units that pertain to the
LonWorks network data. This attribute is for AI
and AO objects only.
Lists the types of files that can be used as file
extensions to the LON Integration object. The list
includes:
•

eng

•

enm

•

enu

•

fmt

•

fpt

•

typ

•

xif

File Filter can be edited for alternate languages
and must be in the xxx file format.
Interface Value
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Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.
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Table 333: LonWorks Hardware Tab Attributes
Attribute Name
LNS Database
Name

Notes
C,W

Initial Value

Location Label

Maximum Length = 30

Manufacturer

C,W

1
0

Neuron ID

Offline
Overridden
Priority
Program ID

Resource File
Language

C,W

ENU

Status Launch
Interval

C,W

0

Target Reference

C

Temporary Status
Item Expiration
Time

C,W

Transceiver

60

Indicates that an HOA switch on the referenced
item is set to Hand or Off.
Indicates the manufacturer of a device. The
LonWorks network server is responsible for
Category = Default
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.
Range = 0–15
Indicates the number of retry attempts to use
when communicating with this controller.
Indicates the model number of a device. The
LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.
Fixed Length = 6
Displays the Neuron ID of the local LonWorks
network interface board or contains the Neuron
Category = Default
ID of the remote LonWorks network controller.
The Neuron ID must be unique to the LonWorks
network.
Indicates whether the connected LonWorks
network hardware is online or offline.
Indicates if the hardware is overridden (if
supported).
1–3
Indicates the Priority (1–3) at which to poll this
item.
Number of Elements = 40 Displays the Standard Program ID for the device
in hex characters. The LonWorks network server is
Category = Default
responsible for populating the Program ID (which
includes the Manufacturer, Device Class, Device
Subclass, Transceiver, and Model). If no standard
Program ID exists, the value is n/a.
Maximum Length = 3
Defines the language extracted from the resource
file.
Category = Default
Range = 0–10,000
Indicates how often the LON integration launches
milliseconds
a status request to the field. A value of 0 means
as often as needed. This attribute limits the LON
bandwidth usage for the LON integration.

Range = 0–65,535
seconds
Immediate (0), Never
(65,535)
Maximum Length = 40
Category = Default
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Describes the location of the controller.

Category = Default
Applies to AO, BO, and
MO objects only.
Maximum Length = 40

Manual Control

Message Retry
Count
Model

Values/Options/Range Description
Maximum Length = 30
Displays the name of the LNS database used to
build the LonWorks network trunk.
Category = Default

Defines the path into a controller for the data
being mapped by the object.
Indicates the time to poll the temporary objects in
the status list.

Indicates the transceiver type for a device. The
LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.
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Table 333: LonWorks Hardware Tab Attributes
Attribute Name
Trouble

Notes

Update Interval

C,W

Initial Value

Values/Options/Range Description
Applies to BI and BO
Indicates whether the hardware device is
objects.
currently under a trouble condition. Applies to BI
and BO objects.
Units = Seconds
Specifies how often (in seconds) to repeat the last
command. This attribute provides a heartbeat
0–65,535
for controllers needing it. Use this attribute
Applies to AO, BO, and
sparingly.
MO objects only.

XIF Present

Indicates whether a XIF file matching this
controller’s Program ID was found.

MS/TP Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 334: MS/TP Hardware Tab
Attribute Name
Notes
Baud Rate Selection C,W

Initial Value
0

Values/Options/Range Description
Uses MSTPDL Baud Rate Indicates the baud rate of the NAE FC bus.
See the attribute
description.

Device Type
Disable Automatic
Alarming

C,W

False

FC Bus MAC
Address
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False
True

•

Auto: Uses baud rate of running network.
This value is the recommended setting for
everything on the FC bus except the bus
supervisor port.

•

1200: Uses 1200 baud only. This value is not
recommended and may not be allowed on
some devices.

•

9600: Uses 9600 baud only. This value is the
lowest standard MS/TP baud rate.

•

19200: Uses 19200 baud only. This value is
not recommended.

•

38400: Uses 38400 baud only. This value
is the recommended baud rate for bus
supervisor ports.

•

76800: Uses 76800 baud only.

Indicates the type of device. This value comes
from CCT.
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Displays the MAC address of the device on which
the object exists (if the object physically resides
on a device on the FC bus) or the FEC/VMA
field controller MAC Address that the point is
connected to (if the object physically resides on
the SA bus).
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Table 334: MS/TP Hardware Tab
Attribute Name
Instance Number

Notes

MAC Address

C

Network Address

C,W

Initial Value

0

Offline
SA Bus MAC
Address

Values/Options/Range Description
Displays the Instance Number of the object on the
remote field device. The Instance number, along
with the object type, defines the remote object’s
BACnet Object Identifier. The BACnet Object
Identifier is used to establish communication with
the object.
1–255
Indicates the MAC address of the device on the
field bus.
1–65,534
Contains the network number of the MS/TP bus
used for BACnet message addressing. A value
0 = Local network
of 0 indicates a local network (the device is not
65,535 = Reserved for
intended as a router). Do not change this number
broadcast
after you start device mapping or discovery
because it may invalidate the devices that have
been found.
Specifies whether or not the point is offline.
This attribute applies
to AI, AO, BI, BO, and
Accumulator objects.
This attribute applies to
AI, BI, and Accumulator
objects.
This attribute applies to
AO and BO objects.
This attribute applies to
PAO and BO objects.

Slot

Slot A
Slot B

Trunk Number

Displays the MAC address of the device on which
the object exists (if the object physically resides
on a device on the SA bus).
Defines the physical location of a point data
source on the device.
Defines the physical location of a point data
source on the device.
Defines the physical location of a second data
point source on the devices (if present). Only a
PAO would have Slot B defined.
Displays the trunk number where the device (on
which the point resides) is located.

N1 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable and attributes marked with the letter W are writeable.
Table 335: N1 Hardware Tab Attributes
Attribute Name
Interface Value

Notes

Initial Value

NCM Name

None

Network Name

None

Offline

False

Overridden

False
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Values/Options/Range Description
Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.
8 characters maximum Contains the name of the NCM where the
integrated N1 object resides, as defined in the N1
network. Read from the NCM.
8 characters maximum Contains the network name of the NCM where
the integrated object resides as defined in the N1
network. The network name is obtained at startup
through the N1 Migration Object.
Indicates whether the object is online or offline as
determined by the communication status to the
NCM.
Indicates if the point is overridden in the NCM.
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Table 335: N1 Hardware Tab Attributes
Attribute Name
Reference

Notes

Initial Value
None

Remote Object
Name

C,W

None

Values/Options/Range Description
<system>.<object>
Contains the name of the hardware object in the
format of system.object, that the N1 object is
associated within the NCM.
<system>.<object>
Contains the name of the object in the format of
system.object.
8 characters each
maximum

N2 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable and attributes marked with the letter W are writeable. The writeable
attributes in the N2 Master Datalink object are writeable only if the UDP Port attribute is not zero. If
the UDP Port attribute is zero and you attempt to write these attributes, an error message appears.
Table 336: N2 Hardware Tab Attributes
Attribute Name

Notes

Controller Type

C

Disable Automatic
Alarming

C,W

Error Log

W

Initial Value

Values/Options/Range Description

False

AHU, VAV, UNT, PHX,
VND, MIG, VMA, DX, TC,
XTM, LCP, ILC, IFC
False
True

See Table 337

Host Name

Interface Value

Message Timeout

W

250

250–3,000
Milliseconds
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Defines the N2 controller type assigned to this
object.
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Lists up to 100 error log entries. Each entry
contains the N2 Controller Type, N2 Address,
Error Description, and a Timestamp (time error
occurred). Logging stops once the 100th entry
is added. This list is stored in memory only. The
Clear Statistics command clears the Error Log.
Indicates the host name of the Ethernet (or
wireless) converter. When a host name is given,
the system attempts to resolve the Host Name
and IP Address using DNS/DHCP (assuming
that the installer assigned a host name to the
converter and enabled DHCP). If the device can
be located using the ping hostname command,
the system can resolve the host name to an
IP address. After resolving the host name, the
system updates the IP address.
Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.
Specifies the delay in milliseconds between the
last character going out and the first character
received. The timeout for VMA devices is three
times this value. The actual timeout can be
extended dynamically when at least one character
of a response message is received before the
timeout.
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Table 336: N2 Hardware Tab Attributes
Attribute Name
Net N2 Address

Notes
C

Initial Value
0

Net Point Address
Net Point Type
Offline

Online Point Delay

Values/Options/Range Description
1–254
Defines the host controller Address (1–254) on the
N2 bus.
Defines the hardware address associated with the
point.
Indicates the type of point (for example, AI or BI).
Offline (True), Online
(False)

C,W

Range = 0–8
Units = Minutes

Overridden
Poll Delay

W

100

0–65,535
Milliseconds

Retries

W

3

3–10

Trouble

Applies to BI and BO
objects.

Trunk Number

0–65,535

UDP Port

W

0

Indicates whether the hardware device is
currently communicating with the system (True =
Offline; False = Online).
Indicates the number of minutes that must elapse
before bringing an N2 Controller online. This
attribute allows integration devices, such as the
MIG or VND, to gather status from their many
field points before being reported online by the
engine. With no delay, the N2 Controller reports
unreliable and causes nuisance alarms. This timer
is ignored when the Controller Type is not MIG or
VND.
Indicates whether the hardware device is
currently overridden.
Specifies the time to wait in milliseconds for a
response to an offline poll.
The Poll Delay attribute is writable only if UDP
Port is not zero. If UDP Port is zero and you
attempt to write Poll Delay, an error message
appears.
Specifies the number of message retries allowed
when the device is online, including the initial
attempt. Only one retry is attempted to an offline
device.
The Retries attribute is writable only if UDP Port
is not zero. If UDP Port is zero and you attempt to
write Retries, an error message appears
Indicates whether the hardware device is
currently under a trouble condition. Applies to BI
and BO objects.
Specifies the number of the trunk on which the
object resides.
Indicates the Ethernet UDP Port used for
N2 communication over the IP network. The
recommended UDP Port for N2 Trunk 1 is 4096
and for N2 Trunk 2 is 4097. Only valid on NAE5512
and NAE5513 models.

Table 337: N2 Errors
Error Number

Description

0

Controller has reset and is waiting for the Identify Yourself command

1

Undefined Command: command not understood by addressed controller

2

Checksum Error detected by controller

3

Input buffer overflow detected by controller

4

Invalid ASCII character detected by controller

5

Data field error: size of message not correct for command type

6

Invalid Data: one of the fields contains a value that is out of the expected range
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Table 337: N2 Errors
Error Number

Description

7

Invalid command for data type: command not appropriate for this field or
record

8

Command not accepted due to problems with the controller, the command is
ignored

9

Device at address is the wrong type

10

No additional records are available (end of search)

11

Controller not ready

12

Data not matching the item or function type

13

Nonexistent item or function

14

Temporarily impossible to access the item

15

Not a programmable item

16

Table programmed with illegal item

17

Trend programmed with illegal item

18

Invalid Function Module

19

Exceeding Addressing Range

20

Password Not Enabled

21

I2C bus communication error (see I2CE)

22

Hardware not available (see OPMO)

23

Illegal item number

24

Counters unreliable

25

Power supply unreliable

26

Checksum Error detected by NxE

27

Block Checksum Error detected by NxE

28

Controller type does not match NxE database

29

Controller revision is less than C03

30

Controller revision is less than B03

31

Controller revision is less than A03

32

Controller revision is less than C05

33

VMACOV error

34

VMA BAC error

35

VMA FMT error

36

Retry error not due to a NAK

37

Unknown NAK error

VND Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
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Table 338: VND Hardware Tab Attributes
Attribute Name
Disable Automatic
Alarming

Notes
C,W

Initial Value
False

Max Value

C,W

250.0 deg F

Min Value

C,W

-50.0 deg F

Field Value
Interface Value

Offline
Overridden

Priority

C,W

Protocol
Description
Protocol Revision

C

Protocol Revision
Date
Protocol Review
Time
Temporary Status
Item Expiration
Time
Trouble

C

VendorDriver

C

C
C,W

Values/Options/Range Description
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Applies to only AI, AO,
Indicates the current value of the field point.
BO, MI, and MO objects. Applies to only AI, AO, BO, MI, and MO objects.
Applies to only AI, AO,
Indicates the current value from the hardware
BO, MI, and MO objects. interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes. Applies to only AI, AO, BO, MI, and
MO objects.
Applies to only AO
Defines the highest reliable value for the Present
objects.
Value. Applies to only AO objects.
Applies to only AO
Defines the lowest reliable value for the Present
objects.
Value. Applies to only AO objects.
Applies to only AI, AO, BI, Specifies whether or not the point is offline.
BO, MI and MO objects. Applies to only AI, AO, BI, BO, MI and MO objects.
Applies to only AI, AO,
Indicates whether the hardware device is
BO, MI, and MO objects. currently overridden. Applies to only AI, AO, BI,
BO, MI and AO objects.
Applies to only AI, AO,
Specifies the priority for polling the vendor point.
BO, MI, and MO objects. Applies to only AI, AO, BI, BO, MI and MO objects.
Indicates the protocol supplied by the Vendor
DLL.
Indicates the revision of the protocol for reference
purposes.
Indicates the date the Vendor DLL protocol was
compiled.
Indicates the time the Vendor DLL protocol was
compiled.
0–65,535
Indicates how long a point remains in the polling
list.
Units = Seconds
Applies to only BI and BO Indicates whether the hardware point is currently
objects.
under a trouble condition. Applies to only BI and
BO objects.
Maximum characters = Contains data for proper configuration of the
80
integration.

Vendor
C,W
Configuration Data

Maximum entries = 128
Vendor DLL

C,W

Vendor Integration
Size
Vendor Reference C
Vendor Revision
Date
Vendor Revision
Time
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C
C

VENDOR.DLL
Units = bytes

Specifies the name of the vendor DLL to load at
startup.
Specifies the name of the vendor DLL to load at
startup.
Specifies the address of the vendor device.
Indicates the date of the Vendor integration
revision.
Indicates the time of the Vendor integration
revision.

Metasys Site Management Portal Help

XL5K Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 339: XL5K Hardware Tab Attributes
Attribute Name
Baud Rate

Notes
C,W

Initial Value
9600

Data Bits

W

8

Device Number

C,W

30

Device Type

C

Disable Automatic
Alarming

C,W

Device Configured
OK
Device Database OK

Device Health

False

Download Date

Download Time

Driver Name

XL5Kdrvr

Firmware Version

Values/Options Ranges Description
Indicates the baud rate of the integrated
Honeywell XL-5000 field device. Baud rates
typically encountered include: 4800, 9600, 19200,
38400, and 76800.
Uses Databits
Indicates the data bits used by the XL-5000
equipment. The valid data bits/stop bits value for
Honeywell protocol is 8/1.
Indicates if the Honeywell field device is fully
configured, ready to run, operational, and if its
database has objects.
Indicates if the Honeywell field device has a
fully populated database containing no errors,
corruptions, or missing parts.
OK or Fault
Indicates if the Honeywell field device is fully
operational, running, and has correct operations.
Range = 1–30
Indicates the number assigned to the NIE (as a
Honeywell field device on the C-bus).
Maximum Length = 18
Indicates the type of Honeywell field device.
characters
For example, the XL-5000 family: XL-10, XL-20,
XL-50, XL-80, XL-100, XL-300, XL-500, XL-600, Zone
Manager.
False
Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
True
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.
Displays the Date stamp returned from the
Honeywell field device (if extractable, otherwise
displays the date when the object was defined).
Displays the Time stamp returned from the
Honeywell field device (if extractable, otherwise
displays the time when the object was defined).
Indicates the protocol DLL driver name for this
integration (for example, XL5Kdrvr).
Indicates the firmware version of the receiver
module.

Hardware Version
Parity

W

Even

Uses Parity

Protocol Revision
Remote Name

C,W

Remote Object Type C

Honeywell device name
Undefined
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Indicates the hardware version of the receiver
module.
Indicates the parity used by the XL-5000
equipment. The valid parity for Honeywell
protocol is Even.
Indicates the current version number of the XL5K
Protocol Engine (PC104).
Indicates the existing name of the Honeywell field
device.
Indicates the type of remote object (for example,
Analog Input, Digital Output, and Pulse Input).
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Table 339: XL5K Hardware Tab Attributes
Attribute Name
Reset Date

Notes

Initial Value

Stop Bits

W

1

Trunk Number

W

1

Reset Time

Values/Options Ranges Description
Indicates the date of the last Clear Statistics
command.
Indicates the time of the last Clear Statistics
command.
Uses Stopbits
Indicates the stop bits used by the XL-5000
integration. The valid Data Bits value for
Honeywell protocol is 8/1.
Range = 0–6
Indicates the trunk number used for the
integration. This number is typically 1.

Input Category Tab
The Input Category tab appears on GIO objects and includes the status, description, and value of
the items in the category. See the Generic Integration Object section for details.

Interlock Definition Tab
The Interlock Definition tab appears on Interlock objects.

Load Tab
The Load tab appears on an object that has a load extension.

Load Summary Tab
The Load Summary tab appears on DLLR objects.

Logic Tab
The Logic tab appears on Program (Control System) objects, which are used for the LCT feature.

Members Tab
The Members tab appears on Life Safety Point and Life Safety Zone point objects.

Network Tab
The Network tab appears on Engine Device objects.

Options Tab
Attributes associated with the default state, control source, and restart options for an object
are shown under the Options tab of the display panel. Attributes marked with the letter C are
configurable and attributes marked with the letter W are writeable.
Table 340: Options Tab
Attribute
Name

Notes

Initial
Value

Values/Options/
Range

Description

Auto Restore

C,W

True

Applies to AO, BO,
MO, AV, BV, and
MV objects.

When True, the point restores the last
command on field device online/offline
transition.

Ok
Applies to AV, BV,
and MV objects.

Indicates the current status of the
connection between the AV/BV/MV
and the object that is specified in the
Connected To attribute.

Connected
Status
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Table 340: Options Tab
Attribute
Name

Notes

Connected To

C, W, N

Direction

C, W

Initial
Value

Values/Options/
Range

Description

Object Name,
Reference,
Attribute
Applies to AV, BV,
and MV objects.

Specifies an optional attribute
reference of another object in the
system to which the AV/BV/MV is
connected. The direction of the data
flow depends on the value of the
Direction attribute.

Not
Sends Value
Connected To; Receives
Value From; Not
Connected
Applies to AV, BV,
and MV objects.

Specifies the directional flow of
data if the Connection To attribute
is configured. If the Connected To
attribute is not set, this attribute is not
used. Three direction states can be
written:
•

Sends Value To: changes to
Present Value are sent to the
object/attribute configured in
Connected To.

•

Receives Value From: changes to
Present Value are received from
the object/attribute configured
in Connected To. If the AV/BV/MV
is set to Monitor Only=True, you
cannot set the Direction.

•

Not Connected: the object is
not connected to any source
or destination; the value of the
Connected To attribute is ignored.

Ignore
Relinquish
Default

C,W

True

Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

When True, the Relinquish Default
attribute is not used and has no effect.

Local Control

C,W

True

True or False
Applies to AO, BO,
MO, AV, BV, and
MV objects.

When True, the point is under local
control and the Present Value can be
commanded only with an operator
override command.

Relinquish
Default

C,W

Values and ranges
depend on object
type.
Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

Used as the default value for Present
Value when all command values in
Priority Array are Null.

Restore
Command
Priority

C,W

Uses Restore
Priority
Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

Allows you to select which commands
(at a selected priority) persist through
a supervisory device restart. When the
bit is set, the command (at the selected
priority) is saved at shutdown and
restored at startup.

Operator
Override
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Output Category Tab
The Output Category tab appears on GIO objects and includes the status, description, and value of
the items in the category. See the Generic Integration Object section for details.

Pager Tab
The Pager tab appears on some older Engine models that run a version of Windows Embedded
operating system. The newer Engine models that run a Linux operating system do not support
pagers. The Pager DDA Attributes appear on the Shared Configuration section of the Pager
Tab. The Pager DDA Destination Configuration Attributes appear when you edit a specific Pager
destination on the Pager Tab.
Table 341: Pager DDA Shared Configuration Attributes
Attribute Name
Connect Using

Initial Values
Internal Modem (0)

Description
Refer to the modem type.

Access Number

Data Type
One from a list of
values
Text

Redial Attempts

Number

3

Be sure to check the Access Number and Password
after an upgrade. In some cases, these values are
not maintained after upgrade.
Minimum Value = 0, Maximum Value = 32767

Time Between Redial
One from a list of
Attempts
values
Idle time Before Hanging Up One from a list of
values
Redial if Line is Dropped
True or False

1 Second (0)

Range Check = Use Limits
Refer to the Redial Delay (Set 565).

1 Minute (1)

Refer to the Idle Time (Set 566).

True

Databits

7

Whether the modem redials the number if the line
is dropped.
Refer to the Pager Databits

Even

Refer to the Pager Parity

1

Refer to the Pager Stopbits

000000

Supports alphanumeric and special ASCII
characters.

Parity
Stopbits
Password

Pager Diagnostics

One from a list of
values
One from a list of
types
One from a list of
values
Text

000000 is the standard default password for the
Telocator Alphanumeric Protocol used by the
pager.
Displays the communication between the Pager
DDA, modem, and customer's paging Service. It
displays both successful and unsuccessful attempts
to send a page.

Text

Table 342: Pager DDA Destination Configuration Attributes
Attribute Name

Description

Label

Identifies the user-friendly name for a pager destination in the list of
Pager DDAs.

Pager Phone Number

Specifies the phone number for the user’s pager.

Max Characters

Specifies the maximum number of characters supported by the pager
service provider.

Retries

Specifies the number or attempts made to send a message if there is a
failure before the system discards it.
Range: 0–10
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Table 342: Pager DDA Destination Configuration Attributes
Attribute Name

Description

Enabled

Defines whether or not the destination is enabled. When this attribute
is False, the Engine or Server does not deliver pager messages to the
configured recipients.

Filters

Specifies the rules to filter pager messages.
See Filters for more information.

Format

Defines the format of the message, indicating which fields are present
in the received message.
The following fields are optional:
•

Acknowledge Required (not an option for pager)

•

Authorization Category

•

Item Description

•

Item Fully Qualified Reference

•

Message

•

Previous Status

•

Priority

•

Site Name

•

Value

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Parameter Category Tab
The Parameter Category tab appears on GIO objects and includes the status, description, and value
of the items in the category.

Printer Tab
The Printer tab appears on Server objects. The Printer DDA Destination Configuration Attributes
appear when you edit a specific Printer destination on the Printer tab.
Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.
Table 343: Printer DDA Destination Configuration Attributes
Attribute Name

Description

Printer

Specifies the name of the printer where reports are routed.
The Printer DDA can send alarms to one or multiple printers.
Note: If you are uncertain about the proper printer name to use, print a
test page from the printer and look for the Printer name line in the test
printout. Copy the name and syntax exactly.

Font Face

Specifies the font used by the printed report.

Font Size

Specifies the font size used in the printed report.

Orientation

Defines the orientation of the printed report (landscape or portrait).
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Table 343: Printer DDA Destination Configuration Attributes
Attribute Name

Description

Line Out

Defines how many lines of data are required before the Printer
DDA routes reports to the printer. Setting this value to 0 enables
tractor-feed/line printing. See the Printer topic in the Alarm and Event
Management section.
Range: 0 to 60

Timeout

Timer (in minutes) that begins when the first alarm is stored in the
DDA line out buffer (Line Out). Upon expiration, the contents of the
line out buffer prints.

Printing Priority Threshold Specifies the priority for printing alarm messages. You can print
multiple alarms in a normal priority range at once using the Line
Out and Timeout attributes. You also can set the Printing Priority
Threshold to print the contents of the line out buffer immediately
when a higher priority alarm (such as a fire alarm) is detected. You
can set the Printing Priority Threshold to a value from 0 to 255.
When an alarm is received that has a lower priority number than the
Printing Priority Threshold (lower priority numbers have a higher
alarm priority), the contents of the line out buffer print immediately
when the higher priority alarm (such as a fire alarm) is detected, thus
printing the high priority alarm in addition to the contents of the line
out buffer.
For example, if the Printing Priority Threshold is set to 20, alarms with
a priority number of 20 or greater are buffered using the Line Out
and Timeout attributes. Receiving an alarm with a priority number
of 19 or less forces an immediate printout of the currently buffered
alarms plus the new high priority alarm.
This functionality applies when the Line Out attribute is set to 1
or greater. Also see the the Printer topic in the Alarm and Event
Management section.
See the Hi Normal Low.
Retries

Specifies the number or attempts made to print a report if there is a
failure before the system discards it.
Range: 0 to 10

Enabled

Defines whether or not the destination is enabled. When this attribute
is False, the Server does not deliver reports to the configured printer.
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Table 343: Printer DDA Destination Configuration Attributes
Attribute Name

Description

Filters

Specifies the rules to filter messages.
See Event Message Routing, Filtering, and Destinations for more
information.

Format

Defines the format of the message, indicating which fields are
present in the received message.
The following fields are optional:
•

Acknowledge Required (not an option for pager)

•

Authorization Category

•

Item Description

•

Item Fully Qualified Reference

•

Message

•

Previous Status

•

Priority

•

Site Name

•

Value

See Event Message Routing, Filtering, and Destinations for more information on this DDA.

Profile Tab
The Profile tab appears on DLLR objects.

Recipient List Tab
The Recipient List tab appears on Notification Class objects.

Remote Services Connection Tab
The Remote Services Connection tab resides on the Site Object and enables you to connect to the
cloud-based platform. Starting at Release 10.0, you can no longer configure a connection to a cloudbased platform with the attributes in the Remote Services Connection tab of the Site object. The tab
is appears but its attributes should no longer be defined.

Resource Tab
The Resource tab appears on an object that has a resource file extension.

Schedule Tab
The Schedule tab appears on Schedule objects.

Site View Tab
The Site View tab appears on Site objects.

SNMP Tab
The SNMP tab appears on Engine or Server objects. The SNMP DDA Attributes appear on the
Shared Configuration section of the SNMP Tab. The SNMP DDA Destination Configuration Attributes
appear when you edit a specific SNMP destination on the SNMP tab.
Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.
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Table 344: SNMP DDA Shared Configuration Attributes
Attribute Name

Description

SNMP Enabled

Specifies whether the SNMP feature is enabled. Once this attribute
is enabled, the ability to send and receive messages (Traps and
Gets) can be enabled or disabled on an individual basis using the
other SNMP DDA attributes.

SNMP Trap Version

Specifies the version used to send SNMP traps. The versions are
v1, v2c, and v3.

SNMP Management Device

Specifies an IP address or Host Name on which to filter Get
requests. SNMP only responds to requests from the device listed
in this attribute. If this attribute is 0.0.0.0, SNMP responds to all
requests.

SNMP Request Port

Specifies the port on the destination device that requests
information from the Engine or Server. The direction of
communication is from the destination device to the Engine or
Server. Currently, this function is supported only on hardware and
software-based network engines. For hardware network engines
that run with a Windows operating system, changing the value
of this attribute requires a restart for the change to take effect,
but for engines running the Linux operating system, a restart is
not required. Setting this attribute to 0 disables the Get feature of
SNMP.

Contact Person

Specifies the IT person who is responsible for managing SNMP
communications.

Public Community Name

A case-sensitive string used to authenticate v1 and v2c Get and
Get Next messages. This attribute contains the community string
used by the Network Management System to edit data in objects
maintained by managed devices.

SNMP Trap Message Format

Defines the message format used for generating SNMP Traps,
including the startup Trap. The options are:
•

String Based (default) - SNMP Traps are sent as a string of
characters

•

MIB Based - SNMP Traps are sent using the OIDs defined in
the Johnson Controls MIB (called, JCI MIB).

Table 345: SNMP DDA Destination Configuration Attributes
Attribute Name

Description

Label

The name of this destination when it appears in the Destinations
list.

Trap Community Name

A case-sensitive string used to authenticate v1 and v2c SNMP
Traps. This attribute contains the community string used by the
Network Management System to edit data in objects maintained
by managed devices.

JCI IP Address

Specifies the IP address or host name of the system that receives
the traps.
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Table 345: SNMP DDA Destination Configuration Attributes
Attribute Name

Description

Destination Port Number

Specifies the port on the destination device that receives
messages from the Engine or Server. The direction of
communication is from the Engine or Server to the destination
device. Setting this attribute to 0 disables the Get feature of SNMP.

Enabled

Specifies whether this SNMP destination is enabled or disabled.

Filters

Specifies the rules to filter alarms. This attribute uses Alarm Value
(Set 108). See Filters for more information.

Format

Allows you to select which attributes of a Metasys event are in the
SNMP Trap.
The following fields are optional:
•

Acknowledge Required (not an option for pager)

•

Authorization Category

•

Item Description

•

Item Fully Qualified Reference

•

Message

•

Previous Status

•

Priority

•

Site Name

•

Value

See Event Message Routing, Filtering, and Destinations for more information on this DDA.
For detailed information on SNMP, refer to the SNMP Agent Protocol Implementation appendix
located in the Network and IT Guidance Technical Bulletin (LIT-12011279).

Syslog Tab
The Syslog tab appears on Engine or Server objects. The Syslog DDA Attributes appear on the
Shared Configuration section of the Syslog Tab. The Syslog DDA destination Configuration
Attributes appear when you edit or create a new Syslog Destination on the Syslog tab.
Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.
Syslog has one Share Configuration attribute—Syslog Reporting Enabled. When the Syslog
Reporting Enabled attribute is set to True the feature is active and your error logging is forwarded
to your destination server.
Table 346: Syslog DDA Destination Configure Attributes
Attribute

Value / Description

Label

Destination name

Syslog Server

IP Address for the destination server

UDP Send Port

The designated port on the device for error transmitting to your
server.

UDP Receive Port

The designated port on your server for receiving the error transmits.

Event Filters

To add or remove Events from displaying

Audit Filters

To add or remove Audits from displaying
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Summary Tab
The Summary tab provides summary data for items in the navigation tree. For example, the
Summary tab of the MSTP Field Bus object shows summary data for the devices on the field bus.
The Summary tab shows the status, icon, item, value, and description information of the items. You
can view and edit items on this tab using the right-click menu options.
Note: Data appears in the Status column of the Summary tab when the status is not Normal
(for example, High Alarm).

Summary Definition Tab
The Summary Definition tab appears on Summary Definition objects used by the Tailored Summary
feature. This tab allows you to view and edit the Summary Definition object. Refer to the Tailored
Summaries section in the Metasys SCT Help (LIT-12011964) for more information on this object and
feature.

Tailored Summary Tab
The Tailored Summary tab appears when you view the folder containing the Tailored Summary in
the associated User View. This tab allows you to view the Tailored Summary you defined using the
User View and the Summary Definition tab. See the Tailored Summaries section in the Metasys SCT
Help (LIT-12011964) for more information on this feature.

Totalization Tab
The Totalization tab appears on an object that has a totalization extension.

Tree View Tab
The Tree View tab appears on User Navigation Tree objects, which are used by the User Views
feature.

Trend Tab
The Trend tab appears on an object that has a trend extension.

Trend Study Tab
The Trend Study tab appears on the Trend Study feature.

User Defined Enumeration Editor Tab
The User Defined Enumeration Editor provides the user interface for the quick modification,
creation, or deletion of User Defined Enumerations on a Metasys Site. Authorized users can modify
one or more User Defined Enumerations. This tool provides a solution for various change requests,
and satisfies requirements for new and future Metasys system features that need to provide the
user with the ability to define the displayed text for multiple User Defined Enumerations. The User
Defined Enumeration Editor is available in both the online (runtime) and offline (SCT) modes of the
Metasys system supervisory user interface. Access the tool by selecting the Custom Enumeration
tab of the Site Object.
•

For Release 5.2 and later, the Rediscover Text Strings operation generates custom
enumerations from all mapped BACnet and MS/TP objects. These custom enumerations are
backed up when the Site Director is uploaded in the Release 5.2 database. During the upgrade
process, a restored, upgraded, or downloaded Release 5.2 database maintains these custom
enumerations during the upgrade process.

•

For Release 6.5 and later, the User Defined States Text attribute is set to true whenever an
object has a custom enumeration set assigned to it.

•

Engines at Release 8.0 and later automatically read custom state sets text created in CCT and
display them in the SMP user interface, instead of the generic State 0 to State X text.
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Figure 60: User Defined Enumeration Editor

Table 347: User Defined Enumeration Editor Areas
Item

Name

Use

1

Add and Delete Custom
Enumeration buttons.

Add new or Delete existing User Defined Enumeration
Sets.

2

Edit OR Save and Cancel
Buttons.

When you select the Custom Enumeration tab there is
an Edit button here; upon selecting Edit, the button is
replaced by the Save and Cancel buttons.

3

Name

Name of the new or selected Enumeration set - limited
to 32 characters.

4

Size

Enumeration set size. This is the number of values
within the selected enumeration. You may not see
optimal performance if this exceeds 5 members.

5

Enumeration Entries

Entries within the selected enumeration. Cannot
be blank or white space. You may not see optimal
performance if this exceeds 10 characters.

6

List of existing user defined
enumeration sets.

Displays the current list of User Defined Enumerations.
This list is limited to 256 entries.

Graphic
Menu Selection: Insert > Graphic
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Inserts a graphic into the site.

User Graphics Tool (UGT)
Graphics provide a visual representation of the monitored systems that enable you to quickly check
the status of system symbols and recognize unusual system conditions. Graphics can be designed
to allow the user to move through buildings, floors, and other areas, viewing building systems and
control processes. You can view, create, and edit graphics using the User Graphics Tool (UGT).
User graphics are usually made up of three parts:
•

the Static Background image

•

Symbols

• Hyperlinks that allow you to navigate to graphics and web addresses
The UGT operates in two modes:
•

The Edit Mode allows you to edit an existing graphic or create new graphics.

•

The View Mode allows you to view existing graphic to monitor and command all systems
integrated into the Metasys network.
The UGT is available with the NAE, NIE, Metasys server, and SCT. You can access the UGT when you
are logged in to the Metasys user interface through any web browser. The Group Object represents
user graphics in the All Items navigation tree and can be displayed in any active display panel.
Note: If your graphics reference multiple Engines or multiple Metasys servers, and one device
needs to be downloaded, upload all Engine/Metasys servers prior to making changes in SCT.
This procedure ensures your graphics work consistently.
For information on default preferences for graphics (such as status colors, fan colors, state colors,
and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
For more information on configuring an NAE or NIE and for details on user access configuration,
see the Related Documentation table.

User Graphics Tool Concepts
Graphic Workspace
When viewing an existing graphic or creating new graphics, the UGT runs in the Graphics
Workspace, which is displayed in an active display panel. The default workspace background
is gray. The graphic workspace displays all graphical symbols and a user-selectable Static
Background. The UGT Toolbar shows only the appropriate tools for the UGT Modes that you are
working in, either View Mode or Edit Mode.

UGT Modes
The User Graphics tool runs in either Edit Mode View Mode. When you are generating new graphics
or editing graphics, the User Graphics tool is in Edit mode. When you finish editing and click save
and the UGT switches to View mode.
You can generate graphics in the Metasys system with the online mode or with the offline mode:
Online: Use this method if your web browser is connected to an Engine or Metasys server. In this
case, a new graphic is generated online in the device where the graphic resides during normal
operation. When you are finished creating or editing graphics, Upload the database to the archive
database in the SCT.
Offline: If your web browser is connected to the SCT. If this case, the new graphic is generated
offline and stored in the archive database. When you are finished creating or editing graphics,
Download the database to the device where the graphic resides during normal operation.
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Edit Mode
Edit mode is the mode used by the UGT to design and edit graphics. Access the Edit mode by
clicking the Edit button on the UGT Toolbar. In Edit mode, you have access to all toolbar items/
symbols and you can bind symbols to objects and link graphics to other graphics.
Right clicking in Edit mode brings up basic choices for editing graphics such as copy, paste, delete,
duplicate, hide, and zoom, depending on the type of item you select. Double clicking in Edit mode
brings up the binding information for a symbol.
For a list of mouse shortcuts, see the Mouse Shortcuts: Edit Mode topic.
View Mode
Graphics display in the View mode when you are navigating using graphics and when you first open
a graphic. Graphics appear in an active display panel. You must enter the Edit Mode (by clicking the
Edit button) to design or edit a graphic. In View mode, you have access only to a limited number of
items on the UGT Toolbar. The symbols in the palette on the left do not appear in this mode.
The View mode allows you to command an object bound to a Value Display Box or Analog Fill Bar
Graph and to click on Hyperlinks to access linked graphics. Double clicking on a bound symbol in
View mode displays the Focus view of the bound object.
For binary point objects, the value and status update every 10 seconds. For analog point objects,
the value and status update every 10 seconds. Commands and value changes return a new state/
value or error message within 10 seconds or less. The error message could be related to priority (if
the system can’t perform the requested function now) or failure to reach a commanded state or
value. Error messages appear in dialog boxes.
For a list of mouse shortcuts, see the Mouse Shortcuts: View Mode topic.

Toolbar
The UGT toolbar shows only the appropriate tools for the current mode of the UGT. The table below
shows the toolbar options available in Edit Mode and View Mode.
For information on mouse shortcuts, see Mouse Shortcuts.
Table 348: UGT Toolbar Options in Edit Mode and View Mode
Icon

Description

Visible In:
Edit
Mode

(Standard
Windows
Icons not
Shown)

Action Performed
View
Mode

Save

X

Saves all changes to the graphic and exits Edit
mode.

Cancel

X

Cancels any changes to the graphic (made
since the last save) and exits Edit mode.

Edit

X

Changes the UGT to Edit mode.
Note: This is the only toolbar item that
requires Configure Access (Security Administrator System).

Print

X

X

Brings up the Print dialog.

Print Preview

X

X

Brings up the Print Preview dialog.

Cut

X

Cuts the selected symbol out of the graphic.

Copy

X

Copies the selected symbol.
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Table 348: UGT Toolbar Options in Edit Mode and View Mode
Icon

Description

(Standard
Windows
Icons not
Shown)

Visible In:
Edit
Mode

Action Performed
View
Mode

Paste

X

Pastes a cut or copied symbol into the system.

Undo

X

Undoes the previous action (except for a save)
up to 4 actions.

Redo

X

Redoes the previous undone action up to 4
actions.

Set
Background
Image

X

Allows you to import the background of the
graphic.

Set Advanced
Image

X

Allows you to import an advanced graphic.

Save
Background
Image

X

Saves the background image.

Bind

X

Brings up the Bind Information dialog box
for the selected item. (This box is the same as
when you double click on an item.)

Select

X

Text

X

Pan

X

X

Turns the cursor into a hand that allows you to
pan over the diagram by dragging.

Marquee Zoom

X

X

Allows you to select an area to zoom in on.

Interactive
Zoom

X

X

Zooms in and out on a graphic when you hold
the mouse down.

Zoom - Fit
Window

X

X

Zooms the diagram to fit within the window.

Overview

X

X

Shows an overview of the entire graphic in one
window.

Selective Zoom

X

X

Allows you to select the percentage zoom
applied to the diagram.

X

Turns the cursor into a selection cursor.
Turns the cursor into a text cursor that allows
you to create a text box.

Static Background
Backgrounds are static images displayed in the background of a graphic. Backgrounds represent
buildings, floor plans, mechanical equipment, and any other picture that represents the location
or function of the equipment in the graphic. By default, a newly created graphic has a gray
background. You can insert a background image using a file based on SVG, SVGZ, or JPEG graphic
format.
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You can create SVG/SVGZ background images with graphic drawing packages or from established
libraries of images. We recommend using the Professional or Standard edition of Microsoft Visio
2003, 2007 or 2010 (32 bit) software and the AGSL to create background images. Alternatively,
you can use Microsoft Visio 2002 software with the GSL. SVGZ and SVG images must be created in
positive space (quadrant 1, on the positive X and positive Y axis).
Background images in JPG format are usually created with cameras or scanners. You cannot resize
a UGT background in JPG format, and if an area of the graphics workspace is not fully covered by
the JPG image, the exposed area defaults to gray.
Access available backgrounds with the background icon on the Toolbar.
For information on how to edit an existing background image, see Editing a Background Image.

Managing Graphic Creation
In general, you should store your graphic files on the Site Director. The Site Director provides
you with a uniform point of entry and traffic control. The Site Director allows information sharing
between users while minimizing network traffic.
NAE35/NAE45 Graphic Size Limitation
When you create or edit graphics with an online UI to an NAE35 or NAE45, changes you make
do not save if the graphic is too large. The total size of the graphic background, dynamics, and
static text must not exceed 700K bytes. A typical size for an SVGZ graphic is 100–200K. You do not
receive a warning that the graphic is too large to save. Transactions larger than 1 MB are rejected
by the NAE. The size limitation includes a 40% overhead from the HTML wrapper around the save
transaction.
Note: This size restriction does not apply to graphics that are created and saved through the
online UI to an NAE55, NAE85, or SCT.
When you work with NAE35/NAE45 graphics, use the following equation to help keep your graphics
at a manageable size:
(background image size x 140%) - 1 MB (1,048,576 bytes) = available space for graphic dynamic
symbols and text blocks
Note: Each graphic symbol is 3,000 bytes.
Example:
Background size: 700,000 bytes
Background + overhead: 700,000 x 140% = 980,000
Total Space for symbols and text = 1,048,576 - 980,000 = 68,576
Total symbol and text elements = 68,576 / 3,000 = 22

Symbols
Symbols are graphic elements or components that are inserted into graphics to represent the value
or status of equipment in your system. The UGT contains the set of symbols described in the table
below. In Edit mode, the symbols appear in a palette to the left side of the graphic workspace.
Symbols support drag and drop functionality. For more information, see Drag and Drop Shortcuts.
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Table 349: Symbol Descriptions
Symbol

Description

Buttons

Buttons allow you to hyperlink from one graphic to an item, URL, or
application.

Value Display Boxes

Value Display Boxes display the value and status of bound objects
and allow you to access the Focus view of the bound object. Value
Display Boxes also show the units used by the value.

Gauges

Gauges display the value and status of bound objects with
graphs, dials, and standard colors. UGT offers the following gauge
categories:
Analog Fill Bar Graph
Dial Gauge

Dynamics

Dynamic symbols indicate the value of bound objects. Some
of these symbols move as the object change. Members of this
category are:
Fans
Basic Shapes (Block)
Switch (2 or 3 State)

Button Symbols
Button symbols are useful when browsing to another graphic, object, or a website. Buttons support
the drag and drop functionality, allowing you to drag items from the navigation tree and drop them
in the graphic workspace with the following rules:
If you select multiple objects in the Navigation Tree and then drag a button to the Graphic
Workspace, the UGT creates buttons that Alias the selected objects.
If you select a graphic/object in the navigation tree and then drag a button to the graphic
workspace, the UGT creates a button bound to the selected graphic/object.
In Edit mode, after you drag and drop a button, click on it to add a label. If you double click on a
Button in the Edit mode, the Hyperlink Information box appears. Using this box, you can specify
to link the graphic to a graphic, object, or web page, choose display properties, and choose to hide
the button. See the Button Symbols topic for more information.
Only buttons support Hyperlinks.
In the View mode, left click on the Button to navigate to the bound object, graphic, or web page.
When your cursor passes over a button, the cursor changes into a finger pointer.
See the Buttons step section for information on binding Buttons.
Hyperlinks
Hyperlinks are links from one graphic to other items (graphics or other objects), URLs, or
applications using buttons. If you click on a button hyperlinked to an item, your view switches from
the current graphic to the hyperlinked graphic or object. If you click on a hyperlink to a URL, the
website appears in a separate browser window. If you click on a hyperlink to an application, the
application opens.
Only buttons support hyperlinks. Set hyperlinks when you bind a button symbol.
Value Display Boxes
Value Display Boxes are useful for displaying the value and status of a large number of objects in
a single graphic. The Value Display Box supports drag and drop functionality. If you select a single
item or multiple items in the navigation tree and then drag and drop a Value Display Box, the box/
es automatically binds to the selected item/s.
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If a Value Display Box is configured to display the Status of the bound object, the text and box
background appear in the standard Status Colors.
In View mode, Value Display Boxes appear as if they are editable boxes, but they are not. Double
click on the Value Display Box to display the Focus view for the bound object and right click to show
the command menu.
See the Value Display Boxes step section for information on binding Value Display Boxes.
Gauges Category
Gauges provide an indication of the present value and status for the bound objects. If you select
a single item or multiple items in the navigation tree and drag a gauge to the workspace, the UGT
creates one gauge per item and binds each symbol to an item.
The following table lists the gauges included in the UGT.
Table 350: Gauges
Gauge Type

Symbol

Animation

Analog Fill Bar Graph

Bar moves to indicate value of bound
object.

Dial Gauge

Dial needle moves to indicate value of
bound object.

Analog Fill Bar Graph
Analog Fill bar graph symbols show the present value of an object by changing the size of the
bar in the graph and indicating the present value as a number in the display box. The color of the
moving bar graph and the display box background color indicate the status of the bound object. We
recommend using Analog Fill Bar Graphs with analog objects.
You can define the minimum and maximum value of the bar graph range. If you don’t define the
minimum and maximum for the bar range, the gauge defaults to 0 for the minimum and 100 for
the maximum. Under the bar, a value box displays the numeric value of the bound object. Analog
Fill symbols can be configured to move vertically or horizontally. To change the orientation of the
Analog Fill box, see Gauges: Analog Fill.
In View mode, the display box appears as an edit box, but it is not editable. If you choose, the color
of the display box background shows the status of the bound object and the units used by the
symbol. Double click on the symbol to see the Focus view of the bound object and right-click to
show the command dialog box.
Dial Gauge
Dial gauges indicate the present value of a bound object with the position of a needle on a gauge.
A display box shows the present value as a number with units, and shows the status of the bound
object. We recommend using Dial Gauge with analog objects.
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You can choose the minimum and maximum value for the dial range. If you don’t define the
minimum and maximum for the dial range, the gauge defaults to 0 for the minimum and 100 for
the maximum.
In the View mode, the Dial Gauge appears as a circular dial with a needle pointing to the position
that represents the value of the bound analog object. A value box below the dial shows the numeric
value of the bound object. Double click the dial gauge to display the Focus view for the bound
object and right-click to show the command dialog box.
See the Gauges: Dial Gauge Symbol step section for information on binding Dial Gauges.
Dynamics
Dynamic symbols display the status of bound objects. If you select a single item or multiple items in
the navigation tree and drag a dynamic symbol to the workspace, the UGT creates one symbol per
item and binds each symbol to an item.
The dynamics category includes the symbols listed in the table below.
Table 351: Dynamics
Dynamics Type

Symbol

Animation

Fans

Fan/pump blades spin or
remain stationary.

Basic Shapes (Square, Circle, and
Triangle)

Colors change.

Switch (2 or 3 State)

Switch changes positions.

Fans
Fan symbols display rotational movement when bound to an object. Use this dynamic component
to provide animation capabilities for fans or pumps that appear in the background image. You
can choose either a clockwise or a counter-clockwise spin. We recommend using Fans with binary
objects.
In View mode, if the bound object has a value of 0, the fan appears stationary. If the bound object
has a value greater than 0, the fan/pump blade spins. The fan/pump color shows the state of the
bound object (red for Off, green for On).
If the fan is spinning, the bound object has a normal status or is unreliable, and the device that
the bound point resides on is online, the color of the fan is set to the color defined in the system
preferences for the On state. If the fan is not spinning, the bound object has a normal status or is
unreliable, and the device that the bound point resides on is online, the color of the fan is set to the
color defined in the system preferences for the Off state. If neither of these scenarios apply, the
color of the fan is defined by the status colors defined in the system preferences.
In the View mode, a double click on a fan symbol displays the Focus view of the bound object. A
right-click shows the command dialog box.
See the Dynamics: Fans step section for information on binding Fans.
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Basic Shapes
Basic Shapes show the status of the bound object. Any basic shape can be bound to either an
analog, binary, or multistate object. You can resize these symbols, which include a square, triangle,
and circle.
If a basic shape is bound to an analog object, in the View mode, the color of the shape indicates the
status of the bound object. White is normal, but other colors are listed. See Status Colors.
If a basic shape is bound to a binary object, in the View mode, the color of the shape indicates the
state of the bound object. By default, if the state is 0, the shape is white and if the state is greater
than 0, the shape is green. These can be configured by the user when you bind the symbol.
Double click on the shape to display the Focus view for the bound object. Right-click to display the
commands.
Tip: Use the circles to depict temperature sensors on a floor plan graphic. Circles and
rectangles can be used as status lights.
See the Dynamics: Basic Shapes step section for information on binding basic shapes.
Switch (2 or 3 State)
The Switch is a dynamic symbol that can be bound to an object, and can be configured to be either
a 2 or 3 state switch). User-defined text appears at the top of the Switch to show what state the
point is in. You can resize Switches. We recommend you bind a Switch to a binary or multistate
object.
In View mode, Switch symbols show the state of the bound object. Double click on the shape to
display the Focus view for the bound object. Right-click to show the command dialog box.
See the Dynamics: Switches step section for information on binding switches.

Binding Symbols to Objects
In the UGT you can bind symbols to objects, which allows the symbol to display the condition of
the bound object. Refer to each symbol section for details about which object type can be bound to
each symbol.
To speed up the binding process, select one item or several items (using the Shift or Control key)
in the navigation tree and then drag and drop a symbol into the graphic workspace. The symbol
automatically binds to the item or items selected in the tree.
To bind graphics in Edit Mode, see Binding Symbols to Objects in Edit Mode.
For information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

Status Colors
Status colors are used by symbols such as Value Display Boxes, Analog Fill Bar Graphs, and Basic
Shapes to indicate the status of a bound object. The following table lists the default status colors
used by the UGT.
Table 352: Status Colors
Status

Symbol Text Color

Symbol Background Color

Normal

Black

White

Alarm

Black

Red

Warning

Black

Yellow

Trouble

Black

Yellow

Offline

White

Black

Operator Override

Black

Orange

Out of Service

Black

Light Brown
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Note: All status color defaults can be changed in the Graphic Settings Tab in the Preferences
chapter.
See Binding Symbols to Objects in Edit Mode for information on binding graphics.

Alias
Aliases simplify the process of binding symbols to objects during graphic generation when a site
has several graphics that contain a common set of objects. The Alias feature allows you to use a
wildcard character (*) to represent a single string of characters that may be part of the complete
object reference as part of the binding information for a symbol. When a graphic is displayed in
View Mode, the alias symbol (*) is replaced with the text from the alias box of the symbol you used
to access the graphic. If you navigate to a graphic using an aliased button, you cannot edit the
graphic. To edit the aliased graphic, access it through the navigation tree.
For example, aliasing allows you to use a single aliased graphic for multiple field controllers, such
as VMAs, with similar configurations. See Creating Aliases.
Figure 61 shows an example of a main graphic and an aliased graphic. In the figure, the top panel
contains the main graphic, which has several buttons bound to the aliased graphic. Each button has
its alias string set to the reference for a different field device. The bottom panel shows the aliased
graphic, displayed directly from the navigation view (that is, with no alias strings passed in).
Figure 62 show the aliased graphic as it displays when the user clicks the corresponding buttons in
the main graphic (that is, with field device-specific values).
Figure 61: Alias Example - Main and Aliased Graphics
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Figure 62: Alias Example - Using the Aliases

For more information on binding graphics, see Binding Symbols to Objects in Edit Mode.

Navigation
You can navigate between graphics by using hyperlinked Button Symbols or by selecting graphics
from the navigation tree and displaying them in the Display Frame. You can restrict user access to
specific graphics by setting security levels in the Security Administrator System.
You can also create user views that contain only graphics (hierarchy of graphics references).

Commands
You can command objects that are bound to symbols by right clicking on the symbol in View Mode.
If you are not authorized to command the object, the command is disabled in the command dialog
box.

Mouse Shortcuts
Use mouse shortcuts to speed up User Graphics Tool use. See Mouse Shortcuts: Edit Mode and
Mouse Shortcuts: View Mode.
Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the User Graphics
Tool.
Table 353: Edit Mode Mouse Shortcuts
Item

Single Left Click

Double Left Click

Right-Click

Static Background No action takes
Image
place.

No action takes place.

Remove Background

Button

Select

Hyperlink Information
dialog box appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Value Display Box

Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align

Gauge: Analog Fill Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align
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Table 353: Edit Mode Mouse Shortcuts
Item

Single Left Click

Double Left Click

Right-Click

Gauge: Dial

Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align

Dynamics: Fan

Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align

Dynamic: Basic
Shape

Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align

Dynamics:
Switches

Select

Bind Information dialog box Cut, Copy, Paste, Duplicate,
appears.
Delete, Format, Align

Format
The Format menu choice contains the choices listed in the following table.
Table 354: Format Menu Options
Choice

Description

Copy Binding

Copies the selected symbol’s binding information, which you can then
paste to a new symbol. With this feature, you can easily bind several
symbols to one object.

Paste Binding

Pastes the previously copied binding information to the selected
symbol(s).

Copy Format

Copies the selected symbol’s formatting (size and font information), which
you can then paste onto another symbol. This allows you to easily format
multiple symbols in the same way.

Paste Format

Pastes the previously copied formatting information to the selected
symbol(s).

Align
The Align menu choice contains the choices listed in the following table.
Table 355: Align Menu Options
Choice

Description
Note: When you select multiple objects by dragging the mouse across them,
the first selected symbol is not based on the symbol's location within the
graphic, but on the order in which it was originally added to the graphic. We
recommend that you first click on the symbol with which you want to align
other symbols. Once you have selected that symbol, hold down the Shift key
while you drag the mouse across additional symbols to select them (you can
also use Shift + click to select additional symbols).

Align Top

Aligns all symbols to the top most edge of the first symbol you selected.

Align Bottom

Aligns all symbols to the bottom most edge of the first symbol you
selected.

Align Left

Aligns all symbols to the left most edge of the first symbol you selected.

Align Right

Aligns all symbols to the right most edge of the first symbol you selected.

Align Horizontal
Center

Aligns all symbols to the horizontal center of the first symbol you selected.

Align Vertical Center

Aligns all symbols to the vertical center of the first symbol you selected.
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Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the User Graphics
Tool.
Table 356: View Mode Mouse Shortcuts
Symbol

Single Left Click

Double Left Click

Right-Click

Button

Navigate to
hyperlink.

Navigate to hyperlink.

No action takes place.

Value Display Box

Select

Display focus view of
bound object.

Command box appears.

Gauge: Analog Fill

Select

Display focus view of
bound object.

Command box appears.

Gauge: Dial

Select

Display focus view of
bound object.

Command box appears.

Dynamics: Fan

Select

Display focus view of
bound object.

Command box appears.

Dynamic: Basic
Shape

Select

Display focus view of
bound object.

Command box appears.

Dynamics: Switches

Select

Display focus view of
bound object.

Command box appears.

Drag and Drop Shortcuts
Consider the following shortcuts when dragging and dropping items to the Graphic Workspace:
•

If you select a Graphic Object in the navigation tree and then drag a button to the graphics
workspace, the UGT creates a button already bound to the selected Graphic object.

•

If you select multiple field points in the Navigation Tree and drag a Value Display Box to the
graphics workspace, the UGT creates multiple Value Display Boxes each bound to a field point.

•

If you select multiple field points in the navigation tree and drag a dynamic symbol or gauge to
the graphics workspace, the UGT creates multiple symbols each bound to a field point.

•

If you select multiple field controllers along with a Graphic object in the navigation tree and
drag a button to the graphics workspace, the UGT creates buttons for all the controllers. All
buttons have the appropriate Alias string already entered.

•

To change the binding information for a symbol or to add binding information (if you drag
and drop a symbol without selecting anything in the navigation tree), see Binding Symbols to
Objects in Edit Mode.

User Graphics Tool Steps
Generating Graphics (Overview)
About this task:
Notes:
•

This process is the same when the system is offline, except the binding is done to the archive
database instead of the online system.

•

For information on default preferences for graphics (such as status colors, fan colors, state
colors, and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
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To create a complete graphic:
1.
2.
3.
4.

On the Insert Menu, select Graphic. The Graphic appears.
Follow the wizard instructions.
Drag the graphic from the Navigation Tree to the display panel.
Click on the Background Image icon on the UGT toolbar to import a Static Background image
into the graphic.
Note: To scale imported SVGZ Floorplans from Visio, cut the rescaled image from Visio.
Paste the image into Paint. Cut the image from Paint and use paste special as a Device
Independent Bitmap into Visio.

5.
6.
7.
8.
9.

Add Symbols as needed on top of the static background.
Bind the symbols to object.
Add Hyperlinks to the buttons and create aliases (if desired).
Save the graphic.
Download the graphic to the online device (if you have created the graphic with the Metasys
software offline using the SCT). Upload the graphic to the archive database of the SCT (if you
have created the graphic with Metasys software online).

Changing UGT Modes
To change from View mode to Edit mode, click the Edit button on the UGT Toolbar.
To change from Edit mode to View mode, click Save on the UGT toolbar.

Viewing User Graphics
To view user graphics, double click on or drag a graphic item from the Navigation Tree into the
Panel Layout.
Note: To be sure the graphic item drops completely, release the drop with your cursor over
the header section of the desired display frame.

Copying an Existing Graphic
About this task:
Note: This is available when using the SCT only.
1.
2.
3.
4.

Click an existing graphic item in the Navigation Tree.
On the Edit menu, select Copy.
Click in the navigation tree where the new graphic is to appear.
On the Edit menu, select Paste and name the new graphic.

Binding Symbols to Objects in Edit Mode
Buttons
About this task:
To bind buttons to items, URLs, or applications:
1.
2.
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Double-click a button. The Hyperlink Information dialog box appears.
Use the information in the following table to edit the fields.
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Table 357: Button Options
Field

Description

Hyperlink Type

Selects whether the button provides a link to an item, URL, or
application.

Item/URL/
Application

If you link the button to a URL, type the address here. If you link to an
item or application, click the Browse icon and see below. Applications
configured using the Metasys Preferences Applications Tab appear on
the drop-down menu.

Browse icon

Opens a dialog box for browsing to an item or application.
If you are linking to an item, UGT displays a navigation tree listing
graphics/objects you can bind to the button.
If you are linking to an application that is not in the Application dropdown menu, UGT allows you to navigate to and select an executable
file for an application that resides on your local file system or a
network drive.
Note: The linked application does not close when you exit the UI.

Hidden

Hides the button in the View mode, creating a virtual hyperlink on the
background image.

Alias

Passes the defined Alias string to the linked graphic when you press
the button.

Properties

Displays a dialog box to change font size and text justification for the
button label text.

OK

Accepts changes.

Cancel

Cancels changes.

Value Display Boxes
About this task:
To bind Value Display Boxes to objects:
1.
2.

Double click a Value Display Box. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
Table 358: Value Display Box Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Value Display Box. Or lets you click the Browse icon to
launch a tree browser to select the object to bind to the Value Display
Box.

Attribute

Allows you to select the specific attribute to bind to the Value Display
Box. The bound attribute is initially set to the object's Default
attribute, which varies per object type, but is typically Present Value.
If an object does not have a Default attribute, the value box
displays ???? on the graphic until you change the binding to a
different attribute.
You can bind to string values or to numeric values.
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Table 358: Value Display Box Options
Field

Description

Units

Shows the Units for the bound object in the Value Display box.

Status

Shows the Status for the bound object by color-coding the text and
background for the Value Display box.

Properties

Allows you to configure the text properties for the Value Display Box
text.

OK

Accepts changes.

Cancel

Cancels changes.

Result
Note: In the View mode, double clicking on the Value Display box displays the focus view for
the bound object. Right-click displays the commands.
Gauges: Analog Fill
About this task:
To bind Analog Fill symbols to objects:
1.
2.

Double-click an Analog Fill Bar Graph icon. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
Table 359: Analog Fill Gauge Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Analog Fill Gauge. Or, lets you click the Browse icon to
launch a tree browser to select the object to bind to the Analog Fill
Gauge.

Attribute

Allows you to select the object’s attribute to bind to the gauge.

Fill Color

Launches the fill color selector to select the color displayed by the bar
graph.

Orientation

Chooses vertical or horizontal motion of the bar graph.

High Limit

Sets the high number for the display range of the gauge.

Low Limit

Sets the low number for the display range of the gauge.

Units

Displays the units used by the bound object.

Status

Displays the status of the object in the display box of the symbol.

Properties

Allows you to configure the text properties for the text in the display
box of the gauge.

OK

Accepts changes.

Cancel

Cancels changes.

Gauges: Dial Gauge Symbol
About this task:
To bind Dial Gauge symbols to objects:
1.
2.
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Double-click the Dial Gauge symbol. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
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Table 360: Dial Gauge Symbol Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Dial Gauge. Or, lets you click the Browse icon to launch a
tree browser to select the object to bind to the Dial Gauge.

Attribute

Allows you to select the object’s attribute to bind to the gauge.

Gauge Color

Launches the color selector for the gauge to select the color displayed
in the center of the gauge.

High Limit

Sets the high number for the display range of the gauge.

Low Limit

Sets the low number for the display range of the gauge.

Units

Displays the units used by the bound object.

Status

Displays the status of the bound object in the display box of the
gauge.

Properties

Allows you to configure the text properties for the text in the display
box of the gauge.

OK

Accepts changes.

Cancel

Cancels changes.

Dynamics: Fans
About this task:
To bind Fan symbols to objects:
1.
2.

Double-click the Fans symbol. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
Table 361: Fan Dynamics Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Fan. Or, lets you click the Browse icon to launch a tree
browser to select the object to bind to the Fan.

Attribute

Allows you to select the object’s attribute to bind to the fan.

Clockwise/CounterClockwise

Selects if the Fan symbol spins in a clockwise or counter-clockwise
direction.

OK

Accepts changes.

Cancel

Cancels changes.

Dynamics: Basic Shapes
About this task:
To bind Basic Shapes symbols to objects:
1.
2.

Double-click the Basic Shapes symbol. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
For information on default preferences for graphics (such as status colors, fan colors, state
colors, and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
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Table 362: Basic Shape Dynamics Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Basic Shape. Or, lets you click the Browse icon to launch a
tree browser to select the object to bind to the Basic Shape.

Attribute

Allows you to select the object’s attribute to bind to the Basic Shape.

State 0

Allows you to set the color for State 0.
The default color is determined by the preferences. See Graphic
Settings Tab in the Preferences section for details.

State 1

Allows you to set the color for State 1.

State 2

Allows you to set the color for State 3.

State 3

Allows you to set the color for State 4.

All Other States

Allows you to set the color for all other states.

Orientation

For the triangle basic shape, chooses the position of the point (Up,
Down, Left, or Right).

OK

Accepts changes.

Cancel

Cancels changes.

Dynamics: Switches
About this task:
To bind Switch symbols to objects:
1.
2.

Double-click the Switch symbol. The Binding Information dialog box appears.
Use the information in the following table to edit the fields.
Table 363: Dynamic Switch Options
Field

Description

Object

Allows you to type in the Item Reference of the object you want to
bind to the Switch. Or, lets you click the Browse icon to launch a tree
browser to select the object to bind to the Switch.

Attribute

Allows you to select the object’s attribute to bind to the switch.

Number of States

Allows you to choose the number of states (2 or 3) the switch has.

State 0/1/2

Allows you to choose the text associated with each state.

OK

Accepts changes.

Cancel

Cancels changes.

Monitoring and Commanding Items Using Graphics in View Mode
About this task:
Note: The Metasys system user interface provides the capability to monitor and command the
Metasys system using graphics. To navigate through the system, see Navigating Graphics in
View Mode.
To monitor your Metasys system using graphics:
1.
2.
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Display graphics to show the status/state of your system components.
Navigate through the system.
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3.

To command objects/items using graphics, right-click on the symbol in View mode and select
the desired command.

Result
Note: Right-clicking has no effect on Button Symbols.

Navigating Graphics in View Mode
About this task:
To navigate graphics in View mode, double-click the symbol and navigate by one of the following
two methods:
1.
2.

Navigate to the hyperlink of a button symbol by clicking on the button.
Navigate to the Focus view of an object by double-clicking a Dial Gauge or Fan symbol.

Adding Symbols to the Workspace
To add symbols to the workspace, drag the symbol from the palette and drop the symbol into the
workspace.
Notes:
•

Depending on the symbol you are adding, be wary if items are selected in the navigation tree.
Some symbols automatically bind to items selected in the tree. See the Symbols topics for
more information on drag and drop capabilities.

•

For more information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

Deleting Symbols from the Graphics Workspace
To delete symbols from the workspace, select the symbol and press Delete on your keyboard or
right-click on the symbol and select Delete from the menu.

Adding Text Blocks
About this task:
To add text blocks in Edit mode:
1.
2.
3.
4.
5.
6.

Click the Text icon on the UGT Toolbar.
Click the workspace to select a location for the text. The text block appears.
Click the Select icon from the toolbar and double-click on the text block. The edit text box
appears.
Type in the text box and click OK.
Select the Select icon on the UGT Toolbar.
Select the text block and drag the sides to resize the block.

Editing Text Blocks
About this task:
To edit text:
1.
2.
3.

With the selection pointer tool, double-click on the block. The block opens for editing.
Change the text and click OK.
To change the text properties, right click on the text block and select Properties from the
menu.

Result
Note: You can change the font (type, size, bold, italic, bold italic), text color, background color,
and border visibility/color.

Metasys Site Management Portal Help

591

Editing a Background Image
About this task:
Use this procedure if you want to edit a background of a graphic by exporting it from the UGT. Use
this method when a copy of the existing background image is not available.
1.
2.
3.
4.
5.

Drag the desired graphic from the Navigation Tree to the display panel.
Click the Edit button on the UGT Toolbar to enter Edit Mode.
Click the Save Background Image icon on the UGT toolbar to save the static background
image to a location on your hard drive. The Save dialog box appears.
Enter a name for the background image, select the desired location on your hard drive, select
JPG or SVG format, and click Save.
Open the background image file in the desired graphic editing program. Edit the background
image as desired and save the file in SVG, SVGZ, or JPG format. See the Static background
image section for information on supported file formats.
Note: You can only save a background image under its original file type. For example, if
the background image was originally a JPG, you can save it only as a JPG now. You can
save SVG and SVGZ files as SVG or SVGZ.

6.
7.
8.
9.

Return to the graphic in the UGT.
Click the Set Background Image icon on the UGT toolbar to import the revised background
image file into the graphic.
Save the graphic.
Download the graphic to the online device (if you have created the graphic with the Metasys
software offline using the SCT). Upload the graphic to the archive database of the SCT (if you
have created the graphic with Metasys software Online Mode).

Result
Note: Save a copy of the background image file in a folder on your hard drive as a backup
method. If you decide to edit that background image later, you can edit your hard drive copy
and use the Set Background Image icon to re-import the background into the graphic in the
UGT. You also can use your hard drive copy in the event that you lose your databases and need
to recover the background image.

Creating Aliases
About this task:
See Alias for more information on aliases.
Note: Do not set the Graphic attribute for an alarm extension to an aliased graphic. Aliased
graphics do not display properly when displayed from the Alarms Window or Event Viewer.
1.
2.

Create a graphic with an appropriate background image, and add value boxes to represent
common field points.
For each value box, edit the bound reference and use a wildcard character (*) to replace the
portion of the reference specific to a particular supervisory device, field trunk, and/or field
controller.
For example, change the bound object reference for a Zone Temperature AI from
ADS1:NAE1/N2 Trunk 1.VMA-1.ZN-T to *.ZN-T. This is your aliased graphic.
Note: One wildcard character is allowed per reference, and all wildcard characters used
in bindings for a particular aliased graphic must represent the same string.

3.
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Create a separate main graphic to use as the access point for your aliased graphic.
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4.
5.

On the main graphic, add a button bound to the aliased graphic. Give the button a name
indicating the field device it represents (see Tip below).
Set the alias string for the button to the text that should replace the wildcard in the reference
for the value boxes on the aliased graphic.
For the example above, the alias string would be:
ADS1:NAE1/N2 Trunk 1.VMA-1

6.

Repeat step Step 4 and step Step 5 to add buttons for additional field controllers, setting the
alias string appropriately for each.
For example, ADS1:NAE201/N2 Trunk 2.VMA-43.
Tip: You can use the following shortcut steps to quickly create the buttons for your
aliased graphic on your main graphic:
a.
b.

Display your main graphic in the Display panel, and click Edit.
Select the aliased graphic in the All Items navigation tree, then use Ctrl + click or Shift +
click to select the items to use with the aliased graphic.
For the example given earlier, select VMA-1 under N2 Trunk on NAE1, and VMA-43
under N2 Trunk 2 on NAE 201.

c.

With the aliased graphic and other items selected in the navigation tree, drag the
Button from the UGT palette into the graphic display area. A new button appears in the
main graphic for each item. Each button is labeled with the item name, bound to the
aliased graphic, and has its alias string set to the full reference of the selected item (for
example, ADS1:NAE1/N2 Trunk 1.VMA-1).
Find the button on the main graphic that has its alias string set to the aliased graphic
(labeled with the name of the aliased graphic). This button is no longer needed, so you
may delete it.
Save your changes.

d.
e.

Result
Once you have finished configuring your main and aliased graphic, display the main graphic in the
online UI. Use the buttons on the main graphic to open the aliased graphic for each field device.
See Figure 61 and Figure 62.

Saving a Graphic
To save a graphic, click the Save button on the Toolbar.

Graphics+
Graphics+ files created with the Graphic Generation Tool (GGT) provide comprehensive and threedimensional views of building automation systems that allow you to monitor the status of a single
building or an entire campus of buildings. Unusual conditions are quickly identified on a dashboard
screen that can navigate deep into a building, floor, or zone. With minimal navigation, you can
diagnose a problem and take corrective action. You can view historical data directly within the
graphic, further enabling effective problem diagnosis. You can also issue commands from the
graphic.
Graphics+ files are created offline with the GGT, a stand-alone application that runs on a computer
with a supported Microsoft Windows operating system. These graphics are then saved as Metasys
objects (typically on the Site Director) and viewed within the Site Management Portal UI in any
active display panel.
Graphics are usually made up of three parts:
•

one or more background images

•

animated HVAC elements, ductwork or piping, and/or floor plan information
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•

buttons that allow you to navigate to other graphics, applications, and Web addresses

You can access a graphic when you are logged in to the Site Management Portal UI through any
Web browser. The XAML Graphic Object represents a Graphics+ object in the All Items navigation
tree. You can open these graphics in any active display panel.
For information about Graphics+ symbol and element functions, refer to the Graphics+ Runtime
Help (LIT-12011708).
For information about creating and editing Graphics+ files, then saving the graphic to an online
device (ADS, ADX, or supervisory controller) or offline to an SCT archive database, refer to the
Graphic Generation Tool Help (LIT-12011697).

Graphics+ Concepts
Graphics+ View
Graphics appear in the navigation tree as stand-alone items. You can access graphics from a
Tailored Summary, the Alarm Pop-ups window, or the Associated Graphic tab of a Field Controller
device. The icon below identifies a Graphics+ graphic.
Figure 63: Icon for Graphics+ Graphics

When you open the graphic, a Display Control tool appears in the upper left corner of the active
display panel. Use the Display Control to zoom and pan a graphic. You can also open the Trend
Module from this control. See Figure 64 and Table 364 for details on the Display Control tool.
Figure 64: Graphics+ Control Tool
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Table 364: Components of Display Control Tool
Callout

Name

Description

1

Collapse

Hides the Display Control tool. After you hide the tool,
a faint arrow appears that allows you to restore the
tool.

2

Fit to Window
(center block)

Zooms the graphic to fit in the frame.

3

Zoom Ball with Zoom Ring

Allows you to zoom by moving the ball clockwise
(zoom in) and counterclockwise (zoom out) along the
zoom ring.

4

Turn On/Off Panning

Enables and disables the panning tool that allows you
to move the graphic in the workspace.

5

Move (four arrows)

Allows you to pan up, down, left, and right over the
graphic in set increments.

6

Current Zoom Level

Displays the current zoom level.

7

Turn On/Off Zoom Mode

Enables and disables the manual zoom (magnifying
glass) that allows you to re-center the graphic and
zoom in an out.

8

Tools Menu

Drops down a list of Tools. At this time, only the Trend
Module is available.

9

Trend

Opens and closes the Trend Module. This option
appears when you click the Tools down arrow.

10

Move Display Control

Allows you to move the Display Control tool to a
different area of the graphic.

Navigation
You can navigate between graphics using various types of elements of a Graphics+ graphic or
by opening the desired graphic from the navigation tree. You can restrict user access to specific
graphics by setting security levels in the Security Administrator System.
You can also create user views that contain only graphics (hierarchy of graphics references).

Commands
You can command objects that are bound to graphic symbols using two methods. The first method
is to left-click the object’s Inline Command Box or Advanced Value Box, then edit the value of
the object. If commanding is disabled for that symbol, the value is not be editable. The second
method is to right-click the object’s Inline Command Box, Advanced Value Box, or other elements
of Graphics+ symbols such as gauges, to open the User Actions Panel, then select More Commands
to bring up the Metasys commands dialog box. With both methods, if you are not authorized to
command the object, the command selection is disabled.

User Actions Panel
You can open the User Actions Panel for a graphic element by right-clicking the graphic element.
The User Actions Panel is a submenu of options that appears adjacent to the graphic element
(Figure 65). The panel in the Site Management Portal UI supports three actions: View, Command,
and Trend (SCT only supports View; Trend only appears for trended objects). To view the Focus
window for the object, select its name (for example, ZN-SP). To command the object, select More
Commands. To view trend data for the object in the Trend Module, select View Trend. If more than
one attribute is trended, select View Trend, then click the attribute name. User access to all three
actions is set with security levels in the Security Administrator System.
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Figure 65: Opening a User Actions Panel

Behaviors
Many elements of Graphics+ graphics support built-in or configurable behaviors.
Elements that support behaviors can flash if the bound object is in an alarm or warning state,
change color based on the bound object's state or status, or show or hide depending on the bound
object's state or status.
In the Metasys UI, the elements of the Graphics+ graphic display the behaviors as the bound
object's state or status changes.
Note: Support of behaviors is limited in SCT.

Trend Module
From a Graphics+ object, you can view trended data for any object in the Site Management Portal
UI with the Trend Module. The object must be displayed in the graphic and have at least one trend
extension defined. Examples of graphic elements that support the Trend Module include any value
box (for example, Basic Value Box, Inline Command Box, and Key Data Item), any basic shape, the
LCD display in the Room Control Module, gauges, and the Room Status element. The Trend Module
shows trend data from the device’s online buffer, not from archived samples stored in a historical
database.

Opening the Trend Module
To open the Trend Module for an object on a Graphics+ graphic, click View Trend from the
element’s User Actions Panel. The Trend Module appears with the charted trend data. If more
than one trended attribute is available, click View Trend to display a submenu that lists all available
trended attributes. Click a trended attribute to open the Trend Module.
Figure 66: Selecting a Trend to Add to the Trend Module

If you want to open the Trend Module without adding or changing its content, click the Tools dropdown arrow on the Graphics+ Display Control tool and select Trend. The Trend Module reappears in
its last state and condition.
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Figure 67: Reopening the Trend Module

Closing the Trend Module
You close the Trend Module by clicking the X in the upper-right corner of the Trend Module screen.

Trend Module Chart Functions
See Figure 68 and Table 365 for explanations of the Trend Module chart components.
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Figure 68: Graphics+ Trend Module - Chart Functions

Table 365: Descriptions of Trend Module Chart Components
Numbe Name
r

Description

1

Plot Area

Plots the trend data for all objects added to the Trend Module.

2

Box Zoom

Zooms in for the area that is highlighted. To enable box zoom,
place the cursor inside the plot area, hold down the mouse and
drag left or right. A white shadow appears to outline the zoom
area.

3

Callouts

Indicates the name of the trended object with its value at the
selected moment in time (white vertical line).

4

Maximize

Changes the size of the Trend Module to its maximum size
within the constraints of the Metasys display panel.

5

Close

Removes the Trend Module from the screen.

6

Zoom Out

Returns the chart to its original size. This option is only
available if the chart is currently zoomed in.
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Table 365: Descriptions of Trend Module Chart Components
Numbe Name
r

Description

7

Right Y Axis
(state data)

Indicates the axis that is plotting the discrete states for objects
currently displayed in the Trend Module. Metasys objects that
are displayed on this axis typically consist of Boolean or multistate values.

8

Right Pan Arrow

Shifts the chart to display more recent trend data.

9

Newest Date/Time

Displays date and time of the last value that appears on the
chart.

10

Moment in Time
(X Axis)

Indicates the date and time of the value at a particular location
on the chart. The date/time information as well as a vertical
moment in time line is displayed as you move the mouse over
the chart. The units along the x-axis always represent time.

11

Oldest Date/Time

Indicates the date and time of first sample that appears on the
chart.

12

Left Pan Arrow

Shifts the chart to display older trend data.

13

Left Y Axis
(numeric)

Indicates the axis that is plotting the numeric values for objects
currently displayed in the Trend Module. Metasys objects that
are displayed using this axis typically consist of analog values.

14

Scroll Bar

Adjusts the range of data that appears on the chart. Also
zooms in and out when you resize the scroll bar. To zoom, click
and drag the left/right arrows of the scroll bar. To pan, drag
the scroll bar left or right.

15

Refresh

Updates the trend data for all objects shown in the Trend
Module.

Trend Module Legend Functions
See Figure 69 and Table 366 for explanations of the Trend Module legend components.
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Figure 69: Graphics+ Trend Module - Legend Functions
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Table 366: Descriptions of Trend Module Legend Components
Number Name

Description

1

Legend Splitter Bar

Resizes the space taken by the legend. Move the
splitter to the bottom or double-click the splitter bar
to hide the legend and increase the size of the trend
chart.

2

Legend Icons

Display both the color and the y-axis that is used to
display the trend data for the trended object in this row
of the legend. The legend color assigned to an object
matches its trended values in the chart, so that you
can correlate information between the legend and the
chart.
Four preset trend line colors are used: blue, orange,
violet, and white. The colors cannot be customized.
These icons are used:
Icon

Description
The forward facing L indicates that
the left y-axis is used for this trend
series, which displays numeric values.
The backward facing L indicates that
the right y-axis is used for this trend
series, which displays state values.

3

Show/Hide Trend

Selects which objects currently appear in the chart.
Click this box to hide and unhide trend data.

4

Object Name

Displays the name for the trended Metasys object.
When you click the object name (or its row), the
corresponding line in the chart is highlighted.

5

Trend Name

Displays the name of the trend that appears in the
chart. If more than one trend is available for this
trended object, a drop-down box appears from which
to select.

6

Navigate

Navigates away from the Trend Module and the
graphic and opens the trend data for the attribute. If
you are not authorized to view the object, the navigate
button is disabled.

7

Remove

Removes the trended object and its associated data
from the Trend Module.

Loading Indicator
A loading indicator appears in the chart area while the system is retrieving trend data.

Trend Module Repositioning
You can reposition the trend module anywhere within the graphic’s display panel, but not across
panels in a multiple-panel layout. To move the Trend Module, drag the title bar.
You can dock the Trend Module by dragging the module outside the panel boundary on the top,
bottom, right or left side of the Metasys display panel. The Trend Module does not support multiple
monitors.
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Zoom Operations
You can zoom in the chart by holding down the mouse and sliding across the chart (either to the
left or to the right). This action activates drag zoom. Zoom works for values on the x-axis, not values
on the y-axis. To zoom out, click the Zoom Out link that appears in the upper right corner on a
zoomed chart.
You can also zoom from the horizontal scroll bar by clicking and dragging on the ends of the scroll
bar.

Legend Operations
Once the trend data is plotted, use the check boxes in the legend to hide or unhide trend values
from appearing in the chart. If you want to remove the trended object from the legend and the
chart, click the Remove icon (X).
To highlight a specific trend object and its data, click on its name in the legend. This action sends
the selected series and its associated y-axis information to the foreground of the chart.
If you try to plot a trended attribute that was deleted or whose object is offline, its legend icon is
blank and a user message box appears.
Figure 70: User Message: No Trend Data Available

Trend Module Limitations
The limitations of the Trend Module are as follows:
•

A maximum of 500 data points can be displayed for a single trended object. No data older than
2 years can be displayed.

•

The trend data originates from the device’s online buffer; samples stored in a historical
database such as the JCIHistorianDB archive database are not included.

•

You can open only one Trend Module per graphic.

•

The Trend Module can chart a maximum of four trended Metasys objects. If you try to plot a
fifth object, a user message box appears.
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Figure 71: User Message Example: Full Trend Module

•

The Trend Module does not support nested trend extensions. For example, the Trend Module
cannot chart totalization extensions that contain a trend extension.

•

You cannot save the Trend settings for later use. Once you close the graphic, you need to
select the objects for the trend module again.

Refresh Function
The Trend Module does not automatically refresh with new data samples. Use the refresh button to
display the latest trend data within the Trend Module.

Error Handling
If an error occurs while stored trend samples are retrieved (for example, the bound trend object
does not exist or its supervisory device is offline), the chart line for this trend series does not
appear. The error message Could not retrieve trend information appears as a tooltip for
the existing legend item.

Graphics+ Steps
Viewing Graphics
To view a graphic, double-click or drag the Graphics+ object from the Navigation Tree into the Panel
Layout.

Monitoring and Commanding Items Using Graphics
About this task:
Note: The Site Management Portal UI provides the capability to monitor and command the
Metasys system from a graphic.
To monitor your Metasys system using graphics:
1.
2.

Open a graphic to display the current status/state of system components.
Navigate through the system.
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3.

To command Metasys objects or items using graphics, right-click the graphic element to open
the User Actions Panel and click More Commands. Select from the available commands.
To change the value of a Metasys object or item from an inline command box, click inside
the box, type a new value, and press Enter. For information on the runtime behavior of a
particular graphic element, refer to the Graphics+ Runtime Help (LIT-12011708).

Navigating Graphics
To navigate graphics, click the image or navigation button in the graphic tonavigate to the linked
graphic.

Opening the User Actions Panel from a Graphic
About this task:
To open the user actions panel from a graphic:
1.
2.

3.

Open a Graphics+ object to display the current status and state of system components.
Right-click the graphic element. The User Actions Panel that applies to the object appears. If
no panel appears, this element does not support the User Actions Panel. Supported elements
include value boxes, room status elements, the LCD display within a Room Control Module,
basic shapes, and gauges.
Select an action.

Opening the Trend Module from a Graphic
About this task:
Note: You can open the Trend Module from a User Actions Panel or from the Graphics+
Display Control tool.
1.
2.

3.

Open a Graphics+ object.
To open the Trend Module from a User Actions Panel, right-click a graphic element to open
its User Actions Panel. Supported elements include value boxes, room status elements, the
LCD display within a Room Control Module, basic shapes, and gauges.
Click View Trend. If more than one trend is available, click View Trend, then select from the
list of trended attributes that appear in the submenu. The Trend Module loads and plots the
trend data.
Note: If View Trend does not appear in the User Actions Panel, this object has no trend
extension.

4.
5.
6.

For more details, see Trend Module.
To open the Trend Module from the Graphics+ Display Control tool, click the Tools drop-down
arrow. The Trend option appears.
Click Trend. The Trend Module appears either blank (no trend data selected) or replots the
trend data for the objects you selected earlier.

Graphic Object
The Graphics object defines the attributes that represent a defined user graphic for a given set of
objects. Graphic objects must exist under a container object or under another Graphic object (this
allows you to link graphics together).
For detailed information on the User Graphics Tool, see User Graphics Tool (UGT).

Graphic Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
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Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 367: Graphic Object Attributes - Focus/Configuration Tab
Attribute Name Notes
File Name

Initial Value

Writable

Values/Options/
Range

Attribute Description
Specifies an XML file containing a user interface
tree.

Table 368: File Name Attribute
Element
Name

Data Type

Initial
Value

Exportable

True or
False value

False (0)

Object
Reference

List of
References

References

True or
False value

Relative
Path

Text

False (0)

Relative Path: The name of the file relative to the
directory containing the .moi file for the device.

XAML Graphic Object
The Extensible Application Markup Language (XAML) Graphic object defines the attributes that
represent a defined Graphics+ file for a given set of objects. XAML Graphic objects are created
exclusively with the GGT and are saved on an SCT computer, or supervisory device as a file with
an .xaml file extension.
Note: The Object Type for this object is labeled XAML Graphic in the software.
For detailed information on viewing XAML Graphic objects, refer to the Graphics+ Runtime Help
(LIT-12011708).
For detailed information on the Graphic Generation Tool that is used to create and modify XAML
Graphic objects, refer to the Graphic Generation Tool Help (LIT-12011697).
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.

Trend Studies
Menu Selection: Insert > Trend Study
Inserts a trend study into the site.
Tip:
•

With the Trend Study tab selected on the Configure Screen, click the plus icon to add
trend items, or click the minus icon button to delete trend items.

•

Select the Configuration tab on the Configure screen for further configuration.

The Metasys Historical Data Management feature allows you to collect and store historical samples
of Engine object data. Metasys Trend Studies allow you to view the historical data. Using this
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information, you can manage energy usage, bill tenants, prove compliance to standards, and
diagnose problems in your Metasys system. You can also trend attributes of system objects. With
the addition of an ADS Device Object to your network, the Metasys system provides long-term
storage of historical data and you dramatically increase storage capabilities.
See the Site Object and Engine Device Object.
The Engine allows you to add Trend Extensions to objects. The Trend Extension contains all of
the trend definition information associated with the object. Each trend is associated with a single
attribute of that object and collects historical data samples of that attribute. With Trend Extensions,
data is collected in the Engine only, but you can configure the Engine to transfer the data to the
Metasys server for long-term storage. For more information on extensions, see Extensions.
Do not confuse the trend study with the Trend Viewer or Trend Extension. For information on Trend
Extensions or the Trend Viewer, see the Trend Extensions and Trend Viewer sections.
For performance information on trends, refer to the Metasys System Configuration Guide
(LIT-12011832).

Trend Studies Concepts
Historical Data Overview
Basic Historical Data Management begins with the Engine trend extension. Each Engine attribute
that can be trended can store historical data samples about the attribute. Sample storage in
the Engine is limited to the size of the individual Trend Buffer. For storage of long-term or large
numbers of samples, configure your system to store historical data in the Metasys server. Use the
Trend Extension to view and configure trends in the Engine and the Trend Study to view trend data
from the Engine and/or Metasys server.
Note: Although multiple trend extensions can be added to an object on an NxE, these
extensions will be combined as a single trend if sent to a Historical Data Repository. This may
not yield the expected result. To use multiple trends on a single object in an Historical Data
Repository, create duplicate AV or BV objects and that map to the point in question, then
create a new trend on the parallel AV or BV.

Historical Data Management in a Metasys Server
When you add a Metasys server to your Metasys system, trend data can be placed in a Historical
Data Repository for long-term storage. If your Engine is configured to route trends to the Metasys
server, the Metasys server stores the trends in the Historical Data database. The Metasys server
utilizes a standard database management system that supports archival storage.

Trend Studies
Accessible through the navigation tree, Trend Studies display trend sample data from trends
in Engine trend buffers and/or Metasys server repositories. A Metasys server on the site is not
required to retrieve trend data from the Engine.
When you create a Trend Study, you use the Trend Study wizard to choose the sources for the
trends and the display properties.
An Audit Trail message is created whenever you create, delete, or edit a Trend Study. Trend Studies,
graphics, and folders are the only items you can create under a Metasys server on the navigation
tree.
The main advantages to using Trend Studies are that you can:
•

view multiple trends at once (from both Engine and Metasys server)

•

view Metasys server historical trend data

•

configure the Study Range with flexible parameters
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Note: You do not need a Metasys server on the site to forward trend samples to a Metasys
server. You can forward trend samples to a Metasys server on a different Metasys site. See the
for Metasys server information.

Views
There are three views in the Trend Study: Chart View, Table View, and Definition View.
Table 369: Views
Button

View

Description

Chart View

Allows you to view trend data in a chart format.

Table View

Allows you to view trend data in a table format.

Definition View

Allows you to view the Trend Study setup and display
options.

Trend Study Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data.
You can zoom, unzoom, and pan within the Chart. You can also specify the X-axis and Y-axis ranges.
You can change the Y-axis type to view the chart using stacked Y-axis or single Y-axis.
Table 370: Chart View
Button

(Zoom)

Name

Description

Update

Retrieves the most recent data samples for the displayed
trends.

Zoom

Toggles the mouse behavior for the chart between zoom
mode and normal mode.
While in zoom mode:

(Normal)

•

drag the mouse over an area of the chart to zoom in
on that area.

•

click Zoom to exit zoom mode and restore the mouse
to normal mode.

•

left-click to zoom out one level.

When you exit zoom mode, the chart remains at the
current zoom level. Use the Restore button to fully zoom
out on the chart.
Note:

Restore
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•

You cannot pan while the mouse is in zoom
mode.

•

You can also zoom and unzoom in normal mode
by using the Shift key and the mouse. To zoom,
hold the Shift key down while dragging the
mouse across the chart. To zoom out one level,
left-click the mouse while holding the shift key
down.

Allows you to return to an unzoomed view and Allows you
to return to an unzoomed view and switches the mouse
back to normal mode if the chart's zoom mode is active.
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Table 370: Chart View
Button

Name

Description

Pan

Allows you to pan the view of the chart vertically or
horizontally by dragging the mouse across a zoomed
chart. Panning is not available for unzoomed charts or
when zoom mode is active. To pan left or right, drag
the mouse over the X-axis. To pan up or down, drag the
mouse over the Y-axis.

Points Line

Displays the data using lines and point markers. The
Points Line chart is the default chart type in chart view.

Area

Displays the data using an area chart.

Bar

Displays the data using a bar chart.
Note: Only use the bar chart when the number of data
samples can reasonably be expected to display as bars. If
too many data samples exist when you click this option, the
display becomes unstable and fails to properly update the
screen. To recover, select any other display option.

Points

Displays the data using markers, with no lines.

Line

Displays the data using lines, with no markers.

Stacked Y-axis

Displays a separate Y-axis for each trend.

Single Y-axis

Displays the trends using a single Y-axis.

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click
in the panel to display the menu.
Table 371: Chart View Right-Click Menu
Menu Item

Description

Background Color

Opens the Select a Color dialog box and allows you to configure the
background color.

Y-axis Scale

Displays the Y-axis Range Configuration dialog box.

X-axis Scale

Displays the X-axis Range Configuration dialog box.

Gridlines

Allows you to select what type of gridlines to appear on the chart. You
can choose: None, X and Y, X Only, and Y Only.

Chart Type

Allows you to select what type of chart to display. You can choose:
Points Line, Area, Bar, Points, and Line.

Stacked Y-axis

Displays the chart on a stacked Y-axis.

Chart Legend
The Chart Legend appears below the graphical charting area. The Chart Legend displays the list of
trend items for the Trend Study in a table, and includes information about each item.
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Table 372: Legend
Button/Field

Name

Description

Select All

Selects the maximum number of trend items for display in
the chart.

Remove All
Selections

Deselects all trend items in the chart Legend.

Show

Indicates if the trend item appears in the Chart. When
checked, the data appears on the chart and in the table.
When unchecked, the data does not appear in the chart or
table.

Historical Trend
Icon

Indicates the trend was selected from the Metasys server
Historical Database folder.

Marker

Indicates the appearance of the marker style and color for
the trend item on the Chart.

Color Palette

Displays the Select a Color dialog box. Allows you to
change the color used to chart the trend data.

Name

Displays the trend item name based on the Name
attribute.

Reference

Displays the trend item’s full reference.

Chart Legend Right-Click Menu
You can right-click an item in the Chart Legend to access item-specific menu options. The right-click
menu content is based on the type of item you click on. For example, if you right-click a trend item
from a historical database, you can only Refresh the Trend Study display.

Trend Study Table View
The Table view of the Trend Study allows you to view data for the selected trends in a table format.
You can copy the trend data to the clipboard for pasting into other applications such as Microsoft
Excel.
Table 373: Table View
Button

Name

Description

Update

Updates the data samples with new trend data
immediately.

Copy to
Clipboard

Allows you to copy selected trend data to the system
clipboard for pasting into other applications such
as Microsoft Excel. You can also use Ctrl + C to copy
selected trend data.

The Historical Trend Icon
appears in the Table
View column headings
when applicable.

Trend Study Definition View
Use the Definition View to edit the Trend Study configuration. You can choose which trends are
viewed, choose the Study Range, and edit the display properties. You can view more than one trend
item at a time on the same graph. The following table details the fields in the Definition View.
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Table 374: Definition View
Field

Description

General

Allows you to edit the refresh rate and display precision.

Range Start
and Range
End

Chart Display

•

Refresh rate: specifies the amount of time, in seconds, for automatic refresh
of data. You must configure this attribute with a value of 0 seconds, 60
seconds, or greater than 60 seconds. Values 1 to 59 are invalid and not
allowed. 0 means manual refresh. If the refresh rate is 0, click the Update
button to display new data.

•

Display precision: specifies the decimal point rounding and the number
of decimal places used to format real values that do not report a display
precision. If the value reports a display precision, this Trend Viewer attribute
is ignored in favor of the value’s native display precision.

Specifies the Start Time and End Time for the Trend Study.
•

Radio Buttons: allows you to choose relative time or absolute time for the
Study Range (start and end times). The fields enable depending on which
one you select.

•

Date: displays the date for the Study Range.

•

Absolute Time: allows you to select a specific date and time for the Study
Range. This selection creates a fixed range of time when the Study is viewed.

•

Relative Time: allows you to select either Today or Now. If you select Today,
enter the Relative Time. If you choose Now, specify an Offset. This selection
creates a moving range that is relative to the time the Study is viewed.

•

Offset: represents a combination of a whole number of days, hours, minutes,
and seconds before or after (- or +) the current date and time.

Allows you to add gridlines, stack the Y-axis, and choose the chart style for the
Trend Study.

Definition View Trend Items Table
The Trend Items table appears at the bottom of the Definition view. The Trend Items table displays
the list of the Trend Study’s trend items.
Table 375: Trend Items Table
Button

Name

Description

Historical Trend
Icon

Indicates the trend was selected from the Metasys server
Historical Database folder.

Add

Opens the Select Item dialog box and allows you to add
trend items to the Trend Study. This button only enables
when the view is in edit mode.
Note: All items and navigation trees appear in the Select Item
window; however, you can only select trends. All other items
appear dimmed.
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Remove

Allows you to remove a trend item from the Trend Study.
This button only enables when the view is in edit mode.

Name

Displays the name of the trend item.

Reference

Displays the trend item’s reference information.
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Table 375: Trend Items Table
Button

Name

Description

Aggregate Function Allows you to select the aggregate function to use on the
trend sample data (NONE, Average, Minimum, Maximum,
Standard Deviation, Range, Sum, and Variance). You can
sample the same point for different aggregate functions
and display them on a single chart. Aggregate functions
group multiple values together to construct a single value
that has significant meaning or measurement. Descriptions
of available aggregate functions are as follows:
•

Average: the sum of values divided by the total
number of values

•

Minimum: the lowest value of a set of values

•

Maximum: the highest value of a set of values

•

Standard Deviation: the amount of variation or
dispersion of a set of data values

•

Range: the difference between the lowest and highest
values on a particular scale

•

Sum: the addition of two or more numbers

•

Variance: the quantity equal to the square of the
standard deviation

The aggregate functions of the trend study apply to
information in the Historical Data at the Metasys server
server and do not apply to data in the NAE buffer.
Aggregate Interval

Specifies the time, in minutes, over which the aggregate
function should be applied (for example, 60 for an hourly
calculation, or 1,440 for a daily calculation).

Plotting Style

Allows you to select the plotting method for the trend item.
•

Continuous - straight line between data samples.
Continuous plotting connects samples with the
shortest possible line, giving an appearance of a set of
diagonal ramps as samples change value.

•

Discrete - line stays at the same value until the next
data sample is taken (good for binary data). Discrete
plotting has 90-degree angles at the time when
samples change value. The chart appears to be a series
of steps.

Study Range
The Study Range is the time period used to filter trend data. The Trend Study gathers and displays
the trends that are taken during this time period.

Default Destination
The ADS Repository defines where trend samples are sent when the local trend buffers reach their
defined Transfer Setpoint (see the Trend Extensions section), the Engine defined ADS Delivery Time
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(see the Engine Device Object) is reached, or the user initiates a transfer. You can initiate a transfer
by using the Trend Extension’s Route command.
Notes:
•

You do not need a Metasys server on the site to forward trends to a Metasys server. You
can forward trend samples to a Metasys server on a different Metasys site. The off-site a
Metasys server that receives forwarded trend samples must be the Site Director of its site.

•

You can define only one repository as the default destination for each Engine.

For more information on a Metasys server default trend destinations, see Configuring the Metasys
Server as the Destination for Trend Data.

Trend Studies Steps
Setting Up Trend Studies (Overview)
1.
2.
3.
4.
5.

Create a Trend Extension.
Configuring the Metasys Server as the Destination for Trend Data
Configure the trend extension to pass trends to the ADS/ADX.
Configure the ADS/ADX to forward trends to another ADS/ADX trend repository (if desired).
Create a Trend Study.

Result
Notes:
•

If you have a site with an ADS/ADX and engines, and you create a Trend Study on an
engine (rather than on the ADS/ADX), any trend items added to the trend study from the
ADS/ADX’s Historical DB folder is listed with the current site name in their references
instead of their actual site names.

•

When referencing trend items that were forwarded from an off-site device, create the
trend study object on the ADS/ADX, rather than on the engine.

Configuring the Metasys Server as the Destination for Trend Data
About this task:
Notes:
•

You can define only one repository as the default destination.

•

If you need to provide long-term storage for trend samples from an Engine, follow these
steps to configure the Trend Repository of a Metasys server as the Default Destination.

To configure the a Metasys server Trend Repository as the Default Destination for trend samples
from an Engine:
1.
2.
3.
4.
5.
6.
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Select the Engine device in the navigation tree.
View the Engine. See Displaying Information About an Item for more information on how to
display an item.
Select the Focus tab and click the Advanced radio button to display additional item
information.
Select Edit.
Edit the ADS Repository and the ADS Delivery Time. (The Engine Device Object attributes table
contains Default Value and Values/Options/Range information for the attributes.)
Click Save.
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Note: If you want to define the a Metasys server attributes for the entire site instead
of at the individual Engine level, select the Site in the navigation tree and edit the ADS
Repository and the ADS Delivery Time. (The Site Object attributes table contains Default
Value and Values/Options/Range information for the attributes.)

Configuring the Trend Extension to Pass Trend Data to the Metasys server
To configure the Metasys server as a default destination for trends, you must configure the
Repository Enabled and Transfer Setpoint attributes in the Trend Extension. See the Object Help
section.

Configuring a Metasys Server to Forward Trend Data to Another Metasys Server
Trend Repository
1.
2.
3.
4.
5.
6.

View the original Metasys server.
Select the Focus tab and click the Advanced radio button to display additional item
information.
Select Edit.
Scroll down to the Repository Storage section.
Edit the Metasys server Device Object's attribute.
Click Save.

Creating Trend Studies (Overview)
About this task:
Note: Before creating a Trend Study, create a Trend extension. See Setting Up Trend Studies
(Overview) for details.
1.
2.
3.
4.
5.
6.

From the Insert Menu, select Trend Study.
Follow the Trend Study’s wizard steps. The new study appears in the Navigation Tree.
Drag the study to the Panel Layout.
On the Definition View, click Edit and configure the fields (see Trend Study Definition View)
as you want them.
Add trend items to the Trend Item table using the add button. The Select Item window
appears.
Select one or more trend items.
Notes:
- Multiple selection adds multiple items.
- All non-trend items appear dimmed. If everything appears dimmed in the Select
Item tree, check to see if you have at least one object with a Trend Extension and/
or that Engine devices from other sites are storing samples in the Metasys server (if
applicable).

7.
8.
9.

Click OK. See Adding New Trend Items to the Trend Study.
Click Save.
Click the Chart or Table buttons to see trended data in the specific format.
Note: If nothing appears in the chart or table, check to see if you have samples in your
study range and adjust if necessary.

Editing Trend Studies
1.
2.

View the Trend Study.
Click the Definition View button.
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3.

Click the Edit button.

4.

Make your changes using the table in the Trend Study Definition View section, including
adding new Trend Items.
Click the Save button to save the changes.

5.

Viewing Trend Studies
About this task:
Note: To create Trend Studies, see Creating Trend Studies (Overview).
1.

From the navigation tree, drag the Trend Study you want to view to the Panel Layout.

2.

Select the Definition View button to edit the Trend Study. Select the Chart View or Table
View buttons to view the trend data.

Result
Notes:
•

The UI limits the number of data samples you can retrieve. Therefore, you may not see
the full range specified. The most recent data samples are always retrieved first.

•

If the chart appears to flicker, you have too many trend samples in the Trend Study.
Reduce the number of displayed trends or change the trending date/time range to
display fewer samples and improve performance. See Deleting Trends from the Trend
Study.

Deleting Trend Studies
1.
2.

Select a Trend Study in the navigation tree.
Select Edit > Delete Items and answer Yes to the Confirm Delete box.

Adding New Trend Items to the Trend Study
1.
2.
3.
4.
5.

View the Trend Study.
If necessary, click the Definition View button.
Click the Edit button in the upper left of the Trend Study tab.
Click the Add icon in the Trend Items table. The Select Item dialog box appears.
Select the trend(s) that you wish to add from the Select Item dialog box.
Notes:
- Multiple selection adds multiple items.
- All non-trend items appear dimmed. If everything appears dimmed in the Select
Item dialog box, check to see if you have at least one object with a Trend Extension
and/or that Engine devices from other sites are storing samples in the Metasys
server (if applicable).

6.
7.

Click the OK button in the Select Item dialog box.
Click the Save button in the Definition View to save the changes.

Deleting Trends from the Trend Study
1.
2.
3.
4.
5.
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View the Trend Study.
Click the Definition View button.
Click the Edit button.
Select a trend in the Trend Item table.
Click the Remove icon. The Remove confirmation dialog box appears asking if you want to
remove the trend item. Click Yes.
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6.

Click Save.

Configuring the X-axis
About this task:
To configure the X-axis in the Chart view:
1.
2.
3.

Place your cursor on the chart and right-click.
Select the X-axis Scale. The Range Configuration dialog box appears.
Specify whether to Use Automatic Range Calculation. The automatic range is determined
automatically based on the set-up in the Definition View.
Notes:
- You are limited to dates and times between the start and end dates configured in
the Trend Study definition.
- When you select Use Automatic Range Calculation, you do not fill in the Range
fields.

4.
5.

Specify the Start Time, Start Date, End Time, and End Date.
Click OK.

Result
Note: You can also configure the X-axis range by changing the start and end dates and times
in the Definition View. See the table in the Trend Study Definition View.

Configuring the Y-axis
About this task:
To configure the Y-axis in the Chart view:
1.
2.
3.
4.

Place your cursor on the chart and right-click.
Select the Y-axis Scale menu item. The Range Configuration dialog box appears.
If you are using stacked Y-axis, choose the trend item to which the Y-axis range should be
applied from the item drop-down list.
Specify whether to Use Automatic Range Calculation. The Range is determined
automatically based on the trend items.
Note: When you select Use Automatic Range Calculation, you do not fill in the Range
fields.

5.

Specify the minimum and maximum values for the Y-axis.
Note: When you use stacked Y-axis, click Apply to apply the changes to a specific
trend item. You can continue setting the ranges for other trend items in the Range
Configuration dialog box.

6.

Click OK.

New User View
Menu Selection: Insert > User View
Inserts a user navigation view (also referred to as user view, user-defined navigation tree, and userdefined tree) item into the All Items navigation tree. In online mode, the user view appears as a
separate tab in addition to the All Items navigation tree if the user has permission for the user view.
In online and offline modes, the user view appears in the User Views folder under the Site in the All
Items tree.
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Assign permissions to user views using the Security Administrator System in the online mode. You
cannot assign permissions to user views in the SCT.
Tip: On the Configure screen, click the Configuration tab for further configuration.

User Views
User views (user-defined navigation trees) contain references to selected items found in the All
Items navigation tree (the default navigation tree). For example, you could create a user navigation
tree with all the AIs grouped together, or a navigation tree that contains only points for a certain
area of a building. User views are useful for restricting access for certain users and grouping
commonly used items/graphics together. You can use the user view edit capabilities to easily
consolidate small user views into a larger view, or to break large user views into multiple smaller
views. Specify the User View navigation display as either a set of tabs (Tabbed) or a drop-down list
(List) in the Default navigation display preference in the Display Settings Tab in the Preferences
section. We recommend list view if the system has many user views, as list view takes up less space
in the navigation tree pane. User views provide a mechanism for viewing Tailored Summaries. See
the Tailored Summary Concepts section in the Metasys SCT Help (LIT-12011964) for more information.
User views are easy to create. The system supports drag-and-drop functionality of items from the
Global Search Results table to add them as references in a User View. To do this, view both the
Global Search Viewer and the User View in the display frame (using a multiple panel view). Click Edit
in the User View. Then drag the desired items from the Search Results table to the User View. The
system also supports drag-and-drop functionality to add references to items from the navigation
frame (User View [online] or All Items tree) to a User View in Edit mode. In addition, to add an
entire tree (only from the navigation frame) to a User View, press the Ctrl key and drag and drop
the tree to a User View in Edit mode.
For more information on the wizard used to create a user view, see the New User View section. For
more information on the object created by this wizard, see User Navigation Tree.
The Security Administrator System allows administrators to assign user view permissions to specific
users (in the Online UI only). For information on the Security Administrator System, see Related
Documentation.

User Views Concepts
User View Behavior by Mode
User views appear and function differently, depending on what mode you are in (Table 376).
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Table 376: User Views in Modes
Mode

Location in UI

Offline (SCT)

Online (SMP)

Simulation

•

Behavior Notes

User Views folder
in the All Items
navigation tree

•

create, edit, and delete user views

•

copy and paste user views

•

drag and drop the user view into the Display
frame for editing

User Views folder
in the All Items
navigation tree

•

create, edit, and delete user views

•

•

User View tab

drag and drop the user view into the Display
frame for editing

•

Security
Administrator
System

•

click a user view tab to display the user view
as an actual tree in the navigation frame.
In this tree, you can view and navigate to
items.

•

assign permissions to the user views
(through Security Administrator System)

•

•

User Views folder
in the All Items
navigation tree

User View Authorization
User view authorization is based on the security privileges assigned to your user account
by a Metasys Administrator. Authorization uses navigation permissions and category-based
permissions.
Your navigation permissions determine which user views display in the navigation frame of the
online UI. Only the user views assigned to you or your assigned security roles appear. When a user
view is created online, navigation permissions for the view are automatically assigned to the user
who created the view. When a user view is created offline in the SCT and then downloaded to the
site, no navigation permissions are assigned. In this case, the user view does not display in the
navigation frame for any users. The Metasys Administrator must assign permissions to all users
and/or roles requiring the navigation view.
Your category-based permissions determine if you are allowed to create, view, edit, or delete a user
view from a particular authorization category (for example, HVAC). Category-based permissions are
separate from navigation permissions.
Note: A User View can contain objects assigned to categories that a user does not have
permissions for. In this case, the objects appear in the User View navigation tree, but the user
cannot access any information from these objects.
Alarm notification is not limited or affected by the current user view, only by the user’s permissions
for managing item events. Therefore, it is possible for a user to receive an alarm for an item that
does not exist in the currently displayed user view.

User View Structure
User views provide graphical, functional, and geographical organizations of your Metasys system.
For example, you might create a user view comprised only of nested references to graphics. Or you
may organize your user view with separate levels for campus, building, floor, room, and so on. You
may even create a separate user view for each user, to provide that user a focused view into the
system or to restrict the user’s access.
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Table 377: User View Structure Icons
Button Icon

Button Name

Description

User view folder

A folder created in the user
view.

Reference to a folder

A reference in the user view
to a folder from the All Items
view.

The structure, or hierarchy, of a user view is based on the following general rules:
•

User view folders may contain any number of additional child folders or other references. For
example, you can add multiple Summary Definition objects for the Tailored Summary feature
to a user view folder.

•

You cannot nest anything under a reference to a folder.

•

Graphic references may contain any number of additional graphic references.

•

With the exception of graphics, references may only be nested under user view folders (that is,
a non-graphic reference cannot be a child of a reference). References do not need to be nested
to exist in the User View.

•

Any item may be referenced any number of times within the user view hierarchy.

Tree View Tab
The Tree View tab appears when you are adding a user view with the New User View or when you
display an existing user view for editing.
Table 378 shows the buttons in the Tree View tab and when to use them. All the functions
represented by buttons in Table 378 are also accessible through the right-click menu. Table 379
describes the functionality available in the Tree View tab.
Table 378: Tree View Tab Buttons/Right-Click Menu
Button Icon
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Button Name

Description

Add Reference(s)

Adds one or more items to the user view. When you add a
reference to an item that has children in the navigation tree,
the children are not included in the user view.

Add Tree(s)

Adds an entire user view, an entire folder hierarchy, or single
item reference to a user view. When you add an item using
this button, you add the item and all of its children to the
user view.

New Folder

Creates a new folder in the user view. Use this button to add
a folder to a user view.

Remove

Removes anything you select from the user view. The
Remove button removes not only what you select, but all
children of the item you select.

Move Up

Moves a selected user view item up in the user view. This
button changes the order of items in the navigation tree but
does not nest items. See Drag and Drop in the Table 379.

Move Down

Moves a selected user view item down in the user view. This
button changes the order of items in the navigation tree but
does not nest items. See Drag and Drop in the Table 379.

Metasys Site Management Portal Help

Table 378: Tree View Tab Buttons/Right-Click Menu
Button Icon

Button Name

Description

Sort Ascending

Sorts the items in the user view in ascending, alphanumeric
order. You can sort items at any level in the user view (for
example, the folders directly under the User View or the
contents of a folder). The items are sorted only one level
down (not subsequent levels).

Sort Descending

Sorts the items in the user view in descending, alphanumeric
order. You can sort items at any level in the user view (for
example, the folders directly under the User View or the
contents of a folder). The items are sorted only one level
down (not subsequent levels).

Edit Label

Changes the label used for an item within a specific user
view. Changing the label for an item in the user view does
not affect the item’s Name attribute or reference, and does
not affect the label used for other occurrences of the item in
the same or other user views.
To change the label for an item, triple-click the item or rightclick the item and select Rename.

Find and Replace

Repairs or updates site, Engine, or Metasys server identifiers
in the references of items stored in the user view. The
references are used to identify the items in the view, and
updates from this feature do not affect the items themselves.
You cannot use this feature to find and replace field device
identifiers within references. See Find and Replace.

Table 379: Tree View Tab Functionality
Functionality

Description

Ctrl/Shift Keys

Selects multiple items in the Select Item dialog box, which is displayed when
you click Add Reference or Add Tree.

Drag and Drop

Moves the selected reference or folder, and its nested items, to a new location
within the user view. When you are dragging an item to a collapsed folder,
hover the mouse pointer over the collapsed folder for a moment and it
automatically expands. To change the order in which items appear within a
parent folder or under a graphic, see Move Up and Move Down in Table 378.
Note: You can drag and drop objects from the all items tree or any other user
view into the user view you are editing. When you drag/drop an object with children, only the parent object is added to the user view.

Find and Replace
The Find and Replace button appears on the Tree View Tab. You can use the Find and Replace
option after renaming a site/device to update references to the new site/device name. This feature
resolves any references that may have become broken due to the name change. See the following
table for search options.
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Table 380: Search Options
Button

Description

Full Reference

Updates the first occurrence of the specified text in all references with the
replacement (Replace with) text. Enter the reference text and the new text
and click Find. A list of references is generated. Click Replace All to update
all references, or select a reference and click Replace to update a reference
individually.

Site Name Only

Updates the site identifier in all references to the site name where the user
navigation view resides. This value comes from the user navigation view’s full
reference and is not editable in this dialog box. Click Find. A list of references
is generated. Click Replace All to update all references, or select a reference
and click Replace to update a reference individually.

Device Name Only Replaces the Engine or Metasys server device identifier in item references
with a different device identifier. All Device Names is entered by default, but
you can specify a specific device name if desired. Enter the new name and
click Find. A list of references is generated. Click Replace All to update all
references, or select a reference and click Replace to update a reference
individually. The device identifier updates in the references for the selected
item and its children.
You also can use the Find and Replace option in online mode to quickly duplicate user view
hierarchies for supervisory devices with similar configurations.
Note: The Select Item dialog box contains the set of views that appear in your navigation
frame. Because user views do not appear in the navigation frame in the SCT, these steps work
only in online mode.
For example, perhaps you have several NAEs on your site that have the same set of N2 controllers
and field points under their N2 trunks. You can create a user view to group your field devices and
field points for NAE-1 into a logical system-based or geographical hierarchy. You can then duplicate
the NAE-1 user view to create the same references and hierarchy for NAE-2.
Follow these steps:
1.

Create a user view referencing NAE-1 items (for example, field devices and/or field points),
organizing the items in folders as desired.

2.

Refresh all tabs in the navigation frame to update the navigation views displayed in the UI.

3.

Create and edit a new user view for NAE-2, or edit the user view you created for NAE-1.

4.

Add items to the new NAE-2 user view.
a. Click Add Trees (see Table 378) to display the Select Item dialog box.
b. In the dialog box, select the tab for the user view you created for NAE-1.
c. Select the items you wish to duplicate (choose the root node to duplicate the entire
navigation view).
d. Click OK. The Select Item dialog box closes, and the selected items and their children
appear in the NAE-2 user view.

5.

Use the Find and Replace feature (Device Name Only in the Table 380) to replace the NAE-1
identifier with NAE-2 in the references for the duplicated items.

6.

Save your changes when finished.
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User Views with Tailored Summaries
The Tailored Summary feature relies on the User View feature to provide a mechanism for viewing
Tailored Summaries. After defining Summary Definition objects, add them to a folder in the User
View through the All Items tree. Then view the Tailored Summary through the User View (that is,
view the User View folder to display the Tailored Summary). See the User View Editor, Workflow, and
Defining User Views with Summary Definitions topics in the Tailored Summaries section in the Metasys
SCT Help (LIT-12011964).

User Views Steps
Creating a User View
About this task:
See User View Authorization for details on the user view permissions.
To create a user view:
1.
2.

On the Insert menu, click User View.
Follow the wizard instructions. See New User View for information on the wizard. See Table
378 and Table 379 for details on using the Tree View tab.

Editing a User View
About this task:
Notes:
•

The Edit menu or Right-click > Delete functions are not used to delete items from a User View
while the User View Editor is open. Using either function permanently deletes selected items
from the archive.

To edit a user view:
1.
2.
3.

Browse to the user view (in either the User Views folder in the All Items navigation tree or by
selecting the user view tab).
Double-click the user view. The user view editor appears in the Display frame.
Click Edit and work with the user view as follows:
- Use the New Folder button to add a folder.
- Use the Add Reference(s) and Add Tree(s) buttons to add references to items.
- Use drag-and-drop functionality to add references to items from the navigation frame
(User View [online] or All Items tree) to a User View in Edit mode.
- Use drag-and-drop functionality to add references to items in a User View from the
Global Search Results table. View both the Global Search Viewer and the User View in the
display frame (using a multiple panel view). Click Edit in the User View. Then drag the
desired items from the Search Results table to the User View.
- Press the Ctrl key and drag and drop a tree (only from the navigation frame) to a User
View in Edit mode to add an entire tree to the User View. This functionality does not
apply to the Global Search Results table.
- Select one or more items and use the Remove button to remove items.
- Sort the items in the user view using the Sort Ascending and Sort Descending buttons.
- Use the Move Up and Move Down buttons to reorganize the order of the items.
- Use the Edit Label button to rename items.
- Use the Find and Replace button to resolve broken references after changing the
Site Director or to duplicate user view hierarchies for supervisory devices with similar
configurations. For details, see Find and Replace.
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For information on the buttons and functionality in the Tree View tab, see the Tree View Tab
section.
For information on the attributes in the Focus tab, see the Summary Definition Object.
4.

Click Save when finished.

Deleting a User View
About this task:
To delete a user view:
1.
2.
3.

Select the user view in the User Views folder of the All Items navigation tree.
On the Edit menu, select Delete Items.
Click Continue in the Delete Items wizard dialog box. The user view disappears.

Consolidating User Views
About this task:
You can consolidate multiple small user views into one larger user view.
To consolidate user views:
1.
2.
3.
4.
5.
6.

Create a new user view, or edit an existing user view. This is the user view to which you add
other views to consolidate them.
With the user view in Edit mode, select the location (root or existing folder) where you would
like to add the contents of another user view.
Click Add Tree. The Add Tree(s) dialog box appears.
In the Add Tree(s) dialog box, select the tab for the user view you would like to add.
Select the root node of the user view you would like to add.
Click OK.
Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation
frame) to a User View in Edit mode to add an entire tree to the User View.
A new folder, which contains the contents of the user view you selected, appears in the user
view you are editing. If you would like to rename the folder or move the children to another
location within the user view, see Table 379.

7.

Repeat Step 1 through Step 6 if you would like to consolidate other user views into the user
view you are editing.
8. When you are finished consolidating user views, click Save.
9. Refresh the tabs in the navigation frame and delete any user views you no longer need.
10. Have a Metasys Administrator adjust the navigation permissions for the consolidated user
view (if necessary).

Breaking Up User Views
About this task:
You can break up a large user view into several smaller views.
To break user views:
1.
2.
3.
4.
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Create a new user view, or edit an existing user view.
Click Add Tree. The Add Tree(s) dialog box appears.
In the Add Tree(s) dialog box, select the tab for the user view you would like to break into
several smaller views.
Select the items from the large user view you would like to add to the new smaller view.
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5.

Click OK.
Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation
frame) to a User View in Edit mode to add an entire tree to the User View.
The items you selected and their children appear in the new user view. If you would like to
rename the folder or move the children to another location within the user view, see Table
379.

6.
7.
8.
9.

Repeat Step 1 through Step 7 if you want to move more content from the large user view to
the new smaller user view.
When you are finished with this new smaller user view, click Save.
Repeat Step 1 through Step 7 to create additional smaller user views with content from the
large user view.
Refresh the tabs in the navigation frame and review the user views to make sure they contain
the correct items.
Edit the new smaller user views as necessary.
Edit the large user view and remove the items that are now located in the new smaller views,
if desired.

10. Refresh the tabs in the navigation frame.
11. Have a Metasys Administrator adjust the navigation permissions for the consolidated user
view (if necessary).

User Navigation Tree
The user navigation tree object defines the attributes that represent the navigation tree.
For information on the Tree View and the User View feature, see User Views.

User Navigation Tree Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. See the Object and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
See Tree View Tab section for details on the buttons of the tab.

Summary Definition Wizard
Menu Selection: Insert > Summary Definition
Inserts a Summary Definition into the system. The Summary Definition object is used by the
Tailored Summary feature. See the Summary Definition Object section and the Tailored Summaries
section in the Metasys SCT Help (LIT-12011964) for more information on this object and feature.

Summary Definition Object
The Summary Definition object is an integral part of the Tailored Summary feature. This object
allows you to view and edit the columns and key data values used in a Tailored Summary based
user view. Tailored summaries are essentially summary views of Metasys system items where the
rows and columns of the summary are tailored to contain information of interest.
A summary definition contains the column rules and key data rules used to display a tailored
summary. Each column may contain a column heading, an item name or Fully Qualified Reference
(FQR), and attribute to display in that column. Each key data item may contain an item name to
display in a tailored summary in a header section outside of the data table. After defining the
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columns and key data items in the summary definition, you can associate that definition with a user
view folder using the user view editor.
For information on how this object interacts with the Tailored Summary and User View features,
see Tailored Summary Viewer or consult the Tailored Summaries section in the Metasys SCT Help
(LIT-12011964). For information on the User View feature, see User Views.

Summary Definition Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. For information on the Tailored Summary
feature, see the Tailored Summaries section in the Metasys SCT Help (LIT-12011964).
Click the attribute name in the table for a description of the attribute.
Note: In the notes column, attributes marked with the letter C are configurable, attributes
marked with the letter N do not require a value, and attributes marked with the letter W are
writable.
Table 381: Summary Definition Object Attributes - Focus/Configuration Tab
Attribute Name
Key Data

Notes
C,N,W

Initial Value

Values/Options/Range Description
Limit of 4 key items
Holds the item name or Fully Qualified Reference
of a key item to display in a tailored summary. You
can configure up to four key items.

Table 382: Summary Definition Object Attributes - Summary Definition Tab
Attribute Name

Notes

Column Definition

C,W

Initial Value

Values/Options/
Description
Range
Column Heading,
Defines the columns displayed in a tailored
Child Item, Attribute summary. You can define up to seven columns (list
of structures).
Each structure contains the following information:
Column Heading - Defines the name of the column
header.
Child Item - Indicates item for which the column
data is retrieved based on its name attribute, which
must match a user-specified pattern (such as ZN-*
or ZN-T, Zone-T). To display an attribute of the row
item, leave this field blank. Otherwise, specify the
name of the child item to display.
Attribute - Defines the attribute information for the
column. The attributes are grouped into categories
for easy selection. Select a category in the Attribute
Filter section of the Select Column Attribute dialog,
and then select the desired attribute from the list.

Row Heading
Column Text

C,N,W

Label
Maximum: 50
characters

Defines the text to display as the label for the row
headings column (that is, the first column) in a
tailored summary.

Tools Menu
Click one of the following menu items for a description of the menu item or perform a key-word
search for the menu item in this PDF, using Ctrl+F.
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Table 383: Tools Menu
Menu Item
User Profile

11 22

Field Device Tools ,

Change Password

Pair Network Engine with Site Director

Administrator
Configure Preferences
All Items Organizer
1
2

The Field Device Tools menu selection includes these options: HVAC PRO (N2), GX-9100 (N2), XTM Configuration (N2), DX
Commissioning (N2), N2 Device Loader (N2), CCT (MSTP/IP).
To use the CCT in Ethernet passthru mode, open CCT from the Tools > Field Device Tools > CCT (MS/TP) menu option.

User Profile
Menu Selection: Tools > User Profile
Launches the current user’s properties for managing the user’s language, default navigation view,
and other profile settings.

Preferences
The Metasys system provides customized preferences for the user interface. The preferences allow
you to configure how the user interface behaves, including its sounds and colors, startup views,
alarm priorities, and the ability to add links to external applications that can be accessed from
within the UI.
Some of the preferences defined in the Metasys Preferences dialog box also apply to the Metasys
UI. The Metasys Preferences Dialog Box section calls out such preferences.

Metasys Preferences Dialog Box
The Metasys Preferences dialog box is accessed through the Tools menu (Configure Preferences)
and allows you to configure system and user preferences. Users authorized to edit system
preferences can edit all preference fields using the Metasys Preferences dialog box. See Users
Authorized to Edit System Preferences. Unauthorized users can edit only user preferences.
Some of the preferences defined in the Metasys Preferences dialog box also apply to the Metasys
UI. The following table calls out the tabs with such preferences. See the specific tab section for
details.
Click the tab name in the table for a description of the Metasys Preferences tabs. For more
information on the modes of operation, see Metasys Modes.
Table 384: Metasys Preferences Dialog Box Tabs for Metasys UI and SMP
Tab
Information Tab

Applies to SMP UI

Applies to Metasys UI

X

1

X

X

Trend Settings Tab

X

X

Graphic Settings Tab

X

X

Display Settings Tab

X

X

Applications Tab

X

Alarm Settings Tab

2
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Table 384: Metasys Preferences Dialog Box Tabs for Metasys UI and SMP
Tab

Applies to SMP UI

Electronic Signature Settings
Tab

3

Annotation Settings Tab
1
2
3

Applies to Metasys UI

X
X

X

Simulation mode uses the default preferences. Preferences are not configurable in Simulation mode.
Only settings that apply to the SCT are available.
This tab appears only for Metasys for Validated Environments (MVE) installations.

Information Tab
The Information tab displays messages regarding the current state of the preferences. This tab
does not contain configurable preferences.

Alarm Settings Tab
The Alarm Settings tab allows you to configure up to 10 alarm priority groups, each with a unique
sound and a unique color. The groups are based on the priority of the alarm. The Alarm Settings
tab allows you to specify the alarm sound interval. The alarm settings are system settings and
therefore can be edited only by Users Authorized to Edit System Preferences.
These alarm settings apply to the Site Management Portal UI (online mode). The alarm color
preferences also apply to the Metasys UI.
The alarm sound files can be Audio (.au) or Wave (.wav) files. The Metasys UI uses Wave (.wav) files
for all web browsers except Windows Internet Explorer. For Windows Internet Explorer, the Metasys
UI uses the MP3 file equivalent to the configured Wave (.wav) file.
Alarm sound files must be placed manually into the audio folder. Refer to the Configuring and
Managing Preferences appendix of the ADS/ADX Commissioning Guide (LIT-1201645) or the NAE
Commissioning Guide (LIT-1201519) for details. The Metasys system validates that the audio file
exists on the device and is in a supported format. If the audio file does not exist or is not in a
supported format, the UI marks the audio file red. If the specified sound file for a particular range
of alarm priorities is missing, the UI uses the default system beep for those alarm priorities. The UI
uses the specified sound files for other alarm priorities if their sound files exist.
The Alarm Settings tab controls the sounds made by the Metasys system when an alarm is received;
however, the sound settings of the client computer control the volume of the audible alarms.
Note:
•

The client computer can only play sound files if a sound card is installed on it. If the UI
does not detect an installed sound card, it uses the default system beep, regardless of
whether sound files are specified and available.

•

To hear alarm notifications, you must also have Enable Audio Alarm selected in your User
Profile.

The following table describes the attributes of the Alarm Settings tab.
Table 385: Alarm Settings Tab
Field Name

Description

Alarm Sound Interval

Sets the audible alarm beeping time delay in seconds.

Use Default System
Beep

Specifies whether the system uses sound files with the four-level alarming
feature or the system uses the default system beep.

Event viewer uses
translucent colors

When true, the event viewer displays the event with a background color
that is a translucent version of the color specified for the priority level. The
color that appears in the Alarm window is not affected by this field.
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Table 385: Alarm Settings Tab
Field Name

Description

Insert Button

Allows you to add and define up to 10 total priority levels.
If you click the Insert button, you can add priority levels. In this case, you
can have more than four priority levels.

Delete Button

Allows you to remove priority levels.

Priority

Indicates the range of priorities of each priority level. The number of
priorities is adjustable, but in each case, the first priority begins at 0 and
the next range begins one number higher than where the previous range
stopped, up to 255.
For example, the following describes the priority ranges if you had 4
priority levels:
•

The Level 1 range starts at priority 0 and ends at the number
configured here.
•

•

The Level 2 range starts at priority Level 1 + 1 (39 + 1 = 40) and ends at
the number configured here.
•

•

The default Level 2 range is 40–79.

The Level 3 range starts at priority Level 2 + 1 (79 + 1 = 80) and ends at
the number configured here.
•

•

The default Level 1 range is 0–39.

The default Level 3 range is 80–139.

The Level 4 range starts at priority Level 3 + 1 (139 + 1 = 140) and ends
at the number configured here.
•

The default Level 4 range is 140–255.

Audio File

Indicates the sound file that plays for each priority level when an
alarm comes in. The default files for levels 1 through 4 are alarm1.wav,
alarm2.wav, alarm3.wav, and alarm4.wav, respectively.
The sound files on a device are only used by the UI when you are directly
logged in to that device. If a sound file is missing from the device, the
Metasys system uses the default system beep in its place.

Color

Allows you to customize the background color and text color for each
priority level. The color you specify here appears in the alarms window and
in the event viewer.

Trend Settings Tab
The Trend Settings tab allows you to configure the number of trends to display, the number of
samples to display, and other trending chart options. The following table describes the attributes of
the Trend Settings tab.
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Table 386: Trend Settings Tab
Field Name

Description

Maximum
samples to
display

Indicates the maximum number of new and historical trend samples shown in
a Trend Display or Trend Study. This attribute allows you to reduce the amount
of memory used by the UI for each trend. The range is 100–6,000. The default
value is 6,000.

Number of initial
visible trends

Indicates the initial number of trends that are marked Visible within the Trend
Viewer or Trend Study. The range is from 1 to the value of the Maximum
number of visible trends attribute. The default value is 6.

Maximum
Indicates the maximum number of trends that can be marked Visible within
number of visible the Trend Viewer or Trend Study. The range is from 1 to 10. The default value is
trends
10.
Default chart
Indicates the default background color of trend charts. The default color is
background color light gray.
Click the Browse icon to access the Select a Color dialog box. The Select a
Color dialog box allows you to select a custom color from three color palettes
and to preview the color for the attribute.
Default chart grid Indicates the default color of the grid lines of trend charts. The default color is
color
white.
Click the Browse icon to access the Select a Color dialog box. The Select a
Color dialog box allows you to select a custom color from three color palettes
and to preview the color for the attribute.
Default line style

Allows you to select what type of gridlines appear on the chart. You can
choose: None, X and Y, X Only, and Y Only. The default value is None.

Legend initially
collapsed

Indicates whether the trend legend is collapsed when the Trend Viewer or a
Trend Study is initially opened. This attribute allows you to maximize screen
space for viewing trend charts. The default value is False.

Line

Indicates the line on the chart to which the settings apply.

Line Color

Allows you to customize the color of the line.
Click the Browse icon to access the Select a Color dialog box. The Select a
Color dialog box allows you to select a custom color from three color palettes
and to preview the color for the attribute.

Line Marker

Opens a drop-down menu and allows you to select a marker type for the line.

Graphic Settings Tab
The Graphic Settings tab allows you to configure the status colors, fan colors, and state colors that
appear in standard and dynamic graphics, along with alarm flash settings. These settings apply to
the Site Management Portal UI (online mode), SCT, and the Metasys UI. The status color settings
may also be used by summaries or other views (Tailored Summaries, for example) to provide a
consistent indication of an object’s status.
The following table describes the attributes of the Graphic Settings tab.

628

Metasys Site Management Portal Help

Table 387: Graphic Settings Tab
Field Names/
Attribute

Description

Browse button

Accesses the Select a Color dialog box. The Select a Color dialog box allows
you to select a custom color from three color palettes and to preview the
color for the attribute.

Status Colors

Applies to value boxes, cells in Tailored Summaries, basic shapes (circle,
triangle, and square), and the Room Status symbol used in floor plan-based
graphics. See the Analog Alarm Extension for details on how these states are
calculated.

Normal

Specifies the color used to indicate a status of Normal. The default color is
white: RGB(255, 255, 255).

Out of Service

Specifies the color used to indicate a status of Out of Service. The default
color is orange: RGB(255, 142, 25).

Overridden

Specifies the color used to indicate a status of Overridden. The default color
is orange: RGB(255, 142, 25).

Trouble/Warning

Specifies the color used to indicate a status of Trouble, Low Warning, High
Warning, or SAB Device Warning. The default color is yellow: RGB(255, 255,
0).

Offline

Specifies the color used to indicate a status of Offline. The default color is
black: RGB(0, 0, 0).

Value Inaccessible

Specifies the color used to indicate a status of an inaccessible value (for
example, communications failed). The default color is gray: RGB(190, 190,
190).

Alarm

Specifies the color used to indicate a status of High Alarm, Low Alarm, Alarm,
or SAB Device Alarm. The default color is red: RGB(255, 0, 0).

Above Setpoint

Specifies the color used to indicate a status of Above Setpoint. The default
color is pink: RGB(191, 0, 95).

Below Setpoint

Specifies the color used to indicate a status of Below Setpoint. The default
color is blue: RGB(0, 0, 255).

Unoccupied

Specifies the color used to indicate an Unoccupied status. The default color is
dark gray: RGB(150,150,150).

Fan Status

Allows you to customize the fan status color of the attribute that appears in
system graphics. The Fan Status colors apply only to fans.

Stopped

Defines the background color used for a fan symbol when its bound object’s
value indicates the fan is stopped.
Stopped is defined as State 0 (for binary/multistate objects) or as zero (for
analog objects).
The default color is red: RGB(255, 0, 0).

Running

Defines the background color used for a fan symbol when its bound object’s
value indicates the fan is running.
Running is defined as State 1+ (for binary/multistate objects) or as non-zero
(for analog objects).
The default color is green: RGB(0, 153, 51).
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Table 387: Graphic Settings Tab
Field Names/
Attribute

Description

Default State Colors Allows you to customize the default state color of the attribute that appears
in system graphics. The Default State Colors apply to basic shapes (circle,
triangle, square) that are bound to a binary/multistate object. These default
state colors can be changed for each shape after it is added to a graphic.
State 0

Specifies the color used for the State 0 setting of a dynamic graphic symbol.
The default color is white: RGB(255, 255, 255).

State 1

Specifies the color used for the State 1 setting of a dynamic graphic symbol.
The default color is green: RGB(0, 153, 51).

State 2

Specifies the color used for the State 2 setting of a dynamic graphic symbol.
The default color is red: RGB(255, 0, 0).

State 3

Specifies the color used for the State 3 setting of a dynamic graphic symbol.
The default color is blue: RGB(0, 0, 255).

All Other States

Specifies the color used for the All Other States setting of a dynamic graphic
symbol. The default color is light gray: RGB(204, 204, 204).

Simple Symbol
Flash Settings

Allows you to customize simple UGT shapes (such as circles and squares) to
flash when their bound object is in alarm.

Flash Type

Defines the type of flashing applied to basic shape symbols:
•

Disabled (No Flashing)

•

State Color/Alarm Color (Flashes between the State Color and Alarm
Color)

•

State Color/Alternate Color (Flashes between the State Color and
Alternate Color)

The default value is 0: Disabled (No Flashing).
Alternate Flash
Color

Defines the color used when flashing between the current color and an
alternate flash color. The default color is white: RGB(255, 255, 255).

Flash Rate

Defines the flash rate for graphics symbol flashing. The range is from 100 to
1,000 ms. The default value is 250 ms.

Display Settings Tab
The Display Settings tab allows you to configure other properties related to the user interface
display. These settings apply to the Site Management Portal user interface and the SCT.
The following table describes the attributes of the Display Settings tab.
Table 388: Display Settings Tab
Field Name

Description

View Settings
Server time
synchronization
interval

Specifies how often (in minutes) the local time is synchronized with the server
time. The range is 5–60 minutes. The default value is 30 minutes.

Hide
unauthorized
commands

Indicates whether the Command window hides the unauthorized commands
for the logged in user. The default value is False, in which case the
unauthorized commands appear dimmed.
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Table 388: Display Settings Tab
Field Name

Description

New entry
timeframe

Indicates the amount of time that audits/events are considered new (based
on their time of occurrence in the Metasys system). The default value is 15
minutes. New audits/events are marked with a blue star in the Event Viewer
and Audit Viewer.

Query Results
Maximum results
in global search

Indicates the maximum number of rows displayed in the Global Search results
view.
If you are logged into an NAE, the range is 10–500 and the default value is 500.
If you are logged into a Metasys server, the range is 10–2,000 and the default
value is 500.
Note: If you display more than 500 results while logged into a Metasys server,
Data Refresh disables.

If you are logged into SCT, the range is 10–10,000 and the default value is
5,000.
Note: Increasing the number of results in global search may have a negative
impact on performance.

Print Settings
Default paper size Specifies the default paper size (Letter or A4) to be used for printing. The
default value is Letter.
General Display Settings
Default to
Advanced View

Indicates whether the Advanced View is the default view when opening an
item in the display panel or a wizard. The default value is False.
If the user is not authorized to access the Advanced View, the Advanced View
is not shown.

Extended labels
enabled on Login

Indicates whether extended labels are displayed in the navigation tree on
login. The default value is False.

Default command Specifies which types of commands are shown by default when the Command
set
window opens. The options are All Commands (default), Primary Commands,
Secondary Commands, and Alarming Commands.
Note: We recommend using Primary Commands as the default command set to
reduce errors by lower level operators.

Default schedule
display

Indicates the initial display mode shown in the scheduling feature:
•

Today’s Schedule (default)

•

Weekly Schedule

•

Exception Schedule

•

Scheduled Items

Default navigation Specifies the User View navigation display as either a set of tabs (Tabbed) or a
display
drop-down list (List). The default is Tabbed.
Note: List is recommended if the system has many user views, as this takes up
less space in the navigation tree pane.

Online Display Settings
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Table 388: Display Settings Tab
Field Name

Description

Enable alarm pop- Specifies that upon login, whether the alarm pop-up window appears
ups on login
automatically (True or False). The default is True. If you change this attribute
to False, a confirmation message appears that warns you that disabling alarm
pop-ups may result in missed notifications of important alarms. Click Yes to
disable alarm pop-ups or No to enable alarm pop-ups.
Collapse
navigation frame
on login

Specifies that upon login, the navigation tree collapses to the left (True or
False). The default is False.

Default display
panel layout

Specifies the Display Frame Layout that is displayed at login. The default panel
layout is Single Panel.

Startup item 1–4

Defines up to four startup views, which are automatically displayed at login.
The number of views that can be displayed is based on the Default display
panel layout.
Note: Aliased graphics do not display properly if selected as a startup item. Specify the main graphic instead.

Click the Browse icon to access the Select Item dialog box. Select the item you
want to appear in the panel upon login and click OK.
Note: Login time is increased when startup views are specified.

Delay startup
graphic load

Specifies an optional login delay time of 1 to 60 seconds to allow the SMP UI to
fully load a system graphic. The default is 0 seconds.

Applications Tab
The Applications tab allows you to specify links to external applications, such as a spreadsheet or
Microsoft Word document, that can be launched from the Tools menu or from within graphics. The
following table describes the attributes of the Applications tab.
Table 389: Applications Tab
Field Name

Description

Add button

Allows you to add a new external application that can be accessed from within
the Site Management Portal (SMP) UI. Once you click Add, the lower pane allows
you to enter application information. If you are authorized to change system
preferences, an Add Application dialog box appears first and allows you to specify
whether the application is to be a system or user preference.
Note: If you are not authorized to change system preferences, the application is automatically added as a user preference.

For more information, see System and User Preferences.
Remove
button

Removes the selected application from the list.

Application
Name

Enter the name of the application as you want it to appear on the Tools menu or
within graphics.
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Table 389: Applications Tab
Field Name

Description

Application
Path

Enter the full path of the application, including the command line arguments.
The path is based on the local file system (where you are browsing from), not on
the path of the device you are logged in to. The application path can also use any
mapped network drives.
Click the Browse button to access a Browse dialog box and select the application
and path.
To launch a specific file, select the path to the application that opens the file,
followed by a space and the path to the specific file in quotation marks. Use the
following format:
C:\Application Path\Application.exe “C:\filename path
\filename.extension”
For example, to launch a Microsoft Word document named Worksheet_01:
C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE "C:
\Documents and Settings\username\Desktop\Worksheet_01.doc"
Note: The Application you add is specific to the computer you are using when you
add it. The application may not launch from a different computer unless the application exists on that computer in the same location.

Tools Menu

Indicates whether the application appears on the Tools menu in the SMP UI.
Select True (default) to have the application appear on the Tools menu. Select
False if you do not want it to appear on the Tools menu.
Note: You must log out of the SMP UI and then log back in for new items to appear in
the Tools menu.

Graphics

Indicates whether the application can be hyperlinked to and launched by a button
in a standard graphic. The application name you specify appears on the Hyperlink
Information Application drop-down menu for buttons in graphics. See Buttons.
Select True to enable this functionality. Select False (default) if you do not want
the application to provide graphics.
Note: This hyperlink capability is supported in the Graphics+ as well as the User
Graphics Tool (UGT).

Mnemonic

Allows the application to be launched from a navigation key.
For example, if you add the Calculator to the Tools menu and specify the letter C
as the mnemonic, you can access the Calculator in the following way:
From the SMP UI, press Alt+T to access the Tools menu. Press C to highlight
Change Password. Press C again to highlight the Calculator application. Press
Enter to start the Calculator application.

Type

Specifies whether the application is available for the system or the user. This
is specified when you first click Add to add a new application to the list. Once
specified, this attribute cannot be changed.

Electronic Signature Settings Tab
The Electronic Signature Settings tab appears only for Metasys for Validated Environments (MVE)
installations. This tab allows you to define reasons for electronic signature requirements.
MVE sites have settings in the Site Object for enabling annotation and electronic signature
functionality. You can set the MVE site to require only annotations, only electronic signatures, both
annotations and signatures, or neither annotations nor signatures. Non-MVE sites may optionally
define and use annotations; however, electronic signatures are specific to MVE sites.
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You can configure electronic signatures at the device and object levels. Table 390 describes the
attributes of the Electronic Signature Settings tab.
Table 390: Electronic Signature Settings Tab
Field Name

Description

Reason Text

Enter a new reason for electronic signature requirement, to be added to the list
of predefined reasons. The text can be from 1 to 255 characters in length. Click
Add to save the new reason.
Predefined reasons are Approval, Author, Required, Cause, and Operator Action.
These reasons can be edited or deleted.

Predefined
Reason List

Displays the list of predefined reasons. Select a reason and click Delete to
remove the reason from the list. The Move Up and Move Down buttons allow you
to reorder the list.

For additional information, refer to the Metasys for Validated Environments, Extended Architecture
Technical Bulletin (LIT-12011327).

Annotation Settings Tab
The Annotations Settings tab allows you to define customized annotations to select when
acknowledging and discarding events.
MVE sites have settings in the Site Object for enabling annotation (and electronic signature)
functionality. You can set the MVE site to require only annotations, only electronic signatures, both
annotations and signatures, or neither annotations nor signatures. Non-MVE sites may optionally
define and use annotations; however, electronic signatures are specific to MVE sites.
We recommend that you define custom annotations specific to your needs, in addition to the
predefined annotations. When the new Annotation Settings are saved in an MVE system, the new
annotation selections are available to users when they electronically sign for changes.
You can configure annotations at the device and object levels. See Audit Message Annotations
in Audit Trail for details on annotation fields. Also see Configuring Annotation and Electronic
Signature Requirements in the Site Object in MVE.
Table 391 describes the attributes of the Annotation Settings tab.
Table 391: Annotation Settings Tab
Field Name

Description

Annotation
Text

Enter a new annotation to be added to the list of predefined annotations. The text
can be from 1 to 255 characters in length. Click Add to save the new annotation.
Predefined annotations can be edited or deleted.

Predefined
Displays the list of predefined annotations. Select a reason and click Delete to
Annotation List remove the annotation from the list. The Move Up and Move Down buttons allow
you to reorder the list.
For additional information, refer to the Metasys for Validated Environments, Extended Architecture
Technical Bulletin (LIT-12011327).

System and User Preferences
Preferences are divided into two categories: system preferences and user preferences.

System Preferences
System preferences apply to all users who log in to the site or device. System preferences affect the
performance and operation of the system and require authorization to configure. A change to the
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audible alarm notification is an example of a system preference. Only the users defined in the Users
Authorized to Edit System Preferences section are authorized to configure system preferences.
To synchronize system preferences within a site or to reuse the system preferences on another site,
refer to the Configuring and Maintaining Preferences appendix of the ADS/ADX Commissioning Guide
(LIT-1201645) or the NAE Commissioning Guide (LIT-1201519).

User Preferences
User preferences apply to a specific Metasys system user. User preferences define how the
information is displayed in the user interface, and do not affect the operation for other users of the
system. The colors and marker styles of a trend display are examples of user preferences.
Beginning at SCT Release 11.0 and later, user preferences and object lists are included in uploads
and downloads.
At Release 8.0 or later, user preferences (and object lists) that are created on the Metasys server are
saved in the archive database by SCT. They are part of the archive upload/download process, so you
no longer need to save these xml files before an upgrade. This feature is dependent on the Metasys
server version, and is not applicable for releases earlier than Release 8.0.
To synchronize user preferences within a site or to reuse the user preferences on another site,
refer to the Configuring and Maintaining Preferences appendix of the ADS/ADX Commissioning Guide
(LIT-1201645) or the NAE Commissioning Guide (LIT-1201519).

Users Authorized to Edit System Preferences
Any user whose account is assigned to the Administrator role is authorized to configure system
preferences.

Change Password
Menu Selection: Tools > Change Password
Changes the current user’s password. The password you select must meet the requirements
for complex passwords. For details, refer to the Network and IT Guidance Technical Bulletin
(LIT-12011279).
Note: For Active Directory users, the Change Password menu remains disabled.

Administrator
Menu Selection: Tools > Administrator
Launches the Security Administrator System. This menu item is only available for users in the
ADMINISTRATOR role. Within the Security Administrator System, Administrators manage user
accounts by creating roles/profiles; setting user passwords; assigning category-based, systemlevel, and navigation view permissions/access; and performing other duties. The same set of
administrative management is available in Metasys UI Online, which is now preferred over the
Security Administrator System in SMP.
For more information on the Security Administrator System in SMP, refer to the Security
Administrator System Technical Bulletin (LIT-1201528). For more information on the Security
Administrator System in Metasys UI Online, refer to the Settings, Security, and Authorization for
Metasys UI section in Metasys UI Help (LIT-12011953).

Configure Preferences
Menu Selection: Tools > Configure Preferences
Launches the Metasys Preferences dialog box.
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The Metasys system provides customized preferences for the user interface. The preferences allow
you to configure how the user interface behaves, including the sounds and colors, the startup
view, and the ability to add links to external applications that can be accessed from within the user
interface.

All Items Organizer
Menu Selection: Tools > All Items Organizer
Launches the Metasys All Items Organizer.
Allows an authorized user to specify the order of any items in the All Items tree. You can order all
devices below the site (for example, NxEs) and nodes within devices.

Field Device Tools
Passthru Wizard
Modes: Available in online and offline mode only
Menu Selection: Tools > Field Device Tools
Accesses tools such as HVAC PRO, GX-9100, XTM Configurator, DX Commissioning, N2 Device
Loader, and CCT.
Note: The Field Device Tools menu selection replaces the N2 Tools menu selection available at
Release 2.0 and earlier.
tips:
•

You must have N2 Tools and SCT installed on the same PC that is running Passthru with
HVAC PRO, GX-9100, XTM Configurator, DX Commissioning, or N2 Device Loader passthru.

•

The Passthru wizard does not always appear when you are connected to the NAE or
Metasys server online if you are already logged on to the site. The selected tool loads
automatically after you select it from the Tools menu.

•

On the Passthru Site Login screen of the wizard, enter your username and password as
defined by your User Profile. To verify access, click Login to check if your login parameters
are valid to access the tools.

•

As a best practice, if you have a Site Director NAE with child NAEs, do not initiate CCT
Passthru at the Site Director to commission field controllers on the child NAE. File
transfers between the Site Director NAE and its child NAE may terminate prematurely.
This behavior only affects NAEs that have been updated with Release 9.0.7; earlier
releases are not affected. Instead, commission the field controllers directly at the
child NAE. However, if you have no other option, you may add a parameter to the CCT
configuration file to increase the time allowed for transfers. This file is located on the CCT
computer in this folder: C:\ProgramData\Johnson Controls\MetasysIII\CCT\UI. Open the
ApplicationConfiguration.properties file with a text editor and add this parameter at the
end of the file on a separate line: da.SyncAgent.Download.ReadAttrTimeout=30. Even
with this parameter added, successful transfers between network engines at Release 9.0.7
is not guaranteed.

Passthru Requirements
For installation requirements, refer to the Metasys Server Installation and Upgrade Instructions
(LIT-12012162).
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Note: Computers with Windows 8 and Windows 7 require the use of Passthru. To use CCT,
HVAC PRO™ software, or the GX-9100 tool software in Passthru mode from SCT, you must
disable user account control in Control Panel. If you do not disable user account control,
Passthru mode does not work. To disable user account control, go to Control Panel > System
and Security > Action Center. Locate User Action Control under the Security section and click
Choose Your UAC level. On the left side of the screen, drag the slide bar to Never Notify.
Click OK and restart the computer.

Launching N2 Configuration Tools and CCT in Passthru Mode
About this task:
N2 Devices are configured using N2 configuration tools in Passthru mode in the SCT. To use the N2
configuration tools in Passthru mode, install the N2 configuration tools on the SCT computer.
CCT devices are configured using CCT in Passthru mode. To use CCT in Passthru mode, install CCT
on the SCT computer.
To launch N2 configuration tools and CCT in Passthru mode:
•

Open the archive database in SCT or log in to the engine.

•

On the Tools menu, select Field Device Tools, then click the N2 configuration tool you want to
use or CCT (MS/TP). The selected tools open in Passthru mode.

•

If you are launching a Passthru session from the SCT, you are guided through a login sequence
to log in to the Site Director that contains the devices that contain the N2 controllers or MS/TP
controllers.

•

Any offline conditions/actions in the Site Director (such as a download to the Site Director)
interrupts N2 and MS/TP Passthru communications.
- When you use the GX-9100 tool in Passthru mode, engines appear as N30 devices in the
UI of the GX-9100 tool.
- If you use Passthru on a Windows 8 or Windows 7, you must turn off the user access
control (UAC). To turn off UAC, go to Control Panel and click System and Security > Action
Center. The Action Center window appears. Click Change User Account Control settings,
then move the slider bar to the bottom position called Never notify. Click OK and restart
the computer.

User Defined States Text
Prior to Release 6.0, States Text was auto generated for third-party BACnet® Objects devices during
the online discovery process within the Metasys system. Once the states text was discovered online,
the information could be uploaded into an SCT archive for storage.
At Release 6.0 and later, User Defined States Text sets can be created both online or offline in SCT.
The new Custom Enumeration tab has been added to the Site Object, which allows the creation of
new enum sets that can be applied to any Binary or Multi-Value Objects.
Note: If you create a custom enumeration set that has only two members, the set does not
appear in the list of sets for a Multistate Value Object.

HVAC PRO
HVAC PRO configures the ASC: VMA14, VAV, AHU, and UNTs.
In Passthru mode, you can use the HVAC PRO software to download, upload, and commission ASC
devices through an engine.
In addition, Passthru mode makes it easier to identify and manage controllers for common tasks
by showing the user a complete list of controllers currently mapped to an engine. The first step in
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any Passthru operation from HVAC PRO is to select a controller from a list. Subsequent Passthru
operations, such as Controller Information and Upload/Download, are performed on the selected
controller.
HVAC PRO restricts the number of characters allowed in each controller name. See HVAC PRO Name
Restrictions in Passthru Mode.

HVAC PRO Name Restrictions in Passthru Mode
HVAC PRO Release 8.06 and later restricts the number of characters allowed in each controller
name. HVAC PRO does not download, upload, commission, or retrieve information about the
controller if the item name or controller name exceeds the 157 maximum characters limit.
The controller’s full name consists of the following: domain name, site name, equipment name,
trunk name, and the actual controller’s name. The controller name appears in the following format:
Site_name:device_name.domain_name/N2 Trunk #.controller_name
The following table describes the controller name restrictions.

Note: The component column lists each of the components represented in a Full Item
reference. The Maximum Viewable Characters column lists the restrictions on the Component
names when entered through SCT or a web-based user interface of the Metasys supervisory
controller. The Maximum Characters Allowed by HVAC PRO column shows the maximum
number of characters in a Full Item Reference allowed in HVAC PRO.
Table 392: Controller Name Restrictions
Component

Maximum Number of Maximum Viewable
Characters
Characters Allowed
by the Engine or SCT

Maximum Characters
Allowed by HVAC PRO

Site Name

fewer than or equal to 30
32

157

Device Name

fewer than or equal to
15

Domain Name

fewer than or equal to
64

N2 Trunk Name

fewer than or equal to 32

Controller Name

fewer than or equal to
32

47 Total

HVAC PRO Naming Recommendations
Use the following list of naming conventions to assist you while naming your controllers. If you
follow these recommendations, 61 additional characters are available.
•

Choose a site name under 15 characters.

•

Choose a device name (network name) under 15 characters.

•

Leave the default N2 Trunk name unchanged, so it only consists of 10 characters (for example,
N2 Trunk 1 or N2 Trunk 2).

•

Choose a controller’s name under 15 characters.

GX-9100 Tool
The GX-9100 tool configures the DX-9100 and DX-9200 controllers.
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In Passthru mode, you can use the GX-9100 software to download or upload the DX configurations.
When you use the GX-9100 through an engine, the LoaderUI application launches to initiate the
upload or download.

XTM Configurator
The XTM Configurator supports building configuration files for XTMs.
Note: The XTM Configurator tool does not support N2 passthru but can be used to download
XTMs using a serial connection.

DX Commissioning
Opens the DX Commissioning Tool.

N2 Device Loader
Opens the N2 LoaderUI window. You can browse to the location of the DX-9100 device file and other
N2 device files to upload and download. All devices found on the selected engine appear with the
Address, Device Type, and Object Name. You can open the device file in the GX-9100 or HVAC PRO
tool.

Controller Configuration Tool (CCT)
You can use CCT to configure, simulate, load, and commission devices on an MS/TP bus. The list
of devices that you can configure in CCT includes CVMs, CGMs, FECs, FACs, IOMs, NCEs, NIE29s,
VMA16s, and VAVs. You can operate CCT in three modes of operation that provide key functionality
for your system: Configuration, Simulation, and Commissioning.

Pair Network Engine with Site Director
Menu Selection: Tools > Pair NxE with Site Director
Launches the Pair NxE with Site Director wizard option to force device pairing between a network
engine and its Site Director. Beginning at Metasys Release 10.0, a more secure authentication
process has been implemented between updated NxEs and the Site Director that involves device
pairing. After you pair an NxE with a Site Director, the two devices use unique credentials to
authenticate communication between them. Unpaired NxEs are not able to communicate with
a Site Director. Normally, the pairing operation occurs for you when the engine's database is
downloaded with SCT. However, in cases when the pairing between devices is lost, the Pair NxE with
Site Director option is available. For example, use this function in the following scenarios:
•

If you change the Site Director of any network engine and the device pairing for some reason
does not occur automatically as it should, perhaps due to a sudden communication loss. If this
occurs, use this option to force the device pairing.

•

If you reinstall or upgrade the Metasys server from Release 10.0 to a newer release or to a
newer build of Release 10.0. Communication between the two devices may be lost until you
pair the devices.

•

If pairing is lost for some unknown reason and the network engine shows Item Not
Found when you open its Focus window. Forcing a device pairing can often reestablish
communication.
However, do not use this option for network engines that are running Release 9.0 software or
earlier, because these older engines do not have this capability.
To pair an NxE with a Site Director, complete the following steps:
1.

From the Tools menu, select Pair NxE with Site Director. The NAE Pairing wizard appears.
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2.

Select the devices that you want to pair with the Site Director. Click Next. The Device Pairing
window appears.

3.

Specify an administrator account user's credentials of the Site Director. Click Pair Device(s). If
pairing is successful, Paired appears in the Device Paired column for each device.
Note: If Pairing not needed appears in the Device Paired column, the device is at
a release earlier than Metasys Release 10.0, and does not need to be paired. If Failed
to Pair appears in the Device Paired column, the device is pointing to a different Site
Director.

4.

Click Next. The Summary window appears that lists which devices have been successfully
reauthenticated to their Site Directors. Click Finish.

Query Menu
Click one of the following menu items for a description of it. For more information on the modes of
operation, see Metasys Modes.
Table 393: SMP Query Menu
Menu Item
Global Search

11

Alarm Report

1

Offline Report

33

Open Object List

Disabled Report

1

3

Save Object List
1

Operator Override Report

Supervisory Override Report
Trouble Report

22

New Scheduled Report

Delete Object List

3

1

1

Out of Service Report

1

Dormant User Account
Report
1
2
3

1

The content of this report is filtered based on authorization.
Available on the Metasys server only.
Available on the Site Director only.

Query Menu Introduction
Query Menu Concepts

Reports
Use the predefined report feature to query a single network engine, multiple network engines, or
the entire site (all network engines on the site) for alarm, offline, disabled, override, trouble, and
out of service conditions. To generate a report, select one or multiple network engines or the site in
the navigation tree and select a report from the Query Menu. The query executes for the selected
network engines or site. When you select multiple network engines or the site in the navigation
tree, the report feature queries each supervisory device and combines the results in one report.
These predefined reports (alarm, offline, disabled, override, trouble, and out of service) are
different from the Scheduled Reports option available in the Query menu. For information on
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scheduled reports, see the Scheduled Reports section. For information on the Global Search and
Object List options, see the Global Search section.
The query produces a report in the display panel. The report shows the time the query was
initiated, the report status, and the report results. The stop button allows you to cancel a running
query at any time. The Copy button allows you to copy the report content to the clipboard.
The following figure shows an example of an Offline Report. See the Running Reports topic for
information on how to run a query.
Figure 72: Offline Report Screen

Table 394 describes the information provided by each report.
Table 394: Report Types and Descriptions
Report

Description

Alarm

Lists all items in alarm state in the selected site or devices.
For each item in alarm state, the report displays the item type icon, item name,
item description, alarm type, and the value of the item when it entered alarm
state.

Offline

Lists all items in offline state in the selected site or devices.
For each offline item, the report displays the item type icon, item name, and
item description.
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Table 394: Report Types and Descriptions
Report

Description

Disabled

Lists all disabled items in the selected site or devices.
For each disabled item, the report displays the item type icon, item name, and
item description.

Dormant User
Account

Lists all user accounts for the system by supervisory device. This applies to
Local Metasys User accounts and Active Directory accounts.
For each account, the device name, account name, user name, role, account
type, last successful login, days since last login, status, is dormant, days
dormant, and dormant event sent are displayed.
Distinguishes among accounts that have not attempted access in previous x
number of days, accounts that have never been used, and accounts that have
never successfully accessed the Metasys device, additionally showing which of
these accounts are disabled.
Note: Any devices that are not responding or are at a release prior to 8.0 are not
included in the report and are noted at the bottom of the report dialog box.

Operator
Override

Lists all items currently overridden by the operator.
For each overridden item, the report displays the item type icon, item name,
status, item description, and the current value of the item. See the status
column to determine whether an operator overridden item should be released.

Out of Service

Lists all items that have the Out of Service attribute set to True.
For each out of service item, the report displays the item type icon, item
name, and item description. All BACnet point objects have this property (for all
integrations) as well as the BACnet Loop, Program, and Schedule objects.

Supervisory
Override

Lists all items currently overridden by the supervisory device.
For each overridden item, the report displays the item type icon, item name,
status, item description, and the current value of the item. See the status
column to determine whether a supervisory overridden item should be
released.

Trouble

Lists all items that have the Trouble attribute set to True.
For each item in trouble state, the report displays the item type icon, item
name, and item description. Usually, Binary Input and Binary Output points
have this property. It is mostly used in Fire and Security applications but may
be used when the Binary Output command does not match the feedback. (The
Binary Input feature is integration dependent.)

Global Search
The Global Search feature allows you to search the Metasys system for multiple items that meet
specific criteria based on naming and object type. Use global search to manage lists of objects,
which other features can use for commanding, trending, reporting, modification, and object
selection. For example, you can create a list of all discharge air temperatures for the AHU in a
building. Or, you can easily create new User Views and Summary Definitions by using drag and drop
to add items from the search window.
For information on backing up object lists before an upgrade, refer to the Preferences appendix in
the NAE Commissioning Guide (LIT-1201519) or the ADS/ADX Commissioning Guide (LIT-1201645).
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Global Search Concepts
Global Search Overview
The Global Search feature allows you to search for objects from an entire site or from a portion of a
site (for example, one or more trunks or devices). Use the Global Search Viewer to add and remove
items from the search scope and search by object name and type. During a search, the items found
appear in the results table immediately, and the status bar shows the current search location. The
status bar also shows the number of items found.
With the Global Search feature, you can view information about multiple items at once. The Global
Search Viewer lets you view summary data for multiple objects and allows multiple selection for
Global Modifying.

Global Search Viewer Screen
You can access the Global Search Viewer from the Query Menu by selecting Global Search. The
Global Search Viewer opens in the Panel Layout of the Metasys system Site Management Portal.
You can have multiple Global Search Viewers open, but can only initiate one search at a time within
the same UI. If you try to start another search in the same UI, then an error message appears
stating that you must either stop the search in progress or wait until it completes before initiating
another search.
The Global Search feature displays 500 items by default and can be increased to 2,000 in user
preferences.
SCT does not support dynamic updating for search values with the Global Search feature. If the
search results reach the maximum number of items, then a message appears stating the current
search is too broad, and you should change the search criteria to narrow the search and try again.
Note: On an NxE with more than 500 items, the Global Search may display red Xs and
the message Value cannot be read. As the view continues to update data, the red Xs
disappear. However, once the search reaches 500, results data updates are disabled and the
red Xs remain.
Figure 73: Global Search Viewer Screen
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Table 395: Global Search Viewer Screen Components
Screen Area/Item

Description

Instructions Area

Provides tips to help you perform a search.

Search Locations List
Box

Lists the parts of the Metasys system navigation view you selected to
search.
When you initially invoke the Global Search feature, any items currently
selected in the navigation view appear in the Search Locations list box.
If no items are selected in the navigation view, then the box appears
blank. You can drag and drop items from the navigation trees into the
Search Locations List Box to make or change selections most efficiently.
You can also use the Add and Remove buttons to make or change
selections.

Add Button

Opens the Select Item dialog box and allows you to select the parts of
the system that you want to search. Though the preferred method to
make or change selections is the drag and drop functionality, you can
select items from available views (All Items tab or User View tabs)
depending on your user authorization.
You can search the entire site, one or more devices, one or more trunks
on a device, one or more User Views, and so on. Hold down the Ctrl or
Shift keys when clicking to select multiple items. After completing the
dialog box, the items you selected appear in the Select Scope box.

Remove Button

Removes selected items from the Search Locations list box.

Object Name Box

Allows you to type the full or partial name of the object you want to find.
You can leave it blank for a more expansive search. You also can use one
or more wildcards (* or ?) to aid in your search.
Wildcard Examples:
•

LCP-2*

•

ZN-T*

•

OCC-S*

• N?E* (searches for all items named NAE*, NIE*, and so on)
The object name search is not case-sensitive.
The search looks at the Name attribute. For searches against user
navigation views, the search also considers the user-defined label
assigned to the item within that particular navigation view and includes
the item, if the Name attribute or label matches the search criteria for
object name.
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Table 395: Global Search Viewer Screen Components
Screen Area/Item

Description

Object Type Drop-Down Allows you to select a specific type of object to search for or allows a
List
search for all object types. Options include:
•

All (excluding extensions)

•

Trend Extensions

•

Totalization Extensions

•

Alarm Extensions

•

Schedules

•

Calendars

•

Field Devices

•

Field Points

Include child objects
Check Box

Includes all child objects of any items found when searching the Search
Locations. That is, it includes the nested child objects.

Include search location
objects Check Box

Includes the location items in the search results if they meet the search
criteria, as well as any items found when searching in those locations.
For example, if you initiate a search on an N2 Trunk named N2 Trunk
1 to search for all objects named *2*, and you check Include search
location objects, then the results include the N2 Trunk in the results. If
you do not check the option, then the search results only include items
under the N2 Trunk (along with their child objects, if the Include child
objects option was checked) and does not include the N2 Trunk itself.

Search Button

Begins the search.

Stop Search Button

Cancels a search in progress; no more new objects appear in the Search
Results table.

Search Results Table

Displays the results of the search (object list).
•

Dynamic data in this table automatically refreshes periodically. The
refresh rate depends on the platform you are logged in to.

•

If you select an item in the Search Results and place your cursor
over the item within each column, then tooltips appear and
provides more information, if available.

•

Any data that does not fit within the columns is identified by an
ellipsis (. . .). You can resize the column or place your cursor over
the table cell to see its tooltip text.

•

If the search finds an object in more than one location (for
example, in the All Items navigation view and in a user navigation
view), then the object is listed twice in the Search Results Table. If
the same location is searched a second time or if search locations
overlap, then the object is not repeated in the table. Items are only
repeated in the table if their location differs.
See the Working with Search Results section for more information on
manipulating and using the table data.
Status Icon Column

Displays the icon of the object’s current status as defined by its Status
attribute.
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Table 395: Global Search Viewer Screen Components
Screen Area/Item

Description

Icon Column

Displays the icon of the object as it appears in the navigation tree.

Status Column

Displays the current status of the object as defined by its Status
attribute.

Name/Label Column

Displays the name of the object as defined by its Name attribute. The
object’s full reference identifier appears in a tooltip when the cursor is
placed over the name.

Value Column

Displays the object’s value as defined by its default attribute (generally,
the Present Value attribute).

Units/States Column

Displays the Units attribute data for analog objects, Number of States
attribute data for multistate objects, and appears blank for all other
objects.

Description Column

Displays the data defined in the object’s Description attribute.

Location Column

Displays the object’s context, specifically its location within a particular
navigation view.

Type Column

Displays the object’s type (for example, NAE55).

Category

Displays the object’s category as defined by its Object Category attribute
(for example, General).

Signature

Indicates whether a signature is associated with the object.

Annotation

Indicates whether an annotation is associated with the object.

Select All

Selects all rows in the Search Results table.

Clear List

Removes all of the objects from the Search Results table.

Remove From List

Removes selected objects from the Search Results table.

Add New

Allows you to manually add one or more objects to existing search
results (where the added objects append to the bottom of the existing
Search Results table).

Copy to Clipboard

Copies the selected search results in a tab-delimited format to the
Clipboard for pasting into other applications, such as Microsoft Excel®
or Word®.

Status Bar

Displays the current location of the search in progress, the status of the
search, and the number of objects found.

Object List
The objects listed in the Search Results table make up an object list. You can save an object list for
future viewing and commanding. You can open an existing object list in the Global Search Viewer
if you want to access the same search results without having to perform the search again. You also
can open object lists for use by other features such as the Trend Viewer, Scheduled Reports, Global
Commands, and Global Modify. Object lists provide easy object selection for these features.
When you save an object list, it is saved on the Site Director. Sorting order is not saved in the object
list. For information on working with and using object lists, see the Working with Search Results,
Saving an Object List, Opening an Object List, and Deleting an Object List sections. Also, see the
Trend Viewer, Scheduled Reports, Commands Dialog, and Modify Dialog sections.
On the Metasys server, object list files are stored at C:\ProgramData\Johnson Controls
\MetasysIII\File Transfer\Object Lists.
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On the engines, use Remote Desktop within the NxE Information and Configuration Tool (NCT) to
access the files. For information on backing up object lists, refer to the Preferences appendix in the
NAE Commissioning Guide (LIT-1201519) or the ADS/ADX Commissioning Guide (LIT-1201645).

Global Search Steps
Performing a Global Search
About this task:
Note: When initiating a global search, especially after restarting the Metasys server, the
operation may timeout. This is most likely to occur when CPU usage is high.
To perform a global search:
1.

2.

From the Query Menu, select Global Search. The Global Search Viewer appears in a display
panel. Any items currently selected in the navigation view appear in the Search Locations list
box.
To add other areas to search, in the Search Locations section, click Add. The Select Item
dialog box appears.
Notes:
- You can also use the drag-and-drop feature to set search locations from objects in the All
Items tree.
- Any item you select in the All Items tree before you launch Global Search is added to the
Search Location.

Figure 74: Select Item Dialog Box
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3.

Select the part of the system that you want to search from the available tabs depending
on your user authorization and Metasys mode. You can search the entire site, the All Items
navigation tree, a User View, one or more devices, one or more trunks on a device, and so on.
Use the Ctrl or Shift keys when clicking to select multiple items.
Note: Selecting a User View object from the All Items tab does not search that User
View’s contents. You must select the root of the User View from its tab.

4.

Click OK.
Note: To remove items from the Search Locations box, select the item and click Remove.

5.
6.
7.

8.
9.

Select the Include child objects check box if you want to include all child objects of any items
found when searching the Search Locations.
Select the Include search location objects check box to include the Search Locations in the
results.
In the Object Name box, type the full or partial name of the object you want to find or leave it
blank. You can use one or more wildcards (* or ?) to aid in your search (for example, N?E*).
The object name search is not case-sensitive.
From the Object Type menu, select the type of object to search or select All (excluding
extensions).
Click Search. The search begins and the Search Results table fills with any matching object
information. When finished, the status section displays Search Completed and the number of
objects found.

Result
Note: If you rename an object, then you must remove the old name from the Search Locations
list before the object can appear in the results list under its new name.
See the Working with Search Results section.

Stopping a Search
To stop a running search, click Stop Search.

Working with Search Results
Selecting and Using the Search Results
Use the drag-and-drop functionality to add items from the Global Search Results table to a User
View, a Scheduled Items List, or the Action Tables of an Interlock or Multiple Command Object.
You can also use the Search Results with the Tailored Summary Viewer found in the View Menu.
Highlight the desired set of results from the list and follow these steps to use the drag-and-drop
functionality to apply the desired Summary Definition against the results set:
1.

Click Edit in the User View or Tailored Summary Definition.

2. Drag items from the Search Results table to the User View or Tailored Summary Viewer.
You also can drag an item from the Global Search Results table and drop it into an empty display
panel to view the item or perform a Global Modify to the search results.

Selecting Objects in the Search Results
To select objects in the search results, click an individual object in the Search Results table or hold
down the Ctrl or Shift keys when clicking to select multiple items.
To select all of the search results, click Select All.
Note: Click and drag your cursor over objects in the Search Results table to select objects that
appear consecutively.
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Removing Objects from the Search Results
1.
2.
3.

Click an individual object in the Search Results table or hold down the Ctrl or Shift keys when
clicking to select multiple items.
Click Remove From List. The Confirm Delete dialog box appears asking if you want to delete
the selected item from the list.
Click Yes.
Note: You also can use the Delete key to remove selected objects from the Search
Results table.

Clearing All Search Results
1.
2.

Click Clear List. The Confirm Delete dialog box appears asking if you want to delete all the
items from the list.
Click Yes.

Manually Adding Objects to Existing Search Results
About this task:
Note: The added objects append to the bottom of the existing Search Results table.
1.

Click Add New. The Select Item dialog box appears.

2.

Select the object to add to the search results. Hold down the Ctrl or Shift keys when clicking to
select multiple items.
Click OK.

3.

Adding New Search Results to Existing Search Results
About this task:
To add new search results to existing search results (where the results of the new search append to
the bottom of the existing Search Results table):
1.
2.

In the Search Locations box, remove the existing location, if desired, by selecting it and
clicking Remove. The existing search results remain in the Search Results table.
Perform step Step 2 through step Step 9 in the Performing a Global Search section to add the
new search criteria and execute the search. The results appear at the bottom of the Search
Results table.

Sorting Search Results
To sort search results, click the heading of a column. The results sort and a small red triangle
appears indicating the order of the sort (ascending or descending). Click the column heading again
to change the sort order.

Expanding and Collapsing the Global Search Viewer Display Areas
To expand and collapse the Search Locations, Search Criteria, and Search Results table display areas
of the Global Search Viewer, click one of the splitter bar arrows located between the display areas to
show and hide the section. Continue to click until the desired display is achieved.
Figure 75: Splitter Bar Arrows Icon

Reordering Columns in the Search Results Table
To reorder the columns in the Search Results table, drag the heading of the column to the preferred
location.
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Printing the Search Results Table
To print the Search Results table (object list), follow the Print instructions.
Note: You also can use the Scheduled Reports feature to run reports and print object lists. See
the Scheduled Reports section.

Commanding Objects in the Search Results Table
About this task:
To command objects in the Search Results table (object list):
1.
2.

Select one or more objects following the instructions in the Selecting Objects in the Search
Results section.
If you selected one object, then right-click and select Commands. The Command dialog box
appears. Follow the Commanding Items instructions in the Site Management Portal User
Interface section.
If you selected two or more objects, right-click and select Commands. The Global Commands
dialog box appears. See the Commands Dialog section.

Modifying Objects in the Search Results Table
1.
2.

Select one or more objects following the instructions in the Selecting Objects in the Search
Results section.
If you selected one object, then right-click and select Modify. The Modify dialog box appears.
If you selected two or more objects, right-click and select Modify. The Global Modify dialog
box appears. See the Modify Dialog section.

Copying Search Results to the Clipboard
1.
2.

Select the results according to the Selecting Objects in the Search Results section.
Click Copy to Clipboard.
Note: You also can use Ctrl+C to copy the data.

3.
4.

Open the program to paste the results (for example, Microsoft Excel or Word).
Paste the results according the program’s conventions (generally, Edit > Paste).

Modifying an Object List
See the procedures in the Working with Search Results section.

Opening an Object List
1.
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From the Query Menu, select Open Object List, or right-click the Global Search Viewer title
bar and select Open Object List. The Open Object List dialog box appears.
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Figure 76: Open Object List Dialog Box

2.
3.

Select an object list to open. You can only open object lists under All or under categories for
which you have View access.
Click Open. The Global Search Viewer appears in the display panel with the search criteria
and the object list filling the Search Results table.

Result
Note: Objects that are renamed in the SMP UI after an object list is saved do not reflect the
new name in the object list until the object list is re-saved.

Saving an Object List
About this task:
To save an object list (objects appearing in the Search Results table):
1.
2.
3.

From the Query Menu, select Save Object List, or right-click the Global Search Viewer title
bar and select Save Object List. The Save Object List dialog box appears.
In the Name box, enter a unique name for the object list. This name must be unique;
otherwise, you risk overwriting an existing object list.
In the Category list, select All or select the desired category (for example, General, Security,
and Lighting) to which you want to save the list. You only can save to authorized categories
based on your user rights defined in the Security Administrator system.
Note: If you select a specific category, then the object list is available for use or
modification only by users with the proper authorization for that category. If you select
All, all users can access the object list, including the ability to open, modify, or delete the
list.

4.

Click Save. The object list is saved on the Site Director.

Result
Note: Sorting order is not saved in the object list.
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Deleting an Object List
1.

2.

Select an object list to delete from the tree. Hold down the Ctrl or Shift keys when clicking to
select multiple object lists. You can only delete object lists under All or under categories for
which you have authorization based on your user rights defined in the Security Administrator
system.
Click Delete.

Create New Scheduled Report Screen
The Create New Scheduled Report screen (Figure 77) allows you to configure new report
information and associated schedule information. You can access the Create New Scheduled Report
screen from the Query Menu by selecting New Scheduled Report.
Figure 77: Create New Scheduled Report Screen

Table 396 describes the fields in the Create New Scheduled Report screen.
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Table 396: Scheduled Reports
Field

Description

Report Name

Allows you to enter a name for the report. Use a descriptive name so that
you can recognize the details by the name (for example, Weekly Building Two
Status Report).
Note: Enter a name that has fewer than 100 characters. Otherwise, you receive
an error when you attempt to view the new report.

Object List

Allows you to select which object list to run the report against. For
information on Object Lists, see Object List in the Global Search section.

Report Format

Allows you to select the report file format: Tab Delimited, XML, and Text.
•

Tab Delimited: saves the report with an .txt extension. You can use the
report with a spreadsheet application, such as Excel.

•

XML: saves the report with an .xml extension. You can use the report
with an Internet browser, such as Internet Explorer.

•

Text: saves the report with an .txt extension. You can use the report with
any text-viewing application, such as Notepad.

Send To Printer

Allows you to automatically send the report to the default printer of the
Metasys Server each time the report generates. The report first saves to a
file on the server; then, it is sent to the default printer. Scheduled reports
configured to be sent directly to printer on the Metasys Server are printed
in the system’s default language. For more information on configuring the
default printer on the Metasys Server, refer to the Metasys Server documents
listed in Related Documentation.

Run Report Now

Allows you to run the report immediately.

Schedule Report

Allows you to schedule the report to run at one or more future times.

Run This Report

Allows you to select how often to generate the report. Selections include: One
Time Only (default), Daily, Weekly, Monthly, and Yearly.

Start Date

Allows you to select the report start date.

End Date

Allows you to select the report end date.

No End Date

Allows you to configure the report to run indefinitely.

Date Information

Allows you to further configure the date information for when the scheduled
report runs.

Time Information

Allows you to further configure the time information for when the scheduled
report runs.

Scheduled Reports
The Scheduled Reports feature provides a reporting service on a Metasys Server Site Director. The
Metasys Server generates summary reports based on Object Lists and Report Schedules.

Scheduled Reports Concepts
Scheduled Report
A Scheduled Report consists of one Object List and one Report Schedule. You select the objects that
appear on an Object List. Create and Save Object Lists to the Site Director using the Global Search
feature. A Report Schedule specifies the day and time to run the report.
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Object List
An Object List is a list of objects you select. Object Lists are created and saved to the Site Director
using the Global Search feature. See the Object List section in the Global Search section for more
information.

Report Schedule
The Report Schedule specifies the days and times a report is generated.

Report Output
Scheduled reports generate files on the Metasys Server that contain the actual report output. You
can view the content of a report output file through the online SMP UI using any compatible Web
browser, but you must log in to the Metasys Server Windows operating system and use Windows
Explorer (or another software application) to browse to and delete/manage the files. Scheduled
reports configured to be sent directly to the printer on the Metasys Server are printed in the
system’s default language.
To view the content of the Report Output file in the SMP UI, use the Report Output Viewer. See
Report Output Viewer for information on viewing the Scheduled Report output in the SMP UI. To
manage report output files, see Accessing Report Output Files on the Metasys Server.

Report Output Viewer
The Report Output Viewer allows you to view the content of a Scheduled Report output file in the UI
in the Report Output Viewer window. The Report Output Viewer displays output in any format (tab
delimited, XML, and text) and is available by using the Scheduled Reports Viewer.
Each Report Output viewer window displays the content of a single report output file. You can have
multiple Report Output viewers open simultaneously. To display the Report Output viewer, see
Viewing the Content of a Report Output File.

Scheduled Reports Overview
Each scheduled report contains one or more properties (for example, Item Name and Status)
of each item in an Object List. A report engine on the server runs the Scheduled Report at the
specified times and saves it to a file in a standard location on the server. The report engine can also
send the report output to a printer if specified.
There are two scheduled report screens: the Create New Scheduled Report Screen and the
Scheduled Reports Viewer screen.

Scheduled Reports Steps
Creating a New Scheduled Report
1.

On the Query Menu, select New Scheduled Report. The Metasys - New Scheduled Report
screen appears.

2.
3.
4.
5.
6.
7.
8.
9.

Enter a report name that has fewer than 100 characters.
Select an Object List.
Select a Report Format.
Select Send to Printer if you want to print the report.
Select either Run Report Now or Schedule Report.
In the Run This Report drop-down list, specify how often you want to run the report.
Enter a Start Date.
Enter an End Date.
Note: If you wish to run the report indefinitely, select No End Date.
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10. Enter the Date Information if you schedule to run the report more than One Time Only.
11. Enter the time you want the report to run in the Time Information section.
Note: To repeat the schedule select the Repeat check box. Enter the interval (in
minutes) to repeat and configure the time when this repeating interval ends. The range
is 15 to 1,440 minutes. For an example, see the Scheduling Scenarios section.
12. Click Save.
Note: If you click Cancel, a Metasys - Report Changes Pending screen appears. Click Yes
to save your changes. Click No to close the screen without saving your changes.

Launching the Scheduled Reports Viewer
To launch the Scheduled Report Viewer, select Scheduled Reports from the View Menu. The
Scheduled Reports Viewer Screen appears.

Editing an Existing Scheduled Report
1.
2.
3.
4.

Launch the Scheduled Reports Viewer.
On the Scheduled Actions tab, select the report to edit.
Click Edit.
Make the necessary changes.

5.

Click Save.

Copying an Existing Report to a New Report
1.
2.
3.
4.
5.

Launch the Scheduled Reports Viewer.
Select the Scheduled Actions tab.
Select a report to copy.
Click Edit.
Click Copy to New Report. The Copy to a New Report dialog box appears.
Note: The Copy To a New Report button allows you to save an exact copy of the current
report with a different name. Your new report appears in the Scheduled Actions tab in
the Scheduled Reports Viewer.

6.
7.

Enter a new name or Object List.
Click OK. A message appears to indicate a successful copy. Your new report appears in the
Scheduled Actions tab in the Scheduled Reports Viewer.

Enabling/Disabling a Report

2.

Launch the Scheduled Reports Viewer, and select either the Actions in Progress tab or the
Scheduled Actions tab.
Click the report.

3.

Click Enable or Disable.

1.

Rescheduling a Completed or In Progress Report
1.
2.
3.
4.
5.

Launch the Scheduled Reports Viewer and select the Completed Actions or Actions in
Progress tab.
Click the report.
Click Reschedule. The Reschedule a Report screen appears.
Modify the date and time using the drop-down menus.
Click OK.

Metasys Site Management Portal Help

655

Viewing the Status of a Report
1.
2.
3.
4.
5.

Launch the Scheduled Reports Viewer and select the Completed Actions tab.
Click the report.
Click View Status. The Scheduled Reports Status dialog box appears.
Verify the scheduled report has completed successfully.
Click OK.

Deleting an Existing Scheduled Report
1.
2.
3.
4.

Launch the Scheduled Report Viewer and select the Scheduled Actions tab.
Click one or more reports.
Click Delete. The Confirm Delete dialog box appears.
Click Yes to confirm the delete.

Deleting a Completed Report Status Entry or an In Progress Report
1.
2.
3.

Launch the Scheduled Reports Viewer and select the Completed Actions or Actions in
Progress tab.
Click one or more reports.
Click Delete.
Note: The current Report Schedule is not affected. Deleting a completed report status
entry or an in progress report only affects the instance of the report that is currently
running or the completed status entry.

Automatically Deleting Completed Report Status Entries
About this task:
To automatically delete completed report status entries after a given amount of days:
1.
2.

Launch the Scheduled Reports Viewer and select the Completed Actions tab.
Enter a number of days in the Number of days after which entries will be automatically
deleted (1–30) text box.
Note: The SMP UI supports a maximum of 500 entries displayed on each screen of the
Scheduled Reports Viewer. Either configure the number of days between automatic
deletion to ensure the number of entries remains less than 500 or periodically delete the
entries manually.

Accessing Report Output Files on the Metasys Server
About this task:
You may need to access report output files to view, delete, or use data from the report in other
applications. To view the output in the SMP UI, see Viewing the Content of a Report Output File.
To access report output files on the Metasys Server:
1.
2.

Log on the computer that is running your Metasys Server,
Navigate to the report directory. The default directory of the report output files on the
Metasys Server Site Director is C:\ProgramData\Johnson Controls\MetasysIII\File
Transfer\Report Definitions.
To change the default directory of the report output files, see the Changing the Report Output Directory Location section.
Note: The directory name and report name are the same.

3.
4.
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Select the report to view.
Open the report in the correct viewer.
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Notes:
- The correct viewer depends on the report type (for example, text in Notepad, XML in
Internet Explorer, and tab delimited in Excel).
- You may wish to periodically archive or delete report output files to avoid filling the
Metasys Server hard disk.

Viewing the Content of a Report Output File
About this task:
You can use the Report Output viewer to view the content of a report output file, copy the content
to the clipboard, or save the content to a file on your local computer. To view and manage the
output files on the Metasys Server, see Accessing Report Output Files on the Metasys Server.
To view the content of a Report Output file in the SMP UI:
1.
2.

Launch the Scheduled Reports Viewer.
On the Completed Actions tab, select the report for the output file you would like to view.
Note: You can also double-click the report to view it in the Report Output Viewer
window.

3.

4.

Click View Report. The Report Output Viewer window appears.
- The View Report button is enabled only when a single report is selected. If no reports
are selected, or more than one report is selected, the button is disabled.
- To copy the content to the clipboard, click Copy to Clipboard. To save the content to a
file on your computer, click Save to File.
- If the report was not successful, the following error message appears: The report
output file does not exist or cannot be accessed.

Click Close when you are finished. All open Report Output Viewer windows close when you
log out or exit the UI.

Changing the Report Output Directory Location
About this task:
The default directory for the Scheduled Report output on the Metasys Server Site Director is C:
\ProgramData\Johnson Controls\MetasysIII\File Transfer\Report Definitions.
Use this procedure if you want to change the location of the report output directory.
To change the Report Output directory location:
1.
2.
3.
4.

From the Control Panel of the Metasys Server Site Director computer, select Administrative
Tools > Services. The Services window appears.
Right-click the Metasys III Action Queue service and select Stop.
Right-click the Metasys III Device Manager service and select Stop.
Right-click the Metasys III Action Queue service and select Properties. The Metasys III
Action Queue Properties dialog box appears.
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Figure 78: Metasys III Action Queue Properties Dialog Box

5.
6.
7.
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Note the directory in the Path to executable text box (Figure 78), and use Windows Explorer
to navigate to that directory.
Open the ActionQueue.exe.config file using a standard text editor, such as Notepad.
Locate the following line of text (Figure 79):
<add key=“FileTransfer.AliasFilePath” value=“C:\ProgramData\Johnson
Controls\MetasysIII\FileTransfer\”/>
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Figure 79: ActionQueue.exe.config File Text

8.

Change the contents of the value section to the preferred location of the report output. For
example, to send report output to the C:\Metasys System directory, the line of text appears as
follows:
<add key=“FileTransfer.AliasFilePath” value=“C:\Metasys System\”/>

9. Save and close the ActionQueue.exe.config file.
10. Cut the Report Definitions subdirectory and its contents from C:\ProgramData\Johnson
Controls\MetasysIII\File Transfer\Report Definitions.
11. Paste the files to the location defined in step Step 8 (for example, C:\Metasys System
\Report Definitions).
12. Return to the Services window. (See Step 1 for the location.)
13. Right-click the Metasys III Device Manager service and select Start.
14. Right-click the Metasys III Action Queue service and select Start.

Scheduling Scenarios
Repeat step Step 1 to step Step 4 in Creating a Daily Report section for all of the Scheduling
Scenarios.
Creating a Daily Report
About this task:
To create a new report that runs every day at 8:00 A.M. with no end dates:
1.
2.
3.
4.
5.
6.
7.
8.

On the Query menu, select New Scheduled Report. The Create New Scheduled Report Dialog
Box appears.
Enter a report name that has fewer than 100 characters.
Select an Object List to run the report against.
Select a Report Format.
Select Schedule Report.
Select Run This Report Daily.
Verify the Start Date is set to today.
Select the No End Date check box.
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9.

In the Time Information section, configure the Run At time to 8:00 A.M.
Note: Do not configure Repeating Information.

10. Click Save.
Creating a Repeating Weekday Report
About this task:
To create a new report that runs every hour on weekdays between the hours of 11:00 A.M. and 1:00
P.M. with an end date of two months from today:
1.

Repeat step Step 1 to step Step 4 in Creating a Daily Report.

2.
3.
4.
5.
6.
7.
8.
9.
10.

Select Run This Report Weekly.
Verify the Start Date is set to today.
Configure the End Date to two months from today.
In the Date Information section, select the Mon - Fri check box.
In the Time Information section, configure the Run At time to 11:00 A.M.
Select the Repeat check box. The Until and Every fields enable.
Configure the Every field to 60 minutes.
Configure the Until field to 1:00 P.M.
Click Save.

Creating a Repeating Monthly Report
About this task:
To create a repeating monthly report that runs on the 15th and last day of every month at 8:00 A.M.
with no end date:
1.
2.
3.
4.
5.
6.
7.

Repeat step Step 1 to step Step 4 in Creating a Daily Report.
Select Run This Report Monthly.
Verify the Start Date is set to today.
Select the No End Date check box.
In the Date Information section, select 15 and Last (Ctrl + click).
In the Time Information section, configure the Run At time information to 8:00 A.M.
Click Save.

Creating a Repeating Yearly Report
About this task:
To create a repeating yearly report that runs on the last day of February:
1.
2.

Repeat step Step 1 to step Step 4 in Creating a Daily Report.
Select Run This Report Yearly.

3.
4.
5.
6.
7.

Enter the Start Date.
Enter the End Date.
In the Date Information section, select Feb and Last from the drop-down menus.
In the Time Information section, configure the Run At time information.
Click Save.
Note: If it is a leap year, this report runs on February 29th; otherwise, it runs on
February 28th.

Create a Report to Run Immediately
About this task:
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To create a new report to run immediately:
1.
2.
3.

Repeat step Step 1 to step Step 4 in Creating a Daily Report.
Select Run Report Now.
Click Save.

Help Menu Introduction
Help Menu
The Metasys Help files provide shared system information and individualized, mode-dependent
information for the Metasys Site Management Portal (SMP) or the System Configuration Tool (SCT).
The Metasys SMP Help (LIT-1201973) and Open Data Server Help (LIT-12011942) provide information
about alarming, commanding, auditing live data values, and other online features. The Metasys
SCT Help (LIT-12011964) provides information about offline operations such as managing archives,
creating spaces, simulating systems, and establishing equipment and serving relationships.
In either SMP or SCT mode, the Metasys System Help menus provide Help files in PDF format. Refer
to the QuickLIT website for the most up-to-date version of the Metasys Help files.
For more information on the modes of operation, see Metasys Modes. For a description of the
Authorized Required column, see Authorized Menu Items.

Help Menu Concepts
Metasys Help
Menu Selection: Help > Metasys Help
Launches the Metasys System Help for the Site Management Portal User Interface.

Metasys Graphics Help
Menu Selection: Help > Metasys Graphics Help
Launches the Metasys Graphics+ Runtime Help.

SCT Help
Menu Selection: Help > SCT Help
Launches the Metasys SCT Help.
Starting at Release 10.0, you can also launch the Metasys SCT Help using the question mark icon
located in the upper right-hand corner in the Space Tree Editor, Modify Dialog, and All Items
Organizer windows of the Metasys SCT user interface. Click the icon to open the topic related
chapter of the Help PDF in a web browser.
Note: We recommend setting your default web browser to Goggle Chrome for proper
functionality of this feature.

About Metasys
Menu Selection: Help > About Metasys
Displays the Metasys software version, UI version, Graphics+ runtime software version, and
copyright. Click Terms & Conditions to view terms and conditions information.
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Figure 80: About Metasys Software

Help Menu Steps
Printing the Help
Printing Specific Help Topics
About this task:
To print a specific Help topic:
1.
2.

Click the Print button in the Help or click the Options button and select Print.
If the Contents tab is currently active, choose between printing the selected topic only or the
selected heading and all sub-topics. The content prints.
If another tab is active, select a printer and the Help prints the current content displayed on
the right side.

Result
Note: Information in drop-down lists prints only if you have the list open on the screen. Popup content does not print in the pop-up window.

Printing the Entire Help System
About this task:
The entire Help system is available for printing in Adobe PDF format.
To print the entire Help system:
1.
2.
3.
4.
5.

If necessary, download Adobe Reader® (required to view the PDF file) from the Adobe Reader
site.
Go to the QuickLIT Product Information website.
In the tree on the left, browse to Metasys System > General System Information.
On the right side of the window, click Metasys System Help (PDF format). The Help PDF
opens in Adobe Reader.
On the File menu of Adobe Reader, select Print.

Result
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Note: This file is large (approximately 800 pages). Allow adequate time for downloading and
printing.

Right-Click Menus
The contents of the menus vary depending on the item or feature selected. The contents are
either feature-specific based on the active panel or item-specific based on the selected item in the
navigation tree.

Right-Click Menus and Menu Bar Equivalents
The following table shows the menu items that may appear in a right-click menu and their
equivalent in the menu bar.
Table 397: Right-Click Menus and Menu Bar Equivalents
Right-Click Menu Item

=

Menu Bar Item

Audit Viewer

=

View > Audit Viewer

Command

=

Action > Command

Modify

=

Action > Modify

Copy

=

Edit > Copy

Paste

=

Edit > Paste

Delete Items

=

Edit > Delete Items

Edit

Note: The Edit menu or right-click > Delete functions cannot be used to delete items from a User View while the
User View Editor is open. Using either function permanently deletes selected items from the archive.

Event Viewer

=

View > Event Viewer

Alarm Report

=

Query > Alarm Report

Offline Report

=

Query > Offline Report

Disabled Report

=

Query > Disabled Report

Operator Override Report

=

Query > Override Report

Supervisory Override Report

=

Query > Override Report

Trouble Report

=

Query > Override Report

Out of Service Report

=

Query > Override Report

Show Extensions

=

Action > Show Extensions

Export CAF File

=

Action > Export CAF File

Export CAF Files

=

Action > Export CAF Files

Refresh

=

Action > Refresh

Refresh All Tabs

=

Action > Refresh All Tabs

Refresh Current Tab

=

Action > Refresh Current Tab

View

=

View > Selected Item

Rename

=

Action > Rename

Remove From Site

=

Action > Remove From Site

Add Annotation

=

Action > Add Annotation

View Annotations

=

Action > View Annotations
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Table 397: Right-Click Menus and Menu Bar Equivalents
Right-Click Menu Item

=

Menu Bar Item

Import Integration

=

Action > Import Integration

Import Definition

=

Action > Import Definition

Locate in Tree

=

Action > Locate in Tree

Right-Click Menus - Feature Specific
Click one of the following active panels or features for a description of the active panel or feature.
For more information on the modes of operation, see Metasys Modes.
Table 398: Right-Click Menus - Feature Specific
Active Panel/Feature
Audit Viewer

Event Viewer

Online SMP

11

22

•

Refresh

•

Discard

•

Add Annotation

•

View Annotation

•

Refresh

•

Discard

•

Ack

•

View Item

33

2

Note: Once you navigate to the item, you can
right-click it and use the Locate in Tree feature.

Report Viewer
Global Search Viewer

3

•

Add Annotation

•

View Annotation

•

Refresh

•

View

•

Refresh

•

Delete Items

•

Open Object List

•

Save Object List

•

View

•

Command

•

Modify

•

Add Annotation

•

View Annotations

•

Show Extensions

•

Locate in Tree

2

44
2

2

2

4
4

3
3

Change Results Viewer
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Table 398: Right-Click Menus - Feature Specific
Active Panel/Feature
All Items Organizer

6

Tailored Summaries
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Online SMP

11

2

•

Refresh

•

Move Up

•

Move Down

•

Sort Ascending

•

Sort Descending

•

Refresh Current Tab

•

Refresh all Tabs

•

View

•

Event Viewer

•

Audit Viewer

•

Command

•

Modify

•

Add Annotation

•

View Annotations

•

Show Extensions

•

Alarm Report

•

Offline Report

•

Disabled Report

•

Operator Override Report

•

Supervisory Override Report

•

Trouble Report

•

Out of Service Report

•

Import Integration

•

Locate in Tree

55
5
2

2

5

5

3
3

5
5
5
5
5

5
5

77
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Table 398: Right-Click Menus - Feature Specific
Active Panel/Feature
Trend Viewer

Online SMP

11

2,4

•

Refresh

•

View

•

Command

•

Modify

•

Event Viewer

•

Audit Viewer

•

Add Annotation

•

View Annotations

•

Background Color

•

Y-Axis Scale

•

X-Axis Scale

•

Gridlines

4
4

88
4

4
3
3

99

9
9

9
9

- None

9

- X and Y
9

- X Only
- Y Only
•

9

9

Chart Type

- Points Line
- Area

9

9

9

- Bar

9

- Points
9

- Line

Tabbed Item Viewer (Display Panel Tabs)

1
2
3
4
5
6
7
8

666

9

•

Stacked Y-Axis

•

Locate in Tree

•

Delete Items

•

Modify

•

Refresh Current Tab

•

Refresh All Tabs

•

Command

•

Show Extensions

2

2

The View, Commands, and Show Extensions menu items are item specific.
With the header of the display panel selected.
Available on the Metasys Server only.
With an item in the report, Legend, Trend Items table, or results table selected.
Available for an Engine only.
The menu options available are item specific (that is, they depend on the type of item selected in the Tailored Summary
table and Key Data table).
Available for a Tailored Summary with trunk/integration data (for example, trunk diagnostics).
With an item in the Legend selected.
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With the Chart selected.

Right-Click Menus - Item Specific
Click one of the following items for a description of the item. For more information on the modes of
operation, see Metasys Modes.
Table 399: Right-Click Menus - Item Specific
Item
Folder

ADS

User Views
Site
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Online SMP
•

View

•

Modify

•

Import Definition

•

View

•

Modify

•

Command

•

Event Viewer

•

Audit Viewer

•

Add Annotation

•

View Annotations

•

Remove from Site

•

View

•

Modify

•

View

•

Command

•

Add Annotation

•

View Annotations

1

2
2

2
2

667

Table 399: Right-Click Menus - Item Specific
Item

Online SMP

Supervisory Device
(Engine)

Summary Definition Object

3

All Other Objects

1
2
3
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•

View

•

Event Viewer

•

Audit Viewer

•

Command

•

Modify

•

Add Annotation

•

View Annotations

•

Show Extensions

•

Alarm Report

•

Offline Report

•

Disabled Report

•

Operator Override Report

•

Supervisory Override Report

•

Trouble Report

•

Out of Service Report

•

Remove from Site

•

View

•

Modify

•

Export Definition

•

View

•

Command

•

Modify

•

Show Extensions

•

Add Annotation

•

View Annotations

•

Delete Items

2
2

2
2

Available for the Summary Definitions folder in the All Items tree.
Available on the Metasys Server only.
For Trend or other extensions, the View and Show Extensions menu items display for the parent item, not for the
extension itself.
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Troubleshooting
Table 400: Troubleshooting
Problem

Solution

When you attempt to execute any N2 Passthru
tool (for example, HVAC PRO) from the ADS,
ADX, or NAE user interface, the following error
appears:
The Supervisory Controller does not
contain any supported devices

Date or time may be incorrect. Verify that
all dates and times are correct. For more
information, refer to Appendix: Time Zone,
Date, and Time Management in the ADS/ADX
Commissioning Guide (LIT-1201645).
OR
Item name may be too long. Refer to the HVAC
PRO Name Restrictions in Passthru Mode section
in the SCT Help (LIT-12011964).

After I manually change the date on a network
engine, then adjust the date using a manual
command, the new date that appears in the
SMP UI is one day ahead of the commanded
date.

This behavior occurs only for these time zones:
(UTC+400) - Abu Dhabi, Muscat
(UTC+5:54) - Kathmandu
(UTC+1200) - Fiji
To set the date correctly, log on the network
engine with the NCT and change the date. Refer
to the NxE Information and Configuration Tool
Technical Bulletin (LIT-1201990).

The Event Viewer is repeatedly showing the
following alarm message:
<service name> Queue System Monitor
Alarm.
<service name> queue's messages are
not getting processed.
where <service name>is the name of the
Metasys-related service.

These types of warnings are from Metasysrelated services that have not fully started on
the server. They are normal messages that
occur when the server is first started, then stop
occurring once all Metasys-related services have
fully started. This reflects normal operation. An
example for message queue monitoring service
that is starting up would be as follows:
NewActivityData Queue System Monitor
Alarm.
NewActivityData queue's messages are
not getting processed.

A network engine does not come back online to
the Site Director after you download its archive
with SCT.
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Communication between the Site Director
and the network engine may be problematic
on some building networks. To resolve this
issue, specify a domain name in the Completion
Domain attribute under the Network tab of the
engine (for example, mycorp.com). The network
engine then communicates with its Site Director
using the domain name appended to the engine
name, such as NAE-1.mycorp.com. You may
also need to restart the network engine for the
change to be fully applied.
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Table 400: Troubleshooting
Problem

Solution

SCT does not log in to allow HVAC PRO to load
despite already being logged in to the NAE.
SCT (offline) allows you to log in and run HVAC
PRO, but you receive a ZSWHPRO crash when
you try to do anything over Passthru.

The Site Director is offline. Log in and verify it is
online.

When you attempt to open a graphic, the
following message appears:
Metasys Graphic Viewer file is still
being validated. Please wait a few
seconds and click "Refresh All Tabs."

The graphic is still loading onto the screen. The
graphic signature validation process typically
takes a few more seconds than it takes the
SMP UI to load the graphic, which results in
this message that requests the user to wait a
few seconds and refresh all tabs. To resolve,
specify a value for the Delay start graphic
load attribute under the Display Settings Tab of
Metasys Preferences.

Login responds with:
Unable to Login. Unexpected Error.

A user might be denied access to the Metasys
Server/SCT computer over the network. In
Control Panel > Administrative Tools, check
the Local Security Policy properties on the
Metasys Server/SCT computer and make sure
that the user’s name is not listed under the User
Rights Assignment called Deny access to this
computer from the network.
OR
An Active Directory user is denied access to
the SCT because their user name has not
been added to the MSEA-SSO user group on
the SCT computer. For details, refer to the
Security Administrator System Technical Bulletin
(LIT-1201528).
OR
Verify the JRE proxy settings are disabled. To
verify proxy settings are disabled:
1.

On the Start menu, select
Settings > Control Panel.

2.

Select the Java icon. The Java Control Panel
appears.

3.

Select the Proxies tab.

4.

Clear the Use browser settings check box.

5.

Click OK.

OR
SCT must be completely uninstalled. You may
also have to uninstall IIS 5.0 and the .NET
Framework. Reinstalling SCT should fix this
problem. If there are error messages from the
Installer, there may also be an issue at runtime.
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Table 400: Troubleshooting
Problem

Solution

SCT installer responds with:
XPPKInitConsole,exe crash

The error typically occurs if IIS 5.0 is installed
after the .NET Framework. Uninstall .NET,
IIS, and SCT. Reinstall in the following order:
IIS, .NET, SCT.

HVAC PRO gives the item reference of the NAE,
but fails to get any controllers and causes
ZSWHPRO.EXE to crash.

Only the second N2 Trunk is integrated.
Integrate the first N2 Trunk, even if it has no
controllers on it. You must integrate the first
N2 Trunk if N2 Trunk 2 is being used in HVAC
PRO, even if there are no devices on the first N2
trunk.

N2 applications respond with no information, or Two N2 Passthru Applications may not run at
lock up.
the same time when used in Passthru mode.
Close all of the N2 Passthru applications and
restart. Run one N2 Passthru application at a
time.
SCT upgrade tool fails with the following archive
upgrade log error for a restored database:
In ConvertArchives: Error in reading
archive data for fixbuild1, Empty
Archive

Verify the name of the backup matches the
name of the archive. To verify the backup and
archive names match, log in to the Site Director.
The name at the top of the tree is the archive
name. Rename the SCT backup database to
match the archive name, restore the database,
and execute the archive upgrade again.

When you attempt to use one of the N2
Passthru tools, the following error message
appears:
Supervisory Device Offline

M-Tools may have been installed while running
the N2 Passthru. Shut down all active N2 Tools
and SCT. Reinstall SCT.

A DX9100 device may remain offline after exiting
the GX9100 Commissioning tool. This occurs
when the tool is run in passthru mode from
a Metasys Server. In the NAE, the DX9100 N2
Device tab shows:
Offline = True and Enabled = True

The GX9100 device is disabled at the GX9100.
To enable the GX9100 device, you must first
command the DX9100 N2 Device to Disable,
then command the DX9100 device to Enable.

The N2DeviceLoader/LoaderUI
(LoaderUIG3.exe) crashes when you try to
connect to the site.

The error typically occurs when you have a child
NAE listed above the Site Director. When the
child NAE appears offline (with a red or blue X),
the N2DeviceLoader/LoaderUI crashes.
Right-click the offline NAE and choose Remove
from Site.

The SCT installed without error, but the SCT UI
window freezes or stalls while Java software is
loading.

A connection manager may be installed on the
computer. If present, uninstall the connection
manager.
As a reference, refer to Microsoft Knowledge Base
Article KB910435 (http://support.microsoft.com/
kb/910435).
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Table 400: Troubleshooting
Problem

Solution

SCT responds with:
You do not have permission to use the
System Configuration Tool

This error occurs when you attempt to log
in to the SCT and you do not have proper
permissions assigned. If you are an Active
Directory user, this occurs when attempting to
start the SCT.
Verify that System Configuration Tool is
an assigned privilege for the user in the
System Access Permissions of the Security
Administrator System.

The SCT download freezes with the load status
of establishing communications. No error
message appears.

If this problem occurs while performing
downloads in the SCT, wait a few minutes to
allow the download to complete. Then, refresh
the SCT display. The updated status message
appears when the download completes.
Note:

When downloading a device or server, the
following message appears:
Communication Lost after Reset
Communication error (521)

You are uncertain whether to control your
building with standard objects or the LCT.
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•

The amount of time it takes to
download depends on the size of the
database, but is usually a few minutes.

•

In addition, you can determine that
the database downloaded properly by
waiting for the device to come online
after the download completes.

This error may occur due to problems with
network connectivity, or the unavailability of the
target devices.
Check the following:
•

The device (Metasys Server, NxE) to
which you are downloading is powered,
operational, and has network connectivity
to the computer running SCT.

•

In an ADX split configuration, both the
ADX web/application server and the
ADX database server are powered and
operational, and the ADX web/application
server has network connectivity to the
computer running SCT and to the ADX
database server.

In general, if you can perform tasks with
standard objects, do so. Standard objects are
less memory intensive and thus have a smaller
impact on system performance than complex
LCT logic.
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Table 400: Troubleshooting
Problem

Solution

In SCT, when trying to save a standard user
graphic from a restored database, the following
error appears:
Failed to communicate to the server or
device.

This problem occurs when the user graphic size
is over 4 MB, which is the default maximum
allowed size for an IIS message as defined by
Microsoft Corporation.
The workaround is to increase the default
size using the <httpRuntime> element in the
system.web section of the web.config file.
Change the values of the maxRequestLength
and executionTimeout attributes.
Note: maxRequestLength is defined as the
number of KB allowed, so that the default is
4,096 KB (4 MB); executionTimeout is the
number of seconds until the request is killed.

For example, a maxRequestLength of 40 MB
and executionTimeout of 10 minutes appears
as follows:
...
<configuration>
<appSettings>
<!-- The following settings are used by
the GenericItem Capability. -->
<add key="GenericItemDb.AssemblyName"
value="C:\inetpub\wwwroot\MetasysIII
\Tool \bin\Subsystems.Database.dll"/>
<add key="GenericItemDb.ClassName"
value="JohnsonControls.MetasysIII.Databa
se. GenericItemDbFactory"/>
...
</appSettings>
<system.web>
<httpRuntime executionTimeout="600"
maxRequestLength="40960"/>
</system.web>
</configuration>

On your Windows operating system,
applications such as IIS Manager and Windows
Event Viewer do not run with Administrative
privileges even though you are logged in to the
computer as an Administrator.

Manually run the application as an
Administrator:
Right-click the application and select
Properties > Run As Administrator.

On your Windows operating system, when
using Windows Authentication to access a SQL
database with SQL Server Express Management
Studio (or other user-driven application), you
do not obtain sysadmin permissions in the SQL
database even though you are logged in to the
computer as Built-in/Administrators and have
sysadmin permissions in the SQL database.

Manually run the application as an
Administrator:
Right-click the application and select Run As
Administrator.
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Table 400: Troubleshooting
Problem

Solution

You cannot view log files on your Windows
operating system.

Due to changes in Administrator viewing
behavior, log files may not be visible. Manually
run Windows Explorer as an Administrator:
Right-click the Windows Explorer icon and select
Run As Administrator.

You cannot access protected folders (such as
Program Data), even though you are logged
on the computer's operating system as an
Administrator.

Manually run Windows Explorer as an
Administrator:
Right-click the Windows Explorer icon and select
Run As Administrator.

You cannot find the Add/Remove programs
option in Control Panel of your Windows
operating system.

Add/Remove Programs is now called Programs
and Features. In Control Panel, select Control
Panel Home on the left pane. Then in the right
pane, select Programs > Programs and Features.

You cannot locate where to change the folder
settings, such as showing file extensions
and showing system files, on your Windows
operating system.

In Control Panel, select Appearance and
Personalization > Folder Options.

Your Windows operating system does not
prompt for consent or for your credentials when
you are making a software or configuration
change.

This situation happens when you are logged
in as the built-in Administrator account. The
built-in Administrator account provides a
full administrator access token, unlike other
administrative users who are logged in with only
standard access tokens that require elevation
to perform administrative tasks. The builtin Administrator account in your operating
system is disabled.

One of the following errors appears after
attempting a global modification:
Object does not exist.
One or more attribute modifications
failed.

When running Metasys Release 3.0 or later, you
cannot use the global modify feature on devices
at Release 2.2 or earlier.
For information on globally modifying items, see
Performing a Global Modify in the Modify Dialog
section.
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Note: This task is done on an individual user
basis.
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Table 400: Troubleshooting
Problem

Solution

An object appears with no name in the
navigation tree or the Focus/Configuration tab.

This problem occurs when an object is created
through third-party BACnet network and neither
the Object Name (BACnet property) nor the
User Name (Johnson Controls proprietary
property) is initialized. As a result, the object
appears with no name in the navigation
tree (that is, only the icon appears) or the
Focus/Configuration tab. The object functions
properly. An SCT download works and the Site
Management Portal UI displays the information
as it was before the upload.
The UI forces you to enter a user name when
you attempt to edit any other fields of the
object.
This problem does not occur if you specify an
Object Name either during the BACnet create or
through a BACnet write after object creation.

If you use the Release All command from
the Site Management Portal UI to release
overrides of the FEC Outputs, the priority array
that resides in the FEC controller clears. The
FEC controller outputs go to the Relinquish
Default values and are not commanded with the
value determined by the controller application
because the module outputs send on a COV
basis.

This is a misuse of the Release All command.
The Release All command works exactly as
designed. The proper command to use is the
Override Release command.
To recover the FEC controller from a Release
All Command, issue the command value
determined by the application instead of the
relinquish default.
To release an override, use the Override
Release command. For other types of releases,
make sure you use the release that corresponds
to the command to release.

The Metasys system cannot discover BACnet
Trend Logs on a Siemens® device.

You cannot discover BACnet Trend Logs on a
SIEMENS device. Add the Trend Log manually to
show the trend log attributes in the views and
log data graph properly. The SIEMENS thirdparty Trend Log object does not support the
Logging Type attribute, which is used in the
BACnet discovery process.

When adding a LonWorks point manually, the
Target Reference appears blank.

This is normal functionality. Manually type the
path for the Target Reference (path into the
controller for the data being mapped by the
object) in the text box on the Select Data Source
screen.
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Table 400: Troubleshooting
Problem

Solution

You cannot command analog objects to values
outside of the minimum and maximum present
value allowable range. If you have objects
with values outside of the allowable range
and upgrade to the next software release, the
objects may now appear unreliable.
This affects programmed features such as
the LCT, Scheduling, and the MCO, as well as
manual commands.

Change the minimum and maximum range to
include the values used to ensure your features
work properly.

An operator command to an MCO in an
NAE35/45 or NCE25 fails the first time, but
succeeds the second time it is commanded.
This issue does not occur for MCO objects in the
NAE55.

The enabled firewall on the NAE35/45 or NCE25
engine is interfering with command execution.
As a workaround, re-issue the same command
to the MCO.

The Metasys system cannot command or write
LonWorks, N1, N2, XL5000, and VND output
points at priority 6 (Minimum On Off).

Priority 6 (Minimum On Off) is reserved by the
BACnet protocol for minimum on/off control.
You may need to edit interlocks, multiple
command objects, schedules, and LCT objects
in existing databases using this priority after
converting them.

When a point goes into alarm, Metasys software If you experience this issue:
receives the alarm message and a multitude of
1. In the Notification Class object, on the
normal messages. You must acknowledge all
Focus\Configuration tab, click Edit.
normal messages to get to the alarm message.
2. Find the Ack Required attribute.
You are not using BACnet intrinsic alarming.
3. Deselect To Normal.
4.
Computer Name (Host Name) restrictions are
unclear to you.
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Click Save.

Starting at Release 2.1.10, the NAE Update Tool
places restrictions on the Host Name (Computer
Name) values you can use for NAE35, NAE45,
and NCE25 models. Name values must start with
a letter, end with either a letter or a number,
and may contain dashes only in the interior
of the name. The Host Name must contain a
letter other than or in addition to the letter A.
For example, A522446 is not valid, but either
A522446B or AB52446 are valid. Failure to
follow the Host Name restrictions results in
the Computer Name value changing when an
NAE35, NAE45, or NCE25 is updated. Refer to the
NAE Update Tool Technical Bulletin (LIT-12011524)
for more information on Host Name restrictions.
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Table 400: Troubleshooting
Problem

Solution

Changes made at an NxE do not appear in the
UI of the Site Director.

For releases prior to Release 5.0, use the
Update All Items Cache command to update
the All Items cache on the Site Director.
See the Update All Items Cache command
and All Items Update in Progress attribute
descriptions in the Site Object section for
details.
Note: The All Items cache automatically updates
for engines at Release 5.0 or later.

You cannot edit an LCT process on an NxE at
version 2.1 or 2.2 from ADSs/ADXs at Release 3.0
or later.
The following error message appears when
attempting to edit LCT processes or Program
(Control System) objects from earlier versions:
This logic diagram is read-only for
the current version of Metasys. To
edit the diagram you must directly
log in to the device on which it is
located.
A similar error message appears if you try to
edit a graphic object at Release 2.2 or earlier
from a Site Director at Release 3.0 or later.

You cannot have mixed versions to edit the
LCT in the Engine from the Metasys Server, if
the Metasys Server is at Release 3.0 or later.
You cannot have devices at different releases
because the Scalable Vector Graphic (SVG)
rendering program was changed after Release
2.2.
This change in functionality is per design. As the
system progressed, we were unable to support
newer features while maintaining the ability
to edit the processes created in the earlier
versions. To edit LCT processes or Program
(Control System) objects in a mixed system, you
need to log in to the Engine directly.

Some graphics appear jumbled when viewed in
a single pane. If you minimize the window and
maximize it again, the problem resolves for a
few moments and then recurs.

This issue may be due to the following
circumstances:
•

older Java software components are
present on the computer

•

the graphics card on your computer is not
configured properly

To resolve this issue, remove any unused Java
software on your computer using Add/Remove
Programs. Check the product documentation
from the graphic card manufacturer to ensure
the card is configured properly.
You are using Metasys software with P2000
software and alarm behavior is unexpected.

Metasys Site Management Portal Help

Discarding or acknowledging an alarm at the
Metasys Server acknowledges the alarm, but
the alarm reappears (with the same date/time
stamp) in the Alarms window and Event Viewer
of the Metasys Server, but not the P2000 Event
Viewer.
This is expected behavior at this time and occurs
because the Metasys Server cannot confirm
activity in the P2000 system.
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Table 400: Troubleshooting
Problem

Solution

A graphic takes an unusually long time to
appear in the UI.

To resolve this issue, try resizing the UI window.
The graphic should appear at the usual speed.
Note: Keep in mind that graphic complexity,
network traffic, and other factors can impact the
speed at which graphics display. If a graphic displays consistently slow, one of the factors may
be the cause.

Nodes in the navigation tree are slow to open
for Release 5.0 or later.

This behavior may occur if the NavTreeCache
database requires maintenance. A stored
procedure in the NavTreeCache database called
spu_DoDBMaintenance performs the required
maintenance. You can run this stored procedure
manually or on a schedule using either the SQL
Server Agent or Windows OS Task Scheduler.
Refer to microsoft.com for details on stored
procedures and how to run them.

When entering the IP address in the Internet
Explorer address bar to launch Metasys
software, Multiple UI windows open.

If you are using a private network, we
recommend you turn off the Internet Explorer
SmartScreen Filter feature.
Failure to do so does not prevent Metasys
software from running but may launch multiple
UI windows unnecessarily.

Email is no longer being sent after upgrading
from Release 4.0 to Release 5.0.

Due to changes made at Release 5.0, you may
need to rebuild the Email DDA.

You are editing pager destinations and you lose
some of the definitions.

This occurs when the web service times out.
You can work around this by extending the web
service timeout. To do this:
1.
2.
3.
4.
5.
6.

Navigate to c:\Inetpub\wwwroot
\MetasysIII\WS

Open the web.config file in a text editor.
Go to the section that ends with </
system.web>.

Insert a blank line above that entry.
In the inserted line, enter: <httpRuntime
executionTimeout="600"/>.
Save the web.config file. This changes
the default timeout of 110 seconds to 10
minutes, allowing sufficient time for the
save to occur.

Note: Depending on your operating system and
configuration, this file may be listed as an XML
configuration file named web.
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Solution

After a VND Integration is defined and a
resource file extension is added, the file
associated with the resource is not downloaded
into the NAE45 (\N40 folder) and therefore
cannot be found or used for point autodiscovery.

This problem occurs when the User Access
Control (UAC) default setting is set higher than
Never Notify. Lower the UAC to Never Notify and
the resource file can then be downloaded into
the NAE.

After adding a field device using the Insert Field
Device Wizard and using Auto Discovery, the
navigation tree does not automatically update
for defined points (+ sign appears next to device
in tree).

If the navigation tree does not automatically
update for defined points after adding a field
device using Auto Discovery (+ sign appears
next to device in tree), select Refresh All Tabs
on the Action menu to update.

The following message appears in the Alarms
window or in the Event Viewer:
Warning - MSMQ not processing messages
from Private$Message_trendbacklog.
Message Count: 1.

This alarm indicates that the Metasys Server
server could not process at least one message
in the Metasys_trendbacklog queue. The NAE
might be receiving trend data from a point
with an unsupported data type. For further
assistance, contact the Field Support Center
(FSC).

On Windows 10, Windows 8.1, Windows 8,
Windows Server 2012 R2, or Windows Server
2012, the Alarms window does not appear.

Always view the SMP UI on the desktop.
The Alarms window does not appear on the
Windows 10, Windows 8.1, Windows 8, Windows
Server 2016, Windows Server 2012 R2, or
Windows Server 2012 Start screen.

On Windows 10, Windows 8.1, and Windows 8,
with Internet Explorer 10, when you click Print
Preview for a Graphics+ object, the following
ActiveX web browser message appears:
An ActiveX control on this page is not
safe. Your current security settings
prohibit running unsafe controls on
this page. As a result, this page
might not display as intended.
The Print Preview window does not open.

To resolve this issue, in Internet Explorer go
to Tools > Internet Options > Security tab and
complete the following tasks:

Metasys Site Management Portal Help

Note: Windows 10, Windows 8.1, and Windows
8, and server-class Windows operating systems may require changing the User Account
Control (UAC) settings to allow resource files
(LON and Vendor Integrations) to be added to
the NxE/LCS engines. The Metasys Site Portal
does not inform the user when a resource file
fails to download. For details, refer to the Disabling User Access Control section of the Meta-

•

add the Metasys site as a Trusted site.
Ensure you clear the check box next to
Require server verification (https:) for all
sites in this zone.

• change the security level to Medium-low.
Next, go to the Advanced tab and set the
ActiveX settings from Disable to Prompt.
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The following message appears in the Alarms
window or in the Event Viewer:
COV registration has failed due to
table full error. Restart {NAE} to
recover.
Notes:
Symptoms of a full table include:

This problem occurs when the signup database
reaches the maximum size.
Restart the specified NAE as soon as possible.

•

COV updates made to the UI fail.

•

Logic configured online after startup
appears unreliable.

•

MS/TP field points mapped online after
startup are not appearing online.

The following message appears in the Alarms
window or in the Event Viewer:
COV registration failure may occur
soon due to table full error. Restart
{NAE} to prevent.
One of the following messages appears in the
Alarms window or in the Event Viewer:
Server Certificate will expire
<datetime>. Restart device to
automatically replace.
Server Certificate has expired
<datetime>. Restart device to
automatically replace.
Server Certificate is not valid
until <datetime>. Restart device to
automatically replace.

One of the following messages appears in the
Alarms window or in the Event Viewer:
Server Certificate will expire
<datetime>. Install new certificate
using SCT.
Server Certificate has expired
<datetime>. Install new certificate
using SCT.
Server Certificate is not valid until
<datetime>. Install new certificate
using SCT.

This problem occurs when the signup database
is nearing the maximum size. Restart the
specified NAE as soon as practical, but it must
be restarted before the Site Director resets for
any reason.
The self-signed certificate assigned to the
network engine that is identified in the message
is about to expire, has expired, or is not in effect.
For any of these situations, issue a Restart
command to the network engine to issue a new,
self-signed certificate.
Note: The Certificate Renewal Period attribute
in the Site object controls when these reminders
are issued. Once activated, the reminder message occurs once per day until you issue the
new certificate.

The trusted certificate assigned to the network
engine that is identified in the message is about
to expire, has expired, or is not in effect. For any
of these situations, obtain a new certificate from
our certificate authority and install it with SCT.
Note: The Certificate Renewal Period attribute
in the Site object controls when these reminders
are issued. Once activated, the reminder message occurs once per day until you issue the
new certificate.

Product warranty
This product is covered by a limited warranty, details of which can be found at
www.johnsoncontrols.com/buildingswarranty.
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Software terms
Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted
services applicable to this product, if any, is subject to applicable end-user license, opensource software information, and other terms set forth at www.johnsoncontrols.com/
techterms. Your use of this product constitutes an agreement to such terms.

Patents
Patents: https://jcipat.com

Contact information
Contact your local branch office: www.johnsoncontrols.com/locations
Contact Johnson Controls: www.johnsoncontrols.com/contact-us
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